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Официальное уведомление 

Гарантийные обязательства

Единственные гарантийные обязательства в отношении продуктов и услуг компании НР изложены 
в заявлении о прямых гарантийных обязательствах, которое прилагается к таким продуктам и 
услугам. Никакая часть настоящего документа не должна рассматриваться как дополнительные 
гарантийные обязательства. Компания НР не несет ответственности за технические или 
редакторские ошибки и неточности, содержащиеся в данном документе.

Информация, содержащаяся в настоящем документе, может быть изменена без уведомления.

Пояснения к ограниченным правам

Конфиденциальное компьютерное программное обеспечение. Для владения, использования или 
копирования необходима действующая лицензия компании HP. В соответствии с положениями 
FAR 12.211 и 12.212 коммерческое компьютерное программное обеспечение, документация 
компьютерного программного обеспечения и технические данные коммерческих продуктов 
лицензируются государственным учреждениям США на условиях стандартной коммерческой 
лицензии поставщика.

Веб-сайты сторонних производителей

Компания НР предоставляет ссылки на сайты сторонних производителей, содержащих 
дополнительную информацию.  Содержимое и доступность таких веб-сайтов могут быть изменены 
без уведомления.  Компания НР не делает никаких заявлений и не дает никаких гарантий в 
отношении содержимого или доступности таких сайтов.

Уведомление об авторских правах

© Hewlett-Packard Development Company, L.P., 1993-2009.

Уведомление о товарных знаках

Adobe® является товарным знаком компании Adobe Systems Incorporated.

JavaTM является товарным знаком компании Sun Microsystems, Inc. в США.

Microsoft® и Windows® являются зарегистрированными в США товарными знаками корпорации 
Майкрософт.
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Обновление документации

На титульном листе настоящего документа приведена следующая информация.

• Номер версии программного обеспечения.

• Дата выпуска документа, которая изменяется при каждом обновлении документа.

• Дата релиза программного обеспечения, т. е. дата релиза текущей версии программного 
обеспечения.

Чтобы проверить наличие обновлений или убедиться в том, что вы пользуетесь самой последней 
редакцией документа, перейдите на

http://h20230.www2.hp.com/selfsolve/manuals 

Для доступа к этому сайту необходимо зарегистрироваться в службе HP Passport и выполнить вход. 
Чтобы зарегистрироваться для получения идентификатора пользователя службы HP Passport, 
перейдите по адресу 

http://h20229.www2.hp.com/passport-registration.html 

Также можно перейти по ссылке New users - please register на странице входа в службу HP 
Passport.

Подписка на поддержку соответствующего продукта также дает возможность получения 
обновленных или новых выпусков. Подробные сведения можно получить у торгового 
представителя компании HP.
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Поддержка

Веб-сайт технической поддержки программного обеспечения компании HP находится по адресу

http://www.hp.com/go/hpsoftwaresupport 

На этом веб-сайте приведена контактная информация и подробные сведения о продуктах, услугах и 
поддержке, предоставляемых компанией HP в сфере программного обеспечения.

Служба поддержки программного обеспечения компании HP в Интернете предоставляет 
заказчикам возможности для самостоятельного устранения неполадок,  а также быстрый и 
эффективный доступ к интерактивным средствам технической поддержки, необходимым для 
управления бизнесом. Наши клиенты, имеющие право на техническую поддержку, могут 
использовать данный веб-сайт для следующих целей:

• Поиск необходимых документов в базе знаний.

• Подача и отслеживание заявок в службу технической поддержки и запросов на расширение 
функциональных возможностей.

• Загрузка исправлений программного обеспечения.

• Управление договорами на оказание поддержки.

• Поиск контактной информации службы поддержки компании HP.

• Просмотр сведений о доступных услугах.

• Участие в обсуждениях с другими покупателями программного обеспечения.

• Поиск курсов обучения по программному обеспечению и регистрация для участия в них.

Для получения доступа к большинству разделов поддержки сначала необходимо 
зарегистрироваться в качестве пользователя службы НР Passport, а затем войти в систему. Для ряда 
разделов поддержки также необходимо наличие договора на оказание поддержки.

Получить более подробные сведения об уровнях доступа можно по адресу:

http://h20230.www2.hp.com/new_access_levels.jsp 

Чтобы зарегистрироваться на получение идентификатора пользователя службы НР Passport, 
перейдите на страницу:

http://h20229.www2.hp.com/passport-registration.html 
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Введение в руководство

Вас приветствует HP Quality Center, решение компании HP на основе веб-
технологий для управления жизненным циклом приложений. С помощью 
Quality Center можно организовать все этапы управления жизненным 
циклом приложения и управлять ими, включая определение релизов, 
определение требований, планирование тестов, выполнение тестов и 
отслеживание дефектов.

Структура руководства 
В руководстве пользователя Quality Center приведено описание 
использования Quality Center для управления всеми этапами жизненного 
цикла приложения. 

Руководство состоит из следующих частей:

 Часть I Основы Quality Center
Общий обзор функциональных возможностей и методологии Quality Center.

 Часть II Управление релизами
Определение релизов и циклов для управления жизненным циклом 
приложения.

 Часть III Описание требований
Определение требований путем построения дерева требований.
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 Часть IV Планирование тестирования
Планирование процесса тестирования, начиная с построения дерева плана 
тестирования и заканчивая разработкой тестов.

 Часть V Выполнение тестов
Создание наборов тестов, выполнение тестов вручную и в автоматическом 
режиме и анализ результатов тестирования.

 Часть VI Отслеживание дефектов
Направление отчетов о дефектах приложений в проект Quality Center и 
отслеживание процесса устранения дефектов до полного устранения 
дефектов.

 Часть VIIУправление библиотекой
Определение библиотек для отслеживания изменений в проекте, 
повторного использования объектов в проекте и совместного 
использования объектов в нескольких проектах.

 Часть VIIIАнализ в Quality Center
Анализ процесса управления жизненным циклом приложения путем 
создания диаграмм, стандартных отчетов, отчетов Excel, страниц панели 
отчетов и проектной документации.

 Часть IX Приложения
Работа со средством тестирования VAPI-XP и список сочетаний клавиш 
Quality Center. Описание различных выпусков Quality Center: Starter, 
Enterprise и Premier.

Словарь терминов
Список терминов, используемых в Quality Center.
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Documentation Library
Documentation Library — интерактивная справка по  Quality Center. 
Получить доступ к Documentation Library можно следующими способами:

➤ Нажмите кнопку Documentation Library в меню Help Quality Center, чтобы 
открыть главную страницу Documentation Library. На главной странице 
находятся ссылки для быстрого перехода к основным разделам справки.

➤ Выберите элемент Help on this page в меню Help Quality Center, чтобы 
открыть Documentation Library на теме, относящейся к текущей странице.

Руководства Documentation Library
Documentation Library состоит из следующих руководств и справочных 
материалов, которые доступны в Интернете, в электронном виде в 
формате PDF, либо в обоих вариантах. Документы в формате PDF можно 
просматривать и распечатывать в программе Adobe Reader, которую 
можно загрузить с веб-сайта компании Adobe (http://www.adobe.com).

В разделе Getting Started описана процедура использования 
Documentation Library и ее структура. (Доступно в Интернете).

В разделе What’s New? (Новые возможности) содержится описание 
новых функций, добавленных в последнюю версию Quality Center. 
(Доступно в Интернете и в формате PDF).

Получить доступ к разделу What’s New? (Новые возможности) также 
можно из меню Help продукта Quality Center. Кроме того, чтобы 
просмотреть короткие ролики, демонстрирующие основные функции 
продукта, выберите Help > Product Feature Movies. 

Файл Readme содержит самые последние новости и сведения о 
Quality Center. 

http://www.adobe.com
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Руководства Quality Center 
В руководстве пользователя HP Quality Center описано, как с помощью 
Quality Center можно упорядочить и выполнить все этапы процесса 
управления жизненным циклом приложения.   В данном документе 
описано, как определять релизы, разрабатывать требования, планировать 
и выполнять тесты, и отслеживать дефекты. (Доступно в Интернете и в 
формате PDF).

HP Quality Center Administrator Guide содержит описание процедуры 
создания и ведения проектов с помощью функции Site Administration. В нем 
также описано, как настраивать проекты в окне Project Customization. 
(Доступно в Интернете и в формате PDF).

Учебное руководство по HP Quality Centerпредставляет собой 
материалы для самостоятельного изучения использования Quality Center  
для организации процесса управления жизненным циклом программного 
обеспечения. (Доступно в формате PDF).

Руководство по установке HP Quality Center разъясняет процедуру 
установки Quality Center на сервере в кластерной среде или в качестве 
автономного приложения. (Доступно в формате PDF).

Руководство по подготовке к обновлению HP Quality Center содержит 
указания по обнаружению и исправлению проблем перед началом 
обновления проекта.  (Доступно в формате PDF).

HP Quality Center Database Best Practices Guide рассказывается о 
передовых методах развертывания Quality Center на серверах баз данных. 
(Доступно в формате PDF).

Руководства по Business Process Testing
HP Business Process Testing User Guide разъясняет, как использовать HP 
Business Process Testing для создания тестов бизнес-процессов. (Доступно 
в Интернете и в формате PDF).

Учебное руководство HP Business Process Testing представляет собой 
материалы для самостоятельного изучения основных сведений  об 
использовании  программы HP Business Process Testing в приложении 
Quality Center. (Доступно в формате PDF).
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Справочные материалы по интерфейсу прикладного 
программирования (API):
HP Quality Center Database Reference — это полный комплект 
электронной документации по таблицам и полям базы данных проекта. 
(Доступно в Интернете).

HP Quality Center Open Test Architecture API Reference — это полный 
комплект электронной документации по API Quality Center на основе COM. 
Открытую архитектуру тестирования Quality Center можно использовать 
для интеграции средств пользователя по настройке конфигурации, средств 
отслеживания дефектов и пользовательских средств тестирования в 
проекте Quality Center. (Доступно в Интернете).

HP Quality Center Site Administration API Reference — это полный 
комплект электронной документации по API администрирования узлов на 
основе COM. Интерфейс Site Administration API можно использовать для 
того, чтобы приложение выполняло функции упорядочивания, управления 
и ведения пользователей Quality Center, проектов, доменов, подключений и 
параметров конфигурации сайта . (Доступно в Интернете).

HP Quality Center Entity Dependencies API Reference  — доступные в 
Интернете справочные материалы по управлению взаимосвязями между 
объектами Quality Center.  В руководстве описываются API Quality Center на 
базе COM и таблицы данных, которые используются для управления 
взаимосвязями.  Эти справочные материалы пригодятся при интеграции 
средств тестирования и Quality Center. (Доступно в Интернете).

HP Quality Center Custom Test Type Guide — это полное руководство по 
созданию пользовательских средств тестирования и их интеграции в 
продукт Quality Center. (Доступно в Интернете).
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Дополнительные сетевые ресурсы
В меню Help продукта Quality Center доступны следующие дополнительные 
сетевые ресурсы:

 Troubleshooting and Knowledge Base предоставляет доступ к странице 
поиска и устранения неисправностей веб-сайта поддержки программного 
обеспечения НР, на которой можно выполнить поиск в базе знаний для 
самостоятельного устранения неисправностей. Выберите Help > 
Troubleshooting and Knowledge Base. URL-адрес этого веб-сайта: 
http://h20230.www2.hp.com/troubleshooting.jsp.

Пункт меню HP Software Support предоставляет доступ к веб-сайту HP 
Software Support. Этот веб-сайт позволяет осуществлять поиск в базе 
знаний по самостоятельному устранению неисправностей. Кроме того, 
пользователи могут просматривать форумы и оставлять в них сообщения, 
подавать заявки на предоставление поддержки, загружать исправления и 
обновленную документацию, а также выполнять другие операции. 
Перейдите по пунктам меню Help > HP Software Support. Адрес этого веб-
сайта — www.hp.com/go/hpsoftwaresupport.

Для получения доступа к большинству разделов поддержки сначала 
необходимо зарегистрироваться в качестве пользователя службы НР 
Passport, а затем войти в систему. Для ряда разделов поддержки также 
необходимо наличие договора на оказание поддержки.

Получить более подробные сведения об уровнях доступа можно по адресу:  
http://h20230.www2.hp.com/new_access_levels.jsp

Чтобы зарегистрироваться для получения идентификатора пользователя 
службы НР Passport, перейдите на страницу:  
http://h20229.www2.hp.com/passport-registration.html 

Пункт меню HP Software Web site предоставляет доступ к веб-сайту 
программного обеспечения компании НР. На этом веб-сайте приведены 
самые - последние сведения о программных продуктах НР: сведения о 
новых релизах программного обеспечения, семинарах и выставках, 
поддержке клиентов и т.д. Выберите Help > HP Software Web site. Адрес 
этого веб-сайта — www.hp.com/go/software.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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Add-ins Page открывает страницу надстроек HP Quality Center, на которой 
предлагаются решения по интеграции и синхронизации продуктов 
компании HP и вспомогательных программных средств третьих сторон.  
Дополнительные сведения см. в документе Руководство по установке 
HP Quality Center.

Обновление документации
HP Software постоянно обновляет документацию по своим продуктам и 
пополняет ее новыми сведениями..

Чтобы проверить последние обновления или убедиться в том, что вы 
пользуетесь последней редакцией документа, перейдите на веб-сайт HP 
Software Product Manuals (http://h20230.www2.hp.com/selfsolve/manuals).

http://h20230.www2.hp.com/selfsolve/manuals
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Часть I
Основы Quality Center
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1
Введение

Вас приветствует HP Quality Center, решение компании HP на основе веб-
технологий для управления жизненным циклом приложений. Получить 
доступ к Quality Center можно с помощью браузера через Интернет или 
внутреннюю корпоративную сеть.

Управление жизненным циклом приложения — сложный процесс. Он 
включает взаимосвязанные этапы, такие как определение релизов, 
разработка требований, проектирование и проверка требований, 
отслеживание и предоставление сведений о дефектах. 
Администрирование всех аспектов процесса управления приложения 
может потребовать много времени и усилий.

Quality Center упрощает и упорядочивает управление приложением 
благодаря систематическому контролю над процессом. Это средство 
помогает создать структуру и основу рабочего процесса управления 
приложением.

Quality Center предоставляет систему для организации и отслеживания 
релизов приложений, позволяя соотносить бизнес-приоритеты и 
ожидаемые показатели качества с требованиями проекта, тестами и 
дефектами.

Quality Center помогает определить и поддерживать базу данных проекта с 
требованиями и тестами. Требования позволяют обеспечить покрытие всех 
аспектов функциональности приложения. На основе этих требований могут 
быть созданы тесты, обеспечивающие тестирование соответствующих 
компонентов приложения. Чтобы обеспечить соответствие различным 
целям проекта, можно упорядочивать тесты проекта с помощью 
уникальных групп. Quality Center предоставляет эффективный интуитивный 
метод планирования и выполнения наборов тестов, сбора результатов 
тестирования и анализа данных.
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Quality Center также использует сложную систему отслеживания дефектов 
приложения, обеспечивающую полный текущий контроль дефектов, 
начиная с их обнаружения и до устранения. Благодаря взаимодействию 
Quality Center с электронной почтой можно обеспечить совместное 
использование данных отслеживания дефектов всеми сотрудниками групп 
разработки, бизнес-аналитики, контроля качества, технической поддержки 
и информационных систем.

Quality Center предоставляет средства анализа требований, разработки и 
выполнения тестов, а также отслеживания дефектов. Можно создавать 
интерактивные диаграммы, наглядно показывающие разнообразные 
перспективы эффективности бизнеса, или определять отчеты с любыми 
структурами данных. Также можно отслеживать многочисленные бизнес-
показатели, располагая различные диаграммы рядом в одном 
представлении.

Quality Center обеспечивает интеграцию со средствами тестирования 
компании HP (WinRunner, QuickTest Professional, LoadRunner и Visual API-
XP), средствами тестирования сторонних производителей и специальными 
средствами тестирования, а также средствами управления требованиями и 
конфигурациями. Quality Center обеспечивает беспрепятственный обмен 
данными с выбранным средством тестирования, что позволяет получить 
всеобъемлющее решение для полностью автоматизированного 
тестирования приложений.

Quality Center предоставляет рекомендации на всех этапах управления 
жизненным циклом приложения. Благодаря интеграции всех задач 
управления приложениями обеспечивается высочайшее качество 
разрабатываемых приложений.

Quality Center Выпуски. Доступность функциональных возможностей 
определяется используемым выпуском Quality Center — Starter, Enterprise 
или Premier. Дополнительные сведения см. в Приложение C, "Выпуски 
Quality Center".
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Управление жизненным циклом приложения
Процесс управления жизненным циклом приложения с использованием 
Quality Center состоит из следующих этапов. 

Определение релизов. Разработка плана управления на основе релизов 
и циклов.

Определениетребований. Анализ приложения и определение 
требований.

Планирование тестов. Создание плана тестирования на основе 
требований.

Выполнение тестов. Создание наборов тестов и их выполнение.

Отслеживание дефектов. Создание отчетов о дефектах, обнаруженных в 
приложении, и отслеживание процесса их устранения.

Определение
требований

План
тестирования

Выполнение
тестов

Отслеживание
дефектов

Определение 
релизов
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На каждом этапе можно анализировать данные, создавая подробные 
отчеты и диаграммы.

Определение релизов 
Разработка плана управления на основе релизов и циклов. 

Определение релизов и циклов. Построение дерева релизов для 
определения релизов и циклов. Релиз представляет собой группу 
изменений, внесенных в одно или несколько приложений и доступных для 
одновременного распространения. Цикл представляет собой цикл 
разработки и контроля качества на основе временных рамок проекта.

Назначение требований. Определение требований в модуле 
Requirements и назначение их релизам и циклам в дереве релизов. 

Определение версий 
и циклов

Назначение 
требований

Назначение и 
выполнение наборов 

тестов

Назначение 
дефектов

Анализ версий и 
циклов
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Назначение и выполнение наборов тестов. Создание папок наборов 
тестов в модуле Test Lab и назначение их циклам в дереве релизов. Набор 
тестов — это группа тестов в проекте Quality Center, предназначенная для 
решения определенных задач тестирования. После назначения папок 
наборов тестов циклу выполняются наборы тестов, расположенные в 
соответствующих папках. 

Назначение дефектов. Регистрация новых дефектов, обнаруженных в 
приложении, в проекте Quality Center. Назначение дефектов 
соответствующим релизам и циклам в дереве релизов.

Анализ выпусков и релизов. Создание отчетов и диаграмм, с помощью 
которых можно проанализировать ход работы над релизом. Анализ дерева 
релизов для проверки его соответствия целям релиза.
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Определение требований  
Анализ приложения и определение требований. 

Определение объема тестирования. Анализ документации приложения 
для определения объема, целей и стратегий.

Создание требований. Построение дерева требований для определения 
общих требований.

Детализация требований. Создание перечня подробных требований для 
каждого требования в дереве требований. Составление описания каждого 
требования, назначение ему уровня приоритета и добавление вложений 
(если необходимо).

Назначение релизам. Назначение каждого требования релизам и циклам 
в дереве релизов в модуле Releases. Дерево релизов показывает релизы 
продукта в виде иерархической структуры дерева. 

Определение рамок
тестирования

Создание
требований

Детализация
требований

Назначение 
требований релизам

Анализ
требований

Создание базового 
состояния
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Анализ требований. Создание отчетов и диаграмм, с помощью которых 
можно анализировать требования. Анализ требований в целях 
обеспечения соответствия объему управления приложением.

Создание базового состояния. Базовое состояние дает возможность 
получить снимок требований в определенный момент времени. Базовые 
состояния создаются для подписи или для сравнения важных этапов 
жизненного цикла приложения.

Планирование тестирования 
Составление плана тестирования на основе требований. 

Определение стратегии тестирования. Анализ приложения, системной 
среды и ресурсов тестирования для определения целей тестирования.

Определение 
стратегии 

тестирования

Определение 
объектов 

тестирования

Разработка тестов

Создание покрытия 
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Разработка шагов 
тестирования

Автоматизация 
тестов

Анализ плана 
тестирования

Создание базового 
состояния
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Определение объектов тестирования. Разделение приложения на 
функции, подлежащие тестированию. Построение дерева плана 
тестирования для иерархического разделения приложения на модули 
тестирования (объекты тестирования).

Создание тестов. Определение необходимых типов тестов для каждого 
объекта тестирования. Добавление базового определения каждого теста в 
дерево плана тестирования.

Создание покрытия требований тестами. Создание связи каждого теста 
с одним или несколькими требованиями.

Разработка шагов теста. Разработка ручных тестов путем добавления 
шагов к тестам в дереве плана тестирования. Шаги тестов описывают 
операции тестирования и ожидаемый результат каждого теста. 
Определение тестов, подлежащих автоматизации.

Автоматизация тестов. Создание скриптов тестов с помощью средств 
тестирования HP, специальных средств тестирования или средств 
тестирования сторонних разработчиков для тестов, которые необходимо 
автоматизировать.

Анализ плана тестирования. Создание отчетов и диаграмм, 
позволяющих проанализировать данные планирования тестов. Анализ 
тестов с целью определения их соответствия целям тестирования.

Создание базового состояния. Базовое состояние теста — это состояние 
плана тестирования в определенный момент времени. Базовые состояния 
создаются для утверждения или для сравнения важных этапов жизненного 
цикла приложения.
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Выполнение тестов 
Создание наборов тестов и выполнение тестов. 

Создание наборов тестов. Определение групп тестов, соответствующих 
различным целям тестирования в проекте. Эти группы могут включать, 
например, тестирование новой версии или определенной функции 
приложения. Определение тестов для включения в каждый набор тестов. 
Назначение папок наборов тестов циклам, определенным в дереве 
релизов модуля Releases. 

Составление расписания выполнения тестов. Составление расписания 
выполнения тестов и назначение задач тестировщикам приложения. 

Выполнение тестов. Выполнение тестов из набора тестов вручную или 
автоматически.

Анализ результатов тестов. Просмотр результатов выполнения тестов с 
целью определения обнаружения дефектов в приложении. Создание 
отчетов и диаграмм, облегчающих анализ этих результатов.

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements

Создание
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выполнение тестов
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Отслеживание дефектов 
Регистрация обнаруженных дефектов приложения в проекте и 
отслеживание процесса их устранения. 

Добавление дефектов. Создание отчета о новых дефектах, 
обнаруженных в приложении. Тестировщики, разработчики, руководители 
проектов группы контроля качества и конечные пользователи могут 
добавлять дефекты на любом этапе процесса управления приложением.

Анализ новых дефектов. Анализ новых дефектов и определение 
дефектов, подлежащих устранению.

Устранение открытых дефектов. Исправление дефектов, подлежащих 
устранению.

Тестирование новой сборки. Тестирование новой сборки приложения. 
Этот процесс продолжается до устранения дефектов.

Анализ данных о дефектах. Создание отчетов и диаграмм, с помощью 
которых можно провести анализ процесса устранения дефектов и 
определить готовность релиза приложения.

Добавление
дефектов

Анализ новых
дефектов

Устранение
открытых дефектов

Тестирование
новой сборки
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Работа с базами данных проекта 
При создании проекта Quality Center необходимо сохранять данные, 
созданные и собранные с помощью Quality Center, и управлять ими. 
Каждый проект использует базу данных, в которой хранятся сведения о 
проекте.

Дополнительные сведения о поддерживаемых серверах баз данных см. в 
документе Руководство по установке HP Quality Center.

Дополнительные сведения о создании проектов Quality Center и 
управлении ими см. в документе HP Quality Center Administrator Guide.

Привилегии пользователей 
Quality Center позволяет управлять доступом пользователей к проекту. 
Путем создания списка авторизованных пользователей, назначения 
каждому из них пароля и включения пользователей в группы можно 
управлять типами дополнений и изменений, вносимых каждым 
пользователем в проект. Группа пользователей определяет привилегии 
пользователя в проекте. Quality Center включает механизм привилегий и 
разрешений, который позволяет создавать правила для определенных 
полей проекта.

Подробные сведения о существующих в Quality Center группах 
пользователей и назначении паролей и привилегий см. в документе 
HP Quality Center Administrator Guide.
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Импорт из приложений Microsoft Word и Microsoft Excel
Можно импортировать данные из приложений Word или Excel в проект 
Quality Center.

Импорт из приложения Word
Quality Center предоставляет возможность импортировать данные 
требования или плана тестирования из документа Word в проект. Для 
импорта из приложения Word необходимо установить на клиентский 
компьютер надстройки HP Quality Center Microsoft Word Add-In и 
HP Quality Center Connectivity Add-In. Чтобы установить надстройку, 
выберите команду Help > Add-ins Page, чтобы открыть страницу надстроек 
HP Quality Center, и щелкните ссылку на соответствующую надстройку.

Дополнительные сведения см. в документе Руководство по надстройке 
HP Quality Center Microsoft Word Add-in на странице надстройки Microsoft 
Word Add-in.

Импорт из приложения Excel
Quality Center предоставляет возможность импортировать в проект данные 
требования, плана тестирования или дефекта из таблицы Excel. Для 
импорта из приложения Excel необходимо установить на клиентском 
компьютере надстройки HP Quality CenterMicrosoft Excel Add-in и 
HP Quality Center Connectivity Add-in. Чтобы установить надстройку, 
выберите команду Help > Add-ins Page, чтобы открыть страницу надстроек 
HP Quality Center, и щелкните ссылку на соответствующую надстройку.

Дополнительные сведения см. в документе Руководство по надстройке 
HP Quality Center Microsoft Excel Add-in на странице надстройки Microsoft 
Excel Add-in.
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2
Приступая к работе

В этой главе  приведен порядок запуска приложения Quality Center и 
описание окна Quality Center.

Эта глава содержит следующие разделы.

 ➤  Запуск Quality Center на стр. 40

 ➤  Сброс пароля на стр. 44

 ➤  Окно Quality Center на стр. 45

 ➤  Quality Center Общая панель инструментов на стр. 47

 ➤  Изменение свойств и пароля пользователя на стр. 49

 ➤  Удаление истории изменения на стр. 51

 ➤  Просмотр сообщений администратора на стр. 52
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Запуск Quality Center
Для запуска Quality Center на компьютере используется браузер.

Чтобы запустить Quality Center, выполните следующие действия.

 1 Откройте браузер и введите URL-адрес сервера Quality Center
http://<Quality Center имя сервера>[<:номер порта>]/qcbin. Если правильный 
путь не известен, обратитесь к системному администратору.

Откроется окно выбора HP Quality Center.

 2 Щелкните ссылку Quality Center.

При первом запуске Quality Center файлы загружаются на компьютер, и 
выполняется программа установки приложения Microsoft .NET Framework 
2.0 (если оно еще не установлено на компьютере). После этого 
Quality Center выполнит проверку версии. Если на сервере будет 
обнаружена обновленная версия, файлы обновления будут загружены на 
компьютер.
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Примечание. 

➤ Чтобы загрузить файлы на компьютер, необходимо войти в систему с 
правами администратора. Дополнительные сведения о минимальных 
разрешениях, необходимых для установки компонентов клиента, см. в 
документе Руководство по установке HP Quality Center.

➤ Если загрузка файлов запрещена в браузере, их можно установить с 
помощью надстройки HP Quality Center Client Side Setup Add-in на 
странице надстроек HP Quality Center. Дополнительные сведения о 
надстройках см. в документе Руководство по установке 
HP Quality Center. 

➤ Quality Center предложит установить платформу Microsoft.NET 
Framework 2.0, если она еще не установлена на компьютере. Чтобы 
выполнить установку, следуйте инструкциям мастера установки 
обновлений программного обеспечения (если установщик Windows 3.1 
не установлен) и программы установки платформы Microsoft .NET 
Framework 2.0.
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После проверки версии Quality Center и обновления файлов открывается 
окно входа в систему HP Quality Center.

 3 В поле Login Name введите имя пользователя.

 4 В поле Password введите пароль, назначенный администратором сайта. 
Если вы не можете вспомнить пароль, щелкните ссылку Forgot Password. 
Дополнительные сведения см. в разделе “Сброс пароля" на стр. 44.

Сведения об изменении назначенного пароля см. в разделе “Изменение 
свойств и пароля пользователя" на стр. 49.

 5 Установите флажок Automatically log in to my last domain and project on 
this machine, если требуется автоматический вход в последний проект 
Quality Center, с которым вы работали.

 6 Нажмите кнопку Authenticate. Quality Center проверит имя пользователя и 
пароль и определит, к каким доменам и проектам у вас есть доступ. Если 
был указан автоматический вход, откроется Quality Center.

В случае сбоя аутентификации проверьте правильность ввода имени 
пользователя и пароля и повторите попытку входа.
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 7 Выберите домен в списке Domain. По умолчанию отображается последний 
домен, в котором работал пользователь.

 8 Выберите нужный проект в списке Project. По умолчанию отображается 
последний проект, в котором работал пользователь.

Если на сервере Quality Center установлен демонстрационный проект, 
выберите проект QualityCenter_Demo (в списке Domain должен быть 
выбран домен DEFAULT). Этот проект содержит примеры данных, которые 
помогают начать работу с Quality Center. Дополнительные сведения см. в 
документе Учебное руководство по HP Quality Center.

 9 Нажмите кнопку Login. Откроется приложение Quality Center, и будет 
показан последний модуль, в котором выполнялась работа в ходе 
предыдущего сеанса.

При первом запуске Quality Center откроется страница приветствия. 
Страница приветствия предоставляет непосредственный доступ к 
документации Quality Center. Если не требуется отображение страницы 
приветствия при каждом входе в Quality Center, установите флажок Don’t 
show this again. Чтобы открыть страницу приветствия в любое время, 
выберите команду Help > Welcome Page.

 10 Чтобы закрыть приложение и вернуться к окну входа HP Quality Center, 
нажмите кнопку Logout в верхнем правом углу окна. 

Также можно выбрать команду Tools > Change Project, чтобы войти в 
другой проект.
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Сброс пароля
Если при входе в Quality Center не удается вспомнить пароль, можно 
сбросить пароль и создать новый.

Примечание. Сброс пароля недоступен в следующих случаях.

➤ Сброс пароля отключен параметром PASSWORD_RESET_DISABLE в 
модуле Site Configuration. 

➤ Включена аутентификация по протоколу LDAP. 

Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Чтобы сбросить пароль, выполните следующие действия.

 1 В окне входа в Quality Center щелкните ссылку Forgot Password. Откроется 
диалоговое окно Forgot Password.

 2 В поле Login Name введите имя пользователя. По умолчанию будет 
показано имя, указанное в окне входа в Quality Center.

 3 Нажмите кнопку OK. Quality Center отправит сообщение по адресу 
электронной почты, назначенному для имени пользователя Quality Center.

Ссылка в сообщении действительна в течение установленного периода 
времени. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

 4 Откройте сообщение электронной почты, полученное от Quality Center, и 
щелкните ссылку Reset your password. Откроется окно Password Reset.

 5 В поле Login Name введите имя пользователя.

 6 В поле New Password введите новый пароль.

 7 В поле Retype Password введите пароль еще раз.

 8 Нажмите кнопку ОK. Откроется окно входа в Quality Center. Войдите в 
систему с новым паролем.
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Окно Quality Center
При подключении к проекту открывается главное окно Quality Center с 
модулем, в котором пользователь работал в последний раз. В верхней 
правой части окна отображаются домен, проект и имя пользователя.

Примечание. Доступные функциональные возможности Quality Center 
определяются настройкой проекта Quality Center, выполненной 
администратором сайта или проекта.

Окно Quality Center содержит следующие основные элементы.

➤ Quality Center боковая панель. Предоставляет доступ к модулям 
Quality Center. Дополнительные сведения см. в разделе “Модули 
Quality Center" на стр. 46.

Общая панель 
инструментов

Панель меню

Панель 
инструментов

Боковая 
панель 

QualityCenter
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➤ Общая панель инструментов Quality Center. Содержит кнопки навигации 
и предоставляет доступ к общим инструментам, документации и 
дополнительным ресурсам. Эта панель инструментов расположена в левой 
верхней части окна. Дополнительные сведения см. в разделе 
“Quality Center Общая панель инструментов" на стр. 47.

➤ Строка меню модуля. Отображает названия меню команд в текущем 
модуле Quality Center.

➤ Панель инструментов модуля. Содержит кнопки вызова команд, часто 
используемых в текущем модуле Quality Center.

➤ Кнопка Logout. Кнопка Logout, расположенная в правом верхнем углу 
окна, позволяет выйти из текущего проекта и вернуться к окну входа в 
HP Quality Center.

Модули Quality Center
Quality Center содержит следующие модули, доступные с боковой панели.

Quality Center Выпуски. Доступность модулей и функций определяется 
используемым выпуском Quality Center — Starter, Enterprise или Premier. 
Дополнительные сведения см. в Приложение C, "Выпуски Quality Center".

➤ Management. Этот модуль включает следующие подмодули.

➤ Releases. Определение релизов и циклов для процесса управления 
приложением.

➤ Libraries. Определение библиотек для отслеживания изменений в 
проекте, повторного использования объектов в проекте и совместного 
использования объектов в нескольких проектах.

➤ Requirements. Управление требованиями с помощью иерархической 
структуры дерева. Требования можно связывать с другими требованиями, 
тестами и дефектами. 

➤ Test Plan. Разработка тестов и управление ими в иерархической структуре 
дерева. Тесты можно связывать с требованиями и дефектами.
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➤ Test Resources. Управление ресурсами тестов с помощью иерархической 
структуры дерева. Ресурсы тестов могут быть связаны с тестами.

➤ Test Lab. Управление тестами и выполнение тестов. После выполнения 
тестов можно анализировать результаты.

➤ Defects. Добавление дефектов, определение приоритетов устранения, 
устранение открытых дефектов и анализ данных.

➤ Dashboard. Создание диаграмм, отчетов и отчетов Excel. Также можно 
создавать панели отчетов, которые позволяют просматривать несколько 
диаграмм одновременно.

В зависимости от лицензии в Quality Center может быть также доступен 
модуль Business Components. Этот модуль позволяет специалистам в 
предметной области управлять процессом оптимизации качества с 
помощью решения для автоматизации тестирования HP Business Process 
Testing. Дополнительные сведения см. в HP Business Process Testing User 
Guide.

Совет. Переходить от одного модуля к другому можно с помощью 
сочетаний клавиш. Перечень сочетаний клавиш приведен в Приложение B, 
"Сочетания клавиш Quality Center"..

Сведения о настройке имен модулей, см. в документе Руководство по 
установке HP Quality Center.

Quality Center Общая панель инструментов
Панель инструментов Quality Center, расположенная в левой верхней части 
окна Quality Center, доступна во всех модулях. Эта панель содержит 
следующие кнопки.

Кнопки навигации
Back. Возврат к предыдущему окну Quality Center.

Forward. Переход к следующему окну в Quality Center.
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Кнопка Tools
Кнопка Tools содержит следующие пункты меню.

Change Project. Выход из текущего проекта и выбор одного из пяти 
проектов, недавно открывавшихся на этом компьютере, или выбор другого 
проекта в окне входа в систему.

Customize. Открывается окно Project Customization для настройки проекта. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

New Defect. Открывается диалоговое окно New Defect для добавления 
нового дефекта. Дополнительные сведения см. в Глава 35, "Добавление и 
отслеживание дефектов"..

Spelling and Grammar. 

➤ Check Spelling. Проверка орфографии выделенного слова или 
фрагмента текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Spelling Options. Открывается диалоговое окно Spelling Options, в 
котором можно настроить параметры проверки орфографии 
Quality Center. 

➤ Thesaurus. Открывается диалоговое окно Thesaurus, содержащее 
синонимы, антонимы или связанные слова для выделенного слова. 
Можно заменить выбранное слово или найти новое.

Clear History. Открывается диалоговое окно Clear History, которое 
позволяет удалить данные истории изменения из проекта. Для удаления 
истории изменения необходимы соответствующие права пользователя. 
Дополнительные сведения см. в разделе “Удаление истории изменения" на 
стр. 51.

Document Generator. Открывается приложение Document Generator. 
Дополнительные сведения см. в Глава 45, "Создание документов проекта"..

Сведения о настройке меню Tools см. в документе Руководство по 
установке HP Quality Center.
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Кнопка Help
Кнопка Help позволяет открывать Quality Center Documentation Library и 
другие интерактивные ресурсы. Кроме того, выводит сведения о версии 
каждого клиентского компонента Quality Center. Дополнительные сведения 
см. в разделах “Documentation Library" на стр. 19 и “Дополнительные 
сетевые ресурсы" на стр. 22.

Сведения о настройке меню Help см. в документе Руководство по 
установке HP Quality Center.

Изменение свойств и пароля пользователя
Можно изменять свойства пользователя (полное имя, адрес электронной 
почты, номер телефона и описание). Сведения об адресе электронной 
почты важны, так как они позволяют получать уведомления по электронной 
почте и оповещения непосредственно в почтовый ящик. Можно также 
изменять свой пароль для доступа к проектам Quality Center.

Администратор сайта может изменять и переопределять свойства или 
пароль пользователя. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Чтобы изменить свойства и пароль пользователя, выполните 
следующие действия.

 1 В левой верхней части окна нажмите кнопку Tools и выберите команду 
Customize. Откроется окно Project Customization. 
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 2 Щелкните ссылку User Properties. Откроется окно User Properties.

 3 Измените свойства пользователя.

 4 Нажмите кнопку Save, чтобы сохранить изменения.

 5 Нажмите кнопку Change Password. Откроется диалоговое окно Change 
Password.

 6 В поле Old Password введите старый пароль.

 7 В поле New Password введите новый пароль.
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 8 В поле Retype New Password введите новый пароль еще раз.

 9 Нажмите кнопку OK, чтобы сохранить изменения. Окно Change Password 
будет закрыто.

 10 В правой верхней части окна нажмите кнопку Return, чтобы закрыть окно 
Project Customization и вернуться к проекту.

Удаление истории изменения 
При настройке проекта можно включить в Quality Center ведение журнала 
значений системных и пользовательских полей в проекте. Дополнительные 
сведения о включении записи истории изменения поля см. в документе 
HP Quality Center Administrator Guide.

Если данные истории изменения больше не нужны, их можно удалить из 
проекта Quality Center. Например, если созданные наборы тестов 
выполнены успешно, можно удалить историю изменения тестов из проекта.

Можно удалить все данные истории изменения или выбрать отдельный 
объект или поле, историю изменения которого следует удалить. Кроме 
того, можно удалять данные истории изменения до определенной даты 
включительно. Quality Center удаляет данные, отображаемые на вкладке 
History соответствующих модулей.

Примечание. Для удаления истории изменения необходимы 
соответствующие разрешения пользователя. 

Чтобы удалить историю изменения, выполните следующие действия.

 1 В левой верхней части окна нажмите кнопку Tools и выберите команду 
Clear History. Откроется диалоговое окно Clear History.

 2 В поле Entity выберите объект, историю изменения которого необходимо 
удалить. Чтобы удалить историю изменения всех объектов, выберите All.

 3 В поле Field выберите поле, историю изменения которого необходимо 
удалить. Чтобы удалить историю изменения всех полей, выберите All.
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 4 В поле Until Date выберите дату. Все данные до выбранной даты 
включительно будут удалены.

 5 Нажмите кнопку ОK.

Просмотр сообщений администратора
Администратор сайта может отправлять сообщения пользователям, 
подключенным к проектам Quality Center, информируя их о важных 
вопросах, связанных с обслуживанием сайта, и других вопросах. 
Например, администратор сайта может направить предупреждение о том, 
что проект, к которому подключены пользователи, будет отключен, или о 
перезагрузке сервера Quality Center.

Дополнительные сведения об отправке сообщений из модуля Site 
Administration см. в документе HP Quality Center Administrator Guide.

Чтобы просмотреть сообщения администратора сайта, выполните 
следующие действия.

 1 После отправки сообщения администратором сайта на компьютере 
пользователя автоматически открывается всплывающее окно с текстом 
сообщения.

 2 При получении нескольких сообщений для их просмотра используйте 
кнопки Previous Message и Next Message.

 3 Чтобы закрыть окно сообщения, нажмите кнопку Close.
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3
Работа с данными Quality Center

Можно просматривать и изменять данные проекта с помощью таблиц и 
деревьев Quality Center.

Эта глава содержит следующие разделы.

 ➤  О работе с данными Quality Center на стр. 54

 ➤  Упорядочивание столбцов на стр. 54

 ➤  Выбор пользователей на стр. 57

 ➤  Фильтрация записей на стр. 59

 ➤  Расширенная и перекрестная фильтрация записей на стр. 64

 ➤  Сортировка записей на стр. 69

 ➤  Группирование записей таблицы на стр. 72

 ➤  Обновление нескольких записей на стр. 74

 ➤  Копирование параметров на стр. 75

 ➤  Обновление и очистка параметров на стр. 75

 ➤  Поиск записей на стр. 76

 ➤  Экспорт данных в файл на стр. 79
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О работе с данными Quality Center
Quality Center упорядочивает и отображает данные в виде таблиц или 
деревьев. Можно манипулировать данными различными способами, в том 
числе изменяя порядок столбцов, используя фильтрацию, сортировку и 
группировку. Также можно копировать настройки, выполнять поиск текста и 
экспортировать данные в файл.

В таблицах и деревьях Quality Center отображается различное 
содержимое, поэтому действия, описанные в этой главе, не всегда 
относятся ко всем таблицам и деревьям.

Совет. Можно сохранять такие параметры деревьев и таблиц, как 
параметры сортировки и фильтры, в виде избранных представлений. 
Дополнительные сведения см. в Глава 6, "Работа с избранными 
представлениями"..

Упорядочивание столбцов 
Можно настраивать представление данных, указывая порядок 
отображения столбцов, изменяя размеры столбцов. При следующем 
открытии проекта Quality Center отобразит столбцы с измененными 
параметрами.

Quality Center Выпуск Starter Edition. В выпуске Starter Edition доступны 
не все поля и функциональные возможности. 

Определение порядка отображения столбцов
Можно определить, какие столбцы и в каком порядке должны отображаться 
в окне Quality Center с помощью диалогового окна Select Columns. 
Например, в качестве первого столбца таблицы Test Grid можно указать 
столбец Subject.
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Чтобы определить размеры и порядок отображения столбцов, 
выполните следующие действия.

 1 Нажмите кнопку Select Columns. Откроется диалоговое окно Select 
Columns.

Список Available Columns содержит столбцы, которые в настоящее время 
не отображаются. В списке 
Visible Columns показаны столбцы, которые в настоящее время 
отображаются.

 2 При открытии окна Select Columns в модуле Requirements в нем также 
отображаются поле Requirement Type и флажок Hide Risk-Based Quality 
Management Columns. 

В раскрывающемся списке Requirement Type выберите тип требования. 
Отображаются доступные столбцы для выбранного типа требования.

Установите флажок Hide Risk-Based Quality Management Columns, чтобы 
не показывать поля требования, относящиеся к управлению качеством на 
основе рисков, в списке Available Columns. Снимите флажок, чтобы 
показать эти поля.



Глава 3 • Работа с данными Quality Center

56

 3 Выберите имена столбцов и с помощью кнопок со стрелками (> и <) 
перемещайте их между списками Available Columns и Visible Columns. 
Чтобы переместить все столбцы из одного списка в другой, используйте 
кнопки с двумя стрелками (>> и <<). Обратите внимание на то, что можно 
также перетаскивать имена столбцов между списками или дважды 
щелкнуть имя столбца, чтобы переместить его в другой список.

Примечание. Столбцы, помеченные значком , нельзя удалить из списка 
Visible Columns.

 4 В списке Visible Columns укажите порядок отображения столбцов, 
используя кнопки со стрелками вверх и вниз. Также можно перетаскивать 
имена столбцов вверх или вниз.

 5 Чтобы установить столбцы без прокрутки, укажите число таких столбцов в 
поле Fixed Columns. Для указанного числа столбцов, начиная с крайнего 
левого столбца, будет установлен режим отключения прокрутки. При 
горизонтальной прокрутке эти столбцы остаются неподвижными. Эти 
столбцы будут выделены затемнением.

 6 Нажмите кнопку OK, чтобы закрыть диалоговое окно и применить новый 
порядок отображения столбцов.

Изменение размеров столбцов
Изменить размеры столбцов можно с помощью мыши. Щелкните правый 
край заголовка столбца и перетащите его, чтобы установить нужную 
ширину столбца. Изменять размеры фиксированных столбцов (без 
прокрутки) нельзя.
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Выбор пользователей
При выборе столбца, содержащего имя пользователя, в таблице или 
дереве Quality Center, Quality Center отображает список пользователей с 
именами и полными именами пользователей. Можно сортировать список 
пользователей, выполнять поиск пользователей, распределять 
пользователей по группам и выбирать пользователей из списка или из 
дерева групп. 

Чтобы выбрать пользователей, выполните следующие действия.

 1 Выберите поле пользователя и нажмите стрелку раскрывающегося списка. 
Откроется диалоговое окно User List.

Чтобы выполнить сортировку списка Users List по имени или полному 
имени пользователя (по возрастанию или убыванию), щелкните заголовок 
столбца Name или Full Name. Чтобы изменить порядок сортировки, 
щелкните заголовок столбца еще раз. 

 2 Поиск пользователей можно выполнять следующими способами.

➤ Пошаговый поиск путем ввода первого символа имени пользователя. 
Для сужения поиска можно вводить дополнительные символы. 
Quality Center начинает поиск после ввода первого символа строки 
поиска и выделяет запись с первым вхождением всей искомой 
последовательности символов.
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➤ Поиск пользователей по имени пользователя или по его полному имени. 
Введите имя пользователя (или часть имени) в поле Find. Нажмите 
кнопку Find. Quality Center выделит запись с первым вхождением строки 
поиска. Нажимайте клавишу F3, чтобы найти последующие вхождения 
строки поиска.

 3 Чтобы просматривать пользователей по группам, установите флажок View 
by Group. Пользователи будут отображаться по группам.

Чтобы развернуть ветвь дерева, щелкните значок Expand  слева от 
имени группы пользователей. Чтобы свернуть ветвь дерева, щелкните 
значок Collapse  слева от имени группы пользователей.

 4 Выберите пользователя и нажмите кнопку OK. Диалоговое окно Users List 
будет закрыто, а в поле данных будет показано значение выбранного 
пользователя.
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Фильтрация записей 
Можно фильтровать данные Quality Center, чтобы отображать только те 
записи, которые соответствуют определенному критерию. Фильтровать 
можно по одному элементу (например, Failed) или по логическому 
выражению (например, Passed Or Failed). В таблице или дереве будут 
отображаться только записи, соответствующие всем критериям 
фильтрации. 

Кроме того, можно определить несколько фильтров. Например, можно 
определить фильтр для поля Status с критерием Failed и фильтр для поля 
Tester с критерием David Or Mark. После фильтрации будут показаны 
только неудачные тесты, выполненные пользователями David и Mark.

При фильтрации дерева результаты в Quality Center будут показаны 
следующим образом.

➤ При фильтрации дерева требований родительские объекты фильтруемых 
объектов, не соответствующие критериям фильтра, будут отмечены 
значком .

➤ При фильтрации дерева плана тестирования или дерева наборов тестов 
папки, не соответствующие критериям фильтра, не будут показаны.

Управление версиями. Сведения о фильтрации данных на основе полей 
управления версиями см. в разделе “Фильтрация полей управления 
версиями" на стр. 123.

Quality Center Выпуск Starter Edition. В выпуске Starter Edition доступны 
не все поля и функциональные возможности. 
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Совет. Можно сохранять параметры фильтрации и сортировки в виде 
избранного представления, а затем загружать это представление при 
необходимости. Чтобы сохранить параметры в виде избранного 
представления, выберите команду Favorites > Add to Favorites. 
Дополнительные сведения см. в Глава 6, "Работа с избранными 
представлениями".

Чтобы определить фильтр, выполните следующие действия.

 1 Нажмите требуемую кнопку Set Filter/Sort. Откроется диалоговое окно 
Filter и будет показана вкладка Filter Condition.
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 2 Чтобы определить фильтр по типу требования, в поле Requirement Type 
нажмите кнопку обзора. Откроется диалоговое окно Select Filter Condition. 
Выберите тип требования. Нажмите кнопку OK, чтобы закрыть диалоговое 
окно Select Filter Condition. На вкладке Filter Condition будут показаны 
соответствующие имена полей.

 3 При работе в модуле Requirements можно установить флажок Hide Risk-
Based Quality Management Columns, чтобы скрыть поля требования, 
относящиеся к управлению качеством на основе рисков. Будут скрыты 
только те поля, для которых не задано условие для фильтрации. Снимите 
флажок, чтобы показать эти поля.

 4 Чтобы перейти к полю на вкладке Filter Condition, щелкните поле в столбце 
Field Name и введите первый символ имени поля. Quality Center выделит 
первое совпадение.

 5 Чтобы задать условие фильтра для поля, щелкните соответствующее поле 
Filter Condition. Нажмите кнопку обзора. Откроется диалоговое окно Select 
Filter Condition.
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Примечания. 

➤ При выборе поля с именем пользователя в диалоговом окне Select Filter 
Condition отображается список пользователей, в котором можно 
сортировать пользователей, выполнять поиск пользователей, 
упорядочивать пользователей по группам и выбирать пользователей из 
списка или дерева групп. Дополнительные сведения см. в разделе 
“Выбор пользователей" на стр. 57.

➤ Если в модуле Requirements выбрать поле Req Parent, откроется 
диалоговое окно Select Filter Condition с деревом требований, 
отсортированным по имени требования. При выборе требования из 
дерева в поле Condition отображается полный путь к требованию. При 
применении фильтра отображаются только дочерние требования 
выбранного требования.

 6 Определите условие для фильтрации. Если применимо, выберите 
элементы из списка. Можно добавлять операторы, чтобы создать 
логическое выражение. 
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Примечания. 

➤ Некоторые элементы, отображающиеся в иерархических списках, 
содержат подчиненные списки. Перед такими элементами стоит значок 
папки. Чтобы выбрать элемент из вложенного списка, дважды щелкните 
папку и выберите элемент.

➤ При определении условия для пользователя можно указать текущего 
пользователя (выберите [CurrentUser]) или всю группу пользователей 
(например, [Developer]).

➤ При вводе условия фильтра из нескольких слов его необходимо 
заключить в кавычки. Например, для поиска теста Login Boundary в поле 
Condition введите: "login boundary".

➤ При вводе только части элемента используйте звездочку (*). Например, 
для поиска всех тестов со словом Login в поле Condition введите: *login*. 
Для поиска всех тестов, имена которых начинаются со слов Insert New в 
поле Condition введите "insert new*".

➤ Чтобы указать пустое поле, введите ""

➤ Чтобы указать непустое поле, введите not "".

 7 Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

 8 Чтобы добавить перекрестные фильтры, нажмите стрелку Show Advanced 
Filter. Дополнительные сведения см. в разделе “Расширенная и 
перекрестная фильтрация записей" на стр. 64.

 9 Чтобы скопировать параметры фильтра, нажмите кнопку Copy Filter 
Settings.. Дополнительные сведения см. в разделе “Копирование 
параметров" на стр. 75.

 10 Чтобы очистить настройки, нажмите кнопку Clear Filter..

 11 Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter.

После этого применяются все фильтры и отображается их описание. Для 
таблицы Quality Center также отображает условие фильтра в поле фильтра 
таблицы под именем каждого столбца.
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Чтобы отобразить поля фильтров таблицы, выберите команду View > Grid 
Filters. Если поле фильтра пустое, к столбцу не применен ни один фильтр. 
Введите условие фильтра непосредственно в поле или щелкните это поле 
для отображения кнопки Browse, которая позволяет открыть диалоговое 
окно Select Filter Condition. 

Расширенная и перекрестная фильтрация записей
При определении фильтра также можно применять перекрестный 
фильтр. Он представляет собой расширенный второй фильтр для 
связанного элемента, такого как требование, тест, набор тестов или 
дефект. Например, в дереве плана тестирования можно определить 
перекрестный фильтр Open для связанных наборов тестов. При 
применении такого фильтра будут отображаться только тесты, 
принадлежащие к набору тестов со статусом Open. Также можно 
определить фильтр для связанных наборов тестов, чтобы найти тесты, не 
входящие ни в один из наборов.

Общая панель 
инструментов
Поле фильтра 
для столбца 

Designer
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В таблице ниже приведен краткий обзор перекрестных фильтров каждого 
модуля Quality Center.

Модуль Перекрестный фильтр

Requirements ➤ Tests. Фильтрация требований по покрытым тестам.
➤ Defects. Фильтрация требований по дефектам, прямо 

или косвенно связанным с требованиями.
➤ Requirements: Trace from. Фильтрация требований по 

требованиям, от которых выполняется прослеживание.
➤ Requirements: Trace to. Фильтрация требований по 

требованиям, к которым выполняется прослеживание.
➤ Show requirements with alerts. Фильтрация требований 

по инициированным оповещениям.

Test Plan ➤ Requirements. Фильтрация тестов по требованиям, 
покрытым тестами.

➤ Test Sets. Фильтрация тестов по наборам, содержащим 
эти тесты.

➤ Defects. Фильтрация тестов по дефектам, прямо или 
косвенно связанным с тестами.

➤ Show tests with alerts. Фильтрация тестов по 
инициированным оповещениям.

Test Lab — 
список Test Sets

➤ Tests. Фильтрация наборов тестов по содержащимся в 
них тестам.

➤ Defects. Фильтрация наборов тестов по дефектам, прямо 
или косвенно связанным с тестами.

Test Lab — 
таблица 
Execution Grid

➤ Requirements. Фильтрация экземпляров тестов по 
тестам, покрывающим выбранные требования.

➤ Defects. Фильтрация тестов по дефектам, прямо или 
косвенно связанным с тестами.

➤ Show test instances with alerts. Фильтрация 
экземпляров тестов по инициированным оповещениям.
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Примечания.

➤ Несмотря на то что функциональные возможности перекрестных 
фильтров одинаковы во всех модулях Quality Center, интерфейс 
диалогового окна в модуле Dashboard немного отличается от 
интерфейса в других модулях. 

➤ Quality Center Выпуск Starter Edition. В выпуске Starter Edition 
доступны не все поля и функциональные возможности. 

Чтобы определить перекрестный фильтр, выполните следующие 
действия.

 1 Нажмите требуемую кнопку Set Filter/Sort. Откроется диалоговое окно 
Filter с вкладкой Filter. 

Дополнительные сведения об определении фильтра см. в разделе 
“Фильтрация записей" на стр. 59.

Defects ➤ Requirements. Фильтрация дефектов по связанным 
требованиям.

➤ Test Sets. Фильтрация дефектов по связанным наборам 
тестов.

➤ Tests. Фильтрация дефектов по связанным тестам.
➤ Show defects with alerts. Фильтрация дефектов по 

инициированным оповещениям.

Dashboard — 
представление 
Analysis

Можно определять перекрестные фильтры для требований, 
тестов, экземпляров тестов и дефектов. 

Модуль Перекрестный фильтр
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 2 Чтобы отобразить параметры перекрестного фильтра, нажмите стрелку 
Show Advanced Filter.
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 3 Установите флажок фильтра в разделе Cross filter by. Например, 
выберите вариант Test Sets. Откроется диалоговое окно Cross Filter.

В модуле Test Plan можно выбрать следующие варианты.

➤ Filter tests not in any test set. Фильтрация тестов, которые не входят ни 
в один набор тестов. Этот параметр помогает найти, например, те 
тесты, которые еще не выполнялись. Этот вариант можно выбрать 
только в диалоговом окне Cross Filter: Test Sets. 

➤ Filter tests with no requirement coverage. Фильтрация тестов, которые 
не покрывают ни одно требование. Этот вариант помогает найти, 
например, избыточные тесты или тесты, не содержащие связи с 
покрытием требований. Этот вариант можно выбрать только в 
диалоговом окне Cross Filter: Requirements.

 4 Определите перекрестный фильтр с помощью правил определения 
фильтра. Дополнительные сведения см. в разделе “Фильтрация записей" на 
стр. 59.
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 5 Чтобы скопировать параметры фильтра, нажмите кнопку Copy Filter 
Settings.. Дополнительные сведения см. в разделе “Копирование 
параметров" на стр. 75.

 6 Чтобы очистить настройки, нажмите кнопку Clear Filter..

 7 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно Cross Filter. Определенные перекрестные фильтры отображаются в 
разделе Cross filter by диалогового окна Filter.

 8 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно Filter.

Сортировка записей
По умолчанию записи отображаются в окне Quality Center в порядке их 
добавления. При задании приоритетов сортировки записи отображаются в 
соответствии с порядком сортировки ASCII. При сортировке ASCII сначала 
рассматриваются записи, начинающиеся с пробела или символа, а затем 
— записи, начинающиеся с цифр. После этого учитываются заглавные 
буквы, а потом — строчные.

Например, если столбцу Designer таблицы Test Grid присвоен высший 
приоритет сортировки, записи сортируются в порядке сортировки ASCII в 
соответствии с именами, отображающимися в столбце Designer. Если 
столбцу Test Name присвоен следующий по важности приоритет, то затем 
в порядке ASCII и в соответствии с их именами будут сортироваться записи 
тестов, которым назначены одинаковые имена в столбце Designer.
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Примечания.

➤ Можно сохранять параметры фильтрации и сортировки в виде 
избранного представления, а затем загружать это представление при 
необходимости. Чтобы сохранить параметры в виде избранного 
представления, выберите команду Favorites > Add to Favorites. 
Дополнительные сведения см. в разделе Глава 6, "Работа с избранными 
представлениями".

➤ Quality Center Выпуск Starter Edition. В выпуске Starter Edition 
доступны не все поля и функциональные возможности. 

Чтобы отсортировать записи, выполните следующие действия.

 1 Нажмите требуемую кнопку Set Filter/Sort. Откроется диалоговое окно 
Filter.

 2 Перейдите на вкладку View Order.
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Список Available Fields содержит имена всех полей, которые можно 
отображать. 
Список Sorted Fields содержит имена полей, которым в настоящее время 
присвоен приоритет сортировки.

 3 При работе в модуле Requirements выберите тип требования из списка 
Requirement Type. На вкладке View Order будут показаны 
соответствующие имена полей.

 4 При работе в модуле Requirements можно установить флажок Hide Risk-
Based Quality Management Columns, чтобы скрыть поля требования, 
относящиеся к управлению качеством на основе риска, в списке Available 
Fields. Снимите флажок, чтобы показать эти поля.

 5 Выберите имена полей и с помощью кнопок со стрелками (> и <) 
перемещайте их между списками Available Fields и Sorted Fields. Чтобы 
переместить все имена из одного списка в другой, используйте кнопки с 
двумя стрелками (>> и <<). Переместить столбец из одного списка в другой 
также можно перетаскиванием имени поля или двойным щелчком имени 
столбца.

 6 В списке Sorted Fields выберите поле и с помощью кнопок Sort Ascending 
и Sort Descending установите сортировку полей по возрастанию или 
убыванию.

 7 В списке Sorted Fields выберите поле и установите приоритет сортировки с 
помощью кнопок Move Field Up и Move Field Down. Также можно 
перетаскивать имена полей вверх или вниз.

 8 Чтобы скопировать параметры, нажмите кнопку Copy Filter Settings.. 
Дополнительные сведения см. в разделе “Копирование параметров" на 
стр. 75.

 9 Чтобы очистить параметры, нажмите кнопку Clear Filter..

 10 Чтобы применить порядок сортировки, нажмите кнопку OK.
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Группирование записей таблицы
При работе с таблицами Quality Center можно упорядочивать данные по 
группам в соответствии с установленными критериями. Можно определить 
данные, по которым Quality Center будет группировать записи, и установить 
иерархический порядок их отображения (до трех уровней). Это упрощает 
перемещение при работе с большими наборами данных.

Например, если столбцу Assigned To таблицы Defects Grid присвоить 
высший приоритет группирования, записи будут группироваться в 
соответствии с именами, показанными в столбце Assigned To. Если 
столбцам Status и Severity присвоить следующие по важности приоритеты 
соответственно, то дефекты тестов, которым присвоены одинаковые имена 
в столбце Assigned To, будут дополнительно группироваться в 
соответствии с их статусом, а затем и уровнем серьезности.

Примечания.

➤ Нельзя выполнять операции Quality Center для всей группы, выбрав 
заголовок группы. Чтобы выполнять операции с несколькими записями, 
используйте клавиши CTRL или SHIFT для выбора записей.

➤ При группировании записей по полю, содержащему несколько значений, 
для группирования используется полное значения поля. Это значение 
используется в качестве категории для группирования. Например, 
значение, содержащее English и French, будет сгруппировано один раз 
как English;French, а не как части отдельных категорий English и French. 
Дополнительные сведения об использовании нескольких значений см. в 
документе HP Quality Center Administrator Guide:

➤ В списке критериев группирования отображаются только системные 
поля и поля, определенные пользователем, связанные с полем типа 
User List или Lookup List. Дополнительные сведения о типах полей см. в 
документе HP Quality Center Administrator Guide.

➤ Quality Center Выпуск Starter Edition. В выпуске Starter Edition 
доступны не все поля и функциональные возможности. 
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Чтобы сгруппировать записи таблицы, выполните следующие 
действия.

 1 Нажмите требуемую кнопку Set Filter/Sort. Откроется диалоговое окно 
Filter.

 2 Перейдите на вкладку Group.

 3 При работе в модуле Requirements выберите тип требования из списка 
Requirement Type. На вкладке Group будут показаны соответствующие 
имена полей.

При работе в модуле Requirements можно установить флажок Hide Risk-
Based Quality Management Columns, чтобы скрыть поля требования, 
относящиеся к управлению качеством на основе рисков. Снимите флажок, 
чтобы показать эти поля.

 4 Щелкните стрелку Group items by. Выберите поле, по которому 
необходимо сгруппировать записи.
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 5 Чтобы сгруппировать записи по дополнительным полям, нажмите стрелку 
Then by и выберите поле, по которому необходимо сгруппировать записи. 
При группировании записей по нескольким полям выбирайте поля в том 
иерархическом порядке, в котором они должны отображаться. Нельзя 
выбрать уже выбранное поле.

 6 Чтобы удалить уровень группирования, установите значение уровня 
(none). При изменении родительского уровня группирования на (none) 
дочерние уровни группирования автоматически изменятся на (none).

 7 Чтобы скопировать параметры, нажмите кнопку Copy Filter Settings.. 
Дополнительные сведения см. в разделе “Копирование параметров" на 
стр. 75.

 8 Чтобы очистить параметры, нажмите кнопку Clear Filter..

 9 Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter.

Записи таблицы будут сгруппированы в соответствии с параметрами 
группирования.

Обновление нескольких записей
Можно обновлять значение поля в нескольких записях дерева или 
таблицы. Эта возможность доступна в следующих модулях Quality Center: 
Requirements, Test Plan (только таблица) и Defects.

Чтобы обновить несколько записей, выполните следующие действия.

 1 Выберите записи, используя клавишу CTRL или SHIFT.

 2 Выберите команду Edit > Update Selected. Откроется диалоговое окно 
Update Selected.
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 3 В поле Update in Field выберите поле.

 4 В поле Value введите значение для замены.

 5 Нажмите кнопку Update. Откроется диалоговое окно Information с 
указанием количества замененных значений и количества экземпляров, в 
которых значения заменены не были. Нажмите кнопку ОK.

 6 Нажмите кнопку Close, чтобы закрыть диалоговое окно Update Selected.

Копирование параметров
Можно копировать параметры фильтрации, сортировки или группирования 
в буфер обмена и вставлять их из него. Можно копировать эти параметры и 
вставлять их в другой проект. Также можно обмениваться параметрами с 
другим пользователем, вставив их в сообщение электронной почты или 
текстовый файл. 

Чтобы скопировать параметры, выполните следующие действия.

 1 Нажмите требуемую кнопку Set Filter/Sort.. Откроется диалоговое окно 
Filter.

 2 Нажмите кнопку Copy Filter Settings.. Параметры будут скопированы в 
буфер обмена.

 3 Чтобы вставить параметры в другой проект, откройте проект, в который 
необходимо их вставить, перейдите к соответствующему модулю и 
откройте диалоговое окно Filter. Нажмите кнопку Paste Filter Settings. 
Нажмите кнопку ОK.

Чтобы вставить параметры в сообщение электронной почты или текстовый 
файл, нажмите кнопку Paste. 

Обновление и очистка параметров 
Можно обновлять и удалять параметры фильтра, сортировки и 
группирования, примененные к данным Quality Center.

➤ Чтобы обновить данные в таблице или дереве, нажмите кнопкуRefresh All.
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➤ Чтобы очистить все фильтры и приоритеты сортировки в таблице или 
дереве, нажмите стрелку Set Filter/Sort и выберите команду Clear 
Filter/Sort.

Поиск записей
С помощью текстового поиска можно искать записи в предопределенных 
полях модулей Requirements, Test Plan и Defects. Доступные для поиска 
текстовые поля предварительно определяются администратором проекта 
в окне Project Customization. Дополнительные сведения об определении 
доступных для поиска полей см. в документе 
HP Quality Center Administrator Guide.

При вводе ключевого слова Quality Center выполняет поиск этого слова или 
его измененных форм в предопределенных полях. Например, при вводе 
ключевого слова log будут найдены поля, содержащие слова log, logs, 
logging и logged. Слова login или logical найдены не будут, поскольку они не 
являются формами ключевого слова. Дополнительные сведения о функции 
поиска см. в разделе “Что необходимо учитывать при поиске?" на стр. 77.

Если в модуле были определены условия фильтрации, можно ограничить 
поиск только отфильтрованными записями или выполнять поиск во всех 
записях модуля (при этом не требуется очистка текущего фильтра и его 
повторное определение). Если в модуле выбрана папка, поиск все равно 
выполняется во всех записях модуля в соответствии с выбранными 
параметрами фильтра. 

Quality Center отображает результаты поиска в виде списка, 
отсортированного в порядке уменьшения степени соответствия. Можно 
просмотреть результаты поиска и отобразить сведения о записях. Можно 
настроить данные, указав отображаемые столбцы и порядок их 
отображения. 
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Примечания.

➤ Управление версиями. Quality Center выполняет поиск только в 
возвращенных версиях.

➤ Функцию текстового поиска можно использовать только в том случае, 
если она включена в проекте. Если функция поиска недоступна, 
обратитесь к администратору сайта Quality Center.

➤ Quality Center Выпуск Starter Edition. Функция текстового поиска 
недоступна. 

Что необходимо учитывать при поиске?
При использовании функции текстового поиска необходимо учитывать 
следующее.

➤ При поиске пропускаются: артикли (a, an, the); сочинительные союзы 
(and, but, for, nor, or); знаки логических операций (and, or, not, if, or, then).

➤ При вводе нескольких слов результаты поиска будут включать все 
записи, содержащие хотя бы одно искомое слово.

➤ При поиске регистр не учитывается.

➤ Поиск сортирует результаты и отображает их в порядке уменьшения 
степени соответствия.

Для поиска записей выполните следующие действия.

 1 Нажмите кнопку Text Search или выберите команду Edit > Text Search. В 
нижней части окна откроется область поиска. 
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 2 В поле Search for введите слова, которые необходимо найти. При работе в 
модуле Test Plan выполните следующие действия. В поле In выберите 
вариант Tests или Design Steps.

 3 Чтобы выполнить поиск во всех записях модуля, снимите флажок Restrict 
to current filter. 

 4 Нажмите кнопку Search. Quality Center выполнит текстовый поиск в 
предопределенных полях и отобразит результаты в порядке уменьшения 
степени соответствия.

 5 Чтобы изменить размеры и порядок отображения столбцов, нажмите 
кнопку Select Columns. Откроется диалоговое окно Select Columns. 
Дополнительные сведения см. в разделе “Упорядочивание столбцов" на 
стр. 54.

 6 Чтобы просмотреть список предопределенных полей поиска, 
определенных в окне Project Customization, нажмите кнопку Searchable 
Fields Information. Будет показан список предопределенных полей поиска. 
Нажмите кнопку OK, чтобы закрыть список полей, доступных для поиска.

 7 Чтобы отобразить сведения о записи, выберите запись и щелкните ссылку 
ID или Name. Также можно выбрать запись и нажать кнопку Go to Entity.

Примечание. В представлениях дерева Quality Center сведения о записях 
отображаются только в том случае, если запись соответствует текущему 
фильтру. Чтобы отобразить сведения о тех записях, которые не 
соответствуют текущему фильтру, очистите или измените фильтр.
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Экспорт данных в файл 
Можно экспортировать данные из таблицы в текстовый файл, лист 
Microsoft Excel, документ Microsoft Word или документ HTML.

Чтобы экспортировать данные в файл, выполните следующие 
действия.

 1 Можно экспортировать все данные таблицы или выбранные записи.

➤ Чтобы экспортировать все данные таблицы, щелкните таблицу правой 
кнопкой мыши и выберите команду Export > All. Откроется диалоговое 
окно Export All Grid Data.

➤ Чтобы экспортировать отдельные записи таблицы, выберите их с 
помощью клавиш Ctrl или Shift. Щелкните таблицу правой кнопкой 
мыши и выберите команду Export > Selected. Откроется диалоговое 
окно Export Selected Grid Data.

 2 В поле Save in выберите местоположение для сохранения файла.

 3 В поле File name введите имя файла.

 4 В поле Save as type выберите тип файла. 

 5 Нажмите кнопку Save.
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4
Оповещение об изменениях

В Quality Center можно включить автоматическое создание оповещений и 
отправку сообщений электронной почты, чтобы уведомлять ответственных 
лиц при изменениях проекта, которые могут повлиять на процесс 
управления приложением. Также можно добавлять собственные 
оповещения отслеживания.

Эта глава содержит следующие разделы.

 ➤  Об оповещениях об изменениях на стр. 82

 ➤  Понятие об оповещениях на стр. 82

 ➤  Просмотр оповещений на стр. 88

 ➤  Удаление оповещений на стр. 90

 ➤  Установка флажков для отслеживания на стр. 91
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Об оповещениях об изменениях
В процессе тестирования приложений можно отслеживать изменения 
требований, тестов и дефектов. В Quality Center доступны две функции 
оповещения.

➤ Оповещения автоматического уведомления. Администратор проекта 
Quality Center может включать правила оповещения. Правила основаны на 
связях между требованиями, тестами и дефектами Quality Center. При 
изменении объекта в проекте Quality Center оповещает  все связанные 
объекты, на которые может повлиять изменение этого объекта. Эти 
оповещения доступны для просмотра всем пользователям. Quality Center 
также уведомляет ответственных лиц объекта при изменении связанных 
объектов, если эти изменения могут повлиять на объект. Дополнительные 
сведения см. в разделах “Понятие об оповещениях" на стр. 82 и “Просмотр 
оповещений" на стр. 88.

➤ Оповещения отслеживания. Можно установить флажок отслеживания  
для конкретного требования, теста, экземпляра теста или дефекта. Такой 
флажок будет напоминать о необходимости отслеживания события. При 
наступлении даты отслеживания Quality Center отправляет сообщение 
электронной почты. Дополнительные сведения см. в разделе “Установка 
флажков для отслеживания" на стр. 91.

Понятие об оповещениях
При изменении требования, теста или дефекта Quality Center оповещает 
связанные объекты и может уведомлять лиц, ответственных за связанные 
с ним объекты. В Quality Center правила оповещений основаны на 
следующих связях, создаваемых пользователями.

➤ Связь теста в дереве плана тестирования с требованием. Эта связь 
устанавливается путем создания покрытия требований тестами в 
модуле Test Plan или покрытия тестов в модуле Requirements. 
Дополнительные сведения см. в Глава 19, "Покрытие требований и 
покрытие тестами"..
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➤ Связь экземпляра теста с дефектом. Эта связь устанавливается путем 
создания связанных дефектов в модуле Test Plan или добавления 
дефекта во время выполнения ручного теста. Дополнительные сведения 
см. в Глава 36, "Связывание дефектов"..

➤ В модуле Requirements можно создавать связи прослеживаемости между 
требованиями. Дополнительные сведения см. в Глава 14, "Отслеживание 
требований"..

После установления связей в проекте с их помощью можно отслеживать 
изменения. При изменении объекта в проекте Quality Center оповещает все 
связанные с ним объекты, на которые может оказать воздействие это 
изменение. Эти оповещения доступны для просмотра всем пользователям. 
Quality Center также уведомляет ответственных лиц объекта при 
изменении связанных объектов, если эти изменения могут повлиять на 
объект.

Управление версиями. Quality Center оповещает связанные объекты 
только при возврате новой версии. Оповещение указывает, что статус 
версии изменился на Checked In. После этого можно сравнить новую 
версию с предыдущей. Дополнительные сведения о сравнении версий см. 
в разделе “Просмотр истории версий" на стр. 120.
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Администратор проекта Quality Center может включить четыре правила 
оповещений.

Правило Описание
Объекты, 
помечаемые 
флажком

Пользователь, 
уведомляемый по 
электронной почте

1 Оповещение 
связанных тестов 
при изменении 
требования.

Примечание. 
Изменение 
требования — это 
любая его 
модификация, за 
исключением 
изменений в поле 
Direct Cover Status 
и полях управления 
качеством на основе 
рисков.

Тесты, 
покрывающие 
требование.

Разработчик тестов. 

2 Оповещение 
связанных 
экземпляров тестов 
при изменении 
статуса дефекта на 
Fixed.

Экземпляры 
тестов, связанные 
с дефектом.

Тестировщик 
экземпляров тестов.
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Дополнительные сведения о включении правил оповещения в окне Project 
Customization см. в документе HP Quality Center Administrator Guide.

Пример оповещения
Предположим, что используется проект QualityCenter_Demo, основанный 
на приложении Mercury Tours. В окне Project Customization администратор 
проекта включает первое правило: оповещение связанных тестов при 
изменении требования. Администратор проекта также указывает, что 
уведомления должны отправляться по электронной почте.

В модуле Requirements менеджер по контролю качества определяет 
требование Page Download Time (в разделе Application Performance). 

3 Оповещение 
связанных дефектов 
при успешном 
выполнении теста 
(изменение статуса 
на Passed).

Дефекты, 
связанные с 
выполнением 
теста.

Пользователь, 
назначивший 
дефект.

4 Оповещение 
требований, к 
которым 
выполняется 
прослеживание, и 
дочерних 
требований при 
изменении или 
удалении 
требования.

Дочерние 
требования и 
требования, к 
которым 
выполняется 
прослеживание. 

Автор требования.

Правило Описание
Объекты, 
помечаемые 
флажком

Пользователь, 
уведомляемый по 
электронной почте
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Затем в модуле Test Plan менеджер по контролю качества определяет 
новый тест Connect_Site_Stress для этого требования (в разделе Mercury 
Tours Site > Welcome Page). На вкладке Details администратор проекта 
назначает новый тест проектировщику Cecil.
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На вкладке Req Coverage менеджер по контролю качества связывает тест 
Connect_Site_Stress с требованием Page Download Time. 

Тестировщик по контролю качества Mike анализирует требование Page 
Download Time и решает, что 10 секунд на загрузку страницы — это 
слишком много. Он изменяет в описании требования 10 секунд на 7 секунд. 
В результате пользователю Cecil необходимо внести изменения в свой 
тест Connect_Site_Stress таким образом, чтобы он отвечал измененным 
требованиям.
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Если правило включено, при изменении требования пользователем Mike 
Quality Center устанавливает флажок для связанного теста. Этот флажок 
видит проектировщик теста Cecil и все остальные пользователи проекта. 

Если щелкнуть флажок оповещения, откроется диалоговое окно Alerts, 
содержащее сведения об изменении. Дополнительные сведения см. в 
разделе “Просмотр оповещений" на стр. 88. 

Кроме того пользователь Cecil, как проектировщик теста, получает по 
электронной почте автоматическое уведомление Quality Center с 
описанием изменения, внесенного в требование Page Download Time 
пользователем Mike, и рекомендацией проверить связанный тест 
Connect_Site_Stress. Пользователь Cecil щелкает ссылку, чтобы открыть 
окно Quality Center, содержащее указанное требование или тест.

Просмотр оповещений
Можно просматривать список оповещений для выбранного объекта. 
Просмотр оповещений возможен для следующих объектов:

➤ требование в представлении модуля Requirements;

➤ тест в дереве плана тестирования или в таблице Test Grid;

➤ экземпляр теста в таблице Execution Grid;
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➤ дефект в таблице Defects Grid или диалоговом окне Defect Details.

Примечание. Также можно просмотреть список всех оповещений для 
выбранного модуля, установив в диалоговом окне Filter флажок Show 
<объект> with alerts. Дополнительные сведения см. в разделе 
“Расширенная и перекрестная фильтрация записей" на стр. 64.

Дополнительные сведения о создании оповещений в Quality Center см. в 
разделе “Понятие об оповещениях" на стр. 82.

Чтобы просмотреть оповещения, выполните следующие действия.

 1 Выберите объект с оповещением, как описано ниже.

➤ В главном модуле щелкните флажок Alerts  в столбце Alerts дерева 
или таблицы. Если этот столбец не отображается, выберите команду 
View > Indicator Columns. Также можно выбрать команду Edit > Alerts.

➤ В диалоговых окнах Defect Details нажмите кнопку Alerts.

Красный флажок указывает на новое оповещение. Серый флажок 
указывает уже прочитанное оповещение.

Откроется диалоговое окно Alerts.

Quality Center отображает выбранный объект и список оповещений. Чтобы 
выделить элемент в Quality Center, щелкните ссылку в диалоговом окне.
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 2 Чтобы удалить отдельное оповещение, нажмите кнопку Delete Alert или 
нажмите кнопку Clear All, чтобы удалить все оповещения для объекта. 
Нажмите кнопку Yes для подтверждения. Учтите, что можно удалять только 
оповещения, назначенные текущему пользователю или не назначенные ни 
одному из пользователей. Пользователь, которому назначено оповещение, 
— это пользователь, которому при создании оповещения отправляется 
уведомление по электронной почте. Список оповещений и пользователей, 
которым направляются уведомления по электронной почте, см. в разделе 
“Понятие об оповещениях" на стр. 82.

 3 Закройте диалоговое окно Alerts.

Удаление оповещений
В диалоговом окне Alerts можно удалить отдельное оповещение или все 
оповещения для выбранного объекта. Дополнительные сведения о 
диалоговом окне Alerts см. в разделе “Просмотр оповещений" на стр. 88.

Кроме того, можно удалять все оповещения, связанные со всеми 
объектами в модуле Quality Center. При выборе этого варианта будут 
удалены только оповещения, связанные с объектами, соответствующими 
текущему фильтру. Кроме того, можно удалять только оповещения, 
назначенные текущему пользователю, и оповещения, не назначенные ни 
одному из пользователей. Пользователь, которому назначено оповещение, 
— это пользователь, которому при создании оповещения отправляется 
уведомление по электронной почте. Этот пользователь указан в данных 
оповещения в диалоговом окне Alerts. Список оповещений и 
пользователей, которым направляются уведомления по электронной 
почте, см. в разделе “Понятие об оповещениях" на стр. 82.

Чтобы удалить все оповещения в модуле, выполните следующие 
действия.

 1 При работе в модуле Requirement, Test Plan или Defects выберите команду 
Edit > Clear Alerts. При работе в модуле Test Lab выберите команду Tests 
> Clear Alerts.

 2 Нажмите кнопку Yes для подтверждения. Оповещения будут удалены.
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Установка флажков для отслеживания
Quality Center позволяет добавлять к автоматическим уведомлениям об 
отслеживании собственные оповещения. Флажки отслеживания можно 
использовать для напоминания о необходимости отследить определенное 
событие. Например, можно установить флажок отслеживания для дефекта, 
чтобы он напоминал о необходимости проверки статуса через неделю. 

Можно устанавливать флажки отслеживания для следующих объектов:

➤ требование в представлении модуля Requirements;

➤ тест в дереве плана тестирования или в таблице Test Grid;

➤ экземпляр теста в таблице Execution Grid;

➤ дефект в таблице Defects Grid или диалоговом окне Defect Details.

При добавлении флажка Quality Center добавляет к записи значок флажка 
серого цвета . В любой момент можно открыть оповещение об 
отслеживании, чтобы просмотреть нужные сведения. При наступлении 
даты отслеживания Quality Center отправляет сообщение по электронной 
почте и меняет цвет значка флажка на красный.

Для оповещения отслеживания Quality Center также отображает 
информационную панель. Эта панель отображается в правой области 
дерева плана тестирования для отслеживания теста, в диалоговом окне 
Test Instance Properties для отслеживания экземпляра теста и в диалоговом 
окне Defect Details для отслеживания дефекта.

Примечание. Флажок отслеживания связан с конкретным именем 
пользователя. Другие пользователи, просматривающие эту запись, не 
могут видеть флажок отслеживания этого пользователя.

Можно создавать новые оповещения отслеживания и просматривать и 
изменять существующее оповещения.
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Создание оповещений отслеживания
Можно создавать оповещение отслеживания для требования, теста, 
экземпляра теста или дефекта. 

Чтобы создать оповещение отслеживания, выполните следующие 
действия.

 1 Выберите запись, для которой необходимо установить флажок 
отслеживания. Нажмите кнопку Flag for Follow Up или щелкните запись 
правой кнопкой мыши и выберите команду Flag for Follow Up. Откроется 
диалоговое окно Flag For Follow Up. 

 2 В поле Follow up by выберите дату для отправки Quality Center сообщения 
отслеживания по электронной почте 

 3 В поле Description введите напоминание, которое необходимо отобразить.

 4 Нажмите кнопку OK. Quality Center сохранит оповещение отслеживания и 
добавит к записи значок флажка .

Изменение оповещений отслеживания
Можно открыть оповещение отслеживания, созданное для записи. Можно 
просматривать и изменять сведения или удалить отслеживание. 

Чтобы изменить оповещения отслеживания, выполните следующие 
действия.

 1 В дереве или таблице щелкните значок флажка  записи в столбце Follow 
Up Flag. Если этот столбец не отображается, выберите команду View > 
Indicator Columns. Откроется диалоговое окно Flag For Follow Up. 

 2 Чтобы изменить оповещение, измените дату в поле Follow up by или 
описание в поле Description. Чтобы закрыть диалоговое окно, нажмите 
кнопку OK.

 3 Чтобы удалить флажок отслеживания, нажмите кнопку Clear Flag. Нажмите 
кнопку Yes, чтобы подтвердить удаление и закрыть диалоговое окно.
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5
Добавление вложений

Можно добавлять вложения к записям Quality Center.

Эта глава содержит следующие разделы.

 ➤  О добавлении вложений на стр. 94

 ➤  Вложение файла на стр. 95

 ➤  Вложение URL-адреса на стр. 95

 ➤  Вложение снимка на стр. 96

 ➤  Вложение сведений о системе на стр. 98

 ➤  Вложение элементов из буфера обмена на стр. 99

 ➤  Управление вложениями на стр. 99
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О добавлении вложений
Чтобы проиллюстрировать работу, в процессе управления приложением 
можно добавлять вложения. Можно прикладывать файлы, URL-адреса, 
снимки приложения, элементы из буфера обмена или сведения о системе. 
При добавлении вложения к записи Quality Center добавляет к ней значок 

. 

Для управления вложениями используется вкладка или диалоговое окно 
Attachments. 
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Вложение файла 
К записи Quality Center можно приложить файл.

Чтобы приложить файл, выполните следующие действия.

 1 В диалоговом окне Attachments нажмите кнопку File. Откроется диалоговое 
окно Open.

 2 Выберите имя файла и нажмите кнопку Open. Также можно дважды 
щелкнуть имя файла.

Имя файла появится в списке Attachments с указанием размера файла и 
даты его изменения. Рядом с именем файла появится значок приложения, 
связанного с этим файлом.

 3 В поле Description можно ввести комментарии к вложенному файлу.

Вложение URL-адреса 
К записи Quality Center можно приложить URL-адреса. Можно использовать 
любую допустимую схему URL-адресов, например HTTP, FTP, Gopher, 
News, Mailto и File.

Чтобы приложить URL-адрес, выполните следующие действия.

 1 В диалоговом окне Attachments нажмите кнопку URL. Откроется 
диалоговое окно Attach Uniform Resource Locator (URL).

 2 В поле URL введите допустимый URL-адрес и нажмите кнопку OK.

URL-адрес появится в списке Attachments. Рядом с URL-адресом появится 
значок браузера, используемого по умолчанию.

 3 В поле Description можно ввести любые комментарии к вложенному URL-
адресу.
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Вложение снимка 
К записи Quality Center можно приложить снимки приложения.

Чтобы приложить снимок, выполните следующие действия.

 1 В диалоговом окне Attachments нажмите кнопку Snapshot. Откроется 
диалоговое окно Snapshot.

 2 Перетащите значок камеры на объект, снимок которого необходимо 
сделать. Снимок будет показан в диалоговом окне Snapshot.

 3 Можно изменить размер сделанного снимка. 

➤ Для выбора нужного размера изображения нажмите кнопку Zoom Out 
или кнопку Zoom In. 

➤ Чтобы вернуться к стандартному размеру изображения, нажмите кнопку 
Normal.

 4 Нажмите кнопку Attach. 
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Quality Center присвоит изображению уникальное имя файла с 
расширением .jpg. В списке Attachments появится это имя файла со 
значком изображения. Также будет показан размер файла и дата его 
изменения.

 5 В поле Description можно ввести комментарии к вложенному снимку.
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Вложение сведений о системе
К записи Quality Center можно приложить сведения о компьютере.

Чтобы приложить сведения о системе, выполните следующие 
действия.

 1 В диалоговом окне Attachments нажмите кнопку System Info. Откроется 
диалоговое окно System Information.

 2 Чтобы вложить сведения из одной вкладки, выберите вкладку и нажмите 
кнопку Current Topic. 
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 3 Чтобы вложить сведения из всех вкладок, нажмите кнопку All Topics.

Сведениям присваивается уникальное имя файла с расширением .tsi. В 
списке Attachments появляется имя файла со значком. Также будет показан 
размер файла и дата его изменения.

 4 В поле Description можно ввести комментарии к вложенному текстовому 
файлу.

Вложение элементов из буфера обмена 
К записи Quality Center можно приложить текст или изображение, 
скопированное в буфер обмена.

Чтобы приложить элемент из буфера обмена, выполните следующие 
действия.

 1 Скопируйте текст или изображение в буфер обмена.

 2 В диалоговом окне Attachments нажмите кнопку Clipboard.

Тексту будет присвоено уникальное имя файла с расширением .txt. 
Изображению будет присвоено уникальное имя файла с расширением .jpg. 
Вложенный файл со значком появится в списке Attachments. Также будет 
показан размер файла и дата его изменения.

Управление вложениями
На вкладке Attachments и в диалоговом окне Attachments можно 
просматривать, изменять, сохранять и удалять вложения.

Просмотр вложений
Можно просматривать вложения, указанные в списке Attachments.

Чтобы просмотреть вложение, выполните следующие действия.

 1 В списке Attachments выберите вложение. Соответствующее описание 
будет показано в поле Description.
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 2 Дважды щелкните вложение или нажмите кнопку Download and Open. 
Вложение откроется в соответствующем приложении. Например, URL-
адрес открывается в браузере, используемом по умолчанию.

Изменение вложений
Можно изменять вложения, указанные в списке Attachments. При открытии 
вложения в связанном с ним приложении Quality Center загружает 
вложение в локальный каталог на клиентском компьютере. После 
изменения вложения его необходимо сохранить дважды. Сначала 
сохраните вложение на локальном диске в том приложении, с помощью 
которого оно было открыто. Затем в Quality Center нажмите кнопку Upload 
Selected, чтобы сохранить локальную копию вложения в проекте 
Quality Center.

Чтобы изменить вложение, выполните следующие действия.

 1 Дважды щелкните вложение в списке Attachments. Локальная копия 
вложения откроется в связанном с ним приложении. 

 2 Внесите изменения во вложение.

 3 Сохраните вложение в приложении. При этом сохраняется локальная 
копия вложения.

 4 Закройте вложение.

 5 В Quality Center нажмите кнопку Upload Selected в диалоговом окне 
Attachments. Будет сохранена локальная копия вложения в проекте 
Quality Center.

Сохранение вложений
Можно сохранять вложения в локальном каталоге на клиентском 
компьютере.

Чтобы сохранить вложение, выполните следующие действия.

 1 В списке Attachments выберите вложение и нажмите кнопку Save As. 
Откроется диалоговое окно Save Attachment.

 2 В поле Save in выберите местоположение для сохранения файла.

 3 В поле File name введите имя файла.
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 4 Нажмите кнопку Save. Вложение будет загружено и сохранено в локальном 
каталоге на клиентском компьютере.

Удаление вложений
Можно удалять вложения из списка Attachments.

Чтобы удалить вложение, выполните следующие действия.

 1 В списке Attachments выберите вложение, которое необходимо удалить. 
Чтобы выбрать несколько вложений, используйте клавишу CTRL.

 2 Нажмите кнопку Delete Selected, а затем — кнопку Yes для подтверждения 
операции.
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6
Работа с избранными представлениями

Избранное представление — это представление окна Quality Center с 
выбранными пользователем настройками. Можно сохранять избранные 
представления для последующей загрузки.

Эта глава содержит следующие разделы.

 ➤  О работе с избранными представлениями на стр. 103

 ➤  Добавление избранных представлений на стр. 104

 ➤  Загрузка избранных представлений на стр. 105

 ➤  Обновление избранных представлений на стр. 106

 ➤  Упорядочивание избранных представлений на стр. 107

О работе с избранными представлениями
Вид окна Quality Center можно изменять путем выбора определенных 
настроек. Например, эти настройки могут включать фильтры для столбцов 
таблицы или сортировку полей в таблице. Можно сохранить избранное 
представление для последующего использования и загружать его по мере 
необходимости.

Избранные представления можно сохранять в личной или общей папке. 
Представления из общей папки Public доступны всем пользователям. 
Представления из личной папки Private доступны только пользователям, 
создавшим их. 
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Некоторые команды, связанные с избранными представлениями, доступны 
только определенным группам пользователей. Дополнительные сведения 
о привилегиях групп пользователей см. в документе 
HP Quality Center Administrator Guide.

Примечание. Порядок работы с избранными представлениями в 
приложении Document Generator отличается от описанного в этой главе. 

В приложении Document Generator используйте кнопку Add to Favorites, 
чтобы добавить новое представление, и кнопку Favorites, чтобы 
упорядочить представления.

Добавление избранных представлений 
Представления можно добавлять в личную или общую папку.

Чтобы добавить избранное представление, выполните следующие 
действия.

 1 Выберите команду Favorites > Add to Favorites. Откроется диалоговое 
окно Add Favorite.
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 2 В поле Name введите имя представления.

 3 В разделе Location выберите один из следующих вариантов. 

➤ Выберите вариант Private, чтобы добавить представление в личную 
папку. Избранные представления из этой папки доступны только 
создавшему их пользователю. 

➤ Выберите вариант Public, чтобы добавить представление в общую 
папку. Избранные представления из этой папки доступны всем 
пользователям проекта.

Избранные представления в выбранной папке будут показаны в списке 
Existing Favorites.

 4 Нажмите кнопку ОK. Новое представление будет добавлено в личную или 
общую папку.

Загрузка избранных представлений
Можно загрузить существующее представление в окне Quality Center.

Чтобы загрузить избранное представление, выполните следующие 
действия.

➤ Чтобы загрузить недавно использовавшееся представление, откройте 
меню Favorites и выберите нужное представление.

Примечание. По умолчанию в меню Favorites Quality Center отображаются 
четыре недавно использовавшихся представления. Определить 
количество отображаемых в меню представлений можно с помощью 
параметра FAVORITES_DEPTH вкладки Site Configuration в модуле Site 
Administration. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ Чтобы загрузить избранное представление, выберите команду Favorites > 
Private или Favorites > Public и щелкните нужное представление.
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Также можно выбрать представление на панели Favorite панели 
инструментов модуля. По умолчанию панель Favorite не отображается. 
Чтобы отобразить эту панель, выберите команду View > Favorite Bar. 
Панель Favorite доступна только в табличных представлениях 
Quality Center.

Обновление избранных представлений
Можно обновить настройки существующего избранного представления.

Чтобы обновить избранное представление, выполните следующие 
действия.

 1 Загрузите избранное представление из меню Favorites. Дополнительные 
сведения см. в разделе “Загрузка избранных представлений" на стр. 105.

 2 Внесите изменения в представление.

 3 Выберите команду Favorites > Add to Favorites. Откроется диалоговое 
окно Add Favorite.

 4 В списке Existing Favorites выберите имя нужного представления и 
нажмите кнопку OK.

 5 Нажмите кнопку Yes, чтобы заменить предыдущие настройки.
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Упорядочивание избранных представлений
Упорядочить список избранных представлений в личной и общей папке 
можно, изменяя свойства представлений или удаляя представления.

Чтобы упорядочить избранные представления, выполните 
следующие действия.

 1 Выберите команду Favorites > Organize Favorites. Откроется диалоговое 
окно Organize Favorites.

 2 Чтобы изменить свойства представления, выберите представление из 
списка и нажмите кнопку Properties. Откроется диалоговое окно Properties.

 3 В поле Name введите новое имя представления. 

 4 В разделе Location: выберите один из следующих вариантов.

➤ Вариант Private, чтобы добавить имя представления в личную папку. 
Доступ к этому представлению имеет только создавший его 
пользователь.
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➤ Вариант Public, чтобы добавить имя представления в общую папку. 
Доступ к этой папке имеют все пользователи.

 5 Нажмите кнопку OK, чтобы сохранить свойства представления. Нажмите 
кнопку Yes для подтверждения.

 6 Чтобы удалить избранное представление, выберите его из списка и 
нажмите кнопку Delete. Для подтверждения нажмите кнопку OK.

 7 Нажмите кнопку Close, чтобы закрыть диалоговое окно Organize Favorites.
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7
Работа с функциями управления 
версиями

Управление версиями позволяет отслеживать изменения объектов в 
проекте, включая изменения требований, тестов, ресурсов тестов и 
бизнес-компонентов.

Эта глава содержит следующие разделы.

 ➤  О работе с функциями управления версиями на стр. 109

 ➤  Обзор управления версиями на стр. 110

 ➤  Изъятие объектов на стр. 115

 ➤  Возврат объектов на стр. 117

 ➤  Отмена изъятия на стр. 118

 ➤  Просмотр изъятых объектов на стр. 119

 ➤  Просмотр истории версий на стр. 120

 ➤  Фильтрация полей управления версиями на стр. 123

О работе с функциями управления версиями
В проекте с включенными функциями управления версиями можно 
создавать объекты Quality Center и управлять ими, сохраняя предыдущие 
версии этих объектов. К этим объектам относятся требования, тесты, 
ресурсы тестов и бизнес-компоненты. Дополнительные сведения о работе 
с бизнес-компонентами в проекте с включенными функциями управления 
версиями см. в HP Business Process Testing User Guide.
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Для изменения объекта выполняется его изъятие. После этого 
выполняется возврат объекта для сохранения изменений и 
предоставления доступа к новой версии другим пользователям. Можно 
просматривать и сравнивать предыдущие версии объекта, а также изымать 
предыдущую версию.

Дополнительные сведения о включении управления версиями для проекта 
см. в документе HP Quality Center Administrator Guide.

Обзор управления версиями
Чтобы вносить изменения в объект проекта с включенным управлением 
версиями, необходимо сначала изъять нужный объект. При изъятии 
объекта Quality Center блокирует этот объект, не позволяя другим 
пользователям перезаписывать сделанные изменения. Изъятая версия 
объекта невидима для других пользователей. Дополнительные сведения 
см. в разделе “Изъятие объектов" на стр. 115.

После завершения внесения изменений выполняется возврат объекта. 
После этого новая версия объекта становится доступной другим 
пользователям. Дополнительные сведения см. в разделе “Возврат 
объектов" на стр. 117.

По умолчанию для нового объекта используется номер версии 1. До версии 
Quality Center 10.00 номера версий состояли из трех сегментов, 
разделенных точками, например 1.7.4. Начиная с версии Quality Center 
10.00 номера версий состоят из одного сегмента, например 12. При 
возврате объекта номер версии увеличивается на единицу.

После изъятия объекта можно отменить изъятие, чтобы отменить 
сделанные изменения. Дополнительные сведения см. в разделе “Отмена 
изъятия" на стр. 118.

Можно просматривать все предыдущие версии объекта; также можно 
изъять предыдущую версию. Можно также сравнивать две версии объекта, 
чтобы просмотреть изменения между версиями. Дополнительные сведения 
о просмотре предыдущих версий объекта см. в разделе “Просмотр истории 
версий" на стр. 120.
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Примечание. Для обеспечения удобства использования и сохранения 
целостности данных в Quality Center сохраняются предыдущие версии 
объектов без большинства данных, связанных с взаимовзаимосвязями 
между объектами. Для предыдущих версий не сохраняются следующие 
данные: покрытие требований и тестов, прослеживаемость требований и 
связи дефектов. Кроме того, для предыдущих версий объекта также не 
сохраняются данные рисков.

Можно просматривать список всех объектов, изъятых из проекта. 
Дополнительные сведения см. в разделе “Просмотр изъятых объектов" на 
стр. 119.

В проекте с включенным управлением версиями можно создавать объекты 
и управлять ими как в представлениях дерева, так и в табличных 
представлениях. В представлении дерева объект, изъятый текущим 
пользователем, будет отмечен значком в виде замка зеленого цвета . 
Объект, изъятый другим пользователем, будет отмечен значком замка 
красного цвета . Табличные представления содержат дополнительные 
поля управления версиями, такие как поле Version Status, в котором 
указан статус изъятия или возврата объекта.
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В приведенной ниже таблице представлены дополнительные сведения о 
работе с функциями управления версиями в модулях Quality Center.

Модуль Создание нового 
объекта

Поля управления 
версиями

Requirements При создании нового 
требования в Quality 
Center выполняется 
автоматическое изъятие 
требования.

Модуль Requirements 
содержит 
дополнительные поля 
управления версиями. 
Дополнительные 
сведения см. в разделе 
“Поля модуля 
Requirements" на 
стр. 186.

Test Plan При создании нового 
теста предоставляется 
возможность его 
немедленного изъятия. 
Дополнительные 
сведения см. в разделе 
“Добавление теста к 
дереву плана 
тестирования" на 
стр. 294.

Модуль Test Plan 
содержит 
дополнительные поля 
управления версиями. 
Дополнительные 
сведения см. в разделе 
“Столбцы таблицы 
тестов" на стр. 285.
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На основе полей управления версиями можно определять фильтры. 
Дополнительные сведения см. в разделе “Фильтрация полей управления 
версиями" на стр. 123.

На панелях инструментов модулей Requirements, Test Plan и Test 
Resources отображаются следующие дополнительные кнопки для изъятия 
и возврата объектов.

➤ Check Out. Открывается диалоговое окно Check Out, позволяющее 
изъять выбранный объект.

➤ Check In. Открывается диалоговое окно Check In, позволяющее 
возвратить выбранный объект.

Test Resources При создании нового 
ресурса теста в Quality 
Center выполняется 
автоматическое изъятие 
ресурса.

Модуль Test Resources 
содержит 
дополнительные поля 
управления версиями. 
Дополнительные 
сведения см. в разделе 
“Обновление сведений 
ресурсов и папок" на 
стр. 380.

Test Lab Неприменимо В диалоговом окне Test 
Instance Properties поле 
Run VC Version 
указывает номер версии 
теста. В этой версии 
Quality Center не 
используются 
следующие поля:  Run 
VC Status и Run VC 
User.

Модуль Создание нового 
объекта

Поля управления 
версиями
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Поля, исключенные из управления версиями
Изменения следующих полей не сохраняются в системе управления 
версиями.

➤ Поля требований: Reviewed, Direct Cover Status, Target Release, Target 
Cycle и все поля RBQM.

➤ Поля теста: Execution Status.

При работе с полями, исключенными из управления версиями, в проекте с 
включенным управлением версиями необходимо учитывать следующее.

➤ При отмене изъятия все изменения полей, исключенных из управления 
версиями, не отменяются, и сохраняются новые значения.

➤ При изъятии предыдущей версии в поле, исключенном из управления 
версиями, используется значение из текущей возвращенной версии.

➤ При просмотре и сравнении предыдущих версий объекта в полях, 
исключенных из управления версиями, отображается значение 
Non-versioned Field.

Примеры управления версиями
В следующих примерах показано, как можно использовать управление 
версиями.

➤ Мониторинг изменений и сравнение версий.

Менеджер продукта обнаруживает, что разработка продукта реализуется с 
отличиями от его ожиданий. Он анализирует требования к продукту и 
обнаруживает, что некоторые требования были изменены. Он сравнивает 
текущие требования с версиями требований, которые были согласованы в 
начале работы над релизом.
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➤ Восстановление прежней версии.

Тестировщик получает новую сборку разрабатываемого банковского 
приложения. Он приступает к обновлению соответствующих тестов в 
соответствии с требованиями нового релиза. После этого группа 
разработки отправляет уведомление о наличии существенной проблемы в 
сборке. Группа разработки выполняет откат к предыдущей сборке. 
Тестировщик принимает решение выполнить изъятие и вернуться к 
прежним версиям тестов, которые использовались для предыдущей 
сборки, чтобы продолжить тестирование из предыдущего состояния.

➤ Блокировка объектов для изменения.

Бизнес-аналитику необходимо обновить определенные функциональные 
возможности приложения. Для этого ему требуется обновить набор 
требований. Ему требуется несколько дней для обновления требований, и 
в это время никто другой не должен вносить изменения в требования. Он 
выполняет изъятие необходимых требований и приступает к внесению 
изменений.

Изъятие объектов
Для изменения объектов в проекте с включенным управлением версиями 
необходимо изъять объект. При изъятии объекта Quality Center блокирует 
этот объект, не позволяя другим пользователям перезаписывать 
сделанные изменения. Изъятая версия объекта невидима для других 
пользователей.

Существуют следующие способы изъятия объектов.

➤ Автоматическое изъятие объектов

➤ Изъятие объектов вручную
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Автоматическое изъятие объектов
Когда пользователь приступает к изменению объекта в проекте с 
включенным управлением версиями, Quality Center автоматически 
выполняет изъятие объекта.

Чтобы изъять объект автоматически, выполните следующие 
действия.

 1 Выберите объект и приступите к внесению изменений. Открывается 
диалоговое окно Check Out.

 2 В поле Change Comments введите краткое описание причины изъятия.

 3 Установите флажок Don’t show this again, чтобы включить автоматическое 
изъятие изменяемых объектов Quality Center без запроса подтверждения.

Чтобы включить вывод запроса подтверждения в Quality Center перед 
автоматическим изъятием объектов, в строке меню выберите команду 
Versions > Warn Before Check Out.

 4 Нажмите кнопку ОK. В представлении дерева объект будет отмечен 
значком замка , указывающим на то, что объект изъят.

Изъятие объектов вручную
В проекте с включенным управлением версиями можно изъять один или 
несколько объектов для изменения.

Чтобы изъять объект вручную, выполните следующие действия.

 1 Выберите объект, который нужно изъять. Чтобы изъять несколько 
объектов, нажмите клавишу CTRL и выберите объекты.
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 2 Нажмите кнопку Check Out или выберите команду Versions > Check Out. 
Также можно щелкнуть объект правой кнопкой мыши и выбрать команду 
Versions > Check Out. Откроется диалоговое окно Check Out.

 3 В поле Change Comments введите краткое описание причины изъятия.

 4 Нажмите кнопку ОK. В представлении дерева объект будет отмечен 
значком замка , указывающим на то, что объект изъят.

Возврат объектов
После изменения объекта следует выполнить его возврат. При каждом 
возврате объекта создается новая версия. Пусть, например, текущая 
версия требования имеет номер 3. Выполнено изъятие требования и 
требование изменено. При возврате требования Quality Center определяет 
это требование как версию с номером 4. При возврате объекта он 
разблокируется и становится доступным всем пользователям.

Также можно просматривать список объектов, изъятых в текущем модуле. 
Дополнительные сведения см. в разделе “Просмотр изъятых объектов" на 
стр. 119.

Чтобы возвратить объект, выполните следующие действия.

 1 Выберите объект, который необходимо возвратить. Чтобы возвратить 
несколько объектов, нажмите клавишу CTRL и выберите объекты.
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 2 Нажмите кнопку Check In или выберите команду Versions > Check In. 
Также можно щелкнуть объект правой кнопкой мыши и выбрать команду 
Versions > Check In. Откроется диалоговое окно Check In.

 3 В поле Change Comments введите краткое описание изменений, 
сделанных в данной версии.

 4 Установите флажок Keep checked out, чтобы сохранить изменения с 
новым номером версии и оставить объект изъятым.

 5 Нажмите кнопку ОK.

Отмена изъятия
После изъятия объекта можно отменить изъятие, чтобы отменить 
сделанные изменения. Чтобы отменять изъятие объектов другими 
пользователями, необходимы соответствующие разрешения 
пользователя. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

При отмене изъятия все изменения полей, исключенных из управления 
версиями, не отменяются, и сохраняются новые значения. 
Дополнительные сведения см. в разделе “Поля, исключенные из 
управления версиями" на стр. 114.

Можно просматривать список всех объектов, изъятых в текущем модуле. 
Дополнительные сведения см. в разделе “Просмотр изъятых объектов" на 
стр. 119.
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Чтобы отменить изъятие, выполните следующие действия.

 1 Выберите объект или нажмите клавишу CTRL и выберите несколько 
объектов, изъятие которых необходимо отменить.

 2 Выберите команду Versions > Undo Check Out или щелкните объект 
правой кнопкой мыши и выберите команду Versions > Undo Check Out.

 3 Нажмите кнопку Yes для подтверждения.

Просмотр изъятых объектов
Можно просматривать список всех изъятых объектов в текущем модуле и 
возвращать выбранные объекты или отменять их изъятие.

Чтобы просмотреть изъятые объекты, выполните следующие 
действия.

 1 Выберите команду Versions > Pending Check In или нажмите кнопку Check 
In на правой стороне панели инструментов модуля. Откроется диалоговое 
окно Pending Check In, в котором будет показан список всех объектов, 
изъятых текущим пользователем в текущем модуле.
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Можно изменить порядок отображения столбцов, перетаскивая их 
заголовки.

 2 Чтобы вернуть объект, выберите объект в списке или нажмите клавишу 
CTRL и выберите несколько объектов. Нажмите кнопку Check In. 
Дополнительные сведения см. в разделе “Возврат объектов" на стр. 117.

 3 Чтобы отменить изъятие, выберите объект в списке или нажмите клавишу 
CTRL и выберите несколько объектов. Нажмите кнопку Undo Check Out. 
Дополнительные сведения см. в разделе “Отмена изъятия" на стр. 118.

Просмотр истории версий
Можно просматривать историю версий для выбранного объекта, включая 
все предыдущие версии, имена пользователей, создавших различные 
версии, и даты создания каждой версии. Также можно сравнить две версии 
или изъять предыдущую версию.

Можно также просмотреть базовое состояние, в котором хранится версия. 
Дополнительные сведения см. в разделе “Просмотр истории изменения 
базового состояния" на стр. 578.



Глава 7 • Работа с функциями управления версиями

121

Чтобы просмотреть историю версий, выполните следующие 
действия.

 1 Выберите объект и перейдите на вкладку History. Будет показана история 
версий выбранного объекта.

 2 На вкладке Versions and Baselines в поле View by выберите вариант 
Versions. История версий объекта будет показана в виде таблицы.

Столбец Описание

Version Номер версии. Если объект в настоящее время 
изъят, в столбце Version будет показано значение 
Checked out для изъятой версии.

Date Дата создания версии.

Modified By Имя пользователя, создавшего версию.

Baseline Базовое состояние, в котором появилась данная 
версия.
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 3 В разделе Comment for selected version можно просмотреть комментарии, 
введенные пользователем при возврате версии.

 4 Чтобы просмотреть сведения о предыдущей версии, выберите версию и 
нажмите кнопку View. Откроется диалоговое окно Details, в котором будут 
показаны сведения о версии в режиме «только чтение». Можно, например, 
просмотреть сведения о предыдущей версии теста.

Нажмите кнопку на боковой панели, чтобы просмотреть дополнительные 
сведения о версии, такие как Design Steps, Test Script и Attachments. 
Доступные кнопки определяются данными, которые хранятся в системе 
управления версиями для определенного типа объекта.

Изменения некоторых полей не сохраняются в системе управления 
версиями. Дополнительные сведения см. в разделе “Поля, исключенные из 
управления версиями" на стр. 114.

Нажмите кнопку Close, чтобы закрыть диалоговое окно Details.

 5 Чтобы сравнить две версии, нажмите клавишу CTRL и выберите обе версии. 
Нажмите кнопку Compare. Дополнительные сведения о сравнении версий 
объектов см. в разделе “Сравнение объектов" на стр. 583.
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 6 Чтобы изъять предыдущую версию, выберите версию и нажмите кнопку 
Check Out. Дополнительные сведения о процессе изъятия см. в разделе 
“Изъятие объектов" на стр. 115.

Примечание. Для обеспечения удобства использования и сохранения 
целостности данных в Quality Center сохраняются предыдущие версии 
объектов без большинства данных, связанных с взаимовзаимосвязями 
между объектами. Для предыдущих версий не сохраняются следующие 
данные: покрытие требований и тестов, прослеживаемость требований и 
связи дефектов. Кроме того, для предыдущих версий объекта также не 
сохраняются данные рисков.

Откроется диалоговое окно Confirm. Нажмите кнопку Yes для 
подтверждения.

Фильтрация полей управления версиями
Можно фильтровать данные Quality Center на основе полей управления 
версиями в модулях Requirements, Test Plan, Test Resources и Test Lab. 
Дополнительные сведения об определении фильтров см. в разделе 
“Фильтрация записей" на стр. 59.
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Порядок определения фильтра для отображения только изъятых объектов 
изменяется в зависимости от текущего модуля Quality Center. В 
приведенной ниже таблице описано определение условий фильтрации.

Дополнительные сведения об управлении версиями см. в разделе “Обзор 
управления версиями" на стр. 110.

Описание 
фильтра

Условия фильтрации 
для модуля Test Plan

Условия фильтрации 
для всех остальных 
модулей

Отображение 
всех объектов, 
изъятых 
текущим 
пользователем

Version Status=Checked 
Out and Version 
Owner=<имя текущего 
пользователя>

Version Checked Out 
By=<имя текущего 
пользователя>

Отображение 
всех объектов, 
изъятых другим 
пользователем

Version Status=Checked 
Out and Version 
Owner=<имя другого 
пользователя>

Version Checked Out 
By=<имя другого 
пользователя>



Часть II
Управление релизами
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8
Рабочий процесс управления релизами

Процесс управления приложением начинается с определения дерева 
релизов в модуле Releases. 

Quality Center Выпуски. Модуль Releases доступен в выпусках 
Quality Center Enterprise Edition и Quality Center Premier Edition.
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В этой главе описано использование Quality Center для управления 
жизненным циклом релиза. Рабочий процесс управления релизами 
включает следующие стадии.

Определение версий 
и циклов

Назначение 
требований

Назначение и 
выполнение наборов 

тестов

Назначение 
дефектов

Анализ версий и 
циклов
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Определение релизов и циклов
Основным компонентом модуля Releases является дерево релизов. Это 
дерево позволяет моделировать предстоящие релизы в иерархической 
структуре дерева. 

В начале работы выполняется определение папки релизов и 
содержащихся в ней релизов. Релиз представляет собой группу 
изменений, внесенных в одно или несколько приложений и доступных для 
одновременного распространения. После определения релизов 
выполняется определение циклов. Цикл представляет собой 
последовательность действий по разработке и контролю качества для 
достижения общей цели на основе временных рамок релиза.

Предположим, необходимо определить предстоящие релизы приложения 
Mercury Tours, используемого в качестве примера. Папка Mercury Tours 
Application содержит релиз Release 10.5. Этот релиз включает четыре 
цикла. Можно определить релизы и циклы в дереве релизов следующим 
образом.

Дополнительные сведения об определении релизов см. в Глава 10, 
"Создание дерева релизов"..
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Назначение требований
После определения дерева релизов выполняется определение и анализ 
требований в модуле Requirements, после чего требования назначаются 
релизам и циклам. Требования подробно описывают потребности 
приложения. 

Например, в дереве требований в папке Mercury Tours Application можно 
назначить требования Booking System и Application Security циклу Cycle 
1 - New Features релиза Release 10.5.

На основе требований составляется план тестирования в модуле Test Plan. 
Тесты, созданные на этапе разработки плана тестирования, должны 
покрывать эти требования. 

Дополнительные сведения о требованиях см. в Глава 13, "Создание дерева 
требований"..

Дополнительные сведения о планах тестирования см. в Глава 18, 
"Создание дерева плана тестирования".. Дополнительные сведения о 
покрытии требований тестами см. в Глава 19, "Покрытие требований и 
покрытие тестами"..
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Назначение и выполнение наборов тестов
После назначения требований релизам и циклам каждая папка наборов 
тестов в модуле Test Lab назначается циклу. Набор тестов представляет 
собой группу экземпляров тестов в проекте Quality Center, 
предназначенных для решения конкретных задач тестирования.

Например, в дереве наборов тестов релиза Release 10.5 можно 
определить следующие папки наборов тестов.

Каждая папка наборов тестов назначается циклу. Например, папка наборов 
тестов Cycle 1 назначена циклу Cycle 1 - New Features. 

После назначения папок наборов тестов циклу выполняются наборы 
тестов, расположенные в этих папках. 

Дополнительные сведения о наборах тестов см. в Глава 28, "Создание 
наборов тестов".. Дополнительные сведения о выполнении тестов см. в 
Глава 30, "Выполнение тестов вручную" и Глава 31, "Автоматическое 
выполнение тестов"..
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Назначение дефектов
Если во время выполнения набора тестов обнаруживается ошибка в 
приложении, можно создать дефект. Quality Center автоматически создает 
связь между выполнением теста, соответствующим релизом и циклом, и 
новым дефектом. 

Предположим, дефект был обнаружен во время выполнения экземпляра 
теста из набора тестов в папке Cycle 1. При первоначальном добавлении 
дефекта в проект поле Detected in Release назначается релизу Release 
10.5, а поле Detected in Cycle — циклу Cycle 1 - New Features. 

В процессе анализа и определения новых дефектов, требующих 
устранения, можно назначить эти дефекты соответствующему целевому 
релизу и циклу. 

Продолжая рассмотрение примера, предположим, что устранение дефекта 
запланировано в следующем цикле. Поле Target Release будет назначено 
релизу Release 10.5, а поле Target Cycle — циклу Cycle 2 - New Features + 
Regression. 

Дефект можно добавить в проект Quality Center из любого модуля на любой 
стадии процесса управления приложением.

Дополнительные сведения о документировании дефектов см. в Глава 35, 
"Добавление и отслеживание дефектов"..

Анализ релизов и циклов
После выполнения тестов можно проанализировать ход тестирования, 
чтобы определить его соответствие целям релиза. Также можно 
определить, сколько дефектов было устранено, а сколько осталось 
открытыми. Результаты можно проанализировать на уровне релиза или 
цикла. 

Можно отслеживать ход выполнения процесса управления приложением в 
реальном времени путем анализа дерева релизов и обеспечения его 
соответствия целям релиза. Дополнительные сведения об анализе 
результатов на уровне релиза или на уровне цикла см. в Глава 10, 
"Создание дерева релизов"..
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9
Краткий обзор модуля Releases

В этой главе приведен краткий обзор основных элементов модуля 
Releases.

Quality Center Выпуски. Модуль Releases доступен в выпусках 
Quality Center Enterprise Edition и Quality Center Premier Edition.

Эта глава содержит следующие разделы.

 ➤  Модуль Releases на стр. 134

 ➤  Строка меню Releases на стр. 135

 ➤  Панель инструментов Releases на стр. 135

 ➤  Поля релизов и циклов на стр. 136
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Модуль Releases
Модуль Releases используется для определения релизов и циклов в 
Quality Center. Чтобы открыть этот модуль, нажмите кнопку Management на 
боковой панели, а затем выберите вкладку Releases.

Модуль Releases содержит следующие основные элементы.

➤ Строка меню модуля Releases. Содержит раскрывающиеся меню с 
командами модуля Releases. 

➤ Панель инструментов модуля Releases. Содержит кнопки вызова команд 
модуля Releases. 

➤ Вкладка Details. Описание папки релизов, релиза или цикла, выбранных в 
настоящий момент в дереве релизов. Также указывает диапазон дат 
релизов и циклов. В области Statistics показаны требования и папки 
наборов тестов, связанные с релизом или циклом.

➤ Вкладка Attachments. Содержит перечень вложений, содержащих 
дополнительные сведения о текущей выбранной папке релизов, релизе 
или цикле. Дополнительные сведения см. в Глава 5, "Добавление 
вложений".
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➤ Вкладка Progress. Содержит краткий обзор процесса работы в рамках 
релиза или цикла. Дополнительные сведения см. в разделе “Просмотр хода 
выполнения тестирования релизов и циклов" на стр. 150.

➤ Вкладка Quality. Отображает количество дефектов, обнаруженных в 
процессе создания релиза или цикла. На этой вкладке также показано 
количество необработанных дефектов. Дополнительные сведения см. в 
разделе “Просмотр дефектов в релизах и циклах" на стр. 154.

Строка меню Releases 
Строка меню Releases содержит следующие меню.

➤ Меню Releases содержит команды, позволяющие добавлять папки 
релизов, релизы и циклы. 

➤ Меню Edit содержит команды, позволяющие вырезать, вставлять, удалять 
и переименовывать папки релизов, релизы и циклы. Это меню также 
содержит команду для создания копии цикла.

➤ Меню View содержит команды, позволяющие развернуть и свернуть 
дерево релизов. Это меню также содержит команду для обновления 
дерева релизов.

Панель инструментов Releases 
Панель инструментов модуля Releases содержит следующие кнопки.

New Release Folder. Добавление новой папки релизов в дерево релизов. 

New Release. Добавление нового релиза в дерево релизов. 

New Cycle. Добавление нового цикла в дерево релизов.

Cut. Вырезает папку релизов или релиз из дерева релизов для 
перемещения в другое местоположение в дереве.

Paste. Вставка вырезанной папки релизов или релиза в указанное 
местоположение в дереве.
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Duplicate Cycle. Создание копии цикла в том же релизе.

Delete. Удаление выбранного элемента. При удалении папки релизов 
также удаляются релизы и циклы, находящиеся в этой папке. При удалении 
релиза также удаляются его циклы.

Refresh All. Обновление дерева и вкладок релизов для отображения 
самых последних данных.

Поля релизов и циклов 
На вкладке Details модуля Releases могут быть показаны следующие поля.

Поле Описание

Name Имя папки релизов, релиза или цикла.

Start Date Дата начала работы над релизом или циклом. Нажмите 
стрелку «Вниз», чтобы отобразить календарь и выбрать дату 
начала.

End Date Дата завершения работы над релизом или циклом. Нажмите 
стрелку «Вниз», чтобы отобразить календарь и выбрать дату 
завершения.

Release ID Уникальный числовой идентификатор релиза, автоматически 
назначенный в среде Quality Center. Идентификатор релиза 
доступен только для чтения. 

Cycle ID Уникальный числовой идентификатор цикла, автоматически 
назначенный в среде Quality Center. Идентификатор цикла 
доступен только для чтения. 

Statistics Статистические данные о требованиях и папках наборов 
тестов, назначенных релизам и циклам.

Description Описание папки релизов, релиза или цикла.
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Примечания. 

➤ Диапазон дат для циклов должен находиться в пределах диапазона дат 
работы над релизом.

➤ В модуле Releases можно добавлять поля, определенные 
пользователем, а также изменять заголовки любых полей. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ Для ограничения и динамического изменения полей и значений модуля 
Releases можно использовать редактор Script Editor. Дополнительные 
сведения см. в документе HP Quality Center Administrator Guide.
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10 
Создание дерева релизов

Зачастую процесс создания релизов приложения является весьма 
сложным. Требования, тесты и дефекты, содержащиеся в проекте, должны 
быть определены в соответствии с бизнес-приоритетами и требованиями к 
качеству приложения. Большинство приложений требуют тестирования на 
различных аппаратных платформах с использованием разных 
конфигураций (компьютеров, операционных систем и браузеров) и 
различных версий приложений. Управление всеми аспектами создания 
релиза приложения может потребовать много времени и усилий. В модуле 
Releases можно организовывать и отслеживать предстоящие релизы путем 
определения дерева релизов.

Quality Center Выпуски. Модуль Releases доступен в выпусках 
Quality Center Enterprise Edition и Quality Center Premier Edition.

Эта глава содержит следующие разделы.

 ➤  О создании дерева релизов на стр. 140

 ➤  Создание дерева релизов на стр. 146

 ➤  Добавление релизов в папки релизов на стр. 146

 ➤  Добавление циклов к релизам на стр. 147

 ➤  Просмотр назначенных требований и папок наборов тестов на стр. 149

 ➤  Просмотр хода выполнения тестирования релизов и циклов на стр. 150

 ➤  Просмотр дефектов в релизах и циклах на стр. 154

 ➤  Изменение дерева релизов на стр. 157
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О создании дерева релизов 
В модуле Releases можно организовывать и отслеживать предстоящие 
релизы путем определения иерархического дерева релизов, содержащего 
релизы и циклы. Релиз представляет собой группу изменений, внесенных в 
одно или несколько приложений и доступных для одновременного 
распространения. Каждый релиз может содержать несколько циклов. Цикл 
представляет собой цикл разработки и контроля качества на основе 
временных рамок проекта. Как релизы, так и циклы имеют заданные даты 
начала и завершения работы над ними.

После определения дерева релизов определяются требования в модуле 
Requirements, которые назначаются релизам и циклам (см. Глава 13, 
"Создание дерева требований"). Требования содержат подробное описание 
того, что необходимо протестировать в приложении.

Для покрытия требований тестами (чтобы убедиться, что все компоненты, 
разработанные в конкретном цикле, полностью протестированы) 
создаются тесты в модуле Test Plan (см. Глава 18, "Создание дерева плана 
тестирования" и Глава 19, "Покрытие требований и покрытие тестами").

Затем в модуле Test Lab создается папка наборов тестов, в которой будут 
храниться наборы тестов. Затем папка наборов тестов назначается циклу. 
Далее наборы тестов добавляются в созданную папку наборов тестов. И 
наконец, для завершения планирования покрытия тестами, тесты 
добавляются в каждый набор (см. Глава 28, "Создание наборов тестов").

После этого выполняются созданные наборы тестов (см. Глава 30, 
"Выполнение тестов вручную", и Глава 31, "Автоматическое выполнение 
тестов"). При обнаружении ошибок в приложении можно регистрировать 
дефекты в проекте путем назначения их конкретному релизу и циклу в 
дереве релизов (см. Глава 35, "Добавление и отслеживание дефектов"). 
Это позволит всем разработчикам и тестировщикам соответствующих 
компонентов определить, какие дефекты необходимо устранить, а также 
срок устранения каждого дефекта. 

После выполнения указанных наборов тестов можно проанализировать ход 
работы над релизом в модуле Releases, чтобы определить степень 
соответствия целям релиза. Также можно определить количество 
обнаруженных дефектов и необработанных дефектов. Результаты 
тестирования можно анализировать на уровне релиза или цикла.
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Пример управления релизами
Предположим, что выполняется разработка приложения бронирования 
авиабилетов. Релиз версии 10.5 планируется через четыре месяца. Этот 
релиз включает четыре цикла. Первый цикл заключается в тестировании 
новых функций. Второй цикл предназначен для регрессионного 
тестирования. В третьем цикле выполняется тестирование 
работоспособности релиза. В четвертом цикле проверяются все 
функциональные возможности приложения. Дерево релизов можно 
определить следующим образом.

В модуле Requirements следует определить, какие требования необходимо 
покрыть тестами в каждом цикле, и назначить их соответствующим циклам. 
Затем в модуле Test Plan необходимо создать тесты и связать их с 
назначенными требованиями, чтобы создать покрытие. 

В модуле Test Lab создаются папки наборов тестов, которые назначаются 
конкретным циклам. В данном примере можно определить вложенные 
папки наборов тестов Cycle 1, Cycle 2, Cycle 3 и Cycle 4.

После назначения папки наборов тестов циклу значок  папки наборов 
тестов заменяется значком  назначенной папки наборов тестов.



Глава 10 • Создание дерева релизов

142

Затем для каждой назначенной папки наборов тестов создаются наборы 
тестов и в эти наборы добавляются тесты, как показано в примере.

После выполнения наборов тестов из назначенных папок наборов тестов 
можно проанализировать ход работы с помощью вкладки Progress модуля 
Releases, чтобы определить степень соответствия целям релиза. На этой 
вкладке отображается краткий обзор хода работы над релизом. 
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Ниже приведен пример работы над релизом Release 10.5.

В верхней области показано общее количество дней работы над релизом и 
количество дней, оставшихся до завершения работы над релизом, общее 
количество экземпляров тестов для релиза, количество выполненных и 
еще не выполнявшихся экземпляров тестов, а также другие сведения. 

В нижней области приведена диаграмма хода выполнения покрытия. 
Графики на диаграмме отображаются с накоплением, то есть данные для 
каждого графика вычисляются путем суммирования всех данных релиза с 
начала работы над ним. 

График Assigned requirements отображает распределение назначенных 
требований по циклам релиза. В этом примере график показывает, что 
цикл Cycle 4 - Full выполнен на 100%. 
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График Planned coverage, расположенный ниже графика Assigned 
requirements, показывает количество покрытых требований (в процентах) 
для всех циклов релиза. В этом примере в цикле Cycle 4 - Full покрыто 
только 60% требований.

График Executed coverage, расположенный ниже графика Planned 
coverage, показывает количество тестов (в процентах), выполненных в 
ходе работы над релизом. В этом примере график показывает, что в цикле 
Cycle 4 - Full выполнено только 40% назначенных тестов.

График Passed Coverage расположен ниже графика Executed coverage. Он 
показывает количество выполненных тестов, имеющих последний статус 
Passed. В этом примере график показывает значение 20% для цикла Cycle 
4 - Full.
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Для каждого цикла на вкладке Quality можно просматривать количество 
зарегистрированных дефектов и их серьезность. Предположим, что во 
время выполнения набора тестов Cycle 1 из папки наборов тестов Release 
10.5 было обнаружено четыре ошибки в приложении. В дереве релизов 
выберите цикл Cycle 1 - New Features и перейдите на вкладку Quality, 
чтобы просмотреть количество дефектов, обнаруженных во время 
выполнения цикла. Дефекты распределяются по уровням серьезности от 
1-Low до 5-Urgent.

На диаграмме Defect Opening Rate видно, что четыре дефекта были 
обнаружены во время тестирования в первом цикле. Для двух дефектов 
был установлен уровень серьезности 3-High, для одного дефекта — 
5-Urgent, и еще для одного дефекта — уровень 2-Medium.
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На диаграмме Outstanding Defects видно, что два из четырех дефектов пока 
не обработаны. Для одного дефекта установлен уровень серьезности 
2-Medium, а для второго — 3-High.

Создание дерева релизов
Для построения иерархической структуры релизов необходимо создать 
дерево релизов. В каждой папке релизов дерева определяются релизы, в 
которые добавляются циклы. Создание дерева релизов начинается с 
добавления папки в корневую папку Releases.

Чтобы создать дерево релизов, выполните следующие действия.

 1 В дереве релизов выберите папку Releases.

 2 Нажмите кнопку New Release Folder или выберите команду Releases > 
New Release Folder. Откроется диалоговое окно New Release Folder.

 3 Введите имя папки в поле Release Folder Name и нажмите кнопку OK. 
Новая папка будет добавлена в папку Releases дерева релизов.

 4 На вкладке Details введите описание папки релизов.

 5 При необходимости перейдите на вкладку Attachments, чтобы добавить 
вложение к папке. Вложение может представлять собой файл, URL-адрес, 
снимок приложения, содержимое из буфера обмена или сведения о 
системе. Дополнительные сведения см. в Глава 5, "Добавление вложений"..

 6 Чтобы создать дополнительные папки, выберите папку и повторите шаги 2 
– 5.

Добавление релизов в папки релизов
После создания дерева релизов можно добавлять релизы в папки релизов. 
Для каждого определенного релиза добавляются циклы.

Чтобы добавить релиз в папку релизов, выполните следующие 
действия.

 1 Выберите папку релизов в дереве релизов.
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 2 Нажмите кнопку New Release  или выберите команду Releases > New 
Release. Откроется диалоговое окно New Release. 

 3 Введите имя релиза в поле Release Name и нажмите кнопку OK. Новый 
релиз появится в выбранной папке релизов.

 4 На вкладке Details введите следующие сведения о релизе.

 5 При необходимости перейдите на вкладку Attachments, чтобы добавить 
вложение к релизу. Вложение может представлять собой файл, URL-адрес, 
снимок приложения, содержимое из буфера обмена или сведения о 
системе. Дополнительные сведения см. в Глава 5, "Добавление вложений"..

 6 Чтобы создать дополнительные релизы, выберите папку релизов и 
повторите шаги 2 – 5.

Добавление циклов к релизам
После добавления релизов в папки, в каждый релиз можно добавлять 
циклы.

Чтобы добавить цикл к релизу, выполните следующие действия.

 1 Выберите релиз в дереве релизов.

 2 Нажмите кнопку New Cycle или выберите команду Releases > New Cycle. 
Откроется диалоговое окно New Cycle. 

 3 Введите имя цикла в поле Cycle Name и нажмите кнопку OK. Новый цикл 
появится в выбранном релизе.

Поле Описание

Start Date Дата начала работы над релизом. Нажмите стрелку «Вниз», 
чтобы отобразить календарь и выбрать дату начала.

End Date Дата завершения работы над релизом. Нажмите стрелку 
«Вниз», чтобы отобразить календарь и выбрать дату 
завершения.

Description Введите описание релиза.
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 4 На вкладке Details введите следующие сведения о цикле.

Диапазон дат для циклов должен находиться в пределах диапазона дат 
работы над релизом.

 5 При необходимости перейдите на вкладку Attachments, чтобы добавить 
вложение к циклу. Вложение может представлять собой файл, URL-адрес, 
снимок приложения, содержимое из буфера обмена или сведения о 
системе. Дополнительные сведения см. в Глава 5, "Добавление вложений"..

 6 Чтобы создать дополнительные циклы, выберите релиз и повторите шаги 2 
– 5.

Поле Описание

Start Date Дата начала работы над циклом. Нажмите стрелку «Вниз», 
чтобы отобразить календарь и выбрать дату начала.

End Date Дата завершения работы над циклом. Нажмите стрелку «Вниз», 
чтобы отобразить календарь и выбрать дату завершения.

Description Введите описание цикла.
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Просмотр назначенных требований и папок наборов тестов
Можно просматривать статистические данные о требованиях и папках 
наборов тестов, назначенных релизам и циклам.

Чтобы просмотреть требования, назначенные релизу или циклу, 
выполните следующие действия.

 1 В дереве релизов выберите релиз или цикл.

 2 Перейдите на вкладку Details. Будут показаны подробные сведения о 
релизе или цикле.

 3 Если выбран релиз, в области Statistics можно просмотреть следующие 
статистические данные.

Элемент Описание

Requirements assigned to 
release

Число требований, связанных с выбранным 
релизом. Чтобы просмотреть назначенные релизу 
требования в модуле Requirements, щелкните 
ссылку с числом требований. Также можно 
щелкнуть правой кнопкой мыши релиз в дереве 
релизов и выбрать команду Show Requirements.
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Если в области Statistics выбран цикл, можно просмотреть следующие 
статистические данные.

Просмотр хода выполнения тестирования релизов и циклов
На вкладке Progress отображаются статистические данные и диаграммы, 
показывающие ход работы над релизом или циклом. На этой вкладке 
отображаются такие данные, как количество прошедших и оставшихся 
дней, количество выполненных и еще не выполнявшихся экземпляров 
тестов, фактический и необходимый темп выполнения тестов. 

Чтобы просмотреть ход выполнения покрытия для релиза или цикла, 
выполните следующие действия.

 1 Выберите релиз или цикл в дереве релизов.

Элемент Описание

Requirements assigned to 
cycle

Число требований, связанных с выбранным 
циклом. Чтобы просмотреть назначенные циклу 
требования в модуле Requirements, щелкните 
ссылку с числом требований. Также можно 
щелкнуть правой кнопкой мыши цикл в дереве 
релизов и выбрать команду Show Requirements.

Test set folders assigned 
to cycle

Число папок наборов тестов, связанных с 
выбранным циклом. Чтобы просмотреть 
связанные с циклом папки наборов тестов в 
модуле Test Lab, щелкните ссылку с числом папок 
наборов тестов. Также можно щелкнуть правой 
кнопкой мыши цикл в дереве релизов и выбрать 
команду Show Test Set Folders.
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 2 Перейдите на вкладку Progress.

Для каждого релиза в верхней области вкладки Progress можно 
просмотреть следующие сведения.

Элемент Описание

Total days in release Общее число дней в выбранном релизе (дата 
завершения — дата начала). 

Remaining days in 
release

Общее число дней, оставшихся до завершения 
выбранного релиза.

Total test instances for 
release

Общее число экземпляров тестов, включенных в 
папки наборов тестов, назначенные выбранному 
релизу.

Remaining test 
instances to run

Общее число еще не выполнявшихся экземпляров 
тестов, включенных в папки наборов тестов, 
назначенные выбранному релизу.

Required execution 
rate (test 
instances/day)

Среднее число экземпляров тестов, которые 
необходимо выполнять ежедневно до завершения 
выбранного релиза.
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Для каждого цикла в верхней области вкладки Progress можно просмотреть 
следующие сведения.

Actual execution rate 
(test instances/day)

Среднее число выполнений экземпляров тестов в 
день в выбранном релизе до текущей даты.

Days (индикатор 
выполнения)

Время (в процентах от общего числа дней), 
прошедшее с начала работы над выбранным 
релизом.

Test Instance Runs 
(индикатор 
выполнения)

Доля выполнений экземпляров тестов (в 
процентах), завершенных в выбранном релизе.

Элемент Описание

Total days in cycle Общее число дней для работы над выбранным 
циклом (дата завершения – дата начала). 

Remaining days in 
cycle

Общее число дней, оставшихся до завершения 
выбранного цикла.

Total test instances for 
cycle

Общее число экземпляров тестов, включенных в 
папки наборов тестов, назначенные выбранному 
циклу.

Remaining test 
instances to run

Общее число еще не выполнявшихся экземпляров 
тестов, включенных в папки наборов тестов, 
назначенные выбранному циклу.

Required execution 
rate (test 
instances/day)

Среднее число экземпляров тестов, которое 
необходимо выполнять ежедневно в течение дней, 
оставшихся до завершения выбранного цикла.

Actual execution rate 
(test instances/day)

Среднее число выполнений экземпляров тестов в 
день в выбранном цикле до текущей даты.

Days (индикатор 
выполнения)

Число дней (в процентах от общего числа дней), 
прошедших с начала выбранного цикла.

Test Instance Runs 
(индикатор 
выполнения)

Число выполнений экземпляров тестов (в 
процентах), в выбранном цикле.

Элемент Описание
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 3 Чтобы настроить диаграмму Coverage Progress для выбранного релиза, 
установите или снимите следующие флажки.

 4 Чтобы настроить диаграмму Coverage Progress для выбранного цикла, 
установите или снимите следующие флажки.

 5 Чтобы обновить данные на вкладке Progress, нажмите кнопку Refresh All. 

Элемент Описание

Assigned requirements Совокупное число требований (в процентах), 
назначенных всем циклам в релизе. 

Planned coverage Совокупное число тестов (в процентах), 
запланированных для всех циклов в релизе. 

Executed coverage Совокупное число тестов (в процентах), которые 
были выполнены во всех циклах в релизе. 

Passed coverage Совокупное число тестов (в процентах), которые 
были выполнены успешно во всех циклах в релизе. 

Элемент Описание

Planned coverage Число тестов (в процентах), запланированных для 
ежедневного выполнения в цикле.

Executed coverage Число тестов (в процентах), которые выполнялись 
ежедневно в цикле.

Passed coverage Число тестов (в процентах), которые выполнялись 
успешно в течение каждого дня в цикле.
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Просмотр дефектов в релизах и циклах
На вкладке Quality можно быстро определять и просматривать число 
дефектов, зарегистрированных в процессе работы над релизом или 
циклом. Дефекты распределяются по уровням серьезности с точки зрения 
негативного воздействия на работоспособность системы. Уровни 
серьезности изменяются от Low-1 до Urgent-5. Можно просматривать 
диаграммы на любом этапе процесса управления приложением, чтобы 
проверять ход работы над релизом.

Для каждого релиза на вкладке Quality можно просмотреть следующие 
диаграммы.

Диаграмма Описание

Defect Opening 
Rate

Отображает число дефектов, обнаруженных в ходе работы 
над релизом. На диаграмме отображаются дефекты, для 
которых значение Detected in Release соответствует 
выбранному релизу. Дефекты группируются в соответствии с 
уровнем серьезности. По оси Х отображается число 
дефектов в соответствии с их серьезностью на последний 
день каждого цикла. 

Outstanding 
Defects

Отображает число необработанных дефектов для 
выбранного релиза. На диаграмме отображаются дефекты, 
для которых значение Target Release соответствует 
выбранному релизу. Дефекты группируются в соответствии с 
уровнем серьезности. По оси Х отображается число 
необработанных дефектов в соответствии с их серьезностью 
на последний день каждого цикла. По умолчанию 
необработанными считаются дефекты со статусом New, 
Open и Reopened. 
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Для каждого цикла на вкладке Quality можно просмотреть следующие 
диаграммы.

Чтобы просмотреть дефекты релиза или цикла, выполните 
следующие действия.

 1 Выберите релиз или цикл в дереве релизов.

Диаграмма Описание

Defect Opening 
Rate

Отображает число дефектов, обнаруженных в процессе 
работы над циклом. На диаграмме отображаются дефекты, 
значение Detected in Cycle которых соответствует 
выбранному циклу. Дефекты группируются в соответствии с 
уровнем серьезности. По оси Х отображается число 
существующих дефектов для каждой даты.

Outstanding 
Defects

Отображает число необработанных дефектов для цикла. На 
диаграмме отображаются дефекты, значение Detected in 
Cycle которых соответствует выбранному циклу. Дефекты 
группируются в соответствии с уровнем серьезности. По 
оси Х отображается число существующих необработанных 
дефектов для каждой даты. По умолчанию дефекты New, 
Open и Reopened считаются необработанными.
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 2 Перейдите на вкладку Quality.

На этой вкладке показаны диаграммы Defect Opening Rate и Outstanding 
Defects для выбранного релиза или цикла.

 3 На диаграмме Defect Opening Rate  можно устанавливать или снимать 
флажки уровней серьезности дефектов, отображаемых на диаграмме.

 4 На диаграмме Outstanding Defects можно выполнять следующие 
операции.

➤ Устанавливать или снимать флажки уровней серьезности дефектов, 
отображаемых на диаграмме.

➤ Определять, какие дефекты необходимо отображать на диаграмме, 
путем фильтрации дефектов по статусу. Выберите команду Configure 
Outstanding Defects. В диалоговом окне Configure Outstanding Defects 
выберите статус дефекта и с помощью кнопок со стрелками (> и <) 
перемещайте его между списками Available Defect Status и Visible 
Defect Status. Для перемещения всех типов из одного списка в другой 
используйте кнопки с двойными стрелками (>> и <<). Нажмите кнопку 
ОK. 

 5 Чтобы обновить данные на вкладке Quality, нажмите кнопку Refresh All. 
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Изменение дерева релизов
В этом разделе, посвященном изменению дерева релизов, рассмотрены 
следующие вопросы.

➤ Переименование папок релизов, релизов и циклов

➤ Перемещение папок релизов и релизов

➤ Создание копий циклов

➤ Удаление папок релизов, релизов и циклов

Переименование папок релизов, релизов и циклов
Можно переименовать папку релизов, релиз или цикл.

Чтобы переименовать папку релизов, релиз или цикл, выполните 
следующие действия.

 1 Выберите элемент в дереве релизов.

 2 Выберите команду Edit > Rename. Также можно щелкнуть папку релизов 
правой кнопкой мыши и выбрать команду Rename.

 3 Измените имя элемента и нажмите клавишу ENTER. 

Перемещение папок релизов и релизов
Папку релизов или релиз можно переместить в другое местоположение в 
дереве релизов. При перемещении папки релизов перемещаются также 
релизы и циклы, находящиеся в этой папке. При перемещении релиза 
также перемещаются его циклы. Переместить корневую папку Releases 
невозможно. 

Совет. Также можно переместить папку релизов или релиз в новое 
местоположение в дереве перетаскиванием.
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Чтобы переместить папку релизов или релиз, выполните следующие 
действия.

 1 Выберите папку релизов или релиз в дереве релизов. Чтобы переместить 
несколько элементов, нажмите клавишу CTRL и выберите элементы, 
которые необходимо переместить.

 2 Нажмите кнопку Cut. Также можно выбрать команду Edit > Cut.

 3 Выберите папку в дереве релизов.

 4 Нажмите кнопку Paste. Также можно выбрать команду Edit > Paste.

Создание копий циклов
Можно создать копию цикла в том же релизе. 

Чтобы создать копию цикла, выполните следующие действия.

 1 Выберите цикл в дереве релизов. 

Чтобы создать копии нескольких циклов, нажмите клавишу CTRL и 
выберите циклы, копии которых необходимо создать. Можно выбрать 
несколько циклов только в том случае, если они относятся к одному релизу.

 2 Нажмите кнопку Duplicate Cycle. Также можно выбрать команду Edit > 
Duplicate Cycle. Копия цикла будет добавлена в релиз.

Удаление папок релизов, релизов и циклов
Можно удалить папку релизов, релиз или цикл. При удалении папки также 
удаляются входящие в нее релизы и циклы. При удалении релиза также 
удаляются входящие в него циклы.

Примечание. Удаление папки релизов, релиза или цикла также отменяет 
назначение связанных требований, папок наборов тестов и дефектов.
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Чтобы удалить папку релизов, релиз или цикл, выполните следующие 
действия.

 1 Выберите элемент в дереве релизов. Чтобы удалить несколько элементов, 
нажмите клавишу CTRL и выберите элементы, которые необходимо 
удалить.

 2 Нажмите кнопку Delete. Также можно выбрать команду Edit > Delete. 
Отображается подтверждающее сообщение.

 3 Нажмите кнопку Yes для подтверждения. Элементы будут удалены.
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Часть III
Описание требований
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11
Рабочий процесс описания требований

Требования подробно описывают решаемые задачи или достигаемые цели 
в соответствии с поставленными задачами разработки приложения.

В этойглаве рассмотрено использование модуля Requirements для 
описания требований. Процесс описания требований включает следующие 
операции. 

Определение  рамок
тестирования

Создание
требований

Детализация
требований

Назначение  
требований  релизам

Анализ
требований

Создание  базового  
состояния
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Quality Center Выпуск Starter Edition. Не все поля и функциональные 
возможности модуля Requirements доступны в выпуске Starter Edition. 

Определение объема требований
Процесс управления жизненным циклом приложения начинается со сбора 
всей имеющейся документации по разрабатываемому приложению, такой 
как документация маркетинговых и бизнес-требований, спецификации 
системных требований и проектная документация. 

Эта документация используется для тщательного изучения 
разрабатываемого приложения и определения объема, целей, задач и 
стратегий тестирования.

Например, могут возникнуть следующие вопросы.

➤ Каковы основные цели приложения и его назначение?

➤ Каковы критические ограничения приложения?

➤ Каковы основные функции приложения?

➤ Какова относительная важность каждого элемента для функциональности 
приложения?

➤ Какие функции приложения являются наиболее критичными или имеют 
наибольшую вероятность отказа?

➤ Каковы бизнес-приоритеты и приоритеты тестирования? 

➤ Согласны ли заказчики и конечные пользователи с установленными 
приоритетами?

➤ Каковы общие целевые показатели качества?
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Создание структуры требований
Объем требований используется для определения общих требований к 
разрабатываемому приложению. После этого определяются различные 
группы требований на основе типов требований или функциональных 
областей. Группы требований фиксируются в модуле Requirements путем 
создания дерева требований. Дерево требований — это графическое 
представление описания требований, отображающее иерархические связи 
между различными требованиями.

Рассмотрим в качестве примера приложение для бронирования 
авиабилетов, с помощью которого можно управлять расписанием полетов, 
заказами билетов их продажей. Можно определить следующие основные 
требования: Online Travel Booking Services, Online Travel Information Source, 
Profile Management, Reservation Management, Booking System, Application 
Security, Application Usability, Application Client System и Application 
Performance. 

Дополнительные сведения см. в Глава 13, "Создание дерева требований"..
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Детализация требований
Для каждой группы требований в дереве требований создается список 
детальных требований. Например, требование Profile Management может 
быть разделено на следующие требования: 

Каждое требование в дереве имеет подробное описание и может включать 
необходимые вложения. После этого требованиям назначаются уровни 
приоритета, которые могут учитываться при создании плана тестирования. 

После определения требований можно добавлять прослеживаемость 
требований. При анализе влияния предлагаемого изменения 
определенного требования прослеживаемость показывает другие 
требования, на которые может повлиять это изменение. Дополнительные 
сведения см. в Глава 14, "Отслеживание требований"..
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Назначение требований релизам
Можно назначать требования релизам и циклам в дереве релизов модуля 
Releases. Дерево релизов содержит предыдущие, текущие и предстоящие 
релизы продукта в виде иерархической структуры дерева. Релиз 
представляет собой группу изменений, внесенных в одно или несколько 
приложений и доступных для одновременного распространения. Цикл 
представляет собой последовательность действий по разработке и 
контролю качества для достижения общей цели на основе временных 
рамок релиза. Дополнительные сведения о назначении требований см. в 
разделе “Назначение требований релизам или циклам" на стр. 199.

Назначенные требования затем используются в качестве основы плана 
тестирования в модуле Test Plan. Тесты, созданные в ходе планирования 
тестирования используются для связи этих требований в целях создания 
покрытия. Дополнительные сведения о требованиях и покрытии 
требований тестами см. в Глава 19, "Покрытие требований и покрытие 
тестами".. 

Анализ описания требований
Проанализируйте требования, чтобы убедиться в их соответствии объему 
тестирования, определенному раньше. После одобрения требования его 
статус следует изменить с Not Reviewed на Reviewed.

Для принятия решения о распределении доступных ресурсов тестирования 
можно использовать управление качеством на основе рисков. 
Дополнительные сведения см. в Глава 15, "Расчет рисков требований"..

Чтобы облегчить анализ требований, можно создавать отчеты и 
диаграммы. Дополнительные сведения см. в Глава 40, "Модуль 
Dashboard"..
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Создание базовых состояний
После анализа и одобрения требований можно создать базовое состояние 
требований. Базовое состояние можно использовать в качестве 
соглашения, которое должны подписать все заинтересованные лица. Это 
базовое состояние будет использоваться в качестве точки отсчета, с 
которой можно сравнивать изменения. Базовое состояние требований 
может проверяться в ходе всего проекта для постоянного обеспечения его 
соблюдения.

Дополнительные сведения о базовых состояниях см. в Глава 38, 
"Библиотеки и базовые состояния".
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12
Краткий обзор модуля Requirements

В этой главе приведен краткий обзор основных элементов модуля 
Requirements.

Эта глава содержит следующие разделы.

 ➤  Модуль Requirements на стр. 169

 ➤  Строка меню Requirements на стр. 182

 ➤  Панель инструментов Requirements на стр. 183

 ➤  Поля модуля Requirements на стр. 186

Модуль Requirements
Описание требований в Quality Center выполняется в модуле Requirements. 
Чтобы открыть окно этого модуля, нажмите кнопку Requirements на 
боковой панели. 

Для просмотра требований можно использовать следующие 
представления.

➤ Дерево требований

➤ Подробные сведения о требованиях

➤ Таблица требований

➤ Анализ покрытия



Глава 12 • Краткий обзор модуля Requirements

170

Примечание. Также можно импортировать требования в проект 
Quality Center из приложений Microsoft Word, Microsoft Excel или средств 
управления требованиями сторонних разработчиков. Чтобы импортировать 
требования, сначала необходимо установить соответствующую надстройку 
HP Quality Center. Дополнительные сведения см. в документе Руководство 
по установке HP Quality Center. 

Quality Center Выпуск Starter Edition. Не все поля и функциональные 
возможности модуля Requirements доступны в выпуске Starter Edition. 

Дерево требований
Представление Requirements Tree позволяет отображать требования в 
виде дерева. 
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Представление Requirements Tree содержит следующие основные 
элементы.

➤ Строка меню Requirements. Содержит раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 182.

➤ Панель инструментов Requirements. Содержит кнопки команд, часто 
используемых для создания и изменения требований. Дополнительные 
сведения см. в разделе “Панель инструментов Requirements" на стр. 183.

➤ Столбцы индикаторов. Указывают, что определенное требование 
содержит вложения, связанные дефекты, предупреждения и флажки 
отслеживания. Выберите команду View > Indicator Columns, чтобы 
отобразить эти столбцы.

➤ Дерево требований. Отображение требований в виде дерева.

Столбец Описание

Attachments Щелкните значок , чтобы просмотреть вложения 
требования. Дополнительные сведения см. в 
главе 5 "Добавление вложений".

Linked Defects Щелкните значок , чтобы просмотреть связанные 
дефекты требования. Дополнительные сведения 
см. в главе 36 "Связывание дефектов".

Alerts Щелкните значок , чтобы просмотреть 
предупреждения для требования. Дополнительные 
сведения см. в разделе “Просмотр оповещений" на 
стр. 88.

Follow Up Flags Щелкните значок , чтобы просмотреть 
предупреждения отслеживания для требования. 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 91.
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➤ Панель информации. Содержит следующие вкладки: Description, 
Comments, Attachments, History и RichContent. Выберите команду View > 
Information Panel или нажмите стрелку Show , чтобы отобразить эти 
вкладки.
 

Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
представлении Requirements Tree, выберите команду Requirements > Go 
to Requirement и введите идентификатор требования. Чтобы отобразить 
идентификатор требования, выберите столбец ReqID в диалоговом окне 
Select Columns. Можно переходить только к требованиям, 
соответствующим текущему фильтру.

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев к текущему 
требованию. 

Attachments Содержит вложения, предоставляющие 
дополнительные сведения о текущем требовании. 
Дополнительные сведения см. в главе 5 
"Добавление вложений".

History Отображение списка изменений, внесенных в 
текущее требование. Дополнительные сведения 
см. в разделе “Просмотр истории изменения 
требования" на стр. 210. Здесь также отображается 
история изменений базовых состояний, в которые 
включено текущее требование. Дополнительные 
сведения см. в разделе “Просмотр истории 
изменения базового состояния" на стр. 578.

RichContent Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft 
Word непосредственно в Quality Center. 
Дополнительные сведения см. в разделе 
“Добавление форматированного текста к 
требованиям" на стр. 200.
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Подробные сведения о требованиях
Представление Requirement Details позволяет создавать связи между 
требованиями и другими объектами. В этом представлении также можно 
выполнять расчет и анализ рисков требований.

Представление Requirement Details содержит следующие основные 
элементы.

➤ Строка меню Requirements. Содержит раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 182.

➤ Панель инструментов Requirements. Содержит кнопки команд, часто 
используемых для создания и изменения требований. Дополнительные 
сведения см. в разделе “Панель инструментов Requirements" на стр. 183.
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➤ Столбцы индикаторов. Указывают, что определенное требование 
содержит вложения, связанные дефекты, предупреждения и флажки 
отслеживания. Выберите команду View > Indicator Columns, чтобы 
отобразить эти столбцы.
 

➤ Дерево требований. Отображение требований в виде дерева.

➤ Вкладка Details. Отображает сведения о текущем требовании. Эта 
вкладка также содержит следующие вкладки.

Дополнительные сведения о полях, отображаемых на вкладке Details, см. в 
разделе “Поля модуля Requirements" на стр. 186.

➤ Вкладка Requirements Traceability. Отображает требования, связанные с 
текущим требованием. Дополнительные сведения см. в главе 14 
"Отслеживание требований".

Столбец Описание

Attachments Щелкните значок , чтобы просмотреть вложения 
требования. Дополнительные сведения см. в 
главе 5 "Добавление вложений".

Linked Defects Щелкните значок , чтобы просмотреть связанные 
дефекты требования. Дополнительные сведения 
см. в главе 36 "Связывание дефектов".

Alerts Щелкните значок , чтобы просмотреть 
предупреждения для требования. Дополнительные 
сведения см. в разделе “Просмотр оповещений" на 
стр. 88.

Follow Up Flags Щелкните значок , чтобы просмотреть 
предупреждения отслеживания для требования. 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 91.

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев к текущему 
требованию. 
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➤ Вкладка Test Coverage. Отображает тесты, связанные с текущим 
требованием. Дополнительные сведения см. в главе 19 "Покрытие 
требований и покрытие тестами".

➤ Вкладка Linked Defects. Отображает дефекты, связанные с текущим 
требованием. Дополнительные сведения см. в главе 36 "Связывание 
дефектов".

➤ Вкладка Risk. Расчет и анализ рисков требований. Дополнительные 
сведения см. в главе 15 "Расчет рисков требований".

➤ Вкладка Attachments. Отображает вложения, содержащие 
дополнительные сведения о текущем требовании. Дополнительные 
сведения см. в главе 5 "Добавление вложений".

➤ Вкладка RichContent. Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft Word непосредственно в 
Quality Center. Дополнительные сведения см. в разделе “Добавление 
форматированного текста к требованиям" на стр. 200.

➤ Вкладка History. Отображение списка изменений, внесенных в текущее 
требование. Дополнительные сведения см. в разделе “Просмотр истории 
изменения требования" на стр. 210. Здесь также отображается история 
изменений базовых состояний, в которые включено текущее требование. 
Дополнительные сведения см. в разделе “Просмотр истории изменения 
базового состояния" на стр. 578.

Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
представлении Requirement Details, выберите команду Requirements > Go 
to Requirement и введите идентификатор требования. Для отображения 
идентификатора требования выберите столбец ReqID в диалоговом окне 
Select Columns. Можно переходить только к требованиям, 
соответствующим текущему фильтру.
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Таблица требований
Представление Requirements Grid позволяет отображать требования в 
виде таблицы без учета иерархии. В каждой строке таблицы отображается 
отдельное требование. 

Представление Requirements Grid содержит следующие основные 
элементы.

➤ Строка меню Requirements. Содержит раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 182.

➤ Панель инструментов Requirements. Содержит кнопки команд, часто 
используемых для создания и изменения требований. Дополнительные 
сведения см. в разделе “Панель инструментов Requirements" на стр. 183.
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➤ Столбцы индикаторов. Указывают, что определенное требование 
содержит вложения, связанные дефекты, предупреждения и флажки 
отслеживания. Выберите команду View > Indicator Columns, чтобы 
отобразить эти столбцы.

➤ Панель информации. Содержит следующие вкладки: Description, 
Comments, Attachments, History и RichContent. Выберите команду View > 
Information Panel или нажмите стрелку Show , чтобы отобразить эти 
вкладки.
 

Столбец Описание

Attachments Щелкните значок , чтобы просмотреть вложения 
требования. Дополнительные сведения см. в 
главе 5 "Добавление вложений".

Linked Defects Щелкните значок , чтобы просмотреть связанные 
дефекты требования. Дополнительные сведения 
см. в главе 36 "Связывание дефектов".

Alerts Щелкните значок , чтобы просмотреть 
предупреждения для требования. Дополнительные 
сведения см. в разделе “Просмотр оповещений" на 
стр. 88.

Follow Up Flags Щелкните значок , чтобы просмотреть 
предупреждения отслеживания для требования. 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 91.

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев к текущему 
требованию. 

Attachments Содержит вложения, предоставляющие 
дополнительные сведения о текущем требовании. 
Дополнительные сведения см. в главе 5 
"Добавление вложений".



Глава 12 • Краткий обзор модуля Requirements

178

Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
представлении Requirements Grid, выберите команду Requirements > Go to 
Requirement и введите идентификатор требования. Для отображения 
идентификатора требования выберите столбец ReqID в диалоговом окне 
Select Columns.

History Отображает список изменений, внесенных в 
текущее требование. Дополнительные сведения 
см. в разделе “Просмотр истории изменения 
требования" на стр. 210. Здесь также отображается 
история изменений базовых состояний, в которые 
включено текущее требование. Дополнительные 
сведения см. в разделе “Просмотр истории 
изменения базового состояния" на стр. 578.

RichContent Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft 
Word непосредственно в Quality Center. 
Дополнительные сведения см. в разделе 
“Добавление форматированного текста к 
требованиям" на стр. 200.

Вкладка Описание
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Анализ покрытия
Представление Coverage Analysis позволяет анализировать 
классификацию дочерних требований в соответствии со статусом покрытия 
тестами. 

Представление Coverage Analysis содержит следующие основные 
элементы.

➤ Строка меню Requirements. Содержит раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 182.

➤ Панель инструментов Requirements. Содержит кнопки команд, часто 
используемых для создания и изменения требований. Дополнительные 
сведения см. в разделе “Панель инструментов Requirements" на стр. 183.
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➤ Столбцы индикаторов. Указывают, что определенное требование 
содержит вложения, связанные дефекты, предупреждения и флажки 
отслеживания. Выберите команду View > Indicator Columns, чтобы 
отобразить эти столбцы.

➤ Дерево требований. Отображение требований в виде дерева.

➤ Панель информации. Содержит следующие вкладки: Description, 
Comments, Attachments, History и RichContent. Выберите команду View > 
Information Panel или нажмите стрелку Show , чтобы отобразить эти 
вкладки.
 

Столбец Описание

Attachments Щелкните значок , чтобы просмотреть вложения 
требования. Дополнительные сведения см. в 
главе 5 "Добавление вложений".

Linked Defects Щелкните значок , чтобы просмотреть связанные 
дефекты требования. Дополнительные сведения 
см. в главе 36 "Связывание дефектов".

Alerts Щелкните значок , чтобы просмотреть 
предупреждения для требования. Дополнительные 
сведения см. в разделе “Просмотр оповещений" на 
стр. 88.

Follow Up Flags Щелкните значок , чтобы просмотреть 
предупреждения отслеживания для требования. 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 91.

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев к текущему 
требованию. 

Attachments Содержит вложения, предоставляющие 
дополнительные сведения о текущем требовании. 
Дополнительные сведения см. в главе 5 
"Добавление вложений".
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Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
представлении Requirement Details, выберите команду Requirements > Go 
to Requirement и введите идентификатор требования. Для отображения 
идентификатора требования выберите столбец ReqID в диалоговом окне 
Select Columns. Можно переходить только к требованиям, 
соответствующим текущему фильтру.

History Отображает список изменений, внесенных в 
текущее требование. Дополнительные сведения 
см. в разделе “Просмотр истории изменения 
требования" на стр. 210. Здесь также отображается 
история изменений базовых состояний, в которые 
включено текущее требование. Дополнительные 
сведения см. в разделе “Просмотр истории 
изменения базового состояния" на стр. 578.

RichContent Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft 
Word непосредственно в Quality Center. 
Дополнительные сведения см. в разделе 
“Добавление форматированного текста к 
требованиям" на стр. 200.

Вкладка Описание
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Строка меню Requirements 
Строка меню Requirements содержит следующие меню. Меню и команды, 
доступные в строке меню, могут изменяться в зависимости от 
представления требований.

➤ Меню Requirements содержит команды, с помощью которых можно 
добавлять требования, находить требования в дереве, создавать тесты на 
основании требований, отображать сведения о требованиях и отправлять 
требования по электронной почте.

➤ Меню Edit содержит команды, позволяющие вырезать, копировать, 
вставлять, переименовывать и удалять требования, обновлять выбранные 
требования, выполнять поиск и замену, а также находить требования. 
Также можно просматривать и удалять предупреждения требований и 
устанавливать флажки отслеживания требований. Дополнительные 
сведения о предупреждениях и флажках отслеживания см. в главе 4 
"Оповещение об изменениях".

➤ Меню View содержит команды, с помощью которых можно устанавливать 
отображение требований в виде дерева или таблицы, фильтровать и 
сортировать требования, настраивать отображаемые столбцы и выбирать 
представления требований.

➤ Меню Versions доступно в проектах с включенным управлением версиями. 
Это меню содержит команды, которые позволяют возвращать и изымать 
требования, отменять изъятие или просматривать все изъятые 
требования. Дополнительные сведения см. в главе 7 "Работа с функциями 
управления версиями".

➤ Меню Favorites содержит команды, позволяющие добавлять, 
упорядочивать и загружать избранные представления. Дополнительные 
сведения см. в разделе “Работа с избранными представлениями" на 
стр. 103.

➤ Меню Analysis содержит команды, позволяющие создавать отчеты о 
требованиях и диаграммы. Дополнительные сведения об отчетах о 
требованиях см. в главе 42 "Создание стандартных отчетов". 
Дополнительные сведения о диаграммах требований см. в главе 41 
"Создание диаграмм".



Глава 12 • Краткий обзор модуля Requirements

183

Совет. Чтобы получить доступ к строке меню Requirements в модуле 
Requirements, нажмите клавишу F9. Кроме того, с помощью сочетаний 
клавиш можно выполнять множество других операций в среде 
Quality Center. Перечень сочетаний клавиш приведен в приложении B 
"Сочетания клавиш Quality Center".

Панель инструментов Requirements 
Панель инструментов Requirements содержит следующие кнопки. Кнопки 
панели инструментов могут изменяться в зависимости от представления 
требований.

New Folder. Добавление новой папки в дерево требований. 

New Requirement. Добавление нового требования в дерево требований. 

Delete. Удаление выбранного требования или папки. При удалении 
требования также удаляются его дочерние требования, покрытие тестами, 
связи с дефектами и вложения.

Refresh All. Обновление дерева или таблицы требований для отображения 
самых последних требований.

Set Filter/Sort. Можно выбрать следующие варианты.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать требования в дереве или таблице 
требований. 

➤ Clear Filter/Sort. Очистка всех фильтров или параметров сортировки, 
примененных к дереву или таблице требований.

Select Columns. Открывается диалоговое окно Select Columns, в котором 
можно определить поля, которые необходимо отображать в дереве или 
таблице требований, а также порядок этих полей. Дополнительные 
сведения см. в разделе “Упорядочивание столбцов" на стр. 54.
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Requirement Details. Открывается диалоговое окно Requirement Details, 
отображающее сведения о выбранном требовании. Дополнительные 
сведения см. в разделе “Обновление требований" на стр. 201.

Attachments. Открывается диалоговое окно Requirement Details в 
представлении Attachments, в котором можно добавлять вложения к 
выбранному требованию. Дополнительные сведения см. в главе 5 
"Добавление вложений".

Go To Requirement in Requirements Tree. Переход от представления 
Requirement Grid к представлению Requirements Tree с выделением 
выбранного элемента.

Zoom In. Изменение уровня детализации в дереве требований. 
Дополнительные сведения см. в разделе “Изменение масштаба просмотра 
дерева" на стр. 208.

Send by Email. Открывается диалоговое окно Send Email, с помощью 
которого можно отправить требование по электронной почте получателям, 
выбранным из списка, или автору требования. Дополнительные сведения 
см. в разделе “Отправка требований по электронной почте" на стр. 212.

Text Search. В нижней части окна открывается область поиска, в которой 
можно вводить ключевые слова и выполнять поиск в предопределенных 
полях. Дополнительные сведения см. в разделе “Поиск записей" на стр. 76.

Favorite. Щелкните стрелку Favorite, чтобы отобразить список избранных 
представлений. Избранные представления позволяют обновлять окно 
Quality Center с примененными параметрами. (Эта возможность доступна 
только в представлении Requirements Grid. Чтобы отобразить панель 
Favorite, выберите команду View > Favorite Bar.) Дополнительные 
сведения об избранных представлениях см. в главе 6 "Работа с 
избранными представлениями".
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Управление версиями. На панели инструментов Requirements 
отображаются следующие дополнительные кнопки для управления 
версиями.

➤ Check Out. Открывается диалоговое окно Check Out, позволяющее 
изъять выбранное требование.

➤ Check In. Открывается диалоговое окно Check In, позволяющее 
возвратить выбранное требование.

Дополнительные сведения об управлении версиями см. в главе 7 "Работа с 
функциями управления версиями".
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Поля модуля Requirements 
В модуле Requirements отображаются следующие поля.

Поле Описание

Author Имя пользователя, создавшего требование. По умолчанию 
используется имя пользователя, выполнившего вход в 
систему. 

Comments Комментарии к требованию.

Creation Date Дата создания требования. По умолчанию в качестве даты 
создания используется текущая дата сервера баз данных. 
Щелкните стрелку вниз, чтобы отобразить календарь и 
выбрать другую дату создания.

Creation Time Время создания требования. По умолчанию в качестве 
времени создания используется текущее время сервера баз 
данных.

Description Описание требования.

Direct Cover 
Status

Текущий статус требования. По умолчанию требованию 
назначается статус Not Covered.

Возможны следующие значения статуса требования.

➤ Not Covered. Требование не связано с тестом.
➤ Failed. Один или несколько тестов, покрытых требованием, 

имеют статус выполнения Failed.
➤ Not Completed. Один или несколько тестов, покрытых 

требованием, имеют статус выполнения Not Completed. 
Тесты, покрытые требованием, также могут иметь значения 
статуса выполнения Passed или No Run.

➤ Passed. Все тесты, покрытые требованием, имеют статус 
выполнения Passed. 

➤ No Run. Все тесты, покрытые требованием, имеют статус 
выполнения No Run.

➤ N/A. Текущий статус требования неприменим.
➤ -----. Требование не имеет статуса прямого покрытия, 

поскольку оно относится к такому типу требований, 
который не поддерживает покрытие.
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Modified Дата последнего изменения требования.

Name Имя требования.

Old Type 
(obsolete)

(прежнее 
название — 
Type)

Тип требования (устаревшее). В предыдущих версиях 
Quality Center в качестве типа требования могло 
использоваться любое значение, настроенное в проекте. 
Стандартные значения: Change, Functional, Guideline, 
Quality, Standard и System.

Это поле можно использовать только для требований 
неопределенного типа.

Priority Приоритет требования от низкого (уровень 1) до неотложного 
(уровень 5).

Product Компонент приложения, к которому относится требование.

RBQM 
Business 
Impact

Расчетная бизнес-критичность требования. Возможные 
значения: A (высокая), B (средняя) и C(низкая). Это поле 
используется только для требований оценки.

RBQM Custom 
Business 
Impact

Определенная пользователем бизнес-критичность 
требования. Возможные значения: A (высокая), B (средняя) 
и C(низкая). Это поле используется только для требований 
оценки.

RBQM Custom 
Failure 
Probability

Определенная пользователем вероятность сбоя для 
требования. Возможные значения: 1 (высокая), 2 (средняя) и 
3 (низкая). Это поле используется только для требований 
оценки.

RBQM Custom 
Functional 
Complexity

Определенная пользователем функциональная сложность 
требования. Возможные значения: 1 (высокая), 2 (средняя) и 
3 (низкая). Это поле используется только для требований 
оценки.

RBQM Custom 
Risk

Определенный пользователем риск для требования. 
Возможные значения: A (высокий), B (средний) и C(низкий). 
Это поле используется только для требований оценки.

Поле Описание
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RBQM Custom 
Testing Hours

Определенные пользователем трудозатраты, необходимые 
для тестирования требования, измеряемые в единицах, 
определенных в окне Project Customization. Это поле 
используется только для требований оценки.

RBQM Custom 
Testing Level

Определенный пользователем уровень тестирования 
требования. Возможные значения: 1-Full, 2-Partial, 3-Sanity и 
4-None. Это поле используется только для требований 
оценки.

RBQM Date of 
Last Analysis

Дата последнего анализа требования с точки зрения 
управления качеством на основе рисков. Это поле 
используется только для требований анализа.

RBQM Effective 
Business 
Impact

Эффективная бизнес-критичность требования. Возможные 
значения: A (высокая), B (средняя) и C(низкая). Это поле 
используется только для требований оценки.

RBQM Effective 
Failure 
Probability

Эффективная вероятность сбоя для требования. Возможные 
значения: 1 (высокая), 2 (средняя) и 3(низкая). Это поле 
используется только для требований оценки.

RBQM Effective 
Functional 
Complexity

Эффективная функциональная сложность требования. 
Возможные значения: 1 (высокая), 2 (средняя) и 3(низкая). 
Это поле используется только для требований оценки.

RBQM Effective 
Risk

Эффективный риск для требования. Возможные значения: A 
(высокий), B (средний) и C(низкий). Это поле используется 
только для требований оценки.

RBQM 
Estimated RnD 
Effort

Определенная пользователем оценка трудозатрат, 
необходимых для разработки требования. Это поле 
используется только для требований оценки.

RBQM Exclude 
from Analysis

Указывает, следует ли исключать требование из анализа 
рисков. Требование можно исключить из анализа рисков, если 
оно относится к тому типу, для которого оценка рисков 
невозможна, или если его необходимо исключить из анализа 
специально.

RBQM Failure 
Probability

Расчетная вероятность сбоя для требования. Возможные 
значения: 1 (высокая), 2 (средняя) и 3(низкая). Это поле 
используется только для требований оценки.

Поле Описание
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RBQM 
Functional 
Complexity

Расчетная функциональная сложность требования. 
Возможные значения: 1 (высокая), 2 (средняя) и 3(низкая). 
Это поле используется только для требований оценки.

RBQM Risk Расчетный риск для требования. Возможные значения: A 
(высокий), B (средний) и C(низкий). Это поле используется 
только для требований оценки.

RBQM Testing 
Hours

Расчетные трудозатраты, необходимые для тестирования 
требования, измеряемые в единицах, определенных в модуле 
Project Customization. Это поле используется только для 
требований оценки.

RBQM Testing 
Level

Расчетный уровень тестирования для требования. 
Возможные значения: 1-Full, 2-Partial, 3-Sanity и 4-None. Это 
поле используется только для требований оценки.

RBQM Use 
Custom 
Business 
Impact

Указывает, следует ли использовать определенную 
пользователем бизнес-критичность вместо бизнес-
критичности, рассчитанной Quality Center. Это поле 
используется только для требований оценки.

RBQM Use 
Custom Failure 
Probability

Указывает, следует ли использовать определенную 
пользователем вероятность сбоя вместо вероятности сбоя, 
рассчитанной Quality Center. Это поле используется только 
для требований оценки.

RBQM Use 
Custom 
Functional 
Complexity

Указывает, следует ли использовать определенную 
пользователем функциональную сложность вместо 
функциональной сложности, рассчитанной Quality Center. Это 
поле используется только для требований оценки.

RBQM Use 
Custom 
Results

Указывает, следует ли использовать определенные 
пользователем трудозатраты и уровень тестирования вместо 
значений, рассчитанных Quality Center. Это поле 
используется только для требований оценки.

RBQM Use 
Custom Risk

Указывает, следует ли использовать определенный 
пользователем риск вместо риска, рассчитанного 
Quality Center. Это поле используется только для требований 
оценки.

Поле Описание
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Req ID Уникальный буквенно-цифровой идентификатор требования, 
назначаемый автоматически. Поле Req ID нельзя изменить.

Req Parent Имя родительского требования.

Requirement 
Type

Указывает тип требования. По умолчанию используются 
следующие значения: 

➤  Business. Требование к бизнес-процессу. По 
умолчанию добавлять покрытие к такому требованию 
нельзя.

➤  Folder. Папка для упорядочивания требований. По 
умолчанию добавлять покрытие к такому требованию 
нельзя.

➤  Functional. Требование к реакции системы.
➤  Group. Набор связанных требований.
➤  Testing. Требование к производительности системы.
➤  Undefined. Неопределенное требование.

Можно настраивать типы требований по умолчанию и 
создавать собственные. Дополнительные сведения о 
настройке типов требований см. в документе 
HP Quality Center Administrator Guide.

Reviewed Указывает, было ли требование рассмотрено и одобрено 
ответственным лицом, или нет.

Target Cycle Цикл, в котором было назначено требование. Чтобы выбрать 
другой цикл, нажмите стрелку «Вниз».

Target Release Релиз, в котором было назначено требование. Чтобы выбрать 
другой релиз, нажмите стрелку «Вниз».

Поле Описание
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Управление версиями. В модуле Requirements отображаются следующие 
дополнительные поля.

Поле Описание

Version Check 
Out Date

Дата изъятия версии.

Version Check 
Out Time

Время изъятия версии.

Version 
Checked Out 
By

Имя пользователя, изъявшего версию.

Version 
Number

Номер версии.

Version Status Статус версии (Checked Out или Checked In).
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Примечания. 

➤ В модуле Requirements можно добавлять пользовательские поля, а 
также изменять их заголовки. Также предусмотрена возможность 
настройки списков проектов. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ Для ограничения и динамического изменения полей и значений модуля 
Requirements можно использовать редактор Script Editor. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ При выборе столбца требований, содержащего имя пользователя 
(включая поля, определенные пользователем), Quality Center 
отображает список имен и полных имен всех пользователей. Можно 
выполнять поиск пользователей, сортировать и группировать их по 
группам, а также выбирать пользователей из списка пользователей и 
дерева групп. Дополнительные сведения см. в разделе “Выбор 
пользователей" на стр. 57.

➤ Quality Center Выпуск Starter Edition. В выпуске Starter Edition 
доступны не все поля. 
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13 
Создание дерева требований

Дерево требований служит для упорядочивания и отображения требований 
в виде иерархической структуры.

Эта глава содержит следующие разделы.

 ➤  О создании дерева требований на стр. 194

 ➤  Создание дерева требований на стр. 195

 ➤  Назначение требований релизам или циклам на стр. 199

 ➤  Добавление форматированного текста к требованиям на стр. 200

 ➤  Обновление требований на стр. 201

 ➤  Поиск требований на стр. 204

 ➤  Замена значений полей на стр. 206

 ➤  Просмотр дерева требований на стр. 208

 ➤  Просмотр истории изменения требования на стр. 210

 ➤  Отправка требований по электронной почте на стр. 212

 ➤  Изменение требований на стр. 215

 ➤  Создание тестов из требований на стр. 219
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О создании дерева требований 
В модуле Requirements можно определять требования и управлять ими. 
Определить требования в Quality Center можно путем создания дерева 
требований. Дерево требований является графическим представлением 
описания требований и отображает требования в виде иерархической 
структуры. 

После определения требований можно установить прослеживаемость для 
двух или более требований. Прослеживаемость требований определяет 
взаимоотношения между требованиями. При анализе воздействия, которое 
окажет изменение, предлагаемое в определенном требовании, связи 
прослеживаемости указывают на другие требования, на которые может 
повлиять это изменение. При изменении требования Quality Center 
оповещает те отслеживаемые требования, на которые данное изменение 
окажет непосредственное воздействие. Дополнительные сведения об 
установлении прослеживаемости требований см. в Глава 14, 
"Отслеживание требований"..

На этапе описания требований пользователь назначает их релизу или 
циклу в дереве релизов. Требования можно назначать одному или 
нескольким релизам или циклам. Дополнительные сведения см. в разделе 
“Назначение требований релизам или циклам" на стр. 199.

Назначенные требования могут быть связаны с тестами и дефектами. Это 
дает возможность отслеживания на всех стадиях жизненного цикла 
разработки программного обеспечения. При изменении требования можно 
сразу же определить, на какие тесты и дефекты это может оказать 
влияние, и установить ответственных лиц. Дополнительные сведения о 
связывании требований с тестами см. в Глава 19, "Покрытие требований и 
покрытие тестами".. Дополнительные сведения о связывании требований с 
дефектами см. в Глава 36, "Связывание дефектов"..
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Примечание. В этой главе для создания дерева требований используется 
представление Requirements Tree модуля Requirements. Сведения о 
представлении Requirements Grid см. в разделе “Таблица требований" на 
стр. 176. Сведения о представлениях Requirement Details и Coverage 
Analysis см. в Глава 19, "Покрытие требований и покрытие тестами"..

Создание дерева требований
Создание дерева требований начинается с добавления требований в 
корневую папку Requirements. Можно упорядочить разделы требований по 
папкам. Корневую папку нельзя переименовать или удалить.

Quality Center Выпуск Starter Edition. Типы требований недоступны в 
этом выпуске. 

Примечание. Кроме создания требований непосредственно в 
Quality Center, можно импортировать требования в проект Quality Center из 
приложений Microsoft Word или Microsoft Excel. Для импорта из приложения 
Word необходимо установить надстройки HP Quality Center Microsoft 
Word Add-in и HP Quality Center Connectivity Add-in. Для импорта из 
приложения Excel необходимо установить надстройки HP Quality Center 
Microsoft Excel Add-In и HP Quality Center Connectivity Add-In. Эти 
надстройки можно установить со страницы надстроек HP Quality Center. 
Дополнительные сведения см. в документе Руководство по установке 
HP Quality Center.

Чтобы создать дерево требований, выполните следующие действия.

 1 В модуле Requirements выберите команду View > Requirements Tree, 
чтобы отобразить представление дерева требований.
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 2 Чтобы добавить требование на основной уровень, выберите корневую 
папку Requirements. Чтобы создать дочернее требование, выберите 
существующее требование.

 3 Чтобы добавить папку, нажмите кнопку New Folder или выберите команду 
Requirements > New Folder. В диалоговом окне Create New Requirement 
Folder введите имя папки в поле Folder Name и нажмите кнопку OK. Учтите, 
что имя папки не должно содержать следующих символов: \ ^ *

 4 Чтобы добавить требование, нажмите кнопку New Requirement. Также 
можно выбрать команду Requirements > New Requirement. Откроется 
диалоговое окно Create New Requirement.

 5 В списке Requirement Type выберите тип требования. Дополнительные 
сведения о типах требований см. в разделе “Поля модуля Requirements" на 
стр. 186.

 6 В поле Requirement Name введите имя нового требования. Имя 
требования не должно содержать следующих символов: \ ^ *
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 7 Нажмите кнопку ОK. Откроется диалоговое окно New Requirement.

 8 Добавьте сведения о требовании. Учтите, что обязательные поля 
выделены красным цветом. Дополнительные сведения о полях, доступных 
в модуле Requirements, см. в разделе “Поля модуля Requirements" на 
стр. 186.

 9 Чтобы очистить данные в диалоговом окне New Requirement нажмите 
кнопку Clear.

 10 Чтобы добавить вложение к требованию, выполните следующие действия.

➤ Нажмите кнопку Attach File , чтобы приложить текстовый файл.

➤ Нажмите кнопку Attach URL, чтобы приложить URL-адрес.

➤ Нажмите кнопку Attach Snapshot, чтобы сделать снимок экрана и 
приложить его как изображение.

➤ Нажмите кнопку Attach SysInfo, чтобы приложить сведения о 
компьютере.
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➤ Нажмите кнопку Attach Clipboard, чтобы приложить текст или 
изображение из буфера обмена.

Дополнительные сведения о добавлении вложений см. в Глава 5, 
"Добавление вложений"..

 11 В диалоговом окне New Requirement можно проверить орфографию.

➤ Нажмите кнопку Check Spelling, чтобы проверить орфографию 
выделенного слова или текста. 

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии Quality Center, нажмите 
кнопку Spelling Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить синонимы, 
антонимы или связанные слова для выбранного слова, нажмите кнопку 
Thesaurus. 

 12 Нажмите кнопку Submit, чтобы добавить новое требование в дерево. 

 13 Нажмите кнопку Close, чтобы закрыть диалоговое окно New Requirement.

Управление версиями. Новое требование будет изъято автоматически. 
Дополнительные сведения см. в разделе “Изъятие объектов" на стр. 115.

 14 Чтобы добавить к требованию покрытие тестами, выберите команду View > 
Requirement Details. Чтобы просмотреть классификацию дочерних 
требований в соответствии со статусом покрытия тестами, выберите 
команду View > Coverage Analysis. Дополнительные сведения см. в 
Глава 19, "Покрытие требований и покрытие тестами"..

 15 Чтобы добавить связи прослеживаемости требований к конкретному 
требованию, выберите команду View > Requirement Details и перейдите на 
вкладку Requirements Traceability. Дополнительные сведения см. в 
Глава 14, "Отслеживание требований"..

 16 Чтобы добавить связи дефектов к требованию, выберите команду View > 
Requirement Details и перейдите на вкладку Linked Defects. 
Дополнительные сведения см. в Глава 36, "Связывание дефектов"..
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Назначение требований релизам или циклам
После определения требований в дереве требований выполняется 
назначение требований релизам или циклам в модуле Releases. Можно 
назначать требования одному или нескольким релизам или циклам в 
дереве релизов. Дополнительные сведения см. в Глава 10, "Создание 
дерева релизов"..

На стадии планирования тестирования для создания покрытия в модуле 
Test Plan выполняется связывание тестов с назначенными требованиями. 
Благодаря определению покрытия можно отслеживать взаимоотношения 
между тестами, включенными в план тестирования, и требованиями. 
Дополнительные сведения о покрытии см. в Глава 19, "Покрытие 
требований и покрытие тестами"..

На стадии выполнения тестов выполняется добавление тестов, 
покрывающих назначенные требования, в наборы тестов модуля Test Lab, 
а затем назначение папок наборов тестов циклам. Дополнительные 
сведения см. в разделе “Назначение папок наборов тестов циклам" на 
стр. 427.

Quality Center Выпуск Starter Edition. Назначение требований релизам 
или циклам не поддерживается.

Примечание. При назначении родительского требования циклу дочерние 
требования этого требования также назначаются этому же циклу. 

Чтобы назначить требование релизу или циклу, выполните 
следующие действия.

 1 В дереве требований выберите требование, которое необходимо 
назначить релизу или циклу. Чтобы выбрать несколько требований, 
используйте клавишу Ctrl.

 2 Чтобы назначить требования релизу, выберите команду Requirements > 
Assign To Release. Также можно щелкнуть элемент правой кнопкой мыши 
и выбрать команду Assign To Release. Откроется диалоговое окно Assign 
To Release. Разверните дерево и выберите релиз. Нажмите кнопку OK, 
чтобы закрыть диалоговое окно.
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Чтобы назначить требования циклу, выберите команду Requirements > 
Assign To Cycle. Также можно щелкнуть требование правой кнопкой мыши 
и выбрать команду Assign To Cycle. Откроется диалоговое окно Assign To 
Cycle. Разверните дерево и выберите цикл. Нажмите кнопку OK, чтобы 
закрыть диалоговое окно.

 3 Если выбранное требование содержит дочерние требования, откроется 
окно подтверждения. Нажмите кнопку Yes, чтобы назначить требование 
вместе с его дочерними требованиями. Нажмите кнопку No, чтобы 
назначить требование без его дочерних требований.

Добавление форматированного текста к требованиям
В Quality Center можно добавлять, просматривать и изменять 
форматированный текст Microsoft Word без необходимости использования 
приложения Word. При переходе к другому требованию или модулю 
изменения, внесенные в форматированный текст требования, сохраняются 
автоматически.

Примечание. Сведения о поддерживаемых версиях приложения Microsoft 
Word см. в документе Руководство по установке HP Quality Center.

Чтобы добавить форматированный текст к требованию, выполните 
следующие действия.

 1 Выберите требование и перейдите на вкладку RichContent. Откроется 
окно текстового редактора Microsoft Word.

 2 Внесите изменения в текст в форматированный текст таким же образом, 
как в программе Word. Дополнительные сведения об использовании 
текстового редактора Word для изменения форматированного текста см. в 
документации по приложению Microsoft Word.



Глава 13 • Создание дерева требований

201

 3 Чтобы изменить форматированный текст в отдельном окне, нажмите 
кнопку Maximize Content.

 4 Чтобы заменить существующий форматированный текст текстом из файла, 
сохраненного в программе Word, на вкладке RichContent выберите 
команду File > Import.

 5 Чтобы заменить существующий форматированный текст пустой страницей, 
на вкладке RichContent выберите команду File > New.

 6 Чтобы сохранить форматированный текст как документ Word, выберите 
команду File > Save.

Обновление требований
Обновлять требования можно непосредственно в дереве или таблице 
требований, а также в диалоговом окне Requirement Details. В диалоговом 
окне Requirement Details можно обновлять сведения, вложения, покрытие 
тестами, связи прослеживаемости требований, параметры управления 
качеством на основе рисков и связи с дефектами для любого требования. 
Кроме того, можно просматривать список изменений, внесенных в любое 
требование.

Quality Center Выпуск Starter Edition. В выпуске Starter Edition доступны 
не все поля и функциональные возможности окна Requirement Details. 
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Чтобы обновить требование, выполните следующие действия.

 1 Дважды щелкните требование, которое необходимо обновить. Также 
можно выбрать требование и нажать кнопку Requirement Details. 
Откроется диалоговое окно Requirement Details.

 2 Нажмите кнопку First, чтобы отобразить первое требование в дереве или 
таблице, или кнопку Previous, чтобы отобразить предыдущее требование.

 3 Нажмите кнопку Next, чтобы отобразить следующее требование в дереве 
или таблице, или кнопку Last, чтобы отобразить последнее требование в 
дереве или таблице.
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 4 Нажмите кнопку Send by Email, чтобы отправить подробные сведения о 
требовании по электронной почте. Дополнительные сведения об отправке 
требований по электронной почте см. в разделе “Отправка требований по 
электронной почте" на стр. 212.

 5 В представлении Details можно добавлять или изменять сведения о 
выбранном требовании. Дополнительные сведения о полях, доступных в 
представлении Details, см. в разделе “Поля модуля Requirements" на 
стр. 186.

 6 Нажмите кнопку Requirements Traceability на боковой панели, чтобы 
добавить связи прослеживаемости к требованию. Дополнительные 
сведения о прослеживаемости см. в Глава 14, "Отслеживание требований".

 7 Нажмите кнопку Test Coverage на боковой панели, чтобы добавить 
покрытие тестами к требованию. Дополнительные сведения о покрытии 
тестами см. в Глава 19, "Покрытие требований и покрытие тестами"..

 8 Нажмите кнопку Linked Defects на боковой панели, чтобы добавить к 
требованию связи с дефектами. В таблице Requirements рядом с 
требованием располагается активный значок . Дополнительные 
сведения о связанных дефектах см. в разделе “Связывание дефектов" на 
стр. 551.

 9 Нажмите кнопкуRisk на боковой панели, чтобы использовать управление 
качеством на основе рисков для определения стратегии тестирования 
требования. Дополнительные сведения о тестировании на основе рисков 
см. в Глава 15, "Расчет рисков требований".

 10 Нажмите кнопку Attachments на боковой панели, чтобы добавить 
вложение к требованию. Вложение может представлять собой файл, 
URL-адрес, снимок экрана приложения, информацию о системе или 
содержимое буфера обмена. В таблице Requirements рядом с требованием 
располагается активный значок вложения . Дополнительные сведения о 
вложениях см. в Глава 5, "Добавление вложений"..

 11 Нажмите кнопку History на боковой панели, чтобы просмотреть историю 
изменений требования. Дополнительные сведения см. в разделе “Просмотр 
истории изменения требования" на стр. 210.

 12 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно Requirement Details.
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Поиск требований
Можно выполнить поиск определенного требования при помощи команды 
Find.

Совет. Функция Text Search, если она доступна, является более мощным 
средством поиска, позволяющим находить ключевые слова и измененные 
формы ключевых слов. Сведения об использовании текстового поиска см. 
в разделе “Поиск записей" на стр. 76.

Поиск требований в дереве Requirements
Можно выполнять поиск требования в дереве требований. Если к дереву 
применены фильтры, поиск будет ограничен отображаемыми 
требованиями.

Чтобы найти требование в дереве требований, выполните следующие 
действия.

 1 Выберите команду Edit > Find. Откроется диалоговое окно Find 
Requirement.

 2 В поле Find in Field выберите критерий поиска. 

 3 В поле Value to Find введите или выберите значение выбранного поля. 
При поиске регистр не учитывается.

 4 Нажмите кнопку Find. Модуль Requirements выполнит поиск требования с 
указанным значением. При успешном завершении поиска откроется 
диалоговое окно Search Results со списком возможных совпадений. 
Выберите результат из списка и нажмите кнопку Go To, чтобы выделить 
требование в дереве требований. При неудачном завершении поиска 
откроется информационное окно.
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Поиск требований в таблице Requirements
В таблице требований можно выполнять поиск требований по значению 
конкретного поля. Если к таблице применены фильтры, поиск будет 
ограничен текущими показанными требованиями.

Чтобы найти требование в таблице требований, выполните 
следующие действия.

 1 Выберите команду Edit > Find. Откроется диалоговое окно Find.

 2 В поле Find in Field выберите поле таблицы.

 3 В поле Value to Find введите или выберите значение поля, которое 
необходимо найти.

 4 Установите флажок Exact Match, если необходимо найти требования, 
значения выбранного поля которых точно совпадают со строкой Value to 
Find.

 5 Установите флажок Case Sensitive, чтобы поиск выполнялся с учетом 
прописных и строчных символов.

 6 Если необходимо использовать звездочки (*) в строке поиска, чтобы 
вводить только часть элемента, установите флажок Use Wildcard.

 7 Нажмите кнопку Find Next. При успешном завершении поиска 
соответствующее требование будет выделено в таблице. При неудачном 
завершении поиска откроется информационное окно.

 8 Нажмите кнопку Find Next еще раз, чтобы найти следующее требование, 
соответствующее критерию.
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Замена значений полей
С помощью команды Replace можно заменять значения полей в дереве 
или таблице требований.

Замена значений полей в дереве Requirements
В дереве требований можно заменять значения полей в выбранном 
требовании и во всех его дочерних требованиях или во всех требованиях.

Чтобы заменить значение поля в дереве требований, выполните 
следующие действия.

 1 Чтобы заменить значения полей в выбранном требовании и во всех его 
дочерних требованиях, выберите команду Edit > Replace > Replace 
Selected. 

Чтобы заменить все значения, выберите команду Edit > Replace > Replace 
All. 

Откроется диалоговое окно Replace.

 2 В поле Find in Field выберите поле, в котором следует заменять значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение, которое будет 
использоваться для замены.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.
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 6 Для поиска точного значения установите флажок Exact Match. 

 7 Для выдачи запроса перед каждой заменой значения установите флажок 
Prompt on replace. 

 8 Нажмите кнопку Replace. Если в шаге 7 был установлен флажок Prompt on 
replace, откроется диалоговое окно Confirm.

➤ Выберите Yes, чтобы заменить текущий экземпляр значения.

➤ Выберите Replace All, чтобы заменить значение в выбранном 
требовании и во всех его дочерних требованиях или во всех 
требованиях в соответствии с выбором в шаге 1.

Откроется диалоговое окно Information с указанием количества замененных 
значений и количества экземпляров, в которых значения заменены не 
были. Нажмите кнопку ОK.

Замена значений полей в таблице Requirements
С помощью команды Replace можно выполнять замену значений полей в 
таблице требований.

Чтобы заменить значение поля в таблице требований, выполните 
следующие действия.

 1 Выберите команду Edit > Replace. Откроется диалоговое окно 
Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск определенного значения. 
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 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение для замены.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы найти точное совпадение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы, установите флажок From 
Beginning.

 8 Чтобы использовать в строке поиска символ звездочки (*) и вводить только 
часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажимите кнопку Replace.

 10 Чтобы заменить все экземпляры значения в таблице, нажмите кнопку 
Replace All.

Просмотр дерева требований
Можно изменять способ отображения дерева требований в модуле 
Requirements. Можно увеличивать и уменьшать масштаб дерева, 
обновлять и фильтровать дерево, а также разворачивать и сворачивать 
ветви дерева.

Изменение масштаба просмотра дерева
В дереве требований можно увеличивать и уменьшать масштаб просмотра 
разделов требований. Это позволяет изменять уровень детализации 
отображения дерева.

Чтобы увеличить масштаб, выполните следующие действия.

 1 Выберите раздел требований в дереве требований.

 2 Нажмите кнопку Zoom In на панели инструментов. Также можно щелкнуть 
требование правой кнопкой мыши и выбрать команду Zoom In.

В дереве требований будет отображаться только выбранный раздел 
требований, а в заголовке будет указан путь к разделу в иерархии.
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Чтобы уменьшить масштаб, выполните следующие действия.

Отменить увеличение масштаба изображения можно, уменьшив его на 
один уровень или до верхнего уровня в иерархии.

➤ Щелкните стрелку Zoom In и выберите команду Zoom Out One Level, 
чтобы отменить предыдущую команду увеличения масштаба.

➤ Щелкните стрелку Zoom In и выберите команду Zoom Out To Root, чтобы 
уменьшить масштаб до верхнего уровня в иерархии и отобразить все 
дерево требований. 

Обновление дерева
Можно обновить данные в дереве для того, чтобы отобразить самые 
актуальные требования. Чтобы обновить дерево, нажмите кнопку Refresh 
All.

Фильтрация требований
В модуле Requirements можно фильтровать и сортировать требования. 
Щелкните стрелку Set Filter/Sort и выберите один из следующих 
вариантов.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать требования в модуле Requirements. 

➤ Clear Filter/Sort. Очистка всех фильтров или параметров сортировки, 
примененных к дереву или таблице требований.

Дополнительные сведения см. в Глава 3, "Работа с данными 
Quality Center"..

Развертывание и свертывание дерева
В дереве требований можно разворачивать и сворачивать ветви. Это 
позволяет изменять уровень детализации отображения дерева.
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Чтобы развернуть или свернуть дерево, выполните следующие 
действия.

➤ Чтобы развернуть ветвь дерева, щелкните значок Expand  слева от 
имени ветви. Чтобы развернуть все уровни ветви, щелкните имя ветви 
правой кнопкой мыши и выберите команду Expand All. 

➤ Чтобы свернуть ветвь дерева, щелкните значок Collapse  слева от имени 
ветви. Чтобы свернуть все уровни ветви, щелкните имя ветви правой 
кнопкой мыши и выберите команду Collapse.

Просмотр истории изменения требования 
В дереве требований можно просматривать список изменений любого 
требования.

Также можно просматривать предыдущие версии требований, 
сохраненные в том или ином базовом состоянии. Дополнительные 
сведения см. в разделе “Просмотр истории изменения базового состояния" 
на стр. 578.

Чтобы просмотреть историю изменения требования, выполните 
следующие действия.

 1 Выберите требование в дереве требований. Перейдите на вкладку History. 
История изменений требования будет показана в таблице.
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Управление версиями. По умолчанию отображается вкладка Versions and 
Baselines. Перейдите на вкладку Audit Log, чтобы просмотреть историю 
изменения требования.

Для каждого изменения требования в таблице отображается дата и время 
изменения, а также имя пользователя, сделавшего изменение. 

 2 Разверните изменение, чтобы просмотреть список измененных полей. Для 
каждого поля в таблице отображаются старое и новое значения. Чтобы 
развернуть все изменения, нажмите кнопку Expand All.

 3 Можно указать, какие изменения должны отображаться в таблице. В списке 
Field выберите имя поля, чтобы просмотреть изменения только этого поля. 
Чтобы просмотреть изменения всех полей, выберите <All>.

Сведения о сохранении изменений полей см. в документе 
HP Quality Center Administrator Guide.
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Отправка требований по электронной почте 
Можно отправлять сообщения электронной почты о требовании другим 
пользователям, работающим над проектом Quality Center. Это позволят 
регулярно информировать их о состоянии требований. В сообщение 
электронной почты включается ссылка, которая позволяет адресату 
переходить прямо к требованию.

Примечание. По умолчанию Quality Center отправляет сообщения 
электронной почты в формате HTML. Чтобы отправить сообщение 
электронной почты в виде обычного текста, измените параметр 
MAIL_FORMAT на вкладке Site Configuration в разделе Site Administration. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.
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Чтобы отправить требование по электронной почте, выполните 
следующие действия. 

 1 Выберите одно или несколько требований и нажмите кнопку Send by Email. 
Откроется диалоговое окно Send Email.

Совет. Предусмотрена возможность автоматической отправки сообщений 
по электронной почте пользователям определенного типа. Для этого 
можно использовать любой столбец требования со значением имени 
пользователя, включая поля, определенные пользователем. Щелкните 
стрелку Send by Email и выберите требуемый вариант. Например, чтобы 
отправить сообщение электронной почты пользователю, составившему 
требование, выберите команду Send by Email to Author.
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 2 Введите допустимый адрес электронной почты или имя пользователя. 
Также можно нажать кнопку To или CC, чтобы выбрать пользователей. 
Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять поиск 
пользователей, распределять пользователей по группам и выбирать 
пользователей из списка или из дерева групп. Дополнительные сведения 
см. в разделе “Выбор пользователей" на стр. 57.

Выберите пользователей или группы пользователей, которым необходимо 
отправить сообщение электронной почты, и нажмите кнопку OK. 

 3 В поле Subject введите тему сообщения электронной почты.

 4 Выберите, следует ли включать дополнительные сведения о требовании 
(Attachments, History, Tests Coverage или Traced Requirements) в 
сообщение. Если установлен флажок Attachments, форматированный 
текст требования будет включен в сообщение в виде отдельного вложения.

 5 В поле Additional comments добавьте необходимые комментарии.

 6 Чтобы проверить орфографию в диалоговом окне, выполните следующие 
действия.
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➤ Нажмите кнопку Check Spelling, чтобы проверить орфографию 
выделенного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии, нажмите кнопку Spelling 
Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить синонимы, 
антонимы или связанные слова для выбранного слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое.

 7 Чтобы настроить сообщение электронной почты, нажмите кнопку Custom. 
В диалоговом окне Select Fields можно указать, какие поля следует 
включить в сообщение электронной почты. 

 8 Нажмите кнопку Send, чтобы отправить сообщение электронной почты.

Изменение требований
Этот раздел, посвященный изменению требований, содержит следующие 
подразделы.

➤ Переименование требований

➤ Копирование требований

➤ Копирование URL-адресов требований

➤ Обновление нескольких требований

➤ Перемещение требований

➤ Удаление требований

Переименование требований
В модуле Requirements можно переименовать требование. Имя не может 
содержать следующие символы: \ ^ *
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Примечание. Корневую папку переименовать нельзя.

Чтобы переименовать требование, выполните следующие действия.

➤ Чтобы переименовать требование в дереве, выберите требование, а затем 
выберите команду Edit > Rename. Также можно щелкнуть требование 
правой кнопкой мыши и выбрать команду Rename. Измените имя 
требования и нажмите клавишу ENTER.

➤ Чтобы переименовать требование в таблице, щелкните имя требования и 
введите новое имя.

Копирование требований
Можно копировать требования в рамках одного проекта или между 
проектами. При копировании раздела требований также выполняется 
копирование всех дочерних требований раздела.

Примечания.

➤ Покрытие тестами, связи дефектов и данные требования для 
управления качеством на основе рисков не копируются.

➤ Чтобы скопировать требование с прослеживаемостью, необходимо 
также скопировать связанные прослеживаемые требования.

➤ Нельзя скопировать корневую папку в рамках одного проекта.

Чтобы скопировать требование, выполните следующие действия.

 1 Выберите требование в дереве или таблице требований. Чтобы 
скопировать несколько требований, нажмите клавишу CTRL и выберите 
требования, которые необходимо скопировать.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy. 
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 3 При копировании требования из таблицы в дерево требований выберите 
команду View > Requirements Tree. Будет показано представление 
Requirements Tree.

 4 Выберите требование в дереве требований.

 5 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste.

Учтите, что при вставке требования с именем, совпадающим с именем уже 
существующего требования, к имени требования будет автоматически 
добавлен суффикс _Copy. 

Копирование URL-адресов требований
Можно скопировать требование и вставить его URL-адрес в качестве 
ссылки. Само требование скопировано не будет. Вместо этого можно 
вставить адрес в другое место, такое как сообщение электронной почты 
или документ. При щелчке ссылки будет открыто окно Quality Center и 
выполнен переход к требованию. Если вход в систему еще не выполнен, 
сначала будет показано приглашение Quality Center для входа в систему. 

Чтобы скопировать URL-адрес требования, выполните следующие 
действия.

 1 Выберите требование в дереве или таблице требований. 

 2 Выберите команду Edit > Copy URL. Также можно щелкнуть элемент 
правой кнопкой мыши и выбрать команду Copy URL.

 3 Вставьте URL-адрес.

Обновление нескольких требований
Можно обновлять значение поля в нескольких записях дерева или таблицы 
требований. Чтобы обновить поля, выберите записи в таблице или 
выберите требования в дереве. Выберите команду Edit > Update Selected. 
Откроется диалоговое окно Update Selected. Дополнительные сведения см. 
в разделе “Обновление нескольких записей" на стр. 74.
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Перемещение требований
Требование можно переместить в другое местоположение в дереве 
требований. Перемещение требования также ведет к перемещению 
дочерних требований, покрытия тестами, связей прослеживаемости 
требований и связей с дефектами. Переместить корневую папку нельзя.

Совет. Требование также можно переместить в новое местоположение в 
дереве требований перетаскиванием.

Чтобы переместить требование, выполните следующие действия.

 1 Выберите требование в дереве требований. Чтобы переместить несколько 
требований, нажмите клавишу CTRL и выберите требования для 
перемещения.

 2 Выберите команду Edit > Cut или щелкните требование правой кнопкой 
мыши и выберите команду Cut.

 3 Выберите требование в дереве требований.

 4 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste. 

Удаление требований
Можно удалить требование из модуля Requirements. Удаление требования 
также ведет к удалению дочерних требований, покрытия тестами, связей 
прослеживаемости требований и связей с дефектами. Учтите, что 
корневую папку удалить нельзя.

Управление версиями. При удалении требования удаляются все 
предыдущие версии этого требования.

Чтобы удалить требование, выполните следующие действия.

 1 Выберите требование. Чтобы удалить несколько требований, нажмите 
клавишу CTRL и выберите требования для удаления.

 2 Нажмите кнопку Delete или щелкните правой кнопкой мыши и выберите 
команду Delete.
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 3 Нажмите кнопку Yes для подтверждения.

Создание тестов из требований
После создания дерева требований требования используются в качестве 
основы для определения тестов дерева плана тестирования и выполнения 
тестов в наборе тестов. Учтите, что для создания тестов необходимы 
соответствующие разрешения.

Создавать тесты из требований можно двумя способами.

➤ Преобразование требований в тесты. Преобразование требований в 
тесты в указанном объекте дерева плана тестирования. Можно 
преобразовать выбранные требования или все требования в дереве 
требований. Этот способ с использованием мастера Convert to Tests 
помогает при разработке дерева плана тестирования. См. раздел 
“Преобразование требований в тесты" на стр. 219.

➤ Создание теста из требований. Преобразование требований в тест в 
указанном объекте дерева плана тестирования и указанном наборе тестов 
в модуле Test Lab. Этот способ с использованием диалогового окна 
Generate Test, обеспечивает быстрое выполнение теста при анализе 
требований. См. раздел “Создание теста из требований" на стр. 224.

Преобразование требований в тесты
С помощью мастера Convert to Tests выполняется преобразование 
требований в тесты в указанном объекте дерева плана тестирования. 
Покрытие тестами между требованиями и соответствующими тестами 
будет создано автоматически.

Чтобы преобразовать требования в тесты, выполните следующие 
действия.

 1 Чтобы преобразовать конкретное требование, выберите его в дереве 
требований. Чтобы преобразовать все требования, выберите корневую 
папку требований в дереве требований.
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 2 Выберите команду Requirements > Convert to Tests.

Откроется диалоговое окно Step 1.

 3 Выберите способ автоматического преобразования.

➤ Выберите вариант Convert lowest child requirements to design steps, 
чтобы выполнить преобразование всех дочерних требований низшего 
уровня в шаги тестов, требований следующего уровня — в тесты, а 
требований всех остальных более высоких уровней — в объекты.

➤ Выберите вариант Convert lowest child requirements to tests, чтобы 
выполнить преобразование всех дочерних требований низшего уровня в 
тесты, а требований всех остальных более высоких уровней — в 
объекты.

➤ Выберите вариант Convert all requirements to subjects, чтобы 
преобразовать все выбранные требования в объекты.
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 4 Нажмите кнопку Next, чтобы начать преобразование требований. Чтобы 
отменить процесс преобразования и вернуться к диалоговому окну Step 1, 
нажмите кнопку Stop в окне индикатора выполнения. По завершении 
процесса преобразования результаты будут показаны в диалоговом окне 
Step 2.

Примечание. При преобразовании одного требования это диалоговое окно 
не будет показано.

 5 Чтобы просмотреть условные обозначения мастера, щелкните ссылку 
Legend.
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 6 Для каждого преобразованного элемента можно выполнить следующие 
операции.

➤ Выберите элемент и нажмите кнопку Convert to Subject или щелкните 
элемент правой кнопкой мыши и выберите команду Subject, чтобы 
преобразовать элемент в объект в дереве плана тестирования. После 
этого дочерние элементы могут быть объектами или тестами. Учтите, 
что имена объектов должны быть уникальными.

➤ Выберите элемент и нажмите кнопку Convert to Test или щелкните 
элемент правой кнопкой мыши и выберите команду Test, чтобы 
преобразовать элемент в тест в дереве плана тестирования. После 
этого дочерние элементы будут преобразованы в шаги. Учтите, что 
имена тестов должны быть уникальными.

➤ Выберите элемент и нажмите кнопку Convert to Step или щелкните 
элемент правой кнопкой мыши и выберите команду Step, чтобы 
преобразовать элемент в шаг в дереве плана тестирования. После 
этого дочерние элементы будут преобразованы в описания шага.

➤ Выберите элемент и нажмите кнопку Convert to Description или 
щелкните элемент правой кнопкой мыши и выберите команду 
Description, чтобы преобразовать элемент в описание шага в дереве 
плана тестирования. После этого дочерние элементы будут 
преобразованы в структурированный текст описания.

➤ Выберите элемент и нажмите кнопку Exclude from Conversion или 
щелкните элемент правой кнопкой мыши и выберите команду Exclude, 
чтобы исключить элемент из дерева плана тестирования.

 7 Снимите флажок Auto Complete Children, если при внесении изменений 
помощь мастера не нужна. Если этот флажок установлен, и уровень 
родительского элемента изменяется, например с объекта на тест, мастер 
изменит уровень всех дочерних элементов с тестов на шаги тестов.
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 8 Нажмите кнопку Next. Откроется диалоговое окно Step 3.

 9 В разделе Destination Subject Path нажмите кнопку Select Subject, чтобы 
выбрать объект в дереве плана тестирования в диалоговом окне Select 
Destination Subject. Также можно ввести имя нового объекта. По умолчанию 
папка объектов и тесты помещаются в папку Subject модуля Test Plan. 

 10 Нажмите кнопку Finish. 

 11 Чтобы остановить процесс преобразования и вернуться к диалоговому окну 
Step 3, нажмите кнопку Stop в окне индикатора выполнения. 

Примечание. Если процесс преобразования был остановлен, уже 
преобразованные требования не будут удалены из дерева плана 
тестирования. Удалите такие требования вручную.

 12 Нажмите кнопку OK, чтобы закрыть мастер Convert to Tests или 
просмотреть сообщения об ошибках.
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Создание теста из требований
Используйте диалоговое окно Generate Test, чтобы преобразовать 
требования в тест в указанном объекте дерева плана тестирования и 
указанном наборе тестов в модуле Test Lab. Покрытие тестами между 
требованиями и соответствующими тестами будет создано автоматически. 
Учтите, что по умолчанию нельзя создать тест для следующих типов 
требований, не поддерживающих покрытие тестами: Business, Folder и 
Group.

Чтобы создать тест из требований, выполните следующие действия.

 1 Выберите требование, а затем выберите команду Requirements > 
Generate Test. Также можно щелкнуть требование правой кнопкой мыши в 
дереве требований и выбрать команду Generate Test. Откроется 
диалоговое окно Generate Test.

 2 В поле Subject выберите объект из дерева плана тестирования или 
введите имя нового объекта. По умолчанию тест помещается в папку 
Temporary Tests модуля Test Plan.

 3 В поле Test Name введите имя для нового теста. По умолчанию в качестве 
имени нового теста используется имя требования.

 4 В поле Test Status выберите статус теста. 

 5 Если создавать шаги тестов нет необходимости, снимите флажок Create 
Design Steps. Если этот флажок установлен, для каждого дочернего 
требования к тесту будет добавлен шаг.
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 6 Установите флажок Add Test to Test Set, чтобы добавить тест в набор 
тестов в модуле Test Lab. В списке Test Set выберите набор тестов или 
введите имя нового набора тестов.

 7 Нажмите кнопку ОK.
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14 
Отслеживание требований

Прослеживаемость требований устанавливает взаимосвязи между 
требованиями. При изменении требований или связанных с ними 
требований можно отслеживать и контролировать воздействие этих 
изменений на связанные требования.

Quality Center Выпуски. Прослеживаемость требований доступна в 
выпусках Quality Center Enterprise Edition и Quality Center Premier Edition.

Эта глава содержит следующие разделы.

 ➤  Об отслеживании требований на стр. 228

 ➤  Определение взаимосвязей прослеживаемости на стр. 231

 ➤  Просмотр взаимосвязей прослеживаемости на стр. 234

 ➤  Просмотр влияния прослеживаемости на стр. 236

 ➤  Удаление взаимосвязей прослеживаемости на стр. 238



Глава 14 • Отслеживание требований

228

Об отслеживании требований
Прослеживаемость требований определяет взаимосвязь между двумя или 
более требованиями. При анализе воздействия, которое окажет 
изменение, предлагаемое в определенном требовании, связи 
прослеживаемости указывают на другие требования, на которые может 
повлиять это изменение.

После определения требований в дереве требований (см. Глава 13, 
"Создание дерева требований") можно установить прослеживаемость 
между требованиями. Добавлять связи прослеживаемости, направленные к 
выбранному требованию и от него, можно на вкладке Requirements 
Traceability представления Requirement Details. Связи Trace from 
указывают требования, которые влияют на выбранное требование. Связи 
Trace to указывают требования, на которые влияет выбранное требование.

При изменении требования Quality Center оповещает требования, на 
которые данное изменение оказывает воздействие. Эти оповещения могут 
видеть все пользователи. Quality Center также отправляет уведомления по 
электронной почте авторам требований, которые затронуты изменением. 
Дополнительные сведения об оповещениях см. в Глава 4, "Оповещение об 
изменениях".
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Пример прослеживаемости требований
Чтобы реализовать взаимосвязь между требованиями, предположим, что 
требования Requirement_1B и Requirement_2B оказывают влияние на 
требование Requirement_1A. Выберите требование Requirement_1A в 
дереве требований. На вкладке Relationships добавьте требования 
Requirement_1B и Requirement_2B в таблицу Trace From. 

При выборе требования Requirement_1B в дереве требований в таблице 
Trace To будет указано, что требование Requirement_1B прослеживается 
до требования Requirement_1A. 
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При выборе требования Requirement_2B в дереве требований в таблице 
Trace To будет указано, что требование Requirement_2B прослеживается 
до требования Requirement_1A. 

При изменении требования Quality Center устанавливает флажки для 
требований, до которых выполняется прослеживание, и направляет по 
электронной почте уведомления авторам требований, чтобы они оценили 
воздействие изменения на свои требования. Например, при изменении 
требования Requirement_1B или Requirement_2B Quality Center оповещает 
требование Requirement_1A и уведомляет его автора. Оповещения могут 
видеть все пользователи.
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Определение взаимосвязей прослеживаемости
Устанавливать взаимосвязи прослеживаемости между требованиями 
можно на вкладке Relationships. Эта вкладка содержит таблицы Trace From 
и Trace To. В таблице Trace From отображаются требования, которые 
влияют на выбранное требование. В таблице Trace To отображаются 
требования, на которые влияет выбранное требование.

Чтобы установить взаимосвязь, выберите требование в дереве требований 
или введите идентификатор требования. 

Чтобы установить взаимосвязь с помощью дерева требований, 
выполните следующие действия.

 1 В представлении Requirement Details выберите требование в дереве 
требований и перейдите на вкладку Requirements Traceability. По 
умолчанию отображается вкладка Relationships.

 2 Щелкните стрелку Show/Hide, чтобы отобразить таблицу Trace From или 
Trace To. 

 3 На вкладке Relationships нажмите кнопку Add Requirement Traceability , 
чтобы открыть дерево требований в правой области.
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 4 Чтобы выполнить поиск определенного требования в дереве, введите имя 
(или часть имени) требования в поле Find и нажмите кнопку Find. При 
успешном завершении поиска требование будет выделено в дереве.

 5 Для фильтрации или сортировки требований в дереве нажмите кнопку Set 
Filter/Sort. Дополнительные сведения о фильтрации и сортировке записей 
см. в Глава 3, "Работа с данными Quality Center". 

 6 Чтобы обновить дерево, нажмите кнопку Refresh All. 

 7 Выберите требование, чтобы добавить его в таблицу.

➤ Щелкните стрелку Add to Traceability и выберите команду Add to 
Traceability (Trace To), чтобы добавить требование в таблицу Trace To.

➤ Щелкните стрелку Add to Traceability и выберите команду Add to 
Traceability (Trace From), чтобы добавить требование в таблицу Trace 
From.

Требование будет добавлено в таблицу.

Совет. Также можно добавлять связи прослеживаемости требования 
путем перетаскивания требования из дерева в соответствующую таблицу.

 8 Нажмите кнопку Close, чтобы скрыть дерево требований, показанное в 
правой области.

Чтобы установить взаимосвязь путем ввода идентификатора 
требования, выполните следующие действия.

 1 В представлении Requirement Details выберите требование в дереве 
требований и перейдите на вкладку Requirements Traceability. По 
умолчанию отображается вкладка Relationships.

 2 Щелкните стрелку Show/Hide, чтобы отобразить таблицу Trace From или 
Trace To. 

 3 Нажмите кнопку Add Requirement Traceability и выберите один из 
следующих вариантов.

➤ By ID (Trace From). Добавление связи прослеживаемости в таблицу 
Trace From путем ввода идентификатора требования.
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➤ By ID (Trace To). Добавление связи прослеживаемости в таблицу Trace 
To путем ввода идентификатора требования.

Откроется диалоговое окно Trace Existing Requirement.

 4 Введите идентификатор требования, которое необходимо добавить, и 
нажмите кнопку Trace. Требование будет добавлено в указанную таблицу.
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Просмотр взаимосвязей прослеживаемости
На вкладке Relationships можно отобразить взаимосвязи 
прослеживаемости между требованиями. Эта вкладка содержит таблицы 
Trace From и Trace To. В таблице Trace From отображаются требования, 
которые влияют на выбранное требование. В таблице Trace To 
отображаются требования, на которые влияет выбранное требование. 

Кроме столбцов, описанных в разделе “Поля модуля Requirements" на 
стр. 186, вкладка Relationships также может содержать следующие 
столбцы.

Столбец Описание

Created By Имя пользователя, создавшего связь для требования. По 
умолчанию используется имя пользователя, 
выполнившего вход в систему. 

Creation Date Дата создания связи для требования. По умолчанию в 
качестве даты создания используется текущая дата 
сервера баз данных.
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Чтобы просмотреть взаимосвязи прослеживаемости, выполните 
следующие действия.

 1 В представлении Requirement Details выберите требование в дереве 
требований и перейдите на вкладку Requirements Traceability. По 
умолчанию отображается вкладка Relationships.

 2 Чтобы обновить таблицы, нажмите кнопку Refresh All. 

 3 Чтобы настроить внешний вид и порядок отображения столбцов, нажмите 
стрелку Select Columns и выберите команду Select Column (Trace From) 
или Select Column (Trace To). Откроется диалоговое окно Select Columns. 
Дополнительные сведения см. в разделе “Упорядочивание столбцов" на 
стр. 54.

 4 Чтобы отобразить прослеживаемое требование в дереве, выберите 
требование и нажмите кнопку Go To Requirement.

 5 Чтобы просмотреть сведения о прослеживаемом требовании, выберите 
это требование и нажмите кнопку Requirement Details. Откроется 
диалоговое окно Requirement Details. Дополнительные сведения см. в 
разделе “Обновление требований" на стр. 201.

Modified Дата и время изменения связи для требования. По 
умолчанию используется текущая дата и время сервера 
баз данных.

Requirement Trace 
ID

Уникальный буквенно-цифровой идентификатор связи 
для требования, назначаемый автоматически.

Trace Comment Комментарии к связи для требования.

Столбец Описание
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Просмотр влияния прослеживаемости
После установления взаимосвязей прослеживаемости можно 
проанализировать влияние изменений требований путем просмотра 
взаимосвязей. Вкладка Impact Analysis помогает понять многочисленные 
связи и зависимости между требованиями, отображая их в виде 
иерархической структуры дерева. В отличие от вкладки Relationships, на 
вкладке Impact Analysis отображаются требования, на которые оказывают 
влияние изменения, а также их родительские и дочерние требования. 

В дереве Trace From отображаются требования, которые влияют на 
выбранное требование. Например, в дереве Trace From видно, что 
требование Req_A прослеживается от требования Requirement_1B. 
Требование Requirements является родительским требованием для 
требования Req_A. Требование Req_B является родительским 
требованием для требования Requirement_1B. 
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В дереве Trace To отображаются требования, на которые влияет 
выбранное требование. Например, в дереве Trace To видно, что 
требование Requirement_1B прослеживается до требования Req_A. 
Требования Requirement_1A – Requirement_4A являются дочерними 
требованиями для требования Req_A, и на них влияет требование Req_A. 

Вкладка Impact Analysis содержит следующие значки.

Значок Описание

Дочернее требование, на которое влияет изменение выбранного 
требования.

Родительское требование, которое влияет на выбранное 
требование.

Требование, к которому выполняется прослеживание.

Требование, от которого выполняется прослеживание.

Рекурсивная взаимосвязь между требованиями.
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Чтобы просмотреть влияние прослеживаемости, выполните 
следующие действия.

 1 В представлении Requirement Details выберите требование в дереве 
требований и перейдите на вкладку Requirements Traceability. По 
умолчанию отображается вкладка Relationships.

 2 Перейдите на вкладку Impact Analysis.

 3 Чтобы обновить дерево, нажмите кнопку Refresh All. 

 4 Чтобы отобразить прослеживаемое требование в дереве, выберите 
требование и нажмите кнопку Go To Requirement.

 5 Чтобы просмотреть сведения о прослеживаемом требовании, выберите 
это требование и нажмите кнопку Requirement Details. Откроется 
диалоговое окно Requirement Details. Дополнительные сведения см. в 
разделе “Обновление требований" на стр. 201.

Удаление взаимосвязей прослеживаемости
Удалять взаимосвязи прослеживаемости можно на вкладке Relationships.

Чтобы удалить взаимосвязь прослеживаемости, выполните 
следующие действия.

 1 В представлении Requirement Details выберите требование в дереве 
требований и перейдите на вкладку Requirements Traceability. По 
умолчанию отображается вкладка Relationships.

 2 Щелкните стрелку Show/Hide, чтобы отобразить таблицу Trace From или 
Trace To. 

 3 В соответствующей таблице выберите взаимосвязь прослеживаемости. 
Для выбора нескольких взаимосвязей нажмите клавишу CTRL и выберите 
взаимосвязи, которые необходимо удалить.

 4 Нажмите кнопку Remove from Traceability или щелкните правой кнопкой 
мыши и выберите команду Remove from Traceability.

 5 Нажмите кнопку Yes для подтверждения.
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15 
Расчет рисков требований

Управление качеством на основе рисков может помочь определить 
стратегию тестирования в соответствии с имеющимися требованиями.

Quality Center Выпуски. Управление качеством на основе рисков доступно 
в выпусках Quality Center Enterprise Edition и Quality Center Premier Edition.

Эта глава содержит следующие разделы.

 ➤  О расчете рисков требований на стр. 240

 ➤  Процесс управления качеством на основе рисков на стр. 241

 ➤  Оценка требований на стр. 243

 ➤  Определение параметров политики тестирования на стр. 249

 ➤  Завершение определения политики тестирования на стр. 251

 ➤  Анализ стратегии тестирования на стр. 255

 ➤  Пример управления качеством на основе рисков на стр. 260
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О расчете рисков требований
Обычно при разработке плана тестирования требований ресурсы 
ограничены и каждое требование не может быть протестировано 
полностью. Поэтому необходимо прийти к определенному компромиссу и 
выполнять частичное тестирование только тех требований, критичность 
которых для бизнеса низка, или требований, реализация которых связана с 
минимальными рисками. Функция управления качеством на основе рисков 
позволяет выполнять расчет уровня тестирования каждого требования 
исходя из характера требования и доступных ресурсов. Затем на основе 
этих рекомендаций можно приступить к планированию процесса 
тестирования.

Для каждого типа требований можно включить функцию управления 
качеством на основе риска. Каждое требование, для которого включено 
управление качеством на основе рисков, может поддерживать анализ 
рисков (требование анализа) или отдельную оценку риска (требование 
оценки).

➤ Требование анализа — это требование, которое принадлежит к типу 
требований, имеющих более высокий уровень в иерархии дерева 
требований, например к типу Folder. Анализ рисков для требований 
анализа выполняется на основании требований оценки, расположенных в 
дереве ниже требований анализа. 

Результаты определения рисков нескольких требований оценки 
объединяются и образуют общий анализ рисков, который может 
использоваться для определения трудозатрат и стратегии тестирования.

➤ Требование оценки — это требование, которое принадлежит к типу 
требований, являющихся дочерними по отношению к требованиям 
анализа, и расположенных на более низком уровне в иерархии дерева. 
Требования оценки, расположенные в конкретном требовании анализа, 
образуют основу для анализа рисков этого требования анализа.

Работа с функцией управления качеством на основе рисков 
осуществляется в представлении Requirement Details модуля 
Requirements. Функцию управления качеством на основе рисков также 
можно использовать в представлении Risk диалогового окна Requirement 
Details.
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Можно настроить параметры по умолчанию для функции управления 
качеством на основе рисков Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide:

Процесс управления качеством на основе рисков
Анализ управления качеством на основе рисков для требования анализа 
включает следующие этапы. 

Оценка требований
Для каждого требования оценки, расположенного в требовании анализа, 
определяются категории рисков и функциональной сложности.

➤ Категория рисков Risk Category состоит из двух факторов: 
бизнес-критичность и вероятность сбоя. Бизнес-критичность определяет 
критичность требования для деятельности компании. Вероятность сбоя 
служит мерой вероятности сбоя теста, созданного на основе требования. 

➤ Категория функциональной сложности показывает сложность 
реализации требования.

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements

Определение
категорий рисков

Определение параметров
политики тестирования

Окончательное оформление
политики тестирования

Анализ стратегии
тестирования
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Дополнительные сведения см. в разделе “Оценка требований" на стр. 243.

Определение параметров политики тестирования
После определения категорий рисков и функциональной сложности для 
требований оценки, расположенных внутри требования анализа, 
необходимо определить начальные параметры тестирования требования 
анализа и вложенных требований оценки. Эти параметры включают время, 
отводимое требованию с определенной функциональной сложностью при 
условии его полного тестирования, и время, необходимое для частичного 
или базового тестирования требования. Также необходимо определить 
уровень тестирования требований для каждой категории рисков и 
функциональной сложности. Дополнительные сведения см. в разделе 
“Определение параметров политики тестирования" на стр. 249.

Завершение определения политики тестирования
После определения параметров политики тестирования Quality Center 
вычисляет общее расчетное время тестирования для требования анализа 
и расположенных внутри него требований оценки. Необходимо 
определить, сколько времени выделять для тестирования этих требований. 
После этого можно скорректировать политику тестирования, чтобы иметь 
достаточно времени для выполнения всех тестов и не расходовать 
ресурсы зря. Дополнительные сведения см. в разделе “Завершение 
определения политики тестирования" на стр. 251.

Анализ стратегии тестирования
После принятия окончательного решения о том, какое количество ресурсов 
следует выделить каждому требованию, можно просмотреть отчет и 
проанализировать сделанные выводы. Дополнительные сведения см. в 
разделе “Анализ стратегии тестирования" на стр. 255.

Пример использования функции управления качеством на основе рисков 
при принятии решения о выборе стратегии тестирования требования см .в 
разделе “Пример управления качеством на основе рисков" на стр. 260.
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Оценка требований
Для каждого требования оценки в требовании анализа определяются или 
рассчитываются значения рисков и функциональной сложности. Категория 
рисков состоит из бизнес-критичности и вероятности сбоя. Категория 
функциональной сложности показывает сложность реализации 
требования. 

Определение бизнес-критичности, вероятности сбоя и функциональной 
сложности требования выполняется либо путем непосредственного 
присвоения значений, либо путем присвоения значений набору критериев. 
Если эти факторы не определены для требования, Quality Center не 
включает требование в анализ рисков.

Можно настраивать эти критерии, их возможные значения и то, как эти 
значения определяют бизнес-критичность, вероятность сбоя и 
функциональную сложность. Можно также настроить использование 
бизнес-критичности и вероятности сбоя для расчета рисков. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide:

Чтобы оценить требование, выполните следующие действия.

 1 В представлении Requirement Details модуля Requirements выберите 
требование оценки и перейдите на вкладку Risk. 

 2 Перейдите на вкладку Risk Assessment.

 3 Определите категорию рисков для выбранного требования. 
Дополнительные сведения см. в разделе “Определение категории рисков" 
на стр. 244.

 4 Определите категорию функциональной сложности для выбранного 
требования. Дополнительные сведения см. в разделе “Определение 
категории функциональной сложности" на стр. 247.
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 5 В нижней части вкладки Risk в поле Estimated development time можно 
ввести расчетное время, необходимое для разработки требования. После 
этого Quality Center сможет рассчитать общее расчетное время разработки 
требования анализа и его дочерних требований как сумму расчетного 
времени разработки дочерних требований. Указывать расчетное время 
разработки необязательно, и эти значения не оказывают влияния на 
анализ рисков 

 6 Чтобы пропускать требование оценки при выполнении анализа рисков, 
установите флажок Exclude from Analysis, расположенный в верхней 
части вкладки Risk.

Определение категории рисков
Категорию рисков требования оценки можно назначить или рассчитать. 
Категория рисков состоит из бизнес-критичности и вероятности сбоя. 

Бизнес-критичность требования представляет собой оценку важности 
требования для деятельности компании. Возможны три значения: A - 
Critical, B - Important и C - Nice to Have. Например, требованию, 
оказывающему влияние на менее важную функцию, которая будет 
использоваться редко, можно назначить бизнес-критичность Nice to Have, а 
требованию, являющемуся существенным для функциональности 
приложения, может быть назначена бизнес-критичность Critical.

Вероятность сбоя требования служит мерой вероятности сбоя теста для 
этого требования. Возможны три значения: 1 - High, 2 - Medium и 3 - Low. 
Например, требованию, для реализации которого требуется внесение 
значительных изменений в большинство компонентов приложения, скорее 
всего будет назначена вероятность сбоя High. И, наоборот, требование, 
для реализации которого необходимо изменить лишь значок в приложении, 
имеет немного связанных с ним рисков, и поэтому ему может быть 
назначена вероятность сбоя Low.
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Чтобы определить категорию рисков для требования, выполните 
следующие действия.

 1 Чтобы определить значение бизнес-критичности требования, выполните 
следующие операции.

 a На вкладке Risk Assessment выберите вкладку Business Criticality. На 
вкладке Business Criticality отображается перечень критериев, 
используемых для определения бизнес-критичности.

 b Назначьте значение каждому критерию. Чтобы назначить значение 
критерия, в столбце Criterion щелкните имя критерия и выберите 
значение в столбце Value. Просмотреть описание критерия можно в 
поле Description of Criterion.

После определения значения каждого критерия выполняется 
обновление расчетной бизнес-критичности в соответствии с новыми 
значениями критериев.
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 c Чтобы пропустить значение бизнес-критичности, рассчитанное на 
основании значений критериев, и при анализе рисков использовать 
вместо него значение, назначенное пользователем, установите флажок 
Override calculated value. В поле Use custom Business Criticality 
выберите значение бизнес-критичности, которое необходимо 
использовать при выполнении анализа рисков.

 2 Чтобы определить значение вероятности сбоя для требования, выполните 
следующие операции.

 a Перейдите на вкладку Failure Probability.

 b Назначьте значение каждому критерию. Чтобы назначить значение 
критерия, в столбце Criterion щелкните имя критерия и выберите 
значение в столбце Value. Просмотреть описание критерия можно в 
поле Description of Criterion.

После определения значения каждого критерия выполняется 
обновление значения расчетной вероятности сбоя Calculated Failure 
Probability в соответствии с новыми значениями критериев.
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 c Чтобы пропустить значение вероятности сбоя, рассчитанное на 
основании значений критериев, и при анализе рисков использовать 
вместо него значение, назначенное пользователем, установите флажок 
Use custom Failure Probability. В поле Use custom Failure Probability 
выберите значение вероятности сбоя, которое необходимо 
использовать при выполнении анализа рисков.

 3 Чтобы пропустить значение расчетного риска, вычисленное на основании 
значений бизнес-критичности и вероятности сбоя, и при анализе рисков 
использовать вместо него значение, назначенное пользователем, 
установите флажок Use custom Risk. В поле Use custom Risk выберите 
значение, которое необходимо использовать при выполнении анализа 
рисков.

Определение категории функциональной сложности
Категорию функциональной сложности требования оценки можно 
назначить или рассчитать. Категория функциональной сложности 
требования показывает сложность реализации требования. Возможны три 
значения: 1 - High, 2 - Medium и 3 - Low. Например требование, 
реализация которого предусматривает существенные изменения в 
приложении для обеспечения связи с другими системами, скорее всего 
имеет высокую сложность, и ему будет назначено значение 
функциональной сложности High. И наоборот, требование, для реализации 
которого не требуется существенных изменений в приложении для 
обеспечения связи с другими системами, имеет немного связанных с ним 
рисков, и поэтому ему может быть назначено значение функциональной 
сложности Low.
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Чтобы определить категорию функциональной сложности 
требования, выполните следующие действия.

 1 На вкладке Risk выберите вкладку Functional Complexity. На вкладке 
Functional Complexity отображается перечень критериев, используемых для 
определения функциональной сложности.

 2 Назначьте значение каждому критерию. Чтобы назначить значение 
критерия, в столбце Criterion щелкните имя критерия и выберите значение 
в столбце Value. Просмотреть описание критерия можно в поле 
Description of Criterion.

После определения значения каждого критерия выполняется обновление 
значения расчетной функциональной сложности Calculated Functional 
Complexity в соответствии с новыми значениями критериев.
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 3 Чтобы пропустить значение функциональной сложности, рассчитанное на 
основании значений критериев, и при анализе рисков использовать вместо 
него значение, назначенное пользователем, установите флажок Use 
custom Functional Complexity. В поле Use custom Functional Complexity 
выберите значение, которое необходимо использовать при выполнении 
анализа рисков.

Определение параметров политики тестирования
После определения рисков и функциональной сложности для каждого 
требования определите время, в течение которого должно тестироваться 
каждое требование. Время, необходимое для тестирования требования, 
определяется функциональной сложностью требования. Как правило, для 
требования с высокой функциональной сложностью требуется большее 
время тестирования, поскольку велика вероятность того, что реализация 
требования содержит дефекты. Для каждой функциональной сложности 
определяется время тестирования, необходимое для полного 
тестирования требования с этим значением функциональной сложности. 

В Quality Center используются четыре уровня тестирования: Full, Partial, 
Basic и None. Для частичного и базового тестирования необходимое время 
тестирования для требования определяется как доля времени полного 
тестирования (в процентах). Например, если для полного тестирования 
требования необходимо 20 часов, а для частичного тестирования 
установлено 75% от продолжительности полного тестирования, 
Quality Center рассчитает, что для выполнения частичного тестирования 
требования необходимо 15 часов. Требование, для которого установлен 
уровень тестирования None, не тестируется вообще, и поэтому значение 
Testing Effort для него равно нулю.

После определения времени тестирования для каждого уровня 
тестирования и функциональной сложности можно оценить уровень 
тестирования требований. Для каждой категории рисков и функциональной 
сложности назначается уровень тестирования. 

Можно настроить политику тестирования, используемую по умолчанию. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide:
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Чтобы определить параметры политики тестирования для 
требования, выполните следующие действия.

 1 В представлении Requirement Details модуля Requirements выберите 
требование анализа и перейдите на вкладкуRisk. Нажмите кнопку Show , 
чтобы отобразить раздел Change Analysis Constants.

 2 В разделе Testing Time (full) per Functional Complexity для каждого 
значения функциональной сложности введите расчетное время полного 
тестирования для требования.

 3 В разделе Testing level в полях Partial и Basic введите время 
тестирования по умолчанию, необходимое для частичного и базового 
тестирования требования. Эти значения вводятся в процентах от 
длительности полного тестирования.
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 4 В таблице Testing Policy укажите уровень тестирования требования для 
каждой категории рисков и функциональной сложности.

Чтобы определить эти уровни, щелкните кнопки со стрелками вниз рядом с 
ячейками таблицы. Выберите уровень тестирования из доступных 
значений. Доступные уровни тестирования: Full, Partial, Basic и None. 
Рядом с каждым уровнем тестирования указано расчетное время, 
необходимое для тестирования требования на данном уровне, с учетом 
ресурсов и уровней тестирования, определенных пользователем.

 5 Чтобы отобразить константы, используемые по умолчанию, нажмите 
кнопку Show Defaults. Откроется диалоговое окно Risk-Based Quality 
Management Constants Defaults.

В диалоговом окне Risk-Based Quality Management Constants Defaults 
нажмите кнопку Restore Defaults, чтобы присвоить эти значения по 
умолчанию константам, использующимся в текущем требовании.

Нажмите кнопку Close, чтобы закрыть диалоговое окно Risk-Based Quality 
Management Constants Defaults.

Завершение определения политики тестирования
На основании определенной политики тестирования Quality Center может 
вычислить общее расчетное время тестирования для требования анализа 
и расположенных внутри него требований оценки. Чтобы не допустить 
превышения доступного времени тестирования, следует оценить, какое 
время доступно для тестирования этих требований, и внести корректировки 
в политику тестирования.

Например, для тестирования требования доступно 100 часов. 
Quality Center подсчитывает, что для тестирования этого требования с 
текущими уровнями тестирования необходимо 120 часов. Пользователь 
принимает решение о снижении уровня тестирования для требований с 
риском Low и функциональной сложностью Medium с Partial до Basic. После 
корректировки уровня тестирования и пересчета времени тестирования 
Quality Center определяет, что для выполнения тестирования необходимо 
98 часов, что соответствует имеющемуся ресурсу времени. Теперь можно 
разработать план тестирования требования на основе рекомендаций 
Quality Center.
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Чтобы завершить определение политики тестирования, выполните 
следующие действия.

 1 Убедитесь, что категории рисков и функциональной сложности определены 
для всех требований оценки в требовании анализа, для которого 
необходимо завершить определение политики тестирования, и которое 
следует включить в анализ рисков. Дополнительные сведения см. в 
разделе “Оценка требований" на стр. 243.

 2 Чтобы включить в анализ рисков только определенные требования оценки, 
можно применить фильтр к дереву требований. Дополнительные сведения 
о фильтрации см. в разделе “Фильтрация записей" на стр. 59.

 3 Если значения Testing Effort и Testing Level по умолчанию не должны 
использоваться, определите для них пользовательские значения. 
Дополнительные сведения см. в разделе “Определение параметров 
политики тестирования" на стр. 249.

 4 В представлении Requirement Details модуля Requirements выберите 
требование анализа и перейдите на вкладкуRisk.
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 5 В поле Total allocated testing time введите время, доступное для 
тестирования требования анализа и расположенных в нем требований 
оценки.

 6 Нажмите кнопку Perform Risk Analysis. Quality Center рассчитает уровень 
тестирования и время тестирования для каждого требования оценки в 
требовании анализа, соответствующего текущему фильтру. Этот расчет 
основан на категории рисков требования оценки, а также на значениях 
уровня и времени тестирования, определенных для требования анализа. 
Результаты расчета отображаются следующим образом.

➤ Total required testing time. Общее расчетное время, необходимое для 
тестирования всех требований оценки в требовании анализа, 
соответствующих текущему фильтру и включенных в анализ рисков.

➤ Total required development time. Общее время, необходимое для 
разработки всех требований оценки в требовании анализа, на основе 
необходимого для разработки времени, оценка которого была 
выполнена отдельно для каждого требования оценки.

➤ Диаграмма No. of Requirements per Risk Category. Число дочерних 
требований требования анализа для каждой категории рисков.

➤ Диаграмма Total Testing Time per Risk Category. Общее расчетное 
время, необходимое для тестирования всех требований каждой 
категории рисков.

 7 Чтобы просмотреть, какие требования были включены в анализ, а какие — 
нет, щелкните сегмент на диаграмме Requirements per Risk или ссылки 
missing assessment и not assessable. Откроется диалоговое окно Drill 
Down Results c таблицей требований данной категории. Можно определить 
порядок отображения и внешний вид столбцов, а также просмотреть 
сведения для отдельного требования. Также можно экспортировать 
содержимое таблицы в виде текстового файла, электронной таблицы 
Microsoft Excel, документа Microsoft Word или HTML. Дополнительные 
сведения см. в разделе “Экспорт данных в файл" на стр. 79.
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Совет. При выборе ссылки missing assessment будут показаны 
требования, для которых категория рисков не была определена, или 
которые были явным образом исключены из анализа. Убедитесь, что в 
списке нет требований, которым должны быть назначена категория. Если 
требование не должно быть включено в анализ рисков, исключите его из 
анализа явным образом.

 8 Сравните общее расчетное время тестирования с имеющимися ресурсами. 
Если имеющихся ресурсов для тестирования требования с текущими 
параметрами недостаточно, рекомендуется снизить уровень тестирования 
для определенной категории рисков или сократить время тестирования для 
каждого уровня тестирования и выполнить расчет еще раз. 
Дополнительные сведения об изменении уровней и времени тестирования 
см. в разделе“Определение параметров политики тестирования" на 
стр. 249.

 9 Если политика тестирования соответствует ожиданиям, нажмите кнопку 
Save and Apply to Children, чтобы применить ее ко всем требованиям 
оценки в требовании анализа, соответствующим текущему фильтру.

 10 Теперь можно проанализировать влияние политики тестирования, 
разработанной для требования анализа, на расположенные в нем 
требования оценки и создать подробный отчет о стратегии тестирования. 
Дополнительные сведения см. в разделе “Анализ стратегии тестирования" 
на стр. 255.
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Анализ стратегии тестирования
После завершения определения политики тестирования для требования 
анализа можно проанализировать стратегию тестирования для требования 
анализа и расположенных в нем требований оценки. Результаты анализа 
рисков действительны для требований на момент последнего выполнения 
анализа. При последующем изменении категории рисков и 
функциональной сложности требований или политики тестирования 
следует выполнить анализ повторно.

В разделе описаны следующие операции.

➤ Анализ стратегии тестирования для требований анализа

➤ Анализ стратегии тестирования для требований оценки

Анализ стратегии тестирования для требований анализа
После завершения определения политики тестирования для требования 
анализа можно создать подробный отчет о стратегии тестирования. Этот 
отчет сохраняется в виде документа Microsoft Word в соответствующем 
каталоге с файлами. Его также можно сохранить как вложение требования 
анализа.

Примечание. Чтобы создать отчет, на компьютере должны быть 
установлены приложения Microsoft Word и Microsoft Excel.

Чтобы проанализировать стратегию тестирования для требования 
анализа, выполните следующие действия.

 1 В представлении Requirement Details модуля Requirements выберите 
требование анализа и перейдите на вкладку Risk.

 2 Сохраните анализ и примените его ко всем требованиям оценки внутри 
требования анализа. Нажмите кнопку Save and Apply to Children. Нажмите 
кнопку ОK.
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 3 Нажмите кнопку Generate Report. Откроется диалоговое окно Generate 
Report.

 4 В поле Default Location введите местоположение и имя документа Word, в 
который следует экспортировать данные. Для выбора местоположения в 
диалоговом окне Save As нажмите кнопку обзора.

 5 Чтобы также добавить отчет как вложение к требованию анализа, 
установите флажок Add report as attachment.

 6 Чтобы добавить в отчет перечень требований, установите флажок Include 
list of requirements in the report.

 7 Нажмите кнопку Generate. Отчет создается и сохраняется в указанной 
папке.

В зависимости от параметров, выбранных в диалоговом окне Generate 
Report, отчет может содержать следующие заголовки.

Заголовок Описание

Date last saved Дата последнего выполнения анализа рисков.

Filter Фильтр, использованный для определения 
требований, которые были включены в анализ 
рисков.
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Processed Число требований, включенных в анализ рисков. 
Также содержит распределение требований по 
группам: требования с оценкой, требования без 
оценки и требования, оценка которых была 
невозможна.

Total required testing time Общее время, необходимое для тестирования 
требований, включенных в анализ рисков, в 
соответствии с разработанной политикой 
тестирования.

Total allocated testing 
time

Общее время, выделенное для тестирования 
требований, включенных в анализ рисков.

Total required 
development time

Общее время, необходимое для разработки 
функций, определенных в требованиях.

No. of Requirements per 
Risk Category

Диаграмма распределения требований по 
категориям рисков.

Total Testing Time per 
Risk Category

Диаграмма, отображающая общее время, 
необходимое для тестирования всех требований в 
каждой категории рисков.

Implemented testing 
policy

Время, необходимое для тестирования 
требований, принадлежащих к каждой категории 
рисков в соответствии с политикой тестирования, 
использованной для анализа рисков.

Analyzed requirements Перечень требований, включенных в анализ рисков 
и имеющих оценки рисков, а также 
соответствующие категории рисков, уровни 
тестирования и значения времени тестирования.

Requirements with 
missing assessments

Перечень требований, включенных в анализ 
рисков, которые не имеют оценки рисков.

Not assessable 
requirements 

Перечень требований, оценка которых не могла 
быть выполнена. Это могут быть требования, 
исключенные из анализа явным образом, или 
требования, принадлежащие к типу, который не 
поддерживает управление качеством на основе 
рисков.

Заголовок Описание
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Анализ стратегии тестирования для требований оценки
После завершения определения политики тестирования для требования 
анализа можно проанализировать ее воздействие на требования оценки, 
расположенные в требовании анализа.

Чтобы проанализировать стратегию тестирования для требования 
оценки, выполните следующие действия.

 1 В представлении Requirement Details модуля Requirements выберите 
требование оценки и перейдите на вкладку Risk. Перейдите на вкладку 
Analysis Results.

На вкладке Analysis Results отображаются результаты последнего анализа, 
выполненного для требования анализа, являющегося родительским для 
требования оценки.

➤ Based on analysis requirement. Требование анализа, для которого был 
выполнен последний анализ, включающий текущее требование. Чтобы 
перейти к требованию анализа в дереве требований, щелкните имя 
требования анализа.

➤ Last analysis on date. Дата выполнения последнего анализа, 
включающего текущее требование.
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➤ Overall Risk Assessment. Расчетное значение риска на основе 
бизнес-критичности и вероятности сбоя для требования.

➤ Calculated Testing Level. Уровень тестирования требования, 
рассчитанный при последнем анализе, который включал текущее 
требование.

➤ Calculated Testing Time. Время, выделенное для тестирования 
требования по данным расчета при последнем анализе, который 
включал текущее требование.

 2 Чтобы переопределить расчетные значения при следующем расчете и 
использовать вместо них пользовательские значения, установите флажок 
Use these for the next calculation. В поле Testing Level выберите уровень 
тестирования, который будет использоваться для следующего расчета. В 
поле Testing Time выберите значение временных ресурсов, которое будет 
использоваться для следующего расчета. При выполнении последующего 
анализа, включающего текущее требование, эти значения будут 
использоваться вместо расчетных.
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Пример управления качеством на основе рисков
Предположим, что используется проект, созданный для приложения для 
бронирования авиабилетов. Необходимо разработать план тестирования 
требования анализа Online Travel Information Source, расположенного в 
требовании Mercury Tours Application.

Сначала следует присвоить значения критериям бизнес-критичности 
дочернего требования оценки Itineraries Information. Поскольку данные о 
маршрутах путешествий необходимы только для отображения 
информации, и не требуется их расчет или проверка, критерию Type of 
Process следует присвоить значение Display. Так как неправильная 
информация о маршрутах путешествий может послужить причиной для 
судебного иска, критерию Impact of failure следует присвоить значение 
Legal. 
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Критерию Frequency of use необходимо присвоить значение Very often, а 
критерию Number/Significance of affected users — значение Many/High. 
Расчетное значение бизнес-критичности требования, определенное 
Quality Center, будет равно A.

Так же путем присвоения значений критериям определяется вероятность 
сбоя. Quality Center вычисляет значение вероятности сбоя, равное 2. После 
этого путем присвоения значений критериям определяется 
функциональная сложность. Quality Center вычисляет значение 
функциональной сложности, равное 1. Общая категория рисков — A, а 
общая функциональная сложность — 1. 

Затем необходимо определить категорию рисков и функциональную 
сложность для требований оценки Maps, Travel Guides и Tips & FAQ.
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Теперь все готово для анализа рисков требования Online Travel 
Information Source. Принято решение использовать для анализа рисков 
политику тестирования Quality Center по умолчанию. По данным расчета 
Quality Center для тестирования требования необходимо 60 часов. Однако 
ресурс времени составляет всего 50 часов, то есть 83% от необходимых 
ресурсов. Поэтому политику тестирования необходимо изменить.

Уровень тестирования для требований с категорией рисковA2 меняется с 
Full на Partial. Quality Center пересчитывает время, необходимое для 
тестирования требований. Теперь это время составляет 52 часа и 
по-прежнему превышает имеющийся ресурс времени. Следовательно, 
необходимо изменить определение базового тестирования, выделив для 
него не 34%, а 20% от времени полного тестирования. Теперь расчетное 
время, необходимое для тестирования требования, составляет 50 часов и 
совпадает с имеющимся ресурсом времени, и такую политику 
тестирования можно принять.
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Теперь ресурсов для тестирования требования достаточно, и можно 
создать отчет об анализе рисков, чтобы получить общий обзор стратегии 
тестирования, рекомендованной Quality Center, а затем предоставить 
стратегию организации для использования в качестве основы плана 
тестирования.
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Часть IV
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16
Рабочий процесс плана тестирования

Разработка четкого и лаконичного плана тестирования имеет решающее 
значение для успешного тестирования приложения. Хороший план 
тестирования позволяет оценивать качество приложения на любом этапе 
процесса управления приложением.

В этойглаве описана разработка плана тестирования с помощью модуля 
Test Plan. Разработка плана тестирования состоит из следующих этапов. 

Определение 
стратегии 

тестирования

Определение 
объектов 

тестирования

Разработка тестов

Создание покрытия 
требований

Разработка шагов 
тестирования

Автоматизация 
тестов

Анализ плана 
тестирования

Создание базового 
состояния



Глава 16 • Рабочий процесс плана тестирования

268

Определение стратегии тестирования
Определите стратегию выполнения поставленных требований, 
определенных в модуле Requirements. Задайте себе два главных вопроса. 

Как следует тестировать приложение?

➤ Какие методики тестирования необходимо применять (стресс-тесты, тесты 
безопасности, тесты производительности, нагрузочные тесты и т. д.)? 

➤ Как следует работать с дефектами приложений (классификация дефектов 
по уровню серьезности, аутентификация для открытия и закрытия 
дефектов и т. д.)?

Какие потребуются ресурсы?

➤ Какие ресурсы потребуются для тестирования (сотрудники, оборудование 
и т. д.)?

➤ Каковы сроки завершения различных задач?

Рассмотрим в качестве примера приложение для бронирования 
авиабилетов, с помощью которого можно управлять расписанием полетов, 
заказами билетов их продажей. Для тестирования необходимо разработать 
как ручные, так и автоматизированные тесты. Сотрудникам, имеющим опыт 
программирования, следует поручить задачи по разработке 
автоматизированных тестов, а тем сотрудникам, у которых нет такого 
опыта, — поручить создание ручных тестов.
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Определение объектов тестирования
Проанализируйте иерархические взаимосвязи между функциями 
приложения. Распределите функции по объектам и постройте дерево 
плана тестирования, представляющее функциональность приложения. 

Дерево плана тестирования — это графическое представление плана 
тестирования. Это дерево представляет собой иерархический список всех 
тестов, упорядоченных по разделам, описывающий набор тестов, которые 
будут реализованы для обеспечения соответствия требованиям к качеству. 
Например, приложение для бронирования авиабилетов требует включения 
в список таких объектов тестирования, как Flight Finder, Book Flight, Flight 
Confirmation и Flight Cost.

Полное описание и пример создания дерева плана тестирования см. в 
Глава 18, "Создание дерева плана тестирования".

Разработка тестов
Запланируйте тесты для каждого объекта в дереве плана тестирования. 
Продумайте, какие типы тестов необходимо создать для каждого объекта, 
например, тесты на проверку работоспособности приложения или 
регрессионные тесты. (Пояснения к этим типам тестов см. в Глава 28, 
"Создание наборов тестов".) Затем создайте тесты и назначьте их 
определенной ветви дерева плана тестирования. Например, в примере с 
приложением для бронирования авиабилетов можно добавить следующие 
тесты в раздел объекта Flight Finder: Airline Preference, Departing and 
Arriving Locations, Departing Date, Find Flight, Flight Time Preference и 
Number of Passengers.

Тест можно связать с определенными дефектами. Это полезно, например, 
при создании нового теста специально для отслеживания того или иного 
дефекта. Создав связь, можно по статусу дефекта определить, 
необходимо ли выполнять тест. 

Дополнительные сведения о планировании тестов см. в Глава 18, 
"Создание дерева плана тестирования".
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В ручные тесты можно включать параметры. Это позволяет выполнять 
один и тот же тест многократно, назначая параметрам различные 
значения. Дополнительные сведения см. в разделе “Работа с параметрами 
в ручных тестах" на стр. 353.

Также можно связывать тесты с набором ресурсов, загруженных в 
репозиторий Quality Center. После этого можно просматривать созданные 
зависимости и определять используемые ресурсы. Это полезно, например, 
при копировании тестов между проектами. В новый проект будут 
скопированы тесты вместе с соответствующими ресурсами. 
Дополнительные сведения о ресурсах см. в Глава 24, "Управление 
ресурсами тестов" и Глава 25, "Просмотр зависимостей".

Создание покрытия требований
Свяжите каждый тест в дереве плана тестирования с одним или 
несколькими требованиями в дереве требований. Определив покрытие 
требований для теста, можно отслеживать взаимосвязи между тестами 
плана тестирования и исходными требованиями. Например, в случае 
приложения для бронирования авиабилетов тесты из объекта Registration 
покрывают раздел требований Customer Personal Information.

Сведения о покрытии требований см. в Глава 19, "Покрытие требований и 
покрытие тестами".
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Разработка шагов теста
Разработайте тесты для дереве плана тестирования. Определите шаги 
теста, описывающие операции, которые необходимо выполнить, и 
ожидаемые результаты. Определив шаги теста, решите, следует ли 
автоматизировать этот тест.

В случае ручного теста необходимо определить его шаги, выполнить их 
для приложения и записать результаты каждого шага. Ручные тесты 
используются в тех случаях, когда при выполнении теста требуется 
вмешательство тестировщика. К ручным тестам относятся тесты на 
удобство использования, однократно выполняемые тесты, тесты, которые 
должны быть выполнены немедленно, тесты, для выполнения которых 
требуется знание тестируемого приложения, и тесты с непредсказуемыми 
результатами. 

Например, в случае приложения для бронирования авиабилетов при 
проверке удобства работы в диалоговом окне необходимо выполнение 
операций пользователем. Поэтому этот тест должен быть ручным.

Можно включить шаг теста, вызывающий другой ручной тест. Это удобно 
при наличии общих шагов, которые требуется часто выполнять в рамках 
других тестов.

Сведения о разработке шагов теста см. в Глава 20, "Построение тестов".

Автоматизация тестов
Автоматизация теста позволяет выполнять тест без вмешательства 
тестировщика и с большой скоростью. Кроме того, такой тест можно 
использовать повторно и выполнять многократно. Например, имеет смысл 
автоматизировать функциональные тесты, тесты производительности, 
стресс-тесты и нагрузочные тесты, а также тесты, требующие подробной 
информации о приложениях. 

По завершении разработки шагов тестов можно решить, какие тесты 
следует автоматизировать. При рассмотрении этого вопроса следует 
учесть такие факторы, как частота выполнения теста, объем входных 
данных, продолжительность и сложность выполнения теста. 
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Если тест необходимо автоматизировать, можно сначала создать шаги 
теста и автоматизировать их путем создания скрипта теста. Можно 
создавать скрипты тестов для работы с помощью WinRunner, QuickTest 
Professional, LoadRunner или Visual API-XP.

Например, в случае приложения для бронирования авиабилетов можно 
автоматизировать тест, который проверяет работу механизма входа в 
систему. После разработки шагов теста создается скрипт теста. Затем 
разработка скрипта автоматизированного теста завершается с помощью 
решения QuickTest Professional.

Дополнительные сведения о создании автоматизированных тестов см. в 
Глава 22, "Создание автоматических тестов".

Можно также создать автоматизированный тест для получения сведений о 
системе, для захвата снимков рабочего стола компьютера или для 
перезагрузки компьютера. Дополнительные сведения см. в Глава 23, 
"Работа с системными тестами".

Анализ плана тестирования
Проанализируйте план тестирования и определите степень его 
соответствия целям, определенным в начале процесса управления 
приложением. Затем проанализируйте план тестирования, создав отчеты и 
графики. Дополнительные сведения см. в Глава 40, "Модуль Dashboard"..

Например, можно создать отчет, показывающий данные шагов каждого 
теста из дерева плана тестирования. Затем этот отчет можно использовать 
при определении приоритетов тестирования.

Чтобы обеспечить успешное выполнение процесса управления 
приложением, следует анализировать план тестирования в ходе процесса. 
Проанализируйте план, определите его соответствие целям тестирования. 
Внесите необходимые изменения в план тестирования.



Глава 16 • Рабочий процесс плана тестирования

273

Создание базового состояния
После анализа и одобрения плана тестирования можно создать базовое 
состояние. Базовое состояние теста — это состояние плана тестирования 
в определенный момент времени. Базовое состояние можно использовать 
для того, чтобы отметить важный этап жизненного цикла приложения. Это 
базовое состояние будет использоваться в качестве точки отсчета, с 
которой можно сравнивать изменения.

Дополнительные сведения о базовых состояниях см. в Глава 38, 
"Библиотеки и базовые состояния".
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17
Краткий обзор модуля Test Plan

В этой главе кратко описаны основные элементы модуля Test Plan.

Эта глава содержит следующие разделы.

 ➤  Дерево плана тестирования на стр. 276

 ➤  Строка меню Test Plan на стр. 278

 ➤  Панель инструментов Test Plan на стр. 280

 ➤  Таблица тестов на стр. 282
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Дерево плана тестирования
Разработка тестов в Quality Center выполняется в модуле Test Plan, окно 
которого открывается нажатием кнопки Test Plan  на боковой панели. 
Чтобы просмотреть дерево плана тестирования, выберите команду View > 
Test Plan Tree. 

Дерево плана тестирования содержит следующие основные элементы.

➤ Строка меню Test Plan. Раскрывающиеся меню с командами модуля Test 
Plan. Дополнительные сведения см. в разделе “Строка меню Test Plan" на 
стр. 278.

➤ Панель инструментов Test Plan. Кнопки вызова команд, часто 
используемых для создания и изменения дерева плана тестирования. 
Дополнительные сведения см. в разделе “Панель инструментов Test Plan" 
на стр. 280.

➤ Дерево плана тестирования. Графическое представление плана 
тестирования. Дополнительные сведения см. вглаве 18 "Создание дерева 
плана тестирования". Список значков тестов см. в разделе “Просмотр 
дерева плана тестирования" на стр. 299.
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➤ Вкладка Details. Описание теста, выбранного в дереве плана 
тестирования. Дополнительные сведения см. в главе 18 "Создание дерева 
плана тестирования".

➤ Вкладка Design Steps. Список шагов теста, поясняющих выполнение 
теста, выбранного в дереве плана тестирования. Если выбранный тест 
содержит шаги, на вкладке отображается значок . Дополнительные 
сведения см. главе 20 "Построение тестов".

➤ Вкладка Test Script. Скрипт теста, выбранного в дереве плана 
тестирования. Если выбранный тест имеет скрипт, на вкладке 
отображается значок . Дополнительные сведения см. в главе 22 
"Создание автоматических тестов". Дополнительные сведения об 
использовании вкладки Test Script в решении Business Process Testing см. в 
документе HP Business Process Testing User Guide.

➤ Вкладка Test Parameters. Список параметров, связанных с тестом, 
выбранным в дереве плана тестирования. Параметры могут содержаться в 
шагах теста. Если выбранный тест имеет параметры, на вкладке 
отображается значок . Дополнительные сведения см. вглаве 21 "Работа с 
параметрами в ручных тестах".

➤ Вкладка Attachments. Список вложений, содержащих дополнительные 
сведения о тесте, выбранном в дереве плана тестирования. Если 
выбранный тест имеет хотя бы одно вложение, на вкладке отображается 
значок . Дополнительные сведения см. в главе 5 "Добавление вложений".

➤ Вкладка Req Coverage. Список требований, соответствующих тесту, 
выбранному в дереве плана тестирования. Если выбранный тест имеет 
покрытие требований, на вкладке отображается значок . Дополнительные 
сведения см. в главе 19 "Покрытие требований и покрытие тестами".

➤ Вкладка Linked Defects. Список дефектов, связанных с тестом, 
выбранным в дереве плана тестирования. Дополнительные сведения см. в 
главе 36 "Связывание дефектов".

➤ Вкладка Dependencies. Список зависимостей, связанных с тестом, 
выбранным в дереве плана тестирования. Дополнительные сведения см. в 
главе 25 "Просмотр зависимостей".
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➤ Вкладка Live Analysis. Графическое представление данных теста, 
связанных с выбранной папкой объектов тестирования в дереве плана 
тестирования. Дополнительные сведения см. в главе 44 "Создание 
диаграмм анализа в реальном времени".

➤ History. Список изменений выбранного теста. Дополнительные сведения 
см. в разделе “Просмотр истории изменения теста" на стр. 302. Здесь также 
отображается история изменений базовых состояний, в которые включен 
текущий тест. Дополнительные сведения см. в разделе “Просмотр истории 
изменения базового состояния" на стр. 578.

Совет. Чтобы найти тест по идентификатору Test ID в дереве плана 
тестирования, выберите команду Tests > Go to Test, а затем введите 
идентификатор теста. Чтобы отобразить идентификатор теста, выберите 
столбец Test ID в диалоговом окне Select Columns. Можно переходить 
только к тем тестам, которые содержатся в текущем фильтре.

Строка меню Test Plan 
Строка меню модуля Test Plan содержит следующие меню.

➤ Меню Tests содержит команды, которые позволяют выполнять операции с 
папками и тестами в дереве, переходить к тестам в наборах тестов и 
отправлять тесты по электронной почте. Дополнительные сведения см. в 
главе 18 "Создание дерева плана тестирования". 

➤ Меню Edit содержит команды, которые позволяют вырезать, копировать, 
вставлять, переименовывать, удалять, находить тесты и выполнять поиск в 
тестах. Также можно обновлять выбранные тесты, просматривать и 
удалять оповещения тестов и помечать тесты для отслеживания. 
Дополнительные сведения об оповещениях и флажках отслеживания см. в 
главе 4 "Оповещение об изменениях".
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➤ Меню Versions доступно в проектах с включенным управлением версиями. 
Это меню содержит команды, которые позволяют возвращать и изымать 
тесты, отменять изъятие или просматривать все изъятые тесты. 
Дополнительные сведения см. в главе 7 "Работа с функциями управления 
версиями".

➤ Меню View содержит команды, позволяющие отображать тесты в дереве 
или в таблице плана тестирования, фильтровать и сортировать их и 
настраивать отображаемые столбцы.

➤ Меню Favorites содержит команды, которые позволяют добавлять и 
упорядочивать избранные представления. Это меню доступно только в 
таблице Test Grid. Дополнительные сведения об избранных 
представлениях см. в главе 6 "Работа с избранными представлениями".

➤ Меню Analysis содержит команды, которые позволяют создавать отчеты и 
диаграммы при разработке плана тестирования. Дополнительные 
сведения об отчетах при разработке планов см. в главе 42 "Создание 
стандартных отчетов". Дополнительные сведения о диаграммах при 
планировании см. в главе 41 "Создание диаграмм" и в главе 44 "Создание 
диаграмм анализа в реальном времени"

Совет. Для доступа к строке меню Test Plan из модуля Test Plan можно 
также пользоваться клавишей F9. Кроме того, с помощью сочетаний 
клавиш можно выполнять множество других операций в среде 
Quality Center. Перечень сочетаний клавиш приведен в приложении B 
"Сочетания клавиш Quality Center".
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Панель инструментов Test Plan 
Панель инструментов Test Plan содержит следующие кнопки.

New Folder. Добавление новой папки объектов в дерево плана 
тестирования. Дополнительные сведения см. в разделе “Создание дерева 
плана тестирования" на стр. 292.

New Test. Добавление нового теста в дерево плана тестирования. 
Дополнительные сведения см. в разделе “Добавление теста к дереву плана 
тестирования" на стр. 294.

Delete. Удаление выбранной папки или выбранного теста из дерева. 
Дополнительные сведения см. в разделе “Удаление папок и тестов" на 
стр. 315.

Refresh All. Обновление дерева плана тестирования для просмотра 
наиболее актуальных тестов.

Set Filter/Sort. Можно выбрать следующие варианты.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты в дереве плана тестирования. 

➤ Clear Filter/Sort. Очистка всех фильтров или параметров сортировки, 
примененных к дереву плана тестирования.

Дополнительные сведения о фильтрации и сортировке тестов см. в главе 3 
"Работа с данными Quality Center"

Sort Folders. Открывает диалоговое окно Sort Folders in Test Plan Tree, в 
котором можно определить пользовательский порядок сортировки папок 
дерева плана тестирования. По умолчанию папки сортируются по имени. 
Дополнительные сведения см. в разделе “Сортировка дерева плана 
тестирования" на стр. 313.

Flag for Follow Up. Открывается диалоговое окно Flag For Follow Up, в 
котором можно добавлять или изменять флажки отслеживания тестов. 
Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 91.
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Send by E-mail. Открывается диалоговое окно Send by E-mail, с помощью 
которого можно отправлять сообщения электронной почты с выбранными 
тестами получателям из списка или по любым другим адресам 
электронной почты. Дополнительные сведения см. в разделе “Отправка 
тестов по электронной почте" на стр. 303.

Text Search. В нижней части окна открывается область поиска, в которой 
можно вводить ключевые слова и выполнять поиск в предопределенных 
полях. Дополнительные сведения см. в разделе “Поиск записей" на стр. 76.

Управление версиями. На панели инструментов Test Plan отображаются 
следующие дополнительные кнопки для управления версиями.

➤ Check Out. Открывается диалоговое окно Check Out, позволяющее 
изъять выбранный тест.

➤ Check In. Открывается диалоговое окно Check In, позволяющее 
возвратить выбранный тест.

Дополнительные сведения об управлении версиями см. в главе 7 "Работа с 
функциями управления версиями".
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Таблица тестов 
Таблица тестов содержит все тесты проекта Quality Center. Каждая строка 
— это отдельная запись, содержащая сведения о тесте. Каждый столбец 
представляет собой отдельный элемент данных.

Чтобы просмотреть таблицу тестов, выберите команду View > Test Grid. 

В таблице тестов можно просматривать и изменять данные тестов. 
Например, можно копировать несколько автоматизированных тестов и 
вставлять их в другой проект, или удалять сразу несколько тестов. Кроме 
того, данные таблицы можно сохранять в различных форматах, таких как 
текстовый файл, документ Word, документ в формате HTML, документ в 
формате XML и таблица Excel.
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Таблица тестов содержит следующие основные элементы.

➤ Панель инструментов Test Grid. Содержит кнопки команд, часто 
используемых при создании и изменении таблицы тестов. Дополнительные 
сведения см. в разделе “Панель инструментов таблицы тестов" на стр. 284.

➤ Столбцы индикаторов. Индикаторы указывают наличие вложений, 
связанных дефектов, оповещений и флажков отслеживания у теста. Чтобы 
отобразить эти столбцы, выберите команду View > Indicator Columns.

➤ Фильтр таблицы. Текущий фильтр, примененный к столбцу. 
Дополнительные сведения см. в разделе “Фильтрация записей" на стр. 59.

➤ Вкладка Description. Содержит описание теста, выбранного в таблице 
тестов.

➤ Вкладка Attachments. Содержит вложения выбранного теста. 
Дополнительные сведения см. в главе 5 "Добавление вложений".

➤ Вкладка History. Список изменений выбранного теста. Дополнительные 
сведения см. в разделе “Просмотр истории изменения теста" на стр. 302. 
Здесь также отображается история изменений базовых состояний, в 
которые включен текущий тест. Дополнительные сведения см. в разделе 
“Просмотр истории изменения базового состояния" на стр. 578.

Столбец Описание

Attachments Щелкните значок , чтобы просмотреть вложения 
теста. Дополнительные сведения см. в главе 5 
"Добавление вложений".

Linked Entities Щелкните значок , чтобы просмотреть объекты, 
связанные с тестом. Дополнительные сведения см. 
в главе 36 "Связывание дефектов".

Alerts Щелкните значок , чтобы просмотреть 
оповещения теста. Дополнительные сведения см. в 
разделе “Просмотр оповещений" на стр. 88.

Follow Up Flags Щелкните значок , чтобы просмотреть 
оповещения отслеживания теста. Дополнительные 
сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 91.
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Совет. Чтобы найти тест по идентификатору Test ID в таблице тестов, 
выберите команду Test > Go to Test, а затем введите идентификатор 
теста. Чтобы отобразить идентификатор теста, выберите столбец Test ID в 
диалоговом окне Select Columns.

Панель инструментов таблицы тестов
Панель инструментов таблицы тестов содержит следующие кнопки.

Delete Selected Tests. Удаление выбранных тестов из таблицы тестов.

Refresh All. Обновление таблицы тестов для отображения наиболее 
актуальных тестов. 

Set Filter/Sort. Можно выбрать следующие варианты.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать, сортировать и группировать тесты в таблице тестов.

➤ Clear Filter/Sort. Очистка всех фильтров, параметров сортировки или 
группирования, примененных к таблице тестов.

Дополнительные сведения о фильтрации и сортировке тестов см. в главе 3 
"Работа с данными Quality Center"

Select Columns. Открывается диалоговое окно Select Columns, в котором 
можно указать, какие столбцы и в каком порядке будут отображаться в 
таблице тестов. Дополнительные сведения см. в разделе “Упорядочивание 
столбцов" на стр. 54.

Go to Test in Test Plan Tree. Закрывает таблицу тестов и отображает 
выбранный тест в дереве плана тестирования.

Attachments. Открывается диалоговое окно Attachments, в котором можно 
добавлять вложения в выбранный тест. Дополнительные сведения см. в 
главе 5 "Добавление вложений".
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Flag for Follow Up. Открывается диалоговое окно Flag For Follow Up, в 
котором можно добавлять или изменять флажки отслеживания тестов. 
Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 91.

Send by E-mail. Открывается диалоговое окно Send by E-mail, с помощью 
которого можно отправлять сообщения электронной почты с выбранным 
тестом получателям из списка или по любым другим адресам электронной 
почты. Дополнительные сведения см. в разделе “Отправка тестов по 
электронной почте" на стр. 303.

Text Search. В нижней части окна открывается область поиска, в которой 
можно вводить ключевые слова и выполнять поиск в предопределенных 
полях. Дополнительные сведения см. в разделе “Поиск записей" на стр. 76.

Управление версиями. Панель инструментов таблицы тестов содержит 
следующие дополнительные кнопки.

➤ Check Out. Открывается диалоговое окно Check Out, позволяющее 
изъять выбранный тест.

➤ Check In. Открывается диалоговое окно Check In, позволяющее 
возвратить выбранный тест.

Дополнительные сведения об управлении версиями см. в главе 7 "Работа с 
функциями управления версиями".

Столбцы таблицы тестов
Таблица тестов отображает следующие столбцы данных планирования 
тестирования.

Столбец Описание

Comments Комментарии к тесту.

Creation Date Дата создания теста. По умолчанию используется 
текущая дата сервера. Щелкните стрелку вниз, чтобы 
отобразить календарь и выбрать другую дату 
создания.

Description Описание теста.
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Designer Имя пользователя, разработавшего тест.

Estimated DevTime Расчетная продолжительность проектирования и 
разработки теста.

Execution Status Статус последнего выполнения экземпляра теста. 
Статус выполнения может принимать одно из 
следующих значений: Failed, N/A, No Run, Not 
Completed, Passed.

Modified Дата и время последнего изменения теста.

Path Путь к данному тесту в каталоге Tests в репозитории 
проекта.

Status Статус планирования теста. Значение статуса по 
умолчанию: Design.

Subject Папка объектов тестирования в дереве плана 
тестирования, в которой находится тест.

Template Указывает, является ли шаблоном ручной тест или 
тест QuickTest Professional. Если тест является 
шаблоном, то в этом столбце отображается значение 
Y, в противном случае отображается значение N или 
пустое значение. Дополнительные сведения о ручных 
тестах см. в разделе “Просмотр экземпляров тестов" 
на стр. 301. Дополнительные сведения о тестах 
QuickTest Professional см. в разделе “Добавление 
теста к дереву плана тестирования" на стр. 294.

Test ID Уникальный числовой идентификатор теста, 
автоматически назначенный Quality Center. Это поле 
доступно только для чтения. 

Test Name Имя теста.

Type Тип теста. Например, ручной или WinRunner. Это 
поле доступно только для чтения.

Столбец Описание
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Управление версиями. В таблице тестов отображаются следующие 
дополнительные поля.

Примечания. 

➤ В таблицу тестов можно добавлять определенные пользователем поля 
и изменять заголовки любых полей. Также предусмотрена возможность 
настройки списков проектов. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ Для ограничения и динамического изменения полей и значений в 
таблице тестов можно использовать редактор Script Editor. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ При выборе столбца таблицы тестов, содержащего имя пользователя, 
Quality Center отображает список всех имен пользователей и их полных 
имен. Можно выполнять поиск пользователей, сортировать и 
группировать их по группам, а также выбирать пользователей из списка 
пользователей и дерева групп. Дополнительные сведения см. в разделе 
“Выбор пользователей" на стр. 57.

Поле Описание

Version Owner Имя пользователя, выполнившего последнюю 
операцию (возврат или изъятие).

Version Date Дата последней операции (возврата или изъятия), 
выполненной с данной версией.

Version Number Номер версии.

Version Status Статус версии (Checked Out или Checked In).

Version Time Время последней операции (возврата или изъятия), 
выполненной с данной версией.
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18
Создание дерева плана тестирования

Дерево плана тестирования позволяет упорядочить тесты и отобразить их 
в иерархическом порядке в соответствии с объектами тестирования.

Эта глава содержит следующие разделы.

 ➤  О дереве плана тестирования на стр. 290

 ➤  Создание дерева плана тестирования на стр. 292

 ➤  Добавление теста к дереву плана тестирования на стр. 294

 ➤  Просмотр дерева плана тестирования на стр. 299

 ➤  Просмотр экземпляров тестов на стр. 301

 ➤  Просмотр истории изменения теста на стр. 302

 ➤  Отправка тестов по электронной почте на стр. 303

 ➤  Поиск тестов в дереве или в таблице тестов на стр. 306

 ➤  Замена значений полей в таблице тестов на стр. 309

 ➤  Обновление нескольких записей в таблице тестов на стр. 310

 ➤  Копирование тестов на стр. 310

 ➤  Копирование URL-адресов тестов на стр. 312

 ➤  Сортировка дерева плана тестирования на стр. 313

 ➤  Изменение дерева плана тестирования на стр. 314
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О дереве плана тестирования
Как правило, приложение слишком велико, чтобы тестировать его целиком. 
Модуль Test Plan позволяет разбить приложение на функциональные 
составляющие. Приложение делится на модули или объекты 
тестирования путем создания дерева плана тестирования. Это дерево 
служит графическим представлением плана тестирования. Оно 
отображает тесты в соответствии с иерархическими взаимосвязями их 
функций. 

Определив объекты тестирования в дереве, следует решить, какие тесты 
необходимо разработать для каждого объекта, а затем добавить их в 
дерево. На этой стадии следует определить основные сведения о тесте, в 
том числе его имя, статус и разработчика. Можно также приложить файл, 
URL-адрес, снимок приложения или сведения о системе, чтобы 
проиллюстрировать тест. После этого необходимо определить шаги теста. 
Шаги теста содержат подробные инструкции по выполнению теста и 
оценке его результатов.

В процессе управления приложением может потребоваться изменить план 
тестирования. Обновить дерево плана тестирования можно в любое время.

Существуют различные методы организации плана тестирования по 
объектам тестирования. Например, можно определить объекты 
тестирования следующим образом.

➤ По функциональности приложения — изменение, операции с файлами, 
создание отчетов.

➤ По типу тестирования — функциональное тестирование, тестирование 
пользовательского интерфейса, тестирование производительности и 
нагрузочное тестирование.
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Предположим, выполняется тестирование приложения для бронирования 
авиабилетов, с помощью которого можно управлять расписанием полетов, 
заказами и продажей билетов. (Полный пример см. в проекте 
QualityCenter_Demo.) В дереве плана тестирования можно определить 
следующие объекты.

Заметьте, например, что объект тестирования Itinerary содержит 
дополнительные папки объектов. Эти папки группируют тесты в дереве 
плана тестирования с помощью дополнительных уровней объектов 
тестирования.

После создания базовой структуры плана необходимо разработать тесты и 
назначить их объектам тестирования. Например, в приведенном выше 
дереве плана тестирования можно назначить тесты папке объектов 
тестирования Reservation Details, как показано ниже.
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Примечание. Для разработки и изменения дерева плана тестирования 
необходимы соответствующие разрешения пользователя. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Создание дерева плана тестирования
Иерархическая структура плана тестирования создается путем построения 
дерева плана тестирования, которое содержит папки и вложенные папки. 

Примечание. Дерево плана тестирования можно создать непосредственно 
в Quality Center, а можно импортировать данные плана тестирования в 
проект Quality Center из приложений Microsoft Word и Microsoft Excel. Чтобы 
импортировать из приложения Word, необходимо установить надстройки 
HP Quality Center Microsoft Word Add-in и HP Quality Center Connectivity 
Add-in. Чтобы импортировать из приложения Excel, необходимо 
установить надстройки HP Quality Center Microsoft Excel Add-in и 
HP Quality Center Connectivity Add-in. Эти надстройки можно установить 
со страницы надстроек HP Quality Center. Дополнительные сведения см. в 
документе Руководство по установке HP Quality Center.
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Чтобы создать дерево плана тестирования, выполните следующие 
действия.

 1 Выберите папку объектов тестирования в дереве плана тестирования и 
нажмите кнопку New Folder или выберите команду Tests > New Folder. 
Откроется диалоговое окно New Folder.

 2 В поле Folder Name введите имя объекта, а затем нажмите кнопку OK. 
Учтите, что имя папки не должно содержать следующих символов: \ ^ *

Созданная папка появится в дереве плана тестирования в папке Subject.

 3 В поле Description введите описание объекта тестирования. 

 4 Если необходимо добавить в папку вложение, перейдите на вкладку 
Attachments. Вложение может представлять собой файл, URL-адрес, 
снимок приложения, содержимое из буфера обмена или сведения о 
системе. Дополнительные сведения см. в Глава 5, "Добавление вложений"..

 5 Чтобы создать дополнительные объекты на основном уровне, повторите 
шаги с 1 по 4.

 6 Чтобы создать вложенную папку, выберите папку объектов тестирования и 
повторите шаги с 1 по 4. 
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Добавление теста к дереву плана тестирования 
После создания дерева плана тестирования, содержащего основные 
объекты тестирования, можно приступить к созданию тестов. Каждый тест 
должен иметь четко определенную цель, такую как проверка определенной 
функции или системного требования. Разрабатываемые тесты должны 
соответствовать целям, поставленным в начале процесса управления 
приложением.

Например, в случае приложения для бронирования авиабилетов можно 
определить тест Password Verification, позволяющий убедиться в том, что 
войти в систему сможет только тот пользователь, который введет 
правильный пароль. Этот тест можно поместить в объект тестирования 
Sign-On/Sign-Off.

Совет. Тесты можно создавать автоматически непосредственно на основе 
требований в модуле Requirements. Дополнительные сведения см. в 
разделе “Создание тестов из требований" на стр. 219.

Чтобы добавить новый тест, выполните следующие действия.

 1 Выберите папку объектов тестирования в дереве плана тестирования.

 2 Нажмите кнопку New Test или выберите команду Tests > New Test. 
Откроется диалоговое окно Create New Test.

Примечание. Если на компьютере установлена надстройка QuickTest 
Professional Add-in, в диалоговом окне Create New Test будет показано поле 
Template.
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 3 В раскрывающемся списке Test Type выберите тип теста. Можно выбрать 
один из следующих типов теста.

Тип теста Описание

MANUAL Ручной тест в Quality Center.

WR-AUTOMATED Этот тест выполняется средством тестирования 
функциональности WinRunner компании HP, 
предназначенным для тестирования приложений 
Microsoft Windows.

LR-SCENARIO Скрипт, который выполняется средством нагрузочного 
тестирования компании HP LoadRunner.

QUICKTEST_TEST Тест, который выполняется решением QuickTest 
Professional, корпоративным средством 
функционального тестирования компании HP. 

Этот тип теста доступен только в том случае, если 
установлена соответствующая надстройка, 
загруженная со страницы надстроек HP Quality Center. 
Дополнительные сведения об установке надстроек см. 
в документе Руководство по установке 
HP Quality Center.

VAPI-XP-TEST Тест, созданный с помощью с помощью решения 
Visual API-XP, средства тестирования на основе 
интерфейса API открытой архитектуры тестирования 
Quality Center. Дополнительные сведения см. в 
Приложение A, "Работа с VAPI-XP"..

SYSTEM-TEST Тест, который указывает Quality Center предоставить 
сведения о системе, захватить снимок рабочего стола 
или перезагрузить компьютер. Дополнительные 
сведения см. в Глава 23, "Работа с системными 
тестами"..

QAINSPECT-TEST Этот тест выполняется средством QAInspect, 
решением компании HP для тестирования 
безопасности.
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 4 В поле Test Name введите имя теста. Имя теста не должно содержать 
следующих символов: \ / : " ? < > | * % ' 

 5 Если в списке Test Type выбрано значение QUICKTEST_TEST, будет 
доступно поле Template. Новый тест создается на основе другого теста 
QuickTest, определенного как шаблон теста. Шаблон теста копируется в 
созданный тест без результатов тестирования. 

Примечание. Чтобы определить надстройки QuickTest, которые 
Quality Center связывает с новым тестом QuickTest, выберите шаблон 
теста, в котором указаны соответствующие надстройки. Также можно 
использовать шаблон теста по умолчанию, имеющийся в клиентской части 
Quality Center. По умолчанию этот тест загружает веб-надстройку и 
надстройку ActiveX. Дополнительные сведения см. в документации 
QuickTest и в соответствующей документации надстройки QuickTest.

Чтобы выбрать шаблон теста, нажмите кнопку обзора. Откроется 
диалоговое окно Select Tests. По умолчанию будут показаны только 
шаблоны QuickTest. 

Выберите шаблон теста, а затем нажмите кнопку Add Test. Диалоговое 
окно Select Tests закроется, а в поле Template появится шаблон теста.

BUSINESS-PROCESS Тест бизнес-процесса. Дополнительные сведения см. 
в HP Business Process Testing User Guide.

FLOW Тест, объединяющий набор бизнес-компонентов в 
определенной последовательности, позволяющей 
выполнять определенную задачу. Дополнительные 
сведения см. в HP Business Process Testing User 
Guide.

Тип теста Описание
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Примечание. Чтобы сделать тест QuickTest Professional шаблоном теста, 
щелкните тест в дереве плана тестирования правой кнопкой мыши и 
выберите команду Mark as Template Test.

 6 Управление версиями.

➤ Установите флажок Check out immediately, чтобы оставить тест 
извлеченным после создания. Это позволяет продолжить определение 
теста после его создания, например путем определения шагов теста 
или добавления параметров. Этот флажок установлен по умолчанию.

➤ В поле Comments введите краткое описание причины изъятия. Поле 
Comments доступно только в том случае, если установлен флажок 
Check out immediately.

 7 Нажмите кнопку OK, чтобы закрыть диалоговое окно Create New Test.

Если обязательные поля теста были определены в окне Project 
Customization, откроется диалоговое окно Required Test Fields. Выберите 
значения обязательных полей и нажмите кнопку OK.

Новый тест появится в дереве плана тестирования в выбранной папке 
объектов тестирования. Имя будет добавлено в поле Test Name на 
вкладке Details.

 8 На вкладке Details введите следующие сведения о тесте.

Элемент Описание

Designer Разработчик теста. По умолчанию отображается имя 
пользователя, выполнившего вход в Quality Center. Щелкните 
стрелку вниз, чтобы выбрать другое имя пользователя.

Creation Date Дата создания теста. По умолчанию в качестве даты создания 
используется текущая дата сервера баз данных. Щелкните 
стрелку вниз, чтобы отобразить календарь и выбрать другую 
дату создания.

Status Текущий статус теста. По умолчанию тест имеет статус Design. 
Щелкните стрелку вниз, чтобы выбрать в списке другой статус.
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Примечание. Можно изменять заголовок любого поля сведений о тесте. В 
сведения о тесте можно также добавлять поля, определенные 
пользователем. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

 9 На вкладке Details выберите вкладку Description и введите описание теста.

 10 На вкладке Details выберите вкладку Comments и введите комментарий к 
тесту. На вкладке Comments нажмите кнопку Add Comment. На вкладке 
Comments появится новый раздел, в котором будет отображено имя 
пользователя и текущая дата базы данных.

 11 Перейдите на вкладку Test Parameters, чтобы добавить параметры к 
новому тесту, если это необходимо. На вкладке Test Parameters нажмите 
кнопку New Parameter. Дополнительные сведения см. в Глава 21, "Работа с 
параметрами в ручных тестах"..

 12 Если необходимо добавить вложение к новому тесту, перейдите на вкладку 
Attachments. Вложение может представлять собой файл, URL-адрес, 
снимок приложения, содержимое из буфера обмена или сведения о 
системе. Дополнительные сведения см. в Глава 5, "Добавление вложений"..

 13 Перейдите на вкладку Req Coverage, чтобы определить покрытие 
требований тестами. Дополнительные сведения см. в Глава 19, "Покрытие 
требований и покрытие тестами"..

 14 Перейдите на вкладку Linked Defects, чтобы связать дефекты с тестом. 
Дополнительные сведения см. в Глава 36, "Связывание дефектов"..

 15 Перейдите на вкладку Design Steps, чтобы определить шаги теста. 
Дополнительные сведения см. в Глава 20, "Построение тестов"..
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Просмотр дерева плана тестирования
Дерево плана тестирования можно использовать для анализа общей 
структуры плана тестирования и просмотра тестов, назначенных каждому 
объекту тестирования.

Дерево плана тестирования может содержать следующие значки тестов.

Ручной тест.

Ручной тест, содержащий шаги.

Шаблон ручного теста.

Шаблон ручного теста, содержащий шаги.

Тест бизнес-процесса.

Схема бизнес-компонентов.

Тест WinRunner.

Пакетный тест WinRunner.

Дополнительные сведения о создании пакетных тестов WinRunner и 
работе с ними см. в Руководстве пользователя HP WinRunner.

Сценарий LoadRunner.
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Управление версиями. Дерево плана тестирования может содержать 
следующие дополнительные значки.

Чтобы просмотреть тесты в дереве плана тестирования, выполните 
следующие действия.

По умолчанию в дереве плана тестирования отображаются только объекты 
самого высокого уровня иерархии объектов тестирования.

➤ Чтобы развернуть ветвь дерева, щелкните значок Expand  слева от 
имени ветви. Чтобы развернуть все ветви дерева, щелкните папку Subject 
правой кнопкой мыши и выберите команду Expand All. 

➤ Чтобы свернуть ветвь дерева, щелкните значок Collapse  слева от имени 
ветви. Чтобы свернуть все ветви дерева, щелкните папку Subject правой 
кнопкой мыши и выберите команду Collapse.

➤ Чтобы просмотреть тесты, связанные с конкретным объектом, дважды 
щелкните папку этого объекта . 

➤ Чтобы обновить все тесты в дереве плана тестирования, нажмите кнопку 
Refresh All.

Тест QuickTest Professional.

Шаблон теста QuickTest Professional.

Тест QuickTest Professional, содержащий шаги.

Шаблон теста QuickTest Professional, содержащий шаги.

Тест Visual API-XP. 

Системный тест.

Тест Vuser Script.

Тест QAInspect.

Тест изъят текущим пользователем.

Тест изъят другим пользователем.
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➤ Нажмите кнопку Set Filter/Sort, чтобы отфильтровать и отсортировать 
тесты в дереве плана тестирования. Дополнительные сведения см. в 
Глава 3, "Работа с данными Quality Center".. Все примененные фильтры и 
параметры сортировки отображаются ниже панели инструментов дерева 
плана тестирования.

➤ Чтобы просмотреть все тесты проекта Quality Center одновременно, 
выберите команду View > Test Grid. 

Просмотр экземпляров тестов
Можно просматривать экземпляры тестов, созданные в наборах тестов в 
модуле Test Lab. Можно увидеть, какие наборы тестов содержат экземпляр 
теста, и перейти к экземпляру теста в модуле Test Lab.

Чтобы просмотреть экземпляр теста, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования и выберите команду Tests > 
Go to Test in Test Set. Также можно щелкнуть тест правой кнопкой мыши и 
выбрать команду Go to Test in Test Set. Если существует только один 
экземпляр выбранного теста, откроется модуль Test Lab с выделенным 
экземпляром теста. Если экземпляров несколько, откроется диалоговое 
окно Select Test Set.

 2 В поле Test Set выберите набор тестов, содержащий экземпляр теста, к 
которому необходимо перейти.

 3 В поле Test Instance выберите экземпляр теста из списка экземпляров в 
выбранном наборе тестов.

 4 Нажмите кнопку ОK. Откроется модуль Test Lab, в котором будет выделен 
выбранный экземпляр теста.
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Просмотр истории изменения теста
В дереве плана тестирования можно просматривать список изменений 
любого теста. 

Также можно просматривать предыдущие версии тестов, сохраненные в 
том или ином базовом состоянии. Дополнительные сведения см. в разделе 
“Просмотр истории изменения базового состояния" на стр. 578.

Чтобы просмотреть историю изменений теста, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования. Перейдите на вкладку 
History. История изменений теста будет показана в таблице.

Управление версиями. По умолчанию отображается вкладка Versions and 
Baselines. Перейдите на вкладку Audit Log, чтобы просмотреть историю 
изменения теста.

Для каждого изменения теста в таблице отображается дата и время 
изменения, а также имя пользователя, сделавшего изменение.

 2 Разверните изменение, чтобы просмотреть список измененных полей. Для 
каждого поля в таблице отображаются старое и новое значения. Чтобы 
развернуть все изменения, нажмите кнопку Expand All.

 3 Можно указать, какие изменения должны отображаться в таблице. В списке 
Field выберите имя поля, чтобы просмотреть изменения только этого поля. 
Чтобы просмотреть изменения всех полей, выберите <All>.
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Сведения о сохранении изменений полей см. в документе 
HP Quality Center Administrator Guide.

Отправка тестов по электронной почте 
Можно отправлять сообщения электронной почты о тестах другим 
пользователям, работающим над проектом . Эта возможность позволяет 
регулярно информировать сотрудников групп разработки и контроля 
качества о статусе тестов. Сообщение электронной почты содержит ссылку 
Go To Test, которая позволяет получателю переходить непосредственно к 
тесту.

Примечание. По умолчанию Quality Center отправляет сообщения 
электронной почты в формате HTML. Чтобы отправить сообщение 
электронной почты в виде обычного текста, измените параметр 
MAIL_FORMAT на вкладке Site Configuration в разделе Site Administration. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.
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Чтобы отправить тест по электронной почте, выполните следующие 
действия. 

 1 Выберите один или несколько тестов в дереве плана тестирования или в 
таблице тестов и нажмите кнопку Send by Email. Откроется диалоговое 
окно Send Email.

Совет. Предусмотрена возможность автоматической отправки сообщений 
по электронной почте пользователям определенного типа. Для этого 
можно использовать любой столбец теста, содержащий в качестве 
значения имя пользователя, включая поля, определенные пользователем. 
Щелкните стрелку Send by Email и выберите требуемый вариант. 
Например, выберите команду Send Mail to Designer, чтобы отправить 
сообщение электронной почты разработчику теста.
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 2 Введите допустимый адрес электронной почты или имя пользователя. 
Также можно нажать кнопку To или CC, чтобы выбрать пользователей. 
Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять поиск 
пользователей, распределять пользователей по группам и выбирать 
пользователей из списка или из дерева групп. Дополнительные сведения 
см. в разделе “Выбор пользователей" на стр. 57. 

Выберите пользователей или группы пользователей, которым необходимо 
отправить сообщение электронной почты, и нажмите кнопку OK.

 3 В поле Subject введите тему сообщения электронной почты. По умолчанию 
при выборе только одного теста в поле Subject отображаются домен, 
проект, идентификатор теста и краткое описание теста.

 4 Если выбрать несколько тестов, они будут перечислены в поле Item. 
Можно удалить тесты, которые не следует включать в сообщение 
электронной почты.

 5 Выберите, следует ли включать поля теста Attachments, History и (или) 
Design Steps.

 6 В поле Additional comments добавьте необходимые комментарии.
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 7 Чтобы проверить орфографию в диалоговом окне, выполните следующие 
действия.

➤ Нажмите кнопку Check Spelling, чтобы проверить орфографию 
выделенного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии, нажмите кнопку Spelling 
Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить синонимы, 
антонимы или связанные слова для выбранного слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое.

 8 Чтобы настроить сообщение электронной почты, нажмите кнопку Custom. 
В диалоговом окне Select Fields можно указать, какие поля следует 
включить в сообщение электронной почты.

 9 Нажмите кнопку Send, чтобы отправить сообщение электронной почты.

Поиск тестов в дереве или в таблице тестов
С помощью команды Find можно найти тест в дереве плана тестирования 
или в таблице тестов.

Совет. Если доступна функция Text Search, ее можно использовать для 
поиска тестов в дереве плана тестирования или в таблице тестов. 
Текстовый поиск является более мощным средством поиска, позволяющим 
находить ключевые слова и измененные формы ключевых слов. Сведения 
об использовании текстового поиска см. в разделе “Поиск записей" на 
стр. 76.
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Поиск тестов в дереве плана тестирования
В дереве плана тестирования можно найти нужную папку или тест. Если к 
дереву применены фильтры, то поиск будет выполняться только в 
отображенных тестах.

Чтобы найти папку или тест в дереве плана тестирования, выполните 
следующие действия.

 1 Выберите папку объектов в дереве плана тестирования и выберите 
команду Edit > Find.

Откроется диалоговое окно Find Folder/Test, в котором в поле Find in будет 
показано имя папки. При поиске по всему дереву будет показано имя папки 
Subject.

 2 В поле Value To Find введите имя (или часть имени) папки или теста. 
Учтите, что поиск выполняется без учета регистра.

 3 Установите флажок Include Tests, если необходимо найти не только папки, 
но и тесты.

 4 Нажмите кнопку Find.

Модуль Test Plan начнет поиск папки или теста. При успешном завершении 
поиска откроется диалоговое окно Search Results, содержащее список 
возможных совпадений. Выберите в этом списке нужный результат и 
нажмите кнопку Go To, чтобы выделить папку или тест в дереве плана 
тестирования. 

При неудачном завершении поиска откроется информационное окно.
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Поиск тестов в таблице тестов
В таблице тестов можно выполнять поиск тестов по значению 
определенного поля. Если к таблице тестов применены фильтры, поиск 
будет ограничен только текущими показанными тестами.

Чтобы найти тесты в таблице тестов, выполните следующие 
действия.

 1 Выберите команду View > Test Grid.

 2 Выберите команду Edit > Find. Откроется диалоговое окно Find.

 3 В поле Find in Field выберите поле таблицы.

 4 В поле Value to Find введите или выберите значение поля, которое 
необходимо найти.

 5 Установите флажок Exact Match, если необходимо найти тесты с 
значениями полей, точно совпадающими со строкой в поле Value to Find.

 6 Установите флажок Case Sensitive, чтобы поиск выполнялся с учетом 
прописных и строчных символов.

 7 Установите флажок Use Wildcards, чтобы использовать символы 
звездочки (*) в строке поиска для ввода только части элемента.

 8 Нажмите кнопку Find Next. При успешном завершении поиска 
соответствующий тест будет выделен в таблице. При неудачном 
завершении поиска откроется информационное окно.

 9 Чтобы найти следующий тест, удовлетворяющий критериям поиска, еще 
раз нажмите кнопку Find Next.
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Замена значений полей в таблице тестов
С помощью команды Replace можно выполнять замену значений полей в 
таблице тестов.

Чтобы заменить значение поля в таблице тестов, выполните 
следующие действия.

 1 Выберите команду Edit > Replace. Откроется диалоговое окно 
Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск определенного значения. 

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение для замены.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы найти точное совпадение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы, установите флажок From 
Beginning.

 8 Чтобы использовать в строке поиска символ звездочки (*) и вводить только 
часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажимите кнопку Replace.
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 10 Чтобы заменить все экземпляры значения в таблице, нажмите кнопку 
Replace All.

Обновление нескольких записей в таблице тестов
Можно обновлять значение поля в нескольких записях таблицы тестов. 
Чтобы обновить значения, выделите записи в таблице и выберите команду 
Edit > Update Selected. Откроется диалоговое окно Update Selected. 
Дополнительные сведения см. в разделе “Обновление нескольких записей" 
на стр. 74.

Копирование тестов
Можно копировать тесты в рамках одного проекта или между проектами.

Копирование тестов внутри проекта
Тесты и папки объектов можно копировать внутри проекта. 

Чтобы скопировать тест внутри проекта, выполните следующие 
действия.

 1 В дереве плана тестирования выберите тест или папку объектов 
тестирования, которую необходимо скопировать. Чтобы скопировать 
несколько тестов или папок объектов тестирования, используйте клавишу 
CTRL.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy.

 3 Выберите папку, в которую необходимо скопировать тесты или папки 
объектов.

 4 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste.
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Копирование тестов между проектами
Можно копировать тесты из одного проекта в другой. Если тест содержит 
вызовы других тестов, или если тесты зависят от ресурсов тестов, можно 
выбрать в Quality Center один из следующих способов копирования.

➤ Копирование тестов и установление связи с существующими 
вызываемыми тестами и связанными ресурсами тестов в целевом проекте. 
Если вызываемый тест или ресурс теста отсутствует в целевом проекте, 
Quality Center скопирует его в целевой проект.

➤ Копирование тестов вместе с вызываемыми тестами и связанными 
ресурсами тестов в целевой проект. 

➤ Копирование тестов без копирования вызываемых тестов и связанных 
ресурсов тестов в целевой проект.

Примечание. Чтобы копировать тесты между проектами, оба проекта 
должны иметь одну и ту же версию и уровень исправлений Quality Center.

Дополнительные сведения связанных объектах см. в разделе “Просмотр 
зависимостей" на стр. 395.

Чтобы скопировать тест между проектами, выполните следующие 
действия.

 1 В дереве плана тестирования выберите тест или папку объектов 
тестирования, которую необходимо скопировать. Чтобы скопировать 
несколько тестов или папок объектов тестирования, используйте клавишу 
CTRL.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy.

 3 Откройте другой экземпляр Quality Center и войдите в проект, в который 
необходимо вставить тесты.

 4 Выберите папку, в которую необходимо скопировать тесты или папки 
объектов.
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 5 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste. Откроется диалоговое окно Paste 
Tests/Subject Folders to Target Project. 

 6 Выберите один из следующих вариантов.

➤ Copy tests/subject folders and link to existing related entities. 
Quality Center копирует тесты или папки объектов и вставляет их в целевой 
проект. Скопированные тесты или папки объектов будут связаны с 
существующими ресурсами тестов и вызываемыми тестами с теми же 
именем и путем. Если соответствующий ресурс теста или тест отсутствует 
в целевом проекте, Quality Center скопирует его в целевой проект.

➤ Copy tests/subject folders and related entities. Quality Center копирует 
тесты или папки объектов вместе со связанными ресурсами тестов и 
вызываемыми тестами и вставляет их в целевой проект. Если 
соответствующий ресурс или вызываемый тест уже существует в целевом 
проекте, скопированный связанный ресурс теста или вызываемый тест 
будет переименован для разрешения конфликта имен.

➤ Copy tests/subject folders without copying related entities. Quality Center 
копирует тесты или папки объектов без копирования связанных ресурсов 
тестов или вызываемых тестов и вставляет их в целевой проект. 
Скопированные элементы не будут связаны с какими-либо объектами.

 7 Нажмите кнопку ОK. 

Копирование URL-адресов тестов
Можно копировать тест и вставлять его URL-адрес как ссылку. Тест при 
этом не копируется. Вместо этого можно вставить адрес в другое место, 
такое как сообщение электронной почты или документ. При щелчке ссылки 
будет открыто окно Quality Center и выполнен переход к тесту. Если вход в 
систему еще не выполнен, сначала будет показано приглашение 
Quality Center для входа в систему. 

Чтобы скопировать URL-адрес теста, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования или в таблице. 
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 2 Выберите команду Edit > Copy URL. Также можно щелкнуть элемент 
правой кнопкой мыши и выбрать команду Copy URL.

 3 Вставьте URL-адрес.

Сортировка дерева плана тестирования 
По умолчанию объекты тестирования отображаются в дереве плана 
тестирования в алфавитном порядке. Можно выполнять сортировку папок в 
дереве плана тестирования и создавать пользовательскую сортировку.

Примечание. Чтобы создать пользовательскую сортировку, требуются 
разрешения администратора проекта. Дополнительные сведения о 
назначении разрешений группам пользователей см. в документе 
HP Quality Center Administrator Guide.

Чтобы отсортировать дерево плана тестирования, выполните 
следующие действия.

 1 На панели инструментов нажмите кнопку Sort Folders. Откроется 
диалоговое окно Sort Folders in Test Plan Tree.

По умолчанию выбран вариант сортировки Folder Name.
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 2 Чтобы создать пользовательскую сортировку, выберите вариант Custom 
Sort.

 3 Выберите папку объектов в левой части диалогового окна. В правой части 
будут показаны вложенные папки выбранной папки.

 4 Выберите вложенную папку в правой части диалогового окна и настройте 
приоритет сортировки дерева плана тестирования с помощью кнопок со 
стрелками Вверх или Вниз. Также можно перетаскивать вложенные папки 
вверх или вниз.

 5 Чтобы применить порядок сортировки к дереву плана тестирования, 
нажмите кнопку Close.

Изменение дерева плана тестирования
Папки объектов тестирования и тесты в дереве плана тестирования можно 
переименовывать и удалять.

Переименование папок и тестов
Можно переименовать папку или тест.
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Чтобы переименовать папку или тест, выполните следующие 
действия.

 1 Выберите элемент в дереве плана тестирования.

 2 Щелкните этот элемент. Также можно щелкнуть элемент правой кнопкой 
мыши и выбрать команду Rename.

 3 Измените имя элемента и нажмите клавишу ENTER или щелкните в другом 
месте.

Удаление папок и тестов
Можно удалить папку или тест из дерева плана тестирования. При 
удалении папки можно удалить только саму папку или папку вместе с 
вложенными папками и тестами.

Перед удалением папки или теста учтите следующее.

➤ При удалении только самой папки все тесты будут перемешены в папку 
Unattached дерева плана тестирования. 

➤ При удалении папки и тестов будут удалены все вложенные папки и тесты, 
расположенные в выбранной папке, без возможности их восстановления. 

➤ При удалении теста он будет удален вместе со скриптом без возможности 
восстановления.

➤ Если для теста определены зависимости, удаление теста может затронуть 
эти зависимости. Дополнительные сведения связанных объектах см. в 
разделе “Просмотр зависимостей" на стр. 395.

➤ Управление версиями. При удалении теста удаляются все предыдущие 
версии этого теста.

Чтобы удалить папку, выполните следующие действия.

 1 Выберите папку в дереве плана тестирования. Чтобы удалить несколько 
папок, нажмите клавишу CTRL и выберите папки, которые необходимо 
удалить.

 2 Нажмите кнопку Delete. Также можно щелкнуть папку правой кнопкой мыши 
и выбрать команду Delete. Откроется диалоговое окно Confirm Delete 
Folder.
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 3 Чтобы удалить папки и переместить все связанные тесты в папку 
Unattached, выберите вариант Delete folders only. Нажмите кнопку Yes. 

 4 Чтобы удалить папки, тесты и скрипты тестов, выберите вариант Delete 
folders and tests. Нажмите кнопку Yes. 

Если для некоторых тестов в папках определены зависимости, откроется 
еще одно диалоговое окно. Чтобы удалить тесты несмотря на то, что могут 
быть затронуты зависимости, нажмите кнопку Yes. 

Чтобы отменить удаление, нажмите кнопку No. Чтобы просмотреть 
зависимости перед удалением, выберите вкладку Dependencies. 
Дополнительные сведения см. в разделе “Просмотр зависимостей" на 
стр. 395.

Чтобы удалить тест, выполните следующие действия.

 1 Выберите тест в дереве плана тестирования. Чтобы удалить несколько 
тестов, нажмите клавишу CTRL и выберите тесты, которые необходимо 
удалить.

 2 Нажмите кнопку Delete или выберите команду Edit > Delete. Также можно 
щелкнуть тест правой кнопкой мыши и выбрать команду Delete.

 3 Если объекты, зависимые от теста, отсутствуют, откроется диалоговое 
окно подтверждения. Нажмите кнопку Yes.

 4 Если для теста определены зависимости, откроется диалоговое окно 
Delete Test. Чтобы просмотреть связанные объекты, нажмите кнопку 
Details. Нажмите кнопку Yes, чтобы подтвердить удаление теста и 
связанных объектов.
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19
Покрытие требований и покрытие 
тестами

Тесты в плане тестирования должны соответствовать исходным 
требованиям. Для отслеживания взаимоотношений между требованиями и 
тестами следует добавить связи между ними.

Эта глава содержит следующие разделы.

 ➤  О покрытии требований и тестов на стр. 317

 ➤  Связывание требований с тестом на стр. 321

 ➤  Связывание тестов с требованием на стр. 325

 ➤  Анализ покрытия на стр. 330

О покрытии требований и тестов
Сначала необходимо определить требования в дереве требований, а 
затем назначить их релизу или циклу в дереве релизов (см. Глава 13, 
"Создание дерева требований"). На этапе разработки плана тестирования 
на основе назначенных требований создается дерево плана тестирования 
(см. Глава 18, "Создание дерева плана тестирования"). Чтобы отслеживать 
взаимоотношения между назначенными требованиями и тестами, следует 
добавить связи между ними.

Покрытие требований создается в модуле Test Plan путем выбора 
требований для связи с тестом. Также можно создавать покрытие тестами 
в модуле Requirements путем выбора тестов, которые необходимо связать 
с требованием. Тест может покрывать несколько требований, а требование 
может покрываться несколькими тестами.
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Примечание. Можно также создать покрытие требований экземплярами 
тестов. Включить эту функцию можно с помощью параметра 
ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE в модуле Site 
Administration. Дополнительные сведения об этом параметре см. в 
документе HP Quality Center Administrator Guide.

Требования и тесты можно связывать с дефектами. Это поможет 
обеспечить соответствие требованиям к тестированию в течение всего 
процесса управления приложением (см. Глава 36, "Связывание дефектов"). 
При изменении требования можно сразу же определить, на какие тесты и 
дефекты это может оказать влияние, и установить ответственных лиц.
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Пример покрытия требований
Предположим, что используется проект QualityCenter_Demo, основанный 
на приложении Mercury Tours. Нажмите кнопку Test Plan на боковой 
панели. В дереве плана тестирования в папке Profiling разверните папку 
Registration и выберите тест Phone (Contact Information). 

Тест Phone (Contact Information) служит для проверки номера телефона 
заказчика на странице регистрации. Если перейти на вкладку Req 
Coverage, можно увидеть, что этот тест покрывает следующие разделы 
требования: Customer Personal Information и Correct Error Messages.
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Пример покрытия тестами
В примере с покрытием требований также можно просматривать покрытие 
в проекте QualityCenter_Demo с другой стороны. Нажмите кнопку 
Requirements на боковой панели. В папке Requirements дерева 
требований разверните разделы требований Mercury Tours Application, 
Profile Management и Registration, а затем выберите требование 
Customer Personal Information. 

Требование Customer Personal Information обеспечивает наличие личных 
сведений о заказчике в системе бронирования авиабилетов. На вкладке 
Test Coverage можно видеть, что это требование покрывается 
следующими тестами: Email (Contact Information), First & Last Name 
(Contact Information), Mailing Information, Phone (Contact Information) и 
Registration.
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Связывание требований с тестом
В процессе разработке плана тестирования при выборе теста в дереве 
плана тестирования на вкладке Req Coverage можно увидеть требования, 
которые покрываются этим тестом. 

В таблице покрытия перечислены требования, покрытые выбранным 
тестом. В таблице покрытия можно просматривать, добавлять и удалять 
требования. 

Столбцы на вкладке Req Coverage содержат данные о покрываемых 
тестом требованиях. Кроме столбцов, описанных в разделе “Поля модуля 
Requirements" на стр. 186, в таблице покрытия также можно отобразить 
следующие столбцы.

Столбец Описание

Coverage Type Тип покрытия. Этот столбец может содержать значение 
Test или Test Instance.

Entity Name Имя объекта.

Entity Status Текущий статус выполнения для объекта.
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Просмотр таблицы покрытия требований
В таблице покрытия можно настраивать размеры и порядок расположения 
столбцов. В таблице покрытия можно просматривать требования с 
указанием полного пути. Кроме того, можно перейти к необходимому 
требованию в дереве требований Quality Center.

Чтобы просмотреть таблицу Requirements Coverage Grid, выполните 
следующие действия.

 1 Выберите тест в дереве плана тестирования.

 2 Перейдите на вкладку Req Coverage.

 3 Чтобы обновить таблицу покрытия и отобразить в ней самые последние 
требования, нажмите кнопку Refresh All.

 4 Чтобы настроить размеры столбцов и порядок их расположения в таблице, 
нажмите кнопку Select Columns. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 54.

 5 Чтобы отобразить местоположение требований в дереве требований, 
щелкните таблицу покрытия правой кнопкой мыши и выберите команду 
Show Full Path.

 6 Чтобы перейти к требованию в дереве требований, щелкните нужное 
требование в таблице покрытия. Также можно щелкнуть требование 
правой кнопкой мыши и выбрать команду Go To Requirement in 
Requirements Tree.
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Добавление покрытия требований
Чтобы добавить покрытие требований в тест, выберите требование или 
несколько требований в дереве требований. По умолчанию нельзя 
добавлять покрытие для следующих типов требований: Business, Folder и 
Group.

Примечание. Покрытие требований создается автоматически при 
преобразовании требования в тест. Поэтому покрытие требований уже 
может существовать, даже если оно не было добавлено пользователем. 
Дополнительные сведения см. в разделе “Создание тестов из требований" 
на стр. 219.

Чтобы добавить покрытие требований, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования.

 2 Перейдите на вкладку Req Coverage.

 3 Нажмите кнопку Select Req, чтобы отобразить дерево требований в правой 
области. 
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 4 Чтобы найти требование в дереве, введите имя (или часть имени) 
требования в поле Find и нажмите кнопку Find. При успешном завершении 
поиска требование будет выделено в дереве.

 5 Чтобы найти требование по идентификатору ReqID, нажмите кнопку Go To 
Requirement. Откроется диалоговое окно Go To Requirement. Введите 
идентификатор требования и нажмите кнопку OK. При успешном 
завершении поиска требование будет выделено в дереве.

 6 Для фильтрации и сортировки требований в дереве нажмите кнопку Set 
Filter/Sort. Дополнительные сведения см. в Глава 3, "Работа с данными 
Quality Center".

 7 Чтобы обновить дерево требований или таблицу покрытия, нажмите 
соответствующую кнопку Refresh All. 

 8 Выберите требование или раздел требований, чтобы добавить его в 
покрытие. 

➤ Нажмите кнопку Add to Coverage (Without Children), чтобы добавить 
требование без его дочерних требований. Также можно дважды 
щелкнуть требование.

➤ Щелкните стрелку Add to Coverage и выберите команду Add to 
Coverage (Include Children), чтобы добавить требование и его 
дочерние требования. В покрытие добавляются только те дочерние 
требования, которые соответствуют текущему фильтру и принадлежат к 
типу, поддерживающему тестовое покрытие.

Требование добавляется в таблицу покрытия.

Совет. Также можно определить покрытие требований путем 
перетаскивания требования из дерева требований в таблицу покрытия. 
Требование будет добавлено в таблицу покрытия без дочерних 
требований.

 9 Нажмите кнопку Close, чтобы скрыть дерево требований.
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Удаление покрытия требований
Можно удалять требования из покрытия требований теста.

Чтобы удалить покрытие требований, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования.

 2 Перейдите на вкладку Req Coverage.

 3 Выберите в таблице покрытия требование, которое необходимо удалить.

 4 Нажмите кнопку Remove Selected, а затем нажмите кнопку Yes для 
подтверждения.

Связывание тестов с требованием
С помощью модуля Requirements можно связывать тесты с требованиями.

При выборе требования в дереве требований на вкладке Test Coverage 
отображается покрытие этого требования тестами. Таблица покрытия 
содержит тесты, которые покрывают выбранное требование. В таблице 
покрытия можно просматривать, добавлять и удалять тесты. 
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Столбцы таблицы Test Coverage содержат данные о тестах, покрывающих 
требование. Кроме столбцов, описанных в разделе “Столбцы таблицы 
тестов" на стр. 285, в таблице покрытия также можно отобразить 
следующие столбцы.

Просмотр таблицы покрытия тестами
В таблице покрытия можно применять фильтры и отображать или скрывать 
полное покрытие. Кроме того, Quality Center позволяет переходить к 
необходимому тесту в дереве плана тестирования.

Чтобы просмотреть таблицу покрытия тестами, выполните 
следующие действия.

 1 Выберите требование в представлении Requirement Details.

 2 Перейдите на вкладку Test Coverage.

 3 Для фильтрации таблицы покрытия по типу статуса выберите нужный 
статус в списке Status Filter. Например, можно просматривать только 
тесты со статусом Passed. Чтобы очистить фильтр, выберите вариант All.

 4 Чтобы обновить данные в таблице покрытия, нажмите кнопку Refresh All.

 5 Чтобы фильтровать, сортировать или группировать записи в таблице 
покрытия, нажмите кнопку Set Filter/Sort. Чтобы очистить все фильтры, 
параметры сортировки или группирования, нажмите стрелку Set Filter/Sort 
и выберите команду Clear Filter/Sort.

 6 Чтобы настроить вид столбцов и порядок их расположения в таблице, 
нажмите кнопку Select Columns. Подробные сведения о диалоговом окне 
Select Columns см. в разделе “Упорядочивание столбцов" на стр. 54.

Столбец Описание

Coverage Type Тип покрытия. Этот столбец может содержать значение 
Test или Test Instance.

Entity Name Имя объекта.

Entity Status Текущий статус выполнения для объекта.
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 7 Чтобы просмотреть покрытие тестами всех дочерних требований 
выбранного требования, установите флажок Full Coverage. По умолчанию 
полное покрытие не отображается.

 8 Чтобы перейти к определенному тесту в дереве плана тестирования, 
щелкните этот тест в таблице покрытия. Также можно щелкнуть тест в 
таблице покрытия правой кнопкой мыши и выбрать команду Go to Test in 
Test Plan Tree.

 9 Чтобы перейти к определенному тесту в модуле Test Lab, щелкните этот 
тест в таблице покрытия правой кнопкой мыши и выберите команду Go to 
Test in Test Set.

 10 В нижней правой части окна щелкните значок Show, чтобы отобразить 
диаграмму Coverage Chart. На этой круговой диаграмме графически 
показан статус выполнения тестов в таблице покрытия.

Добавление покрытия тестами
Чтобы добавить к требованию покрытие тестами, следует выбрать тесты в 
дереве плана тестирования. По умолчанию нельзя добавлять покрытие 
для следующих типов требований: Business, Folder и Group.

Примечание. Покрытие тестами создается автоматически при создании 
теста из требования. Поэтому покрытие тестами уже может существовать, 
даже если оно не было добавлено пользователем. Дополнительные 
сведения см. в разделе “Создание тестов из требований" на стр. 219.

Чтобы добавить покрытие тестами к требованию, выполните 
следующие действия.

 1 Выберите требование в дереве требований. На вкладке Test Coverage 
будет показана таблица покрытия для выбранного требования.
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 2 На вкладке Test Coverage нажмите кнопку Select Tests, чтобы отобразить 
дерево плана тестирования в правой области.

 3 Чтобы найти определенный тест в дереве, введите его имя (или часть 
имени) в поле Find и нажмите кнопку Find. При успешном завершении 
поиска тест будет выделен в дереве.

 4 Чтобы найти тест по идентификатору Test ID, нажмите кнопку Go To Test. 
Откроется диалоговое окно Go To Test. Введите идентификатор теста и 
нажмите кнопку OK. При успешном завершении поиска тест будет выделен 
в дереве.

 5 Для фильтрации или сортировки требований в дереве нажмите кнопку Set 
Filter/Sort. Дополнительные сведения о фильтрации и сортировке записей 
см. в Глава 3, "Работа с данными Quality Center". 

 6 Чтобы обновить дерево, нажмите кнопку Refresh All. 
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 7 Чтобы добавить тест в покрытие требования тестами, выберите тест или 
папку тестов на вкладке Test Plan Tree и нажмите кнопку Add To Coverage. 
Тест будет добавлен в таблицу покрытия. При выборе папки в покрытие 
тестами будут добавлены только те тесты, которые соответствуют 
текущему фильтру.

Совет. Также можно определять покрытие тестами путем перетаскивания 
теста или папки тестов с вкладки Test Plan Tree в таблицу покрытия.

 8 Нажмите кнопку Close, чтобы скрыть дерево плана тестирования в правой 
области.

Удаление покрытия тестами
Можно удалять тесты из покрытия требования тестами.

Чтобы удалить покрытие требования, выполните следующие 
действия.

 1 Выберите требование в представлении Requirement Details. На вкладке 
Test Coverage будет показана таблица покрытия для выбранного 
требования.

 2 Выберите тест, который необходимо удалить из таблицы покрытия.

 3 Нажмите кнопку Remove From Coverage, а затем нажмите кнопку Yes для 
подтверждения.
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Анализ покрытия
В модуле Requirements в представлении Coverage Analysis можно 
анализировать статус требований. Это позволяет понять распределение 
дочерних требований в соответствии с покрытием тестами. Можно 
выполнять анализ покрытия по циклам, что позволяет просматривать в 
анализе только покрытие выполнениями, назначенными определенным 
циклам.

Например, в проекте QualityCenter_Demo выберите требование 
Application Client System, которое находится в требовании Mercury Tours 
Application. Это требование имеет двенадцать дочерних требований, 
включая само родительское требование. В представлении Coverage 
Analysis видно, что два дочерних требования имеют статус Failed (один или 
несколько тестов, покрывающих это требование, не пройдены). Анализ 
показывает, что три теста (27%), связанных с выбранным требованием, не 
пройдены.

Примечание. По умолчанию покрытие доступно только для следующих 
типов требований: Functional, Testing и Undefined.

Чтобы проанализировать покрытие, выполните следующие действия.

 1 Выберите команду View > Coverage Analysis. 
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Представление Coverage Analysis содержит следующие столбцы.

 2 Quality Center Выпуски Enterprise Edition и Premier Edition. Чтобы 
включить в анализ только тесты, имеющие выполнения, назначенные 
определенным циклам, нажмите кнопку обзора в поле Coverage 
calculation by cycle. Откроется дерево релизов. Разверните это дерево и 
выберите циклы, для которых необходимо проанализировать покрытие. 
Чтобы закрыть дерево релизов, нажмите кнопку OK.

 3 Щелкните в столбце Coverage Analysis требование, которое необходимо 
проанализировать. Также можно щелкнуть требование правой кнопкой 
мыши и выбрать команду Coverage Analysis. Откроется диалоговое окно 
Coverage Analysis.

Столбец Описание

Name Дерево требований, содержащее иерархически 
упорядоченные требования.

Direct Cover Status Текущий статус требования, определенный по статусу 
тестов, связанных с этим требованием. Например, если 
показано значение статуса прямого покрытия Not 
Completed, это значит, что один или несколько тестов, 
покрытых требованием, не были завершены. Полное 
определение см. в разделе “Direct Cover Status" на 
стр. 186. 

Coverage Analysis В этом столбце графически показан статус прямого 
покрытия требования и его дочерних требований. При 
анализе не учитываются требования, которые не 
соответствуют текущему фильтру, и требования со 
статусом прямого покрытия N/A.

Если покрытие было установлено по циклам, 
Quality Center не использует при расчетах  поле Direct 
Cover Status. Вместо этого Quality Center использует 
значения статуса прямого покрытия, вычисленные на 
основе тестов, которые имеют экземпляры, относящиеся 
к папкам наборов тестов, назначенным включенным в 
фильтр циклам. В этом случае требования, не имеющие 
покрытия тестами ни для одного из циклов в фильтре, не 
учитываются при анализе.
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Например, щелкните в столбце Coverage Analysis ячейку требования 
Application Client System. На диаграмме видно, что у этого требования 
есть два дочерних требования, которые имеют статус Failed, и десять 
дочерних требований, которые имеют статус Not Covered.

 4 Щелкните участок на диаграмме, чтобы отобразить список дочерних 
требований с выбранным статусом. В данном примере щелкните участок 
Failed, чтобы отобразить требования, которые имеют статус Failed. Будут 
показаны имена двух требований со статусом Failed.

Можно выбрать требование и нажать кнопку Go To, чтобы выделить 
требование в дереве требований.
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 5 Щелкните ссылку Show Tests Coverage, чтобы развернуть диалоговое 
окно Coverage Analysis и отобразить диаграмму Tests Coverage Chart.

Эта круговая диаграмма графически отображает полное покрытие 
требования тестами, сгруппированными по статусу. В данном примере 
требование Application Client System и его дочерние требования связаны с 
одним тестом со статусом Failed, одним тестом со статусом Not Completed, 
двумя тестами со статусом No Run и семью тестами со статусом Passed. 
Если родительское требование имеет несколько дочерних, и все они 
покрывают один и тот же тест, то этот тест включается в диаграмму Tests 
Coverage Chart для родительского требования только один раз.
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 6 Щелкните участок на диаграмме, чтобы просмотреть список тестов с 
выбранным статусом, которые покрывают данное требование и его 
дочерние требования. Откроется диалоговое окно Tests Coverage, в 
котором значение в поле Status Filter совпадает со статусом теста на 
выбранном участке диаграммы.

Если родительское требование имеет несколько дочерних, и все они 
покрывают один и тот же тест, то этот тест включается в диаграмму Tests 
Coverage Chart родительского требования для каждого дочернего 
требования.

Можно изменять значение в поле Status Filter или изменять покрытие 
требования тестами. Дополнительные сведения см. в разделе “Связывание 
тестов с требованием" на стр. 325.

 7 Чтобы отобразить диаграмму Tests Coverage Chart, нажмите кнопку Show.

 8 Нажмите кнопку Close, чтобы закрыть диалоговое окно Test Coverage.

 9 Нажмите кнопку Close, чтобы закрыть диалоговое окно Coverage Analysis.
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 10 Чтобы сохранить представление Coverage Analysis в документе Word, 
выберите команду Requirements > Export > Word Document. Будет создан 
документ Word с гистограммой для каждого родительского требования в 
дереве требований.
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20
Построение тестов

После создания дерева плана тестирования можно перейти к разработке 
тестов путем определения шагов тестов.

Эта глава содержит следующие разделы.

 ➤  О построении тестов на стр. 337

 ➤  Определение шагов теста на стр. 339

 ➤  Вызов ручных тестов на стр. 341

 ➤  Управление шагами теста на стр. 344

О построении тестов
Построение тестов выполняется в модуле Test Plan путем определения 
шагов тестов — подробных пошаговых инструкций по выполнению теста. 
Шаг теста включает операции, выполняемые с приложением, вводимые 
данные и ожидаемые выходные данные. Шаги теста можно определить 
лишь после добавления этого теста в дерево плана тестирования и 
определения основной информации теста.

Шаги теста можно создавать как для ручных, так и для автоматических 
тестов. Для ручного теста планирование и разработка завершаются после 
создания шагов. Можно сразу начать выполнение теста в соответствии с 
планом. Для автоматизированных тестов необходимо создание скриптов 
автоматизированных тестов с использованием средств тестирования 
компании HP или сторонних разработчиков. 
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При необходимости автоматизировать тест скрипт теста создается на 
основе определенных шагов теста. После анализа проекта теста 
принимается решение о необходимости автоматизации теста. 
Дополнительные сведения см. в Глава 22, "Создание автоматических 
тестов"..

Можно создать шаг теста, вызывающий другой ручной тест. Это удобно при 
наличии общих шагов, которые требуется часто выполнять в рамках других 
тестов. Дополнительные сведения о вызове ручных тестов см. в разделе 
“Вызов ручных тестов" на стр. 341.

Разработка шагов теста выполняется на вкладке Design Steps в дереве 
плана тестирования.
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Определение шагов теста 
Шаги теста добавляются в тест с помощью редактора Design Step Editor.

Примечание. Можно включить шаг теста, вызывающий другой ручной тест. 
Дополнительные сведения см. в разделе “Вызов ручных тестов" на стр. 341.

Чтобы определить шаг теста, выполните следующие действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps. 

 2 Нажмите кнопку New Step или щелкните правой кнопкой мыши на вкладке 
Design Steps и выберите команду New Step. Откроется окно Design Step 
Editor, в котором в поле Step Name будет показано имя шага теста по 
умолчанию. 
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По умолчанию для имени шага теста используется порядковый номер шага 
(Step 1 при добавлении первого шага). Если это имя необходимо изменить, 
введите другое имя в поле Step Name.

 3 Введите описание шага теста в поле Description и ожидаемый результат 
шага в поле Expected Result.

 4 Чтобы добавить параметр, нажмите кнопку Insert Parameter. 
Дополнительные сведения см. в разделе “Вставка параметров теста в шаг 
теста" на стр. 357.

 5 Чтобы сохранить текущий шаг вручную, нажмите кнопку Save Steps.

 6 Чтобы добавить другие шаги, нажмите кнопку New Step. В поле Step Name 
будет показан следующий порядковый номер шага.

 7 Чтобы закрыть окно редактора Design Step Editor и добавить шаги, нажмите 
кнопку OK.

Созданные шаги теста появятся на вкладке Design Steps. В дереве плана 
тестирования рядом со значком теста появится значок  , указывающий, 
что шаги теста определены.

 8 К шагу теста можно прикладывать вложения. Вложением может быть файл, 
URL-адрес, снимок приложения, элемент из буфера обмена или сведения 
о системе. Чтобы добавить вложение к шагу теста, выберите шаг, а затем 
нажмите кнопку Attachments. Дополнительные сведения см. в Глава 5, 
"Добавление вложений"..

Примечания. 

➤ Можно копировать шаги из существующего теста. Дополнительные 
сведения см. в разделе “Управление шагами теста" на стр. 344.

➤ Если к шагу добавлено вложение, то при каждом выполнении теста 
создается копия этого вложения. Дополнительные сведения о 
выполнении тестов см. в разделе “Выполнение теста вручную" на 
стр. 468.
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Вызов ручных тестов
В тест можно добавлять шаги, включающие вызов ручного теста. При 
выполнении вызывающего теста он будет включать шаги и параметры 
вызываемого теста. Это удобно при наличии общих шагов, которые 
требуется часто выполнять в рамках других тестов.

Предположим, например, что в различные тесты необходимо включить шаг 
входа в систему. Можно создать тест Login_Template, который выполняет 
вход пользователя в систему при запуске приложения. Этот тест можно 
вызывать в начале каждого теста.

Чтобы отличать тесты, которые будут вызываться из других тестов, можно 
пометить вызываемые тесты как шаблоны тестов. 

Шаблоны тестов часто включают параметры тестов. Эти параметры 
удобно использовать, если необходимо выполнять шаблон теста с 
различными данными в зависимости от типа вызывающего теста. 
Дополнительные сведения об использовании параметров в ручных тестах 
см. в Глава 21, "Работа с параметрами в ручных тестах"..

Этот раздел, посвященный вызову ручных тестов, содержит следующие 
подразделы.

➤ Пометка ручного теста как шаблона теста

➤ Вызов ручного теста
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Пометка ручного теста как шаблона теста
В дереве плана тестирования ручной тест можно пометить как шаблон 
теста. Для вызова теста необязательно помечать его как шаблон теста. 
Пометка теста как шаблона позволяет упростить выбор шаблона теста при 
его вызове из другого теста.

Чтобы пометить ручной тест как шаблон, выполните следующие 
действия.

В дереве плана тестирования щелкните правой кнопкой мыши ручной тест 
и выберите команду Mark as Template Test. Значок ручного теста изменит 
цвет с серого на белый для указания шаблона теста.

Вызов ручного теста
В тест можно добавлять шаги, включающие вызов другого ручного теста. 
При выполнении вызывающего теста к его шагам добавляются шаги 
вызываемого теста.

Чтобы вызвать ручной тест, выполните следующие действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.
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 2 На вкладке Design Steps выберите шаг, после которого необходимо 
вызвать другой тест, а затем нажмите кнопку Call to Test. Откроется 
диалоговое окно Select a Test.

 3 По умолчанию будут показаны только шаблоны тестов. Если необходимо 
добавить тест, который не является шаблоном, снимите флажок Show only 
Template Tests.

 4 Для фильтрации и сортировки тестов в диалоговом окне Select a Test 
нажмите кнопку Set Filter/Sort. Откроется диалоговое окно Filter. 
Дополнительные сведения о фильтрации и сортировке см. в Глава 3, 
"Работа с данными Quality Center".

 5 Чтобы найти тест, введите его имя (или часть имени) в поле Find и 
нажмите кнопку Find. При успешном завершении поиска тест будет 
выделен в дереве.

 6 Чтобы обновить все тесты в дереве, нажмите кнопку Refresh All. 

 7 Выберите ручной тест, который необходимо вызвать.
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 8 Нажмите кнопку ОK. Если вызываемый тест содержит параметры, 
откроется диалоговое окно Parameters of Test, в котором будут показаны 
параметры вызываемого теста. Присвойте параметрам фактические 
значения. Эти значения будут использоваться для всех экземпляров 
тестов, созданных из этого теста. Дополнительные сведения см. в разделе 
“Назначение фактических значений" на стр. 358.

 9 Нажмите кнопку ОK. Вызов будет вставлен в шаг теста в виде ссылки, и 
будут показаны значения, присвоенные параметрам вызываемого теста.

 10 Чтобы изменить значения параметров вызываемого теста, щелкните вызов 
теста правой кнопкой мыши и выберите команду Called Test Parameters. В 
диалоговом окне Called Test Parameters введите новые значения 
параметров, а затем нажмите кнопку OK.

Управление шагами теста
Этот раздел, посвященный управлению шагами теста, содержит 
следующие подразделы.

➤ Редактирование шагов теста

➤ Изменение порядка шагов теста

➤ Изменение нумерации шагов теста

➤ Изменение размеров шагов теста

➤ Упорядочивание столбцов шагов теста

➤ Удаление шагов теста

➤ Копирование шагов теста в проекте

➤ Копирование шагов теста между проектами

➤ Поиск замена текста в шаге теста

Редактирование шагов теста
Можно изменять существующие шаги теста и добавлять новые.
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Чтобы изменить шаги теста, выполните следующие действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.

 2 Дважды щелкните шаг или выберите его, а затем нажмите кнопку Edit Step. 
Откроется окно Design Step Editor. 

Для перемещения по шагам теста можно использовать кнопки навигации.

➤ Нажмите кнопку First Step, чтобы отобразить первый шаг теста, или 
кнопку Previous Step, чтобы отобразить предыдущий шаг.

➤ Нажмите кнопку Next Step, чтобы отобразить следующий шаг теста, или 
кнопку Last Step, чтобы отобразить последний шаг.
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Совет. Для переключения между шагами в окне Design Step Editor можно 
использовать следующие сочетания клавиш. Сочетание клавиш ALT+HOME 
— переход к первому шагу, ALT+СТРЕЛКА ВЛЕВО — переход к 
предыдущему шагу, ALT+СТРЕЛКА ВПРАВО — переход к следующему 
шагу, ALT+END — переход к последнему шагу.

 3 Описание и ожидаемые результаты можно изменять в полях Description и 
Expected Result.

 4 Нажмите кнопку New Step, чтобы добавить шаг после текущего выбранного 
шага.

 5 Чтобы закрыть окно Design Step Editor и сохранить изменения, нажмите 
кнопку OK.

Изменение порядка шагов теста
Порядок шагов теста можно изменять.

Чтобы изменить порядок шагов теста, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.

 2 Наведите указатель мыши на серую боковую панель слева от шага, 
который требуется переместить. Указатель мыши примет вид .

 3 Щелкните и перетащите мышью шаг в нужное положение.

Изменение нумерации шагов теста
После добавления, удаления или изменения порядка шагов теста их можно 
перенумеровать. 

Чтобы перенумеровать шаги теста, выполните следующие действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.

 2 Нажмите кнопку Renumber Steps.
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Изменение размеров шагов теста
Размер строки шага теста можно изменять. Это позволяет увидеть весь 
текст в столбцах Description и Expected Result, если текст очень длинный. 

Чтобы изменить размер строки шага, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.

 2 Наведите указатель мыши на серую боковую панель возле нижней границы 
шага, размер которого необходимо изменить. 

 3 Нажмите кнопку Adjust Rows Height. 

Также можно навести указатель мыши на серую боковую панель возле 
нижней границы шага, размер которого необходимо изменить. Указатель 
мыши примет вид . Щелкните и перетащите мышью границу строки, 
чтобы настроить размер.

Упорядочивание столбцов шагов теста
Можно определить, какие столбцы и в каком порядке должны отображаться 
на вкладке Design Steps.

Чтобы упорядочить столбцы шагов теста, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.

 2 Нажмите кнопку Select Columns. Откроется диалоговое окно Select 
Columns. Дополнительные сведения см. в разделе “Упорядочивание 
столбцов" на стр. 54.

Удаление шагов теста
Шаги можно удалять из теста.

Чтобы удалить шаг теста, выполните следующие действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.
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 2 Выберите шаг, который необходимо удалить. Чтобы удалить несколько 
шагов, сначала наведите указатель мыши на серую боковую панель слева 
от шага, который требуется удалить. Указатель мыши примет вид . 
Щелкните, чтобы выбрать этот шаг. С помощью клавиши CTRL или SHIFT 
выберите остальные шаги.

 3 Нажмите кнопку Delete Selected. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Delete Selected.

 4 Нажмите кнопку Yes для подтверждения.

Копирование шагов теста в проекте
В пределах проекта можно копировать шаги из другого теста. Параметры 
шага теста также будут скопированы в целевой тест.

Чтобы скопировать шаг теста внутри проекта, выполните следующие 
действия.

 1 В дереве плана тестирования выберите тест, из которого необходимо 
скопировать шаги, а затем перейдите на вкладку Design Steps.

 2 Выберите шаг, который необходимо скопировать. Чтобы скопировать сразу 
несколько шагов, сначала наведите указатель мыши на серую боковую 
панель слева от шага. Указатель мыши примет вид . Щелкните, чтобы 
выбрать этот шаг. С помощью клавиши CTRL или SHIFT выберите 
остальные шаги.

 3 Нажмите кнопку Copy Steps или щелкните правой кнопкой мыши и 
выберите команду Copy.

 4 Выберите тест, в который необходимо вставить шаги, а затем перейдите на 
вкладку Design Steps.

 5 Нажмите кнопку Paste Steps или щелкните правой кнопкой мыши и 
выберите команду Paste.

Копирование шагов теста между проектами
Можно копировать шаги из одного проекта и вставлять их в другой проект. 
Если шаги содержат вызовы других тестов, Quality Center позволяет 
скопировать их одним из следующих способов.
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➤ Копирование шагов теста и установление связи шагов с существующими 
тестами в целевом проекте. Если вызываемый тест отсутствует в целевом 
проекте, Quality Center скопирует его в целевой проект.

➤ Копирование шагов теста и вызываемых тестов в целевой проект.

➤ Копирование шагов теста без копирования вызываемых тестов в целевой 
проект.

Параметры шага теста также будут скопированы в целевой тест.

Примечание. Для копирования шагов теста между проектами оба проекта 
должны иметь одну и ту же версию и уровень исправлений Quality Center.

Чтобы скопировать шаг теста между проектами, выполните 
следующие действия.

 1 В дереве плана тестирования выберите тест, из которого необходимо 
скопировать шаги, а затем перейдите на вкладку Design Steps.

 2 Выберите шаг, который необходимо скопировать. Чтобы скопировать сразу 
несколько шагов, сначала наведите указатель мыши на серую боковую 
панель слева от шага. Указатель мыши примет вид . Щелкните, чтобы 
выбрать этот шаг. С помощью клавиши CTRL или SHIFT выберите 
остальные шаги.

 3 Нажмите кнопку Copy Steps или щелкните правой кнопкой мыши и 
выберите команду Copy.

 4 Откройте другой экземпляр Quality Center и войдите в проект, в который 
необходимо вставить шаги.

 5 Выберите тест, в который необходимо вставить шаги, а затем перейдите на 
вкладку Design Steps.

 6 Нажмите кнопку Paste Steps или щелкните правой кнопкой мыши и 
выберите команду Paste. Откроется диалоговое окно Paste Design Steps to 
Target Project. 
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 7 Выберите один из следующих вариантов.

➤ Copy design steps and link to existing related entities. Quality Center 
копирует шаги теста и вставляет их в целевой проект. Скопированные 
шаги теста будут связаны с существующими тестами с теми же 
именами. Если вызываемый тест отсутствует в целевом проекте, 
Quality Center скопирует его в целевой проект.

➤ Copy design steps and related entities. Quality Center копирует шаги 
теста и вызываемые тесты и вставляет их в целевой проект. Если имя 
вызываемого теста уже существует в целевом проекте, то 
скопированный вызываемый тест будет переименован для разрешения 
конфликта имен.

➤ Copy design steps without copying related entities. Quality Center 
копирует шаги теста, не копируя вызываемые тесты, и вставляет их в 
целевой проект. Скопированные шаги теста не будут связаны с 
вызываемыми тестами.

Нажмите кнопку ОK. 

Поиск замена текста в шаге теста
На вкладке Design Steps можно выполнить поиск текста в шагах теста. Для 
одного шага поиск и замену текста можно также выполнить в редакторе 
Design Steps Editor.

Чтобы найти текст на вкладке Design Steps, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.
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 2 Нажмите кнопку Find Text. Откроется диалоговое окноFind.

 3 В поле Find in Field выберите критерий поиска.

 4 В поле Value to Find укажите значение выбранного поля.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы найти точное совпадение, установите флажок Exact Match.

 7 Чтобы использовать звездочки (*) в строке поиска и вводить только часть 
элемента, установите флажок Use Wildcard.

 8 Нажмите кнопку Find Next. При успешном завершении поиска шаг будет 
выделен. При неудачном завершении поиска откроется информационное 
окно.

 9 Нажмите кнопку Close, чтобы закрыть диалоговое окно.

Чтобы найти и заменить текст в редакторе Design Steps Editor, 
выполните следующие действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку 
Design Steps.

 2 Нажмите кнопку New Step, чтобы добавить новый шаг, или нажмите кнопку 
Edit Step, чтобы изменить уже существующий шаг. Откроется редактор 
Design Step Editor.
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 3 Нажмите кнопку Find/Replace Text. Откроется диалоговое окно Replace.

 4 В поле Find what введите текст, который необходимо найти.

 5 Чтобы заменить указанный текст, введите текст для замены в поле Replace 
with.

 6 Если необходимо найти целое слово, установите флажок Match whole 
word only.

 7 Чтобы найти значение с учетом регистра, установите флажок Match case.

 8 Нажмите кнопку Find Next. При неудачном завершении поиска откроется 
информационное окно.

 9 Нажмите кнопку Replace, чтобы заменить первое вхождение текста, или 
кнопку Replace All, чтобы заменить все вхождения текста.
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21
Работа с параметрами в ручных тестах

К ручным тестам можно добавлять параметры и использовать их в шагах 
теста.

Эта глава содержит следующие разделы.

 ➤  О работе с параметрами в ручных тестах на стр. 353

 ➤  Определение параметров теста на стр. 355

 ➤  Обновление параметров теста на стр. 356

 ➤  Вставка параметров теста в шаг теста на стр. 357

 ➤  Назначение фактических значений на стр. 358

 ➤  Управление параметрами теста на стр. 361

О работе с параметрами в ручных тестах
Для увеличения гибкости ручных тестов можно добавить параметры к 
шагам теста. Это позволяет запускать один и тот же тест несколько раз с 
разными данными.

Параметр теста — это переменная, которой присваивается значение вне 
теста, в котором она была определена.
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Ручные тесты с параметрами можно вызывать из других тестов. Это 
удобно при наличии общих шагов, которые требуется часто выполнять в 
рамках других тестов. Например, можно создать шаблон теста 
Login_Template, который выполняет вход пользователя в систему при 
запуске приложения. Необходимо вызывать этот тест в начале каждого 
теста. В некоторых случаях необходимо входить в систему с правами 
обычного пользователя, в других случаях — с правами администратора 
проекта.

Для этого можно создать два параметра, <<<user name>>> и 
<<<password>>>, и изменять их значения в зависимости от типа теста, 
вызывающего тест Login_Template. Если чаще всего выполняется вход в 
систему с именем обычного пользователя, можно присвоить этим 
параметрам значения по умолчанию, соответствующие имени и паролю 
обычного пользователя. Дополнительные сведения о вызове ручных 
тестов см. в разделе “Вызов ручных тестов" на стр. 341.

Работа с параметрами в ручных тестах осуществляется следующим 
образом.

 1 Определите параметры в ручном тесте. Дополнительные сведения см. в 
разделе “Определение параметров теста" на стр. 355.

 2 Добавьте параметры к шагу теста. Дополнительные сведения см. в 
разделе “Вставка параметров теста в шаг теста" на стр. 357.

 3 На различных стадиях разработки теста назначайте параметрам значения, 
используемые при выполнении теста. Дополнительные сведения см. в 
разделе “Назначение фактических значений" на стр. 358.
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Определение параметров теста
Перед использованием параметров в шагах теста необходимо определить 
эти параметры в тесте.

Чтобы определить параметр теста, выполните следующие действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку Test 
Parameters.

 2 Нажмите кнопку New Parameter. Откроется диалоговое окно New 
Parameter.

 3 Введите имя для нового параметра. Имя параметра не должно содержать 
следующих символов: ~ ? ’ < > %

 4 Перейдите на вкладку Default Value и введите значение параметра по 
умолчанию. Значение по умолчанию помогает пользователю присвоить 
фактическое значение перед выполнением теста.

 5 Перейдите на вкладку Description и введите описание параметра.

 6 Нажмите кнопку OK.
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Обновление параметров теста
Можно добавлять или изменять данные существующего параметра теста.

Чтобы обновить параметр теста, выполните следующие действия.

 1 В таблице Test Parameters дважды щелкните параметр, который 
необходимо изменить. Также можно выбрать параметр и нажать кнопку 
Parameter Details. Откроется диалоговое окно Parameter Details.

 2 Обновите или введите значения в следующих полях.

➤ Parameter Name. Имя параметра не должно содержать следующих 
символов: ~ ? ’ < > %

При изменении имени параметра Quality Center создает новый параметр 
с новым именем, сохраняя исходный параметр.

➤ Default Value.

➤ Description.

 3 Нажмите кнопку OK, чтобы сохранить изменения.
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Вставка параметров теста в шаг теста
Можно добавлять параметры в описание или ожидаемые результаты шага 
ручного теста. Можно использовать существующие параметры или 
определять новые.

Чтобы вставить параметр теста в шаг теста, выполните следующие 
действия.

 1 Дважды щелкните шаг теста на вкладке Design Steps. Поместите курсор в 
поле Description или в поле Expected Result.

 2 Нажмите кнопку Insert Parameter. Откроется диалоговое окно Insert 
Parameter.

 3 Чтобы вставить существующий параметр, выделите параметр и нажмите 
кнопку OK.

Параметр будет добавлен в шаг теста в текущей позиции курсора с 
использованием синтаксиса <<<имя параметра>>>.
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Примечание. Если к имени параметра в шаге теста применяется 
форматирование, необходимо применять одинаковое форматирования ко 
всему имени параметра, включая символы <<< и >>>. Например, если 
необходимо, чтобы параметр <<<password>>> отображался курсивом, то 
следует выделить курсивом всю строку <<<password>>>, а не только слово 
password.

 4 Чтобы добавить новый параметр, нажмите кнопку New Parameter. 
Дополнительные сведения см. в разделе “Определение параметров теста" 
на стр. 355. Новый параметр будет добавлен в шаг теста. 

Также можно ввести имя нового параметра в описании шага теста с 
использованием синтаксиса <<<имя параметра>>>. После сохранения 
шага теста новый параметр будет добавлен на вкладку Test Parameters.

Назначение фактических значений
Перед выполнением теста Quality Center выдает запрос для назначения 
фактических значений параметрам, включенным в тест. Фактическое 
значение представляет собой данные, используемые при выполнении 
теста. Можно принять значения параметров по умолчанию и использовать 
их как фактические значения.

Quality Center выдает запрос для назначения фактических значений на 
трех стадиях разработки теста. В соответствии с политикой тестирования 
можно назначать фактические значения на любой из этих стадий.

➤ При вызове теста с параметрами. Если фактические значения 
назначаются параметрам при вызове теста, эти значения автоматически 
применяются ко всем экземплярам тестов, созданным из вызывающего 
теста.
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➤ При создании экземпляра теста. Если фактические значения 
назначаются параметрам при создании экземпляра теста, эти значения 
автоматически применяются ко всем выполнениям экземпляра теста. 
Также можно назначать фактические значения экземплярам тестов в 
конфигурации экземпляра теста. Дополнительные сведения см. в разделе 
“Установка значений параметров для экземпляров ручных тестов" на 
стр. 501.

➤ При выполнении теста. Если фактические значения назначаются 
параметрам для выполнения теста, значения используются только для 
этого выполнения теста. Если фактические значения не будут назначены 
на этой стадии, тест будет выполнен с неопределенными значениями.

На каждой из этих стадий можно назначать значения только тем 
параметрам, значения которых еще не были назначены.

Чтобы назначить фактические значения, выполните следующие 
действия.

 1 При вызове ручного теста с параметрами, создании экземпляра теста с 
параметрами или выполнении теста с параметрами Quality Center выдает 
запрос для назначения фактических значений параметров. Открывается 
диалоговое окно Parameters of Test.
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Quality Center показывает только те параметры, которым еще не были 
назначены фактические значения.

 2 Выберите параметр, которому необходимо назначить фактическое 
значение. Чтобы выбрать несколько параметров, используйте клавишу 
CTRL или SHIFT.

 3 В столбце Actual Value введите значение, которое будет использоваться 
для параметра при выполнении теста. После начала ввода текста 
откроется текстовое поле. Нажмите кнопку OK, чтобы сохранить значение.

 4 Чтобы использовать значение параметра по умолчанию в качестве 
фактического значения, нажмите кнопку Take Default Values. Текущее 
фактическое значение будет заменено значением по умолчанию.

 5 Нажмите кнопку ОK.
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Управление параметрами теста
На вкладке Test Parameters можно просматривать параметры теста и 
управлять ими.

Чтобы управлять параметрами теста, выполните следующие 
действия.

 1 Выберите тест в дереве плана тестирования и перейдите на вкладку Test 
Parameters.

Галочка в столбце Used указывает на то, что параметр включен в шаг 
теста.

 2 Чтобы добавить новый параметр теста, нажмите кнопку New Parameter. 
Дополнительные сведения см. в разделе “Определение параметров теста" 
на стр. 355.

 3 Чтобы удалить параметр теста, выберите параметр и нажмите кнопку 
Delete. Если удалить параметр, включенный в шаг теста, параметр в шаге 
теста будет заменен обычным текстом с использованием синтаксиса <имя 
параметра>.

 4 Чтобы обновить таблицу параметров теста, нажмите кнопку Refresh All.
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 5 Чтобы отфильтровать параметры теста, показанные в таблице, 
используйте одну из следующих команд, доступных при нажатии кнопки Set 
Filter/Sort.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать параметры в таблице параметров теста. 

➤ Clear Filter/Sort. Очистка всех фильтров и параметров сортировки, 
примененных к таблице параметров теста.

Дополнительные сведения о фильтрации и сортировке см. в Глава 3, 
"Работа с данными Quality Center".

 6 Чтобы выбрать столбцы, отображаемые в таблице параметров теста, и 
установить порядок столбцов, нажмите кнопку Select Columns. 
Дополнительные сведения см. в разделе “Упорядочивание столбцов" на 
стр. 54.

 7 Чтобы изменит данные параметра теста, выберите параметр и нажмите 
кнопку Parameter Details. Дополнительные сведения см. в разделе 
“Обновление параметров теста" на стр. 356.
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22
Создание автоматических тестов

Разработанные шаги теста можно использовать в качестве основы для 
создания скрипта автоматизированного теста.

Эта глава содержит следующие разделы.

 ➤  О создании автоматизированных тестов на стр. 363

 ➤  Создание скриптов автоматизированных тестов на стр. 364

О создании автоматизированных тестов 
При разработке плана тестирования следует решить, какие тесты должны 
быть автоматизированы. Если тест должен быть автоматизирован, 
необходимо создать скрипт теста и выполнить тест с помощью средств 
WinRunner, QuickTest Professional, LoadRunner или Visual API-XP.

При определении того, следует ли автоматизировать тест, необходимо 
учитывать следующие факторы.

Частота выполнения теста
Тесты, которые необходимо выполнять для каждой новой версии 
приложения, желательно автоматизировать. К числу таких тестов 
относятся тесты для проверки работоспособности приложения в целом. 
Эти тесты используются для проверки стабильности каждой новой версии 
приложения. После выполнения этих тестов можно перейти к более 
детальному тестированию.
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Также желательно автоматизировать тесты, используемые при проверке 
набора значений для одной и той же операции (тесты, определяемые 
данными). Выполнение теста вручную с различными входными данными 
весьма утомительно и малоэффективно. Создание автоматизированного 
теста, определяемого данными, позволяет выполнять один и тот же тест с 
различными наборами данных.

Тесты на стрессовые условия и тесты на нагрузку
Рекомендуется также автоматизировать многократно выполняемые тесты 
(тесты на стрессовые условия) и тесты для проверки 
многопользовательских систем клиент-сервер (тесты на нагрузку). 
Предположим, например, что тест должен повторяться тысячу раз. 
Выполнять такой тест вручную очень нерационально. В этом случае можно 
создать тест, выполняющий тысячу итераций.

Какие тесты не следует автоматизировать
Обычно чем чаще требуется участие пользователя при выполнении теста, 
тем он менее пригоден для автоматизации. Ниже приведены тесты, 
которые не следует автоматизировать.

➤ Тесты на удобство использования — тесты, предоставляющие модели 
использования для проверки простоты использования приложений.

➤ Тесты, которые выполняются только один раз.

➤ Тесты, которые необходимо выполнить немедленно.

➤ Тесты, основанные на интуиции пользователя и его знании приложения.

➤ Тесты с непредсказуемыми результатами.

Создание скриптов автоматизированных тестов
После разработки шагов ручного теста можно создать структуру скрипта 
теста, на основе которой можно писать скрипты, позволяющие выполнять 
этот тест в автоматическом режиме.

Любой текст, содержащийся в шагах ручного теста, будет преобразован в 
комментарии созданного скрипта теста. Если ручной тест содержит 
параметры, они также будут преобразованы в текст комментариев.
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Чтобы создать скрипт автоматизированного теста, выполните 
следующие действия.

 1 В дереве плана тестирования выберите ручной тест, который необходимо 
автоматизировать.

 2 Перейдите на вкладку Design Steps и нажмите кнопку Generate Script. 

 3 Выберите тип автоматизированного теста, в который необходимо 
преобразовать ручной тест.

Значок 
теста Тип теста Описание

WR-AUTOMATED Этот тест выполняется средством 
WinRunner, решением компании HP для 
функционального тестирования приложений 
Microsoft Windows.

VAPI-XP-TEST Этот тест создается с помощью решения 
Visual API-XP, средства тестирования на 
основе интерфейса API открытой 
архитектуры тестирования Quality Center. 
Дополнительные сведения о тестах VAPI-XP, 
см. в приложении Приложение A, "Работа с 
VAPI-XP"..

LR-SCENARIO Этот тест выполняется решением 
LoadRunner, средством компании HP для 
тестирования на нагрузку.

QUICKTEST_TEST Этот тест выполняется решением QuickTest 
Professional, корпоративным средством 
функционального тестирования компании 
HP.

QAINSPECT_TEST Этот тест выполняется средством QAInspect, 
решением компании HP для тестирования 
безопасности.
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Примечание. Тип QUICKTEST_TEST доступен только в том случае, если 
установлена соответствующая надстройка, загруженная со страницы 
надстроек HP Quality Center. Дополнительные сведения об установке 
надстроек см. в документе Руководство по установке HP Quality Center.

На основе шагов выбранного теста в модуле Test Plan выполняется 
создание скрипта автоматизированного теста. В дереве плана 
тестирования значок ручного теста  рядом с только что 
автоматизированным тестом заменяется значком автоматизированного 
теста.

 4 Перейдите на вкладку Test Script, чтобы просмотреть скрипт теста. 

 5 Если тест выполняется средством WinRunner, то к этому тесту можно 
присоединить другой скрипт теста, нажав кнопку Copy From. Откроется 
диалоговое окно Select Test, в котором можно выбрать тест WinRunner в 
файловой системе. 

 6 Если тест выполняется средством WinRunner, LoadRunner или QuickTest 
Professional, нажмите кнопку Launch, чтобы просмотреть скрипт в средстве 
тестирования, для которого он был создан. После этого тест можно 
изменить в соответствии с требованиями тестирования.
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23
Работа с системными тестами

С помощью системных тестов в Quality Center можно получать сведения о 
компьютере, захватывать снимки рабочего стола и перезагружать 
компьютер.

Эта глава содержит следующие разделы.

 ➤  О работе с системными тестами на стр. 367

 ➤  Добавление системных тестов в дерево плана тестирования на стр. 368

 ➤  Определение системного теста на стр. 370

 ➤  Выполнение системного теста на стр. 371

 ➤  Просмотр результатов системного теста на стр. 372

О работе с системными тестами
Системный тест можно выполнять для получения сведений о системе на 
компьютере, просмотра снимка рабочего стола при выполнении теста на 
компьютере или для перезапуска компьютера. Например, можно запустить 
тест очистки системы, который перезагрузит компьютер, на котором 
произошел сбой автоматизированного теста. Также можно создать 
системный тест для получения сведений об использовании ресурсов 
компьютера до или после выполнения теста.
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Чтобы создать системный тест, необходимо добавить системный тест в 
дерево плана тестирования, определить тест и добавить тест в набор 
тестов.

Примечание. Чтобы выполнять системный тест, необходимо установить 
надстройки System Test Remote Agent Add-in и HP Quality Center 
Connectivity Add-in на компьютере, на котором будет выполняться этот 
тест. Дополнительные сведения о надстройках HP Quality Center см. в 
документе Руководство по установке HP Quality Center.

При выполнении системного можно создавать следующие шаги.

➤ SysInfo. Сбор сведений о системе.

➤ Snapshot. Захват снимка рабочего стола.

➤ Reboot Start и Reboot Finish. Перезагрузка компьютера.

После выполнения системного теста можно просмотреть сведения о 
каждом из этих шагов. Также можно просмотреть полученные сведения о 
системе (сведения о центральном процессоре, памяти и выполняющихся 
на компьютере процессах) и изображение компьютера, выполняющего 
системный тест.

Добавление системных тестов в дерево плана 
тестирования

Создание системного теста начинается с его добавления в дерево плана 
тестирования.

Чтобы добавить системный тест в дерево плана тестирования, 
выполните следующие действия.

 1 Выберите папку объектов тестирования в дереве плана тестирования.

 2 Нажмите кнопку New Test или выберите команду Tests > New Test. 
Откроется диалоговое окно Create New Test.
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 3 В поле Test Type выберите вариант SYSTEM-TEST. 

Примечание. Если на компьютере установлена надстройка QuickTest 
Professional Add-in, в диалоговом окне Create New Test будет показано поле 
Template.

 4 В поле Test Name введите имя теста.

 5 Нажмите кнопку ОK.

Примечание. Если обязательные поля теста были определены в разделе 
Project Customization, откроется диалоговое окно Required Test Fields. 
Выберите значения обязательных полей и нажмите кнопку OK.

Новый системный тест со значком системного теста  появится в дереве 
плана тестирования в выбранной папке объектов тестирования. 

 6 К тесту можно добавить сведения и вложения и определить покрытие 
требований тестами. Дополнительные сведения см. в Глава 18, "Создание 
дерева плана тестирования"..
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Определение системного теста
После добавления системного теста в дерево плана тестирования можно 
создать скрипт теста. 

Чтобы определить системный тест, выполните следующие действия.

 1 В дереве плана тестирования выберите созданный системный тест и 
перейдите на вкладку Test Script.

 2 Установите флажок Collect system information, чтобы собирать сведения 
о системе (сведения о центральном процессоре, памяти и процессах, 
выполняющихся на компьютере) во время выполнения системного теста. 

 3 Установите флажок Capture desktop image, чтобы добавить вложение, 
содержащее снимок рабочего стола компьютера во время выполнения 
системного теста. 
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 4 Установите флажок Restart the computer, если необходимо, чтобы 
Quality Center перезагружал компьютер при выполнении системного теста. 

Примечания. 

➤ Чтобы использовать флажок Restart the computer, необходимо 
включить на компьютере автоматический вход в систему. Выберите 
команду Start > Programs > HP Quality Center SystemTest Agent > 
SystemTest Agent (configuration). Откроется диалоговое окно Auto 
Restart Settings. Про умолчанию поля User Name и Domain доступны 
только для чтения. Введите пароль и нажмите кнопку OK. 

➤ Чтобы выбрать другое имя пользователя, снова откройте диалоговое 
окно Auto Restart Settings. Теперь можно изменять значения полей User 
Name и Domain. Измените значения и нажмите кнопку OK.

 5 Нажмите кнопку Save, чтобы сохранить параметры системного теста.

После определения системного теста в модуле Test Plan можно добавить 
этот тест в набор тестов в модуле Test Lab. Дополнительные сведения о 
создании наборов тестов см. в Глава 28, "Создание наборов тестов".

Выполнение системного теста
После определения системного теста и добавления его в набор тестов в 
модуле Test Lab можно выполнить системный тест. Пользователь может 
выполнять системные тесты на своем компьютере или на нескольких 
удаленных хостах, подключенных к сети. 

Дополнительные сведения о выполнении тестов см. в Глава 31, 
"Автоматическое выполнение тестов".
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Просмотр результатов системного теста
Результаты системного теста можно просматривать в модуле Test Lab.

Чтобы просмотреть результаты системного теста, выполните 
следующие действия.

 1 В таблице Execution Grid дважды щелкните системный тест или выберите 
тест, а затем нажмите кнопку Test Instance Properties. На вкладке 
Execution Flow щелкните системный тест правой кнопкой мыши, а затем 
выберите команду Test Instance Properties. 

Откроется диалоговое окно Test Instance Properties с представлением All 
Runs.

В нем показаны статус, дата и время выполнения следующих шагов, 
созданных при выполнении системного теста. 

➤ SysInfo. Информация о сборе сведений о системе.

➤ Snapshot. Информация о захвате снимка рабочего стола.



Глава 23 • Работа с системными тестами

373

➤ Reboot Start и Reboot Finish. Информация о перезагрузке компьютера.

 2 Щелкните ссылку Collected System Info, чтобы просмотреть собранные  
сведения о системе, в том числе информацию о процессоре, памяти и 
процессах, выполняющихся на компьютере.

 3 Щелкните ссылку Captured Desktop Image, чтобы просмотреть 
изображение рабочего стола компьютера, выполняющего системный тест.
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24
Управление ресурсами тестов

Модуль Test Resources позволяет управлять набором ресурсов, которые 
будут использоваться в тестах. Можно упорядочить ресурсы путем 
определения дерева ресурсов тестов.

Эта глава содержит следующие разделы.

 ➤  Об управлении ресурсами тестов на стр. 376

 ➤  Модуль Test Resources на стр. 377

 ➤  Создание дерева ресурсов тестов на стр. 378

 ➤  Обновление сведений ресурсов и папок на стр. 380

 ➤  Работа с ресурсами на стр. 382

 ➤  Просмотр зависимостей ресурсов тестов на стр. 384

 ➤  Управление деревом ресурсов тестов на стр. 384

 ➤  Просмотр истории изменения ресурса на стр. 393
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Об управлении ресурсами тестов
Модуль Test Resources позволяет управлять ресурсами, используемыми в 
тестах. Можно упорядочивать ресурсы путем определения иерархического 
дерева ресурсов тестов, которое содержит папки ресурсов и ресурсы. 
Для каждого ресурса в дереве можно выбрать и загрузить набор файлов 
ресурсов в репозиторий Quality Center. Эти файлы могут быть 
использованы в одном или нескольких тестах.

Предположим, что вы работаете с внешним средством тестирования, 
которое сохраняет тесты в приложении Quality Center. Все тесты 
используют общий файл конфигурации, который, в свою очередь, 
используется в нескольких тестах. При этом желательно иметь один 
рабочий экземпляр файла конфигурации, а не сохранять отдельные копии 
этого файла для каждого теста.

В средстве тестирования можно определить файл конфигурации как 
ресурс и указать для каждого теста, использующего этот файл, наличие 
зависимости от этого ресурса. Поскольку в Quality Center существует 
только одна копия этого ресурса, при замене файла конфигурации новый 
файл будет использоваться всеми тестами, зависящими от этого файла. 

Можно определять зависимости между ресурсами и тестами с помощью 
средства QuickTest Professional. Дополнительные сведения см. в 
документе HP QuickTest Professional User Guide.

Также можно определять зависимости между ресурсами и тестами, 
создавая собственные приложения или скрипты. Дополнительные 
сведения см. в справочном руководстве HP Quality Center Entity 
Dependencies API Reference.

После определения зависимостей при попытке удаления ресурса в Quality 
Center будет выдано предупреждение о том, что удаление может повлиять 
на тесты, зависящие от ресурса. При копировании одного из тестов, 
зависящих от ресурса, в другой проект, Quality Center позволяет выбрать 
копирование ресурса вместе с тестом.
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Модуль Test Resources
Определение папок ресурсов и ресурсов в Quality Center выполняется в 
модуле Test Resources. Чтобы открыть этот модуль, нажмите кнопку Test 
Resources на боковой панели.

Модуль Test Resources содержит следующие основные элементы.

➤ Дерево ресурсов тестов. Графическое представление ресурсов тестов. 

➤ Вкладка Details. Сведения о текущей выбранной папке ресурсов или 
ресурсе. Дополнительные сведения см. в разделе “Обновление сведений 
ресурсов и папок" на стр. 380.

➤ Вкладка Resource Viewer. Позволяет отправлять и загружать файлы 
ресурсов тестов из репозитория Quality Center. Дополнительные сведения 
см. в разделе “Работа с ресурсами" на стр. 382.

➤ Вкладка Dependencies. Показывает взаимосвязи зависимости между 
объектами, такими как ресурсы тестов и тесты. Дополнительные сведения 
см. в разделе “Просмотр зависимостей ресурсов тестов" на стр. 384.

➤ Вкладка History. Показывает историю изменения базовых состояний, в 
которые включен выбранный ресурс. Дополнительные сведения см. в 
разделе “Просмотр истории изменения ресурса" на стр. 393.
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Создание дерева ресурсов тестов
Для построения иерархической структуры ресурсов необходимо создать 
дерево ресурсов тестов. Для каждой папки ресурсов в дереве 
определяются ресурсы.

Примечание. Когда проект Quality Center с Business Process Testing 
подключается к QuickTest Professional, в дереве автоматически создается 
папка BPT Resources. Папка BPT Resources содержит все доступные 
ресурсы QuickTest для бизнес-компонентов в проекте.

Добавление папок к дереву ресурсов тестов
Создание дерева ресурсов начинается с добавления папки в корневую 
папку Resources. 

Чтобы добавить папку ресурсов к дереву ресурсов тестов, выполните 
следующие действия.

 1 В дереве ресурсов тестов выберите папку Resources.

 2 Нажмите кнопку New Resource Folder или выберите команду Resources > 
New Resource Folder. Откроется диалоговое окно New Resource Folder.

 3 Введите имя папки в поле Resource Folder Name и нажмите кнопку OK. 
Новая папка будет добавлена в папку Resources дерева ресурсов тестов.

 4 На вкладке Details введите описание папки ресурсов. Дополнительные 
сведения о вкладке Details см. в разделе “Обновление сведений ресурсов и 
папок" на стр. 380.

 5 Чтобы добавить еще одну папку, выберите папку в дереве и повторите 
шаги 2 – 4.

Добавление ресурсов в папки ресурсов
В папки ресурсов можно добавлять ресурсы.

Управление версиями. Новый ресурс будет изъят автоматически. 
Дополнительные сведения см. в разделе “Изъятие объектов" на стр. 115.
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Чтобы добавить ресурс в папку ресурсов, выполните следующие 
действия.

 1 Выберите папку ресурсов в дереве ресурсов тестов.

 2 Нажмите кнопку New Resource или выберите команду Resources > New 
Resource. Откроется диалоговое окно New Resource.

 3 В поле Name введите имя ресурса.

 4 В поле Type выберите тип ресурса.

 5 В поле Created By выберите имя пользователя, создавшего ресурс. По 
умолчанию отображается имя пользователя, выполнившего вход в 
Quality Center.

 6 В поле Description введите описание ресурса.

 7 Чтобы добавить комментарий, перейдите на вкладку Comments. Нажмите 
кнопку Add Comment. Новый раздел будет добавлен в поле Comments с 
именем пользователя и текущей датой базы данных.

 8 Нажмите кнопку Submit. В выбранную папку ресурсов будет добавлен 
пустой ресурс. 
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На вкладке Details будут показаны сведения о ресурсе. Дополнительные 
сведения о вкладке Details см. в разделе “Обновление сведений ресурсов и 
папок" на стр. 380.

Добавить содержимое к ресурсу можно при помощи вкладки Resource 
Viewer. Дополнительные сведения о вкладке Resource Viewer см. в разделе 
“Работа с ресурсами" на стр. 382. 

Дополнительные сведения о работе с ресурсами QuickTest см. в разделе, 
посвященном работе с Quality Center, в руководстве HP QuickTest 
Professional User Guide.

Обновление сведений ресурсов и папок
Просматривать и обновлять сведения ресурсов и папок дерева ресурсов 
тестов можно на вкладке Details.

Чтобы обновить сведения ресурса или папки, выполните следующие 
действия.

 1 Выберите ресурс или папку в дереве ресурсов тестов.

 2 Перейдите на вкладку Details.
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➤ Если выбрана папка, на вкладке Details будут показаны следующие 
поля.

➤ Если выбран ресурс, на вкладке Details будут показаны следующие 
поля.

Поле Описание

Name Имя папки ресурсов. 

Folder ID Уникальный числовой идентификатор папки, 
назначенный Quality Center. Изменять это поле 
нельзя.

Description Описание папки ресурсов. 

Поле Описание

Name Имя ресурса. 

Type Тип ресурса. Щелкните стрелку вниз, чтобы выбрать 
другой тип ресурса из списка.

Created By Имя пользователя, создавшего файл. Щелкните 
стрелку вниз, чтобы выбрать другое имя 
пользователя. 

Creation Date Дата создания файла. Нажмите стрелку вниз, чтобы 
отобразить календарь и выбрать дату создания. По 
умолчанию в качестве даты создания используется 
текущая дата сервера баз данных.

Resource ID Уникальный числовой идентификатор файла, 
назначенный Quality Center. Изменять это поле 
нельзя.

Description Описание ресурса. 

Comments Комментарии к ресурсу. Чтобы добавить новый 
комментарий, нажмите кнопку Add Comment. Новый 
раздел будет добавлен в поле Comments с именем 
пользователя и текущей датой базы данных.

Version Number Номер версии ресурса. Это поле будет показано, если 
в проекте включено управление версиями.
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В модуле Test Resources можно добавлять поля, определенные 
пользователем, а также изменять заголовки любых полей. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Для ограничения и динамического изменения полей и значений модуля 
Test Resources можно использовать редактор Script Editor. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Работа с ресурсами
При помощи вкладки Resource Viewer можно отправлять файлы для 
каждого ресурса или папки в дереве ресурсов тестов в репозиторий 
Quality Center. Также можно загружать файлы в локальный каталог. 

После отправки файлов определяются зависимости между ресурсами и 
тестами в используемом средстве тестирования, например QuickTest 
Professional. Дополнительные сведения см. в документе HP QuickTest 
Professional User Guide.

Также можно определять зависимости между ресурсами и тестами, 
создавая собственные приложения. Дополнительные сведения см. в 
справочном руководстве HP Quality Center Entity Dependencies API 
Reference.

Примечание. Чтобы просматривать содержимое ресурса, необходимо 
установить соответствующую надстройку или расширение. 
Дополнительные сведения о надстройке QuickTest Professional см. в 
документе HP QuickTest Professional User Guide.

Данный раздел содержит следующие подразделы.

➤ Отправка файлов ресурсов тестов

➤ Загрузка файлов ресурсов тестов
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Отправка файлов ресурсов тестов
Можно отправлять файлы для каждого ресурса в дереве ресурсов тестов в 
репозиторий Quality Center.

Чтобы отправить файл ресурса теста, выполните следующие 
действия.

 1 Выберите ресурс в дереве ресурсов тестов.

 2 Перейдите на вкладку Resource Viewer.

 3 Чтобы отправить файл, нажмите кнопку Upload File. Откроется диалоговое 
окно Upload File. Выберите файл и нажмите кнопку Open. Файл будет 
отправлен в репозиторий Quality Center.

 4 Чтобы отправить папку, нажмите стрелку Upload File и выберите команду 
Upload Folder. Откроется диалоговое окно Browse for Folder. Выберите 
папку и нажмите кнопку OK. Папка будет отправлена в репозиторий Quality 
Center.

 5 Чтобы заменить отправленный файл, повторите шаг 3.

 6 Чтобы заменить отправленную папку, повторите шаг 4.
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Загрузка файлов ресурсов тестов
Чтобы просматривать и изменять ресурсы тестов, можно загружать их на 
локальный компьютер.

Чтобы загрузить файл ресурса теста, выполните следующие 
действия.

 1 Выберите ресурс в дереве ресурсов тестов.

 2 Перейдите на вкладку Resource Viewer.

 3 Нажмите кнопку Download. Откроется диалоговое окно Browse for Folder.

 4 Выберите папку и нажмите кнопку OK. Ресурс будет загружен в выбранную 
папку.

Просмотр зависимостей ресурсов тестов
После определения связей между ресурсами тестов и тестами можно 
просматривать взаимоотношения зависимости между ними на вкладке 
Dependencies. Дополнительные сведения см. в разделе “Просмотр 
зависимостей" на стр. 395.

Управление деревом ресурсов тестов
В этом разделе, посвященном управлению деревом ресурсов тестов, 
рассмотрены следующие вопросы.

➤ Копирование ресурсов тестов в проекте

➤ Копирование ресурсов тестов между проектами

➤ Копирование URL-адресов ресурсов тестов

➤ Поиск ресурсов тестов

➤ Фильтрация ресурсов тестов

➤ Отправка ресурсов тестов по электронной почте

➤ Перемещение ресурсов тестов

➤ Переименование ресурсов тестов
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➤ Удаление ресурсов тестов

Копирование ресурсов тестов в проекте
Можно копировать ресурсы внутри проекта. 

Чтобы скопировать ресурс теста внутри проекта, выполните 
следующие действия.

 1 Выберите ресурс или папку, которую необходимо скопировать, в дереве 
ресурсов тестов. Чтобы скопировать несколько элементов, используйте 
клавишу CTRL.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy.

 3 Выберите папку, в которую необходимо скопировать ресурс или папку.

 4 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste.

Копирование ресурсов тестов между проектами
Можно копировать ресурсы из одного проекта в другой. Если ресурсы теста 
зависят от других ресурсов теста, или если ресурсы теста содержат 
вызовы других тестов, в Quality Center можно скопировать эти ресурсы 
одним из следующих способов.

➤ Копирование ресурсов тестов и установление связи с соответствующими 
существующими ресурсами тестов и вызываемыми тестами в целевом 
проекте. Если соответствующий ресурс теста или вызываемый тест 
отсутствует в целевом проекте, Quality Center скопирует его в целевой 
проект.

➤ Копирование ресурсов вместе с соответствующими ресурсами тестов и 
вызываемыми тестами в целевой проект. 

➤ Копирование ресурсов в целевой проект без соответствующих ресурсов 
тестов и вызываемых тестов.
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Примечание. Чтобы копировать ресурсы тестов между проектами, оба 
проекта должны иметь одну и ту же версию и уровень исправлений 
Quality Center.

Дополнительные сведения связанных объектах см. в разделе “Просмотр 
зависимостей" на стр. 395.

Чтобы скопировать ресурс теста между проектами, выполните 
следующие действия.

 1 Выберите ресурс или папку, которую необходимо скопировать, в дереве 
ресурсов тестов. Чтобы скопировать несколько элементов, используйте 
клавишу CTRL.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy.

 3 Откройте другой экземпляр Quality Center и войдите в проект, в который 
необходимо вставить ресурсы или папки.

 4 Выберите папку, в которую необходимо скопировать ресурсы или папки.

 5 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste. Откроется диалоговое окно Paste 
Resources to Target Project. 

 6 Выберите один из следующих вариантов.

➤ Copy design steps and link to existing related entities. Quality Center 
копирует ресурсы тестов или папки и вставляет их в целевой проект. 
Скопированные ресурсы тестов или папки будут связаны с 
существующими ресурсами тестов и вызываемыми тестами с теми же 
именами. Если соответствующий ресурс теста или тест отсутствует в 
целевом проекте, Quality Center скопирует его в целевой проект.
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➤ Copy resources and related entities. Quality Center копирует ресурсы 
тестов или папки вместе с соответствующими ресурсами тестов и 
вызываемыми тестами и вставляет их в целевой проект. Если 
соответствующий ресурс или вызываемый тест уже существует в 
целевом проекте, скопированный связанный ресурс теста или 
вызываемый тест будет переименован для разрешения конфликта 
имен.

➤ Copy resources without copying related entities. Quality Center копирует 
ресурсы тестов или папки без соответствующих ресурсов тестов и 
вызываемых тестов и вставляет их в целевой проект. Скопированные 
элементы не будут связаны с какими-либо объектами.

Нажмите кнопку ОK. 

Копирование URL-адресов ресурсов тестов
Можно копировать ресурс из дерева ресурсов тестов и вставлять его 
URL-адрес как ссылку. При этом сам ресурс не копируется. Вместо этого 
можно вставить адрес в другое место, такое как сообщение электронной 
почты или документ. При выборе ссылки открывается Quality Center и 
выполняется переход к файлу или папке ресурсов. Если вход в систему 
еще не выполнен, сначала будет показано приглашение Quality Center для 
входа в систему. 

Чтобы скопировать URL-адрес ресурса теста, выполните следующие 
действия.

 1 Выберите ресурс или папку в дереве ресурсов тестов. 

 2 Выберите команду Edit > Copy URL. Также можно щелкнуть элемент 
правой кнопкой мыши и выбрать команду Copy URL.

 3 Вставьте URL-адрес.
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Поиск ресурсов тестов 
Можно выполнять поиск ресурсов в дереве ресурсов тестов. Если к дереву 
применены фильтры, поиск будет ограничен текущими отображаемыми 
ресурсами.

Чтобы найти ресурс теста, выполните следующие действия.

 1 Выберите команду Edit > Find. Откроется диалоговое окно Find.

 2 В поле Find in Field выберите критерий поиска. 

 3 В поле Value to Find введите или выберите значение выбранного поля. 
При поиске регистр не учитывается.

 4 Нажмите кнопку Find. В модуле Test Resources будет выполнен поиск 
ресурса с указанным значением. При успешном завершении поиска 
откроется диалоговое окно Search Results со списком возможных 
совпадений. Выберите результат из списка и нажмите кнопку Go To, чтобы 
выделить ресурс в дереве ресурсов тестов. При неудачном завершении 
поиска откроется информационное окно.

Фильтрация ресурсов тестов
Нажмите кнопку Set Filter/Sort, чтобы отфильтровать и отсортировать 
ресурсы в дереве ресурсов тестов. Дополнительные сведения см. в 
Глава 3, "Работа с данными Quality Center".. Все примененные фильтры и 
параметры сортировки отображаются ниже панели инструментов дерева 
ресурсов тестов.
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Отправка ресурсов тестов по электронной почте 
Можно отправлять сообщения о ресурсе по электронной почте другим 
пользователям. Эта возможность позволяет регулярно информировать 
персонал групп разработки и контроля качества о статусе ресурсов. В 
сообщение электронной почты будет включена ссылка, которая позволит 
получателю перейти прямо к ресурсу.

По умолчанию Quality Center отправляет сообщения электронной почты в 
формате HTML. Чтобы отправить сообщение электронной почты в виде 
обычного текста, измените параметр MAIL_FORMAT на вкладке 
Site Configuration в разделе Site Administration. Дополнительные сведения 
см. в документе HP Quality Center Administrator Guide.

Чтобы отправить ресурс теста по электронной почте, выполните 
следующие действия. 

 1 Выберите один или несколько ресурсов в дереве ресурсов тестов и 
нажмите кнопку Send by E-mail. Откроется диалоговое окно Send E-mail.
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 2 Введите допустимый адрес электронной почты или имя пользователя. 
Также можно нажать кнопку To или CC, чтобы выбрать пользователей. 
Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять поиск 
пользователей, распределять пользователей по группам и выбирать 
пользователей из списка или из дерева групп. Дополнительные сведения 
см. в разделе “Выбор пользователей" на стр. 57. 

Выберите пользователей или группы пользователей, которым необходимо 
отправить сообщение электронной почты, и нажмите кнопку OK.

 3 В поле Subject введите тему сообщения электронной почты. По умолчанию 
в поле Subject будут указаны домен, проект, идентификатор и имя ресурса.

 4 В поле Additional comments добавьте необходимые комментарии.

 5 Чтобы проверить орфографию в диалоговом окне, выполните следующие 
действия.
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➤ Нажмите кнопку Check Spelling, чтобы проверить орфографию 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово и варианты для замены.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии, нажмите кнопку Spelling 
Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить синонимы, 
антонимы или связанные слова для выбранного слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое.

➤ Нажмите кнопку Custom, чтобы указать поля, которые необходимо 
включить в сообщение электронной почты. В диалоговом окне Select 
Fields можно выбирать имена полей и перемещать их между списками 
Ignored Fields и Considered Fields при помощи кнопок со стрелками (> 
и <). Чтобы переместить все поля из одного списка в другой, 
используйте кнопки с двумя стрелками (>> и <<). Нажмите кнопку OK, 
чтобы закрыть диалоговое окно Select Fields.

 6 Нажмите кнопку Send, чтобы отправить сообщение электронной почты.

Перемещение ресурсов тестов
Ресурс можно переместить в другое местоположение в дереве ресурсов 
тестов. Переместить корневую папку нельзя.

Совет. Ресурс также можно переместить в другое местоположение в 
дереве ресурсов тестов перетаскиванием.

Чтобы переместить ресурс теста, выполните следующие действия.

 1 Выберите ресурс или папку, которую необходимо переместить, в дереве 
ресурсов тестов. Чтобы переместить несколько элементов, используйте 
клавишу Ctrl.

 2 Выберите команду Edit > Cut или щелкните ресурс правой кнопкой мыши и 
выберите команду Cut.
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 3 Выберите папку, в которую необходимо переместить ресурс или папку.

 4 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste. 

Переименование ресурсов тестов
Можно переименовать ресурс или папку в дереве ресурсов тестов.

Чтобы переименовать ресурс теста, выполните следующие действия.

 1 Выберите ресурс или папку в дереве ресурсов тестов. 

 2 Щелкните этот элемент. Также можно щелкнуть элемент правой кнопкой 
мыши и выбрать команду Rename.

 3 Измените имя элемента и нажмите клавишу ENTER.

Удаление ресурсов тестов
Можно удалять ресурсы и папки из дерева ресурсов тестов. Если другие 
объекты зависят от выбранного ресурса, его удаление может повлиять на 
эти связанные объекты. Дополнительные сведения связанных объектах см. 
в разделе “Просмотр зависимостей" на стр. 395.

Управление версиями. При удалении ресурса удаляются все 
предыдущие версии этого ресурса.

Чтобы удалить ресурс теста, выполните следующие действия.

 1 Выберите ресурс в дереве ресурсов тестов. 

 2 Нажмите кнопку Delete или выберите команду Edit > Delete. 

 3 Если ресурс не используется совместно с другим объектами, откроется 
окно подтверждения. Нажмите кнопку Yes.

 4 Если от выбранного ресурса зависят другие объекты, откроется 
диалоговое окно Delete Resource. Чтобы просмотреть связанные объекты, 
нажмите кнопку Details. Нажмите кнопку Yes, чтобы подтвердить удаление 
ресурса.

Чтобы удалить папку, выполните следующие действия.

 1 Выберите папку в дереве ресурсов тестов. 
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 2 Нажмите кнопку Delete или выберите команду Edit > Delete. Откроется 
окно подтверждения.

 3 Если папка не используется совместно с другими объектами, нажмите 
кнопку Yes.

 4 Если другие объекты зависят от некоторых других ресурсов в папке, 
выберите один из следующих вариантов. 

➤ Нажмите кнопку Yes, чтобы удалить папку без учета возможного 
влияния на связанные объекты.

➤ Нажмите кнопку No, чтобы просмотреть связанные объекты перед 
удалением папки. Просматривать связанные объекты можно на вкладке 
Dependencies. Дополнительные сведения см. в разделе “Просмотр 
зависимостей" на стр. 395.

Просмотр истории изменения ресурса
Можно просматривать историю изменения базовых состояний, в которые 
включен выбранный ресурс теста. Также можно сравнивать две версии 
базового состояния. Дополнительные сведения см. в разделе “Просмотр 
истории изменения базового состояния" на стр. 578.

Управление версиями. Можно просматривать все предыдущие версии 
ресурса теста. Дополнительные сведения см. в разделе “Просмотр истории 
версий" на стр. 120.
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25
Просмотр зависимостей

Зависимости определяют взаимоотношения между объектами, такими как 
тесты, компоненты и ресурсы тестов. Можно просматривать объекты, 
используемые выбранным объектом, а также объекты, использующие 
выбранный объект. 

Эта глава содержит следующие разделы.

 ➤  О просмотре зависимостей на стр. 395

 ➤  Просмотр зависимостей на стр. 396

О просмотре зависимостей
Можно просмотреть зависимости между объектами (тестами, 
компонентами и ресурсами тестирования). При анализе влияния 
изменения, предложенного для определенного требования, зависимости 
указывают другие объекты, на которые может повлиять это изменение. 

Взаимоотношения зависимости отображаются на вкладке Dependencies. 
Эта вкладка доступна в модулях Test Plan и Test Resources. В зависимости 
от лицензии Quality Center вкладка Dependencies также может быть 
доступна в модуле Business Components. Дополнительные сведения см. в 
HP Business Process Testing User Guide.

Зависимости между объектами можно определять с помощью других 
средств тестирования HP, например QuickTest Professional. 
Дополнительные сведения см. в документе HP QuickTest Professional User 
Guide. 
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Также можно определять зависимости между объектами, создавая 
собственные приложения. Дополнительные сведения см. в справочном 
руководстве HP Quality Center Entity Dependencies API Reference.

Просмотр зависимостей
Просматривать зависимости можно на вкладке Dependencies. Эта вкладка 
содержит таблицы Used By и Using. В таблице Used By показаны объекты, 
которые зависят от выбранного объекта. В таблице Using показаны 
объекты, от которых зависит выбранный объект. 

Управление версиями. При изъятии старой версии объекта на вкладке 
Dependencies не будут показаны какие-либо зависимости между 
несуществующими объектами.
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Таблица Used By содержит следующие столбцы.

Столбец Описание

Owner ID Уникальный числовой идентификатор связанного 
объекта. Этот идентификатор назначается Quality Center 
автоматически. 

Owner Type Тип связанного объекта, использующего выбранный 
объект. Возможны следующие типы объектов.

➤ Resource. Ресурс, указанный в дереве ресурсов 
тестов.

➤ Test. Тест, указанный в дереве плана тестирования.
➤ Component. В зависимости от лицензии Quality Center 

также может быть доступна возможность просмотра 
компонента, указанного в дереве бизнес-компонентов. 
Дополнительные сведения см. в HP Business Process 
Testing User Guide.

➤ <объект, определенный пользователем>. Объект, 
определенный пользователем.

Owner Name Имя связанного объекта, использующего выбранный 
объект.

Owner Description Описание связанного объекта, использующего 
выбранный объект.
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Таблица Using содержит следующие столбцы.

Чтобы просмотреть зависимости, выполните следующие действия.

 1 Откройте вкладку Dependencies, как описано ниже.

➤ В модуле Test Plan выберите тест в дереве плана тестирования. 
Перейдите на вкладку Dependencies.

➤ В модуле Test Resources выберите ресурс в дереве ресурсов тестов. 
Перейдите на вкладку Dependencies.

В зависимости от лицензии Quality Center вкладка Dependencies также 
может быть доступна в модуле Business Components.

 2 Щелкните стрелку Show/Hide, чтобы отобразить таблицу Used By или 
Using. 

 3 Чтобы обновить таблицы, нажмите кнопку Refresh. 

Столбец Описание

Related ID Уникальный числовой идентификатор связанного 
объекта. Этот идентификатор назначается Quality Center 
автоматически. 

Related Type Тип связанного объекта, используемого выбранным 
объектом. Возможны следующие типы объектов.

➤ Resource. Ресурс, указанный в дереве ресурсов 
тестов.

➤ Test. Тест, указанный в дереве плана тестирования.
➤ Component. В зависимости от лицензии Quality Center 

также может быть доступна возможность просмотра 
компонента, указанного в дереве бизнес-компонентов. 
Дополнительные сведения см. в HP Business Process 
Testing User Guide.

➤ <объект, определенный пользователем>. Объект, 
определенный пользователем.

Related Name Имя связанного объекта, используемого выбранным 
объектом.

Related Description Описание связанного объекта, используемого 
выбранным объектом.
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 4 Чтобы просмотреть дополнительные сведения об объекте, выберите 
объект в таблице Used By или Using и нажмите кнопку Go To. Можно 
просматривать следующие объекты.

➤ Resource. Переход к дереву ресурсов тестов и просмотр ресурса теста.

➤ Test. Переход к дереву плана тестирования и просмотр теста.

➤ <объект, определенный пользователем>. Переход к дереву плана 
тестирования и просмотр теста, связанного с объектом, определенным 
пользователем.

➤ Component. В зависимости от лицензии Quality Center также может 
быть доступна возможность просмотра компонента в модуле Business 
Components. 
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Часть V
Выполнение тестов
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26
Рабочий процесс модуля Test Lab

В процессе модификации приложения в проекте необходимо выполнять 
ручные и автоматизированные тесты, чтобы обнаружить дефекты и 
оценить качество приложения.

Quality Center Выпуск Starter Edition. При использовании выпуска Starter 
Edition поля, связанные с управлением релизами и базовыми состояниями, 
недоступны в модуле Test Lab. 

В этойглаве описано выполнение тестов с помощью модуля Test Lab 
Quality Center. Выполнение тестов включает следующие этапы. 

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements

Создание
наборов тестов

План выполнения
тестов

Выполнение тестов
вручную

Анализ результатов 
тестирования

Автоматическое
выполнение тестов
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Создание наборов тестов
Начните с создания наборов тестов. Выберите, какие тесты необходимо 
включить в каждый набор тестов. Набор тестов – это группа тестов проекта 
Quality Center, предназначенная для решения определенных задач 
тестирования. В приложении Mercury Tours, которое используется в 
качестве примера, можно создать набор тестов для проверки 
работоспособности основных функций этого приложения. Можно включить 
тесты, которые проверяют механизм входа в систему, а также тесты, 
проверяющие механизм бронирования авиабилетов.

После создания наборов тестов необходимо назначить папки наборов 
тестов циклам, определенным в дереве релизов в модуле Releases. Цикл 
представляет собой этап разработки и контроля качества на основе 
временных рамок проекта.

Дополнительные сведения см. в Глава 28, "Создание наборов тестов"..

Планирование выполнения тестов
Quality Center позволяет управлять выполнением тестов, входящих в набор 
тестов. Можно указать условия, дату и время выполнения тестов. Также 
можно установить последовательность выполнения тестов. Например, 
можно указать, что тест test2 должен выполняться только после 
завершения теста test1, а тест test3 должен выполняться только в том 
случае, если тест test1 не обнаружил ошибок в приложении. 

Дополнительные сведения см. в Глава 29, "Планирование выполнения 
тестов"..
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Выполнение тестов вручную
После определения наборов тестов можно приступить к выполнению 
тестов. При выполнении теста вручную выполняются шаги теста, которые 
были определены при планировании тестирования. Результат каждого 
шага устанавливается в зависимости от того, соответствуют ли 
фактические результаты тестирования приложения ожидаемым 
результатам. 

Предположим, например, что тестируется процесс бронирования билетов 
на авиарейсы в приложении Mercury Tours. Пользователь открывает 
приложение, создает новый заказ и бронирует билет в соответствии с 
инструкциями приведенными в шагах теста.

Дополнительные сведения см. в Глава 30, "Выполнение тестов вручную"..
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Автоматическое выполнение тестов
После определения наборов тестов можно приступить к выполнению 
тестов. Можно выбрать все тесты из набора тестов или только некоторые 
тесты. Среди выбранных тестов могут быть как ручные, так и 
автоматизированные тесты. 

При выполнении автоматизированного теста автоматически открывается 
выбранное средство тестирования, которое выполняет тест, а затем 
экспортирует результаты в Quality Center. При выполнении ручного теста 
соответствующий тестировщик получает сообщение электронной почты с 
указанием необходимости выполнения ручного теста.

Дополнительные сведения см. в Глава 31, "Автоматическое выполнение 
тестов"..

Можно также выполнить автоматизированный системный тест для 
получения сведений о системе, захвата снимка экрана или перезагрузки 
компьютера. Дополнительные сведения о выполнении системных тестов 
см. в Глава 23, "Работа с системными тестами".

Анализ результатов тестирования
После выполнения теста необходимо проанализировать его результаты. 
Следует определить шаги, на которых произошел сбой, и определить 
наличие нового дефекта в приложении или необходимость обновления 
ожидаемых результатов теста. Если был обнаружен дефект, можно 
создать новый дефект и связать его с выполнением теста или связать с 
выполнением теста уже существующий дефект. Дополнительные сведения 
см. в Глава 36, "Связывание дефектов"..

Для регулярной проверки результатов тестирования можно просматривать 
данные выполнения и создавать отчеты и диаграммы. Дополнительные 
сведения см. в Глава 40, "Модуль Dashboard", и Глава 44, "Создание 
диаграмм анализа в реальном времени"..

Дополнительные сведения о данных, которые появляются в Quality Center 
после выполнения теста, см. в Глава 32, "Просмотр результатов 
выполнения тестов"..
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27
Краткий обзор модуля Test Lab

В этой главе кратко описаны основные элементы модуля Test Lab.

Эта глава содержит следующие разделы.

 ➤  Модуль Test Lab на стр. 408

 ➤  Строка меню модуля Test Lab на стр. 410

 ➤  Панели инструментов модуля Test Lab на стр. 411

 ➤  Таблица выполнения на стр. 414

 ➤  Схема выполнения на стр. 419
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Модуль Test Lab 
Модуль Test Lab приложения Quality Center используется для создания 
наборов тестов и выполнения тестов. Чтобы открыть этот модуль, нажмите 
кнопку Test Lab на боковой панели. 

Модуль Test Lab содержит следующие основные элементы.

➤ Строка меню Test Lab. Раскрывающиеся меню с командами модуля Test 
Lab. Дополнительные сведения см. в разделе “Строка меню модуля Test 
Lab" на стр. 410.

➤ Панель инструментов Test Set. Содержит кнопки команд, часто 
используемых для создания и изменения наборов тестов в дереве наборов 
тестов. Дополнительные сведения см. в разделе “Панель инструментов Test 
Set" на стр. 412.

➤ Область Test Set. Отображение наборов тестов в виде иерархической 
структуры дерева наборов тестов. По умолчанию тесты сгруппированы в 
папки. Наборы тестов также можно просматривать в виде списка, выбрав 
команду View > Test Sets Grid. Дополнительные сведения о создании 
дерева наборов тестов см. в разделе “Создание дерева наборов тестов" на 
стр. 426.
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➤ Вкладка Details. Описание набора тестов, выбранного в дереве наборов 
тестов. Дополнительные сведения см. в разделе “Добавление наборов 
тестов" на стр. 428.

➤ Вкладка Execution Grid. Отображение данных тестов в виде таблицы. 
Дополнительные сведения см. в разделе “Таблица выполнения" на стр. 414.

➤ Вкладка Execution Flow. Отображение данных тестов в виде схемы. 
Дополнительные сведения см. в разделе “Схема выполнения" на стр. 419.

➤ Вкладка Attachments. Список вложений, содержащих дополнительные 
сведения о наборе тестов, выбранном в дереве наборов тестов. Если 
выбранный набор тестов имеет вложения, на вкладке отображается 
значок . Дополнительные сведения см. в Глава 5, "Добавление 
вложений"..

➤ Вкладка Automation. Правила отправки уведомлений по электронной 
почте и инструкции при сбое выполнения для набора тестов, выбранного в 
дереве наборов тестов. Дополнительные сведения см. в Глава 28, 
"Создание наборов тестов"..

➤ Вкладка Linked Defects. Содержит список объектов, связанных с текущим 
набором тестов. Дополнительные сведения см. в Глава 36, "Связывание 
дефектов"..

➤ Область Select Tests. Отображает тесты в правой части экрана и 
позволяет добавлять тесты в набор. Чтобы открыть эту область, нажмите 
кнопку Select Tests Область Select Tests содержит две вкладки. На вкладке 
Test Plan Tree отображается дерево плана тестирования. На вкладке 
Requirements Tree отображаются тесты в соответствии со связанными с 
ними требованиями.

➤ Вкладка Live Analysis. Графическое представление данных тестов для 
выбранной папки наборов тестов в дереве наборов тестов. 
Дополнительные сведения см. в Глава 44, "Создание диаграмм анализа в 
реальном времени"..
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Совет. Щелкните правой кнопкой мыши тест в таблице выполнения или на 
схеме выполнения и выберите команду Go to Test in Test Plan Tree, чтобы 
открыть модуль Test Plan и выделить выбранный тест в дереве плана 
тестирования.

Quality Center Выпуск Starter Edition. При использовании выпуска Starter 
Edition поля, связанные с управлением релизами, недоступны в модуле 
Test Lab. 

Строка меню модуля Test Lab
Строка меню модуля Test Lab содержит следующие меню.

➤ Меню Test Sets содержит команды, позволяющие создавать, изменять и 
выполнять наборы тестов. Можно удалять результаты выполнения, 
устанавливать оповещения и правила при сбое выполнения для наборов 
тестов, добавлять хосты и определять группы хостов, а также 
экспортировать содержимое таблицы выполнения в файл. 
Дополнительные сведения см. в Глава 28, "Создание наборов тестов". 

➤ Меню Edit содержит команды, которые позволяют вырезать, копировать, 
вставлять, переименовывать и удалять наборы тестов, а также искать 
папки и наборы тестов. На вкладке Execution Flow это меню позволяет 
найти тест на схеме.

➤ Меню View содержит команды, которые позволяют фильтровать и 
сортировать наборы тестов, а также настраивать отображение дерева и 
таблицы наборов тестов.
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➤ Меню Tests содержит команды, которые позволяют выполнять тесты, 
удалять тесты из наборов тестов, настраивать отображение таблицы 
выполнения, просматривать свойства экземпляров тестов, изменять 
порядок тестов, искать тесты, выбирать их и просматривать результат 
последнего выполнения. Дополнительные сведения см. в Глава 28, 
"Создание наборов тестов".

Также можно просматривать и добавлять оповещения для тестов и 
помечать тесты для отслеживания. Дополнительные сведения см. в 
Глава 4, "Оповещение об изменениях".

➤ Меню Analysis содержит команды, которые позволяют создавать отчеты о 
выполнении тестов и диаграммы. Дополнительные сведения об отчетах о 
выполнении тестов см. в Глава 42, "Создание стандартных отчетов".. 
Дополнительные сведения о диаграммах выполнения тестов см. в 
Глава 41, "Создание диаграмм", и Глава 44, "Создание диаграмм анализа в 
реальном времени"..

Совет. Чтобы получить доступ к строке меню Test Lab из модуля Test Lab, 
нажмите клавишу F9. Кроме того, с помощью сочетаний клавиш можно 
выполнять множество других операций в среде Quality Center. Перечень 
сочетаний клавиш приведен в Приложение B, "Сочетания клавиш 
Quality Center"..

Панели инструментов модуля Test Lab
Модуль Test Lab содержит следующие панели инструментов: Test Set и 
Select Tests.

Кроме того, можно использовать панели инструментов на вкладках 
Execution Grid и Execution Flow. Дополнительные сведения см. в разделах 
“Панель инструментов таблицы выполнения" на стр. 415 и “Панель 
инструментов схемы выполнения" на стр. 420.
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Панель инструментов Test Set
Панель инструментов Test Set содержит следующие кнопки.

New Folder. Открывается диалоговое окно New Folder, в котором можно 
создать папку наборов тестов. Эта папка добавляется к дереву наборов 
тестов в левой области. Дополнительные сведения см. в разделе 
“Создание дерева наборов тестов" на стр. 426.

New Test Set. Открывается диалоговое окно New Test Set, в котором можно 
создать набор тестов в уже существующей папке. Дополнительные 
сведения см. в разделе “Добавление наборов тестов" на стр. 428.

Delete. Удаление папок и наборов тестов из дерева наборов тестов. 
Удаление наборов тестов из таблицы наборов тестов. Дополнительные 
сведения см. в разделе “Удаление наборов тестов" на стр. 450.

Assign To Cycle. Можно выбрать следующие варианты.

➤ Assign To Cycle. Назначение папки наборов тестов циклу. 
Дополнительные сведения см. в разделе “Назначение папок наборов 
тестов циклам" на стр. 427.

➤ Clear Assigned Cycle. Отмена назначения папки наборов тестов циклу.

Refresh All. Обновление дерева наборов тестов или таблицы наборов 
тестов для отображения наиболее актуальных наборов тестов.

Set Filter/Sort. Можно выбрать следующие варианты.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать наборы тестов. 

➤ Clear Filter/Sort. Очистка всех примененных фильтров и параметров 
сортировки.

Дополнительные сведения см. в разделе “Фильтрация записей" на стр. 59.

Панель инструментов Select Tests
Чтобы отобразить дерево плана тестирования в правой области, нажмите 
кнопку Select Tests. Будет показана вкладка Test Plan Tree. Если перейти 
на вкладку Requirements Tree, тесты будут показаны в соответствии со 
связанными с ними требованиями.
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Панель инструментов Select Tests содержит следующие кнопки.

Add Tests to Test Set. Добавление тестов в набор тестов. 

Refresh All. Обновление дерева.

Set Filter/Sort. Можно выбрать следующие варианты.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты. 

➤ Clear Filter/Sort. Очистка всех примененных фильтров и параметров 
сортировки.

Find. Поиск определенного теста в дереве. При успешном завершении 
поиска тест будет выделен в дереве.

Go To Test. Поиск определенного теста в дереве по идентификатору Test 
ID. При успешном завершении поиска тест будет выделен в дереве.

Go To Requirement. Поиск определенного требования в дереве по 
идентификатору ReqID. При успешном завершении поиска требование 
будет выделено в дереве.
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Таблица выполнения 
На вкладке Execution Grid данные тестов отображаются в виде таблицы. В 
каждой строке этой таблицы отображается запись отдельного теста. 

Вкладка Execution Grid содержит следующие основные элементы.

➤ Панель инструментов таблицы выполнения. Содержит кнопки команд, 
часто используемых при выполнении и просмотре тестов. См. раздел 
“Панель инструментов таблицы выполнения" на стр. 415.

➤ Столбцы индикаторов. Указывают, что определенный экземпляр теста 
содержит вложения, связанные дефекты, оповещения и флажки 
отслеживания. Чтобы отобразить эти столбцы, выберите команду Tests > 
Indicator Columns.
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➤ Фильтр таблицы. Текущий фильтр, примененный к столбцу. Чтобы 
отобразить фильтры таблицы, выберите команду Tests > Grid Filters.

➤ Область Last Run Result. Результаты последнего выполнения теста. 
Чтобы отобразить область результатов последнего выполнения теста, 
выберите команду Tests > Last Run Result или нажмите стрелку Show.

Панель инструментов таблицы выполнения
Панель инструментов таблицы выполнения содержит следующие кнопки.

Select Tests. Отображение дерева плана тестирования в правой области. 
В дереве плана тестирования можно выбирать тесты для добавления их в 
набор. Можно также перейти на вкладку Requirements Tree, чтобы 
просматривать тесты в соответствии с требованиями. Дополнительные 
сведения см. в разделе “Добавление тестов в набор тестов" на стр. 431.

Столбец Описание

Вложения Чтобы просмотреть вложения экземпляра теста, 
щелкните значок . Дополнительные сведения см. в 
Глава 5, "Добавление вложений"..

Связанные 
объекты

Чтобы просмотреть связанные с экземпляром теста 
объекты, щелкните значок . Дополнительные сведения 
см. в Глава 36, "Связывание дефектов"..

Оповещения Чтобы просмотреть оповещения для экземпляра теста, 
щелкните значок . Дополнительные сведения см. в 
разделе “Просмотр оповещений" на стр. 88.

Флажки 
отслеживания

Чтобы просмотреть оповещения об отслеживании для 
экземпляра теста, щелкните значок . Дополнительные 
сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 91.
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Run. Если выбран ручной тест, откроется диалоговое окно Manual Runner 
для выполнения этого теста. Если выбран автоматизированный тест, 
откроется диалоговое окно Automatic Runner для выполнения этого теста. 
Также возможны следующие варианты.

➤ Run Manually. Выполнение автоматизированного теста вручную.

➤ Continue Manual Run. Возобновление выполнения ручного теста.

Дополнительные сведения о выполнении тестов вручную см. в Глава 30, 
"Выполнение тестов вручную". Дополнительные сведения о выполнении 
автоматизированных тестов см. в Глава 31, "Автоматическое выполнение 
тестов".

Run Test Set. Открывается диалоговое окно Automatic Runner для 
выполнения набора тестов. Набор тестов может содержать как ручные, так 
и автоматизированные тесты. Дополнительные сведения см. в разделе 
“Автоматическое выполнение тестов" на стр. 478.

Remove Tests from Test Set. Удаление выбранных тестов из набора 
тестов. Дополнительные сведения см. в разделе “Удаление тестов из 
набора тестов" на стр. 445.

Refresh All. Обновление таблицы выполнения для отображения наиболее 
актуальной информации о тестах с учетом выбранных фильтров.

Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты в таблице выполнения. Возможны 
следующие варианты.

➤ Set Filter/Sort. Открывается диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты. 

➤ Clear Filter/Sort. Очистка всех фильтров и параметров сортировки, 
примененных к таблице выполнения.

Дополнительные сведения см. в разделе “Фильтрация записей" на стр. 59.

Select Columns. Открывается диалоговое окно Select Columns, в котором 
можно указать столбцы, отображаемые в таблице выполнения, и порядок 
их отображения. Дополнительные сведения см. в разделе “Упорядочивание 
столбцов" на стр. 54.
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Test Instance Properties. Открывается диалоговое окно Test Instance 
Properties, в котором отображаются свойства выбранного экземпляра 
теста. Дополнительные сведения см. в разделе “Просмотр результатов 
выполнения тестов" на стр. 491.

Attachments. Открывается диалоговое окно Test Instance Properties, в 
котором можно добавить вложение к экземпляру выполнения теста. 
Дополнительные сведения см. в Глава 5, "Добавление вложений"..

Flag for Follow Up. Открывается диалоговое окно Flag For Follow Up, в 
котором можно добавить или изменить флажок отслеживания экземпляра 
теста. Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 91.

Столбцы таблицы выполнения
В таблице выполнения показаны столбцы данных плана тестирования и 
выполнения тестов. Дополнительные сведения о столбцах данных плана 
тестирования см. в разделе “Столбцы таблицы тестов" на стр. 285.

Столбец Описание

Exec Date Дата последнего выполнения теста.

Modified Дата и время последнего изменения теста в таблице 
выполнения.

Planned Exec Date Дата запланированного выполнения теста.

Planned Exec Time Запланированное время выполнения теста.

Planned Host Name Имя или IP-адрес компьютера, на котором должен 
выполняться тест.

Responsible Tester Имя пользователя, ответственного за выполнение теста.

Status Статус последнего выполнения теста. Статус 
выполнения может принимать одно из следующих 
значений: Failed, N/A, No Run, Not Completed, Passed.

Target Cycle Цикл, которому назначен тест. Чтобы выбрать другой 
цикл, нажмите стрелку «Вниз».
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Примечания. 

➤ В таблицу выполнения можно добавлять поля, определенные 
пользователем. Можно также изменить заголовок любого поля этой 
таблицы. Также предусмотрена возможность настройки списков 
проектов. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ Для ограничения и динамического изменения полей и значений в 
таблице выполнения можно использовать редактор Script Editor. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ Если в таблице выполнения выбрать столбец, содержащий имя 
пользователя, Quality Center покажет список с именем и полным именем 
каждого пользователя. Можно выполнять поиск пользователей, 
сортировать и группировать их по группам, а также выбирать 
пользователей из списка пользователей и дерева групп. 
Дополнительные сведения см. в разделе “Выбор пользователей" на 
стр. 57.

Tester Имя последнего пользователя, выполнявшего этот тест.

Time Время последнего выполнения теста.

Столбец Описание
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Схема выполнения 
На схеме выполнения отображаются данные тестирования, 
организованные и представленные в виде схемы. Схему выполнения 
можно использовать для управления способом выполнения тестов. Можно 
указать, когда и при каких условиях должен выполняться тест. 

Дополнительные сведения о вкладке Execution Flow см. в Глава 29, 
"Планирование выполнения тестов". 

Вкладка Execution Flow содержит следующие основные элементы.

➤ Панель инструментов схемы выполнения. Содержит кнопки команд, 
часто используемых при планировании выполнения тестов. См. раздел 
“Панель инструментов схемы выполнения" на стр. 420.

➤ Схема выполнения. Показывает тесты и условия в виде схемы. 
Дополнительные сведения см. в Глава 29, "Планирование выполнения 
тестов"..
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Панель инструментов схемы выполнения
Панель инструментов схемы выполнения содержит следующие кнопки.

Select Tests. Отображение дерева плана тестирования в правой области. 
В дереве плана тестирования можно выбирать тесты для добавления их в 
набор. Можно также перейти на вкладку Requirements Tree, чтобы 
просматривать тесты в соответствии с требованиями. Дополнительные 
сведения см. в разделе “Добавление тестов в набор тестов" на стр. 431.

Run. Если выбран ручной тест, откроется диалоговое окно Manual Runner 
для выполнения этого теста. Если выбран автоматизированный тест, 
откроется диалоговое окно Automatic Runner для выполнения этого теста. 
Также возможны следующие варианты.

➤ Run Manually. Выполнение автоматизированного теста вручную.

➤ Continue Manual Run. Возобновление выполнения ручного теста.

Дополнительные сведения о выполнении тестов вручную см. Глава 30, 
"Выполнение тестов вручную". Дополнительные сведения об 
автоматизированном выполнении тестов см. Глава 31, "Автоматическое 
выполнение тестов"..

Run Test Set. Открывается диалоговое окно Automatic Runner для 
выполнения набора тестов. Набор тестов может содержать как ручные, так 
и автоматизированные тесты. Дополнительные сведения см. в разделе 
“Автоматическое выполнение тестов" на стр. 478.

Find Test In Flow. Открывается диалоговое окно Find Test, в котором 
можно найти тест на схеме выполнения. Дополнительные сведения см. в 
разделе “Поиск тестов" на стр. 464.

Remove Tests from Test Set. Удаление выбранных тестов из набора 
тестов.

Refresh Flow. Обновление схемы выполнения для отображения наиболее 
актуальных тестов.

ArrangeLayout. Расположение тестов в иерархическом порядке для 
просмотра зависимостей между различными тестами.
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Zoom In. Увеличение масштаба для более подробного просмотра части 
схемы выполнения.

Zoom Out. Уменьшение масштаба для просмотра большей части схемы 
выполнения.

Fit Picture In Window. Изменение размеров схемы по размеру окна. 
Щелкните стрелку Fit Picture In Window, чтобы выбрать нужный масштаб. 
Дополнительные сведения см. в разделе “Просмотр схемы выполнения" на 
стр. 464.

Add Time Dependency to Flow Добавление значка временной зависимости 
в схему. Чтобы создать временную зависимость для теста, соедините этот 
значок стрелкой с тестом на схеме выполнения. По умолчанию для 
временной зависимости используется текущая дата и время сервера 
Quality Center. Дополнительные сведения см. в разделе “Планирование 
выполнения тестов" на стр. 457.



Глава 27 • Краткий обзор модуля Test Lab

422



423

28
Создание наборов тестов

Управлять выполнением тестов можно путем создания наборов тестов. 
Набор тестов содержит подмножество тестов проекта. Дерево наборов 
тестов служит для упорядочивания и отображения наборов тестов в 
иерархическом порядке.

Quality Center Выпуск Starter Edition. Поля и функциональные 
возможности, связанные с управлением релизами и работой с базовыми 
состояниями, недоступны при создании наборов тестов в выпуске Starter 
Edition. 

Эта глава содержит следующие разделы.

 ➤  О создании наборов тестов на стр. 424

 ➤  Создание дерева наборов тестов на стр. 426

 ➤  Назначение папок наборов тестов циклам на стр. 427

 ➤  Добавление наборов тестов на стр. 428

 ➤  Добавление тестов в набор тестов на стр. 431

 ➤  Настройка уведомлений набора тестов на стр. 434

 ➤  Настройка правил при сбое выполнения набора тестов на стр. 436

 ➤  Управление наборами тестов на стр. 441
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О создании наборов тестов
После разработки тестов в модуле Test Plan можно создать дерево 
наборов тестов. Дерево наборов тестов позволяет организовать процесс 
управления приложением путем размещения наборов тестов в 
соответствующих папках и распределения их по иерархическим уровням в 
модуле Test Lab. Набор тестов — это группа тестов в проекте 
Quality Center, предназначенная для решения определенных задач 
тестирования. Набор тестов может содержать как ручные, так и 
автоматизированные тесты. После создания дерева наборов тестов 
необходимо назначить папки наборов тестов циклам, определенным в 
дереве релизов в модуле Releases.

Принимая решение о том, какие наборы тестов необходимо создать, 
руководствуйтесь целями управления приложением, определенными в 
начале процесса тестирования. Следует учитывать такие вопросы, как 
текущее состояние приложения, добавление новых и модификация 
существующих функций.

Ниже приведены примеры общих категорий наборов тестов, которые 
можно создавать.

Набор тестов Описание

Работоспособность Проверка функциональности и стабильности всего 
приложения на базовом уровне. Основное внимание 
уделяется широте, а не глубине проверки. Этот набор 
тестов содержит основные тесты, в том числе 
положительные проверки, которые показывают, что 
приложение работает правильно. Например, при 
тестировании приложения Mercury Tours можно 
проверить запуск приложения и возможность входа в 
систему.

Регрессия Система тестируется глубже, чем при поверхностной 
проверке работоспособности. Этот набор тестов 
может содержать как положительные, так и 
отрицательные проверки. Отрицательное 
тестирование представляет собой попытку вызвать 
сбой в приложении, чтобы продемонстрировать его 
неправильную работу.
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Предположим, необходимо протестировать все новые функции, 
добавленные в релизе 10.5 приложения Mercury Tours. Релиз 10.5 состоит 
из четырех циклов. Необходимо протестировать новые функции релиза в 
циклах 1, 2 и 4. Поскольку тесты, которые необходимо выполнить для 
проверки новых функций, одинаковы для всех этих циклов, можно 
использовать один и тот же набор тестов в качестве основы для 
тестирования новых функций в каждом цикле.

В дереве наборов тестов можно создать папку Release 10.5 для релиза. В 
этой папке можно создать папку Cycle 1 для первого цикла релиза. В папке 
Cycle 1 можно создать набор тестов New Features, содержащий тесты, 
необходимые для тестирования новых функций релиза. После создания 
этого набора тестов и добавления тестов можно копировать и вставлять 
папку Cycle 1, создавая на ее основе другие циклы для тестирования 
новых функций.

Расширенный Тестирование приложения как в ширину, так и в 
глубину. Этот набор тестов позволяет проверить все 
приложение, в том числе его расширенные функции. 
Выполнить этот набор тестов можно в случае, если на 
тестирование выделено достаточно много времени.

Функция Тестирование подсистемы приложения. Это может 
быть одна функция или группа функций. Например, 
при проверке приложения Mercury Tours можно 
проверить все действия, связанные с бронированием 
билетов на авиарейс.

Набор тестов Описание
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Обратите внимание, что по умолчанию самый верхний уровень дерева 
наборов тестов — папка Root. Папку Root невозможно удалить; также 
нельзя добавлять наборы тестов непосредственно в эту папку. Подпапка 
Unattached папки Root содержит все наборы тестов, которые больше не 
связаны с папками. Добавлять наборы тестов в папку Unattached нельзя. 
При удалении какой-либо папки в модуле Test Lab можно указать 
необходимость перемещения наборов тестов этой папки в папку 
Unattached или удаления этих наборов тестов без возможности 
восстановления. 

Создание дерева наборов тестов
Иерархическая структура наборов тестов создается путем построения 
дерева наборов тестов. Дерево наборов тестов состоит из папок самого 
верхнего уровня, содержащих вложенные папки. Для каждой папки дерева 
наборов тестов определяется набор тестов, а затем в него добавляются 
экземпляры тестов. Начать создание дерева наборов тестов необходимо с 
добавления папки в папку Root.

После создания дерева наборов тестов необходимо назначить папки 
наборов тестов циклам, определенным в дереве релизов в модуле 
Releases. Дополнительные сведения см. в разделе “Назначение папок 
наборов тестов циклам" на стр. 427.

Чтобы создать дерево наборов тестов, выполните следующие 
действия.

 1 Выберите команду View > Test Sets Tree, чтобы отобразить представление 
дерева наборов тестов в области Test Set.

 2 В дереве наборов тестов выберите папку Root.

 3 Нажмите кнопку New Folder или выберите команду Test Sets > New Folder. 
Откроется диалоговое окно New Folder.

 4 В поле Folder Name ведите имя новой папки, а затем нажмите кнопку OK. 
Учтите, что имя папки не должно содержать следующих символов: \ ^ * 

В дереве наборов тестов в папке Root появится созданная папка.
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 5 На вкладке Details укажите сведения о папке набора тестов, назначив эту 
папку циклу. Дополнительные сведения см. в разделе “Назначение папок 
наборов тестов циклам" на стр. 427.

 6 На вкладке Description введите описание папки наборов тестов. 

 7 Перейдите на вкладку Attachments и добавьте вложение к созданной 
папке наборов тестов (если это необходимо). Вложение может 
представлять собой файл, URL-адрес, снимок приложения, содержимое из 
буфера обмена или сведения о системе. Дополнительные сведения см. в 
Глава 5, "Добавление вложений"..

 8 Чтобы создать дополнительные папки, выберите папку и повторите шаги 3 
– 7. 

Назначение папок наборов тестов циклам
После создания дерева наборов тестов необходимо назначить папки 
наборов тестов циклам, определенным в дереве релизов в модуле 
Releases. Дополнительные сведения см. в Глава 10, "Создание дерева 
релизов"..

Quality Center Выпуск Starter Edition. Назначение папок наборов тестов 
циклам недоступно.

Чтобы назначить папку наборов тестов циклу, выполните следующие 
действия.

 1 В дереве наборов тестов выберите папку наборов тестов, которую 
необходимо назначить циклу. 

 2 Нажмите кнопку Assign To Cycle или выберите команду Test Sets > Assign 
To Cycle. Можно также перейти на вкладку Details и нажать кнопку обзора 
рядом с полем Assigned to cycle. Откроется диалоговое окно Assign To 
Cycle. 

 3 Разверните дерево и выберите цикл. 

 4 Чтобы закрыть диалоговое окно Assign To Cycle, нажмите кнопку OK. В 
дереве наборов тестов значок папки  будет заменен значком 
назначенной папки наборов тестов .
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На вкладке Details будут показаны следующие сведения о папке наборов 
тестов.

Можно нажать кнопку Show, чтобы просмотреть следующие сведения.

 5 Чтобы отменить назначение папки наборов тестов, нажмите стрелку 
Assign To Cycle, а затем выберите команду Clear Assigned Cycle. Также 
можно выделить назначенную папку наборов тестов и выбрать команду 
Test Sets > Clear Assigned Cycle. 

Добавление наборов тестов
В папку в дереве наборов тестов или в таблицу наборов тестов можно 
добавлять новые наборы тестов.

Чтобы добавить набор тестов, выполните следующие действия.

 1 Можно добавить набор тестов в дерево наборов тестов или в таблицу 
наборов тестов.

Поле Описание

Assigned to cycle Цикл, которому назначена выбранная папка наборов 
тестов.

Cycle start date Дата начала работы над циклом. 

Cycle end date Дата завершения работы над циклом. 

Remaining days in 
cycle

Суммарное количество дней, оставшихся до 
завершения цикла.

Поле Описание

Total test instances Суммарное количество экземпляров тестов в 
выбранной папке наборов тестов.

Remaining test 
instances to run

Суммарное количество экземпляров тестов в 
выбранной папке наборов тестов, которые еще не 
выполнялись.



Глава 28 • Создание наборов тестов

429

➤ Откройте дерево наборов тестов с помощью команды View > Test Sets 
Tree. Выберите папку в дереве наборов тестов, а затем нажмите кнопку 
New Test Set или выберите команду Test Sets > New Test Set.

➤ Откройте таблицу наборов тестов с помощью команды View > Test Sets 
Grid. Нажмите кнопку New Test Set или выберите команду Test Sets > 
New Test Set.

Откроется диалоговое окно New Test Set.

Если это диалоговое окно открыто из дерева наборов тестов, то в поле 
Test Set Folder будет показано имя выбранной папки.

 2 Если диалоговое окно New Test Set открыто из таблицы наборов тестов, 
нажмите кнопку обзора в поле Test Set Folder и выберите папку.

 3 В поле Test Set Name введите имя набора тестов. Учтите, что имя набора 
тестов не должно содержать следующих символов: \ ^ , " *

 4 В поле Description введите описание набора тестов.

 5 Нажмите кнопку ОK. Имя набора тестов появится в дереве наборов тестов. 
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 6 Перейдите на вкладку Details.

Введите следующие сведения.

➤ Quality Center Выпуски Enterprise Edition и Premier Edition. В поле 
Baseline выберите базовое состояние, к которому следует прикрепить 
набор тестов. Дополнительные сведения см. в разделе “Прикрепление 
набора тестов к базовому состоянию" на стр. 579.

➤ В поле Close Date выберите планируемую дату закрытия набора тестов.

➤ В поле Open Date выберите дату из календаря. По умолчанию 
устанавливается текущая дата сервера баз данных.

➤ В поле ITG Request Id добавьте идентификатор запроса IT Governance. 
Это требуется только при интеграции со средством IT Governance.

➤ В поле Status установите статус набора тестов: Open или Closed.
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 7 Перейдите на вкладку Attachments, чтобы добавить вложение к набору 
тестов. Вложение может представлять собой файл, URL-адрес, снимок 
приложения, содержимое из буфера обмена или сведения о системе. 
Дополнительные сведения о вложениях см. в Глава 5, "Добавление 
вложений"..

 8 Перейдите на вкладку Automation и выполните следующие операции.

➤ Щелкните ссылку Notifications, чтобы включить в Quality Center 
отправку сообщений электронной почты указанным пользователям при 
наступлении определенных событий. Дополнительные сведения см. в 
разделе “Настройка уведомлений набора тестов" на стр. 434.

➤ Щелкните ссылку On Failure, чтобы указать правила для 
автоматизированных тестов из набора тестов, которые должны 
выполняться в случае сбоя теста. Дополнительные сведения см. в 
разделе “Настройка правил при сбое выполнения набора тестов" на 
стр. 436.

Добавление тестов в набор тестов 
Определив набор тестов, можно добавлять к нему ручные и 
автоматизированные тесты из дерева плана тестирования, а также тесты, 
покрывающие требования из дерева требований. Можно также включать 
экземпляры одного теста в различные наборы тестов, причем в один набор 
тестов можно включать несколько экземпляров одного и того же теста.

Чтобы добавить в набор тестов тесты из дерева плана тестирования, 
выполните следующие действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 На вкладке Execution Grid или Execution Flow нажмите кнопку Select Tests. 
По умолчанию в правой области на вкладке Test Plan Tree отображается 
дерево плана тестирования.

 3 Выберите тест или папку и нажмите кнопку Add Tests to Test Set. 
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Совет. Добавлять тесты можно также двойным щелчком или 
перетаскиванием папки или теста из дерева плана тестирования в таблицу 
Execution Grid или в схему Execution Flow.

 4 При добавлении папки открывается окно сообщения. Нажмите кнопку Yes 
для подтверждения.

Примечание. Добавляются только те тесты, которые соответствуют 
текущему фильтру на вкладке Test Plan Tree.

 5 Если в наборе тестов уже есть добавляемый тест, откроется диалоговое 
окно Create Test Instance. В этом окне будут показаны все тесты, 
существующие в данном наборе тестов, с указанием числа экземпляров. 
Выберите тесты, которые необходимо добавить в набор тестов, а затем 
нажмите кнопку Create.

 6 Если добавляемый тест содержит параметры, которым не были присвоены 
фактические значения, откроется диалоговое окно Parameters of Test. 
Присвойте параметрам фактические значения. Эти значения будут 
использоваться для всех выполнений теста. Дополнительные сведения см. 
в разделе “Назначение фактических значений" на стр. 358.

 7 Чтобы закрыть правую область, нажмите кнопку Close.

Чтобы добавить в набор тестов тесты, покрывающие требования, из 
дерева требований, выполните следующие действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 На вкладке Execution Grid или Execution Flow нажмите кнопку Select Tests. 

 3 На правой области перейдите на вкладку Requirements Tree. Тесты 
показаны в соответствии со связанными требованиями. 

 4 Чтобы добавить тест, выберите его и нажмите кнопку Add Tests Covering 
Requirement.
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Совет. Добавлять тесты можно также двойным щелчком или 
перетаскиванием теста или требования из вкладки Requirements Tree в 
таблицу Execution Grid или схему Execution Flow.

 5 Чтобы добавить все тесты, покрывающие выбранное требование, 
выберите требование и нажмите кнопку Add Tests Covering Requirement.

Чтобы добавить все тесты, покрывающие выбранное требование и его 
дочерние требования, выберите требование. Нажмите стрелку Add Tests 
Covering Requirement, а затем выберите команду Add Tests Covering 
Requirement and Children.

Откроется окно сообщения. Нажмите кнопку Yes для подтверждения.

Примечание. Добавляются только те тесты, которые соответствуют 
текущему фильтру на вкладке Requirements Tree.

 6 Если в наборе тестов уже есть хотя бы один из добавляемых тестов, 
откроется диалоговое окно Create Test Instance. В этом окне будут 
показаны все тесты, существующие в данном наборе тестов, с указанием 
числа экземпляров. Выберите тесты, которые необходимо добавить в 
набор тестов, а затем нажмите кнопку Create.

 7 Если добавляемый тест содержит параметры, которым не были присвоены 
фактические значения, откроется диалоговое окно Parameters of Test. 
Присвойте параметрам фактические значения. Эти значения будут 
использоваться для всех выполнений теста. Дополнительные сведения см. 
в разделе “Назначение фактических значений" на стр. 358.

 8 Чтобы закрыть правую область, нажмите кнопку Close. 
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Настройка уведомлений набора тестов 
В Quality Center можно включить отправку сообщений электронной почты 
указанному пользователю при наступлении одного из следующих событий, 
связанных с набором тестов.

➤ Сбой какого-либо теста из набора тестов.

➤ Сбой какого-либо теста из набора тестов по причинам, не связанным с 
логикой теста. Возможны следующие причины сбоя теста: отсутствие 
возврата вызова функций, нарушение прав доступа, несовместимость 
версий компонентов приложения, отсутствие библиотеки DLL, 
недостаточные разрешения и многие другие причины.

➤ Закончено выполнение всех выполняемых тестов из набора тестов. Учтите, 
что это не касается тестов, которые не выполнялись.



Глава 28 • Создание наборов тестов

435

Чтобы добавить уведомления набора тестов, выполните следующие 
действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Перейдите на вкладку Automation и щелкните ссылку Notifications.

 3 Выберите одно или несколько событий для набора тестов.

 4 Чтобы указать получателя сообщений электронной почты, введите 
допустимый адрес электронной почты.

Также можно нажать кнопку To. Откроется диалоговое окно Select 
Recipients. Выберите отдельных пользователей или всю группу 
пользователей. Нажмите кнопку ОK. Сообщение будет отправлено 
пользователю, если в свойствах пользователя указан допустимый адрес 
электронной почты. Дополнительные сведения об указании свойств 
пользователей см. в документе HP Quality Center Administrator Guide.

 5 В поле Message введите текст сообщения электронной почты.
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Настройка правил при сбое выполнения набора тестов 
В Quality Center можно указать правила для набора тестов при сбое 
выполнения автоматизированного теста. В этих правилах можно указать 
количество повторных выполнений теста, а также тест очистки, который 
должен быть выполнен перед повторным выполнением теста. Для каждого 
автоматизированного теста из набора можно изменить правила, 
применяемые по умолчанию в случае сбоя выполнения теста. 

Чтобы настроить правила при сбое выполнения набора тестов, 
выполните следующие действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Перейдите на вкладку Automation и щелкните ссылку On Failure.

 3 Чтобы настроить правило при сбое выполнения набора тестов, установите 
первый флажок и укажите число повторных выполнений 
автоматизированного теста. 
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 4 Чтобы добавить тест очистки перед каждым повторным выполнением 
теста, установите второй флажок и нажмите кнопку обзора, чтобы выбрать 
тест очистки из дерева плана тестирования в диалоговом окне Select 
Cleanup Test.

 5 Можно изменить правила по умолчанию при сбое выполнения для 
определенного теста в наборе тестирования. Дополнительные сведения 
см. в разделе “Изменение правил по умолчанию при сбое тестирования для 
отдельных тестов" на стр. 437.

 6 При окончательном сбое выполнения любого теста в наборе тестирования 
в Quality Center можно указать следующие действия.

➤ Не выполнять никаких действий.

➤ Остановить выполнение набора тестов.

➤ Выполнить набор тестов повторно указанное число раз.

Изменение правил по умолчанию при сбое тестирования 
для отдельных тестов
Можно изменить правила по умолчанию при сбое выполнения для 
определенного теста в наборе тестирования. Эти правила содержат 
инструкции для Quality Center при сбое выполнения теста. Правила 
позволяют указать число повторных выполнений теста, а также тест 
очистки, который должен быть выполнен перед повторным выполнением 
теста.

Примечание. Можно также воспользоваться представлением Run Events в 
диалоговом окне Test Instance Properties, чтобы указать правила, 
применяемые при сбое выполнения теста в наборе тестов. 
Дополнительные сведения см. в разделе “Просмотр событий выполнения 
теста" на стр. 504.
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Чтобы изменить правила по умолчанию при сбое выполнения 
отдельного теста, выполните следующие действия.

 1 Установите правила по умолчанию при сбое выполнения тестов. 
Дополнительные сведения см. в разделе “Настройка правил при сбое 
выполнения набора тестов" на стр. 436.

 2 Чтобы изменить эти правила для какого либо теста, нажмите кнопку 
Settings per test. Откроется диалоговое окно On Test Failure.
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 3 Указать количество повторных выполнений автоматизированного теста 
можно следующими способами.

➤ Если необходимо указать количество повторных выполнений 
выбранного теста, дважды щелкните соответствующую ячейку в 
столбце Number of Reruns. Откроется диалоговое окно Number of 
Reruns. Укажите количество повторных выполнений и нажмите кнопку 
Apply. 

➤ Чтобы указать количество повторных выполнений выбранных тестов, 
выберите тесты или нажмите кнопку Select All. Нажмите клавишу CTRL, 
а затем дважды щелкните любую ячейку в столбце Number of Reruns. 
Также можно нажать стрелку Change Selected Tests и выбрать команду 
Change Number of Reruns. Откроется диалоговое окно Number of 
Reruns. Обратите внимание на то, что флажок Apply to all selected tests 
установлен. Укажите количество повторных выполнений и нажмите 
кнопку Apply.
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 4 Указать тест очистки можно следующими способами.

➤ Чтобы указать тест очистки для выбранного теста, дважды щелкните 
соответствующую ячейку в столбце Cleanup Test. Откроется 
диалоговое окно Select Cleanup Test. В дереве плана тестирования 
выберите тест очистки, а затем нажмите кнопку Apply.

➤ Чтобы указать один тест очистки для выбранных тестов, выберите тесты 
или нажмите кнопку Select All. Нажмите клавишу CTRL, а затем дважды 
щелкните любую ячейку в столбце Cleanup Test. Также можно нажать 
стрелку Change Selected Tests и выбрать команду Change Cleanup 
Test. Откроется диалоговое окно Select Cleanup Test. Обратите 
внимание на то, что флажок Apply to all selected tests установлен. В 
дереве плана тестирования выберите тест очистки, а затем нажмите 
кнопку Apply.

 5 Чтобы сбросить правила для теста до установок по умолчанию, выберите 
тест и нажмите кнопку Set to Default. Нажмите кнопку Yes для 
подтверждения.

 6 Чтобы очистить настройки теста, выберите тест и нажмите кнопку Clear. 
Нажмите кнопку Yes для подтверждения.

 7 Чтобы скопировать настройки из одного теста в другой, выберите тест, из 
которого необходимо скопировать настройки, а затем нажмите кнопку Copy 
Test Settings.

Выберите тест, в который необходимо вставить настройки, а затем 
нажмите кнопку Paste Test Settings.

 8 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно On Test Failure. 
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Управление наборами тестов 
Этот раздел, посвященный управлению наборами тестов, содержит 
следующие подразделы.

➤ Поиск наборов тестов в дереве

➤ Поиск тестов в таблице выполнения

➤ Замена значений полей в таблице выполнения

➤ Удаление тестов из набора тестов

➤ Копирование наборов тестов в проекте

➤ Копирование наборов тестов между проектами

➤ Копирование URL-адресов наборов тестов

➤ Переименование наборов тестов

➤ Удаление папок наборов тестов

➤ Удаление наборов тестов

➤ Сброс наборов тестов

➤ Удаление результатов выполнения тестов из набора тестов
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Поиск наборов тестов в дереве
Предусмотрена возможность поиска папки или набора тестов в дереве 
наборов тестов. Если к дереву набора тестов применены фильтры, то 
модуль Test Lab будет выполнять поиск только в текущих отображаемых 
наборах тестов.

Чтобы найти набор тестов в дереве, выполните следующие действия.

 1 Выберите папку в дереве наборов тестов.

 2 Выберите команду Edit > Find Folder/Test Set. Откроется диалоговое окно 
Find Folder/Test Set, в котором в поле Find in будет показано имя папки. При 
поиске по всему дереву именем папки является Root.

 3 В поле Value To Find введите имя (или часть имени) папки или набора 
тестов. Нельзя использовать подстановочный знак звездочки (*). Учтите, 
что поиск выполняется без учета регистра.

 4 Установите флажок Include Test Sets, если в поиск необходимо включить 
наборы тестов.

 5 Нажмите кнопку Find.

Модуль Test Lab выполнит поиск папки или набора тестов. При успешном 
завершении поиска откроется диалоговое окно Search Results, содержащее 
список возможных совпадений. Выберите в этом списке нужный результат, 
а затем нажмите кнопку Go To, чтобы выделить папку или набор тестов в 
дереве наборов тестов. 

При неудачном завершении поиска откроется информационное окно.
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Поиск тестов в таблице выполнения
Можно искать тесты в таблице выполнения по значению указанного поля. 
Если к таблице применены фильтры, то поиск будет выполнен только 
среди отображаемых тестов.

Чтобы найти тест в таблице выполнения, выполните следующие 
действия.

 1 Выберите команду Tests > Find. Откроется диалоговое окно Find.

 2 В поле Find in Field выберите поле таблицы.

 3 В поле Value to Find введите или выберите значение поля, которое 
необходимо найти.

 4 Установите флажок Exact Match, если необходимо найти тесты со 
значениями полей, точно совпадающими со значением в поле Value to Find.

 5 Установите флажок Case Sensitive, чтобы поиск выполнялся с учетом 
прописных и строчных символов.

 6 Если необходимо использовать звездочки (*) в строке поиска, чтобы 
вводить только часть элемента, установите флажок Use Wildcard.

 7 Нажмите кнопку Find Next. При успешном завершении поиска 
соответствующий тест будет выделен в таблице. При неудачном 
завершении поиска откроется информационное окно.

 8 Чтобы найти следующий тест, удовлетворяющий критериям поиска, еще 
раз нажмите кнопку Find Next.
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Замена значений полей в таблице выполнения
С помощью команды Replace можно заменять значения полей в таблице 
выполнения.

Чтобы заменить значение поля в таблице выполнения, выполните 
следующие действия.

 1 Выберите команду Tests > Replace. Откроется диалоговое окно 
Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск определенного значения. 

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение для замены.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы найти точное совпадение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы, установите флажок From 
Beginning.

 8 Чтобы использовать в строке поиска символ звездочки (*) и вводить только 
часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажимите кнопку Replace.
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 10 Чтобы заменить все экземпляры значения в таблице, нажмите кнопку 
Replace All.

Удаление тестов из набора тестов
Предусмотрена возможность удаления тестов из набора тестов.

Чтобы удалить тест из набора тестов, выполните следующие 
действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов. Тесты отображаются в таблице Execution Grid или на схеме 
Execution Flow.

 2 Выберите тест, который необходимо удалить. Чтобы удалить несколько 
тестов из таблицы выполнения или схемы выполнения, нажмите клавишу 
CTRL и выберите тесты, которые необходимо удалить.

 3 Нажмите кнопку Remove Tests from Test Set.

 4 Нажмите кнопку Yes для подтверждения. 

Копирование наборов тестов в проекте
Можно копировать набор тестов внутри проекта. Информация о 
выполнении тестов не копируется. 

Чтобы скопировать набор тестов внутри проекта, выполните 
следующие действия.

 1 Выберите набор тестов или папку наборов тестов в дереве наборов тестов. 
Чтобы скопировать несколько наборов тестов или папок, используйте 
клавишу CTRL.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy.

 3 Выберите папку, в которую необходимо скопировать набор тестов или 
папку объектов тестирования.

 4 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste.
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Копирование наборов тестов между проектами
Можно копировать наборы тестов из одного проекта в другой. Если набор 
тестов содержит вызовы других тестов, или если наборы тестов зависят от 
ресурсов тестов, можно выбрать в Quality Center один из следующих 
способов копирования.

➤ Копирование наборов тестов и установление связи с существующими 
вызываемыми тестами и ресурсами тестов в целевом проекте. Если 
вызываемый тест или ресурс теста отсутствует в целевом проекте, 
Quality Center скопирует его в целевой проект.

➤ Копирование наборов тестов вместе с вызываемыми тестами и 
связанными ресурсами тестов в целевой проект. 

➤ Копирование наборов тестов без вызываемых тестов и связанных ресурсов 
тестов в целевой проект.

Примечания.

➤ Чтобы копировать наборы тестов или папки наборов тестов между 
проектами, оба проекта должны иметь одну и ту же версию и уровень 
исправлений Quality Center.

➤ При копировании наборов тестов или папок наборов тестов информация 
о выполнении тестов не копируется.

Дополнительные сведения связанных объектах см. в разделе “Просмотр 
зависимостей" на стр. 395.

Чтобы скопировать набор тестов между проектами, выполните 
следующие действия.

 1 В дереве набора тестов выберите набор тестов или папку наборов тестов. 
Чтобы скопировать несколько наборов тестов или папок, воспользуйтесь 
клавишей CTRL.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy.

 3 Откройте другой экземпляр Quality Center и войдите в проект, в который 
необходимо вставить тесты.
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 4 Выберите папку, в которую необходимо скопировать наборы тестов или 
папки наборов тестов.

 5 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste. Откроется диалоговое окно Paste 
Test Sets/Test Set Folders to Target Project. 

 6 Выберите один из следующих вариантов.

➤ Copy test sets/test set folders and link to existing related entities. 
Quality Center копирует наборы тестов или папки наборов тестов и 
вставляет их в целевой проект. Скопированные наборы тестов или 
папки наборов тестов будут связаны с существующими ресурсами 
тестов и вызываемыми тестами с тем же именем и путем. Если 
соответствующий ресурс теста или тест отсутствует в целевом проекте, 
Quality Center скопирует его в целевой проект.

➤ Copy test sets/test set folders and related entities. Quality Center 
копирует наборы тестов или папки наборов тестов вместе со 
связанными ресурсами тестов и вызываемыми тестами и вставляет их в 
целевой проект. Если соответствующий ресурс или вызываемый тест 
уже существует в целевом проекте, скопированный связанный ресурс 
теста или вызываемый тест будет переименован для разрешения 
конфликта имен.

➤ Copy test sets/test set folders and related entities. Quality Center 
копирует наборы тестов или папки наборов тестов без связанных 
ресурсов тестов и вызываемых тестов и вставляет их в целевой проект. 
Скопированные элементы не будут связаны с какими-либо объектами.

Нажмите кнопку ОK. 

Копирование URL-адресов наборов тестов
Можно скопировать набор тестов и вставить его URL-адрес как ссылку. При 
этом сам набор тестов не копируется. Вместо этого можно вставить адрес в 
другое место, такое как сообщение электронной почты или документ. Если 
щелкнуть эту ссылку, откроется окно Quality Center, в котором будет 
показан набор тестов. 
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Чтобы скопировать URL-адрес набора тестов, выполните следующие 
действия.

 1 Выберите набор тестов в дереве или в таблице наборов тестов. 

 2 Выберите команду Edit > Copy URL. Также можно щелкнуть элемент 
правой кнопкой мыши и выбрать команду Copy URL.

 3 Вставьте URL-адрес.

Переименование наборов тестов
Набор тестов или папку наборов тестов можно переименовывать. Учтите, 
что переименовать набор тестов по умолчанию нельзя.

Чтобы переименовать набор тестов, выполните следующие действия.

 1 В дереве наборов тестов или в таблице наборов тестов выберите набор 
тестов или папку наборов тестов.

 2 Щелкните правой кнопкой мыши набор тестов или папку наборов тестов, а 
затем выберите команду Rename.

 3 Измените имя набора тестов, а затем нажмите клавишу ENTER. 
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Удаление папок наборов тестов
Можно удалить папку и переместить все наборы тестов этой папки в папку 
Unattached или удалить папку вместе со всеми наборами тестов этой 
папки без возможности восстановления.

Чтобы удалить папку наборов тестов, выполните следующие 
действия.

 1 Выберите папку в дереве наборов тестов. Чтобы удалить несколько папок, 
нажмите клавишу CTRL и выберите папки, которые необходимо удалить.

 2 Нажмите кнопку Delete или выберите команду Edit > Delete. Откроется 
диалоговое окно Confirm Delete Folder.

 3 Возможны следующие варианты удаления.

➤ Выберите вариант Delete folders only, чтобы удалить папку и 
переместить все наборы тестов этой папки в папку Unattached. Папка 
Unattached содержит все наборы тестов, которые больше не связаны с 
какой-либо папкой.

➤ Выберите вариант Delete folders and test sets, чтобы удалить папку и 
все наборы тестов этой папки без возможности восстановления.

 4 Нажмите кнопку Yes для подтверждения.
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Удаление наборов тестов
Из проекта можно удалять наборы тестов. Учтите, что удалить набор 
тестов по умолчанию нельзя.

Чтобы удалить набор тестов, выполните следующие действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов. Чтобы удалить несколько наборов тестов, нажмите клавишу CTRL и 
выберите наборы тестов, которые необходимо удалить.

 2 Нажмите кнопку Delete или выберите команду Edit > Delete.

 3 Нажмите кнопку Yes для подтверждения. 

Сброс наборов тестов
После сброса набора тестов для всех тестов набора устанавливается 
статус No Run. При сбросе набора тестов можно также удалить результаты 
выполнения тестов. 

Чтобы сбросить набор тестов, выполните следующие действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Выберите команду Test Sets > Reset Test Set. Откроется диалоговое окно 
Confirm Reset Test Set.

 3 Чтобы не удалять результаты выполнения набора тестов в модуле Test 
Lab, снимите флажок Delete all the test run results in test set.

 4 Нажмите кнопку Yes для подтверждения.
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Удаление результатов выполнения тестов из набора 
тестов 
С помощью мастера Purge Runs можно удалять из проекта старые 
результаты выполнения тестов.

Чтобы удалить результаты выполнения тестов из набора тестов, 
выполните следующие действия.

 1 Выберите команду Test Sets > Purge Runs. Откроется диалоговое окно 
Select Test Sets to Purge, в котором можно выбрать наборы тестов, 
результаты выполнения которых необходимо удалить.

С помощью кнопок со стрелками переместите имена соответствующих 
наборов тестов из списка Available Test Sets в список Selected Test Sets. 

Совет. Наборы тестов также можно перетаскивать из одного списка в 
другой.
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 2 Нажмите кнопку Next. Откроется диалоговое окно Choose Type of Purge, в 
котором можно выбрать тип удаления и определить условия удаления.

 3 Удаление шагов выполнения без удаления общих сведений о выполнении.

➤ В поле Delete выберите значение Run Steps Only. 

➤ В разделе From runs older than выберите период времени. Более 
ранние шаги выполнения будут удалены.

 4 Удаление результатов выполнения тестов.

➤ В поле Delete выберите значение Runs. 

➤ В разделе From runs older than выберите период времени. Более 
ранние результаты выполнения тестов будут удалены. 

➤ В поле Keep last выберите количество результатов выполнений, 
которые необходимо сохранить для каждого теста.
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 5 Нажмите кнопку Next. Откроется диалоговое окно Confirm Purge Request со 
сводкой выбранных операций удаления.

 6 Нажмите кнопку Purge, чтобы подтвердить удаление.
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29
Планирование выполнения тестов

Модуль Test Lab позволяет управлять выполнением тестов из набора.

Эта глава содержит следующие разделы.

 ➤  О планировании выполнения тестов на стр. 455

 ➤  Планирование выполнения тестов на стр. 457

 ➤  Изменение расписания выполнения тестов на стр. 460

 ➤  Определение последовательности тестов на стр. 463

 ➤  Поиск тестов на стр. 464

 ➤  Просмотр схемы выполнения на стр. 464

О планировании выполнения тестов 
На схеме выполнения можно указать дату, время и условия выполнения 
теста. В основе условия лежат результаты выполнения другого теста, 
указанного в схеме выполнения. Задавая условия, можно указать модулю 
Test Lab отложить выполнение текущего теста до завершения или 
успешного выполнения другого определенного теста. Также можно 
установить последовательность выполнения тестов. 

Например, в наборе тестов можно указать, что тест test2 должен 
выполняться только в том случае, если тест test1 не обнаружил ошибок, а 
тест test3 должен выполняться только в том случае, если тест test2 не 
обнаружил ошибок. 
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В отличие от таблицы выполнения, которая содержит тесты и информацию 
об их выполнении, схема выполнения показывает тесты и условия в виде 
схемы.

Набор тестов на схеме выполнения изображается значком . Каждый тест 
на этой схеме представлен значком теста. 

Штриховая линия со стрелкой  означает, что тест должен 
выполняться после предыдущего теста без каких-либо условий. 

Сплошная линия со стрелкой  обозначает условие. Эта линия 
может быть синей или зеленой. Если сплошная линия имеет синий цвет, 
тест должен выполняться только в том случае, если предыдущий тест 
имеет статус Finished. Если сплошная линия имеет зеленый цвет, тест 
должен выполняться только в том случае, если предыдущий тест имеет 
статус Passed.

Если тест зависит от времени, то на схему добавляется значок 
зависимости от времени  . 
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Планирование выполнения тестов 
На вкладке Execution Flow можно видеть процесс выполнения тестов и 
управлять ходом их выполнения. Можно указать, при каких условиях 
(условия выполнения) и в какое время (временная зависимость) 
должен выполняться тест.

Сведения о выполнении тестов см. в разделах “Выполнение тестов 
вручную" на стр. 467 и “Автоматическое выполнение тестов" на стр. 477.

Чтобы запланировать выполнение тестов, выполните следующие 
действия.

 1 На вкладке Execution Flow дважды щелкните тест. Также можно щелкнуть 
тест правой кнопкой мыши и выбрать команду Test Run Schedule. 
Откроется диалоговое окно Run Schedule, в котором будет показана 
вкладка Execution Conditions.
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 2 Чтобы добавить условие, нажмите кнопку New. Откроется диалоговое окно 
New Execution Condition.

 3 В поле Test выберите тест, от которого должен зависеть текущий тест.

➤ Выберите Finished (это значение установлено по умолчанию), чтобы 
модуль Test Lab выполнял текущий тест только после завершения 
выполнения указанного теста.

➤ Выберите Passed, чтобы модуль Test Lab выполнял текущий тест 
только после того как указанный тест завершится со статусом Passed.

 4 В поле Comments добавьте сведения об условии.

 5 Нажмите кнопку ОK. Условие будет добавлено в список.

Совет. Условие также можно добавить непосредственно на вкладке 
Execution Flow. Щелкните значок теста (не имя теста) и перетащите стрелку 
к другому тесту. По умолчанию устанавливается условие Finished. Чтобы 
изменить это условие, дважды нажмите стрелку условия и выберите 
Passed. 
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 6 Перейдите на вкладку Time Dependency, если необходимо указать время 
выполнения теста.

 7 Выберите команду Run At Specified Time, а затем выберите дату в поле 
Date и (или) время в поле Time.

Совет. Запланировать дату и время выполнения теста можно также 
следующим способом: нажмите кнопку Add Time Dependency To Flow  и 
свяжите стрелку от значка с тестом. Дважды щелкните значок, чтобы 
установить время в диалоговом окне Time Dependency. По умолчанию для 
временной зависимости используется текущая дата и время сервера 
Quality Center.

 8 Чтобы закрыть диалоговое окно Run Schedule, нажмите кнопку OK. На 
схеме выполнения будут показаны тесты и условия. 
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Изменение расписания выполнения тестов
В расписании запуска тестов можно изменять и удалять условия и 
сведения о временной зависимости.

Данный раздел содержит следующие подразделы.

➤ Изменение условий выполнения

➤ Удаление условий выполнения

➤ Изменение временной зависимости

➤ Удаление временной зависимости

➤ Удаление всех условий и зависимостей

Изменение условий выполнения
Можно изменять условия выполнения теста.

Чтобы изменить условие выполнения теста, выполните следующие 
действия.

 1 На схеме выполнения дважды нажмите стрелку условия. Также можно 
щелкнуть стрелку условия правой кнопкой мыши и выбрать команду 
Execution Condition. Откроется диалоговое окно Execution Condition.

 2 Измените необходимые параметры условия и нажмите кнопку OK.
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Удаление условий выполнения
Можно удалять одно условие или все условия, связанные с тестом. 

Чтобы удалить условие выполнения теста, выполните следующие 
действия.

 1 На схеме выполнения щелкните правой кнопкой мыши стрелку условия и 
выберите команду Remove Execution Condition.

 2 Нажмите кнопку Yes для подтверждения. Стрелка условия будет удалена.

Чтобы удалить все условия выполнения теста, выполните 
следующие действия.

 1 На схеме выполнения щелкните тест правой кнопкой мыши и выберите 
команду Remove Test’s Execution Conditions.

 2 Нажмите кнопку Yes для подтверждения. Будут удалены все соединяющие 
стрелки.

Изменение временной зависимости
Можно изменять дату и время запланированного выполнения теста.

Чтобы изменить временную зависимость, выполните следующие 
действия.

 1 На схеме выполнения дважды щелкните связанный с тестом значок Time 
Dependency . Откроется диалоговое окно Time Dependency. 

 2 Измените дату и (или) время, а затем нажмите кнопку OK.
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Удаление временной зависимости
Можно удалять указанную ранее временную зависимость.

Чтобы удалить временную зависимость, выполните следующие 
действия.

 1 На схеме выполнения щелкните правой кнопкой мыши связанный с тестом 
значок Time Dependency  и выберите команду Remove Time 
Dependency. 

 2 Нажмите кнопку Yes для подтверждения. Значок временной зависимости 
будет удален из схемы выполнения.

Удаление всех условий и зависимостей
Можно удалить все условия выполнения и временные зависимости набора 
тестов.

Чтобы удалить все условия выполнения набора тестов, выполните 
следующие действия.

 1 Щелкните правой кнопкой мыши схему выполнения и выберите команду 
Remove All Execution Conditions.

 2 Если набор тестов содержит не только условия выполнения, но и 
временные зависимости, откроется диалоговое окно Remove All Execution 
Conditions.

Выберите один из следующих вариантов.

➤ Run conditions and time dependencies. Из набора тестов удаляются 
все условия выполнения и временные зависимости.

➤ Run conditions only. Из набора тестов удаляются условия выполнения.

➤ Time dependencies only. Из набора тестов удаляются временные 
зависимости.

Нажмите кнопку ОK. Условия выполнения и (или) временные зависимости 
будут удалены.

 3 Если набор тестов содержит только условия выполнения или только 
временные зависимости, откроется диалоговое окно подтверждения. 
Нажмите кнопку Yes для подтверждения. Условия выполнения или 
временные зависимости будут удалены.
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Определение последовательности тестов 
На схеме выполнения можно изменить порядок выполнения показанных 
тестов.

Чтобы установить последовательность выполнения тестов, 
выполните следующие действия.

 1 Нажмите клавишу CTRL и выберите несколько тестов на схеме выполнения.

 2 Щелкните тест правой кнопкой мыши и выберите команду Order Tests. 
Откроется диалоговое окно Order Tests. 

 3 Выберите тест в списке и с помощью кнопок со стрелками вверх и вниз 
измените положение теста в последовательности.

 4 Нажмите кнопку ОK. 
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Поиск тестов 
На схеме выполнения можно найти нужный тест.

Чтобы найти тест, выполните следующие действия.

 1 Нажмите кнопку Find Test In Flow на панели инструментов или выберите 
команду Edit > Find Test in Flow. Откроется диалоговое окно Find Test.

В поле Value To Find введите имя или часть имени теста. При поиске 
регистр не учитывается.

 2 Нажмите кнопку Find. Модуль Test Lab выполнит поиск теста.

 3 При успешном завершении поиска откроется диалоговое окно Search 
Results со списком возможных совпадений. Выберите результат из списка и 
нажмите кнопку Go To, чтобы выделить тест на схеме выполнения. 

Нажмите кнопку Keep on Top, чтобы диалоговое окно Find Results 
отображалось поверх других открытых окон. 

Нажмите кнопку Not on Top, чтобы выбранное окно отображалось поверх 
диалогового окна Find Results.

 4 При неудачном завершении поиска откроется информационное окно. 

Просмотр схемы выполнения
Вид схемы выполнения можно изменять. Например, можно увеличивать 
или уменьшать схему, упорядочивать тесты в иерархическом порядке, 
обновлять схему и отображать на схеме полные имена тестов. Можно 
также копировать схему в буфер обмена.

Компоновка
Нажмите кнопку Arrange Layout, чтобы упорядочить тесты в 
иерархическом порядке. Такой вид схемы позволяет просматривать 
зависимости между тестами.

Увеличение
Нажмите кнопку Zoom In, чтобы увеличить масштаб схемы.
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Уменьшение
Нажмите кнопку Zoom Out, чтобы уменьшить масштаб схемы.

Изображение по размеру окна
Нажмите кнопку Fit Picture in Window, чтобы изменить масштаб для 
отображения всей схемы в окне. Можно также щелкнуть стрелку вниз, 
чтобы выбрать нужный масштаб.

➤ Выберите масштаб, например 25%, 50%, 150% или 200%.

➤ Выберите Normal, чтобы отобразить схему в масштабе 100%.

➤ Выберите вариант Fit In Window, если необходимо, чтобы вся схема 
поместилась в окне.

➤ Выберите Custom Zoom, чтобы указать масштаб. В диалоговом окне 
Custom Zoom введите масштаб и нажмите кнопку Zoom.

Обновление схемы
Нажмите кнопку Refresh Flow, чтобы обновить схему выполнения для 
отображения наиболее актуальных сведений о тестах.

Отображение полных имен тестов
Выберите команду Tests > Flow > Show Full Test Names, чтобы показать 
на схеме выполнения полные имена тестов. По умолчанию длинные имена 
обрезаются.

Копирование в буфер обмена
Выберите команду Tests > Flow > Copy to Clipboard, чтобы скопировать 
схему выполнения в буфер обмена как точечный рисунок.
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30
Выполнение тестов вручную

При выполнении тестов вручную выполняются операции с тестируемым 
приложением в соответствии с шагами теста. Статус Passed или Failed 
каждого шага теста определяется соответствием результатов работы 
приложения ожиданиям. Вручную можно выполнять как ручные, так и 
автоматизированные тесты.

Эта глава содержит следующие разделы.

 ➤  О выполнении тестов вручную на стр. 467

 ➤  Выполнение теста вручную на стр. 468

 ➤  Изменение шагов тестов на стр. 474

 ➤  Возобновление ручного выполнения теста на стр. 475

О выполнении тестов вручную
Тесты можно выполнять вручную, следуя шагам тестов, определенным при 
планировании тестирования. 

 1 Выполните операции в тестируемом приложении. Следуйте инструкциям, 
приведенным в описании шагов тестов.

 2 Сравните фактические результаты с ожидаемыми. Выполняя шаги, 
проверьте, правильно ли реагирует приложение.

 3 В зависимости от того, соответствуют ли фактические результаты 
тестирования приложения ожидаемым, назначьте каждому шагу статус 
Passed или Failed. 
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 4 Если при выполнении шага обнаружена ошибка в приложении, опишите 
поведение приложения при этой ошибке. Тест получает статус Failed, если 
этот статус получил хотя бы один шаг.

Тесты из одного и того же набора можно выполнять многократно. Каждое 
повторное выполнение теста считается новым выполнением. 

После завершения выполнения теста можно просмотреть сводку 
результатов тестирования в модуле Test Lab. Новый статус выполненного 
теста появляется в таблице выполнения. Результаты каждого шага теста 
отображаются в области Last Run Result. Подробные результаты 
отображаются в диалоговом окне Test Instance Properties. Дополнительные 
сведения о просмотре результатов тестирования см. в Глава 32, "Просмотр 
результатов выполнения тестов"..

Выполнение теста вручную 
При выполнении теста вручную выполняются операции с тестируемым 
приложением в соответствии с шагами теста. Необходимо сравнивать 
фактические результаты с ожидаемыми и записывать результаты 
сравнения. Один и тот же тест можно выполнять многократно. При этом 
отдельно сохраняются результаты каждого выполнения теста. Вручную 
можно выполнять как ручные, так и автоматизированные тесты.

При выполнении тестов вручную можно изменять шаги теста. Эти 
изменения можно сохранять в исходном тесте в модуле Test Plan и в 
экземпляре теста в модуле Test Lab. Можно также сохранять изменения 
только для текущего выполнения теста. Дополнительные сведения см. в 
разделе “Изменение шагов тестов" на стр. 474.

Если выполнение теста вручную было приостановлено, его можно 
продолжить. Дополнительные сведения см. в разделе “Возобновление 
ручного выполнения теста" на стр. 475.

Примечание. Сведения о выполнении тестов бизнес-процессов см. в HP 
Business Process Testing User Guide.
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Чтобы выполнить тест вручную, выполните следующие действия.

 1 На вкладке Execution Grid или Execution Flow выберите тесты, которые 
необходимо выполнить вручную. 

➤ Если необходимо выполнить только один ручной тест, выберите тест и 
нажмите кнопку Run.

➤ Если необходимо выполнить более одного ручного теста, выберите 
нужные тесты и нажмите кнопку Run. Откроется диалоговое окно Manual 
Test Run.

По умолчанию выбран вариант Manual Runner (Run according to the 
order in the Execution Grid). В этом случае тесты выполняются в том 
порядке, в котором они показаны в таблице выполнения.

Чтобы выполнить ручные тесты автоматически, выберите вариант 
Automatic Runner (Run according to the order in the Execution Flow). В 
этом случае тесты выполняются в том порядке, в котором они показаны 
на схеме выполнения. Дополнительные сведения об автоматическом 
выполнении тестов см. в разделе“Автоматическое выполнение тестов" 
на стр. 478.

Чтобы отключить диалоговое окно Manual Test Run при следующем 
выполнении ручных тестов, установите флажок Don’t show this again. 
Чтобы включить отображение этого окна, выберите команду Tests > 
Enable Manual Test Run Confirmation. 

Нажмите кнопку OK. 

➤ Чтобы выполнить автоматизированные тесты вручную, выберите тесты, 
нажмите стрелку Run, а затем выберите команду Run Manually. 
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Откроется диалоговое окно Manual Runner.

 2 В области Run Details можно изменить следующую информацию о 
выполнении.

➤ Run Name. Имя выполнения теста.

➤ Tester. Имя пользователя, выполняющего тест.

 3 Чтобы просмотреть информацию об операционной системе, щелкните 
ссылку Operating System Info. Откроется диалоговое окно Operating 
System Information.
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В этом окне можно изменять следующую информацию об операционной 
системе.

➤ Operating System. Операционная система, установленная на 
компьютере, на котором выполняются шаги теста. По умолчанию 
отображается операционная система клиентского компьютера 
Quality Center.

➤ OS Service Pack. Пакет обновлений операционной системы.

➤ OS Build Number. Номер сборки операционной системы.

 4 В области Test Details можно увидеть следующую информацию о тесте. 
Щелкните ссылку More, чтобы открыть диалоговое окно Test Properties, 
содержащее сведения о тесте и вложения. Дополнительные сведения о 
свойствах тестов см. в Глава 18, "Создание дерева плана тестирования"..

 5 Чтобы добавить вложения к выполнению теста, нажмите кнопку Attach to 
Run. Вложение может представлять собой файл, URL-адрес, снимок 
приложения, содержимое из буфера обмена или сведения о системе. 
Дополнительные сведения о вложениях см. в Глава 5, "Добавление 
вложений"..

 6 Чтобы добавить дефект к выполнению теста, нажмите кнопку New Defect. 
Откроется диалоговое окно New Defect. Quality Center автоматически 
создает связь между выполнением теста и новым дефектом. 
Дополнительные сведения см. в Глава 35, "Добавление и отслеживание 
дефектов" и Глава 36, "Связывание дефектов".

 7 Чтобы завершить выполнение теста, нажмите кнопку End Run. 
Quality Center сохранит результаты выполнения теста. Чтобы полностью 
отменить выполнение теста, нажмите кнопку Cancel Run, а затем нажмите 
кнопку No для подтверждения.

 8 Чтобы начать выполнение теста, нажмите кнопку Begin Run.

Если выполняемый тест содержит параметры, которым не были присвоены 
фактические значения, откроется диалоговое окно Parameters of Test Run. 
Присвойте параметрам фактические значения. Дополнительные сведения 
см. в разделе “Назначение фактических значений" на стр. 358.
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Откроется диалоговое окно Manual Runner: Step Details.

Список Filter by позволяет фильтровать шаги теста по столбцу Status.

Совет. Удобно просматривать сведения о каждом шаге теста и записывать 
результаты его выполнения в компактном представлении этого 
диалогового окна. Чтобы открыть это представление, нажмите кнопку 
Compact View. Чтобы вернуться к таблице шагов, нажмите кнопку Back to 
Steps Grid.

 9 Если шагов теста нет или требуется изменить шаги, измените их до начала 
их выполнения. Дополнительные сведения см. в разделе “Изменение шагов 
тестов" на стр. 474.

 10 Чтобы просмотреть значения параметров теста, нажмите кнопку Show 
Parameters. Откроется диалоговое окно Parameter Values for Run.



Глава 30 • Выполнение тестов вручную

473

 11 Откройте тестируемое приложение и выполните первый шаг теста.

➤ Нажмите кнопку Pass Selected, если фактический результат совпадает 
с ожидаемым. Шаг получит статус Passed и будет помечен зеленым 
флажком. (Чтобы установить статус Passed сразу для всех шагов теста, 
нажмите стрелку Pass Selected и выберите команду Pass All.)

➤ Если фактический результат отличается от ожидаемого, введите 
фактический результат в поле Actual и нажмите кнопку Fail Selected. 
Шаг получит статус Failed и будет помечен красным знаком "X". (Чтобы 
установить статус Failed сразу для всех шагов теста, нажмите стрелку 
Fail Selected и выберите команду Fail All.)

 12 Чтобы добавить вложения к шагу теста, нажмите кнопку Attachments. 
Чтобы добавить вложения ко всему выполнению теста, нажмите стрелку 
Attachments, а затем выберите команду Attach to Run. Дополнительные 
сведения о вложениях см. в Глава 5, "Добавление вложений"..

 13 Если при выполнении теста обнаружена ошибка в приложении, нажмите 
кнопку New Defect. Откроется диалоговое окно New Defect, в котором 
можно добавить дефект. Quality Center автоматически создает связь между 
выполнением теста и новым дефектом. Дополнительные сведения см. в 
разделах “Добавление новых дефектов" на стр. 531 и “Связывание 
дефектов" на стр. 551.

 14 Нажмите кнопку Keep on Top, чтобы диалоговое окно Manual Runner: Step 
Details отображалось поверх других открытых окон. Нажмите кнопку Not on 
Top, чтобы выбранные окна отображались поверх диалогового окна Manual 
Runner: Step Details.

 15 Выполните оставшиеся шаги.

 16 Нажмите кнопку End Run после завершения выполнения теста или чтобы 
приостановить выполнение теста. Сведения о том, как продолжить 
выполнение приостановленного ручного теста см. в разделе 
“Возобновление ручного выполнения теста" на стр. 475.
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Изменение шагов тестов 
При выполнении теста в диалоговом окне Manual Runner: Step Details 
можно добавлять, удалять и изменять шаги теста. По окончании 
выполнения теста можно сохранить измененные шаги. 

Чтобы изменить шаг теста, выполните следующие действия.

 1 Откройте диалоговое окно Manual Runner: Step Details. Дополнительные 
сведения см. в разделе “Выполнение теста вручную" на стр. 468.

 2 Нажмите кнопку Add Step, чтобы добавить шаг. Будет добавлен новый шаг 
с именем по умолчанию. В поле Description можно ввести сведения о 
новом шаге.

 3 Нажмите кнопку Delete Selected, чтобы удалить выбранный шаг или 
несколько шагов, а затем нажмите кнопку Yes для подтверждения.

 4 Чтобы закрыть диалоговое окно, нажмите кнопку End Run. Откроется окно 
сообщения. 

 5 Нажмите кнопку Yes, чтобы сохранить изменения и обновить тест в 
модулях Test Plan и Test Lab. Нажмите кнопку No, чтобы сохранить 
изменения только в текущем выполнении теста.

Модуль Test Lab позволяет обновлять изменения вызываемых тестов 
только в текущем выполнении теста. Изменения не затрагивают 
вызываемые тесты. Дополнительные сведения о вызываемых тестах см. в 
разделе “Управление шагами теста" на стр. 344.
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Возобновление ручного выполнения теста 
Если выполнение ручного теста было приостановлено, его можно 
продолжить позже. 

Примечание. Команда Continue Manual Run возобновляет последнее 
выполнение выбранного теста. Если необходимо продолжить предыдущее 
выполнение теста, нажмите кнопку Test Instance Properties, выберите All 
Runs на боковой панели, а затем выберите выполнение, которое 
необходимо продолжить. Нажмите кнопку Continue.

Чтобы продолжить выполнение ручного теста, выполните 
следующие действия.

 1 На вкладке Execution Grid или Execution Flow выберите тест, выполнение 
которого необходимо продолжить.

 2 Выберите команду Tests > Continue Manual Run. Также можно нажать 
стрелку Run и выбрать команду Continue Manual Run. Откроется 
диалоговое окно Manual Runner с выбранным тестом.

 3 Продолжайте выполнение теста.
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31
Автоматическое выполнение тестов

Можно выполнять тесты автоматически непосредственно в Quality Center. 
Выполнять тесты можно как на своем компьютере, так и на удаленных 
хостах.

Эта глава содержит следующие разделы.

 ➤  Об автоматическом выполнении тестов на стр. 477

 ➤  Автоматическое выполнение тестов на стр. 478

 ➤  Просмотр журнала выполнения на стр. 483

 ➤  Настройка хостов для удаленного выполнения тестов на стр. 485

 ➤  Упорядочивание тестов в таблице выполнения на стр. 487

 ➤  Поиск и замена значений в таблице выполнения на стр. 489

Об автоматическом выполнении тестов
Выполнять тесты автоматически можно как на своем компьютере, так и на 
удаленных хостах. Хостом называется любой подключенный к сети 
компьютер, на котором установлено средство тестирования.

Выбрать тесты для выполнения можно на вкладке Execution Grid или 
Execution Flow. Можно выполнять все тесты из набора тестов или только 
определенные тесты, причем среди выбранных тестов могут быть как 
автоматизированные, так и ручные тесты. Выбранные тесты отображаются 
в диалоговом окне Automatic Runner. 
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При выполнении автоматизированного теста Quality Center автоматически 
открывает выбранное средство тестирования, выполняет тест на 
локальном компьютере или на удаленных хостах, а затем экспортирует 
результаты тестирования в Quality Center. 

При выполнении ручного теста из диалогового окна Automatic Runner, 
Quality Center уведомляет соответствующего тестировщика по электронной 
почте о необходимости выполнения теста на указанном хосте.

Можно также запустить автоматизированный системный тест для 
получения сведений о системе, захвата снимка экрана или перезагрузки 
компьютера. Дополнительные сведения о системных тестах см. в Глава 23, 
"Работа с системными тестами".

Автоматическое выполнение тестов
При выполнении автоматизированного теста Quality Center автоматически 
открывает выбранное средство тестирования, выполняет тест, а затем 
экспортирует результаты тестирования в Quality Center. При выполнении 
ручного теста соответствующий тестировщик получает сообщение 
электронной почты с указанием необходимости выполнения ручного теста.

Можно выполнить весь набор тестов или определенные тесты из набора, 
включая как автоматизированные, так и ручные тесты. Выбранные тесты 
отображаются в диалоговом окне Automatic Runner.

При автоматическом выполнении тестов необходимо учитывать 
следующее.

➤ Перед выполнением теста на удаленном хосте необходимо настроить 
хосты в диалоговом окне Host Manager. Дополнительные сведения см. в 
разделе “Настройка хостов для удаленного выполнения тестов" на 
стр. 485.

➤ Чтобы выполнить один тест одновременно на нескольких удаленных 
хостах, добавьте в набор тестов несколько экземпляров этого теста. 
Дополнительные сведения см. в разделе “Добавление тестов в набор 
тестов" на стр. 431.
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➤ Чтобы выполнить несколько наборов тестов одновременно на 
нескольких удаленных хостах, откройте новый экземпляр диалогового 
окна Automatic Runner для каждого набора тестов.

➤ Чтобы выполнять тесты QuickTest Professional и WinRunner на 
удаленном хосте из Quality Center, откройте соответствующее 
приложение на удаленном хосте, а затем выберите требуемый вариант. 
Более подробные сведения см. в Руководстве пользователя 
HP QuickTest Professional или в Руководстве пользователя HP 
WinRunner.

➤ Если тест WinRunner выполняется в пакетном режиме, то каждый тест, 
вызываемый из пакетного теста, считается отдельным тестом, а не 
частью самого пакетного теста. Любой тест, вызванный из пакетного 
теста, еще не включенного в набор тестов, добавляется в этот набор 
тестов после завершения выполнения тестов.

Пользователи QuickTest Professional должны учитывать следующее.

➤ Перед выполнением теста QuickTest Quality Center загружает 
надстройки QuickTest, связанные с выбранным тестом. Убедитесь, что 
эти надстройки QuickTest установлены на компьютере, на котором будет 
выполняться тест. Дополнительные сведения о работе с надстройками 
и списками связанных надстроек в QuickTest см. в документации 
QuickTest Professional и в документации соответствующих надстроек 
QuickTest.

➤ Тесты QuickTest Professional, которые выполняются из модуля Test Lab, 
автоматически выполняются в режиме Fast. Они не могут выполняться 
в режиме Normal.

Чтобы выполнить тесты автоматически, выполните следующие 
действия.

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Можно указать условия и запланировать дату и время выполнения тестов. 
Также можно установить порядок выполнения тестов. Дополнительные 
сведения см. в Глава 29, "Планирование выполнения тестов"..
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 3 Можно выполнять все тесты из набора тестов или только определенные 
тесты.

➤ Чтобы выполнить весь набор тестов, на вкладке Execution Grid или на 
вкладке Execution Flow нажмите кнопку Run Test Set. Также можно 
выбрать команду Test Sets > Run Test Set.

➤ Чтобы выполнить только выбранные тесты, на вкладке Execution Grid 
или на вкладке Execution Flow выберите один или несколько тестов, а 
затем нажмите кнопку Run. Также можно выбрать команду Tests > Run.

Откроется диалоговое окно Automatic Runner, в котором будут показаны 
выбранные тесты.
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 4 Тесты можно выполнять локально или удаленно.

➤ Чтобы выполнять тесты на локальном компьютере, установите флажок 
Run All Tests Locally.

➤ Чтобы выполнять тесты на удаленном компьютере, снимите флажок 
Run All Tests Locally. Для каждого теста необходимо выбрать хост. В 
столбце Run on Host щелкните нужную ячейку и нажмите кнопку обзора. 
Откроется диалоговое окно Select Host. В разделе <Any Host> можно 
выбрать хост, на котором должен выполняться тест.

Также можно выбрать группу хостов. Если выбрана группа хостов, 
Quality Center будет выполнять тест на первом доступном хосте из этой 
группы, а не на каждом хосте.

 5 Если необходимо создать журнал выполнения тестов в Quality Center, 
установите флажок Enable Log. Дополнительные сведения см. в разделе 
“Просмотр журнала выполнения" на стр. 483.
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 6 Чтобы выполнить выбранные тесты, нажмите кнопку Run. Чтобы 
выполнить все тесты, нажмите кнопку Run All в диалоговом окне Automatic 
Runner. 

Для автоматизированных тестов Quality Center автоматически открывает 
выбранное средство тестирования и выполняет тест. Выполнение теста 
начнется только тогда, когда выбранный хост будет доступен для 
выполнения тестов.

Для ручных тестов Quality Center уведомит соответствующего 
тестировщика по электронной почте о необходимости выполнения теста. 
Это уведомление может быть отправлено только в том случае, если для 
теста назначен тестировщик, и известен его адрес электронной почты. 
Чтобы назначить тестировщика, на вкладке Execution Grid найдите нужный 
тест, в столбце Responsible Tester щелкните соответствующую ячейку, а 
затем нажмите кнопку со стрелкой. Выберите имя из списка.

Ход выполнения теста отображается в столбце Status.

 7 Если потребуется прекратить выполнение теста до его завершения, 
нажмите кнопку Stop.

 8 Если перед запуском теста был установлен флажок Enable Log (см. шаг 5), 
можно просмотреть журнал выполнения, выбрав команду Run > View 
Execution Log. Дополнительные сведения см. в разделе “Просмотр 
журнала выполнения" на стр. 483.

 9 Чтобы закрыть диалоговое окно Automatic Runner, выберите команду Run > 
Exit.

 10 После того завершения выполнения тестов в Quality Center можно 
просматривать сводку результатов выполнения тестов. Новый статус 
каждого выполнения теста будет указан на вкладке Execution Grid после 
каждого выполнения теста. Результаты каждого шага теста отображаются 
в области Last Run Result. Подробные результаты отображаются в 
диалоговом окне Test Instance Properties. Более подробные сведения о 
результатах выполнения тестов см. в Глава 32, "Просмотр результатов 
выполнения тестов"..
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Просмотр журнала выполнения 
Журнал выполнения содержит информацию о выполненных тестах, в том 
числе название проекта, имя пользователя, имя набора тестов. Для 
каждого теста в журнал записывается дата и время выполнения, хост и 
описание выполнения.

Примечание. Просматривать журнал выполнения можно лишь в том 
случае, если перед выполнением теста был установлен флажок Enable 
Log в диалоговом окне Automatic Runner. Дополнительные сведения см. в 
описании шага 5 на стр. 481.
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Чтобы просмотреть журнал выполнения, выполните следующие 
действия.

 1 После выполнения теста в диалоговом окне Automatic Runner выберите 
команду Run > View Execution Log. Откроется диалоговое окно Execution 
Log.

 2 Чтобы отфильтровать журнал выполнения, выполните следующие 
действия.

➤ В раскрывающемся списке Test выберите тест, а затем нажмите кнопку 
Refresh. 

➤ В раскрывающемся списке Host выберите хост, а затем нажмите кнопку 
Refresh. 

 3 Чтобы просмотреть другой журнал выполнения, выберите команду Log > 
Open.
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 4 Чтобы удалить журнал выполнения, выберите команду Log > Delete. 
Нажмите кнопку Yes для подтверждения.

 5 Чтобы закрыть журнал выполнения, выберите команду Log > Exit.

Настройка хостов для удаленного выполнения тестов
Выполнять тесты можно на любом хосте, подключенном к сети. С помощью 
диалогового окна Host Manager можно создать список доступных хостов, на 
которых можно выполнять тесты. Можно также распределить хосты по 
группам для конкретного проекта.

Примечание. Если указана группа хостов для удаленного выполнения 
тестов, Quality Center будет выполнять тест на первом доступном хосте, а 
не на каждом хосте группы.
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Чтобы настроить хосты для удаленного выполнения тестов, 
выполните следующие действия.

 1 Выберите команду Test Sets > Host Manager. Откроется диалоговое окно 
Host Manager.

Если в списке Available Hosts нет хостов, нажмите кнопку Get Hosts on the 
Network. Quality Center просмотрит каталог "Сетевое окружение" и добавит 
все найденные хосты в список Available Hosts.

Чтобы синхронизировать хосты из списка Available Hosts с хостами из 
каталога "Сетевое окружение", нажмите стрелку Get Hosts on the Network 
и выберите команду Synchronize Hosts in the Project with Hosts on Net. 
Quality Center добавит найденные в каталоге "Сетевое окружение" хосты и 
удалит те хосты, которые не были найдены в этом каталоге.

 2 Чтобы добавить хост в список Available Hosts, нажмите кнопку New Host. 
Откроется диалоговое окно New Host. В поле Host Name введите имя 
хоста. В поле Description введите описание хоста. Нажмите кнопку ОK. 
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 3 Чтобы удалить хост из списка Available Hosts, выберите хост и нажмите 
кнопку Delete Host. Нажмите кнопку Yes для подтверждения.

 4 Чтобы создать группу хостов, нажмите кнопку New Host Group. Откроется 
диалоговое окно New Host Group. В поле Group Name введите имя группы 
хостов. В поле Description введите описание группы хостов. Нажмите 
кнопку ОK.

 5 Чтобы добавить хост в группу хостов, выберите группу из списка Host 
Group. Выберите хост из списка Available Hosts, а затем нажмите кнопку 
Add Host To Host Group. Также можно дважды щелкнуть группу.

 6 Чтобы удалить хост из группы хостов, выберите группу в списке Host 
Group. Выберите хост в списке Hosts in Group. Нажмите кнопку Remove 
Host From Host Group.

 7 Чтобы удалить группу хостов, выберите группу в списке Host Group. 
Нажмите кнопку Delete Host Group. Нажмите кнопку Yes для 
подтверждения.

 8 Чтобы закрыть диалоговое окно Host Manager, нажмите кнопку Close.

Упорядочивание тестов в таблице выполнения 
Порядок тестов в таблице выполнения можно изменить. Quality Center 
выполняет тесты в заданном порядке, группируя их по типу узла. 
Например, если указан порядок тестов test1, test2 и test3, то Quality Center 
сначала выполнит тесты test1 и test3, если они должны выполняться на 
одном и том же хосте, а затем выполнит тест test2, который будет 
выполняться на другом хосте.

Примечание. Определяя порядок запуска тестов, Quality Center сначала 
проверяет схему выполнения. Порядок, определенный в таблице 
выполнения, используется только в том случае, если в схеме выполнения 
не заданы условия. Дополнительные сведения о планировании тестов на 
схеме выполнения см. в Глава 29, "Планирование выполнения тестов"..
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Чтобы упорядочить тесты в таблице выполнения, выполните 
следующие действия.

 1 Выберите команду Tests > Order Tests. Откроется диалоговое окно Order 
Tests. 

 2 Выберите тест в списке и с помощью кнопок со стрелками вверх и вниз 
измените положение теста в последовательности. 

Совет. Тесты также можно перетаскивать вверх или вниз.

 3 Нажмите кнопку ОK.
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Поиск и замена значений в таблице выполнения 
В таблице выполнения можно выполнять поиск и замену значений полей.

Чтобы найти значение, выполните следующие действия.

 1 Выберите команду Tests > Find. Откроется диалоговое окно Find.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск определенного значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти.

 4 Если необходимо найти точное значение, установите флажок Exact Match.

 5 Чтобы выполнить поиск с учетом регистра, установите флажок Case 
Sensitive.

 6 Если необходимо использовать звездочки (*) в строке поиска, чтобы 
вводить только часть элемента, установите флажок Use Wildcard.

 7 Нажмите кнопку Find Next. Quality Center выполнит поиск тестов с 
указанным значением. При успешном завершении поиска тест будет 
выделен в таблице выполнения. При неудачном завершении поиска 
откроется информационное окно.
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Чтобы заменить значение, выполните следующие действия.

 1 Выберите команду Tests > Replace. Откроется диалоговое окно 
Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск определенного значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти.

 4 В поле Replace with введите или выберите значение для замены.

 5 Чтобы выполнить поиск с учетом регистра, установите флажок Case 
Sensitive.

 6 Если необходимо найти точное значение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы выполнения, установите 
флажок From Beginning.

 8 Если необходимо использовать звездочки (*) в строке поиска, чтобы 
вводить только часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить значение, выполните следующие действия.

➤ Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажмите кнопку Replace.

➤ Чтобы заменить все найденные элементы в таблице выполнения, 
нажмите кнопку Replace All.
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32
Просмотр результатов выполнения 
тестов

После выполнения экземпляров тестов проводится анализ результатов 
выполнения, позволяющий определить, какие экземпляры тестов 
завершились с ошибками, и какие шаги привели к этим ошибкам.

Эта глава содержит следующие разделы.

 ➤  О просмотре результатов выполнения тестов на стр. 492

 ➤  Просмотр результатов выполнения тестов на стр. 493

 ➤  Просмотр сведений о выполнении теста на стр. 495

 ➤  Сравнений результатов всех выполнений на стр. 498

 ➤  Просмотр конфигурации выполнения теста на стр. 501

 ➤  Просмотр связанных дефектов на стр. 506

 ➤  Просмотр истории выполнения теста на стр. 507



Глава 32 • Просмотр результатов выполнения тестов

492

О просмотре результатов выполнения тестов
После выполнения экземпляров тестов можно просмотреть результаты в 
Quality Center. Результаты выполнения тестов представляют собой 
значения статуса (пройден или не пройден) экземпляра теста и значения 
статуса (пройден или не пройден) для каждого шага экземпляра теста. Эти 
результаты помогают определить обнаружение дефекта в приложении. В 
некоторых случаях может оказаться, что шаг не был пройден из-за того, что 
ожидаемые результаты уже недействительны и требуют обновления. 

После выполнения ручного или автоматизированного теста можно 
просмотреть результаты и общие сведения о выполнении теста в таблице 
выполнения. В диалоговом окне Test Instance Properties можно 
просматривать результаты выполнения теста, сравнивать результаты 
последнего выполнения теста с результатами предыдущих выполнений, 
управлять вложениями, просматривать информацию о конфигурации 
выполнения теста, просматривать связанные дефекты и историю 
изменения выполнений теста.

Примечание. Дополнительные сведения о просмотре результатов 
выполнения системных тестов см. в Глава 23, "Работа с системными 
тестами"..

Кроме того, имеется возможность анализа хода выполнения набора тестов 
путем периодического создания отчетов и диаграмм. Дополнительные 
сведения см. в Глава 42, "Создание стандартных отчетов", Глава 41, 
"Создание диаграмм", и Глава 44, "Создание диаграмм анализа в реальном 
времени"..
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Просмотр результатов выполнения тестов
Результаты выполнения тестов можно просмотреть в диалоговом окне Test 
Instance Properties.

Чтобы просмотреть результаты тестов, выполните следующие 
действия.

 1 В таблице выполнения дважды щелкните тест или выберите экземпляр 
теста, а затем нажмите кнопку Test Instance Properties. Откроется 
диалоговое окно Test Instance Properties. По умолчанию отображается 
представление All Runs.

На схеме выполнения щелкните правой кнопкой мыши экземпляр теста и 
выберите команду Test Instance Properties. Откроется диалоговое окно 
Test Instance Properties. По умолчанию отображается представление 
Details.
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 2 Щелкните представление на боковой панели. Диалоговое окно Test 
Instance Properties содержит следующие представления.

Представление Описание

Details Сведения о выполнении экземпляра теста. 
Дополнительные сведения см. в разделе “Просмотр 
сведений о выполнении теста" на стр. 495.

All Runs Результаты всех выполнений тестов. Дополнительные 
сведения см. в разделе “Сравнений результатов всех 
выполнений" на стр. 498.

Attachments Просмотр вложений экземпляра теста. Также 
отображаются все вложения, которые были добавлены к 
тесту при планировании тестирования. Дополнительные 
сведения см. в Глава 5, "Добавление вложений"..

Configuration Сведения о конфигурации выполнения экземпляра теста. 
Дополнительные сведения см. в разделе “Просмотр 
конфигурации выполнения теста" на стр. 501. 

Linked Defects Просмотр связанных дефектов и покрытия требований 
для экземпляра теста. Дополнительные сведения см. в 
разделе “Просмотр связанных дефектов" на стр. 506.

Примечание. Если с помощью параметра  
ALLOW_REQ_COVERAGE_BY_
TEST_INSTANCE включено покрытие требований 
экземплярами тестов, вместо представления Linked 
Defects будет доступно представление Linkage and 
Coverage. Представление Linkage and Coverage 
показывает связанные дефекты и покрытие требований 
для экземпляра теста. Дополнительные сведения об 
этом параметре см. в документе 
HP Quality Center Administrator Guide. Дополнительные 
сведения о покрытии требований см. в разделе 
“Связывание требований с тестом" на стр. 321.

History История изменений экземпляра теста. Дополнительные 
сведения см. в разделе “Просмотр истории выполнения 
теста" на стр. 507.
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 3 Нажмите кнопку First Test, чтобы просмотреть первый экземпляр теста, 
или кнопку Previous Test, чтобы просмотреть предыдущий экземпляр теста 
в текущей таблице выполнения.

 4 Нажмите кнопку Next Test, чтобы просмотреть следующий экземпляр 
теста, или кнопку Last Test, чтобы просмотреть последний экземпляр теста 
в текущей таблице выполнения.

 5 Чтобы добавить или изменить флаг отслеживания экземпляра теста, 
нажмите кнопку Flag for Follow Up. Дополнительные сведения см. в 
Глава 4, "Оповещение об изменениях"..

 6 Если экземпляр теста имеет оповещение, можно нажать кнопку Alerts, 
чтобы открыть диалоговое окно Alerts. Дополнительные сведения см. в 
разделе “Просмотр оповещений" на стр. 88.

Просмотр сведений о выполнении теста 
Сведения о выполнении экземпляра теста можно просмотреть в 
представлении Details. 

Чтобы просмотреть сведения о выполнении теста, выполните 
следующие действия.

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов выполнения тестов" на 
стр. 493.
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 2 На боковой панели диалогового окна Test Instance Properties нажмите 
кнопку Details. 

 3 В представлении Details можно проверить следующую информацию о 
тесте.

Параметр Описание

Description Описание теста.

Exec Date Дата последнего выполнения теста.

Planned Exec Time Запланированное время запуска теста.

Responsible Tester Имя пользователя, который последним выполнил данный 
тест.

Planned Exec Date Запланированная дата запуска теста.
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Изменения сведений о тесте будут показаны в таблице выполнения.

Примечание. Заголовок любого поля вкладки Details можно изменять. В 
представление Details можно также добавлять поля, определенные 
пользователем. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Planned Host Name Имя или IP-адрес компьютера, на котором было 
запланировано выполнение теста.

Status Текущий статус теста. Статус может иметь одно из 
следующих значений.

Failed. Выполнение теста завершилось сбоем.

N/A. Текущий статус теста неприменим.

No Run. Тест не выполнялся.

Not Completed. Выполнение теста не было завершено. 

Passed. Тест выполнен успешно.

Tester Имя пользователя, который фактически выполняет 
данный тест.

Time Время последнего выполнения теста.

Параметр Описание
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Сравнений результатов всех выполнений 
Quality Center позволяет сравнивать результаты выполнения теста с 
результатами предыдущих выполнений. В представлении All Runs можно 
видеть сведения о выполнении и результаты шагов для всех выполнений 
выбранного экземпляра теста.

Чтобы просмотреть результаты всех выполнений теста, выполните 
следующие действия.

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов выполнения тестов" на 
стр. 493.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
кнопку All Runs. 
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 3 Если необходимо просматривать только записи выполнения с 
определенным статусом, выберите нужный статус в списке View Runs.

 4 Чтобы фильтровать, группировать или сортировать записи выполнений, 
нажмите кнопку Set Filter/Sort. Дополнительные сведения о фильтрации, 
сортировке и группировании записей см. в Глава 3, "Работа с данными 
Quality Center".. Если указан фильтр, то над таблицей будет показано его 
описание.

 5 Чтобы очистить примененные к записям фильтры и параметры сортировки, 
нажмите стрелку Set Filter/Sort и выберите команду Clear Filter/Sort.

 6 Чтобы обновить таблицу для отображения наиболее актуальных сведений 
о выполнениях теста в соответствии с выбранными фильтрами, нажмите 
кнопку Refresh.

 7 Чтобы настроить вид столбцов и порядок их расположения в таблице, 
нажмите кнопку Select Columns. Дополнительные сведения о диалоговом 
окне Select Columns см. в разделе “Упорядочивание столбцов" на стр. 54.

 8 Чтобы удалить запись выполнения теста из таблицы, выберите 
выполнение, а затем нажмите кнопку Delete Selected. Нажмите кнопку Yes 
для подтверждения.

 9 Чтобы просмотреть шаги выполнения теста, выберите выполнение, а 
затем нажмите кнопку Show Run Steps. Откроется диалоговое окно Run 
Steps со сведениями о шагах теста, их описанием, ожидаемыми и 
фактическими результатами. Дополнительные сведения о шагах теста см. 
в Глава 20, "Построение тестов"..

 10 Чтобы добавить вложение к результату выполнения теста, выберите 
результат, затем нажмите кнопку Attachments. Откроется диалоговое окно 
Attachments. Дополнительные сведения о вложениях см. в Глава 5, 
"Добавление вложений"..

 11 Чтобы добавить связи с дефектами к выполнению, выберите выполнение, 
а затем нажмите кнопку Linked Defects. Откроется диалоговое окно Linked 
Defects. Дополнительные сведения о связанных дефектах см. в Глава 36, 
"Связывание дефектов"..

 12 Чтобы продолжить выполнение приостановленного теста, выберите 
выполнение, а затем нажмите кнопку Continue.
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 13 Для экземпляров автоматизированного теста можно выбрать одну из 
следующих кнопок или ссылок.

Кнопка или 
ссылка Тип теста Описание

LR-SCENARIO Результаты открываются в приложении 
LoadRunner Analysis.

QUICKTEST_TES
T

Отчет открывается в приложении 
QuickTest Professional. 

Учтите, что кнопка Launch Report 
доступна только в том случае, если 
установлена надстройка QuickTest 
Professional Add-in со страницы 
надстроек HP Quality Center. 
Дополнительные сведения об 
установке надстроек см. в документе 
HP Quality Center Installation Guide.

Collected 
System Info

Captured 
Desktop Image

SYSTEM-TEST Если щелкнуть ссылку Collected 
System Info, откроется диалоговое 
окно System Information.

Если щелкнуть ссылку Captured 
Desktop Image, откроется снимок 
экрана. 

Дополнительные сведения о 
просмотре системных тестов см. в 
разделе “Просмотр результатов 
системного теста" на стр. 372.

WR-AUTOMATED 
или WR-BATCH

Отчет открывается в приложении 
WinRunner.
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Просмотр конфигурации выполнения теста
В представлении Configuration можно просматривать и устанавливать 
параметры экземпляра ручного или автоматизированного теста. Можно 
также просматривать и изменять правила при сбое выполнения для 
экземпляра автоматизированного теста. 

Данный раздел содержит следующие подразделы.

➤ Установка значений параметров для экземпляров ручных тестов

➤ Установка параметров автоматизированного теста

➤ Просмотр событий выполнения теста

Установка значений параметров для экземпляров ручных 
тестов
Можно установить фактические значения параметров экземпляров ручных 
тестов. Фактические значения, присвоенные параметрам экземпляра теста, 
используются для всех выполнений экземпляра теста.

Чтобы установить значения параметров экземпляра ручного теста, 
выполните следующие действия.

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов выполнения тестов" на 
стр. 493.
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 2 На боковой панели диалогового окна Test Instance Properties нажмите 
кнопку Configuration. Откроется вкладка Manual Parameters. На этой 
вкладке будут показаны все параметры теста, используемые в шагах теста, 
включая параметры вызываемых тестов, которым еще не были присвоены 
фактические значения.

 3 В столбце Actual Value введите значение, которое будет использоваться 
для параметра при выполнении теста. После начала ввода текста 
откроется текстовое поле. Нажмите кнопку OK, чтобы сохранить значение.

 4 Чтобы использовать значение параметра по умолчанию в качестве 
фактического значения, выберите параметр и нажмите кнопку Take Default 
Values. Текущее фактическое значение будет заменено значением по 
умолчанию.
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Установка параметров автоматизированного теста
В представлении Configuration можно присваивать значения параметрам 
и указывать другие настройки конфигурации экземпляра 
автоматизированного теста. 

Чтобы установить параметры и другие настройки конфигурации 
автоматизированного теста, выполните следующие действия.

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов выполнения тестов" на 
стр. 493.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
кнопку Configuration и перейдите на вкладку Automated. 
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 3 В столбце Parameter Value можно просматривать и изменять значения 
параметров. Учтите, что измененное значение параметра начнет 
действовать только при следующем выполнении теста. 

Примечание. При определении параметра WinRunnerCommandLine 
необходимо указывать путь в кавычках. Пример:

-ini "C:\program files\wrun.ini"

 4 Некоторые типы автоматизированных тестов позволяют указывать 
дополнительные настройки конфигурации. Дополнительные сведения см. в 
документе пользователя автоматизированного теста.

Просмотр событий выполнения теста
Представление Run Events позволяет просматривать и изменять правила 
при сбое выполнения для экземпляра автоматизированного теста. Эти 
правила содержат указания для Quality Center в отношении действий при 
сбое выполнения экземпляра теста. Можно указать количество повторных 
запусков экземпляра теста, а также тест очистки, который должен быть 
выполнен перед повторным выполнением экземпляра теста. 

Примечания. 

➤ Изменения правил при сбое в представлении Run Events начинают 
действовать при следующем выполнении теста.

➤ Чтобы установить правила при сбое выполнения теста, можно также 
выбрать команду Test Set > Test Set Properties > On Failure, а затем 
нажать кнопку Settings per Test. Дополнительные сведения см. в 
разделе “Настройка правил при сбое выполнения набора тестов" на 
стр. 436.



Глава 32 • Просмотр результатов выполнения тестов

505

Чтобы просмотреть события выполнения теста, выполните 
следующие действия.

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов выполнения тестов" на 
стр. 493.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
кнопку Configuration и перейдите на вкладку Run Events. 

 3 Чтобы настроить правило при сбое выполнения теста, установите первый 
флажок и укажите число повторных выполнений теста. 

 4 Чтобы включить тест очистки, установите флажок Run cleanup test, а 
затем нажмите кнопку обзора. В диалоговом окне Select Clean Up Test 
выберите тест в дереве плана тестирования, а затем щелкните значок Add 
Test.
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Просмотр связанных дефектов
Можно просматривать связи дефектов с другими объектами Quality Center 
и управлять этими связями.

Чтобы просмотреть связанные дефекты, выполните следующие 
действия.

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов выполнения тестов" на 
стр. 493.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
кнопку Linked Defects.
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Примечание. Если активировано покрытие требований экземплярами 
тестов при помощи параметров 
ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE, нажмите кнопку Linkage 
and Coverage на боковой панели. Дополнительные сведения об этом 
параметре см. в документе HP Quality Center Administrator Guide.

 3 На вкладке Linked Defects можно просматривать, добавлять и удалять 
связи с дефектами. Дополнительные сведения см. в Глава 36, "Связывание 
дефектов"..

Просмотр истории выполнения теста
В представлении History можно просматривать список изменений 
экземпляра теста.

Чтобы просмотреть историю изменений выполнения теста, 
выполните следующие действия.

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов выполнения тестов" на 
стр. 493.
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 2 На боковой панели диалогового окна Test Instance Properties нажмите 
кнопку History. 

Для каждого изменения экземпляра теста в таблице будут показаны дата и 
время изменения, а также имя пользователя, сделавшего изменение.

 3 Разверните изменение, чтобы просмотреть список измененных полей. Для 
каждого поля в таблице отображаются старое и новое значения. Чтобы 
развернуть все изменения, нажмите кнопку Expand All.

 4 Можно указать, какие изменения должны отображаться в таблице. В списке 
Field выберите имя поля, чтобы просмотреть изменения только этого поля. 
Чтобы просмотреть изменения всех полей, выберите <All>.

Сведения о сохранении истории изменения полей см. в документе 
HP Quality Center Administrator Guide.
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33
Рабочий процесс отслеживания дефектов

Важной частью процесса разработки приложения является обнаружение и 
исправление ошибок. Пользователи могут обнаруживать и добавлять 
дефекты в проект Quality Center на всех стадиях процесса тестирования. С 
помощью модуля Defects среды Quality Center можно сообщать об ошибках 
проектирования приложений и отслеживать данные, извлеченные из 
записей о дефектах.

Quality Center Выпуск Starter Edition. При использовании выпуска Starter 
Edition поля, связанные с управлением релизами, недоступны в модуле 
Defects. 
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В этой главе описан порядок отслеживания дефектов. Рабочий процесс 
отслеживания дефектов включает в себя следующее. 

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements

Добавление
дефектов

Анализ новых
дефектов

Устранение
открытых дефектов

Тестирование
новой сборки

Анализ данных
о дефектах
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Добавление дефектов
При обнаружении дефекта в приложении необходимо зафиксировать 
дефект в проекте Quality Center. В проекте хранится информация о 
дефекте, доступ к которой могут получить авторизованные пользователи, 
например сотрудники групп разработки, контроля качества и поддержки. 
Новый дефект можно связать с циклом и релизом, в которых он был 
обнаружен.

Предположим, что выполняется тестирование приложения Mercury Tours. 
При выполнении набора тестов Cycle 1 из папки набора тестов Release 
10.5 во время выполнения одного из тестов был обнаружен дефект, 
связанный с вводом дат истечения срока действия кредитных карт. При 
первоначальном добавлении дефекта в проект для поля Detected in 
Release устанавливается значение Release 10.5, а для поля Detected in 
Cycle — цикл Cycle 1 - New Features. Дополнительные сведения о релизах 
и циклах см. в Глава 8, "Рабочий процесс управления релизами".

Этот новый дефект можно связать с выполненным тестом для 
дальнейшего использования. Также можно связывать дефекты с другими 
объектами Quality Center, такими как требования, тесты и другие дефекты. 
Дополнительные сведения см. в Глава 36, "Связывание дефектов"..

Также предусмотрена возможность просмотра, обновления и анализа 
дефектов в проекте. Дополнительные сведения см. в Глава 35, 
"Добавление и отслеживание дефектов".
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Анализ новых дефектов
Следует проанализировать все новые дефекты в проекте и принять 
решение о том, какие из них следует устранить. Как правило, это делает 
руководитель проекта. Затем следует изменить статус нового дефекта на 
Open и назначить его сотруднику группы разработки. 

В поле Target Release назначьте открытый дефект релизу, в котором 
должен быть устранен этот дефект. В поле Target Cycle назначьте дефект 
циклу, который планируется закрыть. Предположим, что дефект, 
обнаруженный при вводе дат истечения срока действия кредитных карт, 
планируется устранить в следующем цикле. Назначьте поле Target 
Release релизу Release 10.5, а поле Target Cycle циклу Cycle 2 - New 
Features + Regression. 

Если при анализе новых дефектов в проекте появились дубликаты 
дефектов, измените их статус на Closed или Rejected, или удалите их из 
проекта.
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Устранение открытых дефектов
Устраните дефекты со статусом Open. Для этого необходимо сначала 
определить причину дефектов, а затем модифицировать и перестроить 
приложение. Эти задачи возлагаются на разработчиков приложений. После 
исправления дефекта присвойте ему статус Fixed. Предположим, что 
дефект, обнаруженный при вводе дат истечения срока действия кредитных 
карт, был устранен в новой сборке приложения. Измените статус дефекта с 
Open на Fixed.

Тестирование новой сборки приложения
Выполните тесты с новой сборкой приложения. Если дефект не будет 
обнаружен повторно, присвойте ему статус Closed. При повторном 
обнаружении дефекта присвойте ему статус Reopen и вернитесь к 
предыдущей стадии (см. раздел “Устранение открытых дефектов" на 
стр. 515). Как правило, эта задача возлагается на руководителя группы 
контроля качества или руководителя проекта. Дополнительные сведения о 
выполнении тестов см. в Глава 30, "Выполнение тестов вручную" и 
Глава 31, "Автоматическое выполнение тестов".

Анализ данных о дефектах
Чтобы узнать, сколько дефектов было устранено, а сколько осталось 
открытыми, просмотрите данные отчетов о дефектах. Во время работы 
можно сохранять параметры, которые помогут при отслеживании 
дефектов, а затем загружать их при необходимости. Дополнительные 
сведения см. в Глава 6, "Работа с избранными представлениями"..

Отчеты и диаграммы позволяют анализировать ход устранения дефектов и 
узнавать, сколь долго дефекты присутствовали в проекте. Это помогает 
определить, когда можно выпускать приложение. Дополнительные 
сведения см. в Глава 40, "Модуль Dashboard"..
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34
Краткий обзор модуля Defects

В этой главе приведено краткое описание основных элементов модуля 
Defects.

Эта глава содержит следующие разделы.

 ➤  Модуль Defects на стр. 518

 ➤  Строка меню Defects на стр. 521

 ➤  Панель инструментов Defects на стр. 522

 ➤  Таблица Defects Grid на стр. 524
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Модуль Defects 
Отслеживание дефектов выполняется в модуле Defects Quality Center; 
чтобы открыть окно этого модуля, нажмите кнопку Defects на боковой 
панели. 

Модуль Defects содержит следующие основные элементы.

➤ Строка меню Defects. Раскрывающееся меню с командами модуля 
Defects. Дополнительные сведения см. в разделе “Строка меню Defects" на 
стр. 521.

➤ Панель инструментов Defects. Содержит кнопки команд, часто 
использующихся для добавления, отслеживания дефектов и управления 
ими. Дополнительные сведения см. в разделе “Панель инструментов 
Defects" на стр. 522.
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➤ Столбцы индикаторов. Указывают, что тот или иной дефект содержит 
вложения, связанные объекты, предупреждения и флажки отслеживания. 
Чтобы отобразить эти столбцы, выберите командуView > 
Indicator Columns.

➤ Фильтры таблицы. Текущий фильтр, примененный к столбцу. Чтобы 
отобразить поля фильтра таблицы, выберите команду View > Grid Filters.

➤ Таблица Defects. Отображение данных дефектов в таблице. 
Дополнительные сведения см. в разделе “Таблица Defects Grid" на стр. 524.

Столбец Описание

Вложения Для просмотра вложений дефекта щелкните значок 
. Дополнительные сведения см. в Глава 5, 

"Добавление вложений"..

Связанные объекты Для просмотра связанных объектов дефекта 
щелкните значок . Дополнительные сведения см. 
в Глава 36, "Связывание дефектов"..

Предупреждения Для просмотра предупреждений дефекта щелкните 
значок . Дополнительные сведения см. в разделе 
“Просмотр оповещений" на стр. 88.

Флажки отслеживания Для просмотра предупреждений об отслеживании 
дефекта щелкните значок . Дополнительные 
сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 91.
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➤ Панель информации. Содержит следующие вкладки: Description, 
Attachments и History. Выберите пункт меню View > Information Panel > 
Show или нажмите стрелку Show , чтобы отобразить эти вкладки.
 

Совет. Для поиска конкретного дефекта в таблице Defects Grid по 
идентификатору Defect ID выберите команду Defects > Go To Defect. 

Вкладка Описание

Description Отображение описания выбранного дефекта. 
Также можно отобразить следующие параметры.

➤ Summary. Выберите команду View > Information 
Panel > Summary, чтобы отобразить краткое 
описание дефекта. 

➤ Comments. Выберите команду View > 
Information Panel > Comments, чтобы 
просмотреть или добавить комментарии 
дефекта.

Дополнительные сведения см. в разделе 
“Обновление дефектов" на стр. 538.

Attachments Отображение вложений выбранного дефекта. 
Дополнительные сведения см. в Глава 5, 
"Добавление вложений"..

History Отображение истории изменения дефекта. 
Дополнительные сведения см. в разделе “Просмотр 
истории изменения дефекта" на стр. 543.
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Строка меню Defects 
Строка меню Defects содержит следующие меню.

➤ Меню Defects содержит команды, с помощью которых можно добавлять 
дефекты, переходить к тому или иному дефекту, отправлять дефекты по 
электронной почте, экспортировать дефекты, а также просматривать 
подробные сведения о дефектах.

➤ Меню Edit содержит команды, с помощью которых можно копировать, 
вставлять или удалять дефекты, выполнять поиск и замену значений в 
полях, искать дефекты, обновлять выбранные дефекты и находить 
аналогичные дефекты или текст. Также можно просматривать и удалять 
предупреждения дефектов и устанавливать флажки отслеживания 
дефектов. Дополнительные сведения о предупреждениях и флажках 
отслеживания см. в Глава 4, "Оповещение об изменениях"..

➤ Меню View содержит команды, позволяющие настраивать отображение в 
таблице Defects Grid. 

➤ Меню Favorites содержит команды, с помощью которых можно 
просматривать выбранный в списке Favorites элемент, добавлять 
представление таблицы Defects Grid в список Favorites и упорядочивать 
список Favorites. Дополнительные сведения об избранных представлениях 
см. в Глава 6, "Работа с избранными представлениями"..

➤ Меню Analysis содержит команды, позволяющие формировать отчеты о 
дефектах и диаграммы. Дополнительные сведения об отчетах о дефектах 
см. в Глава 42, "Создание стандартных отчетов".. Дополнительные 
сведения о диаграммах дефектов см. в Глава 41, "Создание диаграмм"..

Совет. Для получения доступа к строке меню Defects из модуля Defects 
нажмите клавишу F9. Кроме того, с помощью сочетаний клавиш можно 
выполнять множество других операций в среде Quality Center. Перечень 
сочетаний клавиш приведен в Приложение B, "Сочетания клавиш 
Quality Center"..
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Панель инструментов Defects 
Панель инструментов Defects содержит следующие кнопки.

New Defect. Открывает диалоговое окно New Defect, в котором можно 
добавить новый дефект в таблицу Defects Grid. Дополнительные сведения 
см. в разделе “Добавление новых дефектов" на стр. 531.

Delete. Удаляет выбранные дефекты из таблицы Defects Grid. 
Дополнительные сведения см. в разделе “Удаление дефектов" на стр. 549.

Refresh All. Обновляет таблицу Defects Grid для отображения наиболее 
актуальных дефектов в соответствии с выбранными фильтрами. 

Set Filter/Sort. Можно выбрать следующие варианты.

➤ Set Filter/Sort. Открывает диалоговое окно Filter, в котором можно 
фильтровать, сортировать и группировать дефекты в таблице Defects 
Grid.

➤ Clear Filter/Sort. Очищает все фильтры, сортировку или группировки, 
примененные пользователем к таблице Defects Grid. 

Дополнительные сведения о фильтрации и сортировке дефектов см. в 
Глава 3, "Работа с данными Quality Center"..

Select Columns. Открывает диалоговое окно Select Columns, в котором 
можно задать, какие столбцы будут отображаться в таблице Defects, и 
порядок их отображения. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 54.

Defect Details. Открывает диалоговое окно Defect Details, в котором 
отображаются подробные сведения о дефекте. Дополнительные сведения 
см. в разделе “Обновление дефектов" на стр. 538.

Attachments. Открывает диалоговое окно Defect Details, в котором можно 
добавить к дефекту новое вложение. Дополнительные сведения см. в 
Глава 5, "Добавление вложений"..

Flag for Follow Up. Открывает диалоговое окно Flag For Follow Up, в 
котором можно добавить или изменить флажок отслеживания дефекта. 
Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 91.
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Send by E-mail. Открывает диалоговое окно Send E-mail, с помощью 
которого можно отправить дефект электронной почтой выбранным из 
списка получателям или на любые другие адреса электронной почты. 
Дополнительные сведения см. в разделе “Отправка дефектов по 
электронной почте" на стр. 544.

Find Similar Defects. Можно выбрать следующие варианты.

➤ Find Similar Defects. Выполняет поиск аналогичных дефектов и 
показывает найденные дефекты в диалоговом окне Similar Defects. 

➤ Find Similar Text. Открывает диалоговое окно Find Similar Text, с 
помощью которого можно выполнять поиск аналогичных дефектов 
путем указания текстовой строки; найденные дефекты будут показаны в 
диалоговом окне Similar Defects.

Дополнительные сведения о поиске аналогичных дефектов см. в разделе 
“Сопоставление дефектов" на стр. 534.

Text Search. Открывает в нижней части окна область поиска текста, в 
которой можно вводить ключевые слова и выполнять поиск в 
предопределенных полях. Дополнительные сведения см. в разделе “Поиск 
записей" на стр. 76.

Favorite. Щелкните стрелку Favorite, чтобы отобразить список избранных 
представлений. Используя избранные представления, можно обновлять 
окно Quality Center с примененными к нему параметрами. Если панель 
Favorite не отображается, выберите команду View > Favorite Bar. 
Дополнительные сведения об избранных представлениях см. в Глава 6, 
"Работа с избранными представлениями"..
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Таблица Defects Grid
Quality Center упорядочивает и отображает данные о дефектах в таблице. 
В каждой строке таблицы Defects Grid отображается отдельная запись 
дефекта. Таблица Defects Grid может содержать следующие столбцы.

Столбец Описание

Actual Fix Time Указывает фактическое количество дней, необходимых 
для устранения дефекта. Если оставить это поле пустым, 
Quality Center автоматически рассчитывает фактическое 
время, необходимое для устранения дефекта, вычитая 
из даты закрытия дефекта дату его обнаружения.

Assigned To Имя пользователя, которому назначена задача по 
устранению дефекта. Щелкните стрелку «Вниз», чтобы 
отобразить список имен и полных имен всех 
пользователей. 

Closed in Version Указывает версию приложения, в которой дефект был 
закрыт. Чтобы отобразить список версий, нажмите 
стрелку «Вниз».

Closing Date Указывает дату закрытия дефекта. Нажмите стрелку 
«Вниз», чтобы отобразить календарь и выбрать дату 
закрытия.

Comments Отображает комментарии к дефекту.

Defect ID Уникальный числовой идентификатор дефекта, 
автоматически назначенный в среде Quality Center. 
Идентификатор дефекта доступен только для чтения.

Description Подробное описание дефекта.

Detected By Имя пользователя, обнаружившего дефект. По 
умолчанию среда Quality Center вставляет в это поле имя 
пользователя, выполнившего вход в систему.
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Detected in Cycle Указывает цикл, в котором был обнаружен дефект. Чтобы 
выбрать другой цикл, нажмите стрелку «Вниз». 

Учтите, что при назначении дефекта циклу в поле 
Detected in Cycle Quality Center автоматически 
присваивает значение соответствующего релиза полю 
Detected in Release.

Detected in Release Указывает релиз, в котором был обнаружен дефект. 
Чтобы выбрать другой релиз, нажмите стрелку «Вниз».

Detected in Version Указывает версию приложения, в которой был обнаружен 
дефект. Чтобы отобразить список версий, нажмите 
стрелку «Вниз».

Detected on Date Дата обнаружения дефекта. По умолчанию отображается 
текущая дата сервера базы данных. Чтобы выбрать 
другую дату обнаружения, нажмите стрелку «Вниз».

Estimated Fix Time Указывает расчетное количество дней, необходимых для 
устранения дефекта.

Modified Указывает дату и время последнего изменения дефекта.

Planned Closing 
Version

Указывает, в какой версии планируется устранить 
дефект. Чтобы отобразить список версий, нажмите 
стрелку «Вниз».

Priority Приоритет дефекта от низкого (уровень 1) до 
неотложного (уровень 5).

Project Имя проекта, в котором обнаружен дефект. Чтобы 
отобразить список проектов, щелкните кнопку стрелку 
«Вниз».

Reproducible Указывает, возможно ли воспроизвести дефект при тех 
же условиях, при которых он был обнаружен. Щелкните 
стрелку «Вниз», чтобы выбрать Y (Да) или N (Нет).

Severity Серьезность дефекта от низкой (уровень 1) до 
неотложной (уровень 5).

Столбец Описание
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Status Текущий статус дефекта. По умолчанию дефекту 
назначается статус New. Для дефекта может 
использоваться один из следующих статусов: Closed, 
Fixed, New, Open, Rejected, Reopen. 

Subject Указывает папку объектов тестирования. Чтобы 
отобразить список объектов тестирования, нажмите 
стрелку «Вниз».

Summary Краткое описание дефекта.

Target Cycle Указывает, в каком цикле планируется устранить дефект. 
Чтобы выбрать другой цикл, нажмите стрелку «Вниз».

Учтите, что при назначении дефекта циклу в полеTarget 
Cycle Quality Center автоматически присваивает 
значение соответствующего релиза полю Target Release.

Target Release Указывает, в каком релизе планируется закрыть дефект. 
Чтобы выбрать другой релиз, нажмите стрелку «Вниз».

Столбец Описание



Глава 34 • Краткий обзор модуля Defects

527

Примечания. 

➤ Можно добавлять поля, определенные пользователем, и изменять 
заголовки любых полей в таблице Defects Grid. Также предусмотрена 
возможность настройки списков проектов. Дополнительные сведения 
см. в документе HP Quality Center Administrator Guide.

➤ Для ограничения и динамического изменения полей и значений таблицы 
Defects Grid можно использовать редактор Script Editor. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ При выборе столбца дефектов, содержащего значение имени 
пользователя, Quality Center отображает список с именем и полным 
именем каждого пользователя. Можно выполнять поиск пользователей, 
сортировать и группировать их по группам, а также выбирать 
пользователей из списка пользователей и дерева групп. 
Дополнительные сведения см. в разделе “Выбор пользователей" на 
стр. 57.

➤ Quality Center Выпуск Starter Edition. При использовании выпуска 
Starter Edition поля, связанные с управлением релизами, недоступны в 
модуле Defects. 
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35
Добавление и отслеживание дефектов

Модуль Defects используется для добавления дефектов приложений 
непосредственно в проект Quality Center. После добавления можно 
отслеживать дефекты до того момента, когда разработчики и тестировщики 
приложений не определят, что дефекты устранены.

Эта глава содержит следующие разделы.

 ➤  О добавлении и отслеживании дефектов на стр. 530

 ➤  Добавление новых дефектов на стр. 531

 ➤  Сопоставление дефектов на стр. 534

 ➤  Обновление дефектов на стр. 538

 ➤  Поиск и замена значений на стр. 540

 ➤  Обновление нескольких записей на стр. 543

 ➤  Просмотр истории изменения дефекта на стр. 543

 ➤  Отправка дефектов по электронной почте на стр. 544

 ➤  Копирование дефектов на стр. 547

 ➤  Копирование URL-адресов дефектов на стр. 548

 ➤  Печать дефектов на стр. 548

 ➤  Удаление дефектов на стр. 549
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О добавлении и отслеживании дефектов
Записи дефектов информируют сотрудников групп разработки приложений 
и контроля качества о новых дефектах, обнаруженных другими 
сотрудниками. Благодаря совместному использованию сведений о 
дефектах ускоряется как процесс разработки приложений, так и процесс 
устранения дефектов, что делает эти процессы более эффективными и 
всеобъемлющими. В процессе контроля за ходом устранения дефектов 
пользователь обновляет сведения в проекте Quality Center.

Предположим, пользователь обнаружил дефект в приложении Mercury 
Tours. При первоначальном предоставлении сведений о дефекте в 
Quality Center дефекту по умолчанию присваивается статус New. 
Руководитель группы контроля качества или руководитель проекта 
анализирует сведения о дефекте, определяет приоритеты его устранения, 
изменяет его статус на Open и передает дефект сотруднику группы 
разработки. Разработчик устраняет дефект и присваивает ему статус 
Fixed. Пользователь повторно тестирует приложение, проверяя отсутствие 
дефекта. Руководитель группы контроля качества или руководитель 
проекта проверяет, что дефект действительно устранен, и присваивает ему 
статус Closed.
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Примечания. 

➤ Можно связывать дефекты с другими объектами Quality Center, такими 
как требования, тесты и другие дефекты. Дополнительные сведения см. 
в разделе Глава 36, "Связывание дефектов"..

➤ Для ограничения и динамического изменения полей и значений модуля 
Defects можно использовать редактор Workflow Script Editor. Также 
предусмотрена возможность настройки полей для определенной группы 
пользователей. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

➤ Quality Center Выпуск Premier Edition. Можно совместно использовать 
дефекты в различных проектах Quality Center. Для совместного 
использования и синхронизации дефектов используется средство 
HP Quality Center Synchronizer. Дополнительные сведения см. в 
документе Руководство пользователя HP Quality Center Synchronizer, 
доступном на странице надстроек Quality Center.

Добавление новых дефектов 
Добавить новый дефект в проект Quality Center можно из любого модуля на 
любой стадии процесса управления приложением.

Примечание. Кроме добавления дефектов непосредственно в 
Quality Center можно импортировать данные о дефектах из Microsoft Excel в 
проект Quality Center. Для импорта из Excel установите надстройки 
Microsoft Excel Add-in и HP Quality Center Connectivity Add-in. Их можно 
загрузить на странице надстроек HP Quality Center. Дополнительные 
сведения см. в документе Руководство по установке HP Quality Center.
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Чтобы добавить новый дефект, выполните следующие действия.

 1 Чтобы добавить новый дефект из любого модуля, нажмите кнопку Tools в 
правом верхнем углу. Выберите New Defect.

Чтобы добавить дефект из модуля Defects, нажмите кнопку New Defect. 
Откроется диалоговое окно New Defect.

 2 Введите сведения о дефекте. Учтите, что обязательные поля выделены 
красным цветом, а некоторые поля Quality Center заполняет значениями по 
умолчанию. Дополнительные сведения о полях, доступных в диалоговом 
окне New Defect, см. в Глава 34, "Краткий обзор модуля Defects"..

 3 Чтобы очистить все данные в диалоговом окне New Defect, нажмите кнопку 
Clear.

 4 К дефекту можно добавить вложение.

➤ Нажмите кнопку Attach File, чтобы приложить файл.

➤ Нажмите кнопку Attach URL, чтобы приложить URL-адрес.

➤ Нажмите кнопку Attach Snapshot, чтобы сделать снимок экрана и 
приложить его как изображение.
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➤ Нажмите кнопку Attach SysInfo, чтобы приложить сведения о 
компьютере.

➤ Нажмите кнопку Attach Clipboard Content, чтобы приложить 
содержимое буфера обмена.

Дополнительные сведения о добавлении вложений см. в Глава 5, 
"Добавление вложений"..

 5 Чтобы удалить дубликаты дефектов или аналогичные дефекты, выполните 
следующие действия.

➤ Нажмите кнопку Find Similar Defects, чтобы выполнить поиск 
аналогичных дефектов по ключевым словам в полях Summary и 
Description.

➤ Щелкните стрелку Find Similar Defects и выберите пункт Find Similar 
Text, чтобы выполнить поиск аналогичных дефектов по введенной 
текстовой строке.

Дополнительные сведения см. в разделе “Сопоставление дефектов" на 
стр. 534.

 6 В диалоговом окне можно проверить орфографию.

➤ Нажмите кнопку Check Spelling, чтобы проверить орфографию 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии Quality Center, нажмите 
кнопку Spelling Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить синонимы, 
антонимы или связанные слова для выбранного слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое.

 7 Для добавления дефекта в проект нажмите кнопку Submit. Quality Center 
назначит идентификатор новому дефекту.

 8 Нажмите кнопку Close.
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Сопоставление дефектов 
Сопоставление дефектов позволяет устранять дублированные или схожие 
дефекты в проекте. При каждом добавлении нового дефекта Quality Center 
сохраняет списки ключевых слов из полей Summary и Description. При 
поиске аналогичных дефектов ключевые слова из этих полей 
сопоставляются с другими дефектами.

Учтите, что ключевые слова имеют длину больше двух символов, при этом 
регистр не влияет на результаты. Будут пропущены следующие элементы: 
артикли (a, an, the); сочинительные союзы (and, but, for, nor, or); логические 
операторы (and, or, not, if, then); подстановочные знаки (?, *, [ ]). 

Поиск аналогичных дефектов можно выполнять двумя способами.

➤ Find Similar Defects. Сравнение выбранного дефекта со всеми 
остальными дефектами, существующими в проекте. Поиск аналогичных 
дефектов можно выполнять в таблице Defects Grid или перед добавлением 
нового дефекта в диалоговом окне New Defect. См. раздел “Поиск 
аналогичных дефектов" на стр. 535.

➤ Find Similar Text. Сравнение указанной текстовой строки со всеми 
остальными дефектами, существующими в проекте. Поиск аналогичных 
дефектов можно выполнять в таблице Defects Grid или перед добавлением 
нового дефекта в диалоговом окне New Defect. Для ограничения числа 
результатов можно указать необходимое сходство в процентах. См. раздел 
“Поиск аналогичного текста" на стр. 536.

Совет. Функция Text Search, если она доступна, является более мощным 
средством поиска, позволяющим находить ключевые слова и измененные 
формы ключевых слов. Сведения об использовании текстового поиска см. 
в разделе “Поиск записей" на стр. 76.
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Поиск аналогичных дефектов
Можно сопоставлять дефекты путем сравнения выбранного дефекта со 
всеми остальными дефектами в проекте. При обнаружении аналогичных 
дефектов они отображаются в соответствии с обнаруженным сходством в 
процентах. 

Для поиска аналогичных дефектов выполните следующие действия:

 1 В таблице Defects Grid выберите дефект и нажмите кнопку Find Similar 
Defects. Также можно нажать кнопку Find Similar Defects в диалоговом 
окне New Defect перед добавлением дефекта.

Результаты отображаются в диалоговом окне Similar Defects в порядке 
уменьшения степени обнаруженного сходства в процентах, указанной в 
столбце Similar. Если аналогичные дефекты обнаружены не были, будет 
показано соответствующее сообщение.
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 2 Чтобы просмотреть подробные сведения о дефекте в диалоговом окне 
Similar Defects, дважды щелкните дефект.

 3 Чтобы закрыть диалоговое окно Similar Defects, нажмите кнопку Close.

Поиск аналогичного текста
Можно сопоставлять дефекты путем сравнения указанной текстовой строки 
со всеми остальными дефектами, существующими в проекте. Можно 
ограничить результаты поиска дефектов, учитывая только дефекты с 
определенной степенью сходства в процентах. Предположим, что 
выполняется поиск дефектов со словом Help. Если ограничить результаты 
степенью сходства 25 процентов, то результаты поиска будут следующими:

Если ограничить результаты степенью сходства 100 процентов, то 
результаты поиска будут следующими:

Для поиска аналогичного текста выполните следующие действия:

 1 В таблице Defects Grid нажмите стрелку Find Similar Defects и выберите 
Find Similar Text. Также можно щелкнуть стрелку Find Similar Defects и 
выбрать Find Similar Text в диалоговом окне New Defect перед 
добавлением дефекта.
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Откроется диалоговое окно Find Similar Text. 

 2 Для ограничения результатов поиска дефектов по минимальной степени 
сходства, введите степень сходства в процентах в поле Percent of 
Similarity. По умолчанию Quality Center возвращает дефекты со степенью 
сходства не менее 25 процентов.

 3 В поле Text to Find введите текстовую строку. 

 4 Нажмите кнопку ОK. Результаты отображаются в диалоговом окне Similar 
Defects в порядке уменьшения степени сходства в процентах, указанной в 
столбце Similar. Если аналогичные дефекты обнаружены не были, будет 
показано соответствующее сообщение.

 5 Чтобы просмотреть подробные сведения о дефекте в диалоговом окне 
Similar Defects, дважды щелкните дефект.

 6 Чтобы закрыть диалоговое окно Similar Defects, нажмите кнопку Close.
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Обновление дефектов
Отслеживание устранения дефектов в проекте требует периодического 
обновления дефектов. Обновлять дефекты можно непосредственно в 
таблице Defects Grid или в диалоговом окне Defect Details.

Для обновления дефектов выполните следующие действия.

 1 В таблице Defects дважды щелкните дефект, который необходимо 
обновить. Также можно выбрать дефект и нажать кнопку Defect Details. 
Откроется диалоговое окно Defect Details. 

 2 Нажмите кнопку First, чтобы просмотреть первый дефект в таблице, или 
кнопку Previous, чтобы просмотреть предыдущий дефект.

 3 Нажмите кнопку Next, чтобы просмотреть следующий дефект в таблице, 
или кнопку Last, чтобы просмотреть последний дефект в таблице.
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 4 Чтобы просмотреть конкретный дефект в диалоговом окне Defect Details 
нажмите кнопку Go To Defect. Откроется диалоговое окно Go To Defect. 
Введите идентификатор дефекта и нажмите кнопку OK.

 5 Чтобы добавить или изменить флажок отслеживания дефекта, нажмите 
кнопку Flag for Follow Up. Дополнительные сведения см. в Глава 4, 
"Оповещение об изменениях"..

 6 Если у дефекта есть предупреждение, можно нажать кнопку Alerts, чтобы 
открыть диалоговое окно Alerts. Дополнительные сведения см. в разделе 
“Просмотр оповещений" на стр. 88.

 7 Нажмите кнопку Send by Email, чтобы отправить подробные сведения о 
дефекте по электронной почте. Дополнительные сведения об отправке 
сведений о дефектах по электронной почте см. в разделе “Отправка 
дефектов по электронной почте" на стр. 544.

 8 Нажмите кнопку Create Report For This Defect, чтобы сформировать отчет 
с подробными сведениями о дефекте. 

 9 Если дефект связан с выполнением теста, щелкните ссылку Execution 
Report в нижней части диалогового окна Defect Details, чтобы создать отчет 
о выполнении. Отчет о выполнении предоставляет подробные сведения о 
выполнении связанного теста. 

 10 В представлении Details можно добавлять или изменять сведения о 
выбранном дефекте. Дополнительные сведения о полях, доступных в 
представлении Details, см. в Глава 34, "Краткий обзор модуля Defects"..

Чтобы добавить новый комментарий, нажмите кнопку Add Comment. 
Новый раздел будет добавлен в поле Comments с именем пользователя и 
текущей датой базы данных.

 11 Щелкните Attachments на боковой панели, чтобы добавить вложение к 
дефекту. Вложение может представлять собой файл, URL-адрес, снимок 
экрана приложения, информацию о системе или содержимое буфера 
обмена. В таблице Defects Grid рядом с дефектом отображается значок 
вложения . Дополнительные сведения о вложениях см. в Глава 5, 
"Добавление вложений"..
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 12 Щелкните Linked Entities на боковой панели. Доступны следующие 
вкладки:

➤ Defects. Позволяет просматривать и добавлять связи к существующим 
дефектам. Например, можно связать дефект с дубликатом дефекта.

➤ Others. Позволяет просматривать и удалять связи от других объектов. 
Новые связи добавлять нельзя.

Дополнительные сведения о связанных дефектах см. в Глава 36, 
"Связывание дефектов"..

 13 Щелкните History на боковой панели, чтобы просмотреть историю 
изменений дефекта. Дополнительные сведения см. в разделе “Просмотр 
истории изменения дефекта" на стр. 543.

 14 Нажмите кнопку OK, чтобы сохранить изменения и вернуться к таблице 
Defects.

Поиск и замена значений 
С помощью команды Find/Replace можно выполнять поиск и замену 
значений в таблице Defects.

Совет. Если доступен текстовый поиск, то его можно использовать для 
поиска дефектов в таблице Defects Grid. Текстовый поиск является более 
мощным средством поиска, позволяющим находить ключевые слова и 
измененные формы ключевых слов. Сведения об использовании 
текстового поиска см. в разделе “Поиск записей" на стр. 76.
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Для поиска значения выполните следующие действия.

 1 В таблице Defects выберите Edit > Find. Откроется диалоговое окноFind.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск определенного значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 Чтобы найти точное совпадение, установите флажок Exact Match.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы использовать в строке поиска символ звездочки (*) и вводить только 
часть элемента, установите флажок Use Wildcard.

 7 Нажмите кнопку Find Next. Quality Center попытается найти любые 
дефекты с указанным значением. При успешном завершении поиска 
дефект будет выделен в таблице Defects Grid. При неудачном завершении 
поиска откроется информационное окно.
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Для замены значения выполните следующие действия:

 1 В таблице Defects Grid выберите Edit > Replace. Откроется диалоговое 
окно Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск определенного значения. 

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение для замены.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы найти точное совпадение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы Defects Grid, установите 
флажок From Beginning.

 8 Чтобы использовать в строке поиска символ звездочки (*) и вводить только 
часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажмите кнопку Replace.

 10 Для замены всех экземпляров значения в таблице Defects Grid нажмите 
кнопку Replace All.
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Обновление нескольких записей
Можно обновлять значение поля в нескольких записях таблицы Defects 
Grid. Чтобы обновить значения, выделите записи в таблице и выберите 
команду Edit > Update Selected. Откроется диалоговое окно Update 
Selected. Дополнительные сведения см. в разделе “Обновление нескольких 
записей" на стр. 74.

Просмотр истории изменения дефекта
Предусмотрена возможность просмотра списка изменений дефекта. 
Учтите, что можно просматривать изменения только для отдельных полей, 
определенных администратором в окне Project Customization. 
Дополнительные сведения о включении истории изменений для поля см. в 
документе HP Quality Center Administrator Guide.

Для просмотра истории изменения дефекта выполните следующие 
действия:

 1 Выберите дефект, а затем выберите команду View > Information Panel > 
Show, чтобы отобразить историю изменений в таблице Defects Grid. 
Перейдите на вкладку History. 

Также можно дважды щелкнуть дефект в таблице Defects Grid, чтобы 
открыть диалоговое окно Defect Details, а затем щелкнуть History на 
боковой панели.

История изменений дефекта будет отображена в таблице.
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Для каждого изменения дефекта в таблице отображается дата и время 
изменения, а также имя пользователя, который его внес.

 2 Разверните изменение, чтобы просмотреть список измененных полей. Для 
каждого поля в таблице отображаются старое и новое значения. Чтобы 
развернуть все изменения, нажмите кнопку Expand All.

 3 Можно указать, какие изменения должны отображаться в таблице. В списке 
Field выберите имя поля, чтобы просмотреть изменения только этого поля. 
Чтобы просмотреть изменения всех полей, выберите <All>.

Отправка дефектов по электронной почте 
Можно отправить сообщение о дефекте по электронной почте другому 
пользователю. Эта функция позволяет информировать сотрудников групп 
разработки и контроля качества о мерах по устранению дефектов. 
Quality Center включает в сообщение электронной почты ссылку Go To 
Defect, которая позволяет получателю сообщения перейти 
непосредственно к дефекту.

Примечание. По умолчанию Quality Center отправляет сообщения 
электронной почты в формате HTML. Чтобы отправить сообщение 
электронной почты в виде обычного текста, измените параметр 
MAIL_FORMAT на вкладке Site Configuration в разделе Site Administration. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.
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Чтобы отправить дефект по электронной почте, выполните 
следующие действия. 

 1 В таблице Defects Grid выберите один или несколько дефектов и нажмите 
кнопку Send by Email. Откроется диалоговое окно Send Email.

Совет. Предусмотрена возможность автоматической отправки сообщений 
по электронной почте пользователям определенного типа. Это может быть 
любой столбец дефекта с именем пользователя, включая поля, 
определенные пользователем. Щелкните стрелку Send by Email и 
выберите требуемый вариант. Например, для отправки сообщения по 
электронной почте пользователю, обнаружившему дефект, выберите Send 
Mail to Detected By.
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 2 Введите допустимый адрес электронной почты или имя пользователя. 
Также можно нажать кнопку To или CC, чтобы выбрать пользователей. 
Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять поиск 
пользователей, распределять пользователей по группам и выбирать 
пользователей из списка или из дерева групп. Дополнительные сведения 
см. в разделе “Выбор пользователей" на стр. 57.

Выберите пользователей или группы пользователей, которым необходимо 
отправить сообщение электронной почты, и нажмите кнопку OK. 

 3 В поле Subject введите тему сообщения электронной почты. По умолчанию 
при выборе только одного дефекта в поле Subject отображаются домен, 
проект, идентификатор дефекта и его краткое описание.

 4 В поле Items можно очистить все элементы, которые не нужно включать в 
сообщение электронной почты.

 5 Выберите, следует ли включать элементы дефекта Attachments и (или) 
History.

 6 В поле Additional comments добавьте необходимые комментарии.
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 7 В диалоговом окне можно проверить орфографию.

➤ Нажмите кнопку Check Spelling, чтобы проверить орфографию 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии Quality Center, нажмите 
кнопку Spelling Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить синонимы, 
антонимы или связанные слова для выбранного слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое.

 8 Чтобы настроить сообщение электронной почты, щелкните Custom. В 
диалоговом окне Select Fields можно указать, какие поля следует включить 
в сообщение электронной почты.

 9 Нажмите кнопку Send, чтобы отправить сообщение электронной почты.

Копирование дефектов
Можно копировать дефекты в любой проект Quality Center.

Чтобы скопировать дефект, выполните следующие действия.

 1 В таблице Defects Grid выберите дефект, который необходимо 
скопировать. Для копирования нескольких дефектов нажмите и 
удерживайте клавишу CTRL и выберите дефекты, которые необходимо 
скопировать.

 2 Выберите команду Edit > Copy. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Copy.

 3 В таблице Defects Grid в том проекте, в который необходимо скопировать 
дефекты, выберите Edit > Paste. Также можно щелкнуть правой кнопкой 
мыши и выбрать Paste.



Глава 35 • Добавление и отслеживание дефектов

548

Копирование URL-адресов дефектов
Можно скопировать дефект и вставить его URL-адрес как ссылку. Сам 
дефект скопирован не будет. Вместо этого можно вставить адрес в другое 
место, такое как сообщение электронной почты или документ. Если 
щелкнуть такую ссылку, будет открыт Quality Center на странице с 
дефектом. Если вход в систему еще не выполнен, сначала будет показано 
приглашение Quality Center для входа в систему. 

Чтобы скопировать URL-адрес дефекта, выполните следующие 
действия.

 1 В таблице Defects Grid выберите дефект. 

 2 Выберите команду Edit > Copy URL. Также можно щелкнуть элемент 
правой кнопкой мыши и выбрать команду Copy URL.

 3 Вставьте URL-адрес.

Печать дефектов
Можно напечатать все дефекты или выбранные дефекты в таблице Defects 
Grid.

Чтобы напечатать дефекты, выполните следующие действия.

 1 Можно напечатать все или выбранные дефекты.

➤ Для печати всех дефектов выберите команду Defects > Print > All.

➤ Для печати выбранных дефектов выберите их с помощью клавиш CTRL 
или SHIFT, а затем выберите команду Defects > Print > Selected. 

Откроется диалоговое окно Print Preview. 

 2 С помощью кнопок на панели инструментов отрегулируйте и настройте 
страницу пред печатью.

 3 Нажмите кнопку Print или выберите команду File > Print.
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Удаление дефектов
Можно удалять старые дефекты или дубликаты дефектов из проекта. 
После удаления дефекта Quality Center не использует идентификатор 
данного дефекта повторно.

Чтобы удалить дефект, выполните следующие действия.

 1 В таблице Defects Grid выберите дефект, который необходимо удалить.

 2 Нажмите кнопку Delete или выберите команду Edit > Delete. Также можно 
щелкнуть дефект правой кнопкой мыши и выбрать команду Delete.

 3 Нажмите кнопку Yes для подтверждения.
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36
Связывание дефектов

Дефекты можно связывать с другими объектами в Quality Center.

Эта глава содержит следующие разделы.

 ➤  О связывании дефектов на стр. 551

 ➤  Просмотр связей дефектов на стр. 554

 ➤  Добавление связей дефектов на стр. 555

 ➤  Удаление связей дефектов на стр. 556

О связывании дефектов
Дефект можно связать со следующими объектами: требования, тесты, 
наборы тестов, экземпляры тестов, выполнения тестов, шаги выполнения и 
другие дефекты. Связывание дефектов удобно, например, при создании 
нового теста для отслеживания конкретного дефекта. Создав такую связь, 
можно указать выполнение теста в зависимости от статуса дефекта.

Дефекты могут быть связаны с объектами напрямую или косвенно. При 
добавлении связи дефекта с объектом Quality Center добавляет прямую 
связь с самим объектом и косвенные связи с другими сопутствующими 
объектами. Кроме того, при добавлении дефекта во время выполнения 
ручного теста Quality Center автоматически создает связь между 
выполнением теста и новым дефектом.
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На приведенной ниже схеме показан процесс косвенного связывания.

Например, при связывании дефекта с шагом выполнения теста, 
Quality Center добавляет косвенную связь к выполнению теста, экземпляру 
теста, набору тестов и тесту. Если этот тест покрывается требованием, 
также добавляется косвенная связь с требованием. Учтите, что косвенное 
связывание представляет собой односторонний процесс. Например, при 
связывании дефекта с выполнением теста дефект не является косвенно 
связанным с шагами выполнения теста.

Просматривать связи дефектов и управлять ими можно с помощью 
диалогового окна или вкладки Linked Defects.
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Таблица Linked Defects содержит следующие столбцы.

Дополнительные сведения о полях дефектов см. в разделе “Таблица 
Defects Grid" на стр. 524.

Столбец Описание

Created By Имя пользователя, создавшего связь.

Creation Date Дата создания связи.

Defect ID Уникальный числовой идентификатор дефекта, 
автоматически назначенный в среде Quality Center. 
Идентификатор дефекта доступен только для чтения.

Link Comment Позволяет добавлять комментарии к связи.

Link ID Уникальный числовой идентификатор связи, 
автоматически назначенный в среде Quality Center. 
Идентификатор связи доступен только для чтения.

Link Type Значение из настраиваемого списка Link Type. 
Дополнительные сведения о списках см. в документе 
HP Quality Center Administrator Guide

Linked By Status Текущий статус связанного объекта.

Linked Entity ID Уникальный числовой идентификатор связанного 
объекта, автоматически назначенный в среде 
Quality Center. Идентификатор связанного объекта 
доступен только для чтения.

Linked Entity Name Имя связанного объекта. Например, имя требования.

Link Entity Type Тип связанного объекта (например, шаг, тест, набор 
тестов).
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Просмотр связей дефектов
Можно фильтровать связи, задавать вид столбцов и порядок их 
расположения в таблице, а также обновлять информацию в таблице. 
Кроме того, предусмотрена возможность просмотра подробных сведений о 
дефекте и задания команды Quality Center на переход к модулю и 
выделение связанного объекта.

➤ Чтобы обновить информацию в таблице, нажмите кнопку Refresh All. 

➤ Для фильтрации и сортировки связей дефектов нажмите кнопку Set 
Filter/Sort. Дополнительные сведения о фильтрации и сортировке см. в 
разделе “Фильтрация записей" на стр. 59. При установке фильтра его 
описание отображается над таблицей.

➤ Чтобы настроить вид столбцов и порядок их расположения в таблице, 
нажмите кнопку Select Columns. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 54.

➤ Для просмотра подробных сведений о дефекте выберите связь дефекта и 
нажмите кнопку Defect Details. Откроется диалоговое окно Defect Details. 
Дополнительные сведения см. в разделе “Обновление дефектов" на 
стр. 538.

➤ Чтобы открыть модуль Defects и выделить связанный дефект, выберите 
связь дефекта. Нажмите стрелку Go To и выберите Go To Defect. 

Также можно щелкнуть ссылку Defect ID, чтобы открыть модуль Defects и 
выделить в нем связанный дефект.

➤ Чтобы открыть соответствующий модуль и выделить связанный объект, 
выберите связь дефекта. Нажмите стрелку Go To и выберите Go To 
’Linked By’ Entity.

Также можно щелкнуть ссылку Linked Entity Name, чтобы открыть 
соответствующий модуль и выделить в нем связанный объект.

➤ Чтобы отобразить прямые связи, выберите Direct Links в списке типов 
связей Type of Link. Для отображения прямых и косвенных связей выберите 
All Links. В модуле Defects данный параметр недоступен.
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➤ Чтобы отобразить связи дефектов, добавленные к родительским 
требованиям, выберите Current Req Links в списке Show Links For. Чтобы 
отобразить связи дефектов, добавленные к родительским или дочерним 
требованиям, выберите Including Child’s Links. Данный параметр 
доступен только в модуле Requirements.

Добавление связей дефектов
Добавить связь дефекта можно путем добавления нового дефекта или 
путем выбора существующего дефекта. При связывании объекта с 
дефектом Quality Center добавляет к объекту и связанному дефекту значок 

. 

Добавление связей путем добавления новых дефектов
Добавить связь дефекта можно путем добавления нового дефекта.

Чтобы добавить связь путем добавления нового дефекта, выполните 
следующие действия:

 1 На вкладке или в диалоговом окне Linked Defects нажмите кнопку Add and 
Link Defect или щелкните правой кнопкой мыши таблицу и выберите 
команду Add and Link Defect. Откроется диалоговое окно New Defect.

 2 Введите сведения о дефекте. Дополнительные сведения о добавлении 
дефектов см. в разделе “Добавление новых дефектов" на стр. 531. 

 3 В диалоговом окне New Defect нажмите кнопку Submit. Дефект будет 
добавлен в проект, а его связь отобразится в таблице Linked Defects.

Добавление связей путем выбора существующих 
дефектов
Добавить связь дефекта можно путем выбора существующего дефекта.

Чтобы добавить связь путем выбора существующего дефекта, 
выполните следующие действия.

 1 На вкладке или в диалоговом окне Linked Defects нажмите стрелку Link 
Existing Defect или щелкните правой кнопкой мыши таблицу и выберите 
команду Link Existing Defect. 
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 2 Выберите вариант By ID или Select.

➤ Чтобы добавить связь путем ввода идентификатора дефекта, выберите 
By ID. В диалоговом окне Link Existing Defect введите идентификатор 
дефекта и нажмите кнопку Link. Связь дефекта отобразится в таблице.

➤ Чтобы добавить связь путем выбора дефекта, выберите Select. 
Выберите дефект в диалоговом окне Defects to Link. Для выбора 
нескольких дефектов нажмите и удерживайте клавишу CTRL и выберите 
дефекты, которые необходимо связать. Нажмите кнопку Link. Связи 
дефектов отобразятся в таблице.

Удаление связей дефектов
Связи дефектов из таблицы Linked Defects можно удалить.

Примечание. Можно удалять только прямые связи. Косвенные связи 
удаляются автоматически после удаления прямых связей.

Чтобы удалить связь дефекта, выполните следующие действия.

 1 Выберите связь в таблице на вкладке или в диалоговом окне Linked 
Defects. Для выбора нескольких дефектов нажмите и удерживайте клавишу 
CTRL и выберите дефекты, которые необходимо удалить.

 2 Нажмите кнопку Remove Link или щелкните правой кнопкой мыши и 
выберите команду Remove Link.

 3 Нажмите кнопку Yes для подтверждения.
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37
Краткий обзор модуля Libraries

В этой главе приведен краткий обзор основных элементов модуля Libraries.

Quality Center Выпуски. Выпуск Quality Center Premier Edition включает 
все функциональные возможности модуля Libraries, а выпуск Quality Center 
Enterprise Edition включает некоторые функциональные возможности этого 
модуля. Этот модуль недоступен в выпуске Quality Center Starter Edition. 

Эта глава содержит следующие разделы.

 ➤  Модуль Libraries на стр. 560

 ➤  Строка меню Libraries на стр. 561

 ➤  Панель инструментов Libraries на стр. 561

 ➤  Поля библиотеки и базового состояния на стр. 562
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Модуль Libraries
Модуль Libraries используется для определения библиотек в Quality Center. 
Чтобы открыть этот модуль, нажмите кнопку Management на боковой 
панели, а затем выберите вкладку Libraries.

Модуль Libraries содержит следующие основные элементы.

➤ Строка меню Libraries. Раскрывающиеся меню с командами модуля 
Libraries. Дополнительные сведения см. в разделе “Строка меню Libraries" 
на стр. 561.

➤ Панель инструментов Libraries. Содержит кнопки вызова команд модуля 
Libraries. Дополнительные сведения см. в разделе “Панель инструментов 
Libraries" на стр. 561.

➤ Дерево библиотек. Представление библиотек и базовых состояний в виде 
иерархической структуры дерева. Дополнительные сведения см. в 
Глава 38, "Библиотеки и базовые состояния"..

➤ Вкладка Details. Описание папки библиотеки, библиотеки или базового 
состояния, выбранных в настоящий момент в дереве библиотек. 
Дополнительные сведения о полях модуля Libraries см. в разделе “Поля 
библиотеки и базового состояния" на стр. 562.
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В области Entities показан список корневых папок, связанных с 
библиотекой. Дополнительные сведения см. в Глава 38, "Библиотеки и 
базовые состояния"..

➤ Выпуск Quality Center Premier Edition. Доступны следующие 
дополнительные вкладки для импорта библиотек.

➤ Вкладка Imported By. Список проектов, в которые была импортирована 
выбранная библиотека. Дополнительные сведения см. в разделе 
“Просмотр связанных библиотек" на стр. 594. Эта вкладка отображается 
только в том случае, если выбранная библиотека была импортирована в 
текущий проект или другие проекты.

➤ Вкладка Imported From. Подробные сведения о библиотеке, из которой 
была импортирована текущая выбранная библиотека. Дополнительные 
сведения см. в разделе “Просмотр связанных библиотек" на стр. 594. 
Эта вкладка отображается только в том случае, если выбранная 
библиотека является импортированной.

Строка меню Libraries
Строка меню Libraries содержит следующие меню.

➤ Меню Libraries содержит команды, позволяющие добавлять папки 
библиотек, библиотеки и базовые состояния. Это меню также содержит 
команду для сравнения библиотек и базовых состояний. Дополнительные 
сведения см. в Глава 38, "Библиотеки и базовые состояния"..

➤ Меню Edit содержит команды, позволяющие вырезать, вставлять, удалять 
и переименовывать папки библиотек, библиотеки и базовые состояния.

➤ Меню View содержит команду для обновления дерева библиотек.

Панель инструментов Libraries
Панель инструментов модуля Libraries содержит следующие кнопки.

New Folder. Добавление новой папки в дерево библиотек.

Create Library. Добавление новой библиотеки в дерево библиотек.
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Выпуск Quality Center Premier Edition. Import Library. Импорт новой 
библиотеки и ее добавление в дерево библиотек. Дополнительные 
сведения см. в Глава 39, "Импорт библиотек"..

Create Baseline. Создание базового состояния и добавление его в дерево 
библиотек.

Compare To. Сравнение текущей выбранной библиотеки или базового 
состояния с другими библиотеками или базовыми состояниями. 
Дополнительные сведения см. в разделах “Средство сравнения базовых 
состояний" на стр. 573 и “Средство сравнения библиотек" на стр. 598.

Cut. Вырезает папку библиотек или библиотеку из дерева библиотек для 
перемещения в другое местоположение в дереве.

Paste. Вставляет вырезанную папку библиотек или библиотеку в указанное 
местоположение в дереве.

Delete. Удаление выбранного элемента. При удалении папки библиотек 
также удаляются библиотеки и базовые состояния. При удалении 
библиотеки также удаляются ее базовые состояния.

Refresh. Обновление дерева библиотек и вкладок с учетом наиболее 
актуальных данных.

Поля библиотеки и базового состояния
На вкладке Details модуля Libraries отображаются следующие поля.

Поле Описание

Name Имя папки библиотек, библиотеки или базового состояния.

Created By Имя пользователя, создавшего библиотеку или базовое 
состояние.

Creation Date Дата создания библиотеки или базового состояния.
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Примечания. 

➤ Можно добавлять поля, определенные пользователем, и изменять 
заголовки любых полей на вкладке Details. Также предусмотрена 
возможность настройки списков проектов. Дополнительные сведения 
см. в документе HP Quality Center Administrator Guide.

➤ Для ограничения и динамического изменения полей и значений модуля 
Libraries можно использовать редактор Script Editor. Дополнительные 
сведения см. в документе HP Quality Center Administrator Guide.

Library ID Уникальный числовой идентификатор библиотеки, 
автоматически назначенный в среде Quality Center.

Baseline ID Уникальный числовой идентификатор базового состояния, 
автоматически назначенный в среде Quality Center.

Modified Дата и время последнего переименования или изменения 
описания базового состояния.

Description Описание папки библиотек, библиотеки или базового 
состояния.

Поле Описание
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38
Библиотеки и базовые состояния

Для создания библиотек используется модуль Libraries. После создания 
библиотеки вы сможете создавать и сравнивать базовые состояния 
библиотеки для отслеживания изменений проекта.

Quality Center Выпуски. Функциональные возможности модуля Libraries, 
описанные в этой главе, доступны только в выпусках Quality Center 
Enterprise Edition и Quality Center Premier Edition.

Эта глава содержит следующие разделы.

 ➤  О библиотеках и базовых состояниях на стр. 566

 ➤  Создание дерева библиотек на стр. 567

 ➤  Создание библиотек на стр. 567

 ➤  Создание базовых состояний на стр. 569

 ➤  Средство сравнения базовых состояний на стр. 573

 ➤  Настройка параметров сравнения на стр. 576

 ➤  Просмотр истории изменения базового состояния на стр. 578

 ➤  Прикрепление набора тестов к базовому состоянию на стр. 579

 ➤  Изменение дерева библиотек на стр. 580

 ➤  Сравнение объектов на стр. 583
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О библиотеках и базовых состояниях
Модуль Libraries позволяет определить иерархическое дерево библиотек 
для создания библиотек и управления ими. Библиотека — набор объектов 
в проекте и отношений между ними. Объекты в библиотеке могут включать 
требования, тесты, ресурсы тестов и бизнес-компоненты. Дополнительные 
сведения см. в разделе “Создание дерева библиотек" на стр. 567.

После создания библиотеки можно создать базовое состояние. При 
создании базового состояния библиотеки формируется моментальный 
снимок библиотеки в определенный момент времени. Базовые состояния 
позволяют отслеживать изменения проекта. Дополнительные сведения о 
базовых состояниях см. в разделе “Создание базовых состояний" на 
стр. 569

Базовые состояния можно сравнивать на всех стадиях жизненного цикла 
разработки приложения. Например, можно сравнить два базовых 
состояния в библиотеке, чтобы проанализировать изменения требований в 
библиотеке с течением времени. Кроме того, можно сравнивать базовое 
состояние с текущими объектами библиотеки. Дополнительные сведения 
см. в разделе “Средство сравнения базовых состояний" на стр. 573.

Quality Center Выпуск Premier Edition. Поддерживается импорт 
библиотек. Возможность импорта библиотеки позволяет повторно 
использовать существующий набор объектов. Дополнительные сведения 
см. в Глава 39, "Импорт библиотек"..

Для создания библиотек и базовых состояний и управления ими 
необходимы соответствующие разрешения пользователя. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.
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Создание дерева библиотек
Иерархическая структура библиотек создается путем построения дерева 
библиотек, которое может содержать папки и вложенные папки.

Чтобы создать дерево библиотек, выполните следующие действия.

 1 В модуле Libraries выберите папку Libraries.

 2 Нажмите кнопку New Folder или выберите командуLibraries > New Folder. 
Откроется диалоговое окно New Library Folder.

 3 В поле Library Folder Name введите имя папки, а затем нажмите кнопку 
OK. Новая папка будет добавлена в дерево библиотек.

 4 На вкладке Details введите описание папки библиотек в области 
Description.

 5 Чтобы создать дополнительные папки, выберите папку и повторите шаги 2 
– 4.

Создание библиотек
После создания дерева библиотек можно добавлять библиотеки в папки 
библиотек. Можно создать новую библиотеку или импортировать 
существующую. Дополнительные сведения об импорте библиотек см. в 
Глава 39, "Импорт библиотек"..

Чтобы добавить библиотеку в папку библиотек, выполните 
следующие действия.

 1 Выберите папку библиотек в дереве библиотек.
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 2 Нажмите кнопку Create Library или выберите команду Libraries > Create 
Library. Откроется диалоговое окно Create Library.

 3 В поле Name введите имя библиотеки. Имя не должно содержать 
следующих символов: \ / : * ? " < > |

 4 В разделе Select Entities выберите папки, которые необходимо включить в 
библиотеку. Можно выбрать одну или несколько корневых папок для 
каждого из модулей Requirements, Business Components, Test Plan и Test 
Resources. Дополнительные сведения о модуле Business Components см. в 
документе  HP Business Process Testing User Guide.

 5 В поле Description введите описание библиотеки.

 6 Нажмите кнопку ОK. Новая библиотека будет добавлена в дерево 
библиотек. 
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Создание базовых состояний
После создания библиотеки можно создать базовое состояние. Базовое 
состояние представляет собой моментальный снимок библиотеки в 
определенный момент времени. Базовое состояние можно использовать 
для того, чтобы отметить важный этап жизненного цикла разработки 
приложения. Базовое состояние включает все объекты, определенные в 
библиотеке, в том числе требования, тесты и ресурсы тестов. Базовые 
состояния также включают отношения между объектами библиотеки, 
например, прослеживаемость и покрытие. Базовые состояния позволяют 
отслеживать изменения проекта.

При создании базового состояния Quality Center сначала проверяет 
библиотеку. В процессе проверки связи выполняется проверка наличия в 
библиотеке объектов, связанных с объектами, не входящими в библиотеку.

Можно использовать базовые состояния следующими способами.

➤ Сравнение двух базовых состояний для просмотра изменений в 
библиотеке на различных стадиях разработки. Дополнительные сведения 
см. в разделе “Средство сравнения базовых состояний" на стр. 573.

➤ Прикрепление набора тестов к базовому состоянию. Это позволяет 
Quality Center выполнять версии тестов, хранящиеся в указанном базовом 
состоянии при выполнении набора тестов. Дополнительные сведения см. в 
разделе “Прикрепление набора тестов к базовому состоянию" на стр. 579.

➤ Выпуск Quality Center Premier Edition. Использование базового 
состояния для совместного использования объектов в библиотеке. Это 
позволяет повторно использовать объекты библиотеки в текущем проекте 
или в другом проекте. Чтобы импорт библиотеки был возможен, она должна 
содержать базовое состояние. Дополнительные сведения см. в Глава 39, 
"Импорт библиотек"..
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Примеры базовых состояний
В следующих примерах показано, как можно использовать базовые 
состояния.

➤ Определение содержания релиза — подписи заинтересованных лиц.

Организация приступает к разработке новой версии приложения. 
Бизнес-аналитик представляет группу требований на рассмотрение 
заинтересованным лицам. После рассмотрения и утверждения требований 
создается базовое состояние. После этого заинтересованные лица могут 
поставить свои подписи под согласованным содержанием релиза.

➤ Мониторинг изменений.

Менеджер продукта обнаруживает, что разработка продукта реализуется с 
отличиями от его ожиданий. Он анализирует требования к продукту и 
обнаруживает, что некоторые требования были изменены. Он сравнивает 
текущие требования с требованиями в базовом состоянии, созданном и 
согласованном в начале работы над релизом.

➤ Оценка влияния изменений.

Тестировщик отвечает за большую группу тестов, которые входят в 
последний релиз приложения. Он обновляет некоторые тесты в 
соответствии с требованиями к этому релизу. По результатам последнего 
заседания по рассмотрению требований тестировщик получает 
уведомление о том, что некоторые требования изменились. Тестировщик 
сравнивает текущие требования с требованиями в базовом состоянии, 
созданном в начале работы над релизом. Он выявляет требования, 
которые влияют на его тест и обновляет тесты с учетом изменений.

Создание базового состояния
Можно создать базовое состояние для библиотеки.

Чтобы создать базовое состояние, выполните следующие действия.

 1 Выберите библиотеку в дереве библиотек.

 2 Нажмите кнопку Create Baseline или выберите команду Libraries > Create 
Baseline. Начинается процесс проверки.
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Для каждого объекта в библиотеке, связанного с другим объектом в 
проекте, Quality Center проверяет принадлежность связанного объекта к 
этой библиотеке. Например, для каждого теста с покрытием требований 
Quality Center проверяет принадлежность связанного требования к той же 
библиотеке.

Если в библиотеке присутствуют объекты, связанные с объектами, не 
принадлежащими к этой библиотеке, Quality Center создает список этих 
объектов, после чего открывается диалоговое окно Broken Links Verification.

 3 Чтобы сохранить результаты проверки в виде текстового файла, нажмите 
кнопку Save Log. В диалоговом окне Save As введите имя файла и 
нажмите кнопку Save. Журнал проверки недействительных ссылок будет 
загружен и сохранен в указанном местоположении. Прежде чем 
продолжить создание базового состояния, просмотрите журнал и 
устраните имеющиеся проблемы.

 4 Чтобы продолжить создание базового состояния, нажмите кнопку 
Continue. Откроется диалоговое окно New Baseline.
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 5 В поле Baseline Name введите имя нового базового состояния.

 6 Нажмите кнопку ОK. Базовое состояние будет добавлено в дерево 
библиотек, и начнется процесс его создания. 

Создание базового состояния осуществляется в фоновом режиме и может 
занять некоторое время. В процессе создания базового состояния можно 
продолжать работу с Quality Center.

 7 Нажмите кнопку View Log на вкладке Details. Откроется диалоговое окно 
Log: Create Baseline, в котором будет показан ход выполнения процесса. 
Нажмите кнопку Close, чтобы закрыть диалоговое окно.

Примечание. По завершении процесса просмотрите журнал перед 
обновлением экрана. Если обновить экран после создания базового 
состояния, кнопка View Log более не будет отображаться, и просмотр 
журнала станет невозможен.

 8 Нажмите кнопку Refresh на панели инструментов модуля, чтобы обновить 
экран. На вкладке Details будут показаны подробные сведения о базовом 
состоянии. Дополнительные сведения о полях, отображаемых на вкладке 
Details, см. в разделе “Поля библиотеки и базового состояния" на стр. 562.

 9 На вкладке Details выберите область Description, чтобы добавить 
описание базового состояния.
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Средство сравнения базовых состояний
Можно сравнивать между собой два базовых состояния библиотеки. 
Например, можно сравнивать базовые состояния на разных стадиях 
разработки, чтобы оценить влияние изменений требований в проекте. 
Затем можно будет обновить соответствующие тесты.

Кроме того, можно сравнивать базовое состояние с текущими объектами 
библиотеки. Предположим, что базовое состояние создано в начале нового 
релиза. Со временем требования в библиотеке меняются. Чтобы 
определить, соответствует ли разработка продукта планам, можно 
сравнить требования исходного базового состояния с текущими 
требованиями в библиотеке.

Примечания.

➤ Quality Center не учитывает изменения полей Target Release и Target 
Cycle при определении наличия изменений объекта.

➤ Если взаимоотношение покрытия или прослеживаемости между двумя 
объектами было удалено, а затем снова добавлено, эти объекты 
считаются измененными.

Чтобы сравнить базовые состояния, выполните следующие 
действия.

 1 В дереве библиотек разверните библиотеку и выберите базовое 
состояние. Нажмите кнопку Compare To или выберите команду Libraries > 
Compare To, а затем выберите базовое состояние для сравнения.

➤ Выберите вариант Select Baseline, чтобы сравнить выбранное базовое 
состояние с другим базовым состоянием в библиотеке. Откроется 
диалоговое окно Select Baseline. Нажмите кнопку обзора и выберите 
базовое состояние из списка. Нажмите кнопку ОK. 

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Baseline.

➤ Выберите вариант Current Entities, чтобы сравнить выбранное базовое 
состояние с текущими объектами в библиотеке.
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 2 Откроется диалоговое окно Compare Baselines Tool.

Базовые состояния будут показаны в отдельных областях окна, при этом 
базовое состояние, созданное позднее, или текущие объекты, будут 
показаны в области справа. В каждой панели элементы библиотеки 
отображаются в виде иерархической структуры, заданной для конкретного 
модуля. 

Различия между двумя базовыми состояниями отображаются в столбце 
Changes. Средство сравнения базовых состояний обнаруживает 
следующие типы изменений.

Изменение Описание

Added Объект не существовал в базовом состоянии, 
созданном раньше.

Modified Обнаружены различия в объекте в различных 
базовых состояниях.
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Число добавленных, измененных, удаленных и перемещенных объектов 
указывается счетчиком над каждой областью окна.

Удаленный или перемещенный объект отображается в первоначальном 
местоположении в дереве; положение объекта указывается прототипом. 
Это позволяет сохранить иерархическую структуру и легко сравнивать 
изменения между базовыми состояниями.

 3 Нажмите кнопку на боковой панели, чтобы просмотреть результаты 
сравнения для объектов определенного модуля. Например, нажмите 
кнопку Tests, чтобы просмотреть результаты сравнения для модуля Test 
Plan. В боковой панели будут показаны только модули, включенные в 
библиотеку.

Deleted Объект не существует в базовом состоянии, 
созданном позднее.

Moved Объект был перемещен в другое местоположение 
в структуре дерева в базовом состоянии, 
созданном позднее.

Изменение Описание
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 4 Нажимайте кнопку Go to Next Change в правой области окна, чтобы 
перейти к следующему изменению, или кнопку Go to Previous Change, 
чтобы перейти к предыдущему изменению.

 5 Чтобы просмотреть дополнительные сведения об объекте, выберите 
объект и нажмите кнопку Details на панели инструментов. Откроется 
диалоговое окно Details со сведениями об объекте. Например, выберите 
требование и нажмите кнопку Details. Откроется диалоговое окно 
Requirement Details, в котором будут показаны подробные сведения о 
выбранном требовании в выбранном базовом состоянии.

 6 Чтобы сравнить измененный объект в разных базовых состояниях, 
выберите объект и нажмите кнопку Compare Entities на панели 
инструментов. Откроется диалоговое окно Compare Entities, в котором 
будут показаны сведения об объекте в каждом базовом состоянии. 
Дополнительные сведения см. в разделе “Сравнение объектов" на стр. 583.

 7 Чтобы настроить параметры средства сравнения базовых состояний, 
нажмите кнопку Comparison Settings на панели инструментов. 
Дополнительные сведения см. в разделе “Настройка параметров 
сравнения.”.

Настройка параметров сравнения
Можно настроить параметры сравнения библиотек или базовых состояний. 
Диалоговое окно Comparison Settings позволяет выбрать поля, которые 
должны учитываться Quality Center при определении наличия изменений 
объекта.

Примечание. Quality Center не учитывает изменения полей Target Release 
и Target Cycle при определении наличия изменений объекта.
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Чтобы настроить параметры сравнения, выполните следующие 
действия.

 1 В окне средства сравнения базовых состояний или средства сравнения 
библиотек нажмите кнопку Comparison Settings. Откроется диалоговое 
окно Comparison Settings.

 2 Перейдите на вкладку в соответствии с типом объектов, параметры 
сравнения которых требуется настроить. Например, выберите вкладку 
Tests. Будут показаны текущие настройки.

➤ Considered Fields. Quality Center считает объект измененным на 
основании изменений полей, указанных в этом списке.

➤ Ignored Fields. Quality Center не считает объект измененным при 
изменении полей, указанных в этом списке.

 3 Выберите имена полей и с помощью кнопок со стрелками (> и <) 
перемещайте их между списками Ignored Fields и Considered Fields. 
Чтобы переместить все поля из одного списка в другой, используйте кнопки 
с двумя стрелками (>> и <<). Также можно дважды щелкнуть имя поля, 
чтобы переместить поле в другой список.
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 4 В разделе Additional Considered Fields выберите дополнительные поля, 
которые следует учитывать. Чтобы Quality Center не учитывал покрытие, 
снимите флажок Coverage на вкладках Requirements и Tests.

Просмотр истории изменения базового состояния
Можно просмотреть все версии объекта, хранящиеся в базовом состоянии. 
Эта возможность доступна для объектов в модулях Requirements, Business 
Components, Test Plan и Test Resources. Также можно сравнивать две 
версии базового состояния. Дополнительные сведения о модуле Business 
Components см. в документе  HP Business Process Testing User Guide.

Управление версиями. Можно просматривать все предыдущие версии 
объекта. Дополнительные сведения см. в разделе “Просмотр истории 
версий" на стр. 120.

Чтобы просмотреть историю изменения базового состояния, 
выполните следующие действия.

 1 Выберите объект в дереве или в таблице. Перейдите на вкладку History, а 
затем выберите вкладку Baselines.

Управление версиями. На вкладке History выберите вкладку Versions 
and Baselines. В поле View By выберите Baselines.

История изменения базового состояния будет показана в таблице.

 2 В разделе Description for selected baseline можно просмотреть описание, 
введенное пользователем при создании базового состояния.

Столбец Описание

Baseline Имя базового состояния, к которому относится 
объект.

Library Библиотека, для которой было создано базовое 
состояние.

Date Дата создания базового состояния.

Created By Имя пользователя, создавшего базовое состояние.
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 3 Чтобы просмотреть версию объекта, сохраненного в базовом состоянии, 
выберите базовое состояние и нажмите кнопку View. Откроется 
диалоговое окно Details, в котором в режиме только для чтения будут 
показаны сведения о версии объекта, сохраненного в выбранном базовом 
состоянии. Нажимайте кнопки на боковой панели, чтобы просмотреть 
дополнительные сведения. Отображаемые кнопки могут меняться в 
зависимости от объекта, выбранного в дереве или в таблице.

Примечание. При просмотре сведений для теста QuickTest кнопка Test 
Script позволяет открыть тест в средстве просмотра QuickTest, чтобы 
просмотреть тест или открыть его в приложении QuickTest. 
Дополнительные сведения см. в документе HP QuickTest Professional User 
Guide.

Нажмите кнопку Close, чтобы закрыть диалоговое окно Details.

 4 Чтобы сравнить две версии базового состояния, нажмите клавишу CTRL и 
выберите обе версии. Можно сравнивать две версии базового состояния, 
если базовые состояния относятся к одной библиотеке.

Нажмите кнопку Compare. Дополнительные сведения о сравнении версий 
базовых состояний см. в разделе “Сравнение объектов" на стр. 583

Прикрепление набора тестов к базовому состоянию
Можно прикрепить набор тестов к базовому состоянию. При этом набор 
тестов будет связан с тестами, хранящимися в выбранном базовом 
состоянии. При выполнении набора тестов, прикрепленного к базовому 
состоянию, Quality Center выполняет версии тестов, которые хранятся в 
указанном базовом состоянии.

Набор тестов, прикрепленный к базовому состоянию, может включать 
только тесты, которые содержатся в базовом состоянии. При прикреплении 
набора тестов к базовому состоянию тесты, которые не входят в это 
базовое состояние, удаляются из набора тестов. Кроме того, из набора 
тестов удаляются все выполнения тестов.



Глава 38 • Библиотеки и базовые состояния

580

Дополнительные сведения о базовых состояниях см. в разделе “Создание 
базовых состояний" на стр. 569.

Чтобы прикрепить набор тестов к базовому состоянию, выполните 
следующие действия.

 1 В модуле Test Lab выберите набор тестов в дереве наборов тестов.

 2 Выберите команду Test Sets > Pin to Baseline или щелкните правой 
кнопкой мыши и выберите команду Pin to Baseline. Откроется диалоговое 
окно Pinned to Baseline, в котором будет показано дерево библиотек.

 3 Выберите базовое состояние и нажмите кнопку OK. Отображается 
подтверждающее сообщение. Для подтверждения нажмите кнопку OK. В 
дереве наборов тестов значок набора тестов  будет заменен значком 
прикрепленного набора тестов .

 4 Чтобы отменить прикрепление набора тестов, выберите набор тестов и 
выберите команду Test Sets > Clear Pinned Baseline. Отображается 
подтверждающее сообщение. Если набор тестов включает тесты, не 
существующие в модуле Test Plan, Quality Center удаляет тесты из набора 
тестов. Кроме того, из набора тестов удаляются все выполнения тестов. 
Для подтверждения нажмите кнопку OK. Тесты в наборе тестов будут 
связаны с текущими тестами в модуле Test Plan.

Изменение дерева библиотек
В данном разделе описано следующее.

➤ Переименование папок библиотек, библиотек и базовых состояний

➤ Перемещение папок библиотек и библиотек

➤ Удаление папок библиотек, библиотек и базовых состояний
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Переименование папок библиотек, библиотек и базовых 
состояний
Можно переименовать папку библиотек, библиотеку или базовое 
состояние.

Чтобы переименовать папку библиотек, библиотеку или базовое 
состояние, выполните следующие действия.

 1 Выберите элемент в дереве библиотек.

 2 Выберите команду Edit > Rename. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Rename.

 3 Измените имя и нажмите клавишу ENTER.

Перемещение папок библиотек и библиотек
Папку библиотек или библиотеку можно переместить в другое 
местоположение в дереве библиотек. При перемещении папки библиотек 
также будут перемещены библиотеки и базовые состояния, находящиеся в 
этой папке. При перемещении библиотеки также будут перемещены ее 
базовые состояния. Нельзя перемещать базовые состояния и корневую 
папку Libraries.

Совет. Также можно переместить папку библиотек или библиотеку в новое 
местоположение в дереве библиотек путем перетаскивания.

Чтобы переместить папку библиотек или библиотеку, выполните 
следующие действия.

 1 Выберите папку библиотек или библиотеку в дереве библиотек. Чтобы 
переместить несколько элементов, нажмите клавишу Ctrl и выберите 
элементы, которые необходимо переместить.

 2 Нажмите кнопку Cut. Также можно выбрать команду Edit > Cut.

 3 Выберите папку в дереве библиотек.

 4 Нажмите кнопку Paste. Также можно выбрать команду Edit > Paste.
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Удаление папок библиотек, библиотек и базовых 
состояний
Можно удалить папку библиотек, библиотеку или базовое состояние. 
Нельзя удалить папку библиотек, в которой находятся библиотеки, или 
удалить библиотеку, которая имеет базовые состояния. При удалении 
библиотеки или базового состояния объекты библиотеки не будут удалены 
из проекта.

Перед удалением базового состояния примите во внимание следующие 
факты.

➤ После удаления базового состояние сравнение библиотеки, для которой 
было создано это базовое состояние, с библиотекой, импортированной из 
этого базового состояния или синхронизированной с ним, будет 
невозможно.

➤ При удалении базового состояния оно будет удалено из прикрепленных 
наборов тестов. Дополнительные сведения см. в разделе “Прикрепление 
набора тестов к базовому состоянию" на стр. 579.

Чтобы удалить папку библиотек, библиотеку или базовое состояние, 
выполните следующие действия.

 1 Выберите элемент в дереве библиотек. Для удаления нескольких 
элементов нажмите клавишу CTRL и выберите элементы, которые 
необходимо удалить.

 2 Нажмите кнопку Delete. Также можно выбрать команду Edit > Delete. 
Отображается подтверждающее сообщение.

 3 Нажмите кнопку Yes для подтверждения. Элементы будут удалены.
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Сравнение объектов
Диалоговое окно Compare Entities позволяет сравнивать объекты. Открыть 
диалоговое окно Compare Entities можно описанными ниже способами.

➤ Сравнение объекта в двух базовых состояниях на странице History 
модулей Requirements, Test Plan и Test Resources. Дополнительные 
сведения см. в разделе “Просмотр истории изменения базового состояния" 
на стр. 578.

➤ Сравнение объекта в двух базовых состояниях в диалоговом окне Compare 
Baselines Tool. Дополнительные сведения см. в разделе “Средство 
сравнения базовых состояний" на стр. 573.

➤ Сравнение объекта в двух библиотеках в диалоговом окне Compare 
Libraries Tool. Дополнительные сведения см. в разделе “Средство 
сравнения библиотек" на стр. 598.

➤ Управление версиями. Сравнение двух версий объекта на странице 
History модулей Requirements, Test Plan и Test Resources. Дополнительные 
сведения см. в разделе “Просмотр истории версий" на стр. 120.

Примечания. 

➤ Изменения полей Target Release и Target Cycle не приводят к отметке 
этих полей как измененных.

➤ Управление версиями. При сравнении двух версий объекта 
отображаются не все кнопки боковой панели. Доступные кнопки 
определяются информацией, сохраненной в системе управления 
версиями. Дополнительные сведения см. в разделе “Обзор управления 
версиями" на стр. 110.
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Чтобы сравнить объекты, выполните следующие действия.

 1 На боковой панели диалогового окна Compare Entities нажмите кнопку 
Details. 

В столбце Field Name будут показаны поля объекта. Можно сравнивать 
значения полей в разных версиях объекта. Измененные поля отмечены 
значением Modified в столбце Changes.

Управление версиями. Изменения некоторых полей не сохраняются в 
системе управления версиями. Дополнительные сведения см. в разделе 
“Поля, исключенные из управления версиями" на стр. 114.

 2 В списке View выберите один из следующих вариантов.

➤ Show All. Будут показаны все поля объекта.

➤ Show Only Changed. Будут показаны поля, значения которых были 
изменены.

➤ Show Only Unchanged. Будут показаны поля, значения которых не 
были изменены.
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 3 Перейдите на вкладку Rich Text, чтобы сравнить форматированный текст 
объекта. В каждой области вкладки Rich Text указывается добавление, 
удаление или изменение форматированного текста в соответствующей 
версии объекта.

 4 Можно открыть или сохранить форматированный текст в файл, чтобы 
просмотреть его и сравнить изменения.

➤ Чтобы просмотреть форматированный текст, нажмите кнопку Open в 
соответствующей версии объекта.

➤ Чтобы сохранить форматированный текст в файл, нажмите кнопку Save 
As в соответствующей версии объекта. В диалоговом окне Save As 
введите имя файла и нажмите кнопку Save. Форматированный текст 
будет загружен и сохранен в указанном местоположении.

 5 Чтобы просмотреть дополнительные результаты сравнения, такие как 
прослеживаемость и покрытие, нажмите кнопку на боковой панели. 
Отображаемые кнопки определяются типом объектов, выбранных для 
сравнения.
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Примечания.

➤ При сравнении объектов QuickTest отображается кнопка QTP 
Comparison, которая позволяет открыть средство QuickTest Asset 
Comparison Tool. Дополнительные сведения о работе с приложением 
QuickTest см. в документе HP QuickTest Professional User Guide.

➤ При сравнении прослеживаемости и покрытия, если связанный объект 
отмечен одновременно метками Deleted и Added, или если он отмечен 
меткой Missing с обеих сторон, это может указывать на то, что связь 
между объектами была удалена, а потом добавлена снова.

 6 Нажмите кнопку Attachments на боковой панели, чтобы сравнить вложения 
объекта. В столбце Changes будут отмечены добавленные, удаленные и 
измененные вложения. 

 7 Можно открывать и сохранять вложения, чтобы просматривать и 
сравнивать изменения.

➤ Чтобы просмотреть вложение, дважды щелкните его или выберите 
вложение и нажмите кнопку Open Attachment.

➤ Чтобы сохранить вложение, выберите его и нажмите кнопку Save As. В 
диалоговом окне Save As введите имя файла и нажмите кнопку Save. 
Вложение будет загружено и сохранено в указанном местоположении.
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39
Импорт библиотек

Можно импортировать библиотеку, чтобы повторно использовать объекты 
библиотеки в проекте или различных проектах организации.

Quality Center Выпуск Premier Edition. Функциональность модуля 
Libraries, описанная в этой главе, доступна только в выпуске Quality Center 
Premier Edition.

Эта глава содержит следующие разделы.

 ➤  Об импорте библиотек на стр. 588

 ➤  Импорт библиотеки на стр. 590

 ➤  Просмотр связанных библиотек на стр. 594

 ➤  Средство сравнения библиотек на стр. 598

 ➤  Синхронизация библиотек на стр. 602

 ➤  Отправка библиотек по электронной почте на стр. 605
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Об импорте библиотек
Возможность импорта библиотеки позволяет совместно использовать 
существующие наборы объектов в различных проектах. Чтобы 
импортировать библиотеку, необходимо выбрать базовое состояние в 
другой библиотеке, из которой выполняется импорт. Можно импортировать 
библиотеку из текущего проекта или из другого проекта. Дополнительные 
сведения о создании библиотек и базовых состояний см. в Глава 38, 
"Библиотеки и базовые состояния".

Можно сравнивать связанные библиотеки на всех стадиях жизненного 
процесса разработки приложения. Например, можно сравнить 
импортированную библиотеку с исходной библиотекой, которая 
использовалась в качестве источника при импорте. Дополнительные 
сведения см. в разделе “Средство сравнения библиотек" на стр. 598.

При изменении объектов в библиотеке можно синхронизировать 
библиотеки, чтобы обновить объекты в связанной библиотеке. 
Дополнительные сведения см. в разделе “Синхронизация библиотек" на 
стр. 602.

Для импорта и синхронизации библиотек необходимы соответствующие 
разрешения пользователя. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Примечание. Также можно совместно использовать дефекты в различных 
проектах Quality Center. Для совместного использования и синхронизации 
дефектов используется средство HP Quality Center Synchronizer. 
Дополнительные сведения см. в документе Руководство пользователя 
HP Quality Center Synchronizer, доступном на странице надстроек Quality 
Center.
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Примеры библиотек
В следующих примерах показано, как можно использовать библиотеки.

➤ Повторное использование требований и тестов в новом релизе.

При разработке нового приложения создается библиотека, которая 
включает все объекты в проекте, относящиеся к приложению. Результатом 
работы является релиз нового приложения. При подготовке к работе над 
следующей версией можно импортировать библиотеку и приступить к 
настройке требований и тестов в соответствии с новой версией.

➤ Создание набора требований, тестов и ресурсов для использования с 
несколькими приложениями.

Проект содержит требования, определенные в модуле Requirements, 
относящиеся к разрабатываемому приложению. В модуле Test Plan проект 
также содержит тесты, разработанные для тестирования соответствия 
указанным требованиям. Кроме того, созданы взаимоотношения между 
требованиями и тестами, такие как прослеживаемость и покрытие. Можно 
создать библиотеку, представляющую приложение. После этого можно 
импортировать библиотеку как самостоятельный компонент других 
приложений.

➤ Обновление импортированных библиотек с учетом изменений 
исходной библиотеки.

Библиотека в проекте включает требования и тесты для приложения 
калькулятора. Эта библиотека импортирована в различные другие 
проекты; эти проекты используют требования и тесты приложения в других 
разрабатываемых приложениях. Бизнес-аналитик пересмотрел некоторые 
требования для приложения калькулятора. Чтобы внести эти изменения в 
импортированные библиотеки, можно синхронизировать импортированные 
библиотеки с исходной библиотекой.
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➤ Обновление исходной библиотеки с учетом изменений в 
импортированной библиотеке.

Тестировщик работает с импортированной библиотекой, которая содержит 
набор регрессионных тестов для разрабатываемого банковского 
приложения. В процессе тестирования тестировщик разрабатывает новые 
тесты для тестирования новых функциональных возможностей новой 
версии банковского приложения. По завершении тестирования 
тестировщику требуется обновить регрессионные тесты в исходной 
библиотеке. Чтобы обновить тесты в исходной библиотеке для 
использования в последующих тестах, можно синхронизировать исходную 
библиотеку с импортированной.

Импорт библиотеки
Можно импортировать библиотеку в дерево библиотек из текущего проекта 
или из другого проекта. При импорте библиотеки она добавляется в дерево 
библиотек, а объекты библиотеки копируются в соответствующие модули 
проекта. Если библиотека содержит связанные объекты, например 
требования, имеющие покрытие тестами, это взаимоотношение также 
копируется. Импортированная библиотека отображается значком 
импортированной библиотеки  в дереве библиотек.

Чтобы импортировать библиотеку, необходимо выбрать базовое состояние 
в другой библиотеке, из которой выполняется импорт. После импорта 
библиотеки Quality Center автоматически создает базовое состояние для 
новой библиотеки в проекте. Это базовое состояние служит основой для 
сравнения библиотек в любой момент времени, и его не следует удалять. 
Дополнительные сведения о базовых состояниях см. в Глава 38, 
"Библиотеки и базовые состояния".

При импорте библиотеки Quality Center сначала выполняет проверку 
возможности успешного импорта библиотеки. Процесс проверки включает 
следующие операции.
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➤ Проверка типов требований. Выполняется проверка наличия в проекте 
требуемых типов требований. Если исходная библиотека содержит типы 
требований, определенные пользователем, в проекте должны 
присутствовать те же типы требований. Дополнительные сведения о типах 
требований см. в документе HP Quality Center Administrator Guide.

➤ Проверка совместимости объектов. Выполняется проверка наличия 
требуемых расширений, включенных в проекте. Если в исходном проекте 
включено расширение Quality Center, а исходная библиотека включает 
объекты для этого расширения, в текущем проекте также должны быть 
включены эти расширения. Дополнительные сведения о расширениях см. в 
документе HP Quality Center Administrator Guide.

Нельзя импортировать библиотеку на место уже импортированной 
библиотеки в дереве требований, плана тестирования или ресурсов теста. 
Например, в дереве требований папка Travel Application представляет 
собой импортированную библиотеку. Если требуется импортировать 
библиотеку Travel Application повторно, нельзя определить папку Travel 
Application или любую вложенную папку этой папки как корневую папку для 
требований в библиотеке.

Импорт библиотеки
Можно импортировать библиотеку путем выбора базового состояния в 
текущем проекте или в другом проекте. Нельзя импортировать 
импортированную библиотеку.
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Чтобы импортировать библиотеку, выполните следующие действия.

 1 Выберите папку библиотеки в дереве библиотек.

 2 Нажмите кнопку Import Library или выберите команду Libraries > Import 
Library. Открывается диалоговое окно Step 1 of 3: Select a Baseline.

 3 Выберите один из следующих вариантов.

➤ From Current Project. Импорт библиотеки из текущего проекта.

➤ From Project. Выбор домена и проекта, из которого требуется 
импортировать библиотеку.

В списке Domain выберите домен.

В списке Project выберите нужный проект.

 4 В поле Select a Baseline нажмите кнопку обзора. Откроется дерево 
библиотек выбранного проекта, в котором будут показаны библиотеки, 
доступные для импорта. Разверните библиотеку и выберите базовое 
состояние, из которого требуется импортировать библиотеку, а затем 
нажмите кнопку OK. Описания библиотеки и базового состояния будут 
показаны в поле Description.

 5 Нажмите кнопку Next. Откроется диалоговое окно Step 2 of 3: Library 
Verification, в котором будут показаны результаты проверки и список 
импортируемых полей.
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Если какая-либо из проверок имеет статус Failed, продолжать процесс 
импорта нельзя. Нажмите кнопку Cancel.

Если все проверки имеют статус Passed, нажмите кнопку Next для 
продолжения.

 6 Откроется диалоговое окно Step 3 of 3: Select Target Root Folders.

 7 В поле Name введите имя для библиотеки или оставьте имя, предлагаемое 
по умолчанию. По умолчанию будет использоваться имя библиотеки, 
используемой для импорта, с суффиксом _Imported.

 8 В разделе Select Target Root Folders выберите местоположение в проекте 
для каждой импортированной корневой папки. Например, в поле 
Requirement Root Folder укажите местоположение для импортированных 
требований. Все папки требований, определенные в библиотеке, будут 
импортированы в указанную папку требований. Нажмите кнопку обзора, 
чтобы отобразить дерево требований в проекте. Выберите 
местоположение для импортированных требований.

 9 В поле Description введите описание библиотеки или оставьте описание, 
предлагаемое по умолчанию. Если исходная библиотека и базовое 
состояние имеют описания, по умолчанию будут показаны эти описания.

 10 Нажмите кнопку Finish, чтобы импортировать библиотеку. 
Импортированная библиотека будет добавлена в дерево библиотек, и 
начнется процесс импорта.
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Импорт библиотеки осуществляется в фоновом режиме и может занять 
некоторое время. В процессе импорта можно продолжать работу с 
Quality Center.

 11 Нажмите кнопку View Log на вкладке Details. Откроется диалоговое окно 
Log: Import Library, в котором будет показан ход выполнения импорта. 
Нажмите кнопку Close, чтобы закрыть диалоговое окно.

Примечание. По завершении процесса просмотрите журнал перед 
обновлением экрана. Если обновить экран после импорта библиотеки, 
кнопка View Log более не будет отображаться, и просмотр журнала станет 
невозможен.

 12 Нажмите кнопку Refresh на панели инструментов модуля, чтобы обновить 
экран. На вкладке Details будут показаны подробные сведения о 
библиотеке. Дополнительные сведения о полях, отображаемых на вкладке 
Details, см. в разделе “Поля библиотеки и базового состояния" на стр. 562.

 13 На вкладке Details выберите область Description, чтобы добавить 
описание библиотеки или изменить существующее описание.

Просмотр связанных библиотек
Можно просматривать сведения о связанных библиотеках. Можно 
просматривать подробные сведения о проектах, в которые была 
импортирована выбранная библиотека, на вкладке Imported By. Также 
можно просматривать сведения об исходном проекте, из которого была 
импортирована библиотека, на вкладке Imported From.

Данный раздел содержит следующие подразделы.

➤ Просмотр вкладки Imported By

➤ Просмотр вкладки Imported From
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Просмотр вкладки Imported By
Можно просматривать список проектов, в которые была импортирована 
выбранная библиотека.

Чтобы просмотреть вкладку Imported By, выполните следующие 
действия.

 1 В дереве библиотек выберите библиотеку и перейдите на вкладку 
Imported By. В таблице будут перечислены проекты, в которые была 
импортирована выбранная библиотека.

На вкладке Imported By для каждой библиотеки, в которую была 
импортирована выбранная библиотека, отображаются следующие 
столбцы.

Столбец Описание

Domain Домен, в котором располагается импортированная 
библиотека.

Project Имя проекта, в который была импортирована 
библиотека.
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Можно изменить порядок отображения столбцов, перетаскивая их 
заголовки.

 2 Нажмите кнопку Refresh, чтобы обновить экран.

 3 Чтобы отправить сообщение электронной почты владельцу библиотеки, 
выберите запись в таблице и нажмите кнопку Send Mail. Дополнительные 
сведения см. в разделе “Отправка библиотек по электронной почте" на 
стр. 605.

 4 Чтобы сравнить исходную библиотеку с импортированной, нажмите кнопку 
Compare To. Дополнительные сведения см. в разделе “Средство 
сравнения библиотек" на стр. 598.

Library Name Имя импортированной библиотеки.

Source Baseline Name Начальное значение указывает имя базового 
состояния в исходном проекте, из которого была 
импортирована библиотека. После синхронизации 
значение указывает имя базового состояния в 
исходном проекте с которым была 
синхронизирована библиотека.

Import Date Дата импорта библиотеки.

Last Synchronization Дата последней синхронизации импортированной и 
исходной библиотеки.

Library Owner Имя пользователя, импортировавшего библиотеку.

Столбец Описание
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Просмотр вкладки Imported From
Можно просматривать сведения об исходной библиотеке, из которой была 
импортирована выбранная библиотека.

Чтобы просмотреть вкладку Imported From, выполните следующие 
действия.

 1 В дереве библиотек выберите импортированную библиотеку и перейдите 
на вкладку Imported From.

На вкладке Imported From будут показаны следующие поля.

Столбец Описание

Domain Домен, в котором располагается исходный проект.

Project Имя исходного проекта.

Library Name Имя библиотеки в исходном проекте.
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 2 Чтобы отправить сообщение электронной почты владельцу библиотеки, 
нажмите кнопку Send Mail to Owner. Дополнительные сведения см. в 
разделе “Отправка библиотек по электронной почте" на стр. 605.

 3 Чтобы сравнить импортированную библиотеку с исходной, нажмите кнопку 
Compare To Source. Дополнительные сведения см. в разделе “Средство 
сравнения библиотек" на стр. 598.

Средство сравнения библиотек
Можно сравнить две связанные библиотеки. Средство сравнения 
библиотек позволяет сравнивать импортированную библиотеку с исходной 
библиотекой, которая использовалась в качестве источника при импорте.

Примечания.

➤ Quality Center не учитывает изменения полей Target Release и Target 
Cycle при определении наличия изменений объекта.

➤ Если взаимоотношение покрытия или прослеживаемости между двумя 
объектами было удалено, а затем снова добавлено, эти объекты 
считаются измененными.

Также можно синхронизировать две связанные библиотеки. 
Дополнительные сведения см. в разделе “Синхронизация библиотек" на 
стр. 602.

Baseline Name Имя исходного состояния в исходном проекте, из 
которого был импортирован проект.

Last Synchronization Дата последней синхронизации импортированной и 
исходной библиотеки. При первоначальном 
импорте библиотеки это поле имеет значение N/A.

Source Library Owner Имя пользователя, создавшего библиотеку в 
исходном проекте.

Столбец Описание
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Чтобы сравнить библиотеки, выполните следующие действия.

 1 Выберите библиотеку в дереве библиотек. Нажмите кнопку Compare To 
или выберите команду Libraries > Compare To.

 2 Выберите базовое состояние, с которым требуется сравнить библиотеку.

➤ Выберите вариант Latest Baseline Created, чтобы сравнить библиотеку 
последним созданным базовым состоянием в другой библиотеке.

➤ Выберите вариант Select Baseline, чтобы выбрать базовое состояние 
для сравнения в другой библиотеке. Откроется диалоговое окно Select 
Baseline. Нажмите кнопку обзора и выберите базовое состояние из 
списка. Нажмите кнопку ОK. 

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Baseline.

 3 Открывается диалоговое окно Compare Libraries Tool.

Библиотеки будут показаны в отдельных областях окна. В левой области 
окна будет показана библиотека, выбранная в дереве библиотек. В правой 
области окна будет показано базовое состояние библиотеки, выбранной 
для сравнения. Объекты каждой библиотеки будут показаны в виде 
одинаковой иерархической структуры дерева, определенной в 
соответствующем модуле.
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Различия между двумя библиотеками будут указаны в столбце Changes 
каждой области окна. Средство сравнения библиотек обнаруживает 
следующие типы изменений.

Число добавленных, измененных, удаленных и перемещенных объектов 
указывается счетчиком над каждой областью окна.

Изменение Описание

Added Объект не существует в другой библиотеке.

Modified Объект был изменен в библиотеке.

Deleted Объект был удален из библиотеки.

Moved Объект был перемещен в другое местоположение 
в структуре дерева библиотеки.



Глава 39 • Импорт библиотек

601

Удаленный или перемещенный объект отображается в первоначальном 
местоположении в дереве; положение объекта указывается прототипом. 
Кроме того, в дереве отображается прототип для каждого объекта, 
добавленного в другой библиотеке. Это позволяет сохранить 
иерархическую структуру и легко сравнивать изменения между 
библиотеками.

 4 Нажмите кнопку на боковой панели, чтобы просмотреть результаты 
сравнения для объектов определенного модуля. Например, нажмите 
кнопку Tests, чтобы просмотреть результаты сравнения для модуля Test 
Plan. В боковой панели будут показаны только модули, включенные в 
библиотеку.

 5 Нажимайте кнопку Go to Next Change на панели инструментов библиотеки, 
чтобы перейти к следующему изменению, или кнопку Go to Previous 
Change, чтобы перейти к предыдущему изменению.
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 6 Чтобы просмотреть дополнительные сведения об объекте, выберите 
объект и нажмите кнопку Details на панели инструментов библиотеки. 
Откроется диалоговое окно Details со сведениями об объекте. Например, 
выберите требование и нажмите кнопку Details. Откроется диалоговое 
окно Requirement Details, в котором будут показаны подробные сведения о 
выбранном требовании.

 7 Чтобы сравнить измененный объект в разных библиотеках, выберите 
объект и нажмите кнопку Compare Entities на панели инструментов. 
Откроется диалоговое окно Compare Entities, в котором будут показаны 
сведения об объекте в каждой библиотеке. Дополнительные сведения см. в 
разделе “Сравнение объектов" на стр. 583.

 8 Нажмите кнопку Comparison Settings на панели инструментов, чтобы 
установить параметры средства сравнения библиотек. Дополнительные 
сведения см. в разделе “Настройка параметров сравнения" на стр. 576.

 9 Чтобы синхронизировать библиотеки, нажмите кнопку Synchronize. 
Данные из другой библиотеки будут скопированы в используемую 
библиотеку. Дополнительные сведения см. в разделе “Синхронизация 
библиотек" на стр. 602.

Синхронизация библиотек
Можно синхронизировать две связанные библиотеки, чтобы внести в одну 
из библиотек изменения, сделанные в другой библиотеке. Можно внести в 
импортированную библиотеку изменения, сделанные в исходной 
библиотеке. Также можно внести в исходную библиотеку изменения, 
сделанные в импортированной библиотеке.

При синхронизации библиотек Quality Center сначала выполняет проверку 
возможности успешной синхронизации библиотек. Процесс проверки 
включает следующие операции.

➤ Проверка типов требований. Выполняется проверка наличия в проекте 
требуемых типов требований. Если другая библиотека содержит типы 
требований, определенные пользователем, в проекте должны 
присутствовать те же типы требований. Дополнительные сведения о типах 
требований см. в документе HP Quality Center Administrator Guide.



Глава 39 • Импорт библиотек

603

➤ Проверка совместимости объектов. Выполняется проверка наличия 
требуемых расширений, включенных в проекте. Если в проекте другой 
библиотеки включено расширение Quality Center, и библиотека включает 
объекты для этого расширения, в текущем проекте также должны быть 
включено это расширение. Дополнительные сведения о расширениях см. в 
документе HP Quality Center Administrator Guide.

В процессе синхронизации данные из базового состояния другой 
библиотеки копируются в текущую библиотеку. В приведенной ниже 
таблице показан порядок обновления объектов текущей библиотеки.

Не следует изменять объекты библиотеки в процессе синхронизации. Если 
в процессе синхронизации другой пользователь изменяет объекты текущей 
библиотеки, успешное выполнение синхронизации будет невозможно.

Управление версиями. Перед синхронизацией все объекты текущей 
библиотеки должны быть возвращены. Если объект текущей библиотеки 
изъят, успешное выполнение синхронизации невозможно.

Событие в исходной 
библиотеке Событие в текущей библиотеке

Объект был добавлен. Объект будет добавлен.

Объект был изменен. Объект будет обновлен.

Если объект был изменен в обеих библиотеках, 
Quality Center перезаписывает объект в текущей 
библиотеке.

Управление версиями. Создается новая версия.

Объект был удален. Quality Center создает новую папку и перемещает 
удаленный объект в новую папку. Новая папка 
получает имя 
SYNC_OBSOLETE_<library_id>_<current_date> и 
размещается в корневой папке модуля.

Объект был перемещен. Объект и его дочерние объекты будут 
перемещены.
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После синхронизации библиотек Quality Center автоматически создает 
базовое состояние обновленной библиотеки. Это базовое состояние 
служит основой для сравнения библиотек в любой момент времени, и его 
не следует удалять. Дополнительные сведения о базовых состояниях см. в 
Глава 38, "Библиотеки и базовые состояния".

Синхронизация библиотек
Можно синхронизировать две библиотеки, чтобы внести в текущую 
библиотеку изменения, сделанные в другой библиотеке. Чтобы 
синхронизировать библиотеки, необходимо выбрать базовое состояние 
библиотеки, используемой в качестве источника синхронизации.

Чтобы синхронизировать библиотеки, выполните следующие 
действия.

 1 В дереве библиотек выберите библиотеку, которую необходимо обновить. 
Используя средство сравнения библиотек, сравните библиотеку с 
выбранным базовым состоянием другой библиотеки. Дополнительные 
сведения см. в разделе “Средство сравнения библиотек" на стр. 598.
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Средство сравнения библиотек показывает текущую библиотеку в левой 
области окна, а базовое состояние другой библиотеки — в правой области 
окна. При синхронизации библиотек Quality Center обновляет текущую 
библиотеку с учетом изменений, показанных в базовом состоянии в правой 
области окна.

 2 Нажмите кнопку Synchronize в окне средства синхронизации библиотек. 
Откроется диалоговое окно Library Verification, в котором будут показаны 
результаты проверки.

 3 Нажмите кнопку Continue, чтобы начать синхронизацию. Quality Center 
копирует данные из базового состояния другой библиотеки в текущую 
библиотеку.

 4 Нажмите кнопку Close, чтобы закрыть диалоговое окно Compare Libraries 
Tool. Синхронизация продолжается в фоновом режиме и может занять 
некоторое время. В процессе синхронизации можно продолжать работу с 
Quality Center.

 5 Нажмите кнопку View Log на вкладке Details. Откроется диалоговое окно 
Log: Synchronize Libraries, в котором будет показан ход выполнения 
синхронизации. Нажмите кнопку Close, чтобы закрыть диалоговое окно.

 6 Нажмите кнопку Refresh на панели инструментов модуля, чтобы обновить 
экран. По завершении процесса будет обновлено значение даты Last 
Synchronization на вкладках Imported By и Imported From.

Отправка библиотек по электронной почте
Можно отправлять сообщения о библиотеке по электронной почте другим 
пользователям. Это позволят информировать их о состоянии библиотек. 
Например, после обновления требований в библиотеке можно уведомить 
владельцев импортированной библиотеки об изменениях. В сообщение 
электронной почты будет включена ссылка, которая позволит получателю 
перейти прямо к библиотеке.

По умолчанию Quality Center отправляет сообщения электронной почты в 
формате HTML. Чтобы отправить сообщение электронной почты в виде 
обычного текста, измените параметр MAIL_FORMAT на вкладке 
Site Configuration в разделе Site Administration. Дополнительные сведения 
см. в документе HP Quality Center Administrator Guide.
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Чтобы отправить библиотеку по электронной почте, выполните 
следующие действия.

 1 Выберите библиотеку в дереве библиотек. Перейдите на вкладку Imported 
By или Imported From. На вкладке Imported By можно выбрать библиотеку 
или нажать кнопку CTRL для выбора нескольких библиотек.

 2 Нажмите кнопку Send E-mail. Откроется диалоговое окно Send E-mail.
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 3 По умолчанию в поле To указан владелец библиотеки. Чтобы добавить 
пользователя, введите допустимый адрес электронной почты или имя 
пользователя. Также можно нажать кнопку To или CC, чтобы выбрать 
пользователей. Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять поиск 
пользователей, распределять пользователей по группам и выбирать 
пользователей из списка или из дерева групп. Дополнительные сведения 
см. в разделе “Выбор пользователей" на стр. 57.

Выберите пользователей или группы пользователей, которым необходимо 
отправить сообщение электронной почты, и нажмите кнопку OK.

 4 В поле Subject введите тему сообщения электронной почты.

 5 В поле Item можно просмотреть имя библиотеки, включенной в сообщение 
электронной почты.

 6 В поле Additional comments добавьте необходимые комментарии.
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 7 В диалоговом окне можно проверить орфографию.

➤ Нажмите кнопку Check Spelling, чтобы проверить орфографию 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии Quality Center, нажмите 
кнопку Spelling Options . 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить синонимы, 
антонимы или связанные слова для выбранного слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое.

 8 Чтобы настроить сообщение электронной почты, нажмите кнопку Custom. 
В диалоговом окне Select Fields можно указать, какие поля следует 
включить в сообщение электронной почты.

 9 Нажмите кнопку Send, чтобы отправить сообщение электронной почты.
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40
Модуль Dashboard

В модуле Dashboard можно создавать, просматривать и администрировать 
диаграммы, стандартные отчеты и отчеты Excel для анализа данных 
Quality Center. Можно также создавать панели отчетов, на которых 
несколько диаграмм могут быть показаны одновременно.

Эта глава содержит следующие разделы.

 ➤  О модуле Dashboard на стр. 611

 ➤  Краткий обзор модуля Dashboard на стр. 613

 ➤  Создание деревьев анализа и панели отчетов на стр. 614

 ➤  Создание элементов анализа на стр. 615

 ➤  Создание панелей отчетов на стр. 616

 ➤  Управление элементами анализа и панелями отчетов на стр. 621

О модуле Dashboard
Модуль Dashboard содержит две вкладки: вкладка Analysis View и вкладка 
Dashboard View.

Вкладка Analysis View содержит дерево для организации всех элементов 
анализа. Возможны следующие типы элементов анализа: диаграммы, 
стандартные отчеты и отчеты Excel.

Вкладка Dashboard View содержит дерево для организации панелей 
отчетов. Панели отчетов позволяют расположить несколько диаграмм, 
созданных в дереве анализа, и показать их в едином представлении.
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В этой главе описано создание дерева анализа и дерева панели отчетов, 
управление этими деревьями и создание панелей отчетов.

Дополнительные средства анализа

➤ Диаграммы Live Analysis. Эти диаграммы позволяют создавать и 
отображать динамические графические представления данных, связанных 
с планами тестирования и наборами тестов. Дополнительные сведения см. 
в Глава 44, "Создание диаграмм анализа в реальном времени"..

➤ Document Generator. Это средство позволяет создавать документы 
Microsoft Word, включающие требования, сведения о планировании, списки 
тестов, папки наборов тестов, а также данные отслеживания дефектов. 
Дополнительные сведения см. в Глава 45, "Создание документов проекта"..



Глава 40 • Модуль Dashboard

613

Краткий обзор модуля Dashboard
Модуль Dashboard используется для определения элементов анализа — 
диаграмм, стандартных отчетов, отчетов Excel, а также панелей отчетов. 
Чтобы открыть модуль Dashboard, нажмите кнопку Dashboard на боковой 
панели.
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Модуль Dashboard содержит следующие основные элементы.

➤ Деревья анализа и панели отчетов. Структуры личных и общих папок, 
содержащих элементы анализа и страницы панели отчетов. 
Дополнительные сведения о создании деревьев см. в разделе “Создание 
деревьев анализа и панели отчетов" на стр. 614.

➤ Вкладка Analysis View. Создание диаграмм, стандартных отчетов и 
отчетов Excel и управление ими.

➤ Дополнительные сведения о диаграммах см. в Глава 41, "Создание 
диаграмм".

➤ Дополнительные сведения о стандартных отчетах см. в Глава 42, 
"Создание стандартных отчетов"..

➤ Дополнительные сведения об отчетах Excel см. в Глава 43, "Создание 
отчетов Excel"..

➤ Вкладка Dashboard View. Создание панелей отчетов, позволяющих 
отображать несколько диаграмм на одной странице, и управление ими. 
Дополнительные сведения о создании панелей отчетов см. в разделе 
“Создание панелей отчетов" на стр. 616.

Создание деревьев анализа и панели отчетов
Модуль Dashboard содержит деревья для элементов анализа и панелей 
отчетов. Каждое дерево состоит из корневых папок Private и Public. В 
каждой из папок создаются отдельные деревья. Элементы анализа и 
панели отчетов, созданные в общей папке, доступны всем пользователям. 
Элементы анализа и панели отчетов, созданные в личной папке, доступны 
только создавшему их пользователю. Общие панели отчетов могут 
включать только общие диаграммы.

Элементы анализа и панели отчетов в общих папках могут показывать 
разные результаты для разных пользователей в зависимости от 
определений скрытия данных для каждой группы пользователей. 
Дополнительные сведения о разрешениях для доступа к данным см. в 
документе HP Quality Center Administrator Guide.
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Чтобы создать дерево анализа или панели отчетов, выполните 
следующие действия.

 1 В модуле Dashboard выберите вкладку Analysis View или вкладку 
Dashboard View.

 2 Выберите в дереве папку, в которой необходимо создать новую папку.

 3 Нажмите кнопку New Folder. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду New Folder. Откроется диалоговое окно 
New Folder.

 4 В поле Folder Name введите имя папки, а затем нажмите кнопку OK. Имя 
не может содержать следующих символов: \ ^ *

Новая папка будет показана как вложенная папка выбранной папки.

 5 Перейдите на вкладку Details. На вкладке Details отображаются 
следующие поля.

Создание элементов анализа
Для создания диаграмм, стандартных отчетов и отчетов Excel 
используется вкладка Analysis View модуля Dashboard.

➤ Создание диаграмм описано в разделах “Создание диаграмм с помощью 
мастера диаграмм" на стр. 626 и “Создание диаграмм в модуле Dashboard" 
на стр. 632.

➤ Создание стандартного отчета описано в разделе “Создание стандартных 
отчетов в модуле Dashboard" на стр. 672.

➤ Создание отчета Excel описано в разделе “Создание отчетов Excel" на 
стр. 685.

Поле Описание

Name Имя папки.

Owner Пользователь, создавший папку. Разрешения на 
изменение общих папок могут быть предоставлены 
только владельцу.

Description Описание папки.
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Создание панелей отчетов
Панели отчетов позволяют размещать и просматривать несколько 
диаграмм на одной странице. Диаграммы для панелей отчетов выбираются 
в дереве анализа. Можно располагать диаграммы на странице в любом 
порядке, а также увеличивать или уменьшать размеры диаграмм.

Данный раздел содержит следующие подразделы.

➤ Создание панелей отчетов

➤ Настройка панелей отчетов

➤ Просмотр панелей отчетов

Создание панелей отчетов
Для создания панелей отчетов используется вкладка Dashboard View 
модуля Dashboard.

Чтобы создать панель отчетов, выполните следующие действия.

 1 В модуле Dashboard щелкните вкладку Dashboard View.

 2 В дереве панели отчетов выберите общую или личную папку. 
Дополнительные сведения о папках в дереве панели отчетов см. в разделе 
“Создание деревьев анализа и панели отчетов" на стр. 614.

 3 Нажмите кнопку New Page. Также можно выбрать команду Dashboard > 
New Page.

Откроется диалоговое окно New Dashboard Page. Введите имя панели 
отчетов и нажмите кнопку OK. Имя не может содержать следующих 
символов: \ ^ *

Панель отчетов будет добавлена в выбранную папку дерева панели 
отчетов.

 4 Перейдите на вкладку Details.
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На вкладке Details отображаются следующие поля.

 5 Выберите и расположите диаграммы, которые необходимо включить в 
панель отчетов. Дополнительные сведения см. в разделе “Настройка 
панелей отчетов" на стр. 617.

 6 Просмотрите панель отчетов. Дополнительные сведения см. в разделе 
“Просмотр панелей отчетов" на стр. 618.

Настройка панелей отчетов
Настройка панелей отчетов осуществляется путем выбора и размещения 
диаграмм на странице. Каждый ряд на панели отчетов может содержать 
одну или две диаграммы. В общие панели отчетов можно включать только 
общие диаграммы.

Примечание. Можно изменять максимальное число диаграмм на панели 
отчетов Quality Center путем изменения параметра сайта DASHBOARD_
PAGE_ITEM_LIMIT. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Поле Описание

Name Имя панели отчетов.

Modified Дата и время последнего изменения панели 
отчетов.

Modified By Пользователь, внесший последнее изменение 
панели отчетов.

Page Owner Пользователь, создавший панель отчетов. 
Разрешения на изменение общих страниц могут 
быть предоставлены только владельцу.

Title Заголовок, отображаемый в строке заголовка 
представления панели отчетов.

Description Описание панели отчетов.
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Чтобы настроить панель отчетов, выполните следующие действия.

 1 В модуле Dashboard щелкните вкладку Dashboard View.

 2 В дереве панели отчетов выберите панель отчетов, которую необходимо 
настроить.

 3 Перейдите на вкладку Configuration. Откроется область Select Graphs.

 4 Чтобы обновить дерево диаграмм, нажмите кнопку Refresh.

 5 Выберите диаграмму и нажмите кнопку Add Graph to Dashboard Page. 
Также можно перетащить диаграмму в новый ряд выше или ниже 
существующих диаграмм или в пустое поле рядом с диаграммой.

Элемент панели отчетов с именем диаграммы будет создан на вкладке 
Configuration.

Примечание. Нельзя включать диаграммы из личной папки анализа в 
общую панель отчетов.

 6 Чтобы переместить диаграмму вправо, влево, вверх или вниз, выберите 
прототип и перетащите его в новое положение. Нельзя оставлять пустые 
строки между диаграммами.

 7 Чтобы увеличить ширину диаграммы до полной ширины ряда, убедитесь, 
что диаграмма занимает отдельный ряд и нажмите кнопку Expand в левом 
верхнем углу поля.

 8 Чтобы уменьшить ширину диаграммы до половины ряда, нажмите кнопку 
Contract в левом верхнем углу поля.

 9 Чтобы удалить диаграмму с панели отчетов, нажмите кнопку Remove в 
правом верхнем углу поля.

Просмотр панелей отчетов
После размещения диаграмм на панели отчетов можно просмотреть 
диаграммы на вкладке View.

Чтобы просмотреть панель отчетов, выполните следующие действия.

 1 В модуле Dashboard щелкните вкладку Dashboard View.
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 2 В дереве панели отчетов выберите панель отчетов, которую необходимо 
просмотреть.

 3 Нажмите кнопку Generate на панели инструментов вкладки Dashboard 
View. Также можно выбрать вкладку View. Quality Center создает и 
показывает диаграммы на панели отчетов.

В окне постоянно отображаются два ряда диаграмм. Используйте 
вертикальную полосу прокрутки, чтобы переместить панель отчетов вверх 
или вниз.

 4 На гистограммах и круговых диаграммах можно переходить от сегментов 
диаграмм к записям, представленным этими сегментами. Дополнительные 
сведения см. в разделе “Переход к записям диаграмм" на стр. 643.

 5 Чтобы просмотреть панель отчетов в полноэкранном режиме, нажмите 
кнопку View Page in Full Screen в правом верхнем углу страницы.

Чтобы вернуться к стандартному виду, нажмите кнопку Close в правом 
верхнем углу страницы.

 6 Чтобы просмотреть отдельную диаграмму в полноэкранном режиме, 
нажмите кнопку View Graph in Full Screen в правом верхнем углу 
диаграммы.

При помощи кнопок панели инструментов можно настраивать отображение 
диаграмм, а также сохранять и печатать диаграммы. Настройки 
отображения диаграммы сбрасываются при последующем создании 
панели отчетов. Дополнительные сведения о просмотре диаграмм см. в 
разделе “Просмотр диаграмм" на стр. 640.

Чтобы вернуться к представлению панели отчетов, нажмите кнопку Close в 
правом верхнем углу диаграммы.

 7 Чтобы обновить данные на всех диаграммах, нажмите кнопку Generate All 
Graphs in Page в правом верхнем углу страницы.

Чтобы обновить данные на отдельной диаграмме, нажмите кнопку 
Generate Graph в правом верхнем углу диаграммы.

Quality Center обновляет диаграмму и устанавливает новые значения даты 
и времени в поле Last Generated.
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 8 Чтобы перейти к диаграмме в дереве анализа, нажмите кнопку Go To 
Graph in Analysis Tree в правом верхнем углу диаграммы. Также можно 
дважды щелкнуть диаграмму. Откроется вкладка Analysis View и 
диаграмма будет выделена в дереве анализа.
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Управление элементами анализа и панелями отчетов
В этом разделе описаны команды редактирования для управления 
элементами анализа и панелями отчетов в дереве анализа и в дереве 
панели отчетов. Данный раздел содержит следующие подразделы.

➤ Перемещение элементов и папок

➤ Копирование элементов анализа и папок

➤ Копирование URL-адреса элемента или папки

➤ Переименование элемента или папки

➤ Удаление элементов и папок

Перемещение элементов и папок
Можно перемещать элементы и папки в новое местоположение в дереве. 
Перед перемещением элемента или папки учтите следующее.

➤ При перемещении папки все элементы анализа или панели отчетов в этой 
папке перемещаются вместе с папкой.

➤ При перемещении элемента анализа из общей папки в личную папку этот 
элемент удаляется из общих панелей отчетов, в которые он включен.

➤ При перемещении панели отчетов из личной папки в общую папку 
Quality Center удаляет все личные диаграммы со панели отчетов.

Чтобы переместить элемент или папку, выполните следующие 
действия.

 1 Выберите элемент или папку в дереве. Чтобы переместить несколько 
элементов или папок, нажмите клавишу CTRL и выберите элементы или 
папки, которые необходимо переместить.

 2 Нажмите кнопку Cut. Также можно щелкнуть элемент правой кнопкой мыши 
и выбрать команду Copy.

 3 Выберите папку в дереве.

 4 Нажмите кнопку Paste. Также можно щелкнуть элемент правой кнопкой 
мыши и выбрать команду Paste.
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Совет. Можно также перемещать элементы и папки, перетаскивая их в 
другую папку.

Копирование элементов анализа и папок
Можно копировать элементы анализа или папки внутри проекта или в 
другой проект Quality Center.

Чтобы скопировать элемент анализа или папку, выполните 
следующие действия.

 1 Выберите элемент анализа или папку, которую необходимо скопировать, в 
дереве анализа. Чтобы скопировать несколько элементов или папок, 
нажмите клавишу CTRL и выберите элементы или папки.

 2 Нажмите кнопку Copy. Также можно щелкнуть элемент правой кнопкой 
мыши и выбрать команду Copy.

 3 Чтобы скопировать в другой проект, откройте еще одно окно браузера и 
войдите в целевой проект.

 4 Выберите папку, в которую необходимо скопировать элемент или папку.

 5 Выберите команду Edit > Paste. Также можно щелкнуть элемент правой 
кнопкой мыши и выбрать команду Paste.

Копирование URL-адреса элемента или папки
Можно скопировать элемент или папку и вставить ее URL-адрес как ссылку. 
При этом сам элемент не будет скопирован. Вместо этого можно вставить 
адрес в другое место, такое как сообщение электронной почты или 
документ. При выборе ссылки открывается Quality Center и выполняется 
переход к элементу или папке. Если вход в систему еще не выполнен, 
сначала будет показано приглашение Quality Center для входа в систему. 

Чтобы скопировать URL-адрес элемента или папки, выполните 
следующие действия.

 1 Выберите элемент или папку в дереве.
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 2 Выберите команду Edit > Copy URL. Также можно щелкнуть элемент 
правой кнопкой мыши и выбрать команду Copy URL.

 3 Вставьте URL.

Переименование элемента или папки
Можно переименовать элемент или папку.

Чтобы переименовать элемент или папку, выполните следующие 
действия.

 1 Выберите элемент или папку в дереве.

 2 Щелкните элемент или папку правой кнопкой мыши и выберите команду 
Rename.

 3 Измените имя элемента или папки и нажмите клавишу Enter.

Удаление элементов и папок
Можно удалять элементы и папки из дерева. Перед удалением элемента 
или папки учтите следующее.

➤ При удалении папки удаляются все элементы в папке.

➤ При удалении диаграммы она удаляется со всех панелей отчетов, в 
которые включена.

Чтобы удалить элемент или папку, выполните следующие действия.

 1 Выберите элемент или папку в дереве. Чтобы удалить несколько 
элементов или папок, нажмите клавишу CTRL и выберите элементы или 
папки, которые необходимо удалить.

 2 Нажмите кнопку Delete или щелкните правой кнопкой мыши и выберите 
команду Delete.

 3 Нажмите кнопку Yes для подтверждения.
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41 
Создание диаграмм

Можно создавать диаграммы для просмотра данных проекта Quality Center 
в графическом виде. Также можно создавать диаграммы, объединяющие 
данные нескольких проектов.

Эта глава содержит следующие разделы.

 ➤  О создании диаграмм на стр. 625

 ➤  Создание диаграмм с помощью мастера диаграмм на стр. 626

 ➤  Создание экспресс-диаграмм на стр. 631

 ➤  Создание диаграмм в модуле Dashboard на стр. 632

 ➤  Настройка диаграмм на стр. 635

 ➤  Создание диаграмм на основе нескольких проектов на стр. 638

 ➤  Просмотр диаграмм на стр. 640

 ➤  Типы диаграмм Quality Center на стр. 649

О создании диаграмм
Диаграммы Quality Center помогают анализировать и просматривать 
взаимоотношения между различными типами данных. Диаграммы могут 
представлять данные модулей Requirements, Test Plan, Test Lab и Defects. 
В зависимости от модуля доступны различные варианты диаграмм. 
Дополнительные сведения о доступных типах диаграмм см. в разделе 
“Типы диаграмм Quality Center" на стр. 649.

Выпуск Quality Center Premier Edition. Можно создавать диаграммы, 
включающие данные из нескольких проектов Quality Center.
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Запуск диаграмм возможен в модуле Dashboard или во время работы в 
модулях Requirements, Test Plan, Test Lab или Defects. В любом случае 
можно сохранять диаграммы в модуле Dashboard для последующего 
использования.

Quality Center содержит мастер диаграмм, который содержит пошаговые 
инструкции по созданию диаграммы. Дополнительные сведения см. в 
разделе “Создание диаграмм с помощью мастера диаграмм" на стр. 626.

При просмотре диаграмм можно переходить к записям, которые 
представлены каждым сегментом. Дополнительные сведения см. в 
разделе “Переход к записям диаграмм" на стр. 643.

Можно просматривать несколько диаграмм в одном представлении, 
включая диаграммы в страницу панели отчетов. Дополнительные сведения 
см. в разделе “Создание панелей отчетов" на стр. 616.

Создание диаграмм с помощью мастера диаграмм
Диаграммы можно создавать с помощью мастера диаграмм. Этот мастер 
предоставляет пошаговые инструкции по созданию диаграммы и указанию 
ее параметров.

Чтобы создать диаграмму с помощью мастера диаграмм, выполните 
следующие действия.

 1 Запустите мастер диаграмм, как описано ниже.

➤ Откройте модуль Requirements, Test Plan, Test Lab или Defects. 
Выберите команду Analysis > Graphs > Graph Wizard.

➤ Откройте модуль Dashboard и выберите вкладку Analysis View. 
Нажмите кнопку New Item и выберите команду Graph Wizard.



Глава 41 • Создание диаграмм

627

Мастер диаграмм откроется на странице Select Graph Type.

 2 Следующий шаг необходим, если мастер диаграмм запущен из модуля 
Dashboard. В разделе Entity выберите модуль Quality Center, для которого 
создается диаграмма.

 3 В разделе Graph Type выберите тип диаграммы, которую необходимо 
отобразить. Дополнительные сведения о типах диаграмм см. в разделе 
“Типы диаграмм Quality Center" на стр. 649. Нажмите кнопку Next.

 4 Выпуск Quality Center Premier Edition. Откроется диалоговое окно Select 
Projects.
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В разделе Project Selection укажите проекты, которые необходимо 
включить в диаграмму.

➤ Use Current Project. В диаграмме используется текущий проект 
Quality Center.

➤ Use Selected Projects. В диаграмме используются проекты, показанные 
в таблице. Чтобы изменить выбранные проекты, нажмите кнопку Select. 
Дополнительные сведения о создании диаграмм на основе нескольких 
проектов см. в разделе “Создание диаграмм на основе нескольких 
проектов" на стр. 638.

 5 Следующий шаг необходим, если мастер диаграмм запущен из модуля 
Test Lab. Открывается диалоговое окно Select Test Set Option. Выберите 
включение в диаграмму только выбранного набора тестов или всех 
наборов тестов. Нажмите кнопку Next.

 6 Откроется диалоговое окно Select Filter.

В разделе Filter Selection укажите, какой фильтр следует использовать, 
чтобы указать записи для включения в диаграмму.

➤ Use current filter. Этот вариант доступен, если мастер диаграмм 
запущен из модулей Requirements, Test Plan, Test Lab или Defects. 
Используется текущий фильтр, примененный к данным.

➤ Do not use a filter. Будут включены все записи выбранного модуля.



Глава 41 • Создание диаграмм

629

➤ Define a new filter. Этот вариант позволяет указать новый фильтр или 
перекрестный фильтр. Нажмите кнопку Filter, чтобы открыть диалоговое 
окно Filter и указать фильтр.

Дополнительные сведения о фильтрации см. в разделе “Фильтрация 
записей" на стр. 59.

Выпуск Quality Center Premier Edition. Если диаграмма включает 
несколько проектов, можно фильтровать записи только по полям, 
присутствующим во всех выбранных проектах.

 7 Нажмите кнопку Next. Откроется диалоговое окно Select Graph Attributes.

В списке Group By field выберите поле, по которому данные будут 
группироваться на диаграмме. Для диаграмм выполнения и тенденций 
можно выбрать только поле с включенной записью истории изменения. 
Дополнительные сведения о включении записи истории изменения поля 
см. в документе HP Quality Center Administrator Guide. 

Выпуск Quality Center Premier Edition. Если диаграмма включает 
несколько проектов, можно выбирать только поля, присутствующие во всех 
выбранных проектах. Чтобы сгруппировать данные по проекту, выберите 
значение QC Project.

 8 При создании сводной диаграммы выберите поле для оси X в списке 
X-axis. 
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Выпуск Quality Center Premier Edition. Если диаграмма включает 
несколько проектов, можно выбирать только поля, присутствующие во всех 
выбранных проектах. Чтобы показать на оси X проекты, выберите значение 
QC Project.

 9 Этот шаг необходим при работе в модуле Requirements. Откроется 
диалоговое окно Select Coverage. В разделе Select a coverage option 
выберите требования, которые следует включить в диаграмму.

➤ Do not show ’Not Covered’ parents. Родительские требования со 
статусом "Not Covered" не будут включены в диаграмму. 

➤ Show ’Not Covered’ parents. В диаграмму будут включены все 
требования. 

Дополнительные сведения о покрытии см. в Глава 19, "Покрытие 
требований и покрытие тестами"..

 10 Нажмите кнопку Next. Откроется диалоговое окно Select Name and Folder.

В поле Graph Name введите имя для диаграммы или оставьте имя, 
предлагаемое по умолчанию.

 11 В разделе Destination Folder выберите папку, в которую будет помещена 
диаграмма в модуле Dashboard. Чтобы создать новую папку, выберите 
родительскую папку и нажмите кнопку New Folder. Дополнительные 
сведения о папках в дереве анализа см. в разделе “Создание деревьев 
анализа и панели отчетов" на стр. 614.
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 12 Нажмите кнопку Finish. Диаграмма с указанными параметрами откроется 
на вкладке View модуля Dashboard.

Создание экспресс-диаграмм
Экспресс-диаграммы можно создавать во время работы в модулях 
Requirements, Test Plan, Test Lab и Defects. Экспресс-диаграммы 
позволяют создавать различные типы диаграмм в каждом модуле, 
используя существующий фильтр модуля. Экспресс-диаграммы можно 
использовать для однократного анализа; их также можно сохранять в 
модуле Dashboard, чтобы завершить настройку данных и представления. 

Примечание. В модулях Requirements, Test Plan, Test Lab и Defects также 
можно создавать диаграммы с помощью мастера диаграмм. 
Дополнительные сведения см. в разделе “Создание диаграмм с помощью 
мастера диаграмм" на стр. 626.

Чтобы создать экспресс-диаграмму, выполните следующие действия.

 1 Откройте модуль Quality Center, в котором необходимо создать диаграмму.

 2 Выберите команду Analysis > Graphs, а затем выберите тип диаграммы. 
Дополнительные сведения о типах диаграмм см. в разделе “Типы диаграмм 
Quality Center" на стр. 649. 

Диаграмма открывается с параметрами данных и представления, 
установленными по умолчанию. 

 3 Используйте кнопки на панели инструментов для обзора диаграммы, 
настройки представления и вывода результатов. Дополнительные 
сведения о просмотре диаграмм см. в разделе “Просмотр диаграмм" на 
стр. 640.

 4 На гистограммах и круговых диаграммах можно переходить к записям, 
представленным сегментами, щелкнув соответствующий сегмент. 
Дополнительные сведения см. в разделе “Переход к записям диаграмм" на 
стр. 643.
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 5 Чтобы сохранить диаграмму в модуле Dashboard, нажмите кнопку Save. 
Откроется диалоговое окно New Graph.

 6 В поле Graph Name введите имя новой диаграммы.

 7 В разделе Select Folder выберите папку дерева анализа, в которой 
следует сохранить диаграмму, или нажмите кнопку New Folder, чтобы 
создать новую папку. Дополнительные сведения о папках в дереве анализа 
см. в разделе “Создание деревьев анализа и панели отчетов" на стр. 614.

 8 Нажмите кнопку Save. Откроется представление Analysis View модуля 
Dashboard; диаграмма будет показана на вкладке View.

 9 Можно настроить содержимое диаграммы на вкладке Configuration. 
Дополнительные сведения см. в разделе “Настройка диаграмм" на стр. 635.

Создание диаграмм в модуле Dashboard
В модуле Dashboard можно создавать диаграммы, отображающие данные 
модулей Requirements, Test Plan, Test Lab и Defects.

Примечание. Кроме того, диаграммы можно создавать с помощью мастера 
диаграмм. Дополнительные сведения см. в разделе “Создание диаграмм с 
помощью мастера диаграмм" на стр. 626.

Чтобы создать диаграмму в модуле Dashboard, выполните 
следующие действия.

 1 В модуле Dashboard щелкните вкладку Analysis View.

 2 Выберите в дереве анализа папку, в которую необходимо добавить 
диаграмму. Дополнительные сведения о добавлении папок в дерево 
анализа см. в разделе “Создание деревьев анализа и панели отчетов" на 
стр. 614.
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 3 Нажмите кнопку New Item и выберите команду New Graph. Откроется 
диалоговое окно New Graph.

 4 В разделе Entity выберите объект, для которого создается диаграмма.

 5 В разделе Graph Type выберите тип диаграммы, которую необходимо 
создать. Дополнительные сведения о типах диаграмм см. в разделе “Типы 
диаграмм Quality Center" на стр. 649.

 6 В поле Graph Name введите имя новой диаграммы.

 7 Нажмите кнопку ОK. Диаграмма будет добавлена в дерево анализа.

 8 Перейдите на вкладку Details. На вкладке Details отображаются 
следующие поля.

Поле Описание

Entity Набор данных, показанный на диаграмме.

Type Тип элемента анализа.

Sub Type Тип диаграммы.

Name Имя диаграммы.

Modified Дата и время последнего изменения диаграммы.

Modified By Пользователь, внесший последнее изменение 
диаграммы.



Глава 41 • Создание диаграмм

634

 9 Можно настроить содержимое диаграммы на вкладке Configuration. 
Дополнительные сведения см. в разделе “Настройка диаграмм" на стр. 635.

 10 Просмотрите диаграмму на вкладке View. Дополнительные сведения см. в 
разделе “Просмотр диаграмм" на стр. 640.

Owner Пользователь, создавший диаграмму. Разрешения 
на изменение общих диаграмм могут быть 
предоставлены только владельцу.

Description Описание диаграммы.

Поле Описание
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Настройка диаграмм
Можно указать данные, показанные на диаграмме, а также способ 
организации данных.

Чтобы настроить диаграмму, выполните следующие действия.

 1 В дереве анализа выберите диаграмму, которую необходимо настроить.

 2 Перейдите на вкладку Configuration.
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 3 Настройте следующие параметры для выбранного типа диаграммы.

Параметр Описание

Age Grouping Можно сгруппировать все дефекты, созданные до 
определенной даты (например, ранее, чем шесть 
месяцев назад) в одном столбце, а более поздние 
дефекты — в другом столбце. Также можно 
сгруппировать дефекты по всем доступным периодам 
времени.

➤ Выберите период времени для группировки дефектов 
в два столбца.

➤ Выберите вариант No Grouping, чтобы просмотреть 
все доступные периоды времени.

Display Options ➤ Выберите Regular, чтобы просмотреть количество 
требований, тестов или дефектов для выбранного 
периода времени.

➤ Выберите Changes over Time, чтобы просмотреть 
изменения в количестве требований, тестов или 
дефектов для выбранного периода времени. Каждая 
запись начинается со значения 0.

Grouped By Выберите поле, чтобы определить информацию, по 
которой Quality Center будет группировать данные на 
диаграмме. Для группировки данных можно использовать 
только строковые поля или списки.

Совет. Для диаграмм, объединяющих несколько 
проектов, выберите вариант QC Projects, чтобы 
сгруппировать данные по проектам.

Period Выберите период времени для отображения на 
диаграмме.

Show Daily Info Установите этот флажок, чтобы показать каждый день на 
оси X.

Show ’Not Covered’ 
parents

На диаграммах модуля Requirements можно включить в 
диаграмму родительские требования со статусом "Not 
Covered".
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 4 Чтобы применить фильтр или перекрестный фильтр к содержимому 
диаграммы, нажмите кнопку Set Filter. Дополнительные сведения о 
фильтрации см. в разделе “Фильтрация записей" на стр. 59. 
Дополнительные сведения о перекрестных фильтрах см. в разделе 
“Расширенная и перекрестная фильтрация записей" на стр. 64.

 5 Выпуск Quality Center Premier Edition. Чтобы изменить проекты, данные 
которых будут показаны на диаграмме, в разделе Cross Project Selection 
нажмите кнопку Select Projects. Дополнительные сведения о создании 
диаграмм на основе нескольких проектов см. в разделе “Создание 
диаграмм на основе нескольких проектов" на стр. 638.

X-Axis Выберите поле, определяющее информацию, 
показанную на оси X диаграммы.

Совет. Для диаграмм, объединяющих несколько 
проектов, выберите вариант QC Projects, чтобы показать 
данные по проектам.

Y-Axis На диаграммах модуля Defects можно выбрать данные, 
показанные на оси Y.

➤ Выберите Count, чтобы отобразить общее количество 
элементов (например, количество открытых 
дефектов).

➤ Выберите Sum of и выберите числовое поле. 
Например, выберите Estimated Fix Time, чтобы 
показать расчетное время устранения дефектов. 
Выберите Actual Fix Time, чтобы показать фактически 
затраченное время на устранение дефектов. 
(Доступно только на диаграммах модуля Defects.)

Параметр Описание
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Создание диаграмм на основе нескольких проектов
Выпуск Quality Center Premier Edition. Можно создавать диаграммы, 
объединяющие данные из нескольких проектов на одной диаграмме. В 
мастере диаграмм можно выбрать проекты, включенные в диаграмму. 
Выбранные проекты также можно изменить в любое время на вкладке 
Configuration диаграммы. Можно выбрать только те проекты, в которых 
текущий пользователь указан в качестве пользователя.

Примечание. Можно изменить максимальное число проектов, которые 
можно объединить на одной диаграмме Quality Center, установив значение 
параметра PROJECT_SELECTION_
MAX_PROJECTS для сайта. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Чтобы создать диаграммы на основе нескольких проектов, 
выполните следующие действия.

 1 Выберите один из следующих вариантов.

➤ Запустите мастер диаграмм. Перейдите к странице Select Projects и 
нажмите кнопку Select.

➤ В дереве анализа выполните следующие действия. Выберите 
диаграмму, перейдите на вкладку Configuration и нажмите кнопку 
Select Projects.
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Откроется диалоговое окно Select Projects.

В дереве проектов будут показаны только те проекты, в которых вы 
указаны в качестве пользователя.

 2 Чтобы добавить проект в таблицу, разверните дерево проектов, выберите 
проект и нажмите кнопку Add. Также можно перетащить проект из дерева 
проектов в таблицу или дважды щелкнуть его.

Совет. Чтобы включить в диаграмму все проекты домена, выберите домен 
в дереве проектов и добавьте его в таблицу. Все проекты домена будут 
перечислены в таблице по отдельности.

 3 Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Projects.

 4 Можно отображать данные проектов на диаграмме по отдельности, выбрав 
вариант QC Project в поле X-Axis или Grouped By. Выберите один из 
следующих вариантов.

➤ В мастере диаграмм перейдите к странице Select Graph Attributes.



Глава 41 • Создание диаграмм

640

➤ На вкладке Configuration установите значения полей X-Axis или 
Grouped By. Дополнительные сведения см. в разделе “Настройка 
диаграмм" на стр. 635.

Рекомендации по созданию диаграмм на основе нескольких 
проектов.

➤ Каждый раз при добавлении или удалении проектов из диаграммы 
Quality Center обновляет список Filter Condition и раскрывающиеся списки 
для следующих полей: X-Axis, Y-Axis и Grouped By. Эти списки содержат 
только поля, совпадающие во всех выбранных проектах. Совпадающими 
считаются поля с одинаковыми именами, заголовками и типами данных. 
Дополнительные сведения о настройке полей см. в документе 
HP Quality Center Administrator Guide.

➤ Если условие фильтрации определено с использованием поля, которое 
более недоступно, это условие будет удалено.

➤ Если поля, выбранные в списках X-Axis, Y-Axis и Grouped By, более 
недоступны, будет выбрано первое поле в каждом раскрывающемся 
списке.

Просмотр диаграмм
Данный раздел содержит следующие подразделы.

➤ Просмотр диаграммы

➤ Переход к записям диаграмм

➤ Настройка внешнего вида диаграмм

➤ Изменение категорий диаграмм

Просмотр диаграммы
Можно изменять формат диаграммы, просматривать диаграмму, 
устанавливать вид диаграммы, изменять категории диаграммы, сохранять 
и печатать диаграммы.
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Чтобы просмотреть диаграмму, выполните следующие действия.

 1 Выберите диаграмму, как описано ниже.

➤ В дереве анализа выберите диаграмму и перейдите на вкладку View.

➤ Выберите модуль Requirements, Test Plan, Test Lab или Defects, 
выберите команду Analysis > Recently Used и выберите диаграмму.

 2 На диаграммах выполнения и тенденций щелкните категории в поле 
условных обозначений, чтобы показать или скрыть категории на 
диаграмме.

 3 Просмотрите диаграмму с помощью панели инструментов представления 
диаграммы. Панель инструментов содержит следующие кнопки (в 
зависимости от типа диаграммы).

Generate. Обновление диаграммы с учетом наиболее актуальных данных.

Bar Chart. Эта кнопка доступна для сводных диаграмм, диаграмм 
тенденций и диаграмм периода существования.

Pie Chart. Отображение категорий оси X в виде сегментов круга. Значения 
оси X представлены размером сегментов. На круговых диаграммах не 
отображается поле Grouped By. Это поле доступно для сводных диаграмм.

Line Chart. Эта кнопка доступна для диаграмм выполнения.

Data Grid. В таблице создается матрица оси X диаграммы и категорий в 
поле Grouped By. Добавляется строка Total, которая содержит итоговые 
значения для каждой категории Grouped By. Доступно для всех типов 
диаграмм.

Show/Hide Total Values. Эта кнопка доступна для диаграмм выполнения. 
Отображение и скрытие категории, представляющей итоговое значение 
для категорий Grouped By.

Scroll to the Left. Прокрутка диаграммы влево. Эта кнопка включена при 
использовании кнопок Zoom In и Zoom Out.

Scroll to the Right. Прокрутка диаграммы вправо. Эта кнопка включена при 
использовании кнопок Zoom In и Zoom Out.

Show All. Возврат к обычному размеру диаграммы. Эта кнопка включена 
при использовании кнопок Zoom In и Zoom Out.
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Zoom In. Увеличение масштаба диаграммы.

Zoom Out. Уменьшение масштаба диаграммы.

Save Graph Data. Сохранение содержимого диаграммы в файле. При 
просмотре диаграммы в виде гистограммы, круговой диаграммы или 
линейного графика можно сохранять изображение диаграммы в различных 
графических форматах. При просмотре таблицы данных можно сохранять 
данные в виде листа Excel, файла Word, документа HTML или текстового 
файла.

Set Graph Appearance. Изменение вида диаграммы, позволяющее 
настраивать заголовок диаграммы, ее цвета и отображение. 
Дополнительные сведения см. в разделе “Настройка внешнего вида 
диаграмм" на стр. 645.

Copy Graph to Clipboard. Можно выбрать следующие варианты.

➤ Copy Graph (Color). Копирование цветного изображения диаграммы в 
буфер обмена.

➤ Copy Graph (Monochrome). Копирование черно-белого изображения 
диаграммы в буфер обмена.

➤ Copy Full Screen Graph (Color). Копирование цветного полноэкранного 
изображения диаграммы в буфер обмена.

➤ Copy Full Screen Graph (Monochrome). Копирование черно-белого 
полноэкранного изображения диаграммы в буфер обмена.

Print Graph. Можно выбрать следующие варианты.

➤ Print Graph (Color). Цветная печать диаграммы. Этот вариант 
используется по умолчанию.

➤ Print Graph (Monochrome). Черно-белая печать диаграммы.

➤ Print Graph and Details (Color). Цветная печать диаграммы и ее описания.

➤ Print Graph and Details (Monochrome). Черно-белая печать диаграммы и 
ее описания.

Edit Categories. Объединение значений полей X-Axis и Group By в 
категории. Дополнительные сведения см. в разделе “Изменение категорий 
диаграмм" на стр. 646.
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Full Screen. Отображение диаграммы в новом окне в полноэкранном 
режиме. Эта функция доступна в модуле Dashboard.

Переход к записям диаграмм
Можно переходить к записям, показанным на диаграмме, щелкая сегменты 
диаграммы.

Чтобы перейти к записям диаграммы, выполните следующие 
действия.

 1 Отобразите диаграмму в виде круговой диаграммы или гистограммы.

 2 Щелкните сегмент или столбец.

 3 Если сегмент или столбец представляет записи только одного текущего 
проекта, откроется диалоговое окно Drill Down Results. В этом случае 
перейдите к шагу 6.

 4 Выпуск Quality Center Premier Edition. Если сегмент или столбец 
представляет только записи другого проекта, записи будут показаны в 
отдельном окне браузера.

➤ Если уже выполнен вход в другой проект в другом окне браузера, в этом 
окне будет выбран соответствующий модуль и будут показаны 
соответствующие записи.

➤ Если вход в другой проект не выполнен, нажмите кнопку OK для 
подтверждения. Откроется новое окно браузера. После входа в систему 
Quality Center покажет соответствующие записи в соответствующем 
модуле.

 5 Выпуск Quality Center Premier Edition. Если сегмент или столбец 
представляет записи из нескольких проектов, откроется диалоговое окно 
Project Selection.

 a В разделе Select Project выберите проект и нажмите кнопку OK.

 b Если выбран текущий проект, откроется диалоговое окно Drill Down 
Results. В этом случае перейдите к шагу 6.

 c Если выбран другой проект, записи будут показаны в отдельном окне 
браузера.



Глава 41 • Создание диаграмм

644

➤ Если уже выполнен вход в другой проект в другом окне браузера, в 
этом окне будет выбран соответствующий модуль и будут показаны 
соответствующие записи.

➤ Если вход в другой проект не выполнен, нажмите кнопку OK для 
подтверждения. Откроется новое окно браузера. После входа в 
систему Quality Center покажет соответствующие записи в 
соответствующем модуле.

 6 В диалоговом окне Drill Down Results нажмите кнопку Select Columns, 
расположенную в правом верхнем углу, чтобы определить столбцы, 
отображаемые в таблице, и порядок их отображения. Дополнительные 
сведения см. в разделе “Упорядочивание столбцов" на стр. 54.

 7 Дважды щелкните запись, чтобы открыть данные записи.

 8 Откроется диалоговое окно <Модуль> Details. В этом диалоговом окне 
можно изменять данные записи.

 9 Нажмите кнопку OK или Cancel, чтобы закрыть диалоговое окно и 
вернуться к диалоговому окну Drill Down Results.

 10 Закройте диалоговое окно Drill Down Results, чтобы вернуться на вкладку 
View.
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Настройка внешнего вида диаграмм
После создания диаграммы можно изменять ее заголовки и внешний вид. 
Для гистограммы можно настроить параметры отображения столбцов. Для 
линейного графика можно настроить параметры отображения линий.

Чтобы настроить внешний вид диаграммы, выполните следующие 
действия.

 1 Перейдите на вкладку View. Нажмите кнопку Set Graph Appearance, 
расположенную на панели инструментов диаграмм. Также можно дважды 
щелкнуть заголовок диаграммы. Откроется диалоговое окно Graph 
Appearance.

 2 Чтобы изменить заголовки диаграммы, оси Y или оси Х, выберите вкладку 
Titles. Чтобы изменить шрифт или цвет заголовка, нажмите кнопку Font. 
Чтобы вернуться к первоначальным параметрам, нажмите кнопку Reset 
Titles. Учтите, что для круговой диаграммы можно изменять только 
заголовок.

 3 Перейдите на вкладку Appearance, чтобы установить формат диаграммы 
по умолчанию, изменить ориентацию заголовков в основании диаграммы 
(только для гистограммы и линейного графика), определить формат 
отображения дат на оси X, отобразить диаграмму с объемным эффектом 
или изменить цвета различных компонентов диаграммы.
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 4 При создании гистограммы перейдите на вкладку Bar Parameters и 
укажите, необходимо ли отображать значение для каждого столбца. Также 
можно настроить ширину столбцов. Если включено отображение значений 
для каждого столбца, можно изменять данные столбцов или их положение 
относительно столбцов. 

 5 При создании линейного графика перейдите на вкладку Line Parameters и 
укажите, необходимо ли отображать рамку графика.

Изменение категорий диаграмм
Можно объединять значения полей X-Axis и Grouped By в категории. Это 
позволяет объединять данные в группы для различных значений полей и 
отображать объединенные данные в виде одной категории. Например, 
поле Priority имеет пять значений: Low, Medium, High, Very High и Urgent. 
Можно объединить значения Medium и High в категорию Important, а 
значения Very High и Urgent — в категорию Critical. При этом диаграмма 
будет отображать три категории данных: Low, Important и Critical.

Чтобы изменить категории диаграммы, выполните следующие 
действия.

 1 Перейдите на вкладку View. Нажмите кнопку Edit Categories, 
расположенную на панели инструментов диаграмм, и выберите один из 
следующих вариантов.

➤ Edit X-Axis Categories. Объединение значений X-Axis в категории для 
отображения на диаграмме. Эта возможность доступна только для 
сводных диаграмм и диаграмм покрытия требований тестами. Этот 
вариант используется по умолчанию.

➤ Edit Grouped By Categories. Объединение значений поля Grouped By в 
категории для отображения на диаграмме. 
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Откроется диалоговое окно Edit ‘X-Axis’ Categories или диалоговое окно Edit 
Grouped By Categories.

 2 Чтобы создать новую категорию, нажмите кнопку New. Откроется 
диалоговое окно New Category.

 3 В поле Category Name введите имя категории.
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 4 Чтобы выбрать значения поля для добавления в категорию, выберите 
необходимые значения и с помощью кнопок со стрелками (> и <), 
переместите их из списка Available groups в список Groups in new 
category. Чтобы переместить все значения поля из одного списка в другой, 
используйте кнопки с двумя стрелками (>> и <<). Также можно 
перетаскивать значения поля из одного списка в другой. Значение поля 
может быть включено только в одну категорию.

Нажмите кнопку OK, чтобы закрыть диалоговое окно New Category.

 5 Чтобы изменить категорию, выберите ее и нажмите кнопку Edit. Повторите 
шаги 3 – 4.

 6 Чтобы удалить категорию, выберите ее и нажмите кнопку Delete.

 7 Чтобы удалить все категории, нажмите кнопку Clear All. Нажмите кнопку 
Yes для подтверждения.

 8 Нажмите кнопку OK, чтобы закрыть диалоговое окно Edit X-Axis Categories 
или Edit Grouped By Categories.

 9 Чтобы сбросить категории X-Axis или Group By в состояние по умолчанию, 
нажмите кнопку Edit Categories на панели инструментов диаграмм и 
выберите один из следующих вариантов.

➤ Reset X-Axis Categories. Сброс категорий X-Axis. Эта возможность 
доступна только для сводных диаграмм и диаграмм покрытия 
требований тестами.

➤ Reset Group By Categories. Сброс категорий Group By.

Нажмите кнопку Yes для подтверждения. Будут сброшены категории X-
Axis или категории Group By.
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Типы диаграмм Quality Center
Quality Center позволяет создавать диаграммы для модулей Requirements, 
Test Plan, Test Lab и Defects. В каждом модуле доступны различные типы 
диаграмм.

Диаграммы модуля Requirements
Для модуля Requirements можно создавать следующие диаграммы.

Диаграмма Описание

Requirements - 
Summary Graph

Отображает общее количество текущих требований в 
проекте Quality Center. Дополнительные сведения см. в 
разделе “Диаграмма Requirements - Summary Graph" на 
стр. 652.

Requirements - 
Progress Graph

Отображает данные о количестве требований, 
накопленных в проекте Quality Center в определенных 
точках за тот или иной период времени. Дополнительные 
сведения см. в разделе “Диаграмма Requirements - 
Progress Graph" на стр. 653.

Requirements - 
Trend Graph

Отображает историю изменения содержимого тех или 
иных полей требований в проекте Quality Center для 
каждого отображаемого временного интервала. 
Дополнительные сведения см. в разделе “Диаграмма 
Requirements - Trend Graph" на стр. 655.

Requirements - 
Coverage Graph

(Доступно только в 
модуле 
Requirements.)

Отображает общее количество текущих требований в 
проекте Quality Center в соответствии со статусом 
покрытия тестами. Дополнительные сведения см. в 
разделе “Диаграмма Requirements - Coverage Graph" на 
стр. 654.
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Диаграммы модуля Test Plan
Для модуля Test Plan можно создавать следующие диаграммы.

Диаграммы модуля Test Lab
Для модуля Test Lab можно создавать следующие диаграммы.

Диаграмма Описание

Test Planning - 
Summary Graph

Отображает общее количество текущих тестов в проекте 
Quality Center. Дополнительные сведения см. в разделе 
“Диаграмма Test Planning - Summary Graph" на стр. 656.

Test Planning - 
Progress Graph

Отображает данные о количестве тестов, накопленных в 
проекте Quality Center в определенных точках за тот или 
иной период времени. Дополнительные сведения см. в 
разделе “Диаграмма Test Planning - Progress Graph" на 
стр. 657.

Test Planning - 
Trend Graph

Отображает историю изменений тех или иных полей 
плана тестирования в проекте Quality Center для каждого 
отображаемого временного интервала. Дополнительные 
сведения см. в разделе “Диаграмма Test Planning - Trend 
Graph" на стр. 658.

Диаграмма Описание

Test Execution - 
Summary Graph

Отображает количество тестов проекта Quality Center, 
относящихся к текущему набору тестов или ко всем 
наборам тестов. Дополнительные сведения см. в 
разделе “Диаграмма Test Execution - Summary Graph" на 
стр. 659.

Test Execution - 
Progress Graph

Отображает данные о количестве тестов, накопленных в 
текущем наборе тестов или во всех наборах тестов в 
определенных точках за тот или иной период времени. 
Дополнительные сведения см. в разделе “Диаграмма Test 
Execution - Progress Graph" на стр. 660.
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Диаграммы модуля Defects
Для модуля Defects можно создавать следующие диаграммы.

Диаграмма Описание

Defects - Summary 
Graph

Отображает общее количество дефектов в проекте 
Quality Center или расчетное/фактическое время 
устранения этих дефектов. Дополнительные сведения 
см. в разделе “Диаграмма Defects - Summary Graph" на 
стр. 661.

Defects - Progress 
Graph

Отображает накопление дефектов в проекте 
Quality Center или расчетное/фактическое время 
устранения этих дефектов в определенных точках за тот 
или иной период времени. Дополнительные сведения см. 
в разделе “Диаграмма Defects - Progress Graph" на 
стр. 662.

Defects - Age Graph Отображает период существования дефектов в проекте 
Quality Center. Дополнительные сведения см. в разделе 
“Диаграмма Defects - Age Graph" на стр. 664.

Defects - Trend 
Graph

Отображает историю изменений в тех или иных полях 
дефектов в проекте Quality Center для каждого 
отображаемого временного интервала. Дополнительные 
сведения см. в разделе “Диаграмма Defects - Trend 
Graph" на стр. 665.
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Диаграмма Requirements - Summary Graph
Диаграмма Requirements - Summary Graph отображает общее количество 
текущих требований в проекте Quality Center. Количество требований 
отображается в соответствии с критериями, заданными пользователем. 
Можно указать тип данных, отображаемых по оси Х, и сведения о 
требованиях, в соответствии с которыми Quality Center будет группировать 
данные. 

Например, для отображения количества требований, существующих в 
проекте, по их авторам, необходимо выбрать значение Author в списке X-
Axis. Чтобы сгруппировать требования в столбцы диаграммы в 
соответствии с уровнем их приоритета, необходимо выбрать значение 
Priority в списке Grouped By. Чтобы включить в диаграмму родительские 
требования со статусом Not Covered, необходимо установить флажок 
Show ‘Not Covered’ parents.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

По умолчанию диаграмма отображается в виде гистограммы.
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Диаграмма Requirements - Progress Graph
Диаграмма Requirements - Progress Graph показывает количество 
требований, накопленных в проекте Quality Center в определенных точках 
за тот или иной период времени. Количество требований отображается в 
соответствии с критериями, заданными пользователем. Можно указать 
временной интервал, отображаемый по оси Х, и сведения о требованиях, в 
соответствии с которыми Quality Center будет группировать данные. Также 
можно указать отображение количества требований или изменения 
количества требований. 

Например, чтобы сгруппировать отображаемые требования в соответствии 
со статусом покрытия тестами, необходимо выбрать значение Direct Cover 
Status в списке Grouped By. В поле Period выберите значение Last 5 
weeks, чтобы показать этот интервал (последние 5 недель) по оси Х. 
Учтите, что на диаграмме отображаются данные по состоянию на 
последний день каждой недели. В поле Display Options выберите 
значение Changes Over Time, чтобы просмотреть изменение количества 
требований со временем, а не количество требований.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

Диаграмму можно отображать только в виде линейного графика.
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Диаграмма Requirements - Coverage Graph
Диаграмма Requirements - Coverage Graph отображает общее количество 
текущих требований в проекте Quality Center в соответствии со статусом 
покрытия тестами.

Можно указать сведения о требованиях, в соответствии с которыми 
Quality Center будет группировать данные. Например, чтобы сгруппировать 
требования в столбцы диаграммы в соответствии с уровнем их приоритета, 
необходимо выбрать значение Priority в списке Grouped By. Чтобы 
включить в диаграмму родительские требования со статусом Not Covered, 
необходимо установить флажок Show ‘Not Covered’ parents.

Примечание. Диаграмма Requirements - Coverage Graph представляет 
собой сводную диаграмму специального типа. При выборе в списке Х-Axis 
другого поля требования будет показана стандартная диаграмма 
Requirements - Summary Graph.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 
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По умолчанию диаграмма отображается в виде гистограммы. Чтобы 
просмотреть диаграмму в виде круговой диаграммы, нажмите кнопку Pie 
Chart.

Диаграмма Requirements - Trend Graph
Диаграмма Requirements - Trend Graph отображает историю изменений в 
тех или иных полях требований в проекте Quality Center для каждого 
отображаемого временного интервала. Можно указать поле, для которого 
необходимо просмотреть количество изменений, а также период времени 
для просмотра данных. 

Например, чтобы просмотреть количество изменений, внесенных в поле 
Direct Cover Status, необходимо выбрать значение Direct Cover Status в 
списке Count Changes in Field. В поле Period выберите Last 5 weeks, 
чтобы показать этот интервал (последние 5 недель) по оси Х. Учтите, что 
на диаграмме отображаются суммарные данные для каждой недели.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 
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Каждое изменение статуса для этой диаграммы записывается только один 
раз. Например, если статус поля был изменен с Not Completed на Passed, а 
затем опять на Not Completed, на диаграмме будет показано только одно 
изменение статуса Not Completed.

Диаграмму Requirements - Trend Graph можно отображать только в виде 
гистограммы.

Диаграмма Test Planning - Summary Graph
Диаграмма Test Planning - Summary Graph отображает общее количество 
текущих тестов в проекте Quality Center. Количество тестов отображается в 
соответствии с критериями, указанными пользователем. Можно указать тип 
данных, отображаемых по оси Х, и сведения о плане тестирования, в 
соответствии с которыми Quality Center будет группировать данные. 

Например, для отображения количества тестов, существующих в проекте, 
по их проектировщикам, необходимо выбрать значение Designer в списке 
X-Axis. Чтобы сгруппировать тесты в столбцы диаграммы в соответствии с 
уровнем их приоритета, необходимо выбрать значение Priority в списке 
Grouped By. Нажмите кнопку Generate, чтобы обновить отображение 
диаграммы.
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Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

По умолчанию диаграмма отображается в виде гистограммы. Чтобы 
просмотреть диаграмму в виде круговой диаграммы, нажмите кнопку Pie 
Chart.

Диаграмма Test Planning - Progress Graph
Диаграмма Test Planning - Progress Graph отображает количество тестов, 
накопленных в проекте Quality Center в определенных точках за тот или 
иной период времени. Количество тестов отображается в соответствии с 
критериями, указанными пользователем. Можно указать временной 
интервал, отображаемый по оси Х, и сведения о плане тестирования, в 
соответствии с которыми Quality Center будет группировать данные. Также 
можно указать отображение количества тестов или изменения количества 
тестов. 

Например, чтобы сгруппировать отображаемые тесты в соответствии с 
уровнем их приоритета, необходимо выбрать значение Status в списке 
Grouped by. В разделе Period выберите All days и Show daily info, чтобы 
показать каждый день на оси Х. В поле Display Options выберите значение 
Changes Over Time, чтобы просмотреть изменение количества тестов со 
временем, а не количество тестов.
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Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

Диаграмма Test Planning - Progress Graph может отображаться только в 
виде линейного графика.

Диаграмма Test Planning - Trend Graph
Диаграмма Test Planning - Trend Graph отображает историю изменений в 
тех или иных полях плана тестирования в проекте Quality Center для 
каждого отображаемого временного интервала. Можно указать поле, для 
которого необходимо просмотреть количество изменений, а также период 
времени для просмотра данных. 

Например, чтобы просмотреть количество изменений, внесенных в поле 
Status плана тестирования, необходимо выбрать значение Status в списке 
Count changes in field. В поле Period выберите Last 5 weeks, чтобы 
показать этот интервал (последние 5 недель) по оси Х. Учтите, что на 
диаграмме отображаются суммарные данные для каждой недели.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 
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Каждое изменение статуса для этой диаграммы записывается только один 
раз. Например, если статус поля был изменен с Ready на Repair, а затем 
опять на Ready, на диаграмме будет показано только одно изменение 
статуса Ready.

Диаграмма Test Planning - Trend Graph может отображаться только в виде 
гистограммы.

Диаграмма Test Execution - Summary Graph
Диаграмма Test Execution - Summary Graph показывает количество тестов 
проекта Quality Center, относящихся к наборам тестов. Можно создать 
диаграмму для текущего набора тестов или для всех наборов тестов. 
Количество тестов отображается в соответствии с критериями, указанными 
пользователем. Можно указать тип данных, отображаемых по оси Х, а 
также сведения о плане тестирования и тесте набора тестов, в 
соответствии с которыми Quality Center будет группировать данные. 

Например, чтобы просмотреть количество тестов, существующих в 
проекте, по их статусу, необходимо выбрать значение Status в списке X-
Axis. Выберите значение Plan: Priority в списке Grouped By, чтобы 
сгруппировать тесты в столбцы диаграммы в соответствии с уровнем их 
приоритета. Нажмите кнопку Generate, чтобы обновить отображение 
диаграммы.
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Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

По умолчанию диаграмма отображается в виде гистограммы. Чтобы 
просмотреть диаграмму в виде круговой диаграммы, нажмите кнопку Pie 
Chart.

Диаграмма Test Execution - Progress Graph
Диаграмма Test Execution - Progress Graph отображает количество тестов, 
накопленных в наборах тестов в определенных точках за тот или иной 
период времени. Можно создать диаграмму для текущего набора тестов 
или для всех наборов тестов. Количество тестов отображается в 
соответствии с критериями, указанными пользователем. Можно указать 
временной интервал, отображаемый по оси Х, и сведения о плане 
тестирования и тесте набора тестов, в соответствии с которыми 
Quality Center будет группировать данные. Также можно указать 
отображение количества тестов или изменения количества тестов. 
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Например, чтобы сгруппировать отображаемые тесты в соответствии с их 
статусом, необходимо выбрать значение Status в списке Grouped by. В 
поле Period выберите значение Last 5 weeks, чтобы показать этот 
интервал (последние 5 недель) по оси Х. (Учтите, что на диаграмме 
отображаются данные по состоянию на последний день каждой недели.) В 
поле Display Options выберите значение Changes Over Time, чтобы 
просмотреть изменение количества тестов со временем, а не количество 
тестов.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

Диаграмма Test Execution - Progress Graph может отображаться только в 
виде линейного графика.

Диаграмма Defects - Summary Graph
Диаграмма Defects - Summary Graph отображает общее количество 
дефектов в проекте Quality Center или расчетное/фактическое время 
устранения этих дефектов. Данные отображаются в соответствии с 
критериями, заданными пользователем. Можно указать тип данных, 
отображаемых по оси Х, тип данных, отображаемых по оси Y, и сведения о 
дефектах, в соответствии с которыми Quality Center будет группировать 
данные. 
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Например, для отображения количества дефектов, существующих в 
проекте, по пользователям, которым они назначены, необходимо выбрать 
значение Assigned To в списке X-Axis. Чтобы сгруппировать дефекты в 
столбцы диаграммы в соответствии с их статусом, необходимо выбрать 
значение Status в списке Grouped By. В поле Data Type выберите 
значение Count, чтобы по оси Y отображалось количество дефектов. 
Нажмите кнопку Generate, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

По умолчанию диаграмма отображается в виде гистограммы. Чтобы 
просмотреть диаграмму в виде круговой диаграммы, нажмите кнопку Pie 
Chart.

Диаграмма Defects - Progress Graph
Диаграмма Defects - Progress Graph отображает накопление дефектов в 
проекте Quality Center или расчетное/фактическое время устранения этих 
дефектов в определенных точках за тот или иной период времени. Данные 
отображаются в соответствии с критериями, заданными пользователем. 
Можно указать временной интервал, отображаемый по оси Х, и сведения о 
дефектах, в соответствии с которыми Quality Center будет группировать 
данные, а также данные, отображаемые по оси Y. Также можно указать 
отображение количества дефектов или изменения количества дефектов. 
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Например, чтобы сгруппировать отображаемые дефекты в соответствии с 
их статусом, необходимо выбрать значение Status в списке Grouped by. В 
поле Data Type выберите значение Count, чтобы по оси Y отображалось 
количество дефектов, а не расчетное/фактическое время устранения этих 
дефектов. В поле Period выберите значение Last 5 weeks, чтобы показать 
этот интервал (последние 5 недель) по оси Х. (Учтите, что на диаграмме 
отображаются данные по состоянию на последний день каждой недели.) В 
поле Display Options выберите значение Changes Over Time, чтобы 
просмотреть изменение количества дефектов со временем, а не 
количество дефектов.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

Диаграмма Defects - Progress Graph может отображаться только в виде 
линейного графика.
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Диаграмма Defects - Age Graph
Диаграмма Defects - Age Graph отображает время существования 
дефектов в проекте Quality Center. Период существования дефекта 
начинается с момента сообщения о нем и заканчивается его закрытием. 
Данные отображаются на этой диаграмме в соответствии с критериями, 
заданными пользователем. Можно указать сведения о дефектах, в 
соответствии с которыми Quality Center будет группировать данные, а 
также данные, отображаемые по оси Y. При необходимости создания 
диаграммы для двух столбцов данных также можно указать временной 
интервал, который будет использоваться для разделения данных. 

Например, чтобы сгруппировать отображаемые дефекты в соответствии с 
их статусом, необходимо выбрать значение Status в списке Grouped by. В 
поле Data Type выберите значение Count, чтобы по оси Y отображалось 
количество дефектов, а не расчетное/фактическое время устранения этих 
дефектов. В поле Age Grouping выберите значение No Grouping, чтобы 
отобразить все доступные группы по периоду существования. Нажмите 
кнопку Generate, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 
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Учтите, что период существования для дефекта со статусом Closed равен 
разнице во времени между датой сообщения о дефекте и датой закрытия 
дефекта. После закрытия дефекта период его существования остается 
неизменным.

Диаграмму Defects - Age Graph можно отображать только в виде 
гистограммы.

Диаграмма Defects - Trend Graph
Диаграмма Defects - Trend Graph отображает историю изменений в тех или 
иных полях дефектов в проекте Quality Center для каждого отображаемого 
временного интервала. Можно указать поле, для которого необходимо 
просмотреть количество изменений, а также период времени для 
просмотра данных. 
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Например, чтобы отобразить количество изменений, внесенных в поле 
Priority дефекта, необходимо выбрать значение Priority в списке Count 
changes in field. В поле Period выберите Last 5 weeks, чтобы показать 
этот интервал (последние 5 недель) по оси Х. (Учтите, что на диаграмме 
отображаются сводные данные для каждой недели.) Нажмите кнопку 
Generate, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы см. в разделе 
“Настройка диаграмм" на стр. 635. 

Учтите, что каждое изменение приоритета для этой диаграммы 
записывается только один раз. Например, если приоритет поля был 
изменен с Urgent на Very High, а затем опять на Urgent, на диаграмме будет 
показано только одно изменение приоритета Urgent.

Диаграмму Defects - Trend Graph можно отображать только в виде 
гистограммы.
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42
Создание стандартных отчетов

Стандартные отчеты позволяют создавать отчеты различных типов на 
основе данных модулей Quality Center.

Эта глава содержит следующие разделы.

 ➤  О создании стандартных отчетов на стр. 667

 ➤  Создание стандартных отчетов на стр. 668

 ➤  Создание стандартных отчетов в модуле Dashboard на стр. 672

 ➤  Настройка стандартных отчетов на стр. 675

 ➤  Добавление суботчетов на стр. 677

 ➤  Просмотр стандартных отчетов на стр. 680

О создании стандартных отчетов
Стандартные отчеты помогают отслеживать покрытие требований и 
покрытие тестами, план тестирования, выполнения тестов и отслеживание 
дефектов.

Стандартные отчеты можно создавать в модуле Dashboard или во время 
работы в модулях Requirements, Test Plan, Test Lab или Defects. В любом 
случае можно сохранять стандартные отчеты в модуле Dashboard для 
последующего использования.

При создании стандартных отчетов в модулях Requirements, Test Plan, Test 
Lab или Defects можно выбирать различные предопределенные отчеты. 
Также можно создавать отчеты на основе выбранных записей для 
немедленного просмотра.
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Стандартные отчеты, создаваемые в модуле Dashboard, позволяют 
указать данные для включения в отчет. Также можно добавлять суботчеты 
для добавления дополнительных слоев связанных данных.

Примечания.

➤ Можно создавать отчеты Excel, извлекающие данные путем выполнения  
SQL-запросов. Дополнительные сведения см. в Глава 43, "Создание 
отчетов Excel"..

➤ Можно экспортировать данные таблицы в виде текстового файла, 
таблицы Microsoft Excel, документа Microsoft Word или документа в 
формате HTML. Можно экспортировать данные из таблиц требований, 
тестов, выполнения и дефектов. Дополнительные сведения см. в 
разделе “Экспорт данных в файл" на стр. 79.

Создание стандартных отчетов
Экспресс-отчеты представляют собой отчеты, отображающие данные 
модулей Requirements, Test Plan, Test Lab и Defects. Экспресс-отчеты 
можно использовать для однократного анализа; их также можно сохранять 
в модуле Dashboard, чтобы завершить настройку данных и представления.

При создании экспресс-отчетов можно выбрать предопределенный отчет 
из списка или создать отчет на основе выбранных данных. 
Дополнительные сведения о типах предопределенных отчетов см. в 
разделе “Доступные предопределенные отчеты" на стр. 670.

Чтобы создать стандартный экспресс-отчет, выполните следующие 
действия.

 1 Выберите модуль Quality Center, в котором необходимо создать отчет.

 2 Чтобы создать предопределенный отчет, выберите команду Analysis > 
Reports и выберите тип отчета, который необходимо создать.
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 3 Чтобы создать экспресс-отчет на основе выбранных записей, выполните 
следующие действия.

 a Выберите требования, тесты или дефекты, которые необходимо 
включить в отчет. Чтобы выбрать несколько записей, нажмите клавишу 
CTRL и выберите записи.

 b Выберите команду Analysis >Reports > Report Selected. Также можно 
щелкнуть записи правой кнопкой мыши и выбрать команду Report 
Selected. Откроется отчет, составленный на основе данных выбранных 
записей.

Чтобы создать экспресс-отчет в модуле Requirements для требования и 
его дочерних объектов, выберите команду Analysis > Report Selected 
with Children. Также можно щелкнуть требование правой кнопкой мыши 
и выбрать команду Report Selected with Children. Откроется отчет с 
данными выбранного требования и его дочерних объектов.

 4 Используйте кнопки на панели инструментов отчета, чтобы настроить 
представление отчета. Дополнительные сведения см. в разделе “Просмотр 
стандартных отчетов" на стр. 680.

 5 Чтобы сохранить отчет в модуле Dashboard, нажмите кнопку Save. 
Откроется диалоговое окно New Standard Report.

 6 В поле Standard Report Name введите имя нового отчета.

 7 В разделе Select Folder выберите папку дерева анализа, в которой 
следует сохранить отчет, или нажмите кнопку New Folder, чтобы создать 
новую папку. Дополнительные сведения о папках в дереве анализа см. в 
разделе “Создание деревьев анализа и панели отчетов" на стр. 614.

 8 Нажмите кнопку Save. Откроется представление Analysis View модуля 
Dashboard; отчет будет показан на вкладке View.

 9 После сохранения отчета можно настроить его содержимое и параметры 
просмотра. Дополнительные сведения см. в разделе “Настройка 
стандартных отчетов" на стр. 675.



Глава 42 • Создание стандартных отчетов

670

Доступные предопределенные отчеты
Можно выбирать предопределенные отчеты в модулях Requirements, Test 
Plan, Test Lab и Defects.

Отчеты модуля Requirements
Для модуля Requirements доступны следующие отчеты.

Отчеты модуля Test Plan
Для модуля Test Plan доступны следующие отчеты.

Отчет Описание

Standard Requirement 
Report

Перечень требований, показанных в дереве 
требований.

Tabular Report Требования в текущем представлении требований, 
показанные в табличном формате. 

Requirements with 
Coverage Tests

Перечень требований в текущем представлении 
требований с информацией о покрытии тестами. 

Requirements with 
Coverage Tests and 
Steps

Перечень требований в текущем представлении 
требований с информацией о покрытии тестами. 
Также отображаются шаги тестов для каждого 
покрытия тестами. 

Requirements with 
Linked Defects

Перечень требований в текущем представлении 
требований со связанными дефектами. 

Requirements with 
Traceability

Перечень требований в текущем представлении 
требований со связанными требованиями, к которым 
и от которых осуществляется прослеживание. 

Отчет Описание

Standard Test Planning 
Report

Перечень тестов текущего представления плана 
тестирования.

Subject Tree Report Перечень тестов текущего представления плана 
тестирования по объектам.
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Отчеты модуля Test Lab
Для модуля Test Lab доступны следующие отчеты.

Tests with Design 
Steps

Перечень тестов текущего представления плана 
тестирования с шагами тестов.

Tests with Covered 
Requirements

Перечень тестов текущего представления плана 
тестирования со сведениями о покрытии требований 
тестами. 

Tests with Linked 
Defects

Перечень тестов текущего представления плана 
тестирования со связанными дефектами.

Отчет Описание

Current Test Set Перечень тестов текущего набора тестов.

Cross Test Set Перечень наборов тестов списка наборов тестов без 
указания содержащихся в них тестов.

Test Set Hierarchy with 
Tests

Перечень наборов тестов в иерархическом порядке с 
указанием статуса каждого набора тестов.

Cross Test Set with 
Tests

Перечень наборов тестов списка наборов тестов с 
указанием содержащихся в них тестов.

Current Test Set with 
Failed Test Runs

Перечень тестов текущего набора тестов со статусом 
выполнения Failed.

Cross Test Set with 
Failed Test Runs

Перечень тестов всех наборов тестов со статусом 
выполнения Failed.

Execution Notification Перечень тестов текущего набора тестов с 
результатами последнего выполнения.

Отчет Описание
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Отчеты модуля Defects
Для модуля Defects доступны следующие отчеты.

Создание стандартных отчетов в модуле Dashboard
В модуле Dashboard можно создавать стандартные отчеты, отображающие 
данные модулей Requirements, Test Plan, Test Lab и Defects.

Примечание. Стандартные отчеты также можно создавать в модулях 
Requirements, Test Plan, Test Lab и Defects. Дополнительные сведения см. в 
разделе “Создание стандартных отчетов" на стр. 668.

Отчет Описание

Standard Defect Report Перечень дефектов, показанных в таблице дефектов.

Tabular Report Отображение дефектов, показанных в таблице 
дефектов, в табличном формате.

Defects with Linked 
Tests and Runs

Перечень дефектов со связанными тестами и 
результатами выполнения тестов.

Fixed or Rejected 
Defects

Перечень дефектов со статусом Fixed или Rejected.

Fixed or Rejected 
Defects Detected by 
Current User

Перечень дефектов со статусом Fixed или Rejected, 
выявленных текущим пользователем.

Opened Defects 
Assigned to Current 
User

Перечень дефектов со статусом Open, назначенных 
текущему пользователю.
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Чтобы создать стандартный отчет в модуле Dashboard, выполните 
следующие действия.

 1 В модуле Dashboard щелкните вкладку Analysis View.

 2 Выберите в дереве анализа папку, в которую необходимо добавить отчет. 
Дополнительные сведения о создании папок дерева анализа см. в разделе 
“Создание деревьев анализа и панели отчетов" на стр. 614.

 3 Нажмите кнопку New Item и выберите команду New Standard Report. 
Откроется диалоговое окно New Standard Report.

 4 В разделе Entity выберите набор данных, для которого требуется создать 
отчет.

 5 В поле Standard Report Type выберите тип создаваемого отчета. 
Дополнительные сведения о доступных типах отчетов см. в разделе 
“Доступные типы отчетов" на стр. 674.

 6 В поле Standard Report Name введите имя отчета.

 7 Нажмите кнопку ОK. Отчет будет добавлен в дерево анализа.

 8 Перейдите на вкладку Details. На вкладке Details отображаются 
следующие поля.

Поле Описание

Entity Набор данных, используемый для создания отчета.

Type Тип элемента анализа.

Sub Type Тип отчета.

Name Имя отчета.
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 9 Можно настроить содержимое отчета и параметры его просмотра. 
Дополнительные сведения см. в разделе “Настройка стандартных отчетов" 
на стр. 675.

 10 Чтобы просмотреть отчет, нажмите кнопку Generate или выберите вкладку 
View. Дополнительные сведения см. в разделе “Просмотр стандартных 
отчетов" на стр. 680.

Доступные типы отчетов
При создании стандартных отчетов в модуле Dashboard можно выбрать 
один из доступных типов отчета. Для разных объектов данных доступны 
разные типы отчетов.

Modified Дата и время последнего изменения отчета.

Modified By Пользователь, внесший последнее изменение отчета.

Owner Пользователь, создавший отчет. Разрешения на 
изменение общих отчетов могут быть предоставлены 
только владельцу.

Description Описание отчета.

Отчет Описание

Requirements Report Перечень требований в модуле Requirements.

Subject Test Report Перечень иерархии объектов тестирования в модуле 
Test Plan.

Test Plan Report Перечень тестов в модуле Test Plan.

Cross Test Set Report Перечень наборов тестов в модуле Test Lab без 
указания содержащихся в них тестов.

Execution Report Перечень экземпляров тестов с указанием статуса 
тестирования.

Test Set Hierarchy 
Report

Перечень иерархии папок наборов тестирования в 
модуле Test Lab.

Defects Report Перечень дефектов в модуле Defects.

Поле Описание
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Настройка стандартных отчетов
Можно определить внешний вид и содержимое отчетов Quality Center. 
Можно указать конфигурацию основного отчета и каждого суботчета по 
отдельности.

Чтобы настроить стандартный отчет, выполните следующие 
действия.

 1 Выберите отчет в дереве анализа.

 2 Перейдите на вкладку Configuration.

 3 В разделе Page укажите количество элементов основного отчета, которые 
будут отображаться на одной странице.

➤ Чтобы ограничить количество элементов, отображаемых на одной 
странице, выберите вариант Limit items per page to и укажите 
количество элементов.

➤ Чтобы отобразить все элементы на одной странице, выберите вариант 
All items in one page.
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 4 В разделе Template выберите шаблон отчета Quality Center по умолчанию 
или собственный шаблон.

 5 Чтобы добавить суботчет, нажмите кнопку Add Sub-Report. 
Дополнительные сведения о суботчетах см. в разделе “Добавление 
суботчетов" на стр. 677.

 6 В дереве слева от вкладки выберите основной отчет или суботчет, которые 
требуется настроить.

 7 В разделе Filter можно определять или очищать фильтры и приоритеты 
сортировки.

➤ Нажмите кнопку Set Filter/Sort, чтобы выполнить фильтрацию и 
сортировку данных в соответствии с выбранными критериями.

➤ Нажмите кнопку Clear Filter/Sort, чтобы очистить все фильтры и 
приоритеты сортировки.

Дополнительные сведения см. в Глава 3, "Работа с данными 
Quality Center"..

 8 В разделе Fields можно указать поля, которые будут показаны в отчете, и 
порядок их отображения.

➤ Чтобы включить в отчет все поля, выберите вариант All Fields (auto-
layout).

➤ Чтобы выбрать поля и настроить порядок их отображения, выберите 
вариант Custom Fields (layout) и нажмите кнопку Select Fields. 
Дополнительные сведения см. в разделе “Упорядочивание столбцов" на 
стр. 54.

 9 В разделе Options выберите следующие параметры в зависимости от типа 
отчета.

Параметр Описание

Attachments Отображение списка связанных вложений.

Grid View Отображение отчета в виде таблицы.

History Отображение списка всех изменений требования, 
теста или дефекта.
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 10 Перейдите на вкладку View, чтобы создать отчет с обновленными 
настройками. Дополнительные сведения о просмотре отчетов см. в 
разделе “Просмотр стандартных отчетов" на стр. 680.

Добавление суботчетов
После создания отчета к нему можно добавлять суботчеты. Суботчет 
добавляет дополнительный слой информации, связанной с родительским 
отчетом. Например, после создания отчета о дефектах можно добавить 
суботчет о связанных требованиях. При этом в отчете будут показаны 
требования, связанные с каждым дефектом. Дополнительные сведения о 
доступных типах суботчетов см. в разделе “Доступные суботчеты" на 
стр. 679.

Keep Parent-Child 
Order

Отображение раздела требования с его дочерним 
требованием. При выборе этого параметра 
установленные фильтры и приоритеты сортировки 
будут отключены. 

Rich Text Включение в отчет форматированного текста 
требований.

Show Full Coverage Отображение покрытия тестами для каждого 
требования из дерева. 

Show Paragraph 
Number

Отображение номера в иерархии, назначенного 
каждому требованию в дереве. Номера не связаны с 
уникальными идентификаторами Req ID, 
назначенными каждому требованию. 

Show Steps only for 
"Failed" Runs

При добавлении суботчета Run Steps шаги будут 
перечислены только для выполнений со статусом 
Failed.

Параметр Описание
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В каждый суботчет можно добавлять суботчеты. На каждом уровне можно 
добавлять несколько суботчетов.

Обзор стандартных отчетов см. в Глава 42, "Создание стандартных 
отчетов"..

Чтобы добавить суботчет, выполните следующие действия.

 1 В дереве анализа выберите отчет и перейдите на вкладку Configuration.

 2 В области отчетов выберите отчет или суботчет, к которому необходимо 
добавить суботчет.

 3 Нажмите кнопку Add Sub Report. В списке Type выберите суботчет и 
нажмите кнопку OK. Также можно щелкнуть отчет правой кнопкой мыши и 
выбрать суботчет в списке Add Sub Report. Суботчет будет добавлен в 
список отчетов.

 4 Чтобы удалить суботчет, выберите его и нажмите кнопку Delete Sub 
Report. Также можно щелкнуть отчет правой кнопкой мыши и выбрать 
команду Delete Sub Report. При удалении родительского отчета также 
будут удалены все его суботчеты.
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Доступные суботчеты
Доступные суботчеты определяются типом родительского отчета.

Могут быть доступны следующие суботчеты.

Отчет Описание

Contained Test Sets Перечень наборов тестов в папке наборов тестов.

Contained Tests Перечень экземпляров тестов в наборе тестов.

Coverage 
Requirements

Перечень сведений о требованиях, покрытых тестом.

Design Steps Перечень шагов теста.

Linked Defects Перечень дефектов, связанных с записью.

Linked Entities Перечень всех объектов, связанных с дефектом.

Parent Test Перечень родительских экземпляров теста для 
выполнения теста.

Related Requirements Перечень требований, связанных с дефектом.

Requirements 
Coverage

Перечень тестов, покрывающих требование.

Run Steps Перечень шагов выполнения теста.

Runs Перечень всех выполнений экземпляра теста.

Source Execution Test Перечень выполненных экземпляров тестов, 
связанных с дефектом.

Source Run Перечень выполнений теста, связанных с дефектом.

Source Test Перечень тестов, связанных с дефектом.

Trace To Перечень требований, прослеживаемых к текущему 
требованию.

Trace From Перечень требований, прослеживаемых от текущего 
требования.
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Просмотр стандартных отчетов
Отчеты Quality Center можно просматривать, печатать и сохранять.

Чтобы просмотреть стандартный отчет, выполните следующие 
действия.

 1 Выберите отчет.

➤ В дереве анализа выберите отчет и перейдите на вкладку View.

➤ Выберите модуль Requirements, Test Plan, Test Lab или Defects, 
выберите команду Analysis > Recently Used и выберите отчет.

 2 Чтобы обновить отчет для отображения наиболее актуальных данных, 
нажмите кнопку Generate.

 3 Чтобы просмотреть отчет в полноэкранном режиме, нажмите кнопку Full 
Screen. Панель инструментов View остается видимой в полноэкранном 
режиме.

Чтобы выйти из полноэкранного режима, нажмите кнопку Close.
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 4 Нажмите кнопку First Page, чтобы просмотреть первую страницу отчета, 
или кнопку Previous Page, чтобы просмотреть предыдущую страницу.

 5 Нажмите кнопку Next Page, чтобы просмотреть следующую страницу 
отчета, или кнопку Last Page, чтобы просмотреть последнюю страницу.

 6 Чтобы напечатать отчет, нажмите стрелку Print и выберите команду 
Current Page или 
All Pages. Откроется диалоговое окно Print. При необходимости измените 
настройки принтера. Нажмите кнопку Print.

 7 Чтобы сохранить отчет в виде веб-страницы или текстового файла, 
нажмите стрелку Save и выберите команду Current Page или All Pages. 
Откроется диалоговое окно Save Web Page. При необходимости измените 
имя файла. Чтобы сохранить отчет в исходном формате, выберите вариант 
Web Page, complete в списке Save as type. Чтобы сохранить отчет в виде 
текстового файла, выберите вариант Text File и нажмите кнопку Save.
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43
Создание отчетов Excel

Можно создавать отчеты Excel, позволяющие экспортировать данные 
Quality Center в Microsoft Excel и анализировать их в этом приложении.

Примечание. Поддерживаемые версии Microsoft Excel см. в документе 
Руководство по установке HP Quality Center.

Эта глава содержит следующие разделы.

 ➤  О создании отчетов Excel на стр. 684

 ➤  Создание отчетов Excel на стр. 685

 ➤  Создание запросов SQL на стр. 686

 ➤  Добавление параметров к запросам SQL на стр. 691

 ➤  Создание скриптов дополнительной обработки на стр. 694

 ➤  Выполнение отчетов Excel на стр. 695
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О создании отчетов Excel
Можно экспортировать данные Quality Center в Microsoft Excel. Это 
позволяет анализировать данные, используя все возможности приложения 
Excel. Отчет Excel состоит из набора данных, определенного запросами 
SQL к базе данных проекта. Также для обработки и анализа извлеченных 
данных можно запустить скрипт Visual Basic.

Например, можно создать сводную таблицу для анализа данных модуля 
Defects, чтобы отобразить в табличном формате число дефектов с 
различным статусом, назначенных разным пользователям.

Также можно создавать отчеты с параметрами. Это позволяет 
сформировать более гибкий отчет, который создается только один раз, но 
может использоваться в различных ситуациях. 

Совет. Проект Quality Center Demo Project содержит образцы отчетов 
Excel. Запросы SQL и скрипты Visual Basic из этих отчетов можно 
использовать в качестве основы для разработки собственных запросов и 
скриптов.

Примечание. Пользователи, принадлежащие к группам, для которых 
определены фильтры скрытия данных, могут получить доступ к данным с 
ограничением доступа при помощи отчетов Excel. Чтобы не допустить 
этого, можно отключить доступ к работе с отчетами Excel для этих групп 
пользователей. Дополнительные сведения о группах пользователей и 
разрешениях см. в документе HP Quality Center Administrator Guide.
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Создание отчетов Excel
Для создания отчетов Excel используется модуль Dashboard.

Чтобы создать отчет Excel, выполните следующие действия.

 1 В модуле Dashboard щелкните вкладку Analysis View.

 2 В дереве анализа выберите папку, в которую необходимо добавить отчет 
Excel. Дополнительные сведения об управлении папками в дереве анализа 
см. в разделе “Создание деревьев анализа и панели отчетов" на стр. 614.

 3 Нажмите кнопку New Item и выберите команду New Excel Report. 
Откроется диалоговое окно New Excel Report.

 4 В поле Excel Report Name введите имя отчета Excel.

 5 Нажмите кнопку ОK. Отчет Excel будет добавлен в дерево анализа.

 6 Перейдите на вкладку Details. На вкладке Details отображаются 
следующие поля.

Поле Описание

Entity В отчетах Excel этот поле содержит значение 
Unspecified Entity.

Type Тип элемента анализа.

Sub Type В отчетах Excel это поле содержит то же значение, что и 
поле Type.

Name Имя отчета Excel.

Modified Дата и время последнего изменения отчета Excel.

Modified By Пользователь, внесший последнее изменение отчета 
Excel.

Owner Пользователь, создавший отчет Excel. Разрешения на 
изменение общих отчетов Excel могут быть 
предоставлены только владельцу.

Description Описание отчета Excel.
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 7 Создайте один или несколько запросов SQL, чтобы определить 
извлекаемые данные. Дополнительные сведения см. в разделе “Создание 
запросов SQL" на стр. 686.

 8 Также можно создать скрипт дополнительной обработки, который будет 
выполняться в Excel после экспорта данных. Дополнительные сведения см. 
в разделе “Создание скриптов дополнительной обработки" на стр. 694.

 9 Выполните экспорт данных в Excel. Дополнительные сведения см. в 
разделе “Выполнение отчетов Excel" на стр. 695.

Создание запросов SQL
После добавления отчета Excel в модуле Dashboard необходимо указать, 
какие данные проекта должны быть включены в отчет. Для определения 
этих данных следует создать запросы SQL. В одном отчете Excel можно 
создать несколько запросов. При создании отчета результаты каждого 
запроса будут показаны на отдельных листах Excel.

Данный раздел содержит следующие подразделы.

➤ Защита базы данных

➤ Создание запроса SQL

Защита базы данных
Чтобы обеспечить целостность базы данных, следует выполнять только 
запросы, извлекающие данные из базы данных проекта. Не следует 
выполнять запросы, изменяющие базу данных проекта путем добавления, 
изменения или удаления записей.

По умолчанию, в целях обеспечения допустимости запросов и для 
предотвращения изменения базы данных проекта, Quality Center 
выполняет проверку следующих условий.

➤ Запрос начинается с команды SELECT.

➤ Запрос содержит только одну инструкцию SQL.
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➤ Запрос не содержит следующих команд (допускаются только в 
комментариях): INSERT, DELETE, UPDATE, DROP, CREATE, COMMIT, 
ROLLBACK, ALTER, EXEC, EXECUTE, MERGE, GRANT, REVOKE, SET, 
INTO и TRUNCATE.

Включить и выключить эту проверку и настроить ее выполнение можно с 
помощью параметров SQL_QUERY_VALIDATION_ENABLED и 
SQL_QUERY_VALIDATION_BLACK_LIST в разделе Site Administration. 
Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide:

Создание запроса SQL
Для создания запроса SQL используется вкладка Query или средство Query 
Builder. Запросы SQL можно записывать вручную непосредственно на 
вкладке Query. Средство Query Builder позволяет выбирать объекты 
проекта из списка и определять или добавлять параметры запроса.

Чтобы создать запрос SQL, выполните следующие действия.

 1 Выберите отчет Excel в дереве анализа.

 2 Перейдите на вкладку Configuration, а затем выберите вкладку Query.

Введите запрос SQL на вкладке Query или выполните следующие шаги, 
чтобы создать запрос при помощи средства Query Builder.
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 3 Нажмите кнопку Query Builder. Откроется диалоговое окно Excel Reports 
Query Builder. 

В окне построителя запросов показаны следующие области и вкладки.

➤ Область SQL. Содержит инструкции SQL для запросов в отчете.

➤ Вкладка Query Parameters. Содержит список параметров запроса.

➤ Вкладка Query Results. Содержит результаты проверок запроса.

➤ Область Entities. Содержит список полей базы данных Quality Center и 
объектов, которые можно добавить к запросу. Можно просматривать 
поля и объекты по имени, по имени столбца в базе данных или обоими 
способами. Чтобы изменить представление, нажмите кнопку Entities 
View и выберите нужное представление.

 4 При создании запроса SQL необходимо использовать версию SQL, 
применяющуюся в базе данных проекта. Чтобы просмотреть тип базы 
данных проекта, нажмите кнопку Database Type..

Панель 
SQL

Панель 
объектов
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 5 Чтобы добавить новый запрос, нажмите кнопку Add Query.. В окне 
средства построения запросов будет добавлена новая вкладка с именем 
по умолчанию Query<номер>.

 6 В области SQL введите запрос SQL, чтобы определить набор данных, 
который будет использоваться в отчете.

Примечание. Символы @ и \ имеют особое значение и не 
интерпретируются буквально при выполнении запросов SQL к базе данных 
проекта. Если необходимо ввести эти символы, следует заменить @ на \@ 
, а  \ на \\. Например, если необходимо, чтобы инструкция 
SELECT * FROM BUG WHERE BUG.BG_SUMMARY = ‘@parameter@’ 
была выполнена в базе данных Quality Center буквально, введите 
SELECT * FROM BUG WHERE BUG.BG_SUMMARY = ‘\@parameter\@’.

 7 В запрос SQL можно добавить объект проекта. Возможны следующие 
варианты.

➤ Чтобы добавить объект проекта без псевдонима столбца, дважды 
щелкните объект в области Entities или выберите объект и нажмите 
кнопку Add Entity to Query.. 

➤ Чтобы добавить объект проекта с псевдонимом столбца, определенным 
названием объекта, выберите объект, который следует добавить. 
Нажмите стрелку Add Entity to Query и выберите команду Add Entity to 
Query with Entity Title as Alias.

Объект будет добавлен в запрос SQL в текущей позиции курсора. Для 
разделения нескольких объектов проекта используйте запятую.

 8 К запросу SQL можно добавлять параметры. Дополнительные сведения 
см. в разделе “Добавление параметров к запросам SQL" на стр. 691.
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 9 Можно провести проверку запроса и просмотреть результаты проверки на 
вкладке Query Results. Можно просмотреть все результаты запроса или 
только первые десять записей.

➤ Нажмите кнопку Run Query, чтобы просмотреть все результаты запроса 
на вкладке Query Results. Если запрос содержит параметры, будет 
выдан запрос для ввода значений параметров или подтверждения 
значений по умолчанию.

➤ Чтобы просмотреть только первые десять записей из результатов 
запроса, нажмите кнопку Test Query. Если запрос содержит параметры, 
Quality Center использует значения параметров по умолчанию.

 10 Можно выполнять поиск текста в запросе. Чтобы найти текст, укажите 
строку для поиска в поле Find и нажмите кнопку Find..

 11 Запросы можно переименовывать. Чтобы переименовать запрос, выберите 
его и нажмите кнопку Rename.. В диалоговом окне Rename query введите 
новое имя и нажмите кнопку OK. Лист Excel, содержащий данные, 
извлеченные при выполнении запроса, будет иметь то же имя, что и запрос 
.

 12 Чтобы удалить запрос, выберите его и нажмите кнопку Delete.. Также 
можно щелкнуть запрос правой кнопкой мыши и выбрать команду Delete. 
Нажмите кнопку Yes для подтверждения.
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Добавление параметров к запросам SQL
Можно добавлять параметры к запросам SQL для создания отчетов Excel. 
Каждому параметру запроса можно присвоить значение по умолчанию. Во 
время создания отчета будет выдан запрос для ввода значения параметра 
или подтверждения значения по умолчанию. Также можно выбрать 
постоянное использование значения по умолчанию без запроса 
Quality Center при каждом создании отчета.

Например, пусть необходимо создать отчет, содержащий диаграмму 
количества требований, добавленных в проект в течение определенного 
периода времени. Возможно, потребуется запускать отчет несколько раз 
(каждый раз для другого периода времени). Можно избежать создания 
нескольких отчетов, создав один отчет с параметрами даты начала и даты 
окончания периода. Каждый раз при создании отчета будет выдан запрос 
для ввода начальной и конечной даты периода.

Параметры запроса сначала необходимо добавить в список Parameters. 
Можно добавить глобальные параметры, доступные для всех запросов в 
отчете, или добавить параметры, которые могут использоваться только в 
отдельных запросах. После добавления параметров в список Parameters 
можно вставить параметры в запрос.

Внимание! 

➤ Нельзя использовать параметры для идентификаторов SQL, таких как 
имена таблиц или столбцов.

➤ Значения параметров не могут содержать инструкций SQL.

Добавление параметров запросов в список Parameters
Перед добавлением параметра в запрос необходимо добавить параметр в 
список Parameters.

Чтобы добавить параметр в список Parameters, выполните 
следующие действия.

 1 Выберите отчет Excel в дереве анализа.
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 2 На вкладке Configuration выберите вкладку Query, а затем нажмите кнопку 
Query Builder.

 3 На вкладке Query Parameters нажмите кнопку New Query Parameter.. 
Откроется диалоговое окно New Query Parameter.

 4 В поле Parameter Name введите имя параметра. Имя не может содержать 
следующих символов: @

 5 В поле Default Value введите значение параметра по умолчанию. 

Установите флажок Hide On Run, чтобы использовать значение по 
умолчанию при каждом создании отчета. Не устанавливайте этот флажок, 
если требуется запрос Quality Center для подтверждения или изменения 
значения по умолчанию при создании отчета.

 6 Установите флажок Global Parameter, чтобы сделать параметр доступным 
для всех запросов в отчете. Если этот флажок не установлен, параметр 
будет доступен только в текущем запросе.

 7 В поле Description введите описание параметра.

 8 Нажмите кнопку ОK. Параметр будет добавлен в список Parameters и 
диалоговое окно будет закрыто.
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 9 Чтобы удалить параметр из списка Parameters, выделите параметр и 
нажмите кнопку Delete.. Нажмите кнопку Yes для подтверждения.

Внимание! При удаления параметра, использующегося в запросе для 
создания отчета, запросы с этим параметром станут недопустимыми.

 10 Чтобы изменить параметр в списке Parameters, выделите этот параметр и 
нажмите кнопку Edit Parameter.. В диалоговом окне Edit Parameter 
измените настройки параметра и нажмите кнопку OK.

Добавление параметра в запрос SQL
После добавления параметра в список Parameters можно добавить 
параметр в SQL-запрос.

Чтобы добавить параметр в SQL-запрос, выполните следующие 
действия.

 1 Выберите отчет Excel в дереве анализа.

 2 На вкладке Configuration выберите вкладку Query, а затем нажмите кнопку 
Query Builder.

 3 В области SQL поместите курсор в позицию, в которую необходимо 
добавить параметр.

 4 На вкладке Query Parameters выберите параметр в списке Parameters и 
нажмите кнопку Add Parameter to Query.. Также можно перетащить 
параметр в область запроса. Параметр будет добавлен к запросу.

Примечание. Для параметра, представляющего текстовое значение, 
необходимо вручную добавить одинарные кавычки (') в области SQL. 
Например, если панель SQL содержит фразу WHERE 
BUG.BG_DETECTED_BY = @name@, необходимо заменить текст 
@name@ на '@name@'.
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Создание скриптов дополнительной обработки
Можно создать скрипт Visual Basic, который будет запускаться после 
экспорта данных в Excel. Используйте этот скрипт для операций с данными 
в Excel. Например, можно представлять данные требований в Excel в виде 
сводной таблицы, выполнять вычисления с данными о дефектах для 
подсчета среднего времени устранения обнаруженного дефекта, а также 
создавать диаграммы на основе экспортированных данных.

Рекомендации по созданию скриптов дополнительной 
обработки
При создании скрипта дополнительной обработки обратите внимание на 
следующие рекомендации.

➤ Перед запуском скрипта дополнительной обработки необходимо 
установить параметры безопасности в Microsoft Excel, чтобы сделать 
возможным выполнение скриптов. В приложении Excel выберите команду 
Сервис > Макросы > Безопасность. Откроется диалоговое окно 
"Безопасность". На вкладке «Уровень безопасности» выберите вариант 
Низкий. На вкладке «Надежные источники» установите флажок "Доверять 
проекту Visual Basic". Закройте приложение Excel.

➤ Скрипт дополнительной обработки должен содержать подпрограмму с 
именем QC_PostProcessing. Эта подпрограмма используется в качестве 
точки входа в скрипт. Эта подпрограмма не возвращает значения и не 
использует никаких аргументов.

➤ Перед началом работы с данными отчета в Excel необходимо определить 
диапазон, содержащий данные отчета. Чтобы определить диапазон, 
выполните два следующих шага. 

➤ Сначала определяется лист, содержащий данные отчета, путем 
создания объекта листа с данными. Например, если лист имеет имя 
Query1, можно использовать инструкцию Set MainWorksheet = 
ActiveWorkbook.Worksheets("Query1").

➤ После определения листа, содержащего данные отчета, определяется 
диапазон данных путем создания объекта диапазона, содержащего 
данные. Например, если определен лист с именем MainWorksheet, 
можно использовать инструкцию Set DataRange = 
MainWorksheet.UsedRange. 
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После определения этого диапазона можно оперировать данными в этом 
диапазоне с использованием кода на языке Visual Basic.

Создание скрипта дополнительной обработки
Для создания скрипта дополнительной обработки используется вкладка 
Post-processing.

Чтобы создать скрипт дополнительной обработки, выполните 
следующие действия.

 1 Выберите отчет Excel в дереве анализа.

 2 На вкладке Configuration выберите вкладку Post-processing.

 3 В поле редактора скриптов введите скрипт Visual Basic, который 
необходимо запустить после экспорта данных, определенных в запросе, в 
приложение Excel. Этот скрипт должен использовать шаблон скрипта, 
показанный в поле Script Editor. Дальнейшие рекомендации по созданию 
скрипта дополнительной обработки см. в разделе “Рекомендации по 
созданию скриптов дополнительной обработки” выше.

 4 Чтобы запустить скрипт дополнительной обработки после экспорта данных 
в Excel, установите флажок Run post-processing. Если этот флажок не 
установлен, скрипт не будет выполняться при создании отчета.

 5 В скрипте дополнительной обработки можно выполнять поиск текста. 
Чтобы найти текст, укажите строку для поиска в поле Find и нажмите кнопку 
Find..

Выполнение отчетов Excel
После настройки отчета его можно выполнять. При выполнении отчета 
данные, указанные в SQL-запросах, будут извлечены из базы данных 
проекта, сохранены в книге Excel и обработаны скриптом дополнительной 
обработки.

Чтобы выполнить отчет Excel, выполните следующие действия.

 1 Выберите отчет Excel в дереве анализа.



Глава 43 • Создание отчетов Excel

696

 2 На вкладке Configuration выберите вкладку Generation Settings.

 3 Чтобы открыть отчет Quality Center в приложении Excel после создания, 
установите флажок Launch report in Excel.

 4 В поле Status выберите статус отчета. Статус отчета информирует других 
пользователей о степени готовности отчета к созданию. Возможны 
следующие значения статуса отчета.

➤ Ready. Отчет готов к созданию. 

➤ Not Ready. Отчет не готов к созданию. Если пользователь попытается 
создать отчет с таким статусом, будет показано предупреждение.

 5 В поле Save report as target file укажите папку и имя файла Excel для 
экспорта данных. Нажмите кнопку обзора, чтобы выбрать местоположение 
в диалоговом окне Save Report.
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 6 Нажмите кнопку Generate, чтобы создать отчет.

➤ Если статус отчета Not Ready, будет показано предупреждение. 
Нажмите кнопку Yes, чтобы создать отчет, несмотря на 
предупреждение.

➤ Если запрос отчета содержит параметры, откроется диалоговое окно 
Report Parameters. Введите значение параметров в столбце Value и 
нажмите кнопку OK.

Отчет будет сохранен в указанном местоположении. Если установлен 
флажок Launch report in Excel, файл отчета будет открыт в приложении 
Excel. Если флажок не установлен, будет показано подтверждающее 
сообщение.
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44 
Создание диаграмм анализа в реальном 
времени

Диаграммы анализа в реальном времени позволяют создавать и 
отображать динамические графические представления данных, связанных 
с планами тестирования и наборами тестов. Диаграммы анализа в 
реальном времени можно использовать для просмотра данных, 
относящихся к папке объектов тестирования или папке наборов тестов. 
Диаграммы изменяются при каждом выборе папки объектов или папки 
наборов тестов, отображая выбранные данные.

Эта глава содержит следующие разделы.

 ➤  О создании диаграмм анализа в реальном времени на стр. 700

 ➤  Создание диаграмм анализа в реальном времени на стр. 700

 ➤  Удаление диаграмм анализа в реальном времени на стр. 709

 ➤  Настройка внешнего вида диаграмм на стр. 710
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О создании диаграмм анализа в реальном времени
Диаграммы анализа в реальном времени создаются с целью быстрого 
динамического визуального обзора всех тестов в папке тестов или наборов 
тестов в папке наборов тестов. После создания диаграммы к ней можно 
перейти, выбрав вкладку Live Analysis в представлении дерева в модуле 
Test Plan или Test Lab.

При обновлении записи в папке изменение данных отображается на 
диаграмме без необходимости повторного создания диаграммы вручную.

Диаграммы анализа в реальном времени отличаются от диаграмм, 
описанных в Глава 41, "Создание диаграмм", тем, что для просмотра 
измененных данных не требуется создавать диаграмму повторно. Кроме 
того, при выборе другой папки в том же самом модуле компоновка и 
параметры диаграммы сохраняются. Это позволяет просматривать один и 
тот же графический анализ различных папок без повторного создания 
диаграмм.

Создание диаграмм анализа в реальном времени
Диаграммы анализа в реальном времени можно создавать для папок 
объектов тестирования или папок наборов тестов. Дополнительные 
сведения о создании диаграмм анализа в реальном времени для папок 
объектов тестирования см. в разделе “Создание диаграмм для папок 
объектов тестирования" на стр. 701. Дополнительные сведения о создании 
диаграмм анализа в реальном времени для папок наборов тестов см. в 
разделе “Создание диаграмм для папок наборов тестов" на стр. 705.

Примечание. Диаграммы анализа в реальном времени уникальны для 
каждого имени пользователя. Каждый пользователь проекта может 
создавать диаграммы анализа в реальном времени, которые будут 
доступны для просмотра только ему и не будут доступны другим 
пользователям.
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Создание диаграмм для папок объектов тестирования
На вкладке Live Analysis можно создавать диаграммы анализа в реальном 
времени для тестов в папках объектов тестирования. После определения 
данных, которые необходимо отобразить, диаграммы обновляются 
автоматически при каждом изменении данных в одном или нескольких 
тестах из той папки объектов, для которой была создана диаграмма.

Примечание. Диаграммы анализа в реальном времени отображают только 
те тесты, которые расположены непосредственно в выбранной папке 
объектов тестирования. Тесты, расположенные в дочерних папках на 
более низких иерархических уровнях выбранной папки объектов, в 
диаграммы не включаются.

Чтобы создать диаграмму папки объектов, выполните следующие 
действия.

 1 Нажмите кнопку Test Plan на боковой панели, чтобы открыть модуль Test 
Plan.

 2 Выберите команду View > Test Plan Tree. Будет показано дерево плана 
тестирования.

 3 В дереве плана тестирования выберите папку объектов тестирования.

 4 Перейдите на вкладку Live Analysis. Вкладка Live Analysis содержит две 
области, в каждой из которых можно отобразить диаграмму. 

 5 В том случае, если уже отображаются две диаграммы и необходимо 
создать новую диаграмму, удалите одну из текущих диаграмм. 
Дополнительные сведения см. в разделе “Удаление диаграмм анализа в 
реальном времени" на стр. 709.
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 6 Щелкните ссылку Add Graph в той области, в которой необходимо показать 
диаграмму. Также можно выбрать команду Analysis > Live Analysis > Add 
Graph. Откроется диалоговое окно Graph Wizard: Test Plan Module.

 7 В разделе Graph type выберите тип диаграммы, которую необходимо 
отобразить. В модуле Test Plan можно создавать следующие диаграммы.

Диаграмма Описание

Summary Graph Отображает текущее количество тестов в выбранной 
папке объектов тестирования.

Progress Graph Отображает количество тестов, накопленных в 
выбранной папке объектов тестирования в 
определенных точках за выбранный период времени.

Trend Graph Отображает историю изменений в определенных полях 
плана тестирования в выбранной папке объектов 
тестирования для каждого отображаемого временного 
интервала. 
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 8 Нажмите кнопку Next. В окне Group By выберите поле, по которому тесты 
будут группироваться в диаграмме. Для диаграмм выполнения и тенденций 
можно выбрать только поле с включенной записью истории изменения. 
Дополнительные сведения о включении записи истории изменения поля 
см. в документе HP Quality Center Administrator Guide.

 9 Если выбрано создание сводной диаграммы, нажмите кнопку Next. В 
списке X-Axis выберите поле, которое будет использоваться для оси Х. 

 10 Нажмите кнопку Finish. Диаграмма анализа в реальном времени будет 
показана в выбранной области.

Выбранные свойства диаграммы отображаются в верхней части 
диаграммы. 
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Примечание. Данные на диаграмме отображаются с учетом фильтров, 
настроенных для дерева плана тестирования. Дополнительные сведения о 
фильтрации см. в разделе “Фильтрация записей" на стр. 59.

 11 Нажмите кнопку Full Screen View, чтобы просмотреть диаграмму в 
полноэкранном режиме. Чтобы восстановить обычный вид диаграммы, 
нажмите кнопку Close.

 12 Чтобы проанализировать данные, щелкните сегмент диаграммы. 
Откроется диалоговое окно Drill Down Results с таблицей, содержащей 
более подробные сведения. Можно определить вид и порядок отображения 
столбцов. Также можно экспортировать содержимое таблицы в текстовый 
файл, таблицу Microsoft Excel, документ Microsoft Word или файл HTML. 
Дополнительные сведения см. в разделе “Экспорт данных в файл" на 
стр. 79. 

 13 Чтобы изменить цвет столбца гистограммы или линии линейного графика, 
щелкните столбец или линию правой кнопкой мыши или выберите 
соответствующий элемент в условных обозначениях диаграммы. В 
открывшемся диалоговом окне Color выберите новый цвет на одной из 
цветовых палитр.

 14 Нажмите кнопку Set Graph Appearance, чтобы настроить заголовок 
диаграммы, ее цвет и отображение. Дополнительные сведения о 
параметрах отображения диаграмм см. в разделе “Настройка внешнего 
вида диаграмм" на стр. 710.
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Создание диаграмм для папок наборов тестов
На вкладке Live Analysis можно создавать диаграммы анализа в реальном 
времени для наборов тестов из папок наборов тестов. После определения 
данных, которые необходимо отобразить, диаграммы обновляются 
автоматически при каждом изменении данных в одном или нескольких 
наборах тестов из той папки, для которой была создана диаграмма. 

Примечание. Диаграммы анализа в реальном времени отображают только 
те наборы тестов, которые расположены непосредственного в выбранной 
папке наборов тестов. Наборы тестов, расположенные в дочерних папках 
выбранной папки наборов тестов на более низких иерархических уровнях, в 
диаграммы не включаются.

Чтобы создать диаграмму папки наборов тестов, выполните 
следующие действия.

 1 Нажмите кнопку Test Lab на боковой панели, чтобы отобразить модуль 
Test Lab.

 2 Выберите команду View > Test Sets Tree. Будет показано дерево наборов 
тестов.

 3 В дереве наборов тестов выберите папку наборов тестов.

 4 Перейдите на вкладку Live Analysis. Вкладка Live Analysis содержит две 
области, в каждой из которых можно отобразить диаграмму. 

 5 В том случае, если уже отображаются две диаграммы и необходимо 
создать новую диаграмму, удалите одну из текущих диаграмм. 
Дополнительные сведения см. в разделе “Удаление диаграмм анализа в 
реальном времени" на стр. 709.
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 6 Щелкните ссылку Add Graph в той области, в которой необходимо показать 
диаграмму. Также можно выбрать команду Analysis > Live Analysis > Add 
Graph. Откроется диалоговое окно Graph Wizard: Test Lab Module.

 7 В разделе Graph type выберите тип диаграммы, которую необходимо 
отобразить. В модуле Test Lab можно создавать следующие диаграммы.

Нажмите кнопку Next.

Диаграмма Описание

Summary Graph Отображает количество тестов из наборов тестов в 
выбранной папке. 

Progress Graph Отображает количество тестов, накопленных в наборах 
тестов выбранных папок в определенных точках за 
определенный период времени.



Глава 44 • Создание диаграмм анализа в реальном времени

707

 8 В окне Group By выберите поле, по которому тесты будут группироваться в 
диаграмме. Для диаграммы выполнения можно выбрать только поле, для 
которого включена запись истории изменения. Дополнительные сведения о 
включении записи истории изменения поля см. в документе 
HP Quality Center Administrator Guide.

 9 Если выбрано создание сводной диаграммы, нажмите кнопку Next. В 
списке X-Axis выберите поле, которое будет использоваться для оси Х.

 10 Нажмите кнопку Finish. Диаграмма анализа в реальном времени будет 
показана в выбранной области.

Выбранные свойства диаграммы отображаются в верхней части 
диаграммы. 



Глава 44 • Создание диаграмм анализа в реальном времени

708

Примечание. Данные на диаграмме отображаются с учетом фильтров, 
определенных для дерева наборов тестов. Дополнительные сведения о 
фильтрации см. в разделе “Фильтрация записей" на стр. 59.

 11 Нажмите кнопку Full Screen View, чтобы просмотреть диаграмму в 
полноэкранном режиме. Чтобы восстановить обычный вид диаграммы, 
нажмите кнопку Close.

 12 Чтобы проанализировать данные, щелкните сегмент диаграммы. 
Откроется диалоговое окно Drill Down Results с таблицей, содержащей 
более подробные данные. Можно определить вид и порядок отображения 
столбцов. Также можно экспортировать содержимое таблицы в текстовый 
файл, таблицу Microsoft Excel, документ Microsoft Word или файл HTML. 
Дополнительные сведения см. в разделе “Экспорт данных в файл" на 
стр. 79.

 13 Чтобы изменить цвет столбца гистограммы или линии линейного графика, 
щелкните столбец или линию правой кнопкой мыши или выберите 
соответствующий элемент в условных обозначениях диаграммы. В 
открывшемся диалоговом окне Color выберите новый цвет на одной из 
цветовых палитр.

 14 Нажмите кнопку Set Graph Appearance, чтобы настроить заголовок 
диаграммы, ее цвет и отображение. Дополнительные сведения о 
параметрах отображения диаграмм см. в разделе “Настройка внешнего 
вида диаграмм" на стр. 710.
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Удаление диаграмм анализа в реальном времени
Можно удалить диаграмму анализа в реальном времени. В том случае, 
если для папки отображаются две диаграммы и необходимо создать новую 
диаграмму, сначала необходимо удалить одну из текущих диаграмм.

Чтобы удалить диаграмму анализа в реальном времени, выполните 
следующие действия.

 1 Нажмите кнопку Remove Graph в верхней части той диаграммы, которую 
необходимо удалить. Также можно выбрать команду Analysis > Live 
Analysis > Remove Graph.

 2 Нажмите кнопку Yes для подтверждения. Диаграмма будет удалена из 
выбранной области, и будет показана ссылка Add Graph.
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Настройка внешнего вида диаграмм
После создания диаграммы можно изменять ее заголовки и внешний вид. 
Для гистограммы можно настроить параметры отображения столбцов. Для 
линейного графика можно настроить параметры отображения линий.

Чтобы настроить внешний вид диаграммы, выполните следующие 
действия.

 1 Нажмите кнопку Set Graph Appearance в верхней части диаграммы. Также 
можно выбрать команду Analysis > Live Analysis > Set Graph Appearance. 
Откроется диалоговое окно Graph Appearance и будет показана вкладка 
General.

Вкладка General содержит сведения о диаграмме, доступные только для 
чтения.

 2 Чтобы изменить заголовки диаграммы, оси Y или оси Х, выберите вкладку 
Titles. Чтобы изменить шрифт, размер, формат или цвет заголовка, 
нажмите кнопку Font. Чтобы вернуть первоначальные заголовки, нажмите 
кнопку Reset Titles.

 3 Перейдите на вкладку Appearance, чтобы изменить цвет различных 
компонентов диаграммы, ориентацию надписей в основании диаграммы 
или отобразить диаграмму с объемным эффектом.
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 4 Для гистограммы перейдите на вкладку Bar Parameters и укажите, 
необходимо ли отображать значение для каждого столбца. Также можно 
установить фиксированную ширину столбца. Если включено отображение 
значений для каждого столбца, можно изменять данные столбцов или их 
положение относительно столбцов. 

Для линейного графика перейдите на вкладку Line Parameters и укажите, 
должна ли отображаться рамка линии, а также формат даты для оси Х.
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45
Создание документов проекта

Quality Center Приложение Document Generator позволяет создавать 
документы Microsoft Word, включающие требования, сведения о 
планировании, списки тестов, папки наборов тестов, а также данные об 
отслеживании дефектов.

Примечания. 

➤ Для запуска приложения Document Generator необходимо разрешить 
выполнение макросов в Microsoft Word. Если при использовании 
приложения Document Generator выдается предупреждение системы 
безопасности, необходимо установить средний или низкий уровень 
безопасности в Microsoft Word. Для этого в меню Word выберите 
команду Сервис > Макросы > Безопасность. На вкладке «Уровень 
безопасности» выберите необходимый уровень защиты (средний или 
низкий) и нажмите кнопку ОК.

➤ Сведения о поддерживаемых версиях Microsoft Word см. в документе 
Руководство по установке HP Quality Center.

Эта глава содержит следующие разделы.

 ➤  Об использовании Document Generator на стр. 714

 ➤  Запуск Document Generator на стр. 716

 ➤  Установка инструкций по форматированию на стр. 717

 ➤  Указание данных проекта на стр. 723

 ➤  Создание документа проекта на стр. 750
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Об использовании Document Generator
Document Generator позволяет создавать документальные копии данных, 
содержащихся в проекте Quality Center. Процесс создания документа 
включает следующие задачи.

 1 Определение формата документа.

 2 Определение содержимого документа.

 3 Создание и правка документа.

Вначале устанавливаются инструкции по форматированию для 
определения внешнего вида проектного документа. Например, можно 
напечатать логотип компании на каждой странице документа, создать 
содержание и указатель, а также добавить скрипты тестов и вложения в 
документ.

Затем необходимо указать данные проекта, которые будет содержать 
документ. Можно выбирать информацию из модулей Quality Center. 
Например, в модуле Test Plan можно выбрать папки и тесты дерева плана 
тестирования для включения в документ, отсортировать эти данные в 
алфавитном порядке или в порядке, определенном пользователем, и 
отобразить эти данные в виде списков или таблиц. 

После разработки инструкций по форматированию и указания содержимого 
документа можно сохранить его параметры как избранное представление 
для последующего использования и создать документ. После того, как 
будет завершено создание документа, его можно просматривать и 
редактировать в приложении Microsoft Word. Сведения из каждого 
выбранного модуля печатаются в отдельной главе документа проекта. 
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Ниже приведен пример страницы документа Microsoft Word, созданной с 
помощью Document Generator. 
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Запуск Document Generator
Чтобы запустить Document Generator, нажмите кнопку Tools в левом 
верхнем углу окна Quality Center. Выберите команду Document Generator. 
Откроется окно Document Generator. 
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Установка инструкций по форматированию
Перед созданием документа необходимо установить инструкции по 
форматированию, определяющие вид документа и содержание титульного 
листа.

Чтобы установить инструкции по форматированию, выполните 
следующие действия.

 1 Откройте окно Document Generator. По умолчанию в дереве Document 
Generator выбрана ссылка Document и отображается вкладка Document 
Settings.

 2 Введите название документа в поле Title сведения об авторе в поле 
Author и описание документа в поле Description.
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 3 Перейдите на вкладку Options. 

 4 В разделе Include with Document можно выбрать следующие элементы, 
определяющие содержимое документа проекта.

Элемент Описание

First page Титульный лист проектного документа. Титульный лист 
содержит название документа, дату создания документа 
и имя пользователя, создавшего документ. Эти сведения 
указываются на вкладке Document Settings

Оглавление Список всех разделов документа проекта.

Указатель Список всех сведений документа проекта в алфавитном 
порядке. Указатель размещается в конце документа.
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 5 В разделе Attachment Placement Options выберите, в какой раздел 
документа следует поместить вложения. 

 6 В разделе Attachment Embedding Options выберите способ помещения 
вложений в документ: в виде значка со ссылкой или в виде встроенного 
текста.

 7 В разделе Test Script Options выберите место размещения скриптов в 
документе.

 8 В разделе Graph Options выберите место в документе для размещения 
диаграмм.

Вариант Описание

In text Вложения будут помещены в основной текст документа.

In appendix Вложения будут помещены в отдельное приложение.

Вариант Описание

As icons В документ будет помещена ссылка на вложение в виде 
значка.

As expanded text Вложение будет помещено в документ в виде 
развернутого текста.

Вариант Описание

In text Скрипты тестов будут помещены в основной текст 
документа.

In appendix Скрипты тестов будут помещены в отдельное 
приложение.

Вариант Описание

In text Диаграммы будут помещены в основной текст документа.

In appendix Диаграммы будут помещены в отдельное приложение.
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 9 Установите флажок Do not generate a paragraph if there is no 
corresponding project information, чтобы не включать пустые поля данных 
в документ проекта.

 10 Чтобы установить изображение, которое будет размещаться вверху каждой 
страницы документа проекта, перейдите на вкладку Logo.

Для документа проекта можно выбрать логотип и сохранить изображение, 
чтобы оно было доступно другим пользователям данного проекта. Если 
изображение не выбрано, Document Generator будет использовать в 
документе проекта логотип HP.

 11 Нажмите кнопку Load from File. Откроется диалоговое окно Open. 

 12 Найдите изображение и нажмите кнопку Open. Изображение будет 
показано на вкладке Logo. Чтобы выгрузить изображение, нажмите кнопку 
Unload.

 13 Чтобы сохранить показанное изображение в текущем проекте, нажмите 
кнопку Save. Чтобы удалить изображение, нажмите кнопку Remove Saved. 
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 14 Чтобы загрузить сохраненное изображение, которое было очищено (с 
использованием кнопки Unload), нажмите кнопку Load from Saved.

 15 Чтобы установить параметры страницы, перейдите на вкладку 
Customization и нажмите кнопку Page Setup.
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Откроется диалоговое окно Page Setup.

 16 Установите единицы измерения, поля, ориентацию и размер страницы для 
документов проекта Нажмите кнопку OK, чтобы вернуться на вкладку 
Customization.
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Указание данных проекта 
Установите флажки в дереве Document Generator, чтобы указать, какие 
данные проекта следует включить в документ.

Флажок Описание

Document Используйте вкладки Document Settings, Options, Logo и 
Customization, чтобы указать инструкции для 
форматирования. Дополнительные сведения см. в 
разделе “Установка инструкций по форматированию" на 
стр. 717. Обратите внимание, что этот флажок 
установлен всегда.

Requirements Укажите, какие требования, отслеживаемые требования, 
покрытие тестами и связанные дефекты следует 
включить из модуля Requirements. Дополнительные 
сведения см. в разделе “Указание данных модуля 
Requirements" на стр. 725.

Business 
Components

Если используется приложение HP Business Process 
Testing, см. HP Business Process Testing User Guide.
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Test Plan Разверните этот узел, чтобы указать папки объектов и 
тесты для включения из модуля Test Plan. 
Дополнительные сведения см. в разделах “Указание 
данных модуля Test Plan из представления дерева плана 
тестирования" на стр. 728 и “Указание данных модуля 
Test Plan из представления таблицы тестов" на стр. 733.

Выберите узел Subject Tree, чтобы указать папки 
объектов для включения из модуля Test Plan.

Выберите узел Subject Tests, чтобы указать тесты для 
включения из выбранных папок.

Выберите узел Test List, чтобы указать тесты для 
включения из таблицы тестов.

Test Lab Укажите папки наборов тестов для включения из модуля 
Test Lab. Разверните узел, чтобы выбрать наборы 
тестов, тесты и выполнения тестов. Дополнительные 
сведения см. в разделе “Указание данных модуля Test 
Lab" на стр. 738.

Выберите узел Test Sets, чтобы указать наборы тестов 
для включения.

Выберите узел Tests, чтобы указать тесты для 
включения из выбранных наборов тестов.

Выберите узел Runs, чтобы указать выполнения тестов 
для включения из выбранных тестов в наборе тестов.

Defects Укажите дефекты для включения из модуля Defects. 
Дополнительные сведения см. в разделе “Указание 
данных модуля Defects" на стр. 748.

Флажок Описание
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Указание данных модуля Requirements
На странице Requirements можно указать, какие сведения о требованиях из 
модуля Requirements следует включить в раздел Requirements документа 
проекта.

Примечание. Microsoft Word создает не более девяти уровней заголовков в 
содержании. Если дерево требований содержит более девяти уровней 
иерархии, эти уровни не будут показаны в содержании созданного 
документа проекта.

Чтобы указать данные модуля Requirements, выполните следующие 
действия.

 1 Установите флажок Requirements в дереве Document Generator и 
щелкните ссылку Requirements. Будет показана страница Requirements.



Глава 45 • Создание документов проекта

726

 2 В разделе Requirements выберите один из следующих вариантов.

 3 В разделе Requirements Layout выберите один из следующих вариантов.

Вариант Описание

All Добавление всех требований из дерева требований.

By status Добавление только требований с выбранным статусом.

Selected Добавление только выбранных требований. Чтобы 
включить дочерние требования, установите флажок First 
Selected with Children. 

Нажмите кнопку Filter & Sort, чтобы указать критерии 
выбора требований. Дополнительные сведения об 
использовании диалогового окна Filter см. в Глава 3, 
"Работа с данными Quality Center"..

Вариант Описание

Full page Список выбранных требований. Нажмите кнопку 
Customize, чтобы выбрать информацию для включения в 
документ.

Tabular Отображение требований в виде таблицы. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки параметров таблицы. В 
диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.

Coverage Analysis Графическое представление распределения статуса 
прямого покрытия для каждого требования. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Coverage Analysis и выбрать вид отображения анализа 
(черно-белый или цветной), количество отображаемых 
уровней иерархии, а также необходимость отображения 
условных обозначений.
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 4 Если в разделе Requirements Layout выбран вариант Full page, можно 
указать следующие параметры.

Параметр Описание

Page break after 
each requirement

Вставка разрыва страниц в документ проекта после 
каждого требования.

Rich text Включение содержимого Microsoft Word для каждого 
требования.

Trace from Добавление в документ требований, от которых 
выполняется прослеживание. Нажмите кнопку 
Customize, чтобы открыть диалоговое окно Tabular 
Layout для настройки таблицы прослеживаемости. В 
диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.

Trace to Включение в документ требований, к которым 
выполняется прослеживание. Нажмите кнопку 
Customize, чтобы открыть диалоговое окно Tabular 
Layout для настройки таблицы прослеживаемости. В 
диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.

Coverage Добавление в документ покрытия требований тестами. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы 
покрытия. В диалоговом окне Tabular Layout выберите 
столбцы таблицы, укажите порядок их расположения, 
ширину и заголовки.
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 5 Чтобы добавить в документ проекта диаграммы, установите флажок 
Graphs, а затем выберите нужные диаграммы из списка диаграмм в 
нижней части страницы. Список содержит только диаграммы, которые 
сохранены как избранные. Дополнительные сведения об избранных 
представлениях см. в Глава 6, "Работа с избранными представлениями"..

Указание данных модуля Test Plan из представления 
дерева плана тестирования
Страницы Subject Tree и Subject Tests используются, чтобы указать, какие 
сведения из представления дерева плана тестирования модуля Test Plan 
следует включить в документ проекта.

Примечание. Microsoft Word создает не более девяти уровней заголовков в 
содержании. Если дерево плана тестирования содержит более девяти 
уровней иерархии, эти уровни не будут показаны в содержании созданного 
документа проекта.

Attachments Добавление в документ вложений требований. Вложения 
требования — это файлы, связанные с требованием, 
например текстовые файлы, изображения или URL-
адреса.

Linked defects Включение в документ связанных дефектов. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки таблицы связанных 
дефектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы дефектов в таблице, указать 
порядок столбцов, их ширину и заголовки. Также можно 
указать отображение только дефектов, напрямую 
связанных с требованиями, или отображение также и 
косвенно связанных дефектов.

Параметр Описание
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Чтобы указать данные из представления дерева плана тестирования 
модуля Test Plan, выполните следующие действия.

 1 Разверните узел Test Plan в дереве Document Generator. Установите 
флажок Subject Tree и щелкните ссылку Subject Tree. Будет показана 
страница Subject Tree.
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 2 В разделе Tree Sort определите порядок расположения информации о 
дереве плана тестирования в документе.

 3 В разделе Folders укажите, какие папки из дерева плана тестирования 
необходимо включить в документ.

 4 Чтобы добавить в документ вложения папок, установите флажок 
Attachments. Вложения папок представляют собой файлы, связанные с 
папкой, например текстовые файлы, изображения или URL-адреса.

Вариант Описание

Alphabetical Содержимое папок будет упорядочено в документе в 
алфавитном порядке. Предположим, что в дереве плана 
тестирования две папки: Automated Tests и Manual Tests. 
Тесты в папке Automated Tests будут напечатаны перед 
тестами в папке Manual Tests.

Custom Содержимое папок будет упорядочено в соответствии с 
порядком сортировки, установленным пользователем 
для отображения папок в дереве плана тестирования. По 
умолчанию папки объектов в дереве плана тестирования 
указываются в алфавитном порядке (по имени). 
Предположим, что в дереве плана тестирования две 
папки: Automated Tests и Manual Tests. Можно создать 
порядок сортировки для печати тестов из папки Manual 
Tests перед тестами из папки Automated Tests. 
Дополнительные сведения о создании 
пользовательского порядка сортировки для дерева плана 
тестирования см. в Глава 18, "Создание дерева плана 
тестирования"..

Вариант Описание

All Будут включены все папки из дерева плана 
тестирования.

Selected Будут включены только выбранные папки из дерева 
плана тестирования. Для выбора папок используется 
дерево плана тестирования, показанное в правой части 
страницы Subject Tree.
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 5 Чтобы вставить разрыв страницы после каждой папки объектов, 
установите флажок Page break after each folder.

 6 Чтобы включить в документ диаграммы, установите флажок Graphs и 
выберите нужные диаграммы из списка. В список будут включены только 
диаграммы, сохраненные как избранные. Дополнительные сведения об 
избранных представлениях см. в Глава 6, "Работа с избранными 
представлениями"..

 7 Чтобы включить в документ проекта данные тестов, разверните узел 
Subject Tree в дереве Document Generator. Установите флажок Subject 
Tests и щелкните ссылку Subject Tests. Будет показана страница Subject 
Tests.
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 8 В разделе Tests укажите, какие тесты необходимо включить в документ.

 9 Чтобы добавить в документ шаги теста из теста, установите флажок 
Design steps.

В разделе Layout укажите способ упорядочивания шагов теста.

В разделе Properties укажите элементы, которые необходимо включить 
для шагов тестов.

 10 Чтобы добавить в документ скрипты тестов, установите флажок Test 
scripts.

Вариант Описание

All tests Добавление всех тестов из выбранных папок дерева 
плана тестирования.

Selected Добавление только выбранных тестов. Нажмите кнопку 
Filter & Sort, чтобы указать критерии для выбора тестов. 
Дополнительные сведения об использовании 
диалогового окна Filter см. в Глава 3, "Работа с данными 
Quality Center"..

Вариант Описание

Full page Отображение списка всех шагов теста в тесте. Нажмите 
кнопку Customize, чтобы выбрать информацию для 
включения в документ.

Tabular Отображение списка всех шагов теста в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
В диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.

Вариант Описание

Recursive Добавление тестов, вызываемых из шагов теста.

Attachments Добавление всех вложений шагов теста.
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 11 Если используется приложение Business Process Testing, можно добавлять 
компоновку компонентов, входящих в тесты. Установите флажок 
Components detailed layout и выберите элементы для включения в 
подробную компоновку.

➤ Чтобы добавить шаги компонентов, установите флажок Component 
steps. Нажмите кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки параметров таблицы шагов компонентов. 
Используйте диалоговое окно Tabular Layout, чтобы выбрать столбцы 
дефектов в таблице, указать порядок столбцов, их ширину и заголовки. 

➤ Чтобы включить список итераций, установите флажок Iterations list.

 12 Чтобы включить в документ вложения тестов, установите флажок 
Attachments.

 13 Чтобы отобразить список всех изменений тестов, а также авторов каждого 
изменения, установите флажок History.

 14 Чтобы вставить разрыв страницы в документ проекта после каждого теста, 
установите флажок Page break after each test.

 15 Чтобы включить таблицу связанных дефектов, установите флажок Linked 
defects. Нажмите кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки таблицы связанных дефектов. Используйте 
диалоговое окно Tabular Layout, чтобы выбрать столбцы дефектов в 
таблице, указать порядок столбцов, их ширину и заголовки. Также можно 
указать отображение только дефектов, непосредственно связанных с 
тестами, или отображение также и косвенно связанных дефектов.

Указание данных модуля Test Plan из представления 
таблицы тестов
Страница Test List используется для указания тестов из таблицы тестов, 
которые должны быть включены в документ проекта. Дополнительные 
сведения о таблице тестов см. в Глава 3, "Работа с данными Quality Center".
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Чтобы указать данные модуля Test Plan из представления таблицы 
тестов, выполните следующие действия.

 1 Разверните узел Test Plan в дереве Document Generator. Установите 
флажок Test List и щелкните ссылку Test List. Будет показана страница 
Test List.

 2 В разделе Tests укажите, какие тесты необходимо включить в документ.

Вариант Описание

All tests Добавление в документ всех тестов из таблицы тестов.

Selected Добавление только выбранных тестов. Нажмите кнопку 
Filter & Sort, чтобы указать критерии для выбора тестов. 
Дополнительные сведения об использовании 
диалогового окна Filter см. в Глава 3, "Работа с данными 
Quality Center"..
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 3 В разделе Test Layout укажите способ упорядочивания тестов.

 4 Чтобы вставить разрыв страницы в документ проекта после каждого теста, 
установите флажок Page break after each test.

 5 Если в разделе Test Layout выбран вариант Full page, можно установить 
флажок Design steps для включения шагов теста.

В разделе Layout укажите способ упорядочивания шагов теста.

Вариант Описание

Full page Отображение списка всех тестов проекта. Нажмите 
кнопку Customize, чтобы выбрать информацию для 
включения в документ.

Tabular Отображение всех тестов в виде таблицы. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки параметров таблицы. В 
диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.

Вариант Описание

Full page Отображение списка всех шагов теста в тесте. Нажмите 
кнопку Customize, чтобы выбрать информацию для 
включения в документ.

Tabular Отображение списка всех шагов теста в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
В диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.
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В разделе Properties укажите элементы, которые необходимо включить 
для шагов тестов.

Вариант Описание

Recursive Добавление тестов, вызываемых из шагов теста.

Attachments Добавление всех вложений шагов теста.
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 6 Если в разделе Test Layout выбран вариант Full page, можно также указать 
следующие параметры.

 7 Чтобы включить в документ диаграммы, установите флажок Graphs и 
выберите диаграммы из списка диаграмм в нижней части страницы. В 
список будут включены только диаграммы, сохраненные как избранные. 
Дополнительные сведения об избранных представлениях см. в Глава 6, 
"Работа с избранными представлениями"..

Вариант Описание

Test scripts Добавление скриптов тестов в документ.

Components 
detailed layout

Если используется приложение HP Business Process 
Testing, можно добавить подробную компоновку 
компонентов, включенных в тесты. Выберите элементы, 
которые необходимо включить в подробную компоновку.

Component steps. Добавление шагов компонентов. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы 
шагов компонентов. Используйте диалоговое окно 
Tabular Layout, чтобы выбрать столбцы дефектов в 
таблице, указать порядок столбцов, их ширину и 
заголовки. 

Iterations list. Включение списка итераций.

Attachments Добавление в документ вложений к выполнениям тестов.

Linked defects Добавление таблицы связанных дефектов. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки таблицы связанных 
дефектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы дефектов в таблице, указать 
порядок столбцов, их ширину и заголовки. Также можно 
указать отображение только дефектов, непосредственно 
связанных с тестами, или отображение также и косвенно 
связанных дефектов.

History Отображение списка всех изменений тестов, а также 
авторов этих изменений.
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Указание данных модуля Test Lab
Страницы Test Lab, Test Sets, Tests и Runs используются для указания 
информации из модуля Test Lab, которая должна быть включена в 
документ проекта.

Примечание. Microsoft Word создает не более девяти уровней заголовков в 
содержании. Если дерево наборов тестов содержит более девяти уровней 
иерархии, эти уровни не будут указаны в содержании созданного 
документа проекта.

Чтобы указать данные модуля Test Lab, выполните следующие 
действия.

 1 Установите флажок Test Lab  в дереве Document Generator и щелкните 
ссылку Test Lab. Будет показана страница Test Lab.
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 2 В разделе Folders укажите, какие папки модуля Test Lab необходимо 
включить в документ.

 3 Чтобы включить в документ вложения наборов тестов, установите флажок 
Attachments.

 4 Чтобы вставить разрыв страницы в документ проекта после каждой папки с 
наборами тестов, установите флажок Page break after each test sets 
folder.

 5 Чтобы включить в документ диаграммы, установите флажок Graphs и 
выберите диаграммы из списка диаграмм в нижней части страницы. В 
список будут включены только диаграммы, сохраненные как избранные. 
Дополнительные сведения об избранных представлениях см. в Глава 6, 
"Работа с избранными представлениями"..

Вариант Описание

All Добавление всех папок дерева наборов тестов.

Selected Добавление только выбранных папок дерева наборов 
тестов. Для выбора папок используется дерево наборов 
тестов, показанное в разделе Folders.



Глава 45 • Создание документов проекта

740

 6 Разверните узел Test Lab в дереве Document Generator.

Чтобы включить данные наборов тестов в документ проекта, установите 
флажок Test Sets и щелкните ссылку Test Sets в дереве Document 
Generator. Будет показана страница Test Sets.

 7 В разделе Available Test Sets укажите, какие наборы тестов необходимо 
включить в документ.

Вариант Описание

All Добавление всех наборов тестов из выбранной папки 
наборов тестов.

Selected Добавление только выбранных наборов тестов. Нажмите 
кнопку Filter & Sort, чтобы указать критерии выбора 
наборов тестов. Дополнительные сведения об 
использовании диалогового окна Filter см. в Глава 3, 
"Работа с данными Quality Center"..
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 8 Чтобы добавить связанные дефекты, установите флажок Linked defects. 
Нажмите кнопку Customize, чтобы настроить связанные дефекты. 
Используйте диалоговое окно Tabular Layout, чтобы выбрать столбцы 
дефектов в таблице, указать порядок столбцов, их ширину и заголовки. 
Также можно указать отображение только дефектов, напрямую связанных 
с наборами тестов, или включить также и отображение косвенно связанных 
дефектов.

 9 Чтобы вставить в документ проекта разрыв страницы после каждого 
набора тестов, установите флажок Page break after each test set.

 10 Чтобы включить в документ диаграммы, установите флажок Graphs и 
выберите диаграммы из списка. В список будут включены только 
диаграммы, сохраненные как избранные. Дополнительные сведения об 
избранных представлениях см. в Глава 6, "Работа с избранными 
представлениями"..

 11 Разверните узел Tests Sets в дереве Document Generator.
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Чтобы включить данные тестов в документ проекта, установите флажок 
Tests и щелкните ссылку Tests. Будет показана страница Test Page.

 12 В разделе Tests укажите, какие тесты необходимо включить в документ.

Вариант Описание

All tests Добавление в документ всех тестов из выбранного 
набора тестов.

Selected Добавление только выбранных тестов. Нажмите кнопку 
Filter & Sort, чтобы указать критерии для выбора тестов. 
Дополнительные сведения об использовании 
диалогового окна Filter см. в Глава 3, "Работа с данными 
Quality Center"..
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 13 В разделе Test Layout укажите способ упорядочивания тестов.

 14 Если в разделе Test Layout выбран вариант Full page, можно также указать 
следующие параметры.

Вариант Описание

Full page Отображение информации тестов в виде списка. 
Нажмите кнопку Customize, чтобы выбрать информацию 
для включения в документ.

Tabular Отображение информации тестов в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
В диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.

Примечание. В случае выбора варианта Tabular в 
документ будет невозможно включить выполнения 
тестов.

Вариант Описание

Test scripts Добавление скриптов тестов в документ.

Components 
detailed layout

Если используется приложение HP Business Process 
Testing, можно добавить подробную компоновку 
компонентов, включенных в тесты. Выберите элементы, 
которые необходимо включить в подробную компоновку.

Component steps. Добавление шагов компонентов. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы 
шагов компонентов. Используйте диалоговое окно 
Tabular Layout, чтобы выбрать столбцы дефектов в 
таблице, указать порядок столбцов, их ширину и 
заголовки.

Iterations list. Включение списка итераций.

Attachments Добавление в документ вложений к выполнениям тестов.
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 15 Чтобы добавить данные о выполнении теста в документ проекта, 
разверните узел Tests в дереве Document Generator. Установите флажок 
Runs и щелкните ссылку Runs. Будет показана страница Runs. 

Linked defects Добавление связанных дефектов в виде таблицы. 
Нажмите кнопку Customize, чтобы настроить таблицу 
связанных дефектов. Используйте диалоговое окно 
Tabular Layout, чтобы выбрать столбцы дефектов в 
таблице, указать порядок столбцов, их ширину и 
заголовки. Также можно указать отображение только 
дефектов, непосредственно связанных с тестами, или 
отображение также и косвенно связанных дефектов.

History Отображение списка всех изменений тестов, а также 
авторов этих изменений.

Page break after 
each test

Вставка разрыва страницы в документ проекта после 
каждого теста.

Вариант Описание
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 16 В разделе Runs выберите один из следующих параметров.

 17 В разделе Run Layout выберите один из следующих параметров.

 18 Если в разделе Run Layout выбран вариант Full page, можно установить 
флажок Run steps, чтобы включить в документ список шагов выполнения.

Вариант Описание

Last run Добавление только последнего выполнения теста.

All runs Добавление всех выполнений теста. 

Selected Добавление в документ только выбранных выполнений 
теста. Нажмите кнопку Filter & Sort, чтобы указать 
критерии для выбора тестов. Дополнительные сведения 
об использовании диалогового окна Filter см. в Глава 3, 
"Работа с данными Quality Center"..

Вариант Описание

Full page Отображение списка всех выполнений теста. Нажмите 
кнопку Customize, чтобы выбрать информацию для 
включения в документ.

Tabular Отображение всех выполнений теста в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
В диалоговом окне Tabular Layout выберите столбцы 
таблицы, укажите порядок их расположения, ширину и 
заголовки.
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Если в документ включаются шаги выполнения, выберите один из 
следующих вариантов в разделе Layout.

Также можно установить флажок Defects, чтобы включить в документ 
таблицу дефектов, связанных с шагами выполнения. Нажмите кнопку 
Customize, чтобы открыть диалоговое окно Tabular Layout для настройки 
таблицы связанных дефектов. Используйте диалоговое окно Tabular 
Layout, чтобы выбрать столбцы дефектов в таблице, указать порядок 
столбцов, их ширину и заголовки. Также можно указать отображение 
только дефектов, напрямую связанных с шагами выполнения, или 
включить также и отображение косвенно связанных дефектов.

Если в документ включаются шаги выполнения, можно установить флажок 
Attachments, чтобы добавить в документ вложения шагов выполнения.

Вариант Описание

Full page Отображение списка всех шагов выполнения. Нажмите 
кнопку Customize, чтобы выбрать информацию для 
включения в документ.

Tabular Отображает списка всех шагов выполнения в виде 
таблицы. Нажмите кнопку Customize, чтобы открыть 
диалоговое окно Tabular Layout для настройки 
параметров таблицы. В диалоговом окне Tabular Layout 
выберите столбцы таблицы, укажите порядок их 
расположения, ширину и заголовки.
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 19 Если в разделе Run Layout выбран вариант Full page, можно установить 
следующие параметры.

Вариант Описание

Linked defects Добавление таблицы дефектов, связанных с 
выполнениями теста. Нажмите кнопку Customize, чтобы 
открыть диалоговое окно Tabular Layout для настройки 
таблицы связанных дефектов. Используйте диалоговое 
окно Tabular Layout, чтобы выбрать столбцы дефектов в 
таблице, указать порядок столбцов, их ширину и 
заголовки. Также можно указать отображение только 
дефектов, напрямую связанных с выполнениями теста, 
или включить также и отображение косвенно связанных 
дефектов.

Attachments Добавление в документ вложений к выполнениям тестов.
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Указание данных модуля Defects
Страница Defects используется для указания информации о дефектах из 
модуля Defects, которая должна быть включена в раздел Track Defects 
документа проекта.

Чтобы указать данные модуля Defects, выполните следующие 
действия.

 1 Чтобы включить данные о дефектах в документ проекта, установите 
флажок Defects и щелкните ссылку Defects в  дереве Document Generator. 
Будет показана страница Defects.
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 2 В разделе Defects выберите один из следующих параметров.

 3 В разделе Defects Layout выберите один из следующих параметров.

 4 Если в разделе Defects Layout выбран вариант Full page, можно указать 
следующие параметры.

Параметр Описание

All defects Добавление всех дефектов из таблицы дефектов.

Selected Добавление только выбранных дефектов. Нажмите 
кнопку Filter & Sort, чтобы указать критерии выбора 
дефектов. Дополнительные сведения об использовании 
диалогового окна Filter см. в Глава 3, "Работа с данными 
Quality Center"..

Параметр Описание

Full page Отображение всех выбранных дефектов в виде списка. 
Нажмите кнопку Customize, чтобы выбрать информацию 
для включения в документ.

Tabular Отображение всех выбранных дефектов в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
Используйте диалоговое окно Tabular Layout, чтобы 
выбрать столбцы, из которых будет состоять таблица, 
указать порядок расположения столбцов, их ширину и 
заголовки.

Параметры Описание

Attachments Добавление в документ вложений дефектов.

Linked defects Добавление связанных дефектов в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки таблицы связанных 
дефектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы дефектов в таблице, указать 
порядок столбцов, их ширину и заголовки. Также можно 
указать отображение только прямых ссылок.



Глава 45 • Создание документов проекта

750

 5 Чтобы включить в документ диаграммы, установите флажок Graphs и 
выберите нужные диаграммы из списка. В список будут включены только 
диаграммы, сохраненные как избранные. Дополнительные сведения об 
избранных представлениях см. в Глава 6, "Работа с избранными 
представлениями"..

Создание документа проекта
После установки инструкций по форматированию и указания данных 
проекта можно создать документ проекта. Документ сохраняется в виде 
файла Microsoft Word.

Совет. Можно создавать документ проекта без включения в него 
подробных сведений для предварительного просмотра, что позволит 
быстро оценить вид документа. Чтобы создать документ проекта для 
предварительного просмотра, нажмите кнопку Preview. Quality Center 
откроет приложение Microsoft Word и отобразит документ проекта для 
предварительного просмотра.

Linked entities Добавление связанных объектов в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки таблицы связанных 
объектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы дефектов в таблице, указать 
порядок столбцов, их ширину и заголовки. Также можно 
изменять заголовки и ширину столбцов таблицы.

History Отображение списка всех изменений дефектов.

Page break after 
each defect

Вставка разрыва страницы в документ проекта после 
каждого дефекта.

Параметры Описание
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Чтобы создать документ проекта, выполните следующие действия.

 1 Если открыты файлы документов проекта, созданные во время 
предыдущих запусков приложения Document Generator, закройте эти 
файлы.

 2 Нажмите кнопку Full Document. Откроется диалоговое окно Save As.

 3 В поле Save As выберите папку для сохранения документа в сетевой 
файловой системе.

 4 В поле File name укажите имя документа.

 5 Нажмите кнопку Save. 

Quality Center начнет создание документа, а в диалоговом окне будет 
показан ход выполнения создания документа.Чтобы отменить создание 
документа, нажмите кнопку Stop.

По завершении процесса откроется приложение Microsoft Word с 
созданным документом.

Если созданный документ содержит ссылки на вложения, то в папке 
документа будет создана папка, в которую будут скопированы файлы 
вложений. В качестве имени папки с вложениями будет использовано имя 
документа с суффиксом "_Attachments". При отправке документа по 
электронной почте вместе с документом можно отправить папку с 
вложениями, чтобы получатель мог переходить к вложениям по ссылкам.
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A
Работа с VAPI-XP

Средство тестирования VAPI-XP на основе интерфейса API открытой 
архитектуры тестирования позволяет создавать новые или изменять 
существующие скрипты тестирования и интегрировать их в процесс 
управления приложением.

Эта глава содержит следующие разделы.

 ➤  О работе с VAPI-XP на стр. 756

 ➤  Создание скриптов тестирования VAPI-XP на стр. 756

 ➤  Изменение скриптов тестов VAPI-XP на стр. 766

 ➤  Использование интерфейса API VAPI-XP на стр. 771

 ➤  Выполнение тестов VAPI-XP в режиме отладки на стр. 776

 ➤  Выполнение тестов VAPI-XP в режиме тестирования на стр. 777

 ➤  Отладка скриптов тестов VAPI-XP на стр. 779
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О работе с VAPI-XP
Средство тестирования VAPI-XP позволяет создавать новые скрипты 
тестирования с использованием языков Microsoft VBScript, Microsoft 
JavaScript (версия JScript ), PerlScript и PythonScript, а также интегрировать 
эти скрипты в процесс управления приложением. С помощью скриптов 
тестов VAPI-XP можно тестировать серверы COM/DCOM, веб-службы на 
основе SOAP, API Java (такие, как классы Java и компоненты EJB), а также 
консольные приложения. Средство тестирования VAPI-XP также можно 
использовать для создания виртуального пользователя LoadRunner.

Кроме того, средство VAPI-XP полностью интегрировано с Quality Center, 
что позволяет разрабатывать скрипты тестов VAPI-XP для вызова любого 
теста или набора тестов Quality Center и выполнять эти тесты как часть 
собственного скрипта. Это позволяет построить более сложную схему 
выполнения набора тестов, в которой можно фильтровать тесты из набора 
тестов в процессе выполнения на основе статуса или типа каждого теста.

Средство VAPI-XP также полностью интегрировано с интерфейсом Open 
Test Architecture API Quality Center. Все классы и методы интерфейса API 
открытой архитектуры тестирования доступны для использования из 
пользовательского интерфейса средства VAPI-XP, что позволяет легко 
включать их в собственный скрипт тестирования. 

Создание скриптов тестирования VAPI-XP
Для создания скриптов тестов VAPI-XP используется дерево плана 
тестирования в модуле Test Plan.

Примечание. Также можно преобразовывать ручные тесты в тесты VAPI-
XP. На вкладке Design Steps нажмите кнопку Generate Script и выберите 
VAPI-XP-TEST. В Quality Center будет создан скрипт теста VAPI-XP, 
содержащий код для определенных ранее шагов. Этот скрипт также 
содержит код вызываемых тестов, которые входили в состав исходного 
ручного теста. Дополнительные сведения о ручных тестах см. в Глава 20, 
"Построение тестов"..
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Чтобы создать скрипт теста VAPI-XP, выполните следующие 
действия.

 1 Выберите папку объектов тестирования в дереве плана тестирования.

 2 Нажмите кнопку New Test или выберите команду Tests > New Test. 
Откроется диалоговое окно Create New Test.

 3 В поле Test Type выберите VAPI-XP-TEST.

 4 В поле Test Name введите имя теста. Учтите, что имя теста не должно 
содержать следующих символов: \ / : " ? < > | * % ‘

Нажмите кнопку ОК.

Примечание. Если обязательные поля теста были определены в окне 
Project Customization, откроется диалоговое окно Required Test Fields. 
Выберите значения обязательных полей и нажмите кнопку OK.
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Откроется мастер HP VAPI-XP.

 5 В поле Script Language выберите язык для создания скриптов. 

Примечания. 

➤ Для разработки скриптов тестов VAPI-XP на языке ActivePython или 
ActivePerl компании ActiveState необходимо установить эти языки на 
компьютере. В меню Help на вкладке Test Script выберите ActivePython 
Home Page или ActivePerl Home Page и следуйте инструкциям по 
установке.

➤ Обычно языки VBScript и JScript корпорации Майкрософт 
устанавливаются вместе с браузером Internet Explorer. Если они не 
установлены, выберите команду VBScript Home Page или JScript Home 
Page в меню Help на вкладке Test Script и следуйте инструкциям по 
установке.
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 6 В поле Script Name введите имя скрипта теста VAPI-XP.

 7 Если в качестве языка скрипта теста выбран язык VBScript или JavaScript, 
выберите Create HP LoadRunner Vuser, чтобы создать скрипт 
виртуального пользователя LoadRunner, который можно будет выполнять в 
контроллере LoadRunner Controller. 

Примечание. Чтобы выполнять этого виртуального пользователя в 
контроллере, необходимо установить последнюю версию надстройки 
HP Quality Center Connectivity на клиентском компьютере LoadRunner. 
Загрузить эту надстройку можно на странице надстроек HP Quality Center. 
Дополнительные сведения см. в документе Руководство по установке 
HP Quality Center.

 8 Чтобы продолжить создание скрипта теста с использованием мастера HP 
VAPI-XP, нажмите кнопку Next. Откроется следующее диалоговое окно.
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Примечание. Чтобы закрыть мастер и продолжить создание скрипта теста 
на вкладке Test Script, в любом окне можно нажать кнопку Finish.

 9 Выберите тип теста, который необходимо создать.

 10 Чтобы продолжить создание скрипта теста с использованием мастера HP 
VAPI-XP, нажмите кнопку Next. 

➤ Если был выбран тип COM/DCOM Server Test, выберите в реестре 
компьютера идентификаторы программ объектов COM/DCOM, которые 
необходимо тестировать, и нажмите кнопку +. Каждый выбранный 
объект COM/DCOM и его описание отобразятся в приведенном ниже 
окне.
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➤ Если был выбран тип Java Class Test, в поле Java Class Name введите 
полное имя класса Java, который необходимо тестировать, и нажмите 
кнопку +. Введенное имя класса Java отобразится в текстовом поле 
ниже.

Примечание. Можно использовать только классы Java с открытым 
конструктором без аргументов.

В разделе Java Virtual Machine выберите Other JVM, если не нужно 
использовать виртуальную машину Microsoft Java по умолчанию, и 
укажите следующие параметры. 

➤ JVM Runtime. Исполняемый файл среды выполнения виртуальной 
машины Java (обычно java.exe).

➤ Java Compiler. Исполняемый файл, который перекомпилирует 
байткод на платформе выполнения (обычно javac.exe).
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➤ Classpath. Перечень дополнительных (нестандартных) библиотек 
Java, разделенных точкой с запятой (;), необходимых для выполнения 
указанного приложения Java. Учтите, что если не указан путь к 
классам Java, Quality Center будет использовать переменную среды 
CLASSPATH.

➤ JVM Parameters. Параметры исполняемого файла среды выполнения 
виртуальной машины Java.

Если виртуальная машина Microsoft Java, необходимая для отладки 
пользовательских скриптов тестов, не установлена на компьютере, 
запустите файл msjavx86.exe, находящийся в каталоге Redist на DVD-
диске HP Quality Center.

Чтобы использовать другие виртуальные машины Java, установите 
пакет программного обеспечения Bean Scripting Framework (BSF) Java 
на клиентский компьютер. Распакуйте файл bsf-bin-22.zip, находящийся 
в каталоге Redist на DVD-диске HP Quality Center. В распакованном 
файле найдите файл bsf.jar и добавьте путь к нему в поле CLASSPATH. 
Убедитесь, что переменная среды CLASSPATH содержит точку (.), 
указывающую текущий каталог.

При работе с другими виртуальными машинами Java добавьте путь к 
библиотекам BSF в системный путь, как описано ниже. На панели 
управления выберите Система > Свойства системы, а затем 
перейдите на вкладку Дополнительно. Нажмите кнопку Переменные 
среды и в области Системные переменные измените параметр Путь, 
добавив в него путь к следующим библиотекам DLL: msvcp60.dll, 
bsfactivescriptengine.dll и bsfactivescriptengine_g.dll. Нажмите кнопку 
ОK.
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➤ Если был выбран тест Web Service (SOAP) Test, из списка SOAP Client 
Library выберите клиентскую библиотеку SOAP и в поле Web Service 
Definition введите или выберите URL-адрес , который необходимо 
тестировать. Нажмите кнопку +. Введенный URL-адрес отобразится в 
приведенном ниже текстовом поле.

Примечание. Поддерживаются две клиентские библиотеки SOAP: Microsoft 
SOAP SDK и PocketSOAP. Учтите, что при выборе работы с PocketSOAP 
для анализа веб-служб необходимо установить пакет Microsoft SOAP SDK. 
Если пакет Microsoft SOAP SDK еще не установлен на компьютере, 
запустите файл SoapToolkit30.exe, расположенный в каталоге Redist на 
DVD-диске HP Quality Center.
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➤ Если был выбран тип Console Application Test, в поле Application 
Executable File введите имя файла приложения, которое необходимо 
тестировать, а в поле Command Line Parameters — его параметры. 

Если нет необходимости заменять стандартный вывод окном вывода 
VAPI-XP, снимите флажок Use VAPI-XP Output instead of Standard 
Output.

В поле Application Timeout введите время в миллисекундах, в течение 
которого Quality Center будет ожидать завершения выполнения 
приложения. Учтите, что при установке времени ожидания равным -1 
Quality Center будет ожидать завершения выполнения приложения 
бесконечно.

Нажмите кнопку +. Введенные данные отобразятся в текстовом поле 
ниже.
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 11 Чтобы продолжить создание скрипта теста с использованием мастера HP 
VAPI-XP, нажмите кнопку Next. Откроется следующее диалоговое окно.

 12 В списке Service выберите функции, которые необходимо добавить в 
скрипт теста. Дважды щелкните мышью каждую функцию или перетащите 
ее, чтобы добавить функцию в код скрипта. Функция будет добавлена в 
поле под списком Service.

 13 Если необходимо, введите дополнительные параметры или добавьте 
дополнительный код в скрипт в нижней области окна.

 14 Нажмите кнопку Finish. Новый тест появится в дереве плана тестирования 
в выбранной папке объектов тестирования.

Примечание. К созданному тесту VAPI-XP можно добавить подробные 
сведения и вложения или определить покрытие требований тестами. 
Дополнительные сведения см. в Глава 18, "Создание дерева плана 
тестирования"..
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Изменение скриптов тестов VAPI-XP
После создания скрипта теста VAPI-XP с помощью мастера HP VAPI-XP 
скрипт можно изменять на вкладке Test Script.

Совет. Чтобы открыть вкладку Test Script в отдельном окне, выберите 
пункт меню View > Window Screen или нажмите кнопку Window Screen.

Чтобы изменить скрипт теста VAPI-XP, выполните следующие 
действия.

 1 В дереве плана тестирования выберите тест VAPI-XP и перейдите на 
вкладку Test Script. Отобразится скрипт теста.



Приложение A • Работа с VAPI-XP

767

Примечание. Для просмотра или изменения свойств созданного скрипта 
теста выберите пункт меню Test > Properties.

 2 Для просмотра списка определений, методов и свойств объектов, которые 
можно добавить в скрипт, выберите один из следующих вариантов.

➤ Test > References > COM Library References. Откроется диалоговое 
окно References, в котором можно выбрать определения, методы и 
свойства объекта СОМ для просмотра.

➤ Test > References > SOAP Web Service References. Откроется 
диалоговое окно Add Web Service Reference, в котором можно ввести 
определение или метод объекта веб-службы для просмотра. 

➤ Test > References > Java Class References. Откроется диалоговое окно 
Add Java Class Reference, в котором можно ввести определение или 
метод класса Java для просмотра.

 3 Выберите пункт меню View > Browsers или нажмите кнопку Show/Hide 
Browsers. Будут показаны следующие вкладки.

➤ Вкладка Library. Список определений, методов и свойств объектов 
VAPI-XP (SRunner), Quality Center (TDAPIOLELib) и COM/DCOM, которые 
можно добавить в скрипт. Описание определений, методов и свойств 
объектов VAPI-XP см. в разделе “Использование интерфейса API VAPI-
XP" на стр. 771. Описание определений, методов и свойств объектов 
Quality Center приведены в документе Open Test Architecture API 
Reference HP Quality Center.
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➤ Вкладка Soap. Список определений, методов и свойств объектов веб-
служб, которые можно добавить в скрипт. 

➤ Вкладка Java. Список определений, методов и свойств классов Java, 
которые можно добавить в скрипт. 

➤ Вкладка Function. Список функций в скрипте.

➤ Вкладка Object. Список объектов с определенными именами, которые 
можно добавить в скрипт..

Примечание. Чтобы просмотреть описание каждого определения, метода 
или свойства объекта, выберите пункт меню View > Output и перейдите на 
вкладку Help.

 4 Чтобы добавить определение, метод или свойство объекта в текущую 
функцию в скрипте, установите курсор в соответствующее место кода и 
дважды щелкните мышью определение, метод или свойство объекта на 
вкладке Library, Soap или Java. 
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 5 Чтобы добавить объект с определенным именем, выберите определение, 
метод или свойство объекта на вкладке Library, Soap или Java, а затем 
выберите пункт меню Test > Add Object. В диалоговом окне Add Object 
введите имя, которое необходимо присвоить объекту, и нажмите кнопку 
OK. Объект будет добавлен на вкладку Object.

Чтобы добавить объект в скрипт, дважды щелкните объект или щелкните 
объект правой кнопкой мыши и выберите команду Insert into Script.

 6 Чтобы проверить синтаксис кода, выберите пункт меню Test > Check 
Syntax или нажмите кнопку Syntax Check. Выберите пункт меню 
View > Output, чтобы просмотреть результаты проверки на вкладке 
Output.
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Дополнительные функции редактирования
На вкладке Test Script также доступны следующие функции 
редактирования.

➤ Чтобы отменить предыдущее действие, нажмите кнопку Undo. Чтобы 
восстановить действие, которое было отменено, нажмите кнопку Redo.

➤ Чтобы удалить фрагмент кода из одной части скрипта и вставить его в 
другую часть, выделите фрагмент кода и нажмите кнопки Cut и Paste. 

➤ Чтобы скопировать фрагмент кода из одной части скрипта и вставить его в 
другую часть, выделите фрагмент кода и нажмите кнопки Copy и Paste. 

➤ Чтобы удалить фрагмент кода, выделите фрагмент и нажмите кнопку 
Delete.

➤ Чтобы найти определенный текст в скрипте, нажмите кнопку Find in Script. 
В диалоговом окне Find Text введите текст, который необходимо найти. 
Выберите параметры, направление, область и начало поиска и нажмите 
кнопку OK. 

Чтобы найти следующее вхождение текста в скрипте, выберите команду 
Search > Find Next.

➤ Чтобы найти определенный текст в скрипте и заменить его другим текстом, 
нажмите кнопку Replace. В поле Text to find диалогового окна Find Text 
введите текст, который необходимо найти. В поле Replace with введите 
текст, которым следует заменить указанный текст. Выберите параметры, 
направление, область и начало поиска и нажмите кнопку OK. Чтобы 
заменить все вхождения указанного текста в скрипте, нажмите кнопку 
Replace All.

➤ Чтобы перейти к определенной строке в скрипте, выберите пункт 
Search > Go to Line Number. В диалоговом окне Go to Line Number введите 
номер строки, которую необходимо найти, и нажмите кнопку OK.

➤ Чтобы изменить такие параметры редактора, как поля, шрифты и цвета 
текста или фона, нажмите кнопку Editor. На вкладках Editor, Display и 
Colors настройте необходимые параметры и нажмите кнопку OK.

После завершения внесения изменений в скрипт нажмите кнопку Save, 
чтобы сохранить внесенные изменения.
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Использование интерфейса API VAPI-XP
Средство VAPI-XP содержит встроенную библиотеку определений 
объектов VAPI-XP, к которым можно обращаться во время создания 
скрипта теста.

Использование объекта TDHelper
Объект TDHelper предоставляет следующие функции, которые можно 
использовать для выполнения задач Quality Center.

RunTestSet
Функция выполняет выбранный набор тестов и возвращает общий статус 
выполнения набора тестов.

RunTestSet([Name = "default"], [Filter = ""], [Locally = FALSE], [Host = ""], 
[HostGroup = ""])

Name. Имя набора тестов. Необязательный параметр. По умолчанию = 
"default".

Filter. Фильтр тестов. Определяет, какие тесты следует выполнить. Если 
этот параметр не указан, дает указание Quality Center на выполнение всех 
тестов указанного набора. Необязательный параметр. По умолчанию = "".

Locally. При выборе значения TRUE дает указание Quality Center на 
локальное выполнение набора тестов. Необязательный параметр. По 
умолчанию = FALSE

Host. Узел, на котором будет выполняться набор тестов. Необязательный 
параметр. По умолчанию = "".

HostGroup. Группа узлов, в которой будет выполняться набор тестов. 
Необязательный параметр. По умолчанию = "".

RunTest
Выполняет выбранный тест и возвращает статус выполнения теста. 

RunTest(Name, Instance, TestSet, [Locally = FALSE], [Host = ""], [HostGroup = 
""])
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Name. Имя теста.

Instance. Экземпляр теста.

TestSet. Имя набора тестов.

Locally. При выборе значения TRUE дает указание Quality Center на 
локальное выполнение набора тестов. Необязательный параметр. По 
умолчанию = FALSE

Host. Узел, на котором будет выполняться набор тестов. Необязательный 
параметр. По умолчанию = "".

HostGroup. Группа узлов, в которой будет выполняться набор тестов. 
Необязательный параметр. По умолчанию = "".

AddDefect
Добавление нового дефекта в текущий тест, если тест выполняется в 
режиме отладки. Если тест выполняется в режиме тестирования, новый 
дефект добавляется в текущее выполнение экземпляра теста в текущем 
наборе тестов. Возвращает созданный объект дефекта.

AddDefect([Fields], [StepKey])

Fields. Двухмерный массив: первое измерение используется для имени 
поля, а второе — для значения поля. Необязательный параметр.

StepKey. Step ID for step related to new defect. Необязательный параметр.

AddDefectUI
Добавление нового дефекта в текущий тест (в режиме отладки) или 
текущее выполнение (в режиме тестирования) с помощью диалогового 
окна New Defect Quality Center.

AddDefectUI([StepKey])

StepKey. Идентификатор шага, связанного с новым дефектом. 
Необязательный параметр.
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AddStepToRun
Добавление нового шага к текущему выполнению. Возвращает созданный 
объект шага.

AddStepToRun(Name, [Desc], [Expected], [Actual], [Status])

Name. Имя шага.

Desc. Описание шага. Необязательный параметр.

Expected. Ожидаемый результат шага. Необязательный параметр.

Actual. Фактический результат шага. Необязательный параметр.

Status. Статус шага. Необязательный параметр.

DownLoadAttachment
Загрузка вложения, связанного с объектом теста. Возвращает локальный 
путь, по которому была выполнена загрузка.

DownLoadAttachment(Name, item)

Name. Имя вложения.

item. Ссылка на объект с вложением.

UpLoadAttachment
Отправка вложения и связывание его с объектом теста.

UpLoadAttachment(path, item)

path. Локальный путь (полное имя файла) элемента, подлежащего 
отправке.

item. Ссылка на объект, с которым следует связать вложение.

Использование объекта TDInput
Объект TDInput предоставляет следующую функцию, которую можно 
использовать для получения входного значения от конечного 
пользователя.
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GetInput
Отображение диалогового окна Input, с помощью которого можно получить 
входное значение от конечного пользователя.

GetInput([Caption],[Name])

Caption. Заголовок диалогового окна. Необязательный параметр.

Name. Имя входного значения. Необязательный параметр.

Использование объекта TDOutput
Объект TDOutput предоставляет следующие функции, которые можно 
использовать для управления вкладкой Output VAPI-XP.

Метод Clear
Очистка вкладки Output.

Clear

Метод Print
Печать текстового сообщения в новой строке на вкладке Output.

Print(Msg)

HookDebug, свойство
Установка или удаление обработчика функции API вкладки 
OutputDebugString.

HookDebug

Text, свойство
Получение или установка текста вкладки Output.

String Text
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Использование объекта XTools
Объект XTools предоставляет следующие функции, которые можно 
использовать для выполнения общих задач.

run
Выполнение командной строки с указанными параметрами.

run(Command, [Args = ""], [Timeout = -1], [UseOutput = TRUE])

Command. Исполняемый файл приложения.

Args. Аргументы приложения. Необязательный параметр. По умолчанию = 
"".

Timeout. Время ожидания в миллисекундах. При значении -1 Quality Center 
будет ожидать завершения выполнения приложения бесконечно.

UseOutput. При значении TRUE Quality Center заменяет стандартный поток 
вывода окном вывода VAPI-XP.

WrapArray
Создание массива значений переменного типа variant из массива объектов. 
Например, если вызванный объект возвращает в качестве результата 
метода массив строк, то ни один из поддерживаемых обработчиков 
скриптов не сможет прочитать такой массив. Вызвав функцию WrapArray и 
передав ей возвращенный массив в качестве параметра функции, можно 
получить массив значений типа variant, который может быть 
интерпретирован обработчиком скриптов.

WrapArray (array)

array. Массив, который необходимо преобразовать. 

Sleep
Приостановка выполнения скрипта на заданное время.

Sleep(interval)

interval. Время в миллисекундах, на которое приостанавливается 
выполнение скрипта .
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Выполнение тестов VAPI-XP в режиме отладки
После создания и изменения скрипта теста VAPI-XP его можно выполнить в 
режиме отладки или в режиме тестирования. Выполнение теста VAPI-XP в 
режиме отладки позволяет выполнить тест без включения его в набор 
тестов и без создания данных выполнения теста в проекте Quality Center. 
Как правило, рекомендуется использовать режим отладки при разработке 
теста, а режим тестирования — после завершения создания теста.

Чтобы выполнить тест VAPI-XP в режиме отладки, выполните 
следующие действия.

 1 В модуле Test Plan выберите тест VAPI-XP из дерева плана тестирования и 
перейдите на вкладку Test Script.

 2 Выберите пункт меню Test > Execute (Debug Mode) или нажмите кнопку 
Execute Script. Quality Center начнет выполнять выбранный скрипт теста.

 3 Для просмотра выходных данных, сформированных скриптом теста, 
выберите пункт меню View > Output.

➤ Чтобы очистить вкладку Output, нажмите кнопку Clear Output.

➤ Чтобы скопировать выведенный текст в буфер обмена, выделите текст 
и нажмите кнопку Copy Selected Text to Clipboard .

➤ Чтобы просмотреть текст вывода скрипта теста в браузере, нажмите 
кнопку Open Output Text in Web Browser.

➤ Чтобы напечатать тест вывода скрипта теста, нажмите кнопку Print 
Output.

 4 Чтобы остановить выполнение теста VAPI-XP до его завершения, 
выберите пункт меню Test > Stop или нажмите кнопку Stop.
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Выполнение тестов VAPI-XP в режиме тестирования
Выполнить тест VAPI-XP в режиме тестирования можно после добавления 
теста в набор в модуле Test Lab. Дополнительные сведения о добавлении 
тестов в наборы тестов см. в Глава 28, "Создание наборов тестов"..

Учтите, что при выполнении теста VAPI-XP в режиме тестирования данные 
выполнения теста создаются в проекте Quality Center.

Выполнить тест VAPI-XP в режиме тестирования можно из модуля Test 
Plan или из модуля Test Lab.

Примечание. Для удаленного выполнения тестов VAPI-XP на хосте, на 
котором будут выполняться тесты, необходимо установить надстройку 
HP Quality Center Client Side Setup Add-in и надстройку HP Quality Center 
Connectivity Add-in. Дополнительные сведения о надстройках 
HP Quality Center см. в документе Руководство по установке 
HP Quality Center.

Чтобы выполнить тест VAPI-XP в режиме тестирования из модуля 
Test Plan, выполните следующие действия.

 1 В дереве плана тестирования выберите тест VAPI-XP и откройте вкладку 
Test Script.

 2 Выберите пункт меню Test > Execute (Test Mode). Откроется диалоговое 
окно Select Test Set.
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 3 В поле Test Set выберите набор тестов, который содержит текущий тест 
VAPI-XP. 

 4 В поле Instance выберите экземпляр теста, который необходимо 
выполнить. 

 5 В поле Run Name введите имя, которое необходимо присвоить запуску 
теста. 

 6 Нажмите кнопку OK. Quality Center начнет выполнение выбранного теста.

 7 Чтобы просмотреть вывод скрипта теста, выберите пункт меню View > 
Output. Сведения о вкладке Output см. в разделе “Выполнение тестов VAPI-
XP в режиме отладки" на стр. 776.

 8 Чтобы остановить выполнение теста VAPI-XP до его завершения, 
выберите пункт меню Test >  Stop или нажмите кнопку Stop.

Чтобы выполнить тест VAPI-XP в режиме тестирования из модуля 
Test Lab, выполните следующие действия.

 1 В списке Test Sets выберите набор тестов, содержащий тест VAPI-XP, 
который необходимо выполнить.

 2 В таблице Execution Grid выберите тест, который необходимо выполнить, 
и нажмите кнопку Run. Откроется диалоговое окно Automatic Runner, в 
котором будет отображен выбранный тест.

 3 В столбце Run on Host выберите хост, на котором будет выполняться тест 
VAPI-XP, или установите флажок Run All Tests Locally, чтобы выполнить 
тест на локальном компьютере.
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 4 Нажмите кнопку Run. Когда Quality Center начнет выполнение выбранного 
теста VAPI-XP, откроется окно VAPI-XP Test Script. Когда Quality Center 
закончит выполнение теста, в диалоговом окне Automatic Runner будет 
показан статус выполнения теста.

Отладка скриптов тестов VAPI-XP
Если выполнение теста не было завершено успешно, можно использовать 
встроенный отладчик VAPI-XP, который поможет отладить скрипт теста 
VAPI-XP. 

Примечание. Встроенный отладчик не поддерживает отладку скриптов 
тестов PerlScript или PythonScript.

Чтобы отладить скрипт теста VAPI-XP, выполните следующие 
действия.

 1 На вкладке Test Script модуля Test Plan выберите Debug > Integrated 
Debugger. На панели инструментов будут показаны дополнительные 
кнопки управления процессом отладки.

 2 Для установки точки останова скрипта выберите строку в скрипте и 
выберите команду меню Debug > Toggle Breakpoint или нажмите кнопку 
Toggle Breakpoint. Также можно щелкнуть серое поле рядом со строкой 
скрипта. Выбранная строка будет выделена красным цветом.
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 3 Нажмите кнопку Execute Script. Quality Center начнет выполнение скрипта 
и остановится в заданной точке останова. На вкладке Output будет 
показано следующее сообщение. 

 4 Чтобы задать команду Quality Center на вход в скрипт после точки 
останова, выберите пункт меню Debug > Step Into или нажмите кнопку 
Step Into. Следующая за точкой останова строка скрипта будет выделена 
синим цветом.

 5 Чтобы задать команду Quality Center на пропуск строки скрипта, нажмите 
кнопку Step Over  или выберите пункт меню Debug > Step Over.
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 6 Чтобы задать команду Quality Center на выполнение скрипта, выберите 
пункт меню Debug > Step Out или нажмите кнопку Step Out. Вывод будет 
отображен на вкладке Output.

 7 Для просмотра или изменения значений переменных скрипта выберите 
пункт меню Debug > Variables или нажмите кнопку Show Variables. 
Откроется диалоговое окно Variables, в котором будут показаны 
переменные, доступные в текущем скрипте. Выберите переменную, чтобы 
просмотреть ее свойства.

Чтобы изменить значение переменной, введите новое значение, которое 
необходимо присвоить переменной, в поле Value и нажмите кнопку Update. 
Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно Variables.
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 8 Чтобы просмотреть сведения о конкретной переменной во время отладки, 
выберите пункт меню Debug > Watch или нажмите кнопку Show Watch 
Window, чтобы отобразить вкладку Watch. 

Чтобы добавить переменную на вкладку Watch, нажмите кнопку +, введите 
имя переменной в поле Prompt и нажмите кнопку OK. Переменная и ее 
значения будут отображаться на вкладке Watch.

 9 Чтобы задать команду Quality Center на возобновление выполнения 
скрипта, выберите пункт меню Debug > Resume Execution или нажмите 
кнопку Resume Execution.

 10 Выберите пункт меню Debug > Stop Debugging или нажмите кнопку Stop 
Debugging, чтобы остановить отладку скрипта встроенным отладчиком. 
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B
Сочетания клавиш Quality Center

Сочетания клавиш позволяют переходить в разные разделы Quality Center 
и выполнять многие команды Quality Center.

Эта глава содержит следующие разделы.

 ➤  Переключение модулей Quality Center на стр. 784

 ➤  Общие сочетания клавиш на стр. 784

 ➤  Сочетания клавиш в разделе Attachments на стр. 786

 ➤  Сочетания клавиш диалогового окна Send Email на стр. 787

 ➤  Сочетания клавиш модуля Management на стр. 787

 ➤  Сочетания клавиш модуля Requirements на стр. 788

 ➤  Сочетания клавиш модуля Test Plan на стр. 788

 ➤  Сочетания клавиш модуля Test Resources на стр. 789

 ➤  Сочетания клавиш модуля Test Lab на стр. 789

 ➤  Сочетания клавиш модуля Defects на стр. 791

 ➤  Сочетания клавиш модуля Dashboard на стр. 792
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Переключение модулей Quality Center
Для переключения модулей Quality Center можно использовать сочетания 
клавиш CTRL+SHIFT+<номер>. Номер представляет собой порядковый 
номер модуля, соответствующий порядку отображения модулей на боковой 
панели, начиная с 0. Например, если модуль Requirements является 
первым модулем, то для его выбора следует нажать CTRL+SHIFT+0. Если 
модуль Business Components является вторым модулем, нажмите 
CTRL+SHIFT+1.

Общие сочетания клавиш
Для перемещения по Quality Center и выполнения общих команд можно 
использовать следующие сочетания клавиш.

Сочетание клавиш Функция

СТРЕЛКА ВНИЗ или 
СТРЕЛКА ВВЕРХ

Выбор предыдущего или следующего элемента 
соответственно.

СТРЕЛКА ВЛЕВО 
или СТРЕЛКА 
ВПРАВО

В папках дерева: свертывание и развертывание папок 
соответственно.

В табличном представлении: выбор предыдущего или 
следующего столбца таблицы соответственно.

TAB Выбор следующего поля на вкладке или в диалоговом 
окне.

SHIFT+TAB Выбор предыдущего поля на вкладке или в диалоговом 
окне.

CTRL+SHIFT+ 
<порядковый 
номер>

Переключение представлений боковых панелей в 
диалоговых окнах Requirement Details, Defect Details и 
Test Instance Properties.

CTRL+TAB Перемещение вперед по вкладкам.

CTRL+SHIFT+TAB Перемещение назад по вкладкам.



Приложение B • Сочетания клавиш Quality Center

785

F9 или ALT Переключение к командам меню модуля. Для 
перемещения в меню используйте клавишиСТРЕЛКА 
ВЛЕВО, СТРЕЛКА ВПРАВО, СТРЕЛКА ВНИЗ,  и 
СТРЕЛКА ВВЕРХ.

ALT+СТРЕЛКА ВНИЗ Открытие раскрывающихся списков в полях со 
списками. Для выбора элемента списка используйте 
клавиши СТРЕЛКА ВНИЗ и СТРЕЛКА ВВЕРХ.

СТРЕЛКА ВЛЕВО Развертывание папки (если она свернута), содержащей 
вложенные папки в представлении дерева.

СТРЕЛКА ВПРАВО Свертывание папки (если она развернута), содержащей 
вложенные папки в представлении дерева.

ALT+G Переход к выбранному объекту.

ALT+HOME/END Отображение соответственно первого или последнего 
объекта диалогового окна Requirement Details, Defect 
Details или Test Instance Properties. 

ALT+СТРЕЛКА 
ВЛЕВО/СТРЕЛКА 
ВПРАВО

Отображение соответственно предыдущего или 
следующего объекта диалогового окна Requirement 
Details, Defect Details или Test Instance Properties. 

CTRL+F Открытие диалогового окна Find, с помощью которого 
можно найти необходимый текст. 

CTRL+C Копирование выбранного элемента в буфер обмена.

CTRL+V Вставка содержимого буфера обмена в выбранное 
место.

CTRL+X Удаление выбранного элемента с помещением в буфер 
обмена.

CTRL+Z Отмена последнего действия.

CTRL+A Выбор всех элементов.

F1 Отображение справки для выбранного диалогового 
окна.

F2 Переименование объекта.

Сочетание клавиш Функция
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Сочетания клавиш в разделе Attachments
С помощью соответствующих сочетаний клавиш на вкладке Attachments 
или в диалоговом окне Attachments можно выполнять следующие команды.

F5 Обновление всех данных в выбранном дереве, таблице 
или папке.

F7 Проверка правописания выделенного слова или текста.

SHIFT+F7, 
SHIFT+CTRL+F7

Открытие диалогового окна Thesaurus и отображение 
синонимов, антонимов и связанных слов для 
выделенного слова.

CTRL+SHIFT+T ИЛИ 
CTRL+T

Создание вкладки для полей MEMO.

Сочетание клавиш Функция

CTRL+F Вложение файла.

CTRL+W Вложение URL-адреса.

CTRL+P Вложение снимка.

CTRL+I Вложение сведений о системе.

CTRL+B Вложение содержимого буфера обмена.

ПРОБЕЛ Загрузка и открытие вложения.

CTRL+U Отправка вложения.

CTRL+S Сохранение вложения.

CTRL+DELETE Удаление вложения.

Сочетание клавиш Функция
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Сочетания клавиш диалогового окна Send Email
С помощью соответствующих сочетаний клавиш можно выполнить 
следующие команды диалогового окна Send Email.

Сочетания клавиш модуля Management
С помощью соответствующих сочетаний клавиш в модуле Management 
можно выполнять следующие команды.

Сочетание клавиш Функция

ALT+C ИЛИ ALT+T Открытие диалогового окна Select Recipients.

ALT+S Отправка сообщения электронной почты.

CTRL+ALT+O Открытие диалогового окна Spelling Options.

CTRL+ALT+T Открытие диалогового окна Thesaurus.

Сочетание клавиш Функция

ALT+B Добавление нового базового состояния.

ALT+M Импорт библиотеки.

CTRL+ALT+N Добавление новой папки библиотеки.

ALT+N Добавление новой библиотеки.

CTRL+N Создание новой папки релиза.

CTRL+R Создание нового релиза.

CTRL+Y Создание нового цикла.

CTRL+D Создание копии цикла.
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Сочетания клавиш модуля Requirements
С помощью соответствующих сочетаний клавиш в модуле Requirements 
можно выполнять следующие команды.

Сочетания клавиш модуля Test Plan
С помощью соответствующих сочетаний клавиш в модуле Test Plan можно 
выполнять следующие команды.

Сочетание клавиш Функция

CTRL+ALT+N Создание новой папки.

ALT+G Открытие диалогового окна Create New Requirement.

ALT+N Создание нового требования.

CTRL+I Увеличение.

CTRL+O Уменьшение на один уровень.

SHIFT+CTRL+O Уменьшение до уровня корневого элемента.

CTRL+A Добавление теста в покрытие.

CTRL+M Отправка требования по электронной почте (из 
диалогового окна Requirement Details).

Сочетание клавиш Функция

ALT+G Открытие диалогового окна Go To Test.

ALT+N Создание нового шага (на вкладке Design Steps).

CTRL+P Добавление параметра (на вкладке Design Steps).

SHIFT+ALT+A Добавление вложений (на вкладке Design Steps).

CTRL+L Добавление вызова теста, проводимого вручную 
(на вкладке Design Steps).

CTRL+S Сохранение шага (на вкладке Design Steps).
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Сочетания клавиш модуля Test Resources
С помощью соответствующих сочетаний клавиш в модуле Test Resources 
можно выполнять следующие команды.

Сочетания клавиш модуля Test Lab
С помощью соответствующих сочетаний клавиш в модуле Test Lab можно 
выполнять следующие команды.

ALT+N Создание нового параметра (на вкладке Test 
Parameters).

CTRL+DELETE Удаление параметра (на вкладке Test Parameters).

ALT+R Удаление требования из покрытия (на вкладке 
Req Coverage).

Сочетание клавиш Функция

CTRL+N Создание новой папки ресурса теста.

CTRL+R Создание нового ресурса теста.

Сочетание клавиш Функция

ALT+N Создание нового набора тестов.

ALT+G Открытие диалогового окна Go To Test Set.

CTRL+A Добавление теста в набор тестов.

CTRL+F9 Запуск теста.

CTRL+ALT+F9 Запуск теста вручную.

CTRL+SHIFT+F9 Возобновление выполнения теста вручную.

Сочетание клавиш Функция
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С помощью соответствующих сочетаний клавиш в диалоговом окне Manual 
Runner можно выполнять следующие команды.

ALT+F9 Выполнение набора тестов.

CTRL+DELETE Удаление выбранных экземпляров тестов из набора 
тестов (на вкладке Execution Grid).

Сочетание клавиш Функция

CTRL+R Запуск теста.

CTRL+Q Завершение выполнения теста.

CTRL+K Отмена выполнения теста.

CTRL+U Открытие диалогового окна Attachments.

CTRL+B Добавление нового дефекта.

CTRL+S Добавление вложений к шагу теста.

CTRL+P Установка статуса Passed для выбранных шагов 
тестирования.

CTRL+F Установка статуса Failed для выбранных шагов 
тестирования.

CTRL+A Установка статуса Passed для всех шагов 
тестирования.

CTRL+G Установка статуса Failed для всех шагов 
тестирования.

CTRL+СТРЕЛКА ВВЕРХ 
И 
CTRL+СТРЕЛКА ВНИЗ

Выбор предыдущего или следующего шага 
тестирования.

Сочетание клавиш Функция
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Сочетания клавиш модуля Defects
С помощью соответствующих сочетаний клавиш в модуле Defects можно 
выполнять следующие команды.

Сочетание клавиш Функция

ALT+N Добавление нового дефекта.

ALT+G Открытие диалогового окна Go To Defect.

CTRL+DELETE Удаление выбранных дефектов.

CTRL+ALT+G Поиск аналогичных дефектов.

CTRL+ALT+F Поиск аналогичного текста.

CTRL+L Поиск следующего вхождения указанного текста.

CTRL+M Отправка дефекта по электронной почте (из 
диалогового окна Defect Details).

CTRL+N Очистка всех полей в диалоговом окне New Defect.
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Сочетания клавиш модуля Dashboard
С помощью соответствующих сочетаний клавиш на вкладке Analysis View 
модуля Dashboard можно выполнять следующие команды.

Сочетание клавиш Функция

ALT+A Открытие диалогового окна Set Graph Appearance.

ALT+F Отображение диаграммы в полноэкранном режиме.

ALT+C Копирование полноцветной диаграммы в буфер 
обмена.

ALT+F Отображение диаграммы или стандартных отчетов в 
полноэкранном режиме.

ALT+G Создание выбранной диаграммы или стандартного 
отчета и их отображение на вкладке View.

ALT+I Отображение сводных диаграмм в виде круговых 
диаграмм.

ALT+L Отображение графиков хода выполнения в виде 
линейных графиков.

ALT+M Копирование монохромной диаграммы в буфер 
обмена.

ALT+O Отображение диаграммы в виде гистограммы.

ALT+P На диаграммах: печать диаграмм в цвете.

В стандартных отчетах: печать текущей страницы.

ALT+Q Открытие диалогового окна Excel Report Query Builder 
из вкладки Query.

ALT+R Отображение диаграммы в виде таблицы данных.

ALT+S На диаграммах: сохранение изображения 
диаграммы.

В стандартных отчетах: сохранение текущей 
страницы.

ALT+T На графиках хода выполнения: отображение или 
скрытие суммарных значений.
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ALT+U Открытие диалогового окна Edit Group By Categories.

ALT+V Сброс категорий группировки.

ALT+X Открытие диалогового окна Edit X-Axis.

ALT+Y Сброс категорий для оси X.

ALT+СТРЕЛКА ВПРАВО На диаграммах: прокрутка диаграммы вправо при 
активном режиме масштабирования.

В стандартных отчетах: отображение последней 
страницы.

ALT+СТРЕЛКА ВЛЕВО На диаграммах: прокрутка диаграммы влево при 
активном режиме масштабирования.

В стандартных отчетах: отображение первой 
страницы.

ALT+СТРЕЛКА ВВЕРХ На диаграммах: увеличение масштаба.

В стандартных отчетах: отображение следующей 
страницы.

ALT+СТРЕЛКА ВНИЗ На диаграммах: уменьшение масштаба.

В стандартных отчетах: отображение предыдущей 
страницы.

ALT+ПРОБЕЛ Сброс масштабирования диаграммы.

CTRL+E Открытие диалогового окна New Excel Report.

CTRL+G Открытие диалогового окна New Graph.

CTRL+R Открытие диалогового окна New Standard Report.

CTRL+W Открытие мастера диаграмм.

CTRL+DELETE Удаление выбранной папки или элемента анализа.

CTRL+ALT+C Копирование полноцветной диаграммы в буфер 
обмена в полноэкранном режиме.

CTRL+ALT+F Открытие диалогового окна New Folder.

CTRL+ALT+M Копирование монохромной диаграммы в буфер 
обмена в полноэкранном режиме.

Сочетание клавиш Функция
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С помощью соответствующих сочетаний клавиш на вкладке Dashboard 
View модуля Dashboard можно выполнять следующие команды.

CTRL+ALT+P На диаграммах: печать монохромной диаграммы.

В стандартных отчетах: печать всех страниц.

CTRL+ALT+S Сохранение всех страниц стандартных отчетов.

Сочетание клавиш Функция

ALT+A Переход к выбранной диаграмме в дереве анализа.

ALT+F Отображение выбранной диаграммы в 
полноэкранном режиме.

ALT+G Создание выбранной страницы панели отчетов и ее 
отображение на вкладке View.

ALT+I Создание выбранной диаграммы.

CTRL+P Открытие диалогового окна New Dashboard Page.

CTRL+DELETE Удаление выбранной папки или страницы панели 
отчетов.

CTRL+ALT+F Открытие диалогового окна New Folder.

СТРЕЛКА ВВЕРХ Перемещение выбранного прототипа диаграммы на 
ряд выше.

СТРЕЛКА ВНИЗ Перемещение выбранного прототипа диаграммы на 
ряд ниже.

СТРЕЛКА ВЛЕВО Перемещение выбранного прототипа диаграммы 
влево, если место свободно.

СТРЕЛКА ВПРАВО Перемещение выбранного прототипа диаграммы 
вправо, если место свободно.

КЛАВИША BACKSPACE Удаление выбранного прототипа диаграммы со 
страницы панели отчетов.

DELETE Удаление выбранного прототипа диаграммы со 
страницы панели отчетов.

Сочетание клавиш Функция
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ПРОБЕЛ Увеличение и уменьшение выбранного прототипа 
диаграммы.

КЛАВИША ВВОД Добавление выбранной диаграммы на страницу 
панели отчетов.

Сочетание клавиш Функция
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C
Выпуски Quality Center

Quality Centerпоставляется в трех выпусках: Starter, Enterprise и Premier. В 
этом разделе описаны функциональные возможности каждого выпуска.

Эта глава содержит следующие разделы.

 ➤  О выпусках Quality Center на стр. 797

 ➤  Функциональные возможности различных выпусков Quality Center 
на стр. 798

О выпусках Quality Center
Поставляются следующие выпуски Quality Center.

➤ Quality Center Выпуск Starter Edition. Текущий выпуск Quality Center для 
групп разработки приложений, управляющих небольшими релизами. 
Поддержка до пяти одновременно работающих пользователей.

➤ Quality Center Выпуск Enterprise Edition. Текущий выпуск Quality Center 
для групп разработки приложений, управляющих средними или крупными 
релизами. Старое название: TestDirector for Quality Center.

➤ Quality Center Выпуск Premier Edition. Новый выпуск Quality Center для 
крупных передовых технологических центров, работающих с релизами 
корпоративного уровня.
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Функциональные возможности различных выпусков 
Quality Center

В следующей таблице указано наличие тех или иных функциональных 
возможностей в различных выпусках Quality Center. Дополнительные 
сведения о каждой функции приведены ниже.

Функциональные возможности Выпуск 
Starter Edition

Выпуск 
Enterprise 
Edition

Выпуск 
Premier 
Edition

Лицензирование  

до пяти

Модули  

с некоторыми 
исключениями

Отчеты Excel

Модуль Test Resources

Управление версиями  

один объект

Интерактивная установка

Различные типы требований

Прослеживаемость требований

Управление релизами

Управление качеством на основе 
рисков (RBQM)
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Лицензирование
Выпуск Quality Center Starter Edition предоставляет до пяти одновременно 
используемых лицензий. Для выпусков Quality Center Enterprise Edition и 
Quality Center Premier Edition условия лицензирования определяются 
договором поставки. 

Администратор сайта может следить за использованием лицензий в 
разделе Site Administration. Дополнительные сведения см. в документе 
HP Quality Center Administrator Guide.

Модули
Выпуски Quality Center Enterprise Edition и Quality Center Premier Edition 
предоставляют доступ ко всем модулям Quality Center. В выпуске 
Quality Center Starter Edition доступны следующие модули: Requirements, 
Test Plan, Test Resources, Test Lab, Defects и Dashboard. 

Совместное использование 
требований и тестов

Совместное использование 
дефектов

Межпроектная настройка

Отчеты по нескольким проектам

Дополнительные возможности

Обновление выпусков —

Функциональные возможности Выпуск 
Starter Edition

Выпуск 
Enterprise 
Edition

Выпуск 
Premier 
Edition
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Отчеты Excel
Все выпуски позволяют экспортировать данные Quality Center в 
приложение Excel для составления отчетов. Дополнительные сведения см. 
в Глава 43, "Создание отчетов Excel"..

Модуль Test Resources
Все выпуски включают модуль Test Resources для управления ресурсами, 
используемыми в тестах. Дополнительные сведения см. в Глава 24, 
"Управление ресурсами тестов"..

Управление версиями 
Во всех выпусках возможно управление версиями проектов Quality Center в 
рамках одного объекта. Дополнительные сведения см. в Глава 7, "Работа с 
функциями управления версиями".. 

Выпуски Quality Center Enterprise Edition и Quality Center Premier Edition 
также имеют возможность работы с базовыми состояниями нескольких 
объектов в библиотеке. Дополнительные сведения см. в Глава 38, 
"Библиотеки и базовые состояния"..

Интерактивная установка
Выпуски Quality Center Enterprise Edition и Quality Center Premier Edition 
требуют полной установки с использованием поддерживаемой базы 
данных. 

Выпуск Quality Center можно установить в ОС Windows XP с помощью 
простого мастера интерактивной установки. При этом выполняется 
автоматическая установка сервера приложений JBoss, веб-сервера JBoss 
и базы данных SQL 2005 Express.

Дополнительные сведения об установке и поддерживаемых средах см. в 
документе Руководство по установке HP Quality Center.

Различные типы требований
Quality Center Enterprise Edition и Quality Center Premier Edition 
поддерживают различные типы требований. Дополнительные сведения о 
типах требований см. в разделе “Поля модуля Requirements" на стр. 186. 
Quality Center Starter Edition не поддерживает различные типы требований. 
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Прослеживаемость требований 
Quality Center Enterprise Edition и Quality Center Premier Edition 
поддерживают определение связей между требованиями. Дополнительные 
сведения о прослеживаемости требований см. в разделе Глава 14, 
"Отслеживание требований".. Выпуск Quality Center Starter Edition не 
поддерживает прослеживаемость требований. 

Управление релизами
Выпуски Quality Center Enterprise Edition и Quality Center Premier Edition 
включают модуль Releases. Дополнительные сведения о модуле Releases 
см. в разделе Глава 8, "Рабочий процесс управления релизами"..

Выпуск Quality Center Starter Edition не поддерживает управление 
релизами. При работе с этим выпуском поля и команды, связанные с 
циклами и выпусками, будут недоступны в Quality Center. Например, 
недоступны поля Target Cycle и Target Release.

Управление качеством на основе рисков (RBQM)
Выпуски Quality Center Enterprise Edition и Quality Center Premier Edition 
включают функции тестирования качества на основе рисков. 
Дополнительные сведения об управлении качеством на основе рисков см. 
в Глава 15, "Расчет рисков требований"..

В выпуске Quality Center Starter Edition вкладка Risk модуля Requirements 
недоступна. Также в Quality Center недоступны все поля, относящиеся к 
рискам. 

Совместное использование требований и тестов
Выпуски Quality Center Starter Edition и Quality Center Enterprise Edition не 
позволяют повторно использовать требования, тесты и ресурсы тестов. В 
выпуске Quality Center Starter Edition недоступен модуль Libraries. В 
выпуске Quality Center Enterprise Edition можно использовать модуль 
Libraries, чтобы создавать и сравнивать базовые состояния, состоящие из 
требований, тестов и ресурсов тестов. В выпуске Quality Center Premier 
Edition можно использовать модуль Libraries, чтобы создавать и сравнивать 
базовые состояния, в дополнение к возможности импорта, синхронизации и 
сравнения библиотек в различных проектах.
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Дополнительные сведения о модуле Libraries см. в Глава 37, "Краткий обзор 
модуля Libraries"..

Совместное использование дефектов
Выпуск Quality Center Premier Edition позволяет совместно использовать 
дефекты в различных проектах Quality Center. Для совместного 
использования и синхронизации дефектов используется средство 
HP Quality Center Synchronizer. Дополнительные сведения см. в документе 
Руководство пользователя HP Quality Center Synchronizer, доступном на 
странице надстроек Quality Center.

Межпроектная настройка 
Выпуск Quality Center Premier Edition включает возможность межпроектной 
настройки, позволяя работать с шаблонами проектов. Дополнительные 
сведения см. в документе HP Quality Center Administrator Guide.

Отчеты по нескольким проектам 
При создании диаграмм в Quality Center Premier Edition можно объединять 
и сравнивать данные различных проектов. Дополнительные сведения об 
отчетах и диаграммах Quality Center см. в Глава 40, "Модуль Dashboard"..

Дополнительные возможности
В выпусках Quality Center Enterprise Edition и Quality Center Premier Edition 
доступны следующие дополнительные возможности: Business Process 
Testing (BPT), Service Test Management (STM) и Change Impact Testing 
(CIT).

Обновление выпусков
Можно обновить Quality Center 10.00 до другого выпуска. Можно обновить 
выпуск Quality Center Starter Edition до выпуска Quality Center Enterprise 
Edition или до выпуска Quality Center Premier Edition. Также можно обновить 
выпуск Quality Center Enterprise Edition до выпуска Quality Center Premier 
Edition.

Дополнительные сведения по обновлению см. в документе Руководство по 
установке HP Quality Center.
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Словарь терминов

В словаре терминов приведена терминология, используемая в 
Quality Center.

B

Business Components, модуль

Функциональная область Quality Center, доступная при нажатии 
кнопки Business Components на боковой панели. Этот модуль 
позволяет специалистам в предметной области работать с 
решением компании HP для автоматизации тестирования Business 
Process Testing (BPT). Для создания тестов бизнес-процессов 
используются повторно используемые компоненты и схемы бизнес-
процессов. Для тестирования приложения в ручном режиме также 
можно использовать ручные компоненты. Доступ к модулю 
определяется действующей лицензией Quality Center.

D

модуль Dashboard

Функциональная область Quality Center, доступная при нажатии 
кнопки Dashboard на боковой панели. Этот модуль позволяет 
анализировать данные Quality Center путем создания и просмотра 
диаграмм, стандартных отчетов и отчетов Excel, а также управления 
ими. Можно также создавать панели отчетов, на которых несколько 
диаграмм могут быть показаны одновременно.

Defects, модуль

Функциональная область Quality Center, доступная при нажатии 
кнопки Defects на боковой панели. Этот модуль позволяет 
регистрировать и отслеживать дефекты, определять приоритеты 
исправления и анализировать данные.
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L

Libraries, модуль

Функциональная область Quality Center, доступная при нажатии 
кнопки Management на боковой панели и при последующем выборе 
вкладки Libraries. Этот модуль позволяет определять и создавать 
библиотеки и базовые состояния для отслеживания изменений в 
проекте, повторного использования объектов проекта или 
совместного использования объектов в нескольких проектах. 

M

Management, модуль

Функциональная область Quality Center, доступная при нажатии 
кнопки Management на боковой панели. Этот модуль включает два 
подмодуля: модуль Releases и модуль Libraries.

R

Releases, модуль 

Функциональная область Quality Center, доступная при нажатии 
кнопки Management на боковой панели и при последующем выборе 
вкладки Releases. Этот модуль позволяет организовать и 
отслеживать предстоящие релизы, определяя релизы и циклы 
процесса управления приложением.

Requirements, модуль 

Функциональная область Quality Center, доступная при нажатии 
кнопки Requirements на боковой панели. Этот модуль позволяет 
создавать и анализировать требования в иерархической структуре 
дерева, а также управлять требованиями. Также можно создавать 
связи между требованиями и другими требованиями, тестами и 
дефектами.

T

Test Lab, модуль

Функциональная область Quality Center, доступная при нажатии 
кнопки Test Lab на боковой панели. Этот модуль позволяет создавать 
наборы тестов и управлять ими, а также выполнять тесты. Можно 
запланировать выполнение тестов вручную или автоматически.
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Test Plan, модуль

Функциональная область Quality Center, доступная при нажатии 
кнопки Test Plan на боковой панели. Этот модуль позволяет 
разрабатывать тесты и управлять ими в иерархической структуре 
дерева. Тесты можно связывать с требованиями и дефектами.

Test Resources, модуль

Функциональная область Quality Center, доступная при нажатии 
кнопки Test Resources на боковой панели. Этот модуль позволяет 
управлять ресурсами тестов в иерархической структуре дерева. 
Ресурсы тестов могут быть связаны с тестами.

Б

базовое состояние

Снимок библиотеки в определенный момент времени. Включает все 
объекты, определенные в библиотеке, и отношения между ними, 
такие как покрытие и прослеживаемость требований. Можно 
сравнивать базовые состояния для отслеживания изменений в 
проекте или использовать базовое состояние для повторного или 
совместного использования объектов библиотеки.

библиотека

Определенный в проекте набор объектов и взаимоотношений между 
ними, таких как покрытие и прослеживаемость требований. 
Объекты в библиотеке могут включать требования, тесты, ресурсы 
тестов и бизнес-компоненты. После определения библиотеки 
создается базовое состояние, позволяющее отслеживать 
изменения в проекте, повторно использовать объекты в проекте или 
совместно использовать объекты в нескольких проектах.

бизнес-критичность

Категория управления качеством на основе рисков (RBQM), 
определяющая степень критичности требования для бизнеса. Риск 
определяется на основе комбинации результатов оценки бизнес-
критичности и вероятности сбоя.
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В

вероятность сбоя

Категория управления качеством на основе рисков (RBQM), 
определяющая вероятность отрицательного результата теста, 
основанного на определенном требовании. Риск определяется на 
основе комбинации результатов оценки вероятности сбоя и бизнес-
критичности.

возврат

При использовании управления версиями — процесса, в ходе 
которого создается и становится доступной пользователям новая 
версия объекта с обновлениями. После изъятия объекта и внесения 
изменений необходимо выполнить возврат новой версии объекта.

выполнение теста

Выполнение экземпляра теста в наборе тестов. Для выполнения 
тестов используется модуль Test Lab. Можно выполнять тесты 
вручную или автоматически, планировать дату и время выполнения 
тестов и устанавливать условия возможности выполнения тестов. 
Можно просматривать результаты одного выполнения теста или 
просматривать и сравнивать подробные данные всех выполнений 
выбранного экземпляра теста.

выпуски Quality Center 

Поставляются три различных выпуска Quality Center: Starter, 
Enterprise и Premier. Доступные функции определяются 
используемым выпуском.

Quality Center Выпуск Starter Edition. Для групп разработки 
приложений, управляющих небольшими релизами, максимум пять 
одновременно работающих пользователей, ограниченные 
возможности.

Quality Center Выпуск Enterprise Edition. Для групп разработки 
приложений, управляющих средними или крупными релизами.

Quality Center Выпуск Premier Edition. Для крупных организаций 
уровня Center of Excellence (CoE), управляющих корпоративными 
релизами.
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Д

дефект

Проблема, обнаруженная в приложении проекта на каком-либо этапе 
процесса управления приложением. Можно связывать дефекты с 
другими объектами проекта, такими как требования, тесты или 
другие дефекты. Дефект может быть связан с другими объектами 
напрямую или косвенно. При добавлении связи дефекта с объектом 
Quality Center добавляет прямую связь к такому объекту и косвенные 
связи к другим связанным объектам.

домен

Проекты Quality Center сгруппированы по доменам. Домен содержит 
группу связанных проектов Quality Center и помогает организовать 
большое количество проектов и управлять ими. Каждый домен 
содержит папку Projects и папку Template Projects для организации 
проектов и шаблонов проектов Quality Center. 

З

закрепленный набор тестов

Набор тестов, связанный с базовым состоянием. В модуле Test Lab 
после создания набора тестов можно связать этот набор с указанным 
базовым состоянием. При выполнении набора тестов Quality Center 
выполняет только версии теста, сохраненные в базовом состоянии.

И

изъятие

При использовании управления версиями — процесса, в ходе 
которого объект блокируется для внесения изменений, 
предотвращая перезапись сделанных изменений другими 
пользователями. Изъятая версия объекта невидима для других 
пользователей.

импортированная библиотека

Новую библиотеку можно создать путем импорта существующей 
библиотеки. Импортированная библиотека — это библиотека, 
которая создается путем импорта существующей библиотеки из того 
же проекта или из другого проекта.
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исходная библиотека

Новую библиотеку можно создать путем импорта существующей 
библиотеки из того же проекта или из другого проекта. Исходная 
библиотека — это библиотека, используемая в качестве основы для 
создания другой библиотеки. 

М

межпроектная настройка

Процесс настройки шаблона проекта для определения и 
поддержания общего набора настроек проекта для нескольких 
проектов Quality Center. Шаблон проекта можно связать с одним или 
несколькими проектами. После этого выполняется настройка 
шаблона и применение сделанных настроек к связанным проектам. 
Настройки шаблона, применяемые к связанным проектам, могут 
включать группы пользователей и права, объекты проектов, типы 
требований, списки и жизненный цикл.

Н

набор тестов

Группа тестов в проекте Quality Center, предназначенных для 
решения определенной задачи тестирования, например для 
проверки общей работоспособности или для регрессионного 
тестирования. Объединение тестов проекта в группы позволяет 
организовать выполнение тестов в соответствии с целями 
тестирования. Можно назначить папки наборов тестов циклам.

Надстройка Excel

Можно импортировать требование, план тестирования или данные 
дефекта из таблицы Microsoft Excel в проект Quality Center. Чтобы 
выполнять импорт из Excel, сначала необходимо установить 
надстройку HP Quality Center Microsoft Excel Add-in на клиентском 
компьютере.

надстройка Word

Можно импортировать данные требования или плана тестирования в 
проект Quality Center из документа Microsoft Word. Чтобы выполнять 
импорт из Word, сначала необходимо установить надстройку HP 
Quality Center Microsoft Word Add-in на клиентском компьютере.
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настройка проекта

Процесс адаптации проекта к определенным потребностям 
организации. В окне Project Customization можно управлять доступом 
к проекту, определяя пользователей, которым будет предоставлен 
доступ к проекту, определяя типы задач, которые может выполнять 
каждый пользователь, а также добавляя и изменяя поля.

O

объект

Набор данных в проекте Quality Center, который используется в виде 
блока, например, объект требования, в котором хранятся данные 
всех требований Quality Center. Объекты содержат данные, 
введенные пользователями для определенного процесса 
управления приложением; эти данные хранятся в таблицах. Каждый 
объект может содержать системные и пользовательские поля.

Объект также может представлять собой отдельную запись, 
содержащую уникальные данные, например отдельное требование в 
модуле Requirements. Можно создавать и изменять объекты, 
отправлять объекты по электронной почте, поддерживать историю 
изменений объекта или создавать связи между объектами.

оповещение

Уведомление, информирующее пользователя об изменениях 
требований, тестов или дефектов. Оповещение может выдаваться в 
результате применения правил автоматического уведомления или 
флажка с напоминанием, установленного пользователем.

П

перекрестный фильтр

Расширенный фильтр второго уровня для связанного элемента, 
такого как требования, тесты, наборы тестов или дефекты. 
Например, в модуле Requirements можно определить перекрестный 
фильтр для исключения требований, покрывающие тесты которых 
имеют статус Passed.
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покрытие

Связи, которые создаются для отслеживания взаимоотношений 
между требованиями и тестами. Покрытие требований создается в 
модуле Test Plan путем выбора требований для связи с тестом. 
Альтернативный вариант — создание покрытия тестами в модуле 
Requirements путем выбора тестов, которые необходимо связать с 
требованием. Тест может покрывать несколько требований, а 
требование может покрываться несколькими тестами.

покрытие тестами

Связи, которые создаются для отслеживания взаимоотношений 
между требованиями и тестами. Покрытие тестами создается в 
модуле Requirements путем выбора тестов для связи с требованием. 
Покрытие тестами помогает оценить влияние изменения теста или 
требования. Требование может покрываться несколькими тестами.

покрытие требований

Связи, которые создаются для отслеживания взаимоотношений 
между требованиями и тестами. Покрытие требований создается в 
модуле Test Plan путем выбора требований для связи с тестом. 
Покрытие требований помогает оценить влияние изменения теста 
или требования. Тест может покрывать несколько требований. 
Статус прямого покрытия требования отражает статус выполнения 
тестов, покрывающих требование.

пользовательское поле (UDF)

Поля данных, которые можно добавить к проекту Quality Center. 
Пользовательские поля можно настроить в соответствии с 
конкретными потребностями организации.

проект

Проект используется для объединения и хранения данных, 
относящихся к процессу управления жизненным циклом приложения, 
включая требования, дефекты и дополнительные ресурсы. Проекты 
хранятся в репозитории проектов Quality Center в файловой системе 
сервера приложений.
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прослеживаемость требований

Связь, создаваемая для установления взаимоотношения между 
требованиями. При анализе воздействия, которое окажет 
предлагаемое изменение на требование, прослеживаемость 
указывает на другие требования, на которые это изменение также 
может оказать воздействие. Взаимосвязи прослеживаемости 
определяются на вкладке Requirements Traceability модуля 
Requirements. Можно добавлять связи прослеживаемости от 
выбранного требования и к нему.

Р

рабочий процесс

Возможность, предоставляющая средства для создания или 
изменения скриптов, используемых для настройки полей и значений 
модулей Quality Center и для управления действиями, которые могут 
выполнять пользователи. Рабочий процесс можно настроить на 
странице Workflow в окне Project Customization.

релиз

Группа изменений приложения, доступных для распространения 
одновременно. Релиз может быть разделен на циклы. После этого 
релизу и циклам могут быть назначены требования и дефекты.

ресурс теста

Ресурсы тестов — это файлы или папки в репозитории Quality Center, 
используемые тестами. Ресурс теста может использоваться одним 
или несколькими тестами. Например, ресурс теста может 
представлять собой файл данных, который содержит входные 
данные для выполнения различных тестов.

С

связанные библиотеки

Две библиотеки в одном проекте или в разных проектах, где одна 
библиотека (исходная библиотека) используется в качестве основы 
для создания другой (импортированной библиотеки). Можно 
сравнивать связанные библиотеки для отслеживания внесенных 
изменений или синхронизировать библиотеки, чтобы внести 
изменения, сделанные в одной библиотеке, в другую.
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связанный проект

Проект, связанный с шаблоном проекта. Можно применять 
обновления настройки шаблона к связанному проекту в ходе 
межпроектной настройки.

системное поле

Стандартное поле Quality Center для ввода данных в проекте 
Quality Center. Системные поля нельзя добавлять или удалять; 
можно только изменять их значения.

страница панели отчетов

Набор диаграмм для одновременного просмотра. Проектирование и 
просмотр страниц панели управления выполняются на вкладке 
Dashboard View модуля Dashboard.

Т

тест

Один или несколько шагов, определяемых для проверки 
определенной функции приложения или требования к нему. Можно 
создавать ручные тесты или автоматизированные тесты, которые 
выполняются средством тестирования. Тесты организованы в виде 
дерева плана тестирования, иерархической структуры, которая 
разделяет приложение на тестируемые модули, или объекты. 

тип требования

Категория для требования, которая описывает назначение 
требования, например функциональное требование или требование 
к тестированию. Каждому требованию можно назначить один из 
стандартных типов требований Quality Center или специальный тип, 
который может быть создан администратором проекта.



Словарь терминов

813

требование

Подробное описание определенной задачи разрабатываемого 
приложения. Требования организованы в виде дерева требований, 
иерархической структуры, позволяющей группировать требования к 
приложению в соответствии с функцией или задачей. Требование 
можно связывать с релизами и циклами в модуле Releases. Также 
можно создавать связи между требованием и другими требованиями, 
тестами и дефектами.

У

управление версиями

Отслеживание изменений объектов в проекте путем сохранения 
предыдущих версий объектов. В проекте с включенным управлением 
версиями поддерживается история версия для объектов, включая 
требования, тесты, ресурсы тестов и бизнес-компоненты. Можно 
просматривать и сравнивать предыдущие версии объекта, а также 
восстанавливать предыдущую версию.

управление качеством на основе рисков (RBQM)

Функция, которая позволяет определить стратегию тестирования для 
указанных требования на основе рисков и функциональной 
сложности, времени тестирования и доступных ресурсов. Работа с 
функцией управления качеством на основе рисков осуществляется 
на вкладке Risk модуля Requirements.

Ф

функциональная сложность

Категория управления качеством на основе рисков (RBQM), 
определяющая сложность реализации требования.

Ц

цикл

Последовательность действий по разработке и контролю качества 
для достижения общей цели на основе временных рамок релиза. 
После определения релиза к нему можно добавлять циклы. После 
этого можно назначать циклам требования, дефекты и папки наборов 
тестов.
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Ш

шаблон проекта

Настроенный проект, используемый для применения общего набора 
настроек проекта к другим проектам в ходе межпроектной 
настройки. Шаблоны проектов позволяют стандартизовать политики 
и процедуры для различных проектов организации.

шаблон теста

Тест, включающий типичные шаги, которые часто требуется 
выполнять как составные части других тестов. Можно отметить 
ручной тест в дереве плана тестирования как шаблон теста, чтобы 
облегчить выбор этого теста для вызова из другого теста.

шаг теста

Подробные инструкции по выполнению теста. Может включать 
операции с приложением, вводимые данные и ожидаемый результат.

Э

экземпляр теста

Тест, включенный в набор тестов. Каждый тест, добавляемый к 
набору тестов, представляет собой экземпляр теста. К набору тестов 
можно добавить несколько экземпляров теста. Также можно 
включить один и тот же тест в несколько наборов тестов.
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A
Actual execution rate, вкладка Progress 152
Actual Fix Time, таблица Defects Grid 524
Add and Link Defect, кнопка 555
Add Comment, кнопка 539
Add Entity to Query, кнопка 689
Add Favorite, диалоговое окно 104, 106
Add Graph to Dashboard Page, кнопка 618
Add Graph, ссылка 702
Add Host to Host Group, кнопка 487
Add Object, диалоговое окно 769
Add Object, команда 769
Add Parameter to Query, кнопка 693
Add Query, кнопка 689
Add report as attachment, флажок 256
Add Requirement Traceability, кнопка 231, 

232
Add Step, кнопка, выполнение теста вручную 

474
Add Sub Report, кнопка 678
Add Tests to Test Set, кнопка 431, 432
Add Time Dependency To Flow, кнопка 459
Add to Coverage, кнопка

вкладка Req Coverage 324
вкладка Test Coverage 329

Add to Favorites, команда 104, 106
Add to Traceability, кнопка 232
AddDefect, функция VAPI-XP 772
AddDefectUI, функция VAPI-XP 772
AddStepToRun, функция VAPI-XP 773
Adjust Rows Height, кнопка 347
Adobe Reader 19
Alerts, диалоговое окно 89
Alerts, кнопка 89, 539
Alerts, флажок 89
All Runs, представление 498
Analysis Results, вкладка 258

Analysis View, вкладка 615
Analysis, команда

диаграммы 631
мастер диаграмм 626
отчеты 668

Arrange Layout, кнопка, схема выполнения 
464

Assign To Cycle, диалоговое окно 200, 427
Assign To Release, диалоговое окно 199
Assigned requirements, вкладка Progress 

153
Assigned To, таблица Defects Grid 524
Attachments, вкладка таблицы Defects Grid 

520
Attachments, вкладка, диалоговое окно 

Defect Details 539
Attachments, диалоговое окно 94
Attachments, представление, диалоговое 

окно Requirement Details 203
Authenticate, кнопка 42
Author, модуль Requirements 186
Auto Complete Children, флажок 222
Automated, вкладка, диалоговое окно Test 

Instance Properties 503
Automatic Runner, диалоговое окно 480
Automation, вкладка

Notifications 435
On Failure 436

Available Columns, список 55
Available Fields, список 70

B
Back to Steps Grid, кнопка 472
Back, кнопка 47
Bar Chart, кнопка 641
Baseline ID, модуль Libraries 563

индекс
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Baseline Name, модуль Libraries 598
Begin Run, кнопка 471
Broken Links Verification, диалоговое окно 

571
Browsers, команда 767
Business Components, модуль 47
Business Criticality, вкладка 245
Business Process Testing 47
Business Process, определение типа теста 

296
By ID (Trace From), команда 232
By ID (Trace To), команда 233

C
Call to Test, кнопка 343
Cancel Run, кнопка, выполнение теста 

вручную 471
Change Password, диалоговое окно 50
Change Project, команда 48
Check In, диалоговое окно 118
Check In, кнопка 120
Check In, команда 118
Check Out, диалоговое окно 116, 117
Check Out, кнопка 123
Check Out, команда 117
Check Spelling, кнопка

Send Mail 215, 547
отправка сообщения электронной 

почты 306
создание требования 198
создать дефект 533

Check Spelling, команда 48
Choose Type of Purge, диалоговое окно 452
Clear All, кнопка 90
Clear Filter, кнопка 75
Clear Filter/Sort, вкладка Test Coverage 326
Clear Filter/Sort, кнопка 75, 499
Clear Output, кнопка 776
Clear Pinned Baseline, команда 580
Clear Test Sets Filter/Sort, команда 75
Clear Tests Filter/Sort, команда 75
Clear, кнопка, диалоговое окно New Defect 

532
Clear, кнопка, диалоговое окно New 

Requirement 197

Clear, метод VAPI-XP 774
Clipboard, кнопка 99
Closed in Version, таблица Defects Grid 524
Closing Date, таблица Defects Grid 524
Collapse, команда

дерево плана тестирования 300
дерево требований 209

Comments
модуль Requirements 186
таблица тестов 285

Comments, вкладка, дерево плана 
тестирования 298

Comments, дерево ресурсов тестов 381
Comments, область таблицы Defects Grid 

520, 524
Comments, область, таблица Defects 539
Compact View, кнопка, выполнение теста 

вручную 472
Compare Baselines Tool, диалоговое окно 

574
Compare Entities, диалоговое окно 583
Compare Entities, кнопка 602
Compare Libraries Tool, диалоговое окно 599
Compare To Source, кнопка 598
Compare To, кнопка 573, 599
Compare, кнопка 122, 579
Comparison Settings, диалоговое окно 577
Comparison Settings, кнопка 577, 602
Configuration, вкладка, диаграммы 635
Configuration, вкладка, отчеты Excel 686
Configuration, вкладка, панели отчетов 617
Configuration, вкладка, стандартные отчеты 

675
Configuration, представление, диалоговое 

окно Test Instance Properties 501
Confirm Purge Request, диалоговое окно 453
Confirm Reset Test Set, диалоговое окно 450
Considered Fields, список 577
Continue Manual Run, команда 475
Continue, кнопка, представление All Runs 

499
Contract, кнопка, панели отчетов 618
Convert to Tests, команда 220
Copy Filter Settings, кнопка 75
Copy From, кнопка 366
Copy Graph To Clipboard, кнопка, модуль 
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Dashboard 642
Copy Selected Text to Clipboard, кнопка 776
Copy Steps, кнопка, вкладка Design Steps 

348, 349
Copy Test Settings, кнопка 440
Copy to Clipboard, команда 465
Copy URL, команда 217, 312, 387, 447, 

548
Copy, кнопка

VAPI-XP 770
дерево требований 216

Coverage Analysis 330
Coverage Analysis, диалоговое окно 330, 

726
Coverage Analysis, кнопка 331
Coverage Analysis, представление 179
Coverage calculation by cycle, поле 331
Coverage Chart 327
Coverage Type

вкладка Req Coverage 321
вкладка Test Coverage 326

Create Baseline, журнал 572
Create Baseline, кнопка 570
Create Library, диалоговое окно 568
Create New Requirement Folder, диалоговое 

окно 196
Create New Requirement, диалоговое окно 

196
Create New Test, диалоговое окно 294
Create Report For This Defect, кнопка 539
Create Test Instance, диалоговое окно 432, 

433
Created By, дерево ресурсов тестов 381
Created By, модуль Libraries 562
Created By, представление Traceability Grid 

234
Created By, таблица Linked Defects 553
Creation Date

дерево плана тестирования 297
дерево ресурсов тестов 381
модуль Libraries 562
модуль Requirements 186
представление Traceability Grid 234
таблица Linked Defects 553
таблица тестов 285

Creation Time, модуль Requirements 186

Cross filter by, раздел 68
Cross Filter, диалоговое окно 68
Custom Sort, параметр, дерево плана 

тестирования 313
Custom Zoom, диалоговое окно 465
Custom, кнопка 215, 306, 547
Customization, вкладка, Document Generator 

721
Customize, команда 48, 49
Cut, кнопка, модуль Releases 158
Cycle ID 136

D
Dashboard View, вкладка 616
Dashboard, модуль

диаграммы 625
краткий обзор 613
отчеты Excel 683
панели отчетов 616
создание деревьев 614
создание элементов анализа 615
стандартные отчеты 672
управление элементами и папками 

621
Data Grid, кнопка, модуль Dashboard 641
Database Type, кнопка 688
Days, индикатор выполнения, вкладка 

Progress 152
Defect Details, диалоговое окно 538
Defect ID

таблица Linked Defects 553
таблица дефектов 524

Defect Opening Rate, диаграмма, вкладка 
Quality 154, 155

Defects, кнопка 518
Defects, кнопка, представление All Runs 499
Defects, меню модуля Defects 521
Defects, модуль

главное окно 518
диаграммы 651
краткий обзор 517
обзор 530
определения столбцов 524
панель инструментов 522
рабочий процесс 511
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создание документов проекта 748
стандартные отчеты 667
строка меню 521
таблица дефектов 529

Defects, ссылка, Document Generator 748
Defects, флажок, Document Generator 748
Delete Alert, кнопка 90
Delete Host Group, кнопка 487
Delete Host, кнопка 487
Delete Resource, диалоговое окно 392
Delete Selected Tests, кнопка, таблица 

тестов 284
Delete Selected, кнопка

вкладка Design Steps 347
вложения 101
выполнение теста вручную 474

Delete Sub-Report, кнопка 678
Delete Test, диалоговое окно 316
Delete, кнопка

 315
VAPI-XP 770
модуль Releases 159
наборы тестов в модуле Test Lab 450
папки в модуле Test Lab 449
представление All Runs 499

Delete, команда
дерево требований 218
таблица дефектов 549

Dependencies, вкладка
модуль Test Plan 277
модуль Test Resources 384

Description
дерево релизов 147, 148
дерево ресурсов тестов 381
модуль Libraries 563
модуль Releases 136
модуль Requirements 186
сведения о выполнении теста 496
таблица Defects Grid 524
таблица тестов 285

Description of Criterion, поле 245, 246, 248
Description, вкладка

дерево плана тестирования 298
модуль Requirements 172, 174, 

177, 180
таблица дефектов 520

Description, команда 222
Design Step Editor 337
Design Steps, вкладка, модуль Test Plan 

277, 338
Designer

дерево плана тестирования 297
таблица тестов 286

Details, вкладка
Defect Details, диалоговое окно 539
модуль Releases 147, 148
модуль Requirements 174
модуль Test Plan 277, 297

Details, вкладка, модуль Test Lab 430
Details, вкладка, модуль Test Resources 

378, 380
Details, представление

Requirement Details, диалоговое окно 
203

диалоговое окно Test Instance 
Properties 495

Detected By, таблица Defects Grid 524
Detected in Cycle, модуль Defects 525
Detected in Release, модуль Defects 525
Detected in Version, таблица Defects Grid 

525
Detected on Date, таблица Defects Grid 525
Direct Cover Status, модуль Requirements 

186
Document Generator 713

данные проекта 723
дерево Document Generator 723
запуск 716
обзор 714
создание и просмотр документов 

проекта 750
указание данных модуля Defects 748
указание данных модуля 

Requirements 725
указание данных модуля Test Lab 

738
указание данных модуля Test Plan 

728
указание данных таблицы тестов 733
форматирование документов проекта 

717
Document Settings, вкладка, Document 
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Generator 717
Documentation Library 19
documentation updates 23
Domain, модуль Libraries 597
Domain, список, окно входа в систему 43
Download and Open, кнопка, вложения 100
DownLoadAttachment, функция VAPI-XP 773
Drill Down Results, диалоговое окно 704, 

708
Duplicate Cycle, кнопка 158

E
Edit Categories, кнопка 646
Edit Group By Categories, диалоговое окно 

646
Edit Parameter, кнопка, отчеты Excel 693
Edit Step, кнопка 345
Edit X-Axis Categories, диалоговое окно 646
Edit, меню

модуль Test Lab 410
модуль Test Plan 278

Editor, кнопка 770
Enable Log, флажок, диалоговое окно 

Automatic Runner 481, 483
Enable Manual Test Run Confirmation, 

команда 469
End Date

дерево релизов 147, 148
модуль Releases 136

End Run, кнопка, выполнение теста вручную 
471, 473, 474

Enterprise Edition, определение 797
Entities, панель, отчеты Excel 688
Entity Name

вкладка Req Coverage 321
вкладка Test Coverage 326

Entity Status
вкладка Req Coverage 321
вкладка Test Coverage 326

Estimated development time, поле 244
Estimated DevTime, таблица тестов 286
Estimated Fix Time, таблица Defects Grid 525
Excel

импорт в Quality Center 38
экспорт данных таблицы из Quality 

Center 79
Exclude from Analysis, флажок 244
Exclude, команда 222
Exec Date

сведения о выполнении теста 496
таблица выполнения 417

Execute (Debug Mode), команда 776
Execute (Test Mode), команда 777
Execute Script, кнопка 776, 780
Executed coverage, вкладка Progress 153
Execution Condition, диалоговое окно 460
Execution Conditions, вкладка, диалоговое 

окно Run Schedule of Test 457
Execution Flow, вкладка 409
Execution Grid, вкладка 409
Execution Report, ссылка, диалоговое окно 

Defect Details 539
Execution Status, таблица тестов 286
Expand All, команда, дерево требований 

209
Expand, кнопка, панели отчетов 618
Expand, команда, дерево плана 

тестирования 300
Export All Grid Data, диалоговое окно 79
Export Selected Grid Data, диалоговое окно 

79
Export Word Document, команда 335
Export, команда 79

F
Fail All, команда 473
Fail Selected, кнопка, выполнение теста 

вручную 473
Failed, статус требования 186
Failure Probability, вкладка 246
Favorite Bar, команда 106
File, кнопка 95
Filter Condition, поле 61
Filter, диалоговое окно

вкладка Filter 60
вкладка Group 73
вкладка View Order 70
с расширенными фильтрами 67

Filter/Sort, команда 60, 70, 75
Find Folder/Test Set, команда 442
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Find Folder/Test, диалоговое окно 307
Find in Script, кнопка 770
Find Next, команда

VAPI-XP 770
таблица дефектов 540, 541
таблица тестов 308
таблица требований 205

Find Similar Defects, кнопка 535, 536
Find Similar Text, диалоговое окно 536
Find Test In Flow, кнопка 464
Find Test, диалоговое окно, схема 

выполнения 464
Find Text, кнопка 351
Find, диалоговое окно 205, 308, 541

вкладка Design Steps 351
таблица выполнения 489
таблица дефектов 541

Find, кнопка
вкладка Req Coverage 324
вкладка Requirements Traceability 

232
вкладка Test Coverage 328

Find, команда
дерево требований 204
таблица выполнения 489
таблица дефектов 540, 541
таблица тестов 308
таблица требований 205

Find/Replace Text, кнопка 352
Find/Replace, диалоговое окно 207, 309, 

444
таблица Requirements 207
таблица выполнения 490
таблица дефектов 309, 444, 542

First Page, кнопка, стандартные отчеты 681
Fit Picture In Window, кнопка, схема 

выполнения 465
Fixed Columns, диалоговое окно Select 

Columns 56
Flag for Follow Up, диалоговое окно 92
Flag for Follow Up, кнопка 92, 539
Flow, определение типа теста 296
Folder ID, дерево ресурсов тестов 381
Forgot Password, ссылка 44
Forward, кнопка 47
Full Coverage, флажок, вкладка Test 

Coverage 327
Full Document, кнопка 751
Full Screen View, кнопка 704
Functional Complexity, вкладка 248

G
Generate All Graphs in Page, кнопка 619
Generate Report, кнопка 256
Generate Script, кнопка 365
Generate Test, диалоговое окно 224
Generate, кнопка, диаграммы 641
Generate, кнопка, отчеты Excel 697
Generate, кнопка, панели отчетов 619
Get Hosts on the Network, кнопка 486
Get Net, кнопка 486
GetInput, функция VAPI-XP 774
Global Parameter, флажок 692
Go To Defect, кнопка 539
Go to Defect, команда 520
Go To Entity, кнопка 78
Go To Graph in Analysis Tree, кнопка 620
Go to Line Number, команда, VAPI-XP 770
Go to Next Change, кнопка 576, 601
Go to Previous Change, кнопка 576, 601
Go To Requirement in Requirements Tree, 

команда 322
Go to Requirement, команда

модуль Test Lab 413
представление Coverage Analysis 

181
представление Requirement Details 

175
представление Requirements Grid 

178
представление Requirements Tree 

172
Go to Test in Test Plan Tree, кнопка, таблица 

тестов 284
Go to Test in Test Plan Tree, команда 327

модуль Test Lab 410
Go to Test in Test Set, команда 327

модуль Test Plan 301
Go to Test, команда

дерево плана тестирования 278
модуль Test Lab 413
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таблица тестов 284
Graph Appearance, диалоговое окно

диаграммы 645
диаграммы анализа в реальном 

времени 710
Grid Filters, команда 64
Group, вкладка, диалоговое окно Filter 73

H
Help, кнопка 49
Hide On Run, флажок 692
Hide Risk-Based Quality Management 

Columns, флажок 61, 71, 73
History, вкладка

Defect Details, диалоговое окно 540
дерево требований 210
история версий 121
таблица дефектов 520, 543
таблица тестов 283

History, представление, диалоговое окно 
Requirement Details 203

History, представление, диалоговое окно 
Test Instance Properties 507

HookDebug, свойство VAPI-XP 774
Host Manager 485
HTML-документ, экспорт данных таблицы 

79

I
Ignored Fields, список 577
Impact Analysis, вкладка, прослеживаемость 

требований 236
Import Library, журнал 594
Import Library, кнопка 592
Imported By, вкладка 595
Imported From, вкладка 597
Indicator Columns, команда

Defects, модуль 519
таблица выполнения 283, 414
таблица тестов 171
таблица требований 174, 177, 180

Information Panel, команда
представление Coverage Analysis 

180

представление Requirements Tree 
172

таблица дефектов 520, 543
таблица требований 177

Insert Parameter, диалоговое окно, 
параметры теста 357

Insert Parameter, кнопка, параметры теста 
340

ITG Request Id 430

K
Knowledge Base 22

L
Last Page, кнопка, стандартные отчеты 681
Last Run Results, область, таблица 

выполнения 414
Last Synchronization 598
Launch, кнопка 366
Libraries, модуль

Imported By, вкладка 595
Imported From, вкладка 597
импорт библиотеки 590
Импортированная библиотека, 

значок 590
краткий обзор 560
настройка параметров сравнения 

576
обзор 566
определения полей 562
отправка библиотек по электронной 

почте 605
панель инструментов 561
переименование базовых состояний 

581
переименование библиотек 581
перемещение библиотек 581
примеры 589
примеры базовых состояний 570
синхронизация библиотек 602
создание базовых состояний 569
создание библиотек 567
сравнение базовых состояний 573
сравнение библиотек 598
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строка меню 561
удаление базовых состояний 582
удаление библиотек 582

Library ID 563
Library Name 597
Library Verification, диалоговое окно 592
Line Chart, кнопка 641
Link Comment, таблица Linked Defects 553
Link Entity Type, таблица Linked Defects 553
Link Existing Defect, кнопка 555
Link ID, таблица Linked Defects 553
Link Type, таблица Linked Defects 553
Linkage and Coverage, представление, 

диалоговое окно Test Instance 
Properties 506

Linked By Status, таблица Linked Defects 553
Linked Defects, вкладка 409, 552

 506
модуль Test Plan 277

Linked Defects, диалоговое окно 552
Linked Defects, диалоговое окно, для 

выполнения теста 499
Linked Defects, представление, диалоговое 

окно Requirement Details 203
Linked Entities, вкладка

Defect Details, диалоговое окно 540
Linked Entity ID, таблица Linked Defects 553
Linked Entity Name, таблица Linked Defects 

553
Live Analysis, вкладка 701, 705
Load from File, кнопка, Document Generator 

720
Load from Saved, кнопка, Document 

Generator 721
LoadRunner Scenario, определение типа 

теста 295
Login, кнопка 43
Logo, вкладка, Document Generator 720
Logout, кнопка 43, 46

M
Mail Requirement, кнопка 213
Management, кнопка 134
Manual Parameters, вкладка, диалоговое 

окно Test Instance Properties 502

Manual Runner - Step Details, диалоговое 
окно 472

Manual Runner, диалоговое окно 470
Manual, определение типа теста 295
Mark as Template Test, команда 297, 342
Maximize Content, кнопка 201
Microsoft Excel

импорт в Quality Center 38
экспорт данных таблицы из Quality 

Center 79
Microsoft Word

импорт в Quality Center 38
создание документов проекта 750
форматированный текст 200
экспорт данных таблицы из Quality 

Center 79
missing assessment, ссылка 253
Modified

модуль Libraries 563
модуль Requirements 187
представление Traceability Grid 235
таблица Defects Grid 525
таблица выполнения 417
таблица тестов 286

Move Field Down, кнопка, диалоговое окно 
Filter 71

Move Field Up, кнопка, диалоговое окно Filter 
71

N
Name

модуль Libraries 562
модуль Releases 136
модуль Requirements 187

Name, дерево ресурсов тестов 381
New Baseline, диалоговое окно 571
New Cycle, кнопка 147
New Dashboard Page, диалоговое окно 616
New Defect, кнопка, выполнение теста 

вручную 473
New Defect, команда 48
New Execution Condition, диалоговое окно 

458
New Folder, диалоговое окно 293, 426
New Folder, кнопка 196, 426, 567
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New Host Group, диалоговое окно 487
New Host Group, кнопка 487
New Host, диалоговое окно 486
New Host, кнопка 486
New Item, кнопка, диаграммы 633
New Item, кнопка, мастер диаграмм 626
New Item, кнопка, отчеты Excel 685
New Item, кнопка, стандартные отчеты 673
New Library Folder, диалоговое окно 567
New Page, кнопка 616
New Parameter, диалоговое окно, параметры 

теста 355
New Query Parameter, кнопка, отчеты Excel 

692
New Release Folder, кнопка 146
New Release, кнопка 147
New Requirement, кнопка 196
New Resource Folder, диалоговое окно 378
New Resource Folder, кнопка 378
New Resource, диалоговое окно 379
New Resource, кнопка 379
New Step, кнопка 339
New Test Set, диалоговое окно 428
New Test Set, кнопка 429
New Test, кнопка 294
Next Page, кнопка, стандартные отчеты 681
No Run, статус требования 186
No. of Requirements per Risk Category, 

диаграмма 253
not assessable, ссылка 253
Not Completed, статус требования 186
Not Covered, статус требования 186
Notifications, ссылка 435

O
Old Type (obsolete), модуль Requirements 

187
On Failure, ссылка 436
On Test Failure, диалоговое окно 438
Open Output Text in Web Browser, кнопка 776
Open, кнопка, вложения 100
Options, вкладка, Document Generator 718
Order Tests, диалоговое окно

схема выполнения 463
таблица выполнения 487

Organize Favorites, диалоговое окно 107
Output, вкладка 769
Output, команда 769
Outstanding Defects, диаграмма, вкладка 

Quality 154, 155
Owner Description, таблица Used By 397
Owner ID, таблица Used By 397
Owner Name, таблица Used By 397
Owner Type, таблица Used By 397

P
Page Setup, диалоговое окно, Document 

Generator 722
Page Setup, кнопка, Document Generator 721
Parameter details, диалоговое окно, модуль 

Test Plan 356
Parameters of Test, диалоговое окно 359
Pass All, команда 473
Pass Selected, кнопка, выполнение теста 

вручную 473
Passed coverage, вкладка Progress 153
Passed, статус требования 186
Paste Design Steps to Target Project, 

диалоговое окно 349
Paste Filter Settings, кнопка 75
Paste Resources to Target Project, 

диалоговое окно 386
Paste Steps, кнопка, вкладка Design Steps 

348, 349
Paste Test Sets/Test Set Folders to Target 

Project, диалоговое окно 447
Paste Test Settings, кнопка 440
Paste Tests/Subject Folders to Target Project, 

диалоговое окно 312
Paste, кнопка, VAPI-XP 770
Paste, команда, дерево релизов 158
Paste, команда, дерево требований 217, 

218
Path, таблица тестов 286
Pending Check In, диалоговое окно 119
Pending Check In, команда 119
Percent of Similarity, поле 537
Perform Risk Analysis, кнопка 253
Pie Chart, кнопка 641
Pin to Baseline, команда 580
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Pinned to Baseline, диалоговое окно 580
Planned Closing Version, таблица Defects 

Grid 525
Planned coverage, вкладка Progress 153
Planned Exec Date

сведения о выполнении теста 496
таблица выполнения 417

Planned Exec Time
сведения о выполнении теста 496
таблица выполнения 417

Planned Host Name
сведения о выполнении теста 497
таблица выполнения 417

Premier Edition, определение 797
Preview, кнопка, Document Generator 750
Previous Page, кнопка, стандартные отчеты 

681
Print Graph, кнопка, панель инструментов 

диаграмм 642
Print Output, кнопка 776
Print, команда в таблице Defects Grid 548
Print, метод VAPI-XP 774
Priority

модуль Requirements 187
таблица Defects Grid 525

Product, модуль Requirements 187
Progress, вкладка, модуль Releases 150
Project, модуль Libraries 597
Project, список, окно входа в систему 43
Project, таблица Defects Grid 525
Properties, диалоговое окно 107
Purge Runs, команда 451

Q
QAInspect Test 295
Quality Center

URL-адрес сервера Quality Center 40
выпуски 797
выход 43, 46
главное окно 45
запуск 40
обзор 27
Окно входа в систему 42
Окно выбора 40
переход к другому проекту 48

сочетания клавиш 783
Quality, вкладка, модуль Releases 154
QualityCenter_Demo, проект 43
Query Builder 686
Query Parameters, вкладка 688
Query Results, вкладка 688
QuickTest Professional, определение типа 

теста 295

R
RBQM Business Impact 187
RBQM Custom Business Impact 187
RBQM Custom Failure Probability 187
RBQM Custom Functional Complexity 187
RBQM Custom Risk 187
RBQM Custom Testing Hours 188
RBQM Custom Testing Level 188
RBQM Date of Last Analysis 188
RBQM Effective Business Impact 188
RBQM Effective Failure Probability 188
RBQM Effective Functional Complexity 188
RBQM Effective Risk 188
RBQM Estimated RnD Effort 188
RBQM Exclude from Analysis 188
RBQM Failure Probability 188
RBQM Functional Complexity 189
RBQM Risk 189
RBQM Testing Hours 189
RBQM Testing Level 189
RBQM Use Custom Business Impact 189
RBQM Use Custom Failure Probability 189
RBQM Use Custom Functional Complexity 

189
RBQM Use Custom Results 189
RBQM Use Custom Risk 189
Readme 19
Refresh All, кнопка

Releases, модуль 153
Select a Test, диалоговое окно 343
вкладка Req Coverage 324
вкладка Test Coverage 232
дерево плана тестирования 300
модуль Releases 156
модуль Requirements 209

Refresh All, команда
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вкладка Req Coverage 324
Refresh Filter/Sort, кнопка 75
Refresh Test Sets Filter/Sort, команда 75
Refresh Tests Filter/Sort, команда 75
Refresh, кнопка, вкладка Test Coverage 328
Related Description, таблица Using 398
Related ID, таблица Using 398
Related Name, таблица Using 398
Related Type, таблица Using 398
Relationships, вкладка, прослеживаемость 

требований 234
Release ID 136
Releases, вкладка 134
Releases, модуль 134

Quality, вкладка 154
вкладка Progress 150
вставка папок, релизов и циклов 158
дерево релизов 139
добавление релизов 146
добавление циклов 147
изменение дерева 157
краткий обзор 133
назначение папок наборов тестов 

циклам 427
назначение требований 199
определения полей 136
панель инструментов 135
просмотр дефектов 154
просмотр назначенных требований 

149
просмотр хода выполнения 

тестирования 150
рабочий процесс 127
строка меню 135

Remaining days in cycle, вкладка Progress 
152

Remaining days in release, вкладка Progress 
151

Remaining test instances to run, вкладка 
Progress 151, 152

Remove All Execution Conditions, диалоговое 
окно 462

Remove Execution Condition, команда 461
Remove From Coverage, кнопка, вкладка Test 

Coverage 329
Remove from Traceability, кнопка 238

Remove Graph, кнопка 709
Remove Host From Host Group, кнопка 487
Remove Link, кнопка 556
Remove Saved, кнопка, Document Generator 

720
Remove Selected, кнопка, вкладка Req 

Coverage 325
Remove Test’s Execution Conditions, команда 

461
Remove Tests from Test Set, кнопка 445
Remove Time Dependency, команда 462
Remove, кнопка, панели отчетов 618
Rename, команда

дерево плана тестирования 314
дерево требований 215
модуль Releases 157
набор тестов 448
ресурсы тестов 392

Renumber Steps, кнопка 346
Replace All, кнопка, VAPI-XP 770
Replace, кнопка, VAPI-XP 770
Replace, команда

Requirements, таблица 207
дерево требований 206
таблица выполнения 444, 490
таблица дефектов 309, 444, 542

Report Selected with Children, команда 669
Report Selected, команда 669
Reproducible, таблица Defects Grid 525
Req ID, модуль Requirements 190
Req Parent, модуль Requirements 190
Reqs Coverage, вкладка, модуль Test Plan 

277
Required execution rate, вкладка Progress 

151, 152
Requirement Details, диалоговое окно 202
Requirement Details, кнопка 202
Requirement Details, представление 173
Requirement Trace ID, представление 

Traceability Grid 235
Requirement Type, модуль Requirements 190
Requirements Grid, представление 176
Requirements Traceability, представление 

203
Requirements Tree, представление 170
Requirements, кнопка 169
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Requirements, модуль
Coverage Analysis 330
вставка требований 217, 218
диаграммы 649
назначение требований релизам или 

циклам 199
определения полей 186
отправка требований по электронной 

почте 212
панель инструментов 183
покрытие 325
представление Coverage Analysis 

179
представление Requirement Details 

173
представление Requirements Grid 

176
представление Requirements Tree 

170
создание документов проекта 725
создание требований 195
стандартные отчеты 667
строка меню 182

Requirements, ссылка, Document Generator 
725

Requirements, флажок, Document Generator 
725

Reset Test Set, команда 450
Reset Titles, кнопка 645, 710
Resource ID, дерево ресурсов тестов 381
Resource Viewer, вкладка 383
Resources, корневая папка, дерево ресурсов 

тестов 378
Responsible Tester

сведения о выполнении теста 496
таблица выполнения 417

Restrict to current filter, флажок 78
Resume Execution, кнопка, VAPI-XP 782
Reviewed, модуль Requirements 190
RichContent, вкладка, модуль Requirements 

200
Risk Assessment, вкладка 243, 245
Risk, вкладка, представление Requirement 

Details 243, 250, 252, 255
Risk, представление, диалоговое окно 

Requirement Details 203

Run All Tests Locally, флажок 481
Run Events, представление, диалоговое 

окно Test Instance Properties 504
Run Manually, кнопка

вкладка Execution Flow 469
вкладка Execution Grid 469

Run on Host, диалоговое окно Automatic 
Runner 481

Run post-processing, флажок 695
Run Query, кнопка 690
Run Schedule of Test, диалоговое окно

Execution Conditions, вкладка 457
вкладка Time Dependency 459

Run Steps, диалоговое окно 499
Run Test Set, кнопка

вкладка Execution Flow 480
вкладка Execution Grid 480

Run VC Status 113
Run VC User 113
Run VC Version 113
Run, кнопка

вкладка Execution Flow 469, 480
вкладка Execution Grid 469, 480

run, функция VAPI-XP 775
Runs, ссылка, Document Generator 744
Runs, флажок, Document Generator 744
RunTest, функция VAPI-XP 771
RunTestSet, функция VAPI-XP 771

S
Save and Apply to Children, кнопка 254, 255
Save Graph Data, кнопка 642
Save Steps, кнопка 340
Save, кнопка, Document Generator 720
Scroll To The Left, кнопка, панель 

инструментов диаграмм 641
Scroll To The Right, кнопка, панель 

инструментов диаграммы 641
Search Results, диалоговое окно

дерево наборов тестов 442
дерево плана тестирования 307
дерево требований 204
схема выполнения 464

Searchable Fields Information, кнопка 78
Select a Test, диалоговое окно 343
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Select Cleanup Test, диалоговое окно 437, 
505

Select Columns, диалоговое окно 55
Select Columns, кнопка, вкладка Design Steps 

347
Select Columns, команда, вкладка Design 

Steps 347
Select Destination Subject, диалоговое окно 

223
Select Fields, диалоговое окно 215, 306, 

547
Select Filter Condition, диалоговое окно 61
Select Host, диалоговое окно 481
Select Projects, кнопка 638
Select Recipients, диалоговое окно 214, 

305, 390, 546
Select Req, кнопка 323
Select Test Set, диалоговое окно 777
Select Test Sets to Purge, диалоговое окно 

451
Select Tests, кнопка, вкладка Test Coverage 

328
Select Tests, кнопка, дерево плана 

тестирования 431, 432
Send by E-mail, кнопка

дефекты 545
тесты 304

Send E-mail, диалоговое окно
дефекты 544
ресурсы тестов 389
тесты 304
требования 212

Set Filter/Sort, вкладка Requirements 
Traceability 232

Set Filter/Sort, вкладка Test Coverage 326, 
328

Set Filter/Sort, кнопка 60, 70, 499
Set Filter/Sort, кнопка, модуль Requirements 

209
Set Graph Appearance, кнопка 645, 704, 

708, 710
Set Test Sets Filter/Sort, команда 60, 70
Set Tests Filter/Sort, команда 70
Set to Default, кнопка 440
Settings per test, кнопка 438
Severity, таблица Defects Grid 525

Show Advanced Filter, стрелка 67
Show All, кнопка, панель инструментов 

диаграмм 641
Show Full Path, команда 322
Show Full Test Names, команда 465
Show Last Run Results, команда 414
Show only Template Tests, флажок 343
Show Parameters, кнопка, параметры теста 

472
Show Requirements, команда 149, 150
Show Run Steps, кнопка, представление All 

Runs 499
Show Test Set Folders, команда 150
Show Variables, кнопка 781
Show/Hide Browsers, кнопка 767
Show/Hide Total Values, кнопка 641
Similar Defects, диалоговое окно 535
Sleep, функция VAPI-XP 775
Snapshot, диалоговое окно, диалоговое окно 

Attachments 96
Snapshot, кнопка, диалоговое окно 

Attachments 96
Sort Ascending, кнопка, диалоговое окно 

Filter 71
Sort Descending, кнопка, диалоговое окно 

Filter 71
Sort Folders in Test Plan Tree, диалоговое 

окно 313
Sort Folders, кнопка 313
Sorted Fields, список 70
Source Library Owner, модуль Libraries 598
Spelling and Grammar, команда

Check Spelling 48
Spelling Options 48
Thesaurus 48

Spelling Options, кнопка
Send Mail 215, 547
отправка сообщения электронной 

почты 306
создание требования 198
создать дефект 533

Spelling Options, команда 48
SQL, область 689
Start Date

дерево релизов 147, 148
модуль Releases 136
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Starter Edition, определение 797
Statistics, модуль Releases 136
Status

дерево плана тестирования 297
сведения о выполнении теста 497
таблица Defects Grid 526
таблица выполнения 417
таблица тестов 286

Status Filter, список, вкладка Test Coverage 
326

Step Into, кнопка 780
Step Out, кнопка 781
Step Over, кнопка 780
Step, команда 222
Stop Debugging, кнопка 782
Stop, кнопка

Document Generator 751
VAPI-XP 776
диалоговое окно Automatic Runner 

482
Subject

таблица Defects Grid 526
таблица тестов 286

Subject Tests, ссылка, Document Generator 
731

Subject Tests, флажок, Document Generator 
731

Subject Tree, ссылка, Document Generator 
729

Subject Tree, флажок, Document Generator 
729

Subject, Команда 222
Summary, область таблицы Defects Grid 520
Summary, таблица Defects Grid 526
Synchronize, кнопка 605
Syntax Check, кнопка 769
Syntax Check, команда 769
System Info, кнопка 98
System Information, диалоговое окно 98
System Test, определение типа теста 295

T
Take Default Values, кнопка 360, 502
Target Cycle

модуль Defects 526

модуль Requirements 190
таблица выполнения 417

Target Release
модуль Defects 526
модуль Requirements 190

TDHelper, объект, VAPI-XP 771
TDInput, объект VAPI-XP 773
TDOutput, объект VAPI-XP 774
Template Test, команда 297
Template, таблица тестирования 286
Test Coverage, представление, диалоговое 

окно Requirement Details 203
Test ID, таблица тестов 286
Test Instance Properties, диалоговое окно 

491
вкладка Automated 503
вкладка Manual Parameters 502
представление All Runs 498
представление Configuration 501
представление Details 495
представление History 507
представление Linkage and Coverage 

506
представление Run Events 504

Test Instance Runs, индикатор выполнения, 
вкладка Progress 152

Test Lab, кнопка 408
Test Lab, модуль

 491
автоматическое выполнение тестов 

477
вкладка Automation 409
вкладка Execution Flow 409
вкладка Execution Grid 409
вкладка Linked Defects 409
выполнение тестов вручную 467
главное окно 408
диаграммы 650
диаграммы анализа в реальном 

времени 705
краткий обзор 407
наборы тестов 423
назначение папок наборов тестов 

циклам 427
панель инструментов Select Tests 

412
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панель инструментов Test Set 412
рабочий процесс 403
создание документов проекта 738
стандартные отчеты 667
строка меню 410

Test Lab, ссылка, Document Generator 738
Test Lab, флажок, Document Generator 738
Test List, ссылка, Document Generator 734
Test List, флажок, Document Generator 734
Test Name, таблица тестов 286
Test Plan, кнопка 276
Test Plan, модуль

автоматизация тестов 363
вкладка Dependencies 395
главное окно 276
дерево плана тестирования 289
диаграммы 650
диаграммы анализа в реальном 

времени 701
краткий обзор 275
панель инструментов 280
параметры теста 353
покрытие требований 321
рабочий процесс 267
создание документов проекта 728
стандартные отчеты 667
строка меню 278
таблица тестов 282
шаги теста 337

Test Query, кнопка 690
Test Resources, кнопка 377
Test Resources, модуль, вкладка 

Dependencies 395
Test Run Schedule, команда 457
Test Script, вкладка 277, 366
Test Sets Filter/Sort, кнопка 60, 70
Test Sets Grid, команда 429
Test Sets Tree, команда 426, 429
Test Sets, меню, модуль Test Lab 410
Test Sets, ссылка, Document Generator 740
Test Sets, флажок, Document Generator 740
Test Type, список, модуль Test Plan 295
Test, команда 222
TestDirector, см. Quality Center
Tester

сведения о выполнении теста 497

таблица выполнения 418
Testing Policy, таблица 251
Tests Coverage Chart 333
Tests Coverage, диалоговое окно 334
Tests Filter/Sort, кнопка 60, 70
Tests Filter/Sort, команда 60
Tests, меню

модуль Test Lab 411
модуль Test Plan 278

Tests, ссылка, Document Generator 742
Tests, флажок, Document Generator 742
Text Search, кнопка 77
Text, свойство VAPI-XP 774
Thesaurus, кнопка

Send Mail 215, 547
отправка сообщения электронной 

почты 306
создание требования 198
создать дефект 533

Thesaurus, команда 48
Time

таблица выполнения 418
Time Dependency of Test, диалоговое окно 

461
Time Dependency, вкладка, диалоговое окно 

Run Schedule of Test 459
Time Dependency, значок 461
Time, сведения о выполнении теста 497
Toggle Breakpoint, кнопка 779
Toggle Breakpoint, команда 779
Tools, кнопка 48

Document Generator, команда 716
команда Customize 48
команда New Defect 48

Total allocated testing time, поле 253
Total days in cycle, вкладка Progress 152
Total days in release, вкладка Progress 151
Total test instances for cycle, вкладка Progress 

152
Total test instances for release, вкладка 

Progress 151
Total Testing Time per Risk Category, 

диаграмма 253
Trace Comment, представление Traceability 

Grid 235
Trace Existing Requirement, диалоговое окно 
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233
Trace From Tree, представление 236
Trace To Tree, представление 236
Traceability Grid, представление 234
Troubleshooting and Knowledge Base 22
Type, дерево ресурсов тестов 381
Type, таблица тестов 286

U
Unattached, папка, дерево плана 

тестирования 315
Undo Check Out, кнопка 120
Undo Check Out, команда 119
Unload, кнопка, Document Generator 720
Update Selected, команда 74, 217, 310, 

543
updates, documentation 23
Upload Selected, кнопка, вложения 100
UpLoadAttachment, функция VAPI-XP 773
URL, кнопка 95
URL-адрес сервера Quality Center 40
URL-адрес, копирование 217, 312, 387, 

447, 548
Use custom Business Criticality, флажок 246
Use custom Failure Probability, флажок 247
Use custom Functional Complexity, флажок 

249
Use custom Risk, флажок 247
Used By, таблица 396
User Properties, окно 50
User Properties, ссылка 50
Using, таблица 396

V
VAPI-XP

интерфейс API 771
определение типа теста 295

VAPI-XP, встроенный отладчик 779
VAPI-XP, тесты 755

выполнение в режиме отладки 776
выполнение в режиме тестирования 

777
изменение 766
отладка 779

создание 756
Variables, команда 781
Version Check Out Date, модуль 

Requirements 191
Version Check Out Time, модуль 

Requirements 191
Version Checked Out By, модуль 

Requirements 191
Version Date, модуль Test Plan 287
Version Number

дерево ресурсов тестов 381
модуль Requirements 191
модуль Test Plan 287

Version Owner, модуль Test Plan 287
Version Status

модуль Requirements 191
модуль Test Plan 287

Version Time, модуль Test Plan 287
Versions and Baselines, вкладка 121
View By Group, флажок 58
View Graph in Full Screen, кнопка 619
View Order, вкладка, диалоговое окно Filter 

70
View Page in Full Screen, кнопка 619
View Runs, список, представление All Runs 

499
View, вкладка, диаграммы 640
View, вкладка, панели отчетов 618
View, вкладка, стандартные отчеты 680
View, меню

модуль Test Lab 410
модуль Test Plan 278

Visible Columns, список 55

W
Warn Before Check Out, команда 116
Window Screen, кнопка 766
WinRunner Automated, определение типа 

теста 295
Word

импорт в Quality Center 38
создание документов проекта 750
экспорт анализа покрытия 335
экспорт данных таблицы из Quality 

Center 79
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WrapArray, функция VAPI-XP 775

X
XML-документ, экспорт данных таблицы 79
XTools, объект VAPI-XP 775

Z
Zoom In, кнопка, панель инструментов 

диаграмм 642
Zoom In, кнопка, схема выполнения 464
Zoom Out One Level, кнопка 209
Zoom Out To Root, кнопка 209
Zoom Out, кнопка, панель инструментов 

диаграмм 642
Zoom Out, кнопка, схема выполнения 465

А
автоматизированные тесты

выполнение 477
выполнение вручную 467
какие тесты не следует 

автоматизировать 364
когда необходимо автоматизировать 

363
создание скрипта теста 364

администратора сайта, просмотр 
сообщений 52

анализ проектов
Document Generator 713
Диаграммы анализа в реальном 

времени 699

Б
базовые состояния

настройка параметров сравнения 
576

прикрепление набора тестов 579
примеры 570
просмотр истории изменения 

базового состояния 578
создание 569
сравнение 573

базы данных проекта 37

базы данных, поддерживаемые Quality 
Center 37

библиотеки
импорт
синхронизация 602
создание 567
сравнение 598

Бизнес-критичность, определение 244

В
варианты поставки, QualityCenter 797
Веб-сайт HP Software 22
Веб-сайт HP Software Support 22
веб-страница, вложение 95
Вероятность сбоя, определение 244
вложения

вложение URL-адреса 95
вложение сведений о системе 98
вложение снимка 96
вложение файла 95
вложение элементов из буфера 

обмена 99
изменение 100
просмотр 99
сохранение 100
удаление 101

возврат объектов 117
время

указание для выполнения теста 457
время тестирования 249
вставка папок релизов, релизов и циклов 

158
вставка требований 217, 218
вызов ручных тестов 341
выполнение наборов тестов 477
выполнение тестов

автоматически 477
вручную 467
наборы тестов 477

выпуски, QualityCenter 797
выход из QualityCenter 43, 46

Г
группирование записей таблицы 72
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группы пользователей 37

Д
дата, указание для выполнения теста 457
демонстрационный проект 43
дерево анализа 614
дерево библиотек. См. Libraries, модуль
дерево наборов тестов

копирование URL-адресов 447
назначение папок циклам 427

дерево наборов тестов, покрытие тестами 
325

дерево панели отчетов 614
дерево плана тестирования 289

добавление тестов 294
значки тестов 299
копирование URL-адресов 312
обзор 290
обновление 300
отображение в модуле Requirements 

328, 329
отправка тестов по электронной 

почте 303
переименование папок и тестов 314
поиск папки или теста 307
покрытие требований 321
просмотр 300
просмотр в модуле Test Lab 431, 

432
развертывание и свертывание 300
создание 292
сортировка папок 313
удаление папок и тестов 315

дерево релизов 139
 149
добавление релизов 146
добавление циклов 147
изменение 157
корневая папка 146
обзор 140
переименование папок релизов, 

релизов и циклов 157
перемещение папок релизов и 

релизов 157
просмотр дефектов 154

просмотр хода выполнения 
тестирования 150

создание копий циклов 158
удаление папок, релизов и циклов 

158
дерево требований

замена значений 206
замена значений полей 207
копирование URL-адреса 217
копирование требований 216
назначение требований релизам или 

циклам 199
обзор 194
обновление 209
определения полей 186
отображение в модуле Test Plan 323
отправка требований по электронной 

почте 212
переименование требования 215
перемещение требований 218
поиск требований 204
покрытие тестами 325
просмотр истории изменения 

требования 210
развертывание и свертывание 209
создание 195
создание тестов из 219
удаление требований 218
уменьшение 209
фильтрация 209

диаграммы
Defects - Age Graph 664
Defects - Progress Graph 662
Defects - Summary Graph 661
Defects - Trend Graph 665
Requirements - Coverage Graph 654
Requirements - Progress Graph 653
Requirements - Summary Graph 652
Requirements - Trend Graph 655
Test Execution - Progress Graph 660
Test Execution - Summary Graph 659
Test Planning - Progress Graph 657
Test Planning - Summary Graph 656
Test Planning - Trend Graph 658
анализ в реальном времени, папка 

наборов тестов 705
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анализ в реальном времени, папка 
объектов тестирования 701

диаграммы анализа в реальном 
времени 699

диаграммы на основе нескольких 
проектов 638

изменение категорий 646
настройка 635
настройка внешнего вида 645
настройка внешнего вида диаграмм 

анализа в реальном времени 710
обзор 625
переход к записям 643
просмотр 640
создание диаграмм вручную 632
создание при помощи мастера 

диаграмм 626
создание экспресс-диаграмм 631
типы диаграмм 649

диаграммы анализа в реальном времени
настройка внешнего вида 710
создание в папке наборов 

тестирования 705
создание в папке объектов 

тестирования 701
удаление 709

диаграммы на основе нескольких проектов 
638

диалоговое окно Find Requirement 204
документ Word, команда Export 335

Ж
журнал выполнения 483

З
зависимости

Dependencies, вкладка 395
просмотр 395
таблица Used By 396
таблица Using 396

зависимости объекта
копирование тестов и папок объектов 

тестирования между проектами 
311

зависимости объектов
 315
копирование наборов тестов и папок 

наборов тестов между проектами 
446

запросы SQL, отчеты Excel 686
запуск Quality Center 40
значки для тестов 299
значок камеры 96

И
избранные представления 103

добавление 104
загрузка 105
изменение свойств 107
личная папка 103
недавно использовавшиеся 105
обновление 106
общая папка 103
определение 103
удаление 107

изменение порядка шагов теста 346
изображения, вложение 96
изъятие

автоматическое 116
вручную 116

изъятие объектов 115
импорт в Quality Center

из приложения Excel 38
из приложения Word 38

Импортированная библиотека, значок 590
история версий 120
история изменения

удаление 51

К
категория рисков, определение 244
категории диаграмм 646
команда Add-ins Page 23
команда Help on this page 19
команда What’s New 19
копирование

URL-адрес дефекта 548
URL-адрес набора тестов 447
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URL-адрес ресурса теста 387
URL-адрес теста 312
URL-адрес требования 217
дефекты 547
наборы тестов, внутри проекта 445
наборы тестов, между проектами 

446
ресурсы тестов, внутри проекта 385
ресурсы тестов, между проектами 

385
тесты, внутри проекта 310
тесты, между проектами 311
требования 216
шаги теста, внутри проекта 348
шаги теста, между проектами 348

критерии группирования
копирование 75
установка 72

критерии сортировки
копирование 75
обновление 75
очистка 75

Л
личная папка, в избранном 105, 107

М
мастер диаграмм 626

Н
набор регрессионных тестов 424
набор тестов для проверки 

работоспособности 424
набор тестов для проверки функции 425
наборы тестов 423

выполнение тестов 477
добавление 428
добавление тестов в наборы 431
копирование, внутри проекта 445
копирование, между проектами 446
назначение папок циклам 427
настройка правил при сбое 

выполнения 436
настройка уведомлений 434

обзор 424
определение 423
переименование 448
поиск в дереве 442
прикрепление к базовому состоянию 

579
сброс 450
типы 424
удаление наборов тестов 450
удаление папок 449
удаление результатов выполнения 

451
удаление тестов из наборов 445

нагрузочное тестирование 268

О
обновления документации 23
обновления, документация 23
обновление нескольких записей 74
общая папка, в избранном 105, 108
объекты

 315
копирование наборов тестов и папок 

наборов тестов между проектами 
446

копирование тестов и папок объектов 
тестирования между проектами 
311

объем 164
обычный уровень увеличения 465
Окно входа в систему Mercury Quality Center 

42
Окно выбора Mercury Quality Center 40
оповещения 81
отслеживание дефектов

 534
добавление дефектов 531
краткий обзор 517
обновление дефектов 538
отправка дефектов по электронной 

почте 544
поиск и замена 540
просмотр истории изменения 

дефекта 543
рабочий процесс 511
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таблица дефектов 524
удаление дефектов 549

отчет об управлении качеством на основе 
рисков 255

отчеты
отчеты Excel 683
создание документов проекта 713

отчеты Excel
выполнение 695
добавление параметров 691
настройки системы безопасности 

694
скрипт дополнительной обработки 

694
создание 685
создание запросов SQL 686

отчеты. См. стандартные отчеты

П
пакетный тест WinRunner 299, 479
панели инструментов

Defects, модуль 522
Select Tests 412
Test Set 412
модуль Releases 135
модуль Requirements 183
модуль Test Plan 280
схема выполнения 420
таблица выполнения 415
таблица тестов 284

панели отчетов
настройка 617
обзор 616
просмотр 618
создание 616

папки объектов
добавление к дереву плана 

тестирования 292
определение 290
переименование 314
поиск в дереве плана тестирования 

307
сортировка в дереве плана 

тестирования 313
удаление 315

параметры WinRunner 503
параметры теста

вставка в шаг теста 357
назначение фактических значений 

358
определение 355
установка значений параметров для 

экземпляров ручных тестов 501
параметры, в отчетах Excel 691
параметры, ручные тесты 353
пароль

изменение 49
сброс 44

перекрестные фильтры 64
фильтрация тестов, не входящих ни в 

один набор 68
фильтрация тестов, не покрывающих 

требования 68
переход к записям, диаграммы 643
планирование выполнения тестов 455
поиск текста 76
покрытие

анализ 330
тесты 325
требования 321

покрытие тестами 325
анализ 330
добавление тестов 327
добавление экземпляров теста 327
пример 320
просмотр 326
удаление тестов из покрытия 329
удаление экземпляров теста из 

покрытия 329
покрытие требования тестами

обзор 317
покрытие требований 321

анализ 330
добавление требований 323
обзор 317
пример 319
просмотр 322
удаление требований 325

поле фильтра в таблице 63
поле фильтра таблицы 63
политика тестирования
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завершение определения 251
определение параметров 249

пользователи
выбор 57
группирование 57
поиск 57
сортировка 57

Порядок сортировки ASCII 69
представления, избранные 103
Преобразование всех требований в объекты 

220
Преобразование дочерних требований 

низшего уровня
в тесты 220
в шаги тестов 220

привилегии 37
привилегии пользователей 37
Приступая к работе 19
прослеживаемость требований 227

добавление 231
просмотр 234, 236
связи trace from 228
связи trace to 228
удаление 238

прослеживаемость, требования 227
добавление 231
просмотр 234, 236
связи trace from 228
связи trace to 228
удаление 238

просмотр сообщений администратора сайта 
52

процесс управления тестированием 29
выполнение тестов 35
определение требований 32
отслеживание дефектов 36
планирование тестирования 33

Р
расширенные фильтры 64
расширенный набор тестов 425
Режим отладки, тесты VAPI-XP 776
результаты выполнения тестов 491
ресурсы тестов

Resources, корневая папка 378

добавление папки ресурсов 378
добавление файла ресурсов 378
загрузка 384
копирование URL-адресов 387
копирование, внутри проекта 385
копирование, между проектами 385
отправка 383
отправка по электронной почте 389
переименование ресурсов тестов 

392
перемещение 391
поиск 388
просмотр зависимостей 384
просмотр истории изменения 393
создание дерева 378
удаление 392
управление 375
фильтрация 388

ресурсы. См. ресурсы тестов
ручные тесты

выполнение 467
преобразование в тест VAPI-XP 756

С
сброс пароля 44
связи trace from 228
связи trace to 228
связи дефектов

добавление 555
косвенные 551
обзор 551
прямые 551
просмотр 554
удаление 556

связывание дефектов
добавление связей 555
косвенное 551
обзор 551
прямое 551
просмотр дефектов 554
удаление связей 556

свойства пользователя, изменение 49
свойства, изменение 49
Системные тесты 367
скрипт Visual Basic, отчеты Excel 694
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скрипт дополнительной обработки, отчеты 
Excel 694

скрипт теста, создание 364
скрипт, создание 364
Словарь терминов 803
совместное использование. См. импорт 

библиотек
создание скриптов автоматизированных 

тестов 364
сообщение о дефектах

 534
добавление дефектов 531
краткий обзор 517
обновление дефектов 538
отправка дефектов по электронной 

почте 544
поиск и замена 540
просмотр истории изменения 

дефекта 543
рабочий процесс 511
таблица дефектов 524
удаление дефектов 549

сочетания клавиш 783
сравнение дефектов 534
стандартные отчеты

добавление суботчетов 677
настройка 675
обзор 667
предопределенные отчеты 670
просмотр 680
создание в модуле Dashboard 672
создание экспресс-отчетов 668
типы отчетов 674

стандартные экспресс-отчеты 668
Страница приветствия 43
стресс-тестирование 268
суботчеты 677
схема выполнения 455

 491
автоматическое выполнение тестов 

477
выполнение тестов вручную 467
добавление временной зависимости 

457
добавление временной зависимости 

в схему 459

добавление условия 458
изменение временной зависимости 

461
изменение масштаба 465
изменение условий 460
краткий обзор 419
наборы тестов 423
обзор 455
определение последовательности 

тестов 463
отображение полных имен тестов 

465
панель инструментов 420
поиск тестов 464
просмотр журнала выполнения 483
просмотр тестов в иерархической 

компоновке 464
увеличение 464
удаление временной зависимости 

462
удаление всех условий и 

зависимостей 462
удаление условий 461
уменьшение 465

Т
таблица выполнения

автоматическое выполнение тестов 
477

выполнение тестов вручную 467
замена значений полей 444
краткий обзор 414
наборы тестов 423
определения столбцов 417
панель инструментов 415
поиск и замена 489
просмотр журнала выполнения 483
просмотр результатов выполнения 

тестов 491
упорядочивание тестов 487

таблица дефектов
добавление дефектов 531
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